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Willkommen! 
Willkommen bei PlanMaker! Mit PlanMaker haben Sie ein überaus leistungsfähi-

ges und dabei komfortabel zu bedienendes Tabellenkalkulationsprogramm erwor-

ben.  

Wir haben uns bei der Erstellung dieses Programms bemüht, die Funktionen von 

PlanMaker so zu integrieren und aufeinander abzustimmen, dass Ihnen bei mög-

lichst geringem Arbeitsaufwand der größtmögliche Nutzen geboten wird.  

Dabei lässt Ihnen PlanMaker genügend Freiraum für Ihre individuellen Ansprüche. 

Über zahlreiche Einstellmöglichkeiten können Sie sich PlanMaker so einrichten, 

wie es Ihnen am besten gefällt. 

Einige Features von PlanMaker: 

 PlanMaker kennt über 330 Rechenfunktionen – von der einfachen Summen-

berechnung bis hin zu zahlreichen finanzmathematischen und statistischen 

Funktionen.  

 Das integrierte Diagramm-Modul erlaubt es Ihnen, Zahlen anschaulich in Di-

agrammen zu präsentieren. 

 Das Erstellen von ansprechenden Tabellen wird durch die vielfältigen Gestal-

tungsfunktionen erleichtert. Nüchterne Zahlenkolonnen können mit dem Au-

toFormat-Befehl auf Knopfdruck in übersichtliche und ansprechende Tabellen 

verwandelt werden. Mit Zellen- und Zeichenvorlagen bringen Sie häufig be-

nötigte Formatierungen auf Knopfdruck an etc. 

 Die ganze Funktionsvielfalt von PlanMaker ist eingebettet in eine durchdachte 

und ergonomische Benutzeroberfläche. Frei gestaltbare Symbolleisten stellen 

Ihnen häufig benötigte Funktionen auf Knopfdruck zur Verfügung. Die Tasta-

turbelegung lässt sich individuell anpassen. Kontextmenüs, die Sie über die 

rechte Maustaste erreichen, enthalten immer genau die Befehle, die Sie gerade 

benötigen. 

PlanMaker wird ständig weiterentwickelt. Falls Sie beim Arbeiten einmal ein Fea-

ture vermissen sollten oder andere Anregungen haben, schreiben Sie uns – wir wol-

len, dass PlanMaker den Wünschen der Anwender entspricht! 
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Technischer Support 

Wenn Sie Fragen haben, hilft Ihnen unser technischer Support gerne weiter. Sie 

können diesen wie folgt erreichen: 

Website: www.softmaker.de 

Auf unserer Website finden Sie die neuesten Updates für Ihre Programme, kosten-

lose Downloads und vieles mehr. Besuchen Sie uns auf: www.softmaker.de 

Supportforen: www.softmaker.com/diskussion 

In unseren Supportforen können Sie technische Fragen stellen und mit anderen 

Anwendern kommunizieren: www.softmaker.com/diskussion 

E-Mail 

Anfragen per E-Mail senden Sie bitte an: support@softmaker.de 

Post oder Fax 

Sie können uns Anfragen auch per Post oder Fax senden: 

SoftMaker Software GmbH 

Kronacher Straße 7 

90427 Nürnberg 

Deutschland 

Fax: 0911/303796 

http://www.softmaker.de/
http://www.softmaker.com/diskussion
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Über dieses Handbuch 

PlanMaker besitzt sehr viele Funktionen – aber keine Sorge: Sie müssen nicht alle 

davon beherrschen! Nutzen Sie am Anfang nur die Möglichkeiten, die Sie benöti-

gen. Wenn Sie später einmal fortgeschrittenere Funktionen in Anspruch nehmen 

möchten, können Sie die entsprechenden Stellen im Handbuch immer noch nachle-

sen. 

Dieses Handbuch ist wie folgt aufgebaut: 

 Das Kapitel „Installation und Programmstart“ ab Seite 25 beschäftigt sich 

mit der Installation von PlanMaker. Sie erfahren weiterhin, wie das Programm 

gestartet wird. 

 Im Kapitel „Der Arbeitsbildschirm“ ab Seite 27 werden die einzelnen Be-

standteile des Programmfensters beschrieben. 

 Das Kapitel „Grundlagen“ ab Seite 33 stellt Ihnen die grundlegenden Funktio-

nen von PlanMaker vor und erläutert einige Grundbegriffe der Tabellenkalkula-

tion. 

 Das Kapitel „Die PlanMaker-Tour“ ab Seite 43 befasst sich praxisbezogen mit 

dem Thema Tabellenkalkulation und führt Sie anhand einiger Beispiele in die 

Bedienung von PlanMaker ein.  

 Mit dem Kapitel „Bearbeiten einer Tabelle“ ab Seite 57 beginnt der Referenz-

teil des Handbuchs. Dieser ist nach Sachgebieten aufgeteilt und beschreibt aus-

führlich alle Funktionen von PlanMaker. 

Systemvoraussetzungen 

Zum Einsatz dieser Software benötigen Sie folgende Hard- und Software:  

Windows-Version 

 Windows XP mit Service Pack 2, Windows Vista, Windows 7 oder Windows 8 

 64 MB Arbeitsspeicher (bei Windows 7 und 8: 512 MB) 
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Linux-Version 

 Beliebiges x86-Linux 

 X Window mit beliebigem Window Manager 
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Installation und Programmstart 
In diesem Kapitel erfahren Sie, wie Sie PlanMaker installieren und wie Sie das 

Programm starten. 

Das Kapitel ist nach Betriebssystemen aufgeteilt: 

 Installation unter Windows 

 Installation unter Linux 

Lesen Sie bitte bei dem Abschnitt für Ihr Betriebssystem weiter. 

Installation unter Windows 

Download 

Wenn Sie PlanMaker als Download aus dem Internet bezogen haben, finden Sie 

Instruktionen zur Installation des Programms in der E-Mail, die Sie beim Kauf 

automatisch erhalten haben. 

CD-ROM 

Wenn Sie PlanMaker auf CD-ROM bezogen haben, starten Sie nun bitte das Instal-

lationsprogramm im Hauptverzeichnis der CD.  

Folgen Sie dann den Anweisungen des Installationsprogramms, um die Software 

zu installieren. 

Starten der Programme 

Zum Starten der installierten Programme verwenden Sie das Start-Menü in der 

linken unteren Bildschirmecke. Klicken Sie nacheinander auf Start > Programme 

> SoftMaker Office > PlanMaker, um PlanMaker zu starten. 

Adresseingabe beim ersten Start: Wenn Sie PlanMaker zum ersten Mal starten, werden Sie gebeten, 
Ihren Namen, Ihre Adresse etc. anzugeben. Diese Angaben dienen nicht der Registrierung. Vielmehr 

erlauben sie Ihnen, über die Funktion BENUTZERFELD Ihren Namen, Ihre Adresse etc. in Dokumente 
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oder Dokumentvorlagen einzufügen. Sie können diese Angaben später jederzeit wieder ändern (siehe 

Abschnitt „Einstellungen, Karteikarte Allgemein“ ab Seite 385). 

Installation unter Linux 

Informationen zur Installation von PlanMaker finden Sie in der E-Mail, die Sie 

zum Download des Programms erhalten haben. 

Starten der Programme 

Bei den meisten Linux-Distributionen legt das Installationsprogramm automatisch 

Verknüpfungen für alle SoftMaker Office-Applikationen im Menü oder auf dem 

Desktop an. Mit diesen können Sie die Programme bequem per Mausklick starten. 

Als Alternative werden außerdem Skripte zum Starten der Programme angelegt:  

 textmaker12 startet TextMaker 

 planmaker12 startet PlanMaker 

 presentations12 startet SoftMaker Presentations 

Sie können diese beispielsweise in einer Shell aufrufen. 

Adresseingabe beim ersten Start: Wenn Sie PlanMaker zum ersten Mal starten, werden Sie gebeten, 

Ihren Namen, Ihre Adresse etc. anzugeben. Diese Angaben dienen nicht der Registrierung. Vielmehr 
erlauben sie Ihnen, über die Funktion BENUTZERFELD Ihren Namen, Ihre Adresse etc. in Dokumente 

oder Dokumentvorlagen einzufügen. Sie können diese Angaben später jederzeit wieder ändern (siehe 

Abschnitt „Einstellungen, Karteikarte Allgemein“ ab Seite 385). 
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Der Arbeitsbildschirm 
Auf den nächsten Seiten stellen wir Ihnen die einzelnen Komponenten der Benut-

zeroberfläche von PlanMaker vor.  

Wenn Sie bisher nur wenig Erfahrung im Umgang mit Computern haben, sollten 

Sie dieses Kapitel unbedingt lesen. 

 
Das Programmfenster von PlanMaker (Windows-Version) 

Anmerkung: Die Abbildungen in diesem Handbuch wurden größtenteils mit der 

Windows-Version von PlanMaker angefertigt. Unter anderen Betriebssystemen 

sehen manche Bedienelemente zwar etwas anders aus, die Funktionsweise ist je-

doch die gleiche. 

Titelleiste 

In der obersten Zeile des Programms finden Sie die Titelleiste. 
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Die Titelleiste zeigt den Namen des Programms an. Ist momentan ein Dokument 

geöffnet, wird dahinter dessen Name angezeigt. 

Menüleiste 

Unter der Titelleiste befindet sich die Menüleiste. 

 

Diese enthält sämtliche Befehle von PlanMaker in Form von übersichtlichen Me-

nüs. Klicken Sie auf einen Menüeintrag, um ein Menü zu öffnen und darin einen 

Befehl aufzurufen. 

Funktionsleiste 

Unterhalb der Menüleiste wird die Funktionsleiste angezeigt. Diese enthält Symbo-

le für die gebräuchlichsten Befehle von PlanMaker. 

 

Symbolleisten wie die Funktionsleiste ermöglichen blitzschnellen Zugriff auf die 

Funktionen eines Programms. Jedes Symbol steht für einen bestimmten Befehl. 

Klicken Sie darauf, wird der entsprechende Befehl aufgerufen.  

Tipp: Wenn Sie mit der Maus auf eines der Symbole zeigen (ohne zu klicken), 

erscheint ein Infotext, der die Funktion des Symbols angibt. 

Es gibt in PlanMaker noch zahlreiche weitere solche Symbolleisten, die Sie nach 

Belieben ein- und ausschalten können. Rufen Sie dazu entweder den Befehl An-

sicht > Symbolleisten auf oder klicken Sie mit der rechten Maustaste auf eine der 

angezeigten Symbolleisten. Es erscheint ein Menü, in dem Sie wählen können, 

welche Leisten angezeigt werden sollen. 

Symbolleisten selbst gestalten: Sie können die vorgegebenen Symbolleisten nach 

Belieben verändern und auch eigene Symbolleisten erstellen. Informationen dazu 

finden Sie im Abschnitt „Symbolleisten anpassen“ ab Seite 414. 
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Formatleiste 

Die Formatleiste finden Sie unterhalb der Funktionsleiste. Sie können damit die 

gebräuchlichsten Textformatierungen (Schriftart, Fettdruck, Kursivschrift usw.) für 

Tabelleninhalte sowohl ablesen als auch ändern. 

 

Um beispielsweise eine andere Schriftart auszuwählen, klicken Sie auf das kleine 

Pfeilchen rechts neben der Schriftart, um die Liste zu öffnen, und wählen dann eine 

Schriftart aus. 

Andere Symbole der Formatleiste sind wiederum Schalter, die Sie durch Anklicken 

ein- und ausschalten können – zum Beispiel das F für Fettdruck. 

Tipp: Wenn Sie mit der Maus auf eines der Symbole zeigen (ohne zu klicken), 

erscheint ein Infotext, der die Funktion des Symbols angibt. 

Bearbeitungsleiste 

Unterhalb von Funktions- und Formatleiste finden Sie die Bearbeitungsleiste. 

 

Auf dieser gibt es folgende Bedienelemente: 

Zelladresse 

Ganz links wird die Adresse der momentan aktiven Tabellenzelle angezeigt. 

Symbole und Eingabefeld zum Bearbeiten von Zellinhalten 

Rechts daneben finden Sie vier Symbole und ein Eingabefeld. 

Mit Hilfe des Eingabefelds können Sie den Inhalt der aktuellen Zelle bearbeiten. 

Alternativ können Sie den Zellinhalt allerdings auch direkt in der entsprechenden 

Zelle bearbeiten: die Zelle einfach ansteuern und tippen. Letzteres geht in der Re-

gel schneller.  
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Ausführliche Informationen zum Ausfüllen und Bearbeiten von Tabellenzellen 

finden Sie im Abschnitt „Daten in Zellen eingeben“ ab Seite 60. 

Die Schaltflächen daneben haben folgende Funktionen: 

Symbol Funktion 

 
Befehl Einfügen > Funktion aufrufen 

 
Summenfunktion einfügen 

 
Eingabe im Eingabefeld übernehmen (entspricht dem Drücken der Ein-

gabetaste (¢)) 

 
Eingabe im Eingabefeld verwerfen (entspricht dem Drücken von (Esc)) 

Weitere Informationen zum Eingeben von Rechenformeln finden Sie im Kapitel 

„Formeln und Funktionen“ ab Seite 437. 

Dokumentfenster 

Den größten Teil des Bildschirms nimmt das Dokumentfenster zum Bearbeiten der 

Tabelle ein.  

Jedes Dokument, das Sie in PlanMaker öffnen oder neu anlegen, in einem eigenen 

Dokumentfenster angezeigt. So können Sie mehrere Dokumente gleichzeitig bear-

beiten und Daten zwischen diesen austauschen.  

Ein Dokumentfenster hat folgende Bestandteile: 

Titelleiste 

Sofern ein Dokumentfenster nicht maximiert worden ist, enthält es seine eigene 

Titelleiste. Hierin wird der Name des darin geöffneten Dokuments angezeigt. 

Dokument 

Den größten Bereich nimmt das Dokument selbst ein. Dies ist Ihr Arbeitsbereich. 

Hier tragen Sie Daten ein, nehmen Berechnungen vor etc. 
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Informationen dazu finden Sie im Rest dieses Handbuchs, insbesondere im Kapitel 

„Bearbeiten einer Tabelle“ ab Seite 57. 

Arbeitsblattregister 

Unterhalb des Dokuments wird das Arbeitsblattregister angezeigt. 

Ein PlanMaker-Dokument kann aus mehreren Tabellenblättern bestehen, die – wie 

ein Stapel Papier – aufeinander gestapelt sind. Diese werden Arbeitsblätter ge-

nannt. Mit dem Arbeitsblattregister können Sie zwischen den einzelnen Arbeits-

blättern eines Dokuments wechseln, neue Blätter anlegen und Blätter löschen (sie-

he Abschnitt „Arbeiten mit mehreren Arbeitsblättern“ ab Seite 83). 

 

In obiger Abbildung sehen Sie, wie das Arbeitsblattregister bei einer Arbeitsmappe 

mit drei Arbeitsblättern aussieht. Das momentan aktive Blatt „Tabelle1“ ist hervor-

gehoben. 

Statuszeile 

Am unteren Ende des PlanMaker-Fensters befindet sich die Statuszeile. 

 

Bewegen Sie die Maus über die Schaltflächen einer Symbolleiste oder über die 

Befehle eines Menüs, wird in der Statuszeile eine kurze Erläuterung dazu ausgege-

ben. 

Weiterhin werden in der Statuszeile folgende Informationen angezeigt (von links 

nach rechts): 

Beispiel Erläuterung 

 Ganz links werden unterschiedliche Informationen angezeigt. Zeigen 

Sie beispielsweise auf ein Symbol der Funktionsleiste, wird hier die 

Funktion dieses Symbols eingeblendet. 

Tabelle1 Rechts daneben wird der Name des aktuellen Arbeitsblatts angezeigt. 
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Summe=6 Daneben wird die sogenannte Online-Berechnung angezeigt. Ist nur 

eine Zelle markiert, wird ihr Inhalt angezeigt. Sind mehrere Zellen 

markiert, wird die Summe der Zellinhalte angezeigt (siehe auch Op-

tion Online-Berechnung in Statuszeile in den Einstellungen). 

 
Dieses Symbol leuchtet auf, wenn die Tabelle einen zirkulären Be-

zug enthält. Dies weist normalerweise auf eine fehlerhaft formulierte 

Formel hin – zum Beispiel eine Rechenformel in Zelle A1, die sich 

auf die Zelle A1 bezieht. 

 Wenn Sie dieses Symbol anklicken, springt der Zellrahmen auf die 

Zelle mit dem zirkulären Bezug. Klicken Sie erneut, springt er auf 

die nächste derartige Zelle (falls mehrere vorhanden sind). 

EINF Zeigt an, ob der Einfügemodus (EINF) oder der Überschreibmodus 

(ÜB) aktiv ist. Dadurch bestimmen Sie, was beim Editieren einer 

Zelle mit dem alten Zellinhalt passieren soll: 

 EINF: Der Einfügemodus ist aktiv – neu eingegebener Text wird 

also vor dem bestehenden Text eingefügt. 

 ÜB: Der Überschreibmodus ist aktiv – neu eingegebener Text über-

schreibt also den bestehenden Text. 

 Die Standardeinstellung ist EINF. Mit der Taste (Einfg) können Sie 

zwischen diesen beiden Modi umschalten. 

AUTO Zeigt den aktuellen Eingabemodus von PlanMaker an: 

 AUTO: Der normaler Eingabemodus ist aktiv – Zahlen werden au-

tomatisch als Zahlen erkannt, und Formeln werden automatisch als 

Formeln erkannt. Dies ist die Standardeinstellung. 

 TEXT: Der Text-Eingabemodus ist aktiv – sämtliche Eingaben wer-

den in Text umgewandelt (auch Zahlen und Formeln). 

 Um zwischen diesen beiden Modi zu wechseln, klicken Sie auf den 

Text „AUTO“ in der Statuszeile oder betätigen die Tastenkombinati-

on (Strg)(ª)(F4). 

 Wichtig: Wenn Sie in den TEXT-Eingabemodus umschalten, wird 

allen Zahlen und Formeln, die Sie eingeben, automatisch ein einfa-

ches Anführungszeichen (') vorangestellt. Dadurch werden diese in 

Text umgewandelt und können nicht mehr für Berechnungen ver-

wendet werden. (Um aus so umgewandelten Zahlen/Formeln wieder 

normale Zahlen/Formeln zu machen, wechseln Sie wieder zurück in 

den AUTO-Modus und entfernen diese Anführungszeichen.) 
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Grundlagen 

Dieses Kapitel stellt Ihnen kurz die wichtigsten grundlegenden Funktionen von 

PlanMaker vor und erläutert Grundbegriffe der Tabellenkalkulation. Anwender, die 

keine oder nur wenig Erfahrung im Umgang mit einer Tabellenkalkulation haben, 

sollten diese Informationen unbedingt lesen. 

Folgende Themen werden in diesem Kapitel behandelt: 

 Der Aufbau einer Tabelle 

 Zunächst erfahren Sie, wie Tabellen überhaupt aufgebaut sind. 

 Bewegen in einer Tabelle 

 Anschließend geht es darum, wie Sie in einer Tabelle navigieren können. 

 Daten eingeben und Daten löschen 

 In den nächsten beiden Abschnitten lernen Sie Methoden zum Eingeben und 

Löschen von Daten kennen. 

 Änderungen rückgängig machen 

 Hier erfahren Sie, wie Sie Änderungen am Dokument wieder rückgängig ma-

chen können. 

 Neues Dokument beginnen 

 Dieser Abschnitt stellt den Befehl Datei > Neu vor, mit dem Sie ein neues Do-

kument anlegen können. 

 Dokument öffnen, Dokument drucken und Dokument speichern 

 In diesen drei Abschnitten geht es um das Öffnen, das Drucken und das Spei-

chern von Dokumenten. 

Lesen Sie dazu die nächsten Seiten. 

Der Aufbau einer Tabelle 

Um PlanMaker beim Durcharbeiten dieses Kapitels gleich ausprobieren zu können, 

sollten Sie ihn jetzt starten.  
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Wie Sie an der Abbildung schon erkennen können, sind Tabellen in Zeilen und 

Spalten aufgeteilt. Jede Tabelle besteht aus 65536 Zeilen und 256 Spalten. Diese 

sind wie folgt beschriftet: 

 Die Zeilen sind mit Nummern von 1 bis 65536 durchnummeriert. 

 Die Spalten sind mit Buchstaben gekennzeichnet: A bis Z, dann AA bis AZ, BA 

bis BZ etc. 

Durch diese Aufteilung in Zeilen und Spalten entsteht ein Netz aus „Kästchen“. 

Diese Kästchen werden die Zellen der Tabelle genannt.  

Jede Zelle hat exakte „Koordinaten“: „B5“ bezeichnet beispielsweise die Zelle in 

der fünften Zeile der Spalte B (also der zweiten Spalte). „A3“ wäre die Zelle in der 

dritten Zeile der Spalte A etc. 

Diese Koordinaten einer Zelle nennt man die Adresse dieser Zelle.  

Die Zelladresse ist sehr wichtig, denn Berechnungen beziehen sich oft auf andere 

Zellen: Wenn Sie beispielsweise in Zelle A2 ausrechnen möchten, wie groß der 

doppelte Wert der Zelle A1 ist, so tippen Sie einfach in Zelle A2 ein: =A1*2.  

In A2 wird nun stets der doppelte Wert von A1 ausgegeben. Wenn Sie den Wert in 

A1 ändern, wird diese Berechnung automatisch aktualisiert. 
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Bewegen in einer Tabelle 

Wenn Sie in PlanMaker etwas eingeben, landet diese Eingabe stets in der aktuellen 

Zelle. Welche Zelle dies ist, zeigt ein kleiner dunklerer Rahmen, der die Zelle 

umgibt – der Zellrahmen.  

 

Um den Zellrahmen zu einer anderen Zelle zu verschieben, gehen Sie wie folgt 

vor: 

Maus: Klicken Sie die gewünschte Zelle an. 

Tastatur: Über die Tastatur können Sie den Zellrahmen mit den Richtungstasten 

verschieben. Eine Tabelle aller verfügbaren Tasten finden Sie im Abschnitt 

„Tastenkürzel zum Editieren von Tabellen“ ab Seite 753. 

Daten eingeben 

Um in eine Zelle etwas einzugeben, steuern Sie die gewünschte Zelle mit den 

Richtungstasten oder per Mausklick an und beginnen mit dem Tippen. 

Um Ihre Eingabe abzuschließen, drücken Sie die Eingabetaste (¢).  

Wenn Sie einen Eingabefehler gemacht haben, ist das kein Problem: Drücken Sie 

nach der Eingabe statt (¢) die Taste (Esc), worauf PlanMaker vergisst, was Sie 

getippt haben, und den alten Zellinhalt wiederherstellt.  

Alternativ können Sie Eingaben auch über die folgenden Schaltflächen der Bear-

beitungsleiste abschließen: 

 Klicken Sie auf , um die Eingabe zu übernehmen. 

 Oder klicken Sie auf , um die Eingabe zu verwerfen. 

Um den Inhalt einer bereits ausgefüllten Zelle nachträglich zu bearbeiten, steuern 

Sie die Zelle an und betätigen die Taste (F2). Alternativ können Sie auch einfach 

einen Doppelklick auf die Zelle ausführen.  

Ausführliche Informationen zu diesem Thema finden Sie im Abschnitt „Daten in 

Zellen eingeben“ ab Seite 60. 
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Daten löschen 

Es gibt mehrere Möglichkeiten, Daten aus einem Dokument zu löschen: 

 Löschen von Teilen des Inhalts einer Zelle 

 Um nur einen Teil des Inhalts einer Zelle zu löschen, steuern Sie diese an und 

drücken die Taste (F2) zum Bearbeiten des Inhalts. Nun können Sie den Inhalt 

editieren, also beispielsweise auch Zeichen löschen. 

 Löschen des kompletten Inhalts einer Zelle 

 Um den kompletten Inhalt einer Zelle zu löschen, steuern Sie diese an und drü-

cken dann die Taste (Entf) oder rufen den Befehl Bearbeiten > Löschen auf. 

 Löschen des Inhalts mehrerer Zellen 

 Mehrere Zellen lassen sich auf die gleiche Weise löschen; Sie müssen diese 

lediglich zuvor markieren (siehe Abschnitt „Markieren von Zellen“ ab Seite 

64). 

Ausführlichere Informationen zu diesem Thema finden Sie im Abschnitt „Löschen 

von Zellen und Zellinhalten“ ab Seite 67. 

Änderungen rückgängig machen 

Mit dem Befehl Bearbeiten > Rückgängig können Sie die zuletzt an einem Do-

kument durchgeführten Änderungen widerrufen. Formatieren Sie also beispiels-

weise Zellen in einer anderen Schrift, brauchen Sie nur Bearbeiten > Rückgängig 

aufzurufen, und schon wird dies wieder aufgehoben.  

Der Befehl Rückgängig lässt sich bei Bedarf mehrmals hintereinander anwenden. 

Rufen Sie ihn zum Beispiel fünfmal auf, werden die letzten fünf Änderungen wi-

derrufen. 

Wiederherstellen von widerrufenen Aktionen 

Es gibt auch ein Gegenstück zum Befehl Rückgängig: den Befehl Bearbeiten > 

Wiederherstellen. Er stellt die zuletzt von Ihnen widerrufene Aktion wieder her. 

So können Sie also das Widerrufen von Änderungen widerrufen. 
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Ausführliche Informationen zu diesem Thema finden Sie im Abschnitt 

„Änderungen rückgängig machen“ ab Seite 63).  

Neues Dokument beginnen 

Wenn Sie ein neues Dokument beginnen möchten, rufen Sie den Befehl Datei > 

Neu auf oder drücken das Tastenkürzel für diesen Befehl: (Strg)(N). 

Es erscheint ein Dialogfenster, in dem Sie eine Dokumentvorlage für die Tabelle 

wählen können. Wenn Sie einfach eine normale Tabelle ohne weitere Vorgaben 

erstellen möchten, wählen Sie die Standardvorlage NORMAL.PMV.  

Sobald Sie mit OK bestätigen, wird das neue Dokument angelegt. 

Neues Fenster: Wenn im Dialogfenster dieses Befehls der Schalter Neues Fenster 

eingeschaltet ist, erscheint das neue Dokument dabei in einem neuen Dokument-

fenster. Andernfalls wird das Dokument im aktuellen Fenster geschlossen und das 

neue Dokument im selben Fenster angelegt. 

Informationen zur Verwendung von Dokumentvorlagen können Sie später im Ab-

schnitt „Dokumentvorlagen“ ab Seite 181 nachlesen. 

Dokument öffnen 

Um ein Dokument zu öffnen, rufen Sie den Befehl Öffnen im Menü Datei auf oder 

drücken (Strg)(O).  

Es erscheint ein Dialogfenster, das beispielsweise wie folgt aussehen kann: 



 

38    Grundlagen Handbuch PlanMaker 

 

Je nach Betriebssystem ist dieses Dialogfenster etwas anders gestaltet, seine Funk-

tion ist aber immer die gleiche: Über diesen Dialog teilen Sie PlanMaker mit, wel-

ches Dokument geöffnet werden soll. 

Dazu könnten Sie einfach den Namen der zu öffnenden Datei von Hand eintippen. 

Über die Auswahlliste mit den Dateien geht dies allerdings komfortabler, denn hier 

werden alle Dateien im aktuellen Ordner aufgelistet und können bequem ausge-

wählt werden. 

Neues Fenster: Um ein Dokument in einem neuen Dokumentfenster zu öffnen, müs-

sen Sie den Schalter Neues Fenster aktiviert haben. Ansonsten wird das Dokument 

im aktuellen Fenster geschlossen und die Datei im selben Fenster geöffnet. 

Andere Dateiformate öffnen 

PlanMaker kann nicht nur seine eigenen Dokumente, sondern auch Dateien anderer 

Programme öffnen. Sie müssen dazu lediglich das gewünschte Format in der Liste 



 

Handbuch PlanMaker Grundlagen    39 

Dateityp auswählen. Informationen über die unterstützten Formate finden Sie im 

Kapitel „Fremdformate“ ab Seite 363. 

Schnellwahlpfade verwenden 

Über die Schaltfläche Schnellwahlpfad können Sie Schnellwahlpfade anlegen und 

abrufen, um beim Öffnen oder Speichern von Dateien blitzschnell in einen be-

stimmten Ordner wechseln zu können. Informationen hierzu finden Sie im Ab-

schnitt „Schnellwahlpfade“ ab Seite 325. 

Dateimanager 

Über die Schaltfläche Dateimanager können Sie den integrierten Dateimanager 

aufrufen. Dieser zeigt eine Liste Ihrer Dokumente an und lässt Sie diese nicht nur 

öffnen, drucken, ansehen oder löschen, sondern auch durchsuchen (siehe Abschnitt 

„Dateimanager“ ab Seite 328). 

Vorschau auf ein Dokument 

Wenn Sie im Öffnen-Dialog ein Dokument ausgewählt haben, sich aber nicht si-

cher sind, ob es sich tatsächlich um das gewünschte Dokument handelt, klicken Sie 

einfach auf Vorschau. Es öffnet sich dann ein Fenster, in dem der Inhalt der Datei 

angezeigt wird. 

Liste der zuletzt geöffneten Dateien 

Tipp: Am unteren Ende des Menüs Datei finden Sie eine Liste der zuletzt geöffne-

ten Dateien. Um eine dieser Dateien erneut zu öffnen, klicken Sie sie einfach an. 

Dokument drucken 

Wenn Sie das aktuelle Dokument ausdrucken möchten, rufen Sie den Befehl Datei 

> Drucken auf oder drücken (Strg)(P). 

Es erscheint ein Dialogfenster, in dem Sie unter anderem einstellen können, welche 

Bestandteile des Dokuments gedruckt werden sollen. 



 

40    Grundlagen Handbuch PlanMaker 

Ausführliche Informationen zum Ausgeben Ihrer Dokumente finden Sie im Kapitel 

„Ausgeben von Dokumenten“ (Seite 343). 

Dokument speichern 

Haben Sie ein Dokument fertiggestellt, sollten Sie dieses speichern, um es dauer-

haft zu erhalten.  

Den Befehl Speichern finden Sie im Menü Datei. Er lässt sich auch mit der Tas-

tenkombination (Strg)(S) aufrufen und sichert das Dokument im aktuellen Fenster 

unter seinem Dateinamen.  

Sollte das Dokument noch keinen Namen besitzen, fordert Sie PlanMaker vor dem 

Speichern automatisch auf, einen Dateinamen zu vergeben. 

Speichern unter einem anderen Namen/an einem anderen Ort 

PlanMaker verfügt außerdem über den Befehl Datei > Speichern unter. Dieser 

sichert Ihr Dokument ebenfalls, jedoch können Sie ihm zuvor einen anderen Datei-

namen geben oder einen anderen Ordner zum Speichern wählen. 

Speichern in einem anderen Dateiformat 

Sie können ein Dokument mit Datei > Speichern unter auch im Dateiformat eines 

anderen Programms speichern. Wählen Sie dazu das gewünschte Format in der 

Liste Dateityp (siehe Kapitel „Fremdformate“ ab Seite 363). 

Speichern aller geöffneten Dokumente 

Haben Sie mehrere Dokumentfenster gleichzeitig geöffnet, können Sie den Befehl 

Datei > Alles speichern verwenden, um die Dokumente in allen Fenstern spei-

chern zu lassen. PlanMaker prüft nach, ob die Dokumente seit dem letzten Spei-

chern geändert wurden, und speichert nur die Dokumente, bei denen dies der Fall 

ist. 
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Arbeit beenden 

Wenn Sie PlanMaker beenden möchten, rufen Sie Datei > Beenden auf.  

Wurde eines der geöffneten Dokumente seit seiner letzten Speicherung verändert, 

fragt PlanMaker automatisch nach, ob Sie es zuvor noch speichern möchten. 
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Die PlanMaker-Tour 

Willkommen bei der PlanMaker-Tour!  

Auf den nächsten Seiten werden Sie PlanMaker noch etwas näher kennenlernen als 

im Kapitel „Grundlagen“. Anwender, die keine oder nur wenig Erfahrung im Um-

gang mit Tabellenkalkulationen haben, sollten die nächsten Seiten unbedingt lesen.  

Auch fortgeschrittene Anwender sollten dieses Kapitel zumindest überfliegen – Sie 

werden darin einige nützliche Tipps finden, die Ihnen die Bedienung von PlanMa-

ker erleichtern. 

Anmerkung: Die Abbildungen in diesem Handbuch wurden größtenteils mit der 

Windows-Version von PlanMaker angefertigt. Unter anderen Betriebssystemen 

sehen manche Bedienelemente zwar etwas anders aus, die Funktionsweise ist je-

doch die gleiche. 

Zu Beginn fünf Minuten Theorie 

Das Thema „Rechnen und Computer“ erschließt sich am besten von einem kleinen 

Rückblick her. Denn gerade über das Gebiet „Rechnen“ erfolgte ursprünglich der 

Siegeszug der Computertechnik in die Haushalte und Büros. Den ersten zaghaften 

Vorstoß unternahmen die Taschenrechner. Sie sind sicherlich eine große Hilfe, aber 

gerade an ihren Nachteilen lässt sich gut zeigen, wo die Stärken einer Tabellenkal-

kulation liegen: 

Wenn Sie beispielsweise einen Computerkauf planen, müssen Sie diverse Angebo-

te vergleichen, die jeweils aus verschiedenen Einzelposten bestehen: Sie brauchen 

beispielsweise einen PC, einen Monitor und einen Drucker. Beim einen Anbieter 

ist der PC sehr günstig, beim anderen gibt es den Monitor billiger etc. Welches 

Angebot ist nun das günstigste? 

Um dies herauszufinden, müssen Sie fleißig addieren. Dazu zücken Sie den Ta-

schenrechner, addieren Zahl für Zahl, notieren das Ergebnis – und ärgern sich. 

Denn bei jedem neuen Angebot beginnt das gleiche Spiel von vorn. Selbst dann, 

wenn die meisten Zahlen gleich bleiben sollten. 

Mit einer Tabellenkalkulation lassen sich derartige Kalkulationen komfortabler 

durchführen. 
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Die erste Technik, der Sie beim Arbeiten mit PlanMaker begegnen werden, ist der 

Einsatz von „Variablen“. Variablen helfen dabei, Formeln – in unserem Beispiel 

einfache Additionen – zunächst einmal ohne Zahlen zu notieren. Dies könnte so 

aussehen: 

PC + Monitor + Drucker = Gesamtpreis  

Ein wenig abstrakter ausgedrückt – so, wie wir es alle einmal im Mathematikunter-

richt gelernt haben – heißt unsere Formel also: 

a + b + c = d 

Praktischen Nutzen hat solch eine Formel beim Rechnen ohne Tabellenkalkulation 

nur, wenn Sie beispielsweise einen programmierbaren Taschenrechner besitzen – in 

den können Sie dann die Formel eintippen, und er fragt Angebot für Angebot die 

Einzelpreise ab, um daraus automatisch die Summe zu berechnen. Allzu viel ge-

wonnen ist damit allerdings noch nicht... 

Erste Schritte mit PlanMaker 

Nach diesen Vorüberlegungen ist es nun an der Zeit, sich einmal anzusehen, wie 

solche Aufgaben mit PlanMaker gelöst werden können. 

Starten Sie dazu PlanMaker jetzt. 

Unter Windows sieht PlanMaker wie folgt aus: 
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Den größten Teil des Programmfensters nimmt das Arbeitsblatt ein. Oben ist es 

durch eine Leiste mit Buchstaben begrenzt, links durch eine Leiste mit Zahlen. 

Sehen wir uns ein solches Arbeitsblatt einmal etwas genauer an: 

Der Aufbau einer Tabelle 

Wie Sie aus dem Kapitel „Grundlagen“ bereits wissen, ist ein Arbeitsblatt (wir 

nennen es meist einfach „Tabelle“) in Zeilen und Spalten aufgeteilt. Die grauen 

Linien, die in der Tabelle zu sehen sind, deuten dies auch an.  

Die Zelle in der linken oberen Ecke ist mit einem dunkleren Rahmen umgeben. 

Dieser wird Zellrahmen genannt. Er zeigt an, welche Zelle gerade aktiv ist. Wenn 

Sie etwas eintippen, landet das immer in der Zelle, auf der sich der Zellrahmen 

befindet. 

 

Drücken Sie nun einige Male die Tasten (¼) und (Æ), um den Zellrahmen zu be-

wegen.  

Achten Sie dabei auf das Anzeigefeld links oberhalb der Tabelle: Dort zeigt Plan-

Maker die Adresse der Zelle an, auf der sich der Zellrahmen gerade befindet. Die 

Adresse besteht immer aus ein bis zwei Buchstaben und einer Zahl:  
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„A1“ bedeutet „Spalte 1, Zeile 1“. 

„A5“ bedeutet „Spalte 1, Zeile 5“. 

„D5“ bedeutet „Spalte 4, Zeile 5“ etc. 

Die Tatsache, dass jede Zelle eine eindeutige Adresse hat, ist der Schlüssel zu allen 

Funktionen der Tabellenkalkulation: Sie können dadurch in jede beliebige Zelle 

Berechnungen eingeben, die sich auf andere Zellen beziehen – also beispielsweise 

die Summe von Zellen bilden. Dabei brauchen Sie nicht einmal mit Variablen wie 

a, b, c zu hantieren, sondern verwenden einfach die Koordinaten der Zellen. 

Dies verhält sich so, als würden Sie jemandem ein Arbeitsblatt übergeben und ihn 

beispielsweise auffordern: „Addiere bitte die Zahlen in der zweiten, dritten und 

vierten Zeile der zweiten Spalte“. 

Eingeben von Werten und Formeln 

Genug der Theorie. Lassen Sie uns nun die erste Berechnung durchführen. 

Zuerst tippen wir den Preis für den PC, darunter den Preis für den Monitor und 

darunter den Preis für den Drucker ein. 

Steuern Sie also die Zelle B2 an und tippen Sie den Wert 799 ein. Der Wert er-

scheint sowohl in der gewählten Zelle als auch in der Bearbeitungsleiste oberhalb 

der Tabelle.  

Hinweis: Übernehmen Sie bitte beim Eingeben von Zahlen nicht die alte 

Schreibmaschinengewohnheit, statt der Zahl „0“ den Buchstaben „O“ oder „o“ 

zu tippen – PlanMaker unterscheidet nämlich penibel zwischen Zahlen und 

Buchstaben. Der Buchstabe „O“ ist für das Programm keine Zahl. PlanMaker 

akzeptiert Ihre Eingabe zwar, interpretiert sie aber als Text und kann dement-

sprechend keine Berechnungen damit anstellen. 

Drücken Sie nun die Eingabetaste (¢), um Ihre Eingabe abzuschließen. Der Zell-

rahmen wandert automatisch um eine Zeile nach unten in die Zelle B3. Tragen Sie 

hier den Wert 425 und in der Zelle darunter den Wert 199 ein. 
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Tipp: Wenn Sie einmal in eine Zelle etwas Falsches eingegeben und bereits die 

Eingabetaste (¢) gedrückt haben, ist dies nicht weiter schlimm. Steuern Sie die 

Zelle mit den Pfeiltasten an und tippen Sie den richtigen Inhalt ein. Drücken Sie 

dann (¢), und der Zellinhalt wird überschrieben. Sie können den Inhalt bereits 

ausgefüllter Zellen auch editieren: drücken Sie dazu in der Zelle die Taste (F2). 

Eingeben von Rechenformeln 

Nun geht es an die erste Rechenformel: 

Um die Gesamtkosten für unsere Computerausstattung auszurechnen, müssen wir 

die gerade eingetippten Einzelpreise addieren. Und das geht denkbar einfach: 

Steuern Sie die Zelle B5 an und tippen Sie erst ein Gleichheitszeichen = ein. Das 

Gleichheitszeichen ist nämlich für PlanMaker das Signal, dass Sie nun eine Formel 

in diese Zelle eingeben möchten. 

Als nächstes tippen Sie die Rechenformel ein. Dazu arbeiten Sie, wie schon ange-

deutet, mit den Adressen der Zellen als „Variablen“. Die Eingabe lautet somit: 

=B2+B3+B4 

Die Buchstaben dürfen wahlweise als Groß- oder als Kleinbuchstaben getippt wer-

den.  

Wenn Sie die Eingabetaste (¢) drücken, erscheint sofort das Ergebnis der Berech-

nung in der Zelle: 

 

Probieren Sie nun einmal aus, was geschieht, wenn Sie die Zahlen in den Zellen 

auswechseln. Steuern Sie beispielsweise die „425“ einmal an und tippen Sie „259“ 

oder einen beliebigen anderen Wert ein. Drücken Sie dann wieder (¢) und be-

obachten Sie, was passiert: Sobald Sie den Zellinhalt ersetzen, wird sofort das Er-

gebnis der Summenberechnung aktualisiert.  

Sie sehen: Egal, was in den Zellen B2, B3 und B4 steht, PlanMaker addiert es brav 

zusammen. Ändert sich bei einem Computer-Angebot also beispielsweise nur der 
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Preis für den Drucker, brauchen Sie diesen nur zu ändern und schon steht in Zelle 

B5 der neue Gesamtpreis. 

Die Funktion „SUMME“ 

Die vorgestellte Methode zum Berechnen der Summe war nun sicherlich zweck-

mäßig, aber noch nicht allzu komfortabel. Stellen Sie sich einmal vor, es wären 

nicht drei, sondern 50 Zahlen zu addieren – das gäbe eine lange Formel zu tippen! 

Zum Glück gibt es hier Alternativen: die Rechenfunktionen von PlanMaker. 

Um eine davon kennen zu lernen, steuern Sie noch einmal die Zelle B5 mit der 

Rechenformel an.  

Löschen Sie erst den Inhalt, indem Sie die Taste (Entf) drücken – oder überschrei-

ben Sie den Zellinhalt einfach. Tippen Sie folgende Formel ein: 

=SUMME(B2:B4) 

Nach dem Betätigen der Eingabetaste (¢) steht das Ergebnis der Berechnung in 

der Zelle: die Summe der Zellen B2 bis B4. 

PlanMaker kennt eine ganze Reihe von Rechenfunktionen – und eine davon ist 

SUMME. Diese ermittelt, wie der Name schon sagt, die Summe von Werten. Der 

eingeklammerte Ausdruck hinter dem Funktionsnamen sagt PlanMaker, wo er mit 

dem Summieren beginnen und aufhören soll:  

Der Start soll in diesem Fall bei der Zelle B2 liegen und das Ende der zu addieren-

den Zahlenkolonne bei B4. Dazwischen liegt in diesem Fall nur die Zahl in B3, 

aber die Summenfunktion würde auch mit Angaben wie B2:B123 funktionieren. 

Die Schreibweise Startzelle:Endzelle funktioniert übrigens auch zeilen- und spal-

tenübergreifend. Wenn Sie beispielsweise als Startzelle B2 und als Endzelle C4 

eingeben, so bilden diese beiden Koordinaten in der Tabelle die Eckpunkte eines 

Rechtecks. Die Formel =SUMME(B2:C4) berechnet also die Summe aller in die-

sem Rechteck enthaltenen Zahlen. 

Verwendung des Summensymbols 

Das Einfügen einer Summenformel geht aber noch einfacher: 

Löschen Sie noch einmal die Formel in Zelle B5. 

Klicken Sie dann das Summensymbol  in der Bearbeitungsleiste an. Führen Sie 

den Mauszeiger dann auf Zelle B2 und markieren Sie durch Überstreichen bei ge-

drückter linker Maustaste die Zellen B2, B3 und B4.  
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Der Mauszeiger hat sich dabei in eine Hand verwandelt – und wenn Sie die Bear-

beitungsleiste beobachten, sehen Sie, wie in der Formel ganz automatisch die Be-

reichsangabe erscheint, die Sie gerade mit der Maus markieren. Wenn alles stimmt, 

lassen Sie die Maustaste los und übernehmen die fertige Formel mit der Eingabe-

taste (¢).  

Wie Sie sehen, gibt es mehrere Methoden, um Formeln in PlanMaker einzugeben. 

Alle Methoden haben ihre besonderen Vor- und Nachteile, liefern aber das gleiche 

Ergebnis. Für welche Methode Sie sich entscheiden, liegt ganz bei Ihnen. 

Formelvielfalt 

Die Grundzüge der Arbeit mit einer Tabellenkalkulation haben Sie nun bereits ken-

nengelernt. 

Damit Sie einen Eindruck von der Vielzahl der Formeln bekommen, die in Plan-

Maker zur Verfügung stehen, können Sie einmal den Befehl Einfügen > Funktion 

aufrufen. 

Es erscheint nun ein Dialogfenster mit einer Liste aller Rechenfunktionen, die 

PlanMaker beherrscht. 
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Tipp: Bei der Windows-Version von PlanMaker können Sie eine Hilfeseite zu 

jeder Rechenfunktion abrufen, indem Sie die Funktion in obigem Dialog ankli-

cken und dann die Taste (F1) drücken. 

Probieren wir noch ein Beispiel aus: Wir berechnen den Mittelwert unserer drei 

Zahlen in der Tabelle: 

Verlassen Sie dazu das Dialogfenster und löschen Sie noch einmal den Inhalt von 

B5.  

Rufen Sie dann den Befehl Einfügen > Funktion auf. Wählen Sie in der linken 

Liste die Kategorie „Alle Funktionen“. Durchblättern Sie dann die rechte Liste mit 

Hilfe des Rollbalkens, bis die Funktion „Mittelwert“ zu sehen ist. Klicken Sie dann 

doppelt auf „Mittelwert“.  

Im Eingabefeld des Dialogs hat PlanMaker nun automatisch die Zeile 

Mittelwert() 

eingesetzt. Um die Formel zu vervollständigen, tippen Sie wieder B2:B4 ein.  

Alternativ können Sie auch hier einfach den gewünschten Bereich direkt in der 

Tabelle mit der Maus markieren, also die Maus bei gedrückter linken Maustaste 

über die Zellen B2 bis B4 ziehen. Sie wissen ja schon, wie das geht. Falls das Dia-

logfenster im Weg sein sollte, ziehen Sie es einfach beiseite, indem Sie auf seine 

Titelleiste klicken und es dann bei gedrückter Maustaste verschieben. 

Die fertige Formel sieht schließlich wie folgt aus: 
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=Mittelwert(B2:B4) 

Klicken Sie auf Einfügen, wird diese Formel in Zelle B5 übertragen und sofort 

ausgerechnet. 

Zwei der über 330 Rechenfunktionen von PlanMaker haben Sie nun kennenge-

lernt. Eine Liste aller Funktionen mit ausführlicher Beschreibung finden Sie übri-

gens im Abschnitt „Funktionen von A-Z“, der auf Seite 455 beginnt. 

Die dritte Dimension 

Tabellen müssen nicht unbedingt aus nur einem einzigen Arbeitsblatt bestehen. Es 

ist auch möglich, mehrere Arbeitsblätter quasi hintereinander zu legen – wie bei 

einem Stapel Papier. Wir nennen ein PlanMaker-Dokument deshalb auch eine Ar-

beitsmappe. Jede Arbeitsmappe kann bis zu 256 Arbeitsblätter enthalten. 

Der Clou dabei: Berechnungen in einem Arbeitsblatt können sich auch auf Zellen 

anderer Arbeitsblätter beziehen, was Ihnen ermöglicht quasi „dreidimensionale“ 

Berechnungen durchzuführen. 

Ein Beispiel: Sie erfassen auf drei Arbeitsblättern die Bilanzen mehrerer Filialen 

Ihrer Firma. Nun könnten Sie ein viertes Arbeitsblatt anlegen und darauf bei-

spielsweise die Summe der Ergebnisse auf den drei anderen Blättern berechnen. 

Wenn Sie ein neues Arbeitsblatt anlegen möchten, rufen Sie den Befehl Tabelle > 

Blatt > Einfügen auf. Um zwischen den vorhandenen Blättern zu wechseln, kön-

nen Sie das Arbeitsblattregister am unteren Fensterrand verwenden.  

 

Klicken Sie das gewünschte Arbeitsblatt dort einfach mit der Maus an.  

Weitere Informationen zu diesem Thema finden Sie im Abschnitt „Arbeiten mit 

mehreren Arbeitsblättern“ ab Seite 83. 

Tabellen gestalten 

Kehren wir noch einmal zu unserer ersten Beispieltabelle zurück. Gut rechnen ließ 

es sich mit ihr, aber von der Gestaltung her sieht sie bislang nicht gerade anspre-

chend aus. Dabei verfügt PlanMaker doch über äußerst leistungsfähige Möglich-

keiten zur optischen Aufbereitung von Tabellen.  
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Probieren wir einige davon einmal aus: 

Überschrift hinzufügen 

Was unserer Tabelle auf jeden Fall fehlt, ist eine Überschrift. Tragen wir also ein-

fach in eine Zelle oberhalb der Zahlen einen entsprechenden Text ein und formatie-

ren diesen in einer größeren Schrift. 

Setzen Sie den Zellrahmen dazu auf die Zelle B1. Tippen Sie dann zum Beispiel 

folgenden Text: 

Meine erste Tabelle(¢) 

Zeichenformatierung ändern 

Jetzt sollten wir vielleicht noch eine andere Schrift für die Überschrift wählen und 

sie vor allem deutlich größer machen. 

Bewegen Sie den Zellrahmen dazu wieder in die Zelle B1 mit der Überschrift zu-

rück. Klappen Sie dann die Schriftenliste in der Formatleiste auf, indem Sie das 

kleine Pfeilchen rechts neben dem Schriftnamen anklicken.  

 

Es erscheint eine Liste aller auf Ihrem Rechner installierten Schriften. Wählen Sie 

beispielsweise die Schriftart „Tahoma“. Öffnen Sie dann die Liste mit den Schrift-

größen rechts daneben und wählen Sie die Größe 24 Punkt.  
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Rechts daneben könnten Sie auf Wunsch noch die Schriftfarbe einstellen, und noch 

ein Stück weiter rechts finden Sie drei mit F, K und U beschriftete Schaltflächen 

zum Ein-/Ausschalten von Fettdruck, Kursivschrift und Unterstreichen. 

Zahlenformatierung ändern 

In einer Tabellenkalkulation finden Sie natürlich auch umfangreiche Möglichkeiten 

zum Formatieren von Zahlen. Sie können nicht nur Zeichenformat von Zahlen än-

dern (Schriftart, Schriftgröße etc.), sondern auch deren Zahlenformat. 

Probieren Sie es aus: In den Zellen B2 bis B5 stehen Geldbeträge, also sollen diese 

auch wie Geldbeträge angezeigt werden:  

Markieren Sie dazu einfach die Zellen B2 bis B5 und rufen Sie Format > Zelle 

auf. Es erscheint ein Dialog mit zahlreichen Einstellungsmöglichkeiten. Uns inte-

ressiert aber nur die erste Karteikarte: die Karteikarte Zahlenformat. Wählen Sie 

darin in der Liste den Eintrag „Währung“ und bestätigen Sie mit OK.  

Das Ergebnis: PlanMaker versieht die Zahlen nun mit einem Währungssymbol – 

und zeigt sie mit zwei Nachkommastellen an, wie das bei Geldbeträgen üblich ist. 

Es gibt viele weitere Einstellungen zum Zahlenformat, mit denen Sie das Erschei-

nungsbild von Zahlen ändern können. So lässt sich beispielsweise die Anzahl der 

angezeigten Nachkommastellen einstellen, Zahlen können als Prozentwerte darge-

stellt werden etc. Wichtig: Die Zahl in der entsprechenden Zelle bleibt dabei stets 

unverändert – es ändert sich lediglich ihre Darstellung. 

Einen kleinen Teil der Funktionen zum Gestalten von Tabellen haben Sie jetzt ken-

nengelernt. Wie Sie sich denken können, gibt es noch viele weitere Möglichkeiten, 

Tabellen optisch aufzuwerten und übersichtlicher zu machen. Alle Informationen 

dazu finden Sie im Kapitel „Gestalten einer Tabelle“, das auf Seite 137 beginnt.  

Diagramme 

Werfen wir zum Schluss unserer kleinen PlanMaker-Tour noch einen Blick auf 

Diagramme. 

Zahlenkolonnen machen es einem oft schwer, ihre wirkliche Bedeutung zu erken-

nen. PlanMaker hat deshalb zur optischen Aufbereitung der Daten aus Ihren Tabel-

len ein eigenes Diagramm-Modul aufzuweisen. 
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Um ein Diagramm einzufügen, markieren Sie die darzustellenden Werte und rufen 

den Befehl Objekt > Neuer Diagrammrahmen auf. Es erscheint ein Dialog, in 

dem Sie den gewünschten Diagrammtyp auswählen. Wenn das erledigt ist, ziehen 

Sie mit der Maus in der Tabelle ein Rechteck auf, um die Position und Größe des 

Diagramms zu bestimmen – fertig. 

 

Weitere Informationen zu diesem Thema finden Sie im Kapitel „Diagramme“ ab 

Seite 257. 

Ausblick 

Hier endet unsere kleine Einführung in PlanMaker. Die grundlegendsten Funktio-

nen haben Sie jetzt kennengelernt, alles Weitere erfahren Sie im Referenzteil des 

Handbuchs, der mit dem nächsten Kapitel beginnt.  

Der Referenzteil ist nach Sachgebieten aufgeteilt und beschreibt ausführlich alle 

Funktionen von PlanMaker. Sie müssen diesen natürlich nicht Kapitel für Kapitel 

durchlesen, um gleich alle Funktionen von PlanMaker auf einmal zu erlernen. Be-
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fassen Sie sich immer nur den Kapiteln, die Sie gerade benötigen, und erkunden 

Sie so Schritt für Schritt die Funktionen von PlanMaker. 

In diesem Sinne: Viel Spaß mit PlanMaker! 
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Bearbeiten einer Tabelle 

Mit diesem Kapitel beginnt der Referenzteil des Handbuchs, der ausführliche In-

formationen zu den einzelnen Funktionen von PlanMaker enthält und nach Sach-

gebieten geordnet ist. 

In diesem ersten Kapitel erfahren Sie, wie Sie eine Tabelle ausfüllen und bearbei-

ten. Folgende Themen werden in diesem Kapitel behandelt: 

 Daten in Zellen eingeben 

 Im ersten Abschnitt wird erläutert, was es beim Ausfüllen von Tabellenzellen 

mit Text, Zahlen, Berechnungen etc. zu beachten gibt. 

 Änderungen rückgängig machen 

 Über den Befehl Bearbeiten > Rückgängig kann man Operationen wieder 

ungeschehen machen. Der Befehl Bearbeiten > Wiederherstellen ist das Ge-

genstück dazu – er macht quasi den Befehl Rückgängig rückgängig. 

 Befehle wiederholen 

 Der Befehl Bearbeiten > Wiederholen wiederholt die Ausführung des zuletzt 

aufgerufenen Befehls mit genau den gleichen Einstellungen. 

 Markieren von Zellen 

 Hier erfahren Sie, wie man Zellen markiert: zum Beispiel durch Überstreichen 

der Zellen mit gedrückter Maustaste oder per Tastatur. 

 Löschen von Zellen und Zellinhalten 

 Sie können wahlweise mit Bearbeiten > Löschen nur die Zellinhalte löschen 

oder mit Tabelle > Zellen löschen die kompletten Zellen aus der Tabelle ent-

fernen (der Rest der Tabelle rückt dann entsprechend nach). 

 Einfügen von neuen Zellen 

 Der Befehl Tabelle > Zellen einfügen fügt neue Zellen in die Tabelle ein, wo-

bei der Rest der Tabelle automatisch verschoben wird. 

 Verschieben und Kopieren 

 Markierte Tabellenbereiche können mit den Befehlen des Menüs Bearbeiten 

oder einfach per Maus kopiert oder verschoben werden. Rechenformeln werden 

dabei automatisch angepasst. 
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 Selektives Einfügen 

 Mit dem Befehl Bearbeiten > Inhalte einfügen können Sie beim Einfügen von 

Zellen aus der Zwischenablage genau bestimmen, ob beispielsweise nur die 

Zellinhalte oder nur die Formatierung eingefügt werden soll. 

 Automatisches Füllen von Zellen 

 Mit dem Befehl Bearbeiten > Ausfüllen können Sie Zellen bequem mit 

gleichbleibenden Werten oder Wertereihen füllen. 

 Arbeiten mit mehreren Arbeitsblättern 

 Sie können in PlanMaker mehrere Arbeitsblätter – wie bei einem Stapel Papier 

– hintereinander anlegen und damit „dreidimensional“ rechnen. 

 Bereiche benennen 

 Wenn Sie Zellbereichen mit dem Befehl Tabelle > Namen einen Namen geben, 

können Sie diese Namen in Berechnungen verwenden – zum Beispiel 

=SUMME(Umsätze). 

 Sortieren 

 Mit dem Befehl Tabelle > Sortieren können Sie Tabellenzellen nach einem 

oder mehreren Kriterien sortieren lassen. 

 Transponieren 

 Der Befehl Tabelle > Transponieren vertauscht die zeilen-/spaltenweise An-

ordnung eines Zellbereichs. 

 Text in Spalten aufteilen 

 Mit dem Befehl Tabelle > Text in Spalten aufteilen können Sie Text, der sich 

in einer Tabellenzelle befindet, auf mehrere Tabellenspalten aufteilen. 

 Filtern 

 Mit dem Befehl Tabelle > Filter lässt sich ein Datenbereich nach einem oder 

mehreren Kriterien filtern. Es werden dann alle Zeilen verborgen, die den Fil-

terbedingungen nicht entsprechen. 

 Analysieren von Tabellen 

 Dieser Abschnitt stellt einige Werkzeuge vor, die für die Analyse von Tabellen 

und die Fehlersuche sehr nützlich sein können. Dazu gehören die Formelanzei-

ge, die Syntaxhervorhebung, das Beobachtungsfenster für Zellinhalte sowie 

verschiedene Funktionen zum Analysieren der Rechenformeln in einer Tabelle. 
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 Aktualisieren von Tabellen 

 Die Berechnungen in einer Tabelle werden automatisch auf dem neuesten Stand 

gehalten. Jedes Mal, wenn Sie einen Zellinhalt abändern, rechnet PlanMaker 

die gesamte Tabelle neu durch. Bei Bedarf können Sie dieses Verhalten ab-

schalten und den Befehl Weiteres > Neu berechnen verwenden, um die Tabel-

le manuell zu aktualisieren. 

 Kommentare einfügen 

 Mit dem Befehl Einfügen > Kommentar können Sie Zellen mit einem Kom-

mentar versehen. Dieser wird angezeigt, wenn Sie mit der Maus auf die Zelle 

zeigen. 

 Zielwertsuche 

 Mit dem Befehl Weiteres > Zielwertsuche können Sie durch ein Näherungs-

verfahren ermitteln, welchen Wert ein bestimmter Bestandteil einer Berechnung 

annehmen muss, damit das gewünschte Ergebnis herauskommt. 

 Szenarien 

 Der Befehl Weiteres > Szenarien erlaubt das Anlegen und Anzeigen verschie-

dener Szenarien. Mit deren Hilfe können Sie beobachten, welche Auswirkun-

gen das Ändern der Werte in bestimmten Zellen auf die Berechnungen in einem 

Arbeitsblatt hat. Dies ermöglicht das Durchführen von „Was-wäre-wenn“-

Analysen aller Art. 

 Konsolidieren von Daten 

 Mit dem Befehl Tabelle > Daten konsolidieren lassen sich Daten aus einem 

oder mehreren Zellbereichen auswerten, um beispielsweise die Summe der ein-

zelnen Daten über all diese Bereiche hinweg zu ermitteln. 

 Fixieren von Zeilen und Spalten 

 Mit dem Befehl Ansicht > Fixieren können Sie die ersten Zeilen oder Spalten 

einer Tabelle auf dem Bildschirm fixieren. Das bewirkt, dass sich diese beim 

Blättern in der Tabelle nicht mehr bewegen. Ideal für Spalten- oder Zeilenbe-

schriftungen. 

 Sonderzeichen einfügen 

 Der Befehl Einfügen > Sonderzeichen öffnet ein Dialogfenster mit allen ver-

fügbaren Zeichen einer Schrift. Mit dessen Hilfe können Sie Zeichen einfügen, 

die per Tastatur nicht erreichbar sind. 
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Ausführliche Informationen zu diesen Themen finden Sie, in obiger Reihenfolge, 

auf den nächsten Seiten. 

Daten in Zellen eingeben 

Um in eine Zelle etwas einzugeben, steuern Sie die gewünschte Zelle mit den 

Richtungstasten oder per Mausklick an und beginnen einfach mit dem Tippen. 

Um Ihre Eingabe abzuschließen, drücken Sie die Eingabetaste (¢).  

Wenn Sie einen Eingabefehler gemacht haben, ist dies kein Problem: Drücken Sie 

statt (¢) die Taste (Esc), vergisst PlanMaker, was Sie getippt haben, und stellt den 

alten Zellinhalt wieder her. 

Alternativ können Sie Eingaben auch über die folgenden Schaltflächen der Bear-

beitungsleiste abschließen: 

 Klicken Sie auf , um die Eingabe zu übernehmen. 

 Oder klicken Sie auf , um die Eingabe zu verwerfen. 

Um den Inhalt einer bereits ausgefüllten Zelle nachträglich zu bearbeiten, steuern 

Sie die Zelle an und betätigen die Taste (F2). Alternativ können Sie auch einen 

Doppelklick auf die Zelle ausführen. 

Anmerkungen zum Eingeben von Zahlen: 

 Zahlen können auch in wissenschaftlicher Schreibweise (Exponentialschreib-

weise) eingegeben werden. 2E03 entspricht beispielsweise 2 * 10^3, also 2000. 

Anderes Beispiel: 2E-03 entspricht 2* 10^-3, also 0,002. 

 Zahlen können auch als Brüche eingegeben werden. 2 1/2 entspricht beispiels-

weise 2,5. 

 Zahlen können auch als Prozentwerte eingegeben werden. 70% entspricht bei-

spielsweise 0,7. 

Mit dem Befehl Format > Zelle können Sie das Format von Zahlen in Tabellenzel-

len jederzeit ändern. Sie können PlanMaker also beispielsweise veranlassen, Zah-

len als Prozentwerte oder als Währung mit einem Währungssymbol anzuzeigen. 

Siehe dazu Abschnitt „Zahlenformat“ ab Seite 142. 
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Anmerkungen zum Eingeben von Daten und Uhrzeiten: 

 Daten können in beliebiger Schreibweise eingetragen werden – also zum Bei-

spiel 25.09.13 oder 25.9.2013 etc. 

 Sie können Daten zwischen dem 1.1.1900 und dem 31.12.2500 eingeben. 

 Wenn Sie ein Datum lediglich mit zweistelliger Jahreszahl eingeben, wird die-

ses wie folgt interpretiert: 

 Jahreszahl zwischen 0 und 29: 2000 bis 2029. 

 Jahreszahl zwischen 30 und 99: 1930 bis 1999. 

 Der 1.1.29 ist für PlanMaker also der 1.1.2029, der 1.1.30 hingegen der 

1.1.1930. 

 Auch Uhrzeiten lassen sich in einem beliebigen Format eingeben – also bei-

spielsweise 21:30 oder 09:30:00 PM etc. 

 Sie können in eine Zelle auch eine Kombination aus Datum und Uhrzeit einge-

ben, indem Sie das Datum, ein Leerzeichen und dann die Uhrzeit eintragen. Bei 

der Eingabe 25.9.13 6:00 weiß PlanMaker beispielsweise, dass damit der 25. 

September 2013 um 6:00 Uhr gemeint ist. 

Anmerkung: Daten und Uhrzeiten werden in Tabellenkalkulationen stets als Zahl 

gespeichert, damit Berechnungen mit ihnen durchgeführt werden können. Die Zahl 

0 steht für den 1.1.1900, die Zahl 1 für den 2.1.1900 etc. Die Uhrzeit wird in den 

Nachkommastellen der Zahl gespeichert. 

Darum brauchen Sie sich aber nicht zu kümmern. Geben Sie Daten und Uhrzeiten 

einfach in beliebiger Schreibweise ein. PlanMaker wandelt Ihre Eingabe unbe-

merkt in eine Zahl um, formatiert diese aber automatisch als Datum beziehungs-

weise Uhrzeit. Wie Sie das Format von Daten und Uhrzeiten ändern, können Sie 

bei Bedarf im Abschnitt „Zahlenformat“ ab Seite 142 nachlesen. 

Anmerkungen zum Eingeben von Wahrheitswerten: 

 Um in eine Zelle einen Wahrheitswert einzugeben, tragen Sie dort entweder 

WAHR oder FALSCH ein. 

Anmerkungen zum Eingeben von Berechnungen: 

 Rechenformeln müssen stets mit dem Gleichheitszeichen = beginnen – zum 

Beispiel =2+5. 
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 Über den Befehl Einfügen > Funktion lassen sich komfortabel Rechenfunktio-

nen einfügen. Sie können diese aber auch einfach eintippen – zum Beispiel 

=SUMME(2; 5). 

 Ausführliche Informationen zum Durchführen von Berechnungen finden Sie im 

Kapitel „Formeln und Funktionen“ ab Seite 437. 

 Eine Beschreibung aller Rechenfunktionen finden Sie im Abschnitt 

„Funktionen von A-Z“ ab Seite 455. 

Anmerkungen zum Eingeben von Text: 

 Text kann einfach eingetippt werden.  

 In bestimmten Situationen möchte man PlanMaker „zwingen“, eine Zahl als 

Text anzusehen. Dies können Sie erreichen, indem Sie der Zahl ein einfaches 

Anführungszeichen (Taste (ª)(#)) voranstellen. Tippen Sie in eine Zelle also 

beispielsweise '42 ein (inklusive des Anführungszeichens), betrachtet PlanMa-

ker diese Eingabe als Text – nicht als Zahl. 

 Tipp: Wenn Sie in einer Spalte einige Texteinträge direkt untereinander einge-

geben haben, können Sie jederzeit eine Auswahlliste mit diesen Einträgen auf-

rufen. Betätigen Sie dazu in der Zelle unter dem letzten (oder über dem ersten) 

Eintrag die Tastenkombination (Alt)(ª)(¼).  

 Es erscheint daraufhin eine Liste aller Zellinhalte direkt oberhalb oder unter-

halb dieser Zelle. Wenn Sie einen der Einträge auswählen und mit (¢) bestäti-

gen, wird dieser in die Zelle übernommen. Dies spart Ihnen viel Tipparbeit bei 

häufig wiederkehrenden Texteinträgen. 

 Hinweis: Dies funktioniert nur mit Texteinträgen – nicht mit Zahlen, Datums-

angaben oder Formeln. 

 Ein weiterer Tipp: Außerdem macht PlanMaker beim Ausfüllen einer Zelle 

automatisch Vorschläge aus den Texteinträgen direkt oberhalb oder unterhalb 

der Zelle. 

 Ein Beispiel: Sie haben in eine Spalte direkt untereinander die Einträge „New 

York“, „Rio“ und „Tokyo“ eingetragen. Wenn Sie nun in der Zelle unterhalb 

dieser Einträge ein „N“ eintippen, schlägt das Programm automatisch „New 

York“ vor. Tippen Sie hingegen ein „T“ ein, wird „Tokyo“ vorgeschlagen etc. 
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 Um den Vorschlag zu übernehmen, drücken Sie die Eingabetaste (¢). Um ihn 

abzulehnen, tippen Sie einfach weiter oder drücken Sie die Taste (Entf). 

 Hinweis: Falls Sie nicht möchten, dass PlanMaker beim Tippen solche Vor-

schläge macht, können Sie dieses Feature jederzeit deaktivieren. Rufen Sie da-

zu den Befehl Weiteres > Einstellungen und schalten Sie auf der Karteikarte 

Bearbeiten die Option Zellen automatisch vervollständigen aus. 

Änderungen rückgängig machen 

Mit dem Befehl Bearbeiten > Rückgängig können Sie die zuletzt an einem Do-

kument durchgeführten Änderungen widerrufen. Formatieren Sie beispielsweise 

Zellen in einer anderen Schrift, brauchen Sie nur Bearbeiten > Rückgängig aufzu-

rufen, und schon wird diese Änderung wieder aufgehoben.  

Dies funktioniert nicht nur bei Formatierungen, sondern bei praktisch allen Ände-

rungen – so können Sie beispielsweise auch das Eintippen oder Löschen von Text 

rückgängig machen.  

Der Befehl Rückgängig lässt sich bei Bedarf mehrmals hintereinander anwenden. 

Rufen Sie ihn zum Beispiel fünfmal auf, werden die letzten fünf Änderungen wi-

derrufen. 

Sie können diesen häufig benötigten Befehl übrigens auch über die Tastenkombi-

nation (Strg)(Z) aufrufen. 

Wiederherstellen von widerrufenen Aktionen 

Es gibt auch ein Gegenstück zum Befehl Rückgängig: den Befehl Bearbeiten > 

Wiederherstellen. Er stellt die zuletzt von Ihnen widerrufene Aktion wieder her. 

So können Sie also das Widerrufen von Änderungen widerrufen. 

Auch dieser Befehl lässt sich mehrmals hintereinander aufrufen. Rufen Sie also 

beispielsweise fünfmal den Befehl Rückgängig auf, werden die letzten fünf Ände-

rungen widerrufen. Rufen Sie anschließend fünfmal den Befehl Wiederherstellen 

auf, erhalten Sie wieder den Ausgangszustand. 
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Für diesen Befehl gibt es ebenfalls ein Tastenkürzel: die Tastenkombination 
(Strg)(Y). 

Befehle wiederholen 

Der Befehl Bearbeiten > Wiederholen (Tastenkürzel: (Strg)(ª)(Y)) wiederholt die 

Ausführung des zuletzt aufgerufenen Befehls mit genau den gleichen Einstellun-

gen. 

Dies ist insbesondere beim Anbringen von Formatierungen praktisch. Wenn Sie 

beispielsweise eine Zelle über den Befehl Format > Zeichen mit einer anderen 

Schrift versehen haben, können Sie anschließend weitere Zellen ansteuern und dort 

einfach den Befehl Bearbeiten > Wiederholen aufrufen. Diese Zellen werden 

dann in der gleichen Schrift formatiert – als ob Sie den letzten Befehl noch einmal 

aufgerufen und erneut die gleichen Einstellungen vorgenommen hätten. 

Auch viele andere Befehle lassen sich auf diese Weise beliebig oft wiederholen. 

Markieren von Zellen 

Bei manchen PlanMaker-Befehlen müssen vor der Ausführung erst die Zellen mar-

kiert werden, auf die der Befehl angewandt werden soll. 

Um etwas zu markieren, können Sie die Maus oder die Tastatur verwenden.  
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Bei gedrückter Strg-Taste können auch unzusammenhängende Bereiche markiert werden. 

Um Zellen zu markieren, gehen Sie wie folgt vor: 

Verwenden der Maus zum Markieren 

Mit der Maus können Tabellenbereiche folgendermaßen markiert werden: 

 Markieren beliebiger Bereiche 

 Zellbereiche beliebigen Umfangs können durch Überstreichen der gewünschten 

Zellen bei gedrückter linker Maustaste markiert werden. 

 Markieren kompletter Zeilen und Spalten 

 Eine komplette Spalte wird markiert, wenn Sie den dazugehörigen Spaltenkopf 

anklicken. Die Spaltenköpfe sind die Schaltflächen oberhalb der Tabelle (be-

schriftet mit A, B, C usw.).  

 Weiterhin gibt es für jede Zeile einen Zeilenkopf (links der Tabelle, beschriftet 

mit 1, 2, 3 etc.). Klicken Sie diesen an, wird die komplette Zeile markiert.  

 Ziehen Sie den Mauszeiger bei gedrückter Maustaste über mehrere Spalten- 

oder Zeilenköpfe, können Sie mehrere Spalten beziehungsweise Zeilen auf 

einmal markieren. 

 Markieren der gesamten Tabelle 

 Eine besondere Funktion hat die Schaltfläche links oben im Tabellenfenster 

(oberhalb von 1 und links von A): Ein Klick darauf markiert die gesamte Tabel-

le. 
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 Alternativ können Sie dies auch mit dem Befehl Bearbeiten > Alles markieren 

erreichen. 

 Markieren einer einzelnen Zelle 

 Um eine einzelne Zeile zu markieren, klicken Sie diese an und führen dann den 

Mauszeiger bei weiterhin gedrückter Maustaste auf eine Nachbarzelle und wie-

der zurück.  

 Markieren unzusammenhängender Bereiche 

 Sie können auch unzusammenhängende Bereiche markieren. Halten Sie dazu 

die Taste (Strg) gedrückt und markieren Sie dann die gewünschten Bereiche. 

 Aufheben einer Markierung 

 Zum Aufheben einer Markierung klicken Sie eine beliebige Zelle an. 

Verwenden der Tastatur zum Markieren 

Mit der Tastatur können Tabellenbereiche folgendermaßen markiert werden: 

 Markieren beliebiger Bereiche 

 Um einen Bereich von Zellen zu markieren, halten Sie die Umschalttaste (ª) 

gedrückt und betätigen dann beliebige Richtungstasten. 

 Wenn Sie beispielsweise die Zelle B5 ansteuern und dann bei gedrückter Um-

schalttaste fünfmal die Taste (¼) drücken, werden die Zellen B5 bis B10 mar-

kiert. Eine Liste aller Tastenkombinationen zum Bewegen und Markieren in ei-

ner Tabelle finden Sie im Abschnitt „Tastenkürzel zum Editieren von Tabellen“ 

ab Seite 753. 

 Markieren einer einzelnen Zelle 

 Eine einzelne Zelle markieren Sie, indem Sie die Zelle ansteuern, dann bei ge-

drückter Umschalttaste eine benachbarte Zelle markieren und schließlich wie-

der in die Ausgangszelle zurückkehren.  

 Drücken Sie also beispielsweise von der zu markierenden Zelle aus bei ge-

drückter Umschalttaste (Æ) und dann (æ). 

 Markieren unzusammenhängender Bereiche 

 Unzusammenhängende Bereiche können nur mit der Maus markiert werden 

(siehe oben). 
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 Aufheben einer Markierung 

 Ein Druck auf eine beliebige Richtungstaste hebt eine bestehende Markierung 

auf. 

Löschen von Zellen und Zellinhalten 

Wenn Sie etwas aus einer Tabelle herauslöschen möchten, sollten Sie beachten, 

dass es hierfür zwei unterschiedliche Methoden gibt: 

 Löschen von Zellinhalten 

 Wenn Sie den Befehl Bearbeiten > Löschen verwenden, werden nur die Inhal-

te der markierten Zellen gelöscht.  

 Löschen kompletter Zellen 

 Wenn Sie hingegen den Befehl Tabelle > Zellen löschen verwenden, werden 

die markierten Zellen komplett aus der Tabelle gelöscht. Die anderen Zellen der 

Tabelle rücken entsprechend nach. 

Darüber hinaus gibt es Befehle speziell zum Löschen von leeren Zeilen und dop-

pelt vorkommenden Zeilen: 

 Löschen leerer Zeilen 

 Um alle leeren Zeilen innerhalb eines bestimmten Bereichs von Zeilen zu lö-

schen, markieren Sie diese Zeilen und rufen dann den Befehl Tabelle > Ent-

fernen > Leere Zeilen auf. 

 Löschen doppelt vorkommender Zeilen 

 Um alle doppelt vorkommenden Zeilen innerhalb eines bestimmten Bereichs 

von Zeilen zu löschen, markieren Sie diese Zeilen und rufen dann den Befehl 

Tabelle > Entfernen > Doppelte Zeilen auf. 

Ausführlichere Informationen zum Löschen von Zellen und Zellinhalten folgen auf 

den nächsten Seiten. 

Löschen von Zellinhalten 

Der Befehl Bearbeiten > Löschen löscht die Inhalte der momentan markierten 

Zellen.  
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Tipp: Schneller geht dies natürlich mit dem Tastenkürzel für diesen Befehl: der 

Taste (Entf). 

Es werden nur die Inhalte der Zellen entfernt, nicht die Zellen selbst. 

Selektives Löschen von Zellinhalten 

Wenn Sie statt des Befehls Bearbeiten > Löschen den Befehl Bearbeiten > Selek-

tiv löschen benutzen, können Sie genau bestimmen, was gelöscht werden soll. 

Es erscheint dazu ein Untermenü mit folgenden Optionen: 

 Alles 

 Löscht alles – sowohl Zellinhalte als auch Formatierung, Kommentare, beding-

te Formatierungen und Gültigkeitsprüfung der markierten Zellen. 

 Formate 

 Löscht nur die Formatierung (Zahlenformat, Schriftformat, Hintergrund, Um-

randung usw.) der markierten Zellen. 

 Inhalte 

 Löscht nur die Inhalte (Werte, Texte, Formeln) der markierten Zellen, während 

die Formatierung für Neueingaben erhalten bleibt. 

 Kommentare 

 Löscht weder Inhalt noch Formatierung der markierten Zellen, sondern entfernt 

nur die Kommentare, die an diesen Zellen angebracht wurden (siehe Abschnitt 

„Kommentare einfügen“ ab Seite 113). 

 Bedingte Formatierung 

 Entfernt alle bedingten Formatierungen von den markierten Zellen(siehe auch 

Abschnitt „Bedingte Formatierung“ ab Seite 185). 

 Gültigkeitsprüfung 

 Entfernt alle Gültigkeitsprüfungen von den markierten Zellen (siehe auch Ab-

schnitt „Gültigkeitsprüfung“ ab Seite 186). 
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Löschen kompletter Zellen 

Der Befehl Tabelle > Zellen löschen löscht nicht nur den Inhalt von Zellen, son-

dern entfernt die Zellen komplett aus der Tabelle.  

Dazu erscheint ein Dialogfenster, in dem Sie bestimmen können, wie die anderen 

Tabellenzellen nach dem Löschvorgang nachrücken sollen. 

 

Folgende Optionen stehen zur Wahl: 

 Zellen nach oben verschieben 

 Wählen Sie diese Option, wird der markierte Bereich gelöscht und die Zellen, 

die sich darunter befinden, rücken nach oben nach. 

 Zellen nach links verschieben 

 Wählen Sie diese Option, wird der markierte Bereich gelöscht und die Zellen, 

die sich rechts davon befinden, rücken nach links nach. 

 Ganze Zeilen löschen 

 Hier werden nicht nur die markierten Zellen, sondern die kompletten Zeilen 

innerhalb des markierten Bereichs gelöscht. Die Zeilen darunter rücken ent-

sprechend nach oben nach. 

 Ganze Spalten löschen 

 Hier werden nicht nur die markierten Zellen, sondern die kompletten Spalten 

innerhalb des markierten Bereichs gelöscht. Die Spalten rechts davon rücken 

entsprechend nach links nach. 
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Löschen leerer Zeilen 

Um alle leeren Zeilen innerhalb eines bestimmten Bereichs von Zeilen zu löschen, 

markieren Sie diese Zeilen und rufen den Befehl Tabelle > Entfernen > Leere 

Zeilen auf.  

PlanMaker durchsucht diesen Bereich dann nach leeren Zeilen (also Zeilen, in de-

nen keine einzige Zelle ausgefüllt ist). Alle entsprechenden Zeilen werden ge-

löscht. 

Anmerkung 

Normalerweise markiert man vor der Anwendung dieses Befehls einen Bereich aus 

kompletten Zeilen. Sie können allerdings auch einen Zellbereich markieren, der 

nicht aus kompletten Zeilen besteht. PlanMaker fragt dann nach, ob die gefunde-

nen Zeilen komplett gelöscht werden sollen oder nicht: 

 Antworten Sie mit Ja, wird bei allen Fundstellen die komplette Zeile gelöscht. 

 Antworten Sie mit Nein, werden nur die Zellen innerhalb der Markierung ge-

löscht. Die Zellen links und rechts der Markierung bleiben erhalten. 

Löschen doppelt vorkommender Zeilen 

Um alle doppelt vorkommenden Zeilen innerhalb eines bestimmten Bereichs von 

Zeilen zu löschen, markieren Sie diese Zeilen und rufen den Befehl Tabelle > Ent-

fernen > Doppelte Zeilen auf.  

PlanMaker durchsucht diesen Bereich dann nach völlig identischen Zeilen (also 

Zeilen, bei denen die Inhalte aller Zellen identisch zu den entsprechenden Inhalten 

in einer bestimmten anderen Zeile sind). Diese doppelten Zeilen werden gelöscht. 

Anmerkung 

Normalerweise markiert man vor der Anwendung dieses Befehls einen Bereich aus 

kompletten Zeilen. Sie können allerdings auch einen Zellbereich markieren, der 

nicht aus kompletten Zeilen besteht. PlanMaker fragt dann nach, ob die gefunde-

nen Zeilen komplett gelöscht werden sollen oder nicht: 

 Antworten Sie mit Ja, wird bei allen Fundstellen die komplette Zeile gelöscht. 
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 Antworten Sie mit Nein, werden nur die Zellen innerhalb der Markierung ge-

löscht. Die Zellen links und rechts der Markierung bleiben erhalten. 

Einfügen von neuen Zellen 

Der Befehl Tabelle > Zellen einfügen fügt neue Zellen, Zeilen oder Spalten in die 

Tabelle ein.  

 

Es erscheint dazu ein Dialogfenster, in dem Sie wählen können, auf welche Weise 

die Zellen eingefügt werden sollen: 

 Zellen nach unten verschieben 

 Es werden genau so viele Zellen eingefügt, wie beim Aufruf des Befehls mar-

kiert sind. Wurde nichts markiert, wird nur eine Zelle eingefügt.  

 Die darunter liegenden Zellen werden nach unten verschoben. 

 Zellen nach rechts verschieben 

 Es werden genau so viele Zellen eingefügt, wie beim Aufruf des Befehls mar-

kiert sind. Wurde nichts markiert, wird nur eine Zelle eingefügt.  

 Die Zellen rechts daneben werden nach rechts verschoben. 

 Ganze Zeilen einfügen 

 Es werden so viele komplette Zeilen eingefügt, wie von der Markierung umfasst 

werden. Wurde nichts markiert, wird nur eine Zeile eingefügt.  

 Die darunter liegenden Zeilen werden nach unten verschoben.  
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 Ganze Spalten einfügen 

 Es werden so viele komplette Spalten eingefügt, wie von der Markierung um-

fasst werden. Wurde nichts markiert, wird nur eine Spalte eingefügt.  

 Die Spalten rechts davon werden nach rechts verschoben. 

Verschieben und Kopieren 

Alle von PlanMaker unterstützten Betriebssysteme verfügen über eine äußerst 

nützliche Einrichtung: die Zwischenablage. 

Die Zwischenablage hat folgende Aufgabe: Sie können in der Tabelle etwas mar-

kieren und dieses dann in die Zwischenablage hinein löschen oder kopieren. An-

schließend können Sie es an einer anderen Stelle der Tabelle wieder einfügen. Auf 

diese Weise lassen sich Zellen (und auch Objekte) löschen, duplizieren oder ver-

schieben.  

Alle hierzu nötigen Befehle finden Sie im Menü Bearbeiten: 

Befehl Erläuterung 

Ausschneiden Der Befehl Bearbeiten > Ausschneiden löscht den Inhalt der 

Markierung – jedoch nicht für immer. Er wandert vielmehr in die 

Zwischenablage und kann von dort aus jederzeit wieder einge-

fügt werden. Für das Ausschneiden gibt es auch ein Tastenkür-

zel: (Strg)(X).  

Kopieren Der Befehl Bearbeiten > Kopieren (Tastenkürzel hierfür: 
(Strg)(C)) kopiert den Inhalt der Markierung in die Zwischenab-

lage. 

Einfügen Um den Inhalt der Zwischenablage einzufügen, verwenden Sie 

den Befehl Bearbeiten > Einfügen. Setzen Sie den Zellrahmen 

an die gewünschte Position und rufen Sie diesen Befehl dann auf 

oder drücken Sie das Tastenkürzel (Strg)(V). Sie können den 

Inhalt der Zwischenablage auch mehrmals einfügen. 

Dies funktioniert auf die gleiche Weise auch mit Objekten wie Grafiken, Dia-

grammen und Zeichnungen. 
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Einfügen der Zwischenablage in einen markierten Bereich 

Wenn Sie vor dem Einfügen von Zellen mit Bearbeiten > Einfügen einen Bereich 

der Tabelle markieren, werden die Zellen in diese Markierung eingepasst. 

Dies äußert sich folgendermaßen: 

 Ist der markierte Zellbereich kleiner als der einzufügende Zellbereich, werden 

beim Einfügen alle Zellen, die nicht hineinpassen, abgeschnitten. 

 Ist der markierte Zellbereich größer, werden die Zellen so oft wiederholt, bis 

der markierte Bereich vollständig ausgefüllt ist. 

Markieren Sie hingegen nichts, werden die Zellen (wie oben beschrieben) ganz 

normal eingefügt. 

Verschieben und Kopieren mit der Maus („Drag and Drop“) 

Sie können Zellen auch verschieben oder kopieren, indem Sie diese mit der Maus 

einfach nehmen, an eine andere Stelle ziehen und dort ablegen. Mit dieser „Drag 

and Drop“ („Ziehen und Ablegen“) genannten Technik können Sie Zellinhalte be-

sonders schnell verschieben oder kopieren. 

Gehen Sie dazu folgendermaßen vor: 

1. Markieren Sie die gewünschten Zellen. 

2. Zeigen Sie mit der Maus auf diese Zellen.  

3. Drücken Sie die linke Maustaste und halten Sie diese gedrückt. 

4. Ziehen Sie die Maus bei weiterhin gedrückter Maustaste an die Zielstelle. 

5. Wenn Sie die Maustaste nun loslassen, werden die Zellen an die Zielstelle ver-

schoben. 

 Wenn Sie beim Loslassen der Maustaste die Taste (Strg) gedrückt halten, wer-

den sie hingegen dorthin kopiert. 

 Wenn Sie beim Loslassen der Maustaste die Taste (Alt) gedrückt halten, er-

scheint ein Dialog, in dem Sie wählen können, ob verschoben oder kopiert 

werden soll. Außerdem können Sie beim Kopieren festlegen, ob nur die Inhalte 

der Zellen oder auch deren Formatierungen kopiert werden sollen. 
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Formeln mit relativen Koordinaten kopieren und verschieben 

Wenn Sie Zellen, die Formeln enthalten, kopieren oder verschieben, werden auto-

matisch die Zelladressen in diesen Formeln dem neuen Ort angepasst. 

Ein Beispiel: 

Nehmen Sie an, in A7 befände sich eine Formel, die die Werte aus den vier darüber 

liegenden Zellen zusammenrechnet: 

=SUMME(A3:A6) 

Diese Formel kopieren Sie nun an Position B7. PlanMaker setzt die Formel dabei 

automatisch so um, dass sie wieder mit den vier Zellen oberhalb der Ergebniszelle 

arbeitet. Sie bekommen also in Zelle B7 folgende Formel präsentiert: 

=SUMME(B3:B6) 

Wünschen Sie dies nicht, verwenden Sie in den Formeln nicht die übliche relative 

Zelladressierung, sondern eine absolute Zelladressierung (siehe Abschnitt 

„Relative und absolute Zellbezüge“ ab Seite 442). 

Selektives Einfügen 

Wenn Sie mit Bearbeiten > Ausschneiden oder Bearbeiten > Kopieren Informa-

tionen in der Zwischenablage ablegen, werden diese dort in mehreren Formaten 

gleichzeitig gespeichert. Hatten Sie beispielsweise Text markiert, erscheint dieser 

in der Zwischenablage sowohl in formatierter Form als auch unformatiert. 

Normalerweise brauchen Sie sich darum nicht zu kümmern, denn PlanMaker wählt 

automatisch das geeignetste Format, wenn Sie die Zwischenablage mit Bearbeiten 

> Einfügen ins Dokument einfügen. Sie können das Format jedoch alternativ 

selbst auswählen. Verwenden Sie hierzu den Befehl Bearbeiten > Inhalte einfü-

gen.  

Beim Aufruf dieses Befehls erscheint ein Dialogfenster mit einer Liste aller Forma-

te, in denen die momentan in der Zwischenablage befindliche Information gespei-

chert ist. Wählen Sie das gewünschte Format in der Liste Einfügen als aus und 

bestätigen mit OK, wird der Inhalt der Zwischenablage im gewählten Format ein-

gefügt. 

Darüber hinaus bietet dieser Dialog verschiedene zusätzliche Optionen an, die al-

lerdings nur verfügbar sind, wenn Tabellenzellen in die Zwischenablage kopiert 

wurden: 
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Folgende Optionen gibt es: 

Inhalt einfügen 

Hier können Sie festlegen, auf welche Weise die Inhalte der kopierten Zellen ein-

gefügt werden sollen: 

 Inhalte einfügen 

 Ist diese Option aktiviert, wird auch der Inhalt der kopierten Zellen eingefügt. 

Ist sie deaktiviert, nur deren Formatierung. 

 Formeln in Werte umwandeln 

 Ist diese Option aktiviert, werden sämtliche in den kopierten Zellen enthaltenen 

Rechenformeln beim Einfügen ausgerechnet und als feste Werte eingetragen. 

Kopieren Sie also eine Zelle mit der Berechnung „=A1*2“ in die Zwischenab-

lage, würde beim Einfügen nicht die Rechenformel eingefügt, sondern das Er-

gebnis dieser Berechnung als Zahlenwert. 
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 Kommentare ignorieren 

 Ist diese Option aktiviert, werden Kommentare, mit denen die kopierten Zellen 

versehen wurden, beim Einfügen weggelassen. 

Formatierung einfügen 

Bestimmt, ob beim Einfügen auch die Formatierung der kopierten Zellen über-

nommen werden soll. 

Hierfür gibt es folgende Optionen: 

 Alle 

 Alle Formatierungsoptionen der kopierten Zellen übernehmen. (Schaltet sämt-

liche nachfolgend aufgelisteten Optionen ein.) 

 Zahlenformat 

 Das Zahlenformat der kopierten Zellen übernehmen. 

 Zellenformat 

 Das Zellenformat der kopierten Zellen übernehmen. 

 Umrandung und Schattierung 

 Umrandungen und Schattierungen der kopierten Zellen übernehmen. 

 Gültigkeitsprüfung 

 Die Einstellungen zur Gültigkeitsprüfung der kopierten Zellen übernehmen. 

 Bedingte Formatierung 

 Bedingte Formatierungen der kopierten Zellen übernehmen. 

Optionen 

Dieser Bereich enthält folgende zusätzlichen Optionen: 

 Transponieren 

 Ist diese Option aktiviert, wird beim Einfügen die zeilen-/spaltenweise Anord-

nung der kopierten Zellen vertauscht. Zeilen werden also zu Spalten, und Spal-

ten werden zu Zeilen. 
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 Leere Zellen überspringen 

 Ist diese Option aktiviert, werden beim Einfügen der kopierten Zellen alle lee-

ren Zellen übersprungen. Fügen Sie also eine leere Zelle auf einer bestehenden 

Zelle ein, behält die bestehende Zelle ihren Inhalt und ihre Formatierung bei. 

 Rechenoperation 

 Diese Option betrifft das Einfügen von kopierten Zellen auf bereits vorhandene 

Zellen. Sie bestimmt, ob dabei die vorhandenen Werte mit den kopierten Wer-

ten kombiniert werden sollen. Hierfür stehen die vier Grundrechenarten zur 

Verfügung. 

 Verfügbare Optionen: 

 Keine: Die kopierten Werte und die vorhandenen Werte nicht kombinieren. Die 

vorhandenen Werte werden also einfach überschrieben. Dies ist die Stan-

dardeinstellung. 

 Zum Ziel addieren: Die kopierten Werte zu den vorhandenen Werten addieren. 

 Vom Ziel subtrahieren: Die kopierten Werte von den vorhandenen Werten 

abziehen. 

 Mit dem Ziel multiplizieren: Die vorhandenen Werte mit den kopierten Wer-

ten multiplizieren. 

 Das Ziel dividieren: Die vorhandenen Werte durch die kopierten Werte teilen. 

 Ein Beispiel: Sie kopieren eine Zelle, die den Wert 2 enthält, in die Zwischen-

ablage. Dann steuern Sie eine Zelle an, die den Wert 8 enthält, und rufen Ein-

fügen > Inhalte einfügen auf. Ist hierbei die Option Zum Ziel addieren einge-

schaltet, wird diese Zelle danach den Wert 10 enthalten (8+2=10). 

Schaltfläche „Bezüge einfügen“ 

Diese Schaltfläche ignoriert sämtliche Einstellungen, die Sie in dem Dialog vor-

nehmen, denn sie hat folgende Spezialfunktion: 

Wenn Sie Tabellenzellen in die Zwischenablage kopiert haben, Bearbeiten > In-

halte einfügen aufrufen und dann auf diese Schaltfläche klicken, werden nicht die 

Inhalte dieser Zellen eingefügt, sondern Zellbezüge auf die Adressen dieser Zellen. 

Kopieren Sie also die Zelle B15 in die Zwischenablage, fügt diese Schaltfläche den 

Zellbezug =B15 ein. 
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Tipp: Dies funktioniert sogar, wenn Zellen von einem anderen Dokument aus in 

die Zwischenablage kopiert wurden. In diesem Fall fügt PlanMaker automatisch 

einen externen Zellbezug ein (siehe Abschnitt „Externe Zellbezüge“, Seite 444). 

Automatisches Füllen von Zellen 

Mit der Funktion Ausfüllen ist es möglich, den Inhalt einer Zelle blitzschnell in 

andere Zellen zu kopieren oder von diesem Wert ausgehend eine ansteigende oder 

abfallende Wertereihe über mehrere Zellen hinweg aufzubauen.  

Es gibt zwei Methoden, diese Funktion einzusetzen: 

Füllen mit der Maus 

Am einfachsten funktioniert das automatische Füllen von Zellen mit der Maus. 

Gehen Sie wie folgt vor: 

1. Tragen Sie den Ausgangswert in eine Zelle ein. 

2. Klicken Sie auf die Zelle mit dem Ausgangswert. 

3. Zeigen Sie mit der Maus auf das kleine Rechteck in der rechten unteren Ecke 

des Zellrahmens, der die aktuelle Zelle umgibt (in der Abbildung umrandet): 

  

4. Ziehen Sie dieses Rechteck bei gedrückter Maustaste in die gewünschte Rich-

tung. Lassen Sie die Maustaste los, wenn die Zielposition erreicht ist. 

Alle Zellen in dem aufgezogenen Bereich werden nun automatisch gefüllt. 

Womit die Zellen gefüllt werden, hängt davon ab, was sich in der Ausgangszelle 

befindet: 

 Ist dort Text eingetragen, füllt PlanMaker alle Zellen mit diesem Text.  

 Ist eine Zahl (z.B. 42) eingetragen, füllt PlanMaker die Zellen automatisch mit 

einer Zahlenreihe mit Inkrement 1 (hier also 43, 44, 45 etc.). 

 Wenn Sie nicht möchten, dass PlanMaker eine Zahlenreihe bildet, sondern ein-

fach nur alle Zellen mit 42 gefüllt haben möchten, dann drücken Sie während 

des Ziehens mit der Maus die Taste (Strg). 
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Wenn Sie während des Ziehens die Taste (Alt) gedrückt halten, erscheint der weiter 

unten beschriebene Dialog, in dem Sie genauer festlegen können, auf welche Weise 

die Zellen gefüllt werden sollen. 

Füllen per Tastatur 

Um Zellen per Tastatur automatisch füllen zu lassen, gehen Sie wie folgt vor: 

1. Tragen Sie den Ausgangswert in eine Zelle ein. 

2. Markieren Sie die Zelle mit dem Ausgangswert und alle zu füllenden Zellen. 

3. Rufen Sie den Befehl Bearbeiten > Ausfüllen nach auf. 

4. Es erscheint ein Untermenü. Wählen Sie darin, in welche Richtung gefüllt wer-

den soll (ausgehend von der Zelle mit dem Ausgangswert): Links, Rechts, 

Oben oder Unten. 

5. Es erscheint ein Dialog, in dem Sie genau festlegen können, auf welche Weise 

die Zellen gefüllt werden sollen (siehe unten). 

6. Sobald Sie mit OK bestätigen, werden die markierten Zellen Ihren Einstellun-

gen entsprechend gefüllt. 

Es erscheint dabei das folgende Dialogfenster: 

 

Hier können folgende Einstellungen vorgenommen werden: 

Quelle 

Aktivieren Sie die Option Inhalte, wenn die zu füllenden Zellen mit Werten gefüllt 

werden sollen. 
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Aktivieren Sie die Option Formate, wenn die zu füllenden Zellen auch die Forma-

tierung der Ausgangszelle erben sollen. 

Standardmäßig sind beide Optionen aktiviert. 

Aktion 

Diese Option entspricht dem Drücken der Taste (Strg) beim Füllen von Zellen per 

Maus: Sie können dadurch bestimmen, ob der Wert in der Ausgangszelle fortge-

schrieben oder kopiert werden soll: 

Steht in der Ausgangszelle beispielsweise die Zahl 42, werden bei Kopieren alle 

auszufüllenden Zellen ebenfalls mit 42 gefüllt. 

Wählen Sie hingegen Fortschreiben, werden die Zellen mit einer Zahlenreihe (in 

diesem Fall also 43, 44, 45 etc.) gefüllt. 

Wie diese Zahlenreihe aufgebaut sein soll, legen Sie mit den anderen Optionen 

fest: 

Reihentyp 

Hier bestimmen Sie, welche Art von Zahlenreihe erzeugt werden soll: 

 Automatisch 

 Entspricht einer arithmetischen Reihe: Jeder weitere Wert wird um das Inkre-

ment erhöht. Das Inkrement ermittelt PlanMaker dabei allerdings automatisch.  

 Wenn Sie beispielsweise zwei Zellen mit den Werten 10 und 20 fortführen, 

werden die auszufüllenden Zellen mit 30, 40, 50 etc. gefüllt (siehe auch Tipps 

und Tricks im nächsten Abschnitt). 

 Arithmetisch 

 Hier wird jeder weitere Wert um das Inkrement erhöht.  

 Steht in der Ausgangszelle also 1, werden die Zellen bei einem Inkrement von 2 

mit folgender Zahlenreihe gefüllt: 3, 5, 7, 9, 11 etc. 

 Geometrisch 

 Hier wird jeder weitere Wert mit dem Inkrement multipliziert. 

 Steht in der Ausgangszelle also 1, werden die Zellen bei einem Inkrement von 2 

mit folgender Zahlenreihe gefüllt: 2, 4, 8, 16, 32 etc. 
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 Datum 

 Hier wird jeder weitere Wert um das Inkrement in der gewählten Zeiteinheit 

(siehe unten) erhöht. Dieser Reihentyp ist nur dann sinnvoll anwendbar, wenn 

sich in der Ausgangszelle ein Datum befindet. 

 Steht in der Ausgangszelle also 1.1.2013, werden die Zellen bei Inkrement 1 

und Zeiteinheit „Monate“ wie folgt gefüllt: 1.2.2013, 1.3.2013, 1.4.2013 etc. 

Inkrement 

Hier bestimmen Sie, um welchen Betrag jeder weitere Wert ansteigen soll.  

Es ist auch ein negativer Wert zulässig. 

Diese Option ist nicht verfügbar, wenn der Reihentyp auf „Automatisch“ gesetzt 

wurde, da PlanMaker das Inkrement hier automatisch ermittelt. 

Zeiteinheit 

Hier bestimmen Sie die Zeiteinheit für das Inkrement. 

Diese Option ist nur dann verfügbar, wenn der Reihentyp auf „Datum“ gesetzt 

wurde. 

 Tage 

 Tageweise weiterzählen 

 Werktage 

 Tageweise weiterzählen, dabei jedoch Samstag und Sonntag überspringen 

 Steht in der Ausgangszelle also ein Datum, das auf einen Freitag fällt, so wäre 

der nächste Wert bei einem Inkrement von 1 nicht der darauf folgende Samstag, 

sondern der Montag. 

 Monate 

 Monateweise weiterzählen 

 Jahre 

 Jahreweise weiterzählen 
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Tipps und Tricks beim automatischen Füllen 

Die vielen Optionen, die es bei der Funktion Ausfüllen gibt, lassen ihre Anwen-

dung schwieriger erscheinen, als sie tatsächlich ist. Deshalb finden Sie nachfolgend 

einige Tipps und Tricks, wie Sie dieses äußerst nützliche Feature am effektivsten 

einsetzen. 

Tipp: Am schnellsten gelingt das automatische Füllen, wenn Sie einfach mit der 

Maus an dem kleinen Rechteck in der rechten unteren Ecke des Zellrahmens zie-

hen. Denn hier setzt PlanMaker den Reihentyp auf „Automatisch“. Das heißt: Er 

erkennt selbstständig, mit welchen Werten die Zellen auszufüllen sind (siehe 

Beispiele). 

Füllen mit Text 

Beim Füllen mit Text brauchen Sie sich um keinerlei Optionen zu kümmern, denn 

Text kann ohnehin nur kopiert werden. 

Möchten Sie also mehrere Zellen mit dem gleichen Text füllen, tragen Sie ihn ein-

fach in eine Zelle ein, klicken diese Zelle an und ziehen das kleine Rechteck in der 

rechten unteren Ecke des Zellrahmens über die Zellen, die damit gefüllt werden 

sollen. 

Füllen mit Zahlen 

Wenn Sie zum Füllen mit Zahlen die Maus verwenden, erhalten Sie eine Zahlen-

reihe, deren Inkrement PlanMaker automatisch bestimmt. 

Ziehen Sie also von einer Zelle mit der Zahl 42 aus an dem kleinen Rechteck, wer-

den die Zellen mit den Werten 43, 44, 45 etc. gefüllt. 

Tragen Sie hingegen in eine Zelle 10 und darunter 20 ein, markieren diese beiden 

Zellen und ziehen dann das Rechteck nach unten, erkennt PlanMaker automatisch, 

wie diese Reihe fortzuführen ist, trägt also 30, 40, 50 etc. ein. 

Füllen mit Formeln 

Wenn Sie Zellen mit Formeln füllen, versucht PlanMaker automatisch, die Zella-

dresse in einer Reihe fortzuführen. 

Tragen Sie in die Ausgangszelle beispielsweise =A1*2 ein, werden die Zellen mit 

=A2*2, =A3*2 etc. gefüllt. 
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Füllen mit Datumsangaben 

Das Füllen mit Datumsangaben funktioniert genauso wie das Füllen mit Zahlen: 

Tragen Sie das Ausgangsdatum in die Ausgangszelle ein, ziehen Sie an dem Recht-

eck und PlanMaker addiert bei jeder Zelle einen Tag hinzu. 

Bei Bedarf können Sie über den Dialog des Befehls Bearbeiten > Ausfüllen fest-

legen, ob um Tage, Monate oder Jahre weitergezählt werden soll. 

Füllen mit Strukturen 

Wie Sie bereits erfahren haben, können Sie auch mehrere Zellen markieren und 

diese fortführen. Was aber, wenn die markierten Zellen kein automatisch erkennba-

res Inkrement oder völlige unterschiedliche Werte haben? 

Hier versucht PlanMaker, dennoch eine Regelmäßigkeit zu erkennen. Tragen Sie 

beispielsweise untereinander die Werte 1, 2, Text ein, so führt PlanMaker diese 

Reihe mit 3, 4, Text, 5, 6, Text, 7, 8, Text etc. fort. 

Handelt es sich bei den Werten ausschließlich um Zeichenketten, so werden diese 

einfach wiederholt. Sind die Ausgangszellen also mit den Zeichenketten Rot, Grün, 

Blau gefüllt, werden die Zellen mit Rot, Grün, Blau, Rot, Grün, Blau etc. gefüllt. 

Erstellen eigener Listen für das automatische Füllen 

Mit dem Befehl Weiteres > Listen editieren können Sie eigene Listen für die 

Funktion Ausfüllen herstellen. 

Erzeugen Sie beispielsweise eine Liste mit dem Inhalt „Rot“, „Grün“ und „Blau“ 

und füllen dann, ausgehend von einer Zelle mit dem Inhalt „Rot“, weitere Zellen, 

so werden diese mit Grün, Blau, Rot, Grün, Blau etc. gefüllt. 

Informationen zum Erstellen solcher Listen finden Sie im Abschnitt „Listen für das 

automatische Füllen editieren“ ab Seite 429. 

Arbeiten mit mehreren Arbeitsblättern 

Tabellen müssen nicht unbedingt aus nur einem einzigen Arbeitsblatt bestehen. Es 

ist auch möglich, mehrere Arbeitsblätter hintereinander zu legen – quasi wie bei 
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einem Stapel Papier. Wir nennen ein PlanMaker-Dokument deshalb auch eine Ar-

beitsmappe. Jede Arbeitsmappe kann bis zu 256 Arbeitsblätter enthalten. 

Der Clou dabei: Berechnungen in einem Arbeitsblatt können sich auch auf Zellen 

anderer Arbeitsblätter beziehen, was Ihnen ermöglicht, quasi „dreidimensionale“ 

Berechnungen durchzuführen (siehe Abschnitt „Rechnen in drei Dimensionen“, 

Seite 88). 

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit mehreren 

Arbeitsblättern in einem Dokument. Folgende Themen werden darin behandelt: 

 Neue Arbeitsblätter anlegen 

 Mit dem Befehl Tabelle > Blatt > Einfügen können Sie jederzeit ein neues 

Arbeitsblatt anlegen. 

 Verwenden des Arbeitsblattregisters 

 Mit dem Arbeitsblattregister am unteren Rand des Dokumentfensters können 

Sie per Mausklick zwischen den Arbeitsblätter eines Dokuments wechseln. 

Weiterhin lassen sich Arbeitsblätter damit anlegen, verschieben und verwalten. 

 Arbeitsblätter verwalten 

 Das Kontextmenü des Arbeitsblattregisters und der Menübefehl Tabelle > Blatt 

stellt Ihnen Befehle zur Verfügung, mit denen Sie Arbeitsblätter verwalten kön-

nen (umbenennen, kopieren, verschieben etc.). 

 Rechnen in drei Dimensionen 

 Im letzten Abschnitt erfahren Sie, wie Sie Berechnungen über mehrere Arbeits-

blätter hinweg durchführen. 

Ausführliche Informationen zu diesen Themen finden Sie auf den nächsten Seiten. 

Neue Arbeitsblätter anlegen 

Um ein neues Arbeitsblatt anzulegen, rufen Sie den Befehl Tabelle > Blatt auf. Es 

öffnet sich ein Untermenü, aus dem Sie den Befehl Einfügen wählen. Nun er-

scheint ein Dialogfenster, das Sie auffordert, dem neuen Blatt einen Namen zu ge-

ben. Tragen Sie einen beliebigen Namen ein und bestätigen Sie mit OK.  

PlanMaker legt das Arbeitsblatt an und macht es zum aktiven Arbeitsblatt.  
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Verwenden des Arbeitsblattregisters 

Im Arbeitsblattregister am unteren Rand des Dokumentfensters werden Register-

karten für alle im aktuellen Dokument vorhandenen Arbeitsblätter angezeigt. 

 
Das momentan aktive Blatt ist hervorgehoben dargestellt. 

Mit dem Arbeitsblattregister lassen sich folgende Aktionen durchführen: 

 Wechseln zwischen Arbeitsblättern 

 Um auf ein anderes Arbeitsblatt zu wechseln, klicken Sie einfach dessen Regis-

terkarte im Arbeitsblattregister an. 

 Hinweis: Falls aus Platzgründen nicht alle Blätter angezeigt werden, können 

Sie das Register mit Hilfe der Pfeilchen links davon durchblättern. 

 Reihenfolge von Arbeitsblättern ändern 

 Sie können Arbeitsblätter im Arbeitsblattregister jederzeit verschieben und so 

die Reihenfolge der Blätter ändern.  

 Klicken Sie dazu die Registerkarte des Blatts an, das verschoben werden soll, 

halten Sie die linke Maustaste gedrückt und ziehen Sie seine Registerkarte an 

die gewünschte Position im Register. 

 Bearbeiten mehrerer Arbeitsblätter gleichzeitig 

 Sie können im Arbeitsblattregister auch mehrere Arbeitsblätter auf einmal se-

lektieren und diese dann gemeinsam bearbeiten. Halten Sie dazu die Taste 
(Strg) gedrückt und klicken Sie die Registerkarten aller Arbeitsblätter an, die 

Sie selektieren möchten. 

 Wenn mehrere Arbeitsblätter markiert sind, wirken sich Änderungen an einem 

dieser Arbeitsblätter auf alle markierten Arbeitsblätter gleichzeitig aus.  

 Beispiele: 

 Wenn Sie die Formatierung von Zellen ändern, wird diese Änderung auch von 

den gleichen Zellen auf den anderen markierten Blättern übernommen. 

 Wenn Sie den Inhalt einer Zelle bearbeiten oder löschen, wird auch diese Ände-

rung auf allen markierten Blättern übernommen. 

 Änderungen mit den Befehlen Tabelle > Zeile und Tabelle > Spalte wirken 

sich ebenfalls auf alle markierten Blätter aus. 



 

86    Bearbeiten einer Tabelle Handbuch PlanMaker 

 Verwalten von Arbeitsblättern 

 Wenn Sie mit der rechten Maustaste auf eine der Registerkarten im Arbeits-

blattregister klicken, erscheint ein Kontextmenü, das alle Befehle zum Anlegen 

und Verwalten von Arbeitsblättern enthält. Lesen Sie dazu den nächsten Ab-

schnitt. 

 Anlegen eines neuen Arbeitsblatts 

 Die Registerkarte mit dem Sternchen (*) ganz rechts dient als „Abkürzung“ für 

das Anlegen neuer Arbeitsblätter: Wenn Sie darauf klicken, legt PlanMaker so-

fort ein neues Arbeitsblatt an. 

Arbeitsblätter verwalten 

Wenn Sie den Befehl Tabelle > Blatt aufrufen, öffnet sich ein Untermenü mit Be-

fehlen zum Verwalten von Arbeitsblättern. 

Tipp: Dieses Menü erscheint auch, wenn Sie mit der rechten Maustaste auf die 

gewünschte Registerkarte im Arbeitsblattregister klicken. 

Folgende Befehle sind in dem Menü verfügbar: 

 Der Befehl Einfügen legt ein neues Arbeitsblatt an. 

 Der Befehl Kopieren fertigt eine Kopie des aktuellen Arbeitsblatts an. Dazu 

erscheint ein Untermenü, in dem Sie wählen können, an welcher Position die 

Kopie platziert werden soll (innerhalb der anderen Arbeitsblätter). 

 Sie können die Kopie auch in einem anderen (momentan geöffneten) Dokument 

oder in einem neuen Dokument ablegen. Wählen Sie dazu die Option In ein 

anderes Dokument. 

 Der Befehl Verschieben verschiebt das Arbeitsblatt an eine andere Position. 

Genau wie beim Befehl Kopieren erscheint auch hier ein Untermenü zur Aus-

wahl des Zielorts. 

 Der Befehl Löschen entfernt das Arbeitsblatt (samt Inhalt). 

 Der Befehl Umbenennen lässt Sie den Namen des Arbeitsblatts ändern. 

 Der Befehl Einblenden macht ausgeblendete Arbeitsblätter wieder sichtbar 

(siehe Befehl Ausblenden).  
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 Dazu öffnet sich ein Untermenü, das alle ausgeblendeten Arbeitsblätter anzeigt. 

Klicken Sie darin auf das Blatt, das wieder eingeblendet werden soll. Der Ein-

trag Alle einblenden macht alle ausgeblendeten Blätter wieder sichtbar. 

 Der Befehl Ausblenden blendet das Arbeitsblatt aus.  

 Ausgeblendete Arbeitsblätter sind unsichtbar. Sie können nicht angezeigt oder 

bearbeitet werden und erscheinen auch nicht im Arbeitsblattregister. PlanMaker 

zieht sie aber auch weiterhin bei Berechnungen heran. 

 Die Befehle Alle Blätter selektieren und Blätter deselektieren (nur im Kon-

textmenü verfügbar) selektieren beziehungsweise deselektieren alle Arbeitsblät-

ter im Arbeitsblattregister. 

 Der Befehl Seite einrichten im Kontextmenü entspricht dem Befehl Datei > 

Seite einrichten im Hauptmenü. Sie können damit Einstellungen wie Papier-

format, Seitenränder etc. für das Arbeitsblatt vornehmen. Siehe Abschnitt 

„Seitenformat“ ab Seite 194. 

 Der Befehl Seiteneinrichtung kopieren im Kontextmenü erlaubt es Ihnen, die 

Seiteneinrichtung eines Arbeitsblatts (also alle mit dem Befehl Datei > Seite 

einrichten gemachten Einstellungen) auf ein anderes Arbeitsblatt zu übertra-

gen. Es erscheint ein Untermenü mit folgenden Befehlen: 

 Auf alle Blätter: Überträgt die Seiteneinrichtung vom aktuellen Arbeitsblatt 

auf alle anderen. 

 Von...: Überträgt die Seiteneinrichtung vom einem beliebigen anderen Arbeits-

blatt auf das aktuelle Blatt. 

 Der Befehl Eigenschaften im Kontextmenü entspricht dem Befehl Tabelle > 

Eigenschaften im Hauptmenü. Sie können damit allgemeine Einstellungen zu 

einem Arbeitsblatt vornehmen. Siehe Abschnitt „Arbeitsblatteigenschaften än-

dern“ ab Seite 410. 

Tipp: Wie zuvor im Abschnitt „Verwenden des Arbeitsblattregisters“ beschrieben, 

können Sie vor dem Aufruf eines dieser Befehle mehrere Arbeitsblätter im Arbeits-

blattregister selektieren. Der Befehl wird dann auf alle selektierten Blätter gleich-

zeitig angewandt. 

Hinweis: Wenn Sie den Arbeitsmappenschutz aktivieren, lassen sich keinerlei 

Änderungen am Arbeitsblattregister mehr durchführen und der Befehl Tabelle > 

Blatt ist nicht mehr verfügbar. Informationen dazu finden Sie im Abschnitt 

„Arbeitsmappenschutz“ ab Seite 358. 
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Rechnen in drei Dimensionen 

Der besondere Clou an Dokumenten mit mehreren Arbeitsblättern ist, dass Sie 

auch Berechnungen über mehrere Arbeitsblätter hinweg durchführen können.  

Dazu muss in der Formel lediglich vor der Zelladresse der Name des Blatts ange-

geben werden (durch ein Ausrufezeichen getrennt). „Tabelle1!A1“ steht beispiels-

weise für die Zelle A1 auf dem Arbeitsblatt „Tabelle1“. 

Ein Beispiel 

Nehmen wir an, Sie möchten eine Gewinn- und Verlustrechnung erstellen. Dazu 

haben Sie drei Arbeitsblätter mit den Namen „Einnahmen“, „Ausgaben“ und „Er-

gebnis“ angelegt. 

 

Nun soll beispielsweise vom Wert in der Zelle A8 des Blatts „Einnahmen“ der Wert 

in Zelle D2 des Blatts „Ausgaben“ abgezogen werden und in Zelle C9 des Blatts 

„Ergebnis“ erscheinen.  

Wechseln Sie dazu zum Blatt „Ergebnis“. Steuern Sie darin die Zelle C9 an und 

tragen Sie folgende Formel ein: 

=Einnahmen!A8-Ausgaben!D2 

Nach Betätigen der Eingabetaste (¢) erhalten Sie in der Zelle C9 auf dem Blatt 

„Ergebnis“ das Resultat dieser Berechnung. 

Bereiche benennen 

Mit dem Befehl Tabelle > Namen können Sie beliebigen Zellbereichen Namen 

geben.  

Hat Ihre Tabelle beispielsweise vier Spalten mit den Umsätzen für Frühjahr, Som-

mer, Herbst und Winter, benennen Sie diese einfach entsprechend. Nun ist bei-

spielsweise folgende Berechnung möglich: 

=SUMME(Frühjahr)  

Wenn Sie den Befehl Tabelle > Namen aufrufen, öffnet sich ein Untermenü. Die-

ses enthält alle Befehle, die Sie für benannte Bereiche benötigen. 
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Hinweis: Der Befehl Tabelle > Namen ist nicht verfügbar, wenn mindestens ein 

Arbeitsblatt der Tabelle mit einem Blattschutz versehen ist (siehe auch Abschnitt 

„Blattschutz“ ab Seite 355). 

Ausführlichere Information zum Arbeiten mit Bereichen finden Sie auf den nächs-

ten Seiten. Folgende Themen werden darin behandelt: 

 Namen festlegen 

 Namen umbenennen oder löschen 

 Namen aus der Markierung automatisch festlegen 

 Liste aller Namen ausgeben 

 Namen in der Praxis einsetzen 

 Namen nachträglich auf Berechnungen anwenden 

Namen festlegen 

Um einem Zellbereich einen Namen zu geben, gehen Sie wie folgt vor: 

1. Markieren Sie den Zellbereich, der benannt werden soll. 

2. Rufen Sie den Befehl Tabelle > Namen > Bearbeiten auf. 

3. Geben Sie in das Eingabefeld Name den gewünschten Namen ein. 

4. Klicken Sie auf die Schaltfläche Hinzufügen. 

Der markierte Zellbereich wurde nun mit dem angegebenen Namen versehen. 

Diesen Namen können Sie ab jetzt – stellvertretend für die Zellen im angegebenen 

Bereich – in Formeln verwenden. Geben Sie zum Beispiel dem Bereich A2 bis A10 

den Namen „Januar“, ist die Rechenformel =SUMME(Januar) gleichbedeutend mit 

=SUMME(A2:A10). 

Hinweis: Namen für benannte Bereiche dürfen nur aus Buchstaben, Zahlen, Un-

terstrichen und Punkten bestehen. Das erste Zeichen muss ein Buchstabe oder 

ein Unterstrich sein.  

Weiterhin dürfen Namen nicht wie Zellbezüge aufgebaut sein. Der Name „A2“ 

ist beispielsweise nicht zulässig, da PlanMaker ihn nicht von der Adresse der 

Zelle A2 unterscheiden kann. 
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Tipp: Eine schnellere Methode 

Folgendermaßen können Sie Namen noch schneller festlegen: 

Links oberhalb des Tabellenfensters befindet sich eine editierbare aufklappbare 

Liste, die normalerweise anzeigt, in welcher Zelle sich der Zellrahmen gerade be-

findet.  

 

Sie können dort aber auch blitzschnell Bereiche benennen: 

1. Markieren Sie den Zellbereich, der benannt werden soll. 

2. Klicken Sie mit der Maus in diese editierbare Liste. 

3. Tragen Sie den Namen ein, den der markierte Bereich erhalten soll. 

4. Drücken Sie die Eingabetaste (¢). 

Der markierte Bereich wurde nun mit dem eingegebenen Namen versehen. 

Namen umbenennen oder löschen 

Um einen benannten Bereichs umzubenennen oder ihn zu löschen, gehen Sie wie 

folgt vor: 

1. Rufen Sie den Befehl Tabelle > Namen > Bearbeiten auf. 

2. Selektieren Sie den zu gewünschten Namen in der Liste der Namen. 

3. Um ihn umzubenennen, klicken Sie auf die Schaltfläche Umbenennen. Um ihn 

zu löschen, klicken Sie auf Löschen. 

Der Name wurde nun geändert beziehungsweise entfernt. 

Hinweis: Wenn Sie einen Namen löschen, wird anschließend bei Formeln, die 

diesen Namen verwenden, anstelle des Ergebnisses der Fehlerwert #NAME? zu-

rückgegeben. War also beispielsweise ein Zellbereich mit dem Namen „Januar“ 

versehen, wird als Ergebnis der Formel =SUMME(Januar) jetzt #NAME? ange-

zeigt. 
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Namen aus der Markierung automatisch festlegen 

Wenn Sie Zellen markieren, die sowohl Werte als auch Zeilen- oder Spaltenüber-

schriften enthalten, können Sie PlanMaker daraus entsprechend benannte Bereiche 

generieren lassen. Die Namen holt sich PlanMaker dabei automatisch aus den 

Überschriften. 

Gehen Sie dazu wie folgt vor: 

1. Markieren Sie den gewünschten Zellbereich. Dieser muss sowohl die Werte als 

auch die Überschriften, die für die Namensgebung verwendet werden sollen, 

enthalten. 

2. Rufen Sie den Befehl Tabelle > Namen > Übernehmen auf. 

3. Es erscheint ein Dialog, in dem Sie angeben, in welcher Zeile und/oder Spalte 

sich die Überschriften befinden, die für die Namensgebung herangezogen wer-

den sollen (siehe Beispiel). 

4. Bestätigen Sie mit OK. 

Die Namen wurden nun den Überschriften entsprechend festgelegt. 

Ein Beispiel 

Sie haben die folgende Tabelle erstellt: 

 

Markieren Sie nun alle Werte und alle Bezeichnungen und rufen Sie den Befehl 

Tabelle > Namen > Übernehmen auf. Legen Sie dann fest, aus welcher Zeile 

und/oder Spalte Namen erzeugt werden sollen: 

 Wenn Sie nur die Option Oberste Zeile einschalten, gibt PlanMaker den Zellen 

unter Januar, Februar und März automatisch den Namen „Januar“, „Februar“ 

beziehungsweise „März“. 

 Wenn Sie nur die Option Linke Spalte einschalten, benennt PlanMaker die 

Zellen neben Kiel, Hamburg und München mit „Kiel“, „Hamburg“ bezie-

hungsweise „München“. 
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 Sie können auch beide Optionen einschalten, worauf PlanMaker alle sechs oben 

aufgeführten Namen anlegt. 

Liste aller Namen ausgeben 

Sie können PlanMaker anweisen, eine Liste aller benannten Bereiche in die Tabelle 

einzufügen. Dies ist praktisch, wenn man einen Überblick haben möchte, welche 

benannten Bereiche sich in der Tabelle befinden und welche Zellen diese umfas-

sen. 

Gehen Sie dazu wie folgt vor: 

1. Steuern Sie die Zelle an, an der die Liste eingefügt werden soll. 

2. Rufen Sie den Befehl Tabelle > Namen > Liste einfügen auf. 

Es wird nun eine Liste aller benannten Bereiche in die Tabelle eingefügt. 

Namen in der Praxis einsetzen 

Wenn Sie mit dem Befehl Tabelle > Namen Zellbereiche benannt haben, können 

Sie verschiedene Operationen wesentlich effizienter durchführen. 

Folgendermaßen setzen Sie benannte Bereiche in der Praxis ein: 

Schnelles Markieren eines benannten Bereichs 

Links oberhalb des Tabellenfensters befindet sich eine aufklappbare Liste, die 

normalerweise anzeigt, in welcher Zelle sich der Zellrahmen gerade befindet.  

 

Wenn Sie diese mit einem Mausklick auf das kleine Pfeilchen rechts daneben öff-

nen, werden alle vorhandenen Bereichsnamen angezeigt. Klicken Sie einen Namen 

an, wird der entsprechende Bereich sofort markiert. 
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Verwenden von Namen in Rechenformeln 

Sie können den Namen eines Bereichs – stellvertretend für die Zellen, die sich da-

rin befinden – in Rechenformeln verwenden. Dies spart Ihnen nicht nur Tipparbeit, 

sondern macht Formeln auch übersichtlicher. 

Ein Beispiel: 

In den Zellen A2 bis A10 haben Sie die Umsätze für den Monat Januar eingetra-

gen. Diesem Bereich geben Sie nun den Namen „Januar“. 

Wenn Sie nun die Summe aller Umsätze vom Januar ermitteln möchten, tippen Sie 

einfach: 

=SUMME(Januar) 

Darunter kann man sich schon wesentlich besser vorstellen, was diese Formel be-

rechnet, als bei der Formel =SUMME(A2:A10). 

Natürlich können Sie nun auch die Umsätze für Februar, März etc. entsprechend 

benennen. 

Tipp: Im Dialogfenster des Befehls Einfügen > Funktion gibt es in der Liste 

Kategorie auch einen Eintrag namens „Benannte Bereiche“. Wenn Sie diesen 

wählen, werden in der Liste Funktion alle benannten Bereiche aufgelistet, so 

dass Sie diese bequem in Formeln einfügen können. 

Namen nachträglich auf Berechnungen anwenden 

Der Befehl Anwenden im Untermenü des Befehls Tabelle > Namen ist ein nützli-

cher Helfer für den Einsatz benannter Bereiche: Er durchsucht alle Formeln im 

markierten Bereich. Findet er innerhalb einer Formel einen Zellbezug, für den be-

reits ein Name definiert wurde, ersetzt er diesen durch den Namen. 

Folgendermaßen setzen Sie diesen Befehl ein: 

1. Markieren Sie den Tabellenbereich, dessen Formeln angepasst werden sollen. 

Wenn Sie nichts markieren, wirkt sich diese Funktion auf die gesamte Tabelle 

aus. 

2. Rufen Sie den Befehl Tabelle > Namen > Anwenden auf. 

3. Selektieren Sie in der Liste Namen alle Namen, die angewandt werden sollen 

oder klicken Sie auf Alle markieren, um alle Namen auszuwählen. 

4. Bestätigen Sie mit OK. 
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PlanMaker durchsucht nun alle Zellbezüge, die in dem markierten Bereich vor-

kommen. Befinden sich darin Zellbezüge, die benannt wurden, ersetzt er sie durch 

den entsprechenden Namen. 

Ein Beispiel: 

Sie haben den Bereich A2 bis A10 „Januar“ genannt. In Ihrer Tabelle befindet sich 

eine Zelle mit der Berechnung =SUMME(A2:A10). Setzen Sie nun den Befehl 

Tabelle > Namen > Anwenden ein, wird die Formel in dieser Zelle in 

=SUMME(Januar) umgewandelt. 

Die Option „Auch relative Bezüge umwandeln“ 

Im obigen Dialog gibt es eine Option namens Auch relative Bezüge umwandeln. 

Normalerweise sollten Sie diese eingeschaltet lassen. 

Diese Option hat folgende Bedeutung: 

Wir haben Ihnen bisher der Einfachheit halber unterschlagen, dass sich Namen 

immer auf Zellbereiche mit absoluter Adressierung (also beispielsweise 

$A$1:$A$10) beziehen. In Berechnungen verwendet man jedoch meist die relative 

Adressierung (zum Beispiel A1:A10).  

Ist diese Option eingeschaltet, werden auch relativ adressierte Zellbezüge umge-

wandelt. 

Wird die Option ausgeschaltet, werden nur absolut adressierte Zellbezüge umge-

wandelt. 

Ein Beispiel: 

Der Bereich von A1 bis A10 (genauer gesagt also $A$1:$A$10) wurde „Januar“ 

genannt. Wenden Sie die Funktion Anwenden nun auf die Berechnung 

=SUMME($A$1:$A$10) an, wird diese in jedem Fall in =SUMME(Januar) um-

gewandelt. Wenden Sie sie jedoch auf die Berechnung =SUMME(A1:A10) an, 

wird diese nur dann umgewandelt, wenn die Option Auch relative Bezüge um-

wandeln eingeschaltet ist. 

Weitere Informationen zum Thema „Relative und absolute Zellbezüge“ finden Sie 

im gleichnamigen Abschnitt ab Seite 442. 
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Sortieren 

Mit dem Befehl Tabelle > Sortieren können Sie Zellen sortieren lassen. 

Markieren Sie die Zellen dazu und rufen Sie den Befehl dann auf. Es erscheint das 

folgende Dialogfenster: 

 

Dieses wird wie folgt bedient: 

 Sortieren nach, Anschließend nach, Anschließend nach 

 Wählen Sie hier die gewünschte(n) Spalte(n) aus, um die Sortierreihenfolge zu 

bestimmen.  

 Wenn Sie mehrere Spalten wählen, wird zuerst nach der Spalte in Sortieren 

nach und dann innerhalb dieser Reihenfolge nach der Spalte in Anschließend 

nach sortiert. Steht also beispielsweise in der ersten Spalte der Nachname und 

in der zweiten der Vorname, können Sie so nach den Nachnamen und innerhalb 

gleicher Nachnamen nach den Vornamen sortieren. 

 Aufsteigend oder Absteigend 

 Über diese Option können Sie bestimmen, in welche Richtung sortiert werden 

soll: Aufsteigend (A...Z) oder Absteigend (Z...A). 

 Zeilenweise sortieren oder Spaltenweise sortieren 

 Diese Option bestimmt, ob zeilen- oder spaltenweise sortiert werden soll. 
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 Erste Zeile enthält Überschriften 

 Wenn die erste Zeile beziehungsweise Spalte der zu sortierenden Zellen Über-

schriften enthält, sollten Sie diese Option einschalten. PlanMaker sortiert diese 

dann nicht mit. 

 Beispiel: Sie haben eine Adressenliste markiert, die Sie zeilenweise sortieren 

möchten. In der ersten Zeile der Markierung stehen Überschriften wie „Name“, 

„Straße“, „Ort“ etc., darunter die Daten. Hier sollten Sie diese Option einschal-

ten, damit diese Zeile nicht mitsortiert wird, sondern weiterhin die erste Zeile 

bleibt. 

 Groß-/Kleinschreibung beachten 

 Schalten Sie diese Option ein, werden Begriffe, bei denen der erste Buchstabe 

klein geschrieben ist, vor Begriffe sortiert, die mit demselben Buchstaben in 

Großschreibung beginnen. 

 Formate mitsortieren 

 Ist diese Option aktiviert, nimmt jede Zelle ihr Format mit, wenn sie durch das 

Sortieren verschoben wird.  

Transponieren 

Der Befehl Tabelle > Transponieren vertauscht die zeilen- und spaltenweise An-

ordnung der markierten Zellen. Zeilen werden also zu Spalten, und Spalten werden 

zu Zeilen. 

Markieren Sie den gewünschten Zellbereich, bevor Sie diesen Befehl anwenden. 

Wichtig! Beachten Sie, dass beim Transponieren keinerlei Rechenformeln oder 

Bereichsnamen auf die dadurch verschobenen Zelladressen angepasst werden – 

weder innerhalb noch außerhalb des transponierten Bereichs! 

Text in Spalten aufteilen 

Mit dem Befehl Tabelle > Text in Spalten aufteilen können Sie Text, der sich in 

einer Tabellenzelle befindet, auf mehrere Tabellenspalten aufteilen. Steht in dieser 
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Zelle beispielsweise ein Satz, verteilt dieser Befehl die einzelnen Wörter auf je-

weils eine Spalte. 

Wenden Sie diesen Befehl wie folgt an: 

1. Navigieren Sie zu der Zelle, die den Text enthält, den Sie auf Spalten verteilen 

möchten.  

 (Sie können auch mehrere Zellen markieren, wenn Sie die Inhalte mehrerer 

Zellen auf einmal auf Spalten verteilen möchten.) 

2. Rufen Sie den Befehl Tabelle > Text in Spalten aufteilen auf. 

3. Es erscheint ein Dialogfenster mit einigen Optionen (siehe unten).  

 In der Regel nimmt PlanMaker alle Einstellungen darin automatisch vor, und 

Sie brauchen nichts zu ändern. 

4. Bestätigen Sie mit OK. 

Der Text in der Zelle wird nun auf mehrere Spalten verteilt. 

Optionen 

Tipp: Die optimalen Einstellungen für dieses Dialogfenster werden nach Analyse 

des Zellinhalts automatisch ermittelt und müssen in der Regel nicht verändert 

werden. 

Das Dialogfenster für diesen Befehl hat folgende Optionen: 

 Zielbereich 

 Hier können Sie auf Wunsch einen anderen Zielbereich eintragen. Der verteilte 

Text landet dann nicht an seiner ursprünglichen Position, sondern an der ange-

gebenen Zielposition.  

 Es genügt, die Adresse der Zelle in der linken oberen Ecke der Zielposition 

anzugeben. 

 Trennzeichen 

 Hier können Sie bei Bedarf festlegen, welches Zeichen PlanMaker als Trenn-

zeichen ansehen soll. Ist in die Zelle beispielsweise der Satz „Dies ist ein Test.“ 

eingetragen, wählt PlanMaker automatisch ein Leerzeichen als Trennzeichen, 

verteilt also jedes Wort auf eine Spalte.  
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 Texterkennungszeichen 

 Falls der Text in der Zelle mit Texterkennungszeichen versehen ist, können Sie 

hier einstellen, welches Zeichen hierfür verwendet wurde (zum Beispiel Anfüh-

rungszeichen).  

 (Hintergrund: Die Text-Exportfunktion mancher Programme umgibt jedes Da-

tenfeld mit einem solchen Texterkennungszeichen, damit genau zu erkennen ist, 

wo jedes Feld beginnt und endet.) 

Filtern 

Sie können einen Tabellenbereich markieren und dann die Daten darin anhand ei-

ner Filterbedingung „filtern“. Alle Zeilen, die dieser Bedingung nicht entsprechen, 

werden daraufhin ausgeblendet.  

Es gibt drei Befehle zum Filtern von Daten, die alle im Untermenü des Befehls 

Tabelle > Filter zu finden sind: 

 Nach Aufruf des Befehls Spezialfilter erscheint ein Dialogfenster, in dem Sie 

eine oder mehrere Filterbedingungen formulieren können. Nach Ihrem OK 

wird der Filter aktiv: alle Zeilen, die der Filterbedingung nicht entsprechen, 

werden ausgeblendet. 

 Der Befehl Alles anzeigen blendet alle ausgeblendeten Zellen wieder ein, hebt 

die Wirkung eines Spezialfilters also wieder auf. 

 Der Befehl AutoFilter bietet nicht so viele Optionen wie der Spezialfilter; er 

ist aber schneller anzuwenden: Rufen Sie diesen Befehl auf, erscheint über je-

der Spalte des markierten Bereichs eine aufklappbare Liste, aus der Sie Filter-

bedingungen blitzschnell auswählen können. 

Ausführliche Informationen zu diesen Befehlen finden Sie auf den nächsten Seiten. 

Spezialfilter 

Über den Befehl Tabelle > Filter > Spezialfilter können Sie die Daten in einem 

Tabellenbereich anhand einer oder mehrerer Bedingungen filtern. Dies bewirkt, 

dass alle Zeilen, die den Bedingungen nicht entsprechen, ausgeblendet werden. 

Gehen Sie dazu wie folgt vor: 
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1. Markieren Sie den gewünschten Tabellenbereich. 

2. Rufen Sie den Befehl Tabelle > Filter auf, worauf sich ein Untermenü öffnet. 

Wählen Sie darin den Befehl Spezialfilter. 

3. Es erscheint ein Dialogfenster. Legen Sie darin eine oder mehrere Filterbedin-

gungen fest (siehe unten). 

4. Bestätigen Sie mit OK. 

Nun werden alle Zeilen, die der Bedingung nicht entsprechen, ausgeblendet.  

Bedingungen formulieren 

Um in das Dialogfenster des Befehls Spezialfilter eine oder mehrere Filterbedin-

gungen einzugeben, gehen Sie wie folgt vor: 

Wählen Sie in der Rubrik Bedingung 1 zunächst links die Spalte aus, der eine Be-

dingung zugeordnet werden soll. Rechts daneben wählen Sie den Operator. Ganz 

rechts geben Sie schließlich den Vergleichswert ein. 

Einige Beispiele: 

Die Bedingung „Spalte A entspricht Kiel“ zeigt nur noch Einträge an, bei denen in 

der Spalte A das Wort Kiel steht. 

Bei der Bedingung „Spalte E größer oder gleich 100000“ werden alle Einträge her-

ausgefiltert, bei denen die Spalte E einen Wert kleiner als 100000 enthält. 

Reicht eine Bedingung nicht aus, so haben Sie die Möglichkeit, bis zu drei Bedin-

gungen miteinander zu verknüpfen, indem Sie auch die Rubriken Bedingung 2 und 

Bedingung 3 ausfüllen. 

Platzhalter verwenden: Die Zeichen * und ? können in Bedingungen als Platzhalter 

für beliebige andere Zeichen verwendet werden: * steht für eine beliebige Anzahl 

an beliebigen Zeichen, ? steht für ein einzelnes beliebiges Zeichen. Die Bedingung 

„NAME entspricht M*er“ trifft also beispielsweise auf die Namen Müller, Meier-

huber etc. zu, die Bedingung NAME = Me?er auf die Namen Meier, Meyer etc. 

Optionen einstellen 

Das Dialogfenster für Spezialfilter verfügt über folgende Optionen: 
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 Bereich enthält Überschriften 

 Wenn die erste Zeile und/oder Spalte der markierten Zellen Überschriften ent-

hält, sollten Sie diese Option einschalten. PlanMaker ignoriert diese Zei-

le/Spalte dann beim Filtern, zeigt dafür aber in den Listen zum Formulieren von 

Bedingungen nicht Spalte A, Spalte B etc. sondern diese Überschriften an. 

 Groß-/Kleinschreibung beachten 

 Wenn diese Option eingeschaltet ist, wird die Groß-/Kleinschreibung in Bedin-

gungen beachtet. Bei der Bedingung „SPALTE A entspricht Meyer“ passieren 

den Filter also nur Zeilen, bei denen in der Spalte A „Meyer“ steht. Zeilen mit 

„MEYER“ oder „meyer“ werden hingegen herausgefiltert. 

 Modus 

 Bestimmt, ob Zeilen oder Spalten gefiltert werden sollen. 

 Wählen Sie die Option Zeilenweise filtern, werden alle Zeilen herausgefiltert, 

die den Bedingungen nicht entsprechen. 

 Wählen Sie hingegen die Option Spaltenweise filtern, werden alle Spalten 

herausgefiltert. 

 Ergebnisse 

 Bestimmt, ob der Filter auf die Originaldaten oder auf eine Kopie davon ange-

wandt werden soll: 

 Wählen Sie die Option An Ort und Stelle filtern werden – wie zuvor be-

schrieben – die Originaldaten gefiltert. Zeilen/Spalten, die der Filterbedingung 

nicht entsprechen, werden also ausgeblendet. 

 Wählen Sie hingegen die Option An folgende Stelle kopieren, wird eine Kopie 

der Originaldaten an der angegebenen Zelladresse erstellt. Diese Kopie enthält 

nur die gefilterten Daten.  

 Geben Sie dazu in das Eingabefeld unter dieser Option ein, an welcher Stelle 

die Kopie eingefügt werden soll. Sie können entweder eine einzelne Zelladresse 

angeben (hier wird dann die linke obere Ecke der Kopie platziert) oder den 

Zellbereich, in den die Kopie gesetzt werden soll, genau festlegen. Vorsicht: 

Passt die Kopie nicht in diesen Bereich hinein, wird entsprechend abgeschnit-

ten. 
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Ausgeblendete Zeilen wieder einblenden 

Möchten Sie, dass alle per Filter ausgeblendeten Zeilen wieder sichtbar werden, 

dann rufen Sie den Befehl Tabelle > Filter > Alles anzeigen auf. 

AutoFilter 

Eine praktische „Abkürzung“ zum dem im letzten Abschnitt vorgestellten Spezial-

filter stellt der Befehl Tabelle > Filter > AutoFilter dar.  

Um diese Funktion zu verwenden, gehen Sie wie folgt vor: 

1. Markieren Sie den gewünschten Tabellenbereich. Wichtig: Die erste Zeile des 

Bereichs sollte Überschriften für die darunter liegenden Daten enthalten. 

2. Rufen Sie den Befehl Tabelle > Filter auf, worauf sich ein Untermenü öffnet. 

Wählen Sie darin den Befehl AutoFilter. 

Die AutoFilter-Funktion ist nun aktiviert. Sie erkennen das daran, dass in der ersten 

Zeile des markierten Bereichs ein nach unten weisender Pfeil für jede Spalte ange-

zeigt wird.  

Klicken Sie diesen Pfeil an, öffnet sich in eine Liste, in der alle in der Spalte vor-

kommenden Inhalte aufgeführt sind. Wählen Sie einen der Inhalte, führt PlanMa-

ker sofort eine entsprechende Filterung durch. Wählen Sie beispielsweise in einer 

Spalte mit der Überschrift „Name“ den Inhalt „Meier“, haben Sie damit einen Fil-

ter mit der Bedingung „Name entspricht Meier“ definiert. Alle Zeilen, die dieser 

Bedingung nicht entsprechen, werden ausgeblendet. 

Neben den Zellinhalten finden Sie in der Liste zusätzlich noch folgende Einträge 

mit nützlichen zusätzlichen Bedingungen: 

 Alle: Alle Zeilen anzeigen (keine Filterung mehr vornehmen). 

 Benutzerdefiniert: Öffnet einen Dialog, in dem Sie (ähnlich einem Spezialfil-

ter) eine genauere Filterbedingung festlegen können. 

 Top 10: Nur noch die Zeilen mit den 10 höchsten oder niedrigsten Werten an-

zeigen. 

 Nur leere: Nur noch Zeilen anzeigen, bei denen in dieser Spalte nichts einge-

tragen ist. 

 Nicht leere: Nur noch Zeilen anzeigen, bei denen in dieser Spalte irgendetwas 

eingetragen ist. 
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Ausgeblendete Zeilen wieder einblenden 

Um einen AutoFilter zu deaktivieren, rufen Sie den Befehl Tabelle > Filter > Au-

toFilter einfach noch einmal auf. 

Hinweis: Wenn Sie die AutoFilter-Funktion deaktivieren, bleiben alle ausge-

blendeten Zeilen auch weiterhin ausgeblendet. Möchten Sie, dass diese Zeilen 

wieder sichtbar werden, dann rufen Sie den Befehl Tabelle > Filter > Alles an-

zeigen auf. 

Analysieren von Tabellen 

In PlanMaker stehen Ihnen verschiedene Werkzeuge zum Analysieren der Zellin-

halte und Rechenformeln in einer Tabelle zur Verfügung. Diese können insbeson-

dere bei der Fehlersuche sehr hilfreich sein. 

Im Einzelnen gibt es hierfür folgende Werkzeuge: 

 Formelanzeige 

 Wenn Sie den Befehl Ansicht > Formelanzeige aufrufen, werden bei Berech-

nungen die Rechenformeln statt der Ergebnisse angezeigt. 

 Syntaxhervorhebung 

 Wenn Sie den Befehl Ansicht > Syntaxhervorhebung aufrufen, werden alle 

Zellinhalte Ihrem Inhalt entsprechend farblich gekennzeichnet. Zellen, die ei-

nen Fehler enthalten, erscheinen in roter Schrift, Zellen mit einer Berechnung 

in grüner Schrift etc. 

 Beobachtungsfenster für Zellinhalte 

 Mit dem Befehl Ansicht > Beobachtungsfenster können Sie jederzeit ein Be-

obachtungsfenster für Zellen einblenden. Mit dessen Hilfe lässt sich der Inhalt 

der gewählten Zellen permanent überwachen. 

 Formelüberwachung 

 Der Befehl Weiteres > Formelüberwachung bietet Funktionen zur grafischen 

Darstellung der Beziehungen zwischen Zellen an. Enthält die aktuelle Zelle 

beispielsweise eine Rechenformel, die sich auf andere Zellen bezieht, können 

Sie PlanMaker Pfeile zu diesen Zellen einblenden lassen. 
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 Weiterhin lassen sich mit diesem Befehl Fehler in der Tabelle aufspüren oder 

ungültige Daten mit roten Kringeln kennzeichnen. 

Ausführliche Informationen zu diesen Funktionen finden Sie auf den nächsten Sei-

ten. 

Formelanzeige 

Wenn Sie die Formelanzeige einschalten, werden bei Berechnungen die Rechen-

formeln statt der Ergebnisse angezeigt. Dies kann bei der Analyse der Formeln in 

einer Tabelle und bei der Fehlersuche nützlich sein.  

Formelanzeige ein- und ausschalten 

Um die Formelanzeige einzuschalten, rufen Sie den Befehl Ansicht > Formelan-

zeige auf.  

Wenn Sie den Befehl noch einmal aufrufen, wird sie wieder deaktiviert. 

Syntaxhervorhebung 

Wenn Sie die Syntaxhervorhebung aktivieren, werden alle Zellinhalte Ihrem Inhalt 

entsprechend farblich gekennzeichnet. Zellen, die einen Fehler enthalten, erschei-

nen in roter Schrift, Zellen mit einer Berechnung in grüner Schrift etc. 

So können Sie auf einen Blick sehen, wo sich Formeln befinden und wo fest ein-

gegebene Werte, wo Fehler auftreten usw. 

Syntaxhervorhebung ein- und ausschalten 

Um die Syntaxhervorhebung einzuschalten, rufen Sie den Befehl Ansicht > Syn-

taxhervorhebung auf.  

Wenn Sie den Befehl noch einmal aufrufen, wird sie wieder deaktiviert. 

Bedeutung der Vordergrundfarbe 

Bei aktivierter Syntaxhervorhebung werden die Zellen mit folgenden Farben einge-

färbt: 
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Zellinhalt Farbe 

Fehlerwert Rot 

Formel Grün 

Fest eingegebene positive Zahl Dunkelblau 

Fest eingegebene negative Zahl Hellblau 

Fest eingegebener Wahrheitswert Braun 

Fest eingegebene Zeichenkette Schwarz 

Bedeutung der Hintergrundfarbe 

Zellen, die einen Fehler enthalten, werden also in roter Farbe dargestellt. Bei 

schwerwiegenden Fehlern wird die Zelle außerdem mit einem farbigen Hinter-

grund versehen. Dessen Farbe zeigt an, um welche Art von Fehler es sich handelt: 

Hintergrundfarbe Art des Fehlers 

Weiß Die Formel liefert einen Fehlerwert. Die Berechnung in 

dieser Zelle liefert einen Fehlerwert, weil sie beispielsweise 

eine Division durch Null enthält. 

 Abhilfe: Setzen Sie den Zellrahmen auf diese Zelle, worauf 

eine Fehlermeldung in der Statuszeile erscheint. Korrigieren 

Sie die Formel entsprechend. 

Zyanblau Schwerwiegender Fehler in der Formel. Die Formel in 

dieser Zelle ist falsch formuliert, weil beispielsweise eine 

schließende Klammer fehlt oder eine Funktion nicht mit den 

korrekten Argumenten aufgerufen wurde. 

 Abhilfe: Setzen Sie den Zellrahmen auf diese Zelle, worauf 

eine Fehlermeldung in der Statuszeile erscheint. Korrigieren 

Sie die Formel entsprechend. Wenn Sie dies nicht tun, wird 

die Formel beim Speichern entfernt und durch den Fehler-

wert #NULL! ersetzt! 

Hellgrau Nicht exportierbare Funktion. Die Formel in dieser Zelle 

verwendet eine Rechenfunktion, die das Dateiformat, in dem 

Sie das Dokument gespeichert haben, nicht unterstützt. 
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 Abhilfe: Ersetzen Sie die Funktion durch eine andere Funk-

tion, die zum gewünschten Dateiformat kompatibel ist. In-

formationen dazu finden Sie bei der Beschreibung der betref-

fenden Funktion. 

Magentarot Möglicherweise falsch importierte Funktion. Die Formel 

in der Zelle enthält eine Rechenfunktion, die PlanMaker 

zwar bekannt ist, von ihm aber anders verwendet wird als 

von der Vorgängerversion PlanMaker 97. Tritt beim Import 

von PlanMaker 97-Dokumenten mit Zeit-Funktionen auf. 

 Abhilfe: Lesen Sie die Informationen bei der Beschreibung 

der betreffenden Funktion. 

Gelb Unbekannte Funktion. Die Formel in dieser Zelle enthält 

eine Rechenfunktion, die PlanMaker nicht bekannt ist. Tritt 

beim Import von Fremdformaten (z.B. Microsoft Excel) auf. 

 Abhilfe: Ersetzen Sie die Funktion durch eine entsprechende 

PlanMaker-Funktion. Informationen über alle verfügbaren 

Rechenfunktionen finden Sie im Abschnitt „Funktionen von 

A-Z“ ab Seite 455. 

Beobachtungsfenster für Zellinhalte 

Sie können jederzeit ein Beobachtungsfenster für Zellen einblenden. Mit dessen 

Hilfe lässt sich der Inhalt der gewählten Zellen permanent überwachen.  

 

Beobachtungsfenster ein- und ausschalten 

Um das Beobachtungsfenster einzublenden, rufen Sie den Befehl Ansicht > Be-

obachtungsfenster auf.  
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Wenn Sie den Befehl noch einmal aufrufen, wird das Fenster wieder ausgeblendet. 

Zellen zum Beobachtungsfenster hinzufügen 

Um den Inhalt einer Zelle zu überwachen, fügen Sie diese dem Beobachtungsfens-

ter hinzu. Gehen Sie dazu wie folgt vor: 

1. Klicken Sie im Beobachtungsfenster auf die Schaltfläche Zelle hinzufügen. 

2. Geben Sie die Adresse der Zelle ein und bestätigen Sie mit OK. 

 Tipp: Sie können auch einen ganzen Zellbereich angeben. Tragen Sie als Ad-

resse beispielsweise A1:A3 ein, werden die Zellen A1, A2 und A3 hinzugefügt. 

Der Inhalt der angegebenen Zellen wird nun im Beobachtungsfenster angezeigt. 

Bei jeder Neuberechnung der Tabelle wird auch das Beobachtungsfenster aktuali-

siert. 

Zellen aus dem Beobachtungsfenster entfernen 

Wenn Sie eine Zelle nicht mehr überwachen möchten, können Sie diese jederzeit 

aus dem Beobachtungsfenster entfernen. Selektieren Sie die Zelle dazu im Be-

obachtungsfenster und klicken Sie auf die Schaltfläche Zelle entfernen. 

Sie können auch alle beobachteten Zellen auf einmal entfernen, indem Sie auf die 

Schaltfläche Alle entfernen klicken. 

Formelüberwachung 

Der Befehl Weiteres > Formelüberwachung bietet Funktionen zur grafischen 

Darstellung der Beziehungen zwischen Zellen an. Enthält die aktuelle Zelle bei-

spielsweise eine Rechenformel, die sich auf andere Zellen bezieht, können Sie 

PlanMaker Pfeile zu diesen Zellen einblenden lassen. 

Weiterhin lassen sich mit diesem Befehl Fehler in der Tabelle aufspüren oder un-

gültige Daten mit roten Kringeln kennzeichnen. 

Wenn Sie den Befehl Weiteres > Formelüberwachung aufrufen, öffnet sich ein 

Untermenü, das entsprechende Kommandos bereithält. Nach Themen geordnet 

stehen darin folgende Funktionen zur Verfügung: 



 

Handbuch PlanMaker Bearbeiten einer Tabelle    107 

 Anzeigen der Beziehungen zwischen Zellen 

 Der Befehl Weiteres > Formelüberwachung bietet unter anderem Komman-

dos, mit denen sich die Beziehungen zwischen Zellen grafisch darstellen lassen. 

So können Sie beispielsweise Pfeile zu allen Zellen einblenden, auf die sich die 

Rechenformel in der aktuellen Zelle bezieht. Enthält die Zelle also die Berech-

nung =A1*A2, erscheinen Pfeile zu den Zellen A1 und A2. 

 Selektieren der mit einer Zelle verbundenen Zellen 

 Darüber hinaus gibt es Kommandos zum Selektieren aller Zellen, auf die sich 

die Rechenformel in der aktuellen Zelle bezieht. Oder umgekehrt aller Zellen, 

die sich auf die aktuelle Zelle beziehen. 

 Fehler in Berechnungen aufspüren 

 Außerdem können Sie auf die vorherige oder nächste Zelle springen, die einen 

Fehlerwert enthält, und Pfeile zur Quelle des Fehlers einblenden lassen. 

 Ungültige Daten in Zellen aufspüren 

 Schließlich lassen sich alle Zellen aufspüren, deren Inhalt der Gültigkeitsprü-

fung für die entsprechende Zelle nicht entspricht. 

Ausführliche Informationen zu diesen Themen finden Sie auf den nächsten Seiten. 

Tipp: Verwenden der Formelüberwachungsleiste 

Am schnellsten lassen sich die Funktionen dieses Befehls über die Formelüberwa-

chungsleiste aufrufen. 

 

Sie können diese Leiste jederzeit ein- oder ausblenden, indem Sie den Befehl Wei-

teres > Formelüberwachung > Formelüberwachungsleiste anzeigen aufrufen. 

Die Leiste verfügt über folgende Schaltflächen (von links nach rechts): 

 Spur zu den Vorgängern 

 Spuren zu den Vorgängern entfernen 

 Spur zu den Nachfolgern 

 Spuren zu den Nachfolgern entfernen 

 Alle Spuren entfernen 

 Spur zum Fehler 
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 Ungültige Daten markieren 

 Markierung für ungültige Daten entfernen 

 Gehe zum vorhergehenden Fehler 

 Gehe zum nächsten Fehler 

 Gehe zur vorhergehenden ungültigen Zelle 

 Gehe zur nächsten ungültigen Zelle 

Informationen zur Funktion der einzelnen Symbole folgen auf den nächsten Seiten. 

Anzeigen der Beziehungen zwischen Zellen 

Der Befehl Weiteres > Formelüberwachung bietet unter anderem Kommandos, 

mit denen sich die Beziehungen zwischen Zellen grafisch darstellen lassen.  

 

Steuern Sie dazu die Zelle an, die Sie analysieren möchten, und rufen Sie dann 

eines der folgenden Kommandos im Untermenü dieses Befehls auf: 

 Spur zu den Vorgängern 

 Dieser Befehl blendet Pfeile zu allen Zellen ein, auf die sich die Rechenformel 

in der aktuellen Zelle bezieht. 

 Beispiel: Enthält die aktuelle Zelle die Berechnung =A1*A2, zeigt dieser Be-

fehl Pfeile zu den Zellen A1 und A2 an. 

 Spuren zu den Vorgängern entfernen 

 Blendet alle Pfeile, die mit dem obigen Befehl eingeblendet wurden, für die 

aktuelle Zelle wieder aus. 

 Spur zu den Nachfolgern 

 Blendet Pfeile zu allen Zellen ein, die sich auf die aktuelle Zelle beziehen. 

 Beispiel: Enthält eine beliebige Zelle die Berechnung =B5*2, zeigt dieser Be-

fehl einen Pfeil zu dieser Zelle an, wenn Sie ihn in der Zelle B5 aufrufen. 
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 Spuren zu den Nachfolgern entfernen 

 Blendet alle Pfeile, die mit dem obigen Befehl eingeblendet wurden, für die 

aktuelle Zelle wieder aus. 

 Alle Spuren entfernen 

 Blendet alle Pfeile, die mit den Befehlen Spur zu den Vorgängern oder Spur 

zu den Nachfolgern eingeblendet wurden, für die gesamte Arbeitsmappe wie-

der aus. 

Anmerkungen und Tipps 

 Sie können die Befehle Spur zu den Vorgängern und Spur zu den Nachfol-

gern in einer Zelle auch mehrmals hintereinander aufrufen. Bei jedem Aufruf 

wird eine weitere Ebene von Beziehungen angezeigt. 

 Die Pfeile, die sich mit obigen Befehlen einblenden lassen, sind anklickbar. 

Wenn Sie auf einen solchen Pfeil klicken, springt PlanMaker zu der Zelle, die 

sich am anderen Ende des Pfeils befindet. 

 Falls sich die aktuelle Zelle auf eine Zelle bezieht, die sich auf einem anderen 

Arbeitsblatt befindet, wird nur ein kleiner Pfeil in der linken oberen Ecke der 

Zelle angezeigt. Auch diesen Pfeil können Sie anklicken, um blitzschnell zu der 

entsprechenden Zelle zu gelangen. 

 Wenn Sie den Inhalt einer Zelle bearbeiten, die Zelle löschen oder sie verschie-

ben, werden alle Pfeile zu dieser Zelle automatisch entfernt. 

 Alle eingeblendeten Pfeile erscheinen auch im Ausdruck. 

 Im Dokument werden die Pfeile allerdings nicht gespeichert. Wenn Sie das Do-

kument also speichern und erneut öffnen, sind alle Pfeile wieder entfernt.  

Selektieren der mit einer Zelle verbundenen Zellen 

Der Befehl Weiteres > Formelüberwachung bietet unter anderem Kommandos, 

mit denen Sie diejenigen Zellen selektieren können, die eine Beziehung zur aktuel-

len Zelle haben. 

Steuern Sie dazu die gewünschte Zelle an und rufen Sie dann eines der folgenden 

Kommandos im Untermenü für diesen Befehl auf: 
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 Vorgänger selektieren 

 Dieser Befehl selektiert alle Zellen, auf die sich die Rechenformel in der aktuel-

len Zelle bezieht. 

 Beispiel: Enthält die aktuelle Zelle die Berechnung =A1*A2, selektiert dieser 

Befehl die Zellen A1 und A2. 

 Nachfolger selektieren 

 Selektiert alle Zellen, die sich auf die aktuelle Zelle beziehen. 

 Beispiel: Enthält eine beliebige Zelle die Berechnung =B5*2, selektiert dieser 

Befehl diese Zelle, wenn Sie ihn in der Zelle B5 aufrufen. 

Fehler in Berechnungen aufspüren 

Der Befehl Weiteres > Formelüberwachung bietet unter anderem Kommandos, 

mit denen sich Zellen finden und analysieren lassen, die einen Fehlerwert liefern.  

Anmerkung: Eine Zelle liefert dann einen Fehlerwert, wenn in der Berechnung, die 

sie enthält, ein Fehler auftritt. Enthält eine Zelle beispielsweise eine Division durch 

Null, wird darin der Fehlerwert #DIV/0 angezeigt. (Weitere Informationen zu Feh-

lerwerten finden Sie im Abschnitt „Fehlerwerte“ ab Seite 448.) 

Verwenden Sie zur Fehlersuche die folgenden Kommandos im Untermenü des Be-

fehls Weiteres > Formelüberwachung: 

 Spur zum Fehler 

 Falls die aktuelle Zelle einen Fehlerwert enthält, blendet dieser Befehl Pfeile zu 

den Zellen ein, die diesen Fehlerwert versuchen (sofern anwendbar). 

 Beispiel: Wenn eine Zelle den Fehlerwert #DIV/0 liefert und sie diesen Befehl 

dort aufrufen, erscheinen Pfeile auf die Zellen, die diese Division durch Null 

verursachen. 

 Gehe zum vorhergehenden Fehler 

 Springt zur vorherigen Zelle mit einem Fehlerwert. 

 Gehe zum nächsten Fehler 

 Springt zur nächsten Zelle mit einem Fehlerwert. 
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Ungültige Daten in Zellen aufspüren 

Der Befehl Weiteres > Formelüberwachung bietet unter anderem Kommandos, 

mit denen sich Zellen aufspüren lassen, die einen ungültigen Wert enthalten. 

Anmerkung: Eine Zelle enthält dann einen ungültigen Wert, wenn mit dem Befehl 

Format > Gültigkeitsprüfung festgelegt wurde, dass die Zelle nur bestimmte 

Werte enthalten darf, und der aktuelle Zellinhalt dieser Prüfung nicht entspricht. 

(Weitere Informationen dazu finden Sie im Abschnitt „Gültigkeitsprüfung“ ab Seite 

186.) 

Verwenden Sie zur Fehlersuche die folgenden Kommandos im Untermenü des Be-

fehls Weiteres > Formelüberwachung: 

 Ungültige Daten markieren 

 Dieser Befehl umgibt alle Zellen auf dem aktuellen Arbeitsblatt, die einen un-

gültigen Wert enthalten, mit einem roten Kringel. 

 Markierung für ungültige Daten entfernen 

 Entfernt alle Kringel (auf dem aktuellen Arbeitsblatt) wieder. 

 Gehe zur vorhergehenden ungültigen Zelle 

 Springt zur vorherigen Zelle mit einem ungültigen Wert. 

 Gehe zur nächsten ungültigen Zelle 

 Springt zur nächsten Zelle mit einem ungültigen Wert. 

Anmerkungen 

 Die Markierungen für ungültige Daten erscheinen auch im Ausdruck.  

 Im Dokument werden die Markierungen allerdings nicht gespeichert. Wenn Sie 

das Dokument also speichern und erneut öffnen, sind alle Markierungen wieder 

entfernt.  
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Aktualisieren von Tabellen 

Sämtliche Berechnungen in einer Tabelle werden automatisch stets auf dem neues-

ten Stand gehalten. Dazu rechnet PlanMaker jedes Mal, wenn Sie einen Zellinhalt 

abändern, die gesamte Tabelle neu durch.  

Normalerweise müssen Sie sich um dieses Thema also überhaupt nicht kümmern. 

Deaktivieren der automatischen Neuberechnung 

Bei Bedarf können Sie das automatische Neuberechnen aller Berechnungen auch 

abschalten. Dies ist beispielsweise bei sehr rechenintensiven Tabellen nützlich, bei 

denen das Neuberechnen einige Zeit dauert. 

Ändern Sie dazu die Einstellung Neuberechnung in den Dokumenteigenschaften 

entsprechend. Siehe Abschnitt „Dokumenteigenschaften, Karteikarte Berechnen“ 

(ab Seite 407). 

Das Aktualisieren der Tabelle muss dann manuell erfolgen. Hierfür gibt es folgen-

de Tasten beziehungsweise Menübefehle: 

 Wenn Sie die Taste (F9) betätigen oder den Befehl Weiteres > Neu berechnen 

aufrufen, aktualisiert PlanMaker die Berechnungen auf allen Arbeitsblättern. 

 Wenn Sie hingegen (ª)(F9) drücken, aktualisiert PlanMaker nur die Berech-

nungen auf dem aktuellen Arbeitsblatt.  

Hinweis: Letzteres kann zu veralteten Ergebnissen führen, falls das aktuelle 

Arbeitsblatt Berechnungen mit Zellen auf anderen Arbeitsblättern durchführt. 

Aktualisieren externer Zellbezüge 

Beachten Sie, dass externe Zellbezüge nicht bei jedem Neuberechnen der Arbeits-

mappe aktualisiert werden.  

(Externe Zellbezüge sind Zellbezüge, die sich auf Zellen in einer anderen Arbeits-

mappe beziehen – also beispielsweise ='C:\Mein Verzeichnis\[Meine Arbeitsmap-

pe.pmd]Tabelle1'!A1.) 

Solche Zellbezüge werden nur beim Öffnen des Dokuments, das die externen Be-

züge enthält, automatisch aktualisiert. Außerdem können Sie externe Bezüge jeder-

zeit manuell aktualisieren. 
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Ausführliche Informationen zum Arbeiten mit externen Zellbezügen finden Sie im 

Abschnitt „Externe Zellbezüge“ (ab Seite 444). 

Kommentare einfügen 

Mit dem Befehl Einfügen > Kommentar können Sie die aktuelle Tabellenzelle 

mit einem Kommentar versehen – zum Beispiel: „Hier müssen noch die Daten vom 

Vorjahr eingetragen werden!“. 

Folgendermaßen arbeiten Sie mit Kommentaren: 

Anbringen von Kommentaren 

Um einen Kommentar anzubringen, steuern Sie die gewünschte Zelle an und rufen 

den Befehl Einfügen > Kommentar auf. Es erscheint ein gelbes Rechteck, in das 

Sie den Kommentar eintippen. Um Ihre Eingabe abzuschließen, klicken Sie an eine 

beliebige Stelle außerhalb des gelben Rechtecks oder drücken die Taste (Esc). 

Kommentare werden im Dokument gespeichert, stehen also wieder zur Verfügung, 

wenn Sie das Dokument das nächste Mal öffnen. 

Ansehen von Kommentaren 

Bei Zellen, die mit einem Kommentar versehen sind, wird in der rechten oberen 

Ecke ein gelbes Dreieck angezeigt. Zeigen Sie mit der Maus auf eine solche Zelle, 

wird nach kurzer Zeit automatisch der Kommentar eingeblendet. Er verschwindet 

wieder, wenn Sie die Maus aus der Zelle herausbewegen. 

Ändern von Kommentaren 

Um einen Kommentar abzuändern, rufen Sie den Befehl Einfügen > Kommentar 

in der betreffenden Zelle noch einmal auf und nehmen die gewünschten Änderun-

gen vor. 

Tipp: Alternativ können Sie auch einen Doppelklick auf das gelbe Dreieck in der 

Zelle durchführen oder die Tastenkombination (ª)(F2) betätigen, um den Kom-

mentar zu einer Zelle zu bearbeiten. 
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Wenn Sie mit den Änderungen fertig sind, klicken Sie an eine beliebige Stelle au-

ßerhalb des Kommentars oder drücken die Taste (Esc). 

Löschen von Kommentaren 

Um Kommentare von Zellen zu entfernen, markieren Sie die betreffenden Zellen 

und rufen den Befehl Bearbeiten > Selektiv löschen auf. Es öffnet sich ein Un-

termenü, aus dem Sie die Option Kommentare wählen. Die Kommentare werden 

daraufhin gelöscht. 

Zielwertsuche 

Mit dem Befehl Weiteres > Zielwertsuche können Sie herausfinden, welchen 

Wert ein bestimmter Bestandteil einer Berechnung annehmen muss, damit ein vor-

gegebenes Ergebnis herauskommt.  

Hinweis: Bei der Zielwertsuche handelt es sich nicht um „schwarze Magie“ oder 

künstliche Intelligenz, sondern um ein simples mathematisches Näherungsver-

fahren (Iterationsverfahren) – und wie bei allen Näherungsverfahren muss das 

Ergebnis nicht unbedingt exakt sein. 

Steuern Sie, bevor Sie diesen Befehl aufrufen, mit dem Zellrahmen die Zelle an, in 

der die Rechenformel enthalten ist. 

 

Nach dem Aufruf meldet sich der Befehl mit einem Dialogfenster. Dieses wird wie 

folgt bedient: 
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 In Formelzelle geben Sie – sofern PlanMaker nicht schon den richtigen Eintrag 

ermitteln konnte – die Adresse der Zelle mit der Rechenformel ein.  

 In Zielwert tippen Sie das gewünschte Ergebnis ein. 

 In Variable Zelle tippen Sie die Adresse derjenigen Zelle ein, in der PlanMaker 

so lange verschiedene Werte ausprobieren soll, bis in der Formelzelle das ge-

wünschte Ergebnis steht. 

 Bei Genauigkeit können Sie die Genauigkeit der Annäherung festlegen. Plan-

Maker wird solange versuchen, Werte anzunähern, bis der Unterschied zum 

Zielwert kleiner als der Parameter Genauigkeit ist.  

Wenn PlanMaker auch nach mehreren Sekunden keinen ausreichend genauen Wert 

finden kann, so lässt sich dieser nicht durch Näherung ermitteln. PlanMaker bricht 

die Suche dann ab. 

Ein Beispiel 

In der weiter unten abgebildeten Tabelle wurde in Zelle A5 die Summenfunktion 

verwendet, um die Zahlen 1, 2 und 3 in den Zellen A2, A3 und A4 zu addieren. Als 

Ergebnis in A5 kommt 6 heraus. Wir möchten nun wissen, auf welchen Wert bei-

spielsweise die Zelle A3 geändert werden muss, damit das Ergebnis der Addition 7 

ist.  

Wir steuern dazu die Zelle mit der Berechnung an, deren Ergebnis wir verändern 

möchten – hier also die Zelle A5 mit der Summenformel – und rufen die Zielwert-

suche auf. 
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In der Abbildung sehen Sie, wie das Dialogfenster für die Berechnung ausgefüllt 

werden muss. Nach Ihrem OK startet PlanMaker die Annäherung und meldet das 

Ergebnis 3 in einem Dialogfenster. 

Der Inhalt der Zelle A3 muss also von 2 auf 3 geändert werden, damit die Berech-

nung das Ergebnis 7 hat. Wenn Sie in dem Dialogfenster auf Übernehmen klicken, 

wird der gefundene Wert in Zelle A3 übernommen. 

Szenarien 

Der Befehl Weiteres > Szenarien erlaubt das Anlegen und Anzeigen von „Szena-

rien“. 

Mit Hilfe von Szenarien können Sie beobachten, welche Auswirkungen das Än-

dern der Werte in bestimmten Zellen auf die Berechnungen in einem Arbeitsblatt 

hat. Dies ermöglicht das Durchführen von „Was-wäre-wenn“-Analysen aller Art. 

Beispiel: Wie ändern sich die Gesamtkosten eines Kredits, wenn die Laufzeit 24, 

36 oder 96 Monate beträgt? 

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit Szenarien. 

Folgende Themen werden darin behandelt: 

 Erstellen von Szenarien 
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 Anzeigen von Szenarien 

 Verwalten von Szenarien 

 Zusammenführen von Szenarien 

 Anlegen eines Szenarioberichts 

Lesen Sie dazu die nächsten Seiten. 

Erstellen von Szenarien 

Um Szenarien zu erstellen, füllen Sie zunächst ein Arbeitsblatt mit den gewünsch-

ten Werten und Berechnungen aus. 

Dann gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Weiteres > Szenarien auf. 

2. Klicken Sie auf Hinzufügen. 

3. Geben Sie bei Szenarioname einen beschreibenden Namen für das Szenario 

ein. 

4. Geben Sie bei Veränderbare Zellen die Adresse der Zelle ein, deren Inhalt 

verändert werden soll.  

 Sie können auch mehrere Zellen angeben. Trennen Sie die Zelladressen dazu 

mit einem Strichpunkt – zum Beispiel: A2;A4;A10. Auch Zellbereiche wie 

B5:B10 sind erlaubt. 

5. Klicken Sie auf die Schaltfläche Weiter, um fortzufahren. 

6. Es erscheint ein weiterer Dialog. Tragen Sie darin den Wert ein, der in diesem 

Szenario in die „veränderbare Zelle“ eingesetzt werden soll. 

 Falls Sie in dem Szenario mehrere veränderbare Zellen definiert haben, enthält 

dieser Dialog eine Liste all dieser Zellen. Klicken Sie darin auf jeden einzelnen 

Listeneintrag und tragen Sie daneben jeweils den gewünschten Zellwert ein. 

7. Bestätigen Sie mit OK. 

8. Wiederholen Sie die Schritte 2. bis 7. für alle weiteren Szenarien, die Sie anle-

gen möchten. 

9. Wenn Sie fertig sind, verlassen Sie den Dialog mit Schließen. 
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Die gewünschten Szenarien wurden nun angelegt. Um zu erfahren, wie Sie diese 

anzeigen, lesen Sie bitte den nächsten Abschnitt. 

Optionen 

Im Dialogfenster für das Hinzufügen von Szenarien gibt es folgende zusätzlichen 

Optionen: 

 Kommentar 

 Hier können Sie einen beschreibenden Kommentar für das Szenario eingeben. 

 Änderungen verhindern 

 Ist diese Option eingeschaltet, lässt sich das Szenario nicht mehr bearbeiten 

oder löschen, wenn Sie den Blattschutz aktivieren. 

 Ausblenden 

 Ist diese Option eingeschaltet, wird das Szenario nicht mehr in der Liste der 

Szenarien angezeigt, wenn Sie den Blattschutz aktivieren. 

Allgemeine Informationen zum Verwenden eines Blattschutzes finden Sie im Ab-

schnitt „Blattschutz“ (Seite 355). 

Anzeigen von Szenarien 

Wenn Sie, wie im vorherigen Abschnitt beschrieben, Szenarien angelegt haben, 

können Sie diese jederzeit anzeigen. 

Gehen Sie dazu wie folgt vor: 

1. Rufen Sie den Befehl Weiteres > Szenarien auf. 

2. Wählen Sie das anzuzeigende Szenario in der Liste Szenarien. 

3. Klicken Sie auf Anzeigen. 

Tipp: Schneller geht dies, wenn Sie in der Liste einfach einen Doppelklick 

auf das anzuzeigende Szenario durchführen. 

Das gewählte Szenario wird nun angezeigt.  



 

Handbuch PlanMaker Bearbeiten einer Tabelle    119 

Durch das Wechseln zwischen verschiedenen Szenarien können Sie nun also ver-

gleichen, wie sich das Ändern der im Szenario festgelegten Zellen jeweils auf die 

Berechnungen auswirkt, die sich auf diese Zellen beziehen. 

Hinweis: Beim Anzeigen eines Szenarios werden die Werte in den angegebenen 

„veränderbaren Zellen“ physikalisch durch die Werte ersetzt, die im Szenario fest-

gelegt wurden. Die alten Zellinhalte gehen für diese Zellen also verloren. 

Verwalten von Szenarien 

Sie können den Befehl Weiteres > Szenarien auch verwenden, um die im aktuel-

len Arbeitsblatt angelegten Szenarien zu verwalten.  

Verwenden Sie dazu die folgenden Schaltflächen im Dialogfenster für diesen Be-

fehl: 

 Hinzufügen 

 Legt ein neues Szenario an. 

 Siehe dazu Abschnitt „Erstellen von Szenarien“ (Seite 117). 

 Löschen 

 Löscht das momentan in der Liste gewählte Szenario. 

 Bearbeiten 

 Öffnet einen Dialog, in dem Sie die Einstellungen für das gewählte Szenario 

bearbeiten können. Wenn Sie darin auf die Schaltfläche Weiter klicken, er-

scheint ein weiterer Dialog, in dem Sie die Werte für die veränderbaren Zellen 

ändern können. 

 Zusammenführen 

 Führt Szenarien, die sich in anderen Arbeitsblättern (oder Arbeitsmappen) be-

finden, auf dem aktuellen Arbeitsblatt zusammen.  

 Siehe dazu Abschnitt „Zusammenführen von Szenarien“ (Seite 120). 

 Zusammenfassung 

 Erstellt einen Bericht, in dem die Werte in den veränderbaren Zellen und die 

Werte in beliebigen „Ergebniszellen“ für alle Szenarien direkt miteinander ver-

glichen werden können. 

 Siehe dazu Abschnitt „Anlegen eines Szenarioberichts“ (Seite 120). 
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Zusammenführen von Szenarien 

Sie können den Befehl Weiteres > Szenarien auch verwenden, um Szenarien, die 

sich in anderen Arbeitsblättern (oder gar anderen Arbeitsmappen) befinden, auf 

dem aktuellen Arbeitsblatt zusammenzuführen. 

Hinweis: Damit dies funktioniert, sollten alle Arbeitsblätter, deren Szenarien Sie 

zusammenführen möchten, den gleichen Aufbau haben und in ihren Szenarien 

die gleichen veränderbaren Zellen verwenden. 

Um Szenarien zusammenzuführen, gehen Sie wie folgt vor: 

1. Öffnen Sie die Arbeitsmappen, in denen sich die Szenarien befinden, die Sie 

zusammenführen möchten. 

2. Wechseln Sie zu der Arbeitsmappe und dem Arbeitsblatt, auf dem die Szenarien 

zusammengeführt werden sollen. 

3. Rufen Sie den Befehl Weiteres > Szenarien auf. 

4. Klicken Sie auf Zusammenführen. 

5. Wählen Sie die Arbeitsmappe und das Arbeitsblatt, auf dem sich die gewünsch-

ten Szenarien befinden. 

6. Bestätigen Sie mit OK. 

7. Wiederholen Sie die Schritte 4. bis 6. für alle weiteren Szenarien, die Sie zu-

sammenführen möchten. 

Alle gewählten Szenarien stehen nun auf dem aktuellen Arbeitsblatt zur Verfügung.  

Anlegen eines Szenarioberichts 

Sie können den Befehl Weiteres > Szenarien auch verwenden, um einen Szena-

riobericht für alle im aktuellen Arbeitsblatt vorhandenen Szenarien anzulegen.  

Ein Szenariobericht listet alle Szenarien übersichtlich nebeneinander auf. Für jedes 

Szenario werden sowohl die veränderbaren Zellen als auch beliebige „Ergebniszel-

len“ (mit den Berechnungen, die Sie betrachten möchten) angezeigt. 

Solche Berichte sind nützlich, um die veränderbaren Werte und die resultierenden 

Ergebnisse von Szenarien auf einen Blick miteinander vergleichen zu können. 

Um einen Szenariobericht zu erzeugen, gehen Sie wie folgt vor: 
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1. Legen Sie, wie im Abschnitt „Erstellen von Szenarien“ beschrieben, die ge-

wünschten Szenarien an. 

2. Rufen Sie den Befehl Weiteres > Szenarien auf. 

3. Klicken Sie auf Zusammenfassung. 

4. Geben Sie die Adresse der gewünschten Ergebniszelle ein. Das ist eine beliebi-

ge Zelle mit der Berechnung, die Sie in Ihren Szenarien betrachten möchten. 

 Sie können auch mehrere Zellen angeben. Trennen Sie die Zelladressen dazu 

mit einem Strichpunkt – zum Beispiel: A2;A4;A10. Auch Zellbereiche wie 

B5:B10 sind erlaubt. 

5. Bestätigen Sie mit OK. 

PlanMaker legt nun ein neues Arbeitsblatt an und erzeugt dann darin den Szena-

riobericht. 

Hinweis: Szenarioberichte werden nicht automatisch aktualisiert, wenn Sie Zell-

inhalte oder die Einstellungen von Szenarien verändern. Um einen Szenariobe-

richt zu aktualisieren, löschen Sie das Arbeitsblatt, das den Bericht enthält, und 

erzeugen den Bericht dann noch einmal. 

Konsolidieren von Daten 

Mit dem Befehl Tabelle > Daten konsolidieren können Sie Daten aus einem oder 

mehreren Zellbereichen auswerten, um beispielsweise die Summe der einzelnen 

Daten über all diese Bereiche hinweg zu ermitteln. 

Dafür legen Sie zunächst die „Quellbereiche“ für die Konsolidierung fest. Dies 

können beliebige Zellbereiche mit den auszuwertenden Daten sein. Sie können sich 

allesamt im aktuellen Arbeitsblatt befinden, oder auf mehrere Arbeitsblätter oder 

gar mehrere Dateien verteilt sein. Für die Auswertung steht eine Vielzahl von Sta-

tistikfunktionen zur Verfügung: Summe, Minimum, Durchschnitt etc. 

Das Ergebnis der Auswertung wird – als feste Zahlenwerte – in den angegebenen 

„Zielbereich“ eingefügt. Beachten Sie: Diese Werte werden nicht aktualisiert, wenn 

sich an den Zahlen in den Quellbereichen etwas ändert. Dieser Befehl ist also in 

erster Linie dann nützlich, wenn man den aktuellen Stand von Daten auswerten und 

Änderungen nicht mehr berücksichtigen möchte (z.B. bei Monatsberichten etc.). 
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In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit Konsolidie-

rungen. Folgende Themen werden darin behandelt: 

 Konsolidieren von Daten anhand ihrer Position 

 Im einfachsten Fall werden Daten anhand ihrer Position konsolidiert. Dies 

funktioniert wie folgt:  

 Sie haben z.B. drei Quellbereiche, die alle identisch aufgebaut und gleich groß 

sind. In jedem der Bereiche befinden sich die einzelnen Daten also jeweils an 

der gleichen (relativen) Position. 

 Beim Konsolidieren wird nun die erste Zelle (links oben) im ersten Bereich zur 

ersten Zelle im zweiten und dritten Bereich addiert. Das Ergebnis erscheint als 

erste Zelle im Zielbereich. Dann wird das gleiche mit allen anderen Zellen in 

den Quellbereichen durchgeführt. 

 Konsolidieren von Daten anhand ihrer Beschriftungen 

 Darüber hinaus kann diese Funktion auch nach Beschriftungen konsolidieren. 

Dies funktioniert wie folgt:  

 Es können ein oder mehrere Quellbereiche vorliegen, die eines gemein haben: 

Jeder einzelne Wert ist mit einer Beschriftung versehen – beispielsweise in der 

Zelle links von ihm.  
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 Wenn Sie nun beim Konsolidieren die Option Beschriftungen in linker Spalte 

einschalten, addiert PlanMaker alle Werte, bei denen sich links die gleiche Be-

schriftung befindet.  

 Dabei darf die gleiche Beschriftung beliebig oft vorkommen. Die Größe der 

Quellbereiche und die Reihenfolge der Daten spielen keine Rolle. PlanMaker 

erkennt schließlich anhand der Beschriftungen, welche Werte addiert werden 

sollen. 

 Bearbeiten und Aktualisieren von Konsolidierungen 

 Wenn Sie mit dem Befehl Tabelle > Daten konsolidieren eine Konsolidierung 

durchführen, merkt sich PlanMaker alle Einstellungen, die Sie im Konsolidie-

ren-Dialog vorgenommen haben (und zwar pro Arbeitsblatt). 

 Dies ermöglicht es Ihnen, diesen Befehl jederzeit erneut aufzurufen, gegebe-

nenfalls Einstellungen für die Konsolidierung zu ändern und diese dann erneut 

durchzuführen.  

Ausführliche Informationen zu diesen Themen finden Sie, in obiger Reihenfolge, 

auf den nächsten Seiten. 

Konsolidieren von Daten anhand ihrer Position 

Wie in der Einleitung des Abschnitts „Konsolidieren von Daten“ (Seite 121) erläu-

tert, können Sie mit dem Befehl Tabelle > Daten konsolidieren Daten aus einem 

oder mehreren Zellbereichen konsolidieren – diese Daten also auswerten und bei-

spielsweise die Summe der einzelnen Daten ermitteln. 

Im einfachsten Fall werden Daten anhand ihrer Position konsolidiert. Dies funktio-

niert wie folgt:  

Sie haben z.B. drei „Quellbereiche“, die alle identisch aufgebaut und gleich groß 

sind. In jedem der Bereiche befinden sich die einzelnen Daten also jeweils an der 

gleichen (relativen) Position. 

Beim Konsolidieren wird nun die erste Zelle (links oben) im ersten Bereich zur 

ersten Zelle im zweiten und dritten Bereich addiert. Das Ergebnis erscheint als 

erste Zelle im „Zielbereich“. Dann wird das gleiche mit allen anderen Zellen in den 

Quellbereichen durchgeführt. 
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Beispiel 

Die Tageserlöse zweier Obstläden sollen, aufgeteilt nach Obstsorten, mittels Sum-

menfunktion konsolidiert werden.  

 

Dazu wurden die Erlöse der beiden Läden in eine Tabelle eingetragen. In der Ab-

bildung sieht man diese Daten in den Zellbereichen C3:C5 und C8:C10. 

Dann wurde Tabelle > Daten konsolidieren aufgerufen und diese beiden Bereiche 

als Quellbereiche hinzugefügt. Der Zielbereich wurde auf C13:C15 gesetzt (in der 

Abbildung selektiert) und die Konsolidierung mit OK gestartet.  

Ergebnis: Im Zielbereich erscheinen die Summen der Tageserlöse (ebenfalls wieder 

pro Obstsorte, genau wie in den Quellbereichen). 

Durchführen der Konsolidierung 

Um Daten anhand ihrer Position zu konsolidieren, gehen Sie wie folgt vor: 

1. Tragen Sie die zu konsolidierenden Daten in einzelne Zellbereiche ein, die alle-

samt gleich aufgebaut sind. Die Daten müssen also in jedem dieser Bereiche 

gleich angeordnet sein. 
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 Die einzelnen Zellbereiche können sich alle auf dem gleichen Arbeitsblatt, in 

mehreren Arbeitsblättern oder sogar in mehreren unterschiedlichen Dokumen-

ten befinden. 

2. Rufen Sie den Befehl Tabelle > Daten konsolidieren auf. 

3. Klicken Sie in das Eingabefeld Quellbereiche. Tragen Sie dort die Adresse des 

ersten Zellbereichs mit den zu konsolidierenden Daten ein. (Siehe auch Anmer-

kungen weiter unten.) 

 Tipp: Alternativ können Sie auch von dem Dialog aus in die Tabelle klicken 

und den Zellbereich darin einfach mit der Maus selektieren. 

4. Klicken Sie auf die Schaltfläche Hinzufügen. 

5. Um weitere Zellbereiche zu den Quellbereichen hinzuzufügen, wiederholen Sie 

die Schritte 3. und 4.  

6. Tragen Sie bei Zielbereich die Adresse des Zellbereichs ein, in dem das Ergeb-

nis der Konsolidierung erscheinen soll. 

 Tipp: Es genügt, die Adresse der Zelle anzugeben, in der sich die linke obere 

Ecke des Zielbereichs befinden soll. PlanMaker ermittelt die korrekte Größe 

dann automatisch. 

 Tipp: Sie können die gewünschte Zelle auch einfach in der Tabelle anklicken, 

um ihre Adresse in den Dialog zu übertragen. 

7. Wählen Sie bei Funktion, welche Rechenfunktion für die Konsolidierung ver-

wenden werden soll. 

8. Die Optionen Beschriftung in... müssen bei dieser Art der Konsolidierung un-

bedingt ausgeschaltet bleiben. (Mehr zu diesen Optionen im Abschnitt 

„Konsolidieren von Daten anhand ihrer Beschriftungen“, Seite 126.) 

9. Klicken Sie auf Anwenden, um den Vorgang zu starten. 

Die Daten aus den Quellbereichen werden nun mit der gewählten Rechenfunktion 

konsolidiert, und das Ergebnis wird im Zielbereich eingefügt. 

Hinweis: Das Ergebnis der Konsolidierung wird in Form von festen Zahlenwer-

ten eingefügt. Diese werden nicht aktualisiert, wenn sich an den Werten in den 

Quellbereichen etwas ändert.  

Dieser Befehl ist also in erster Linie dann nützlich, wenn man den aktuellen 

Stand der Daten auswerten und Änderungen nicht mehr berücksichtigen möchte 

(z.B. bei Monatsberichten). Siehe auch Abschnitt „Bearbeiten und Aktualisieren 

von Konsolidierungen“, Seite 130. 
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Anmerkungen zum Festlegen der Quellbereiche 

Wenn Sie im oben beschrieben Dialogfenster in das Eingabefeld Quellbereiche 

klicken, haben Sie folgende Möglichkeiten, einen Quellbereich hinzuzufügen: 

 Quellbereich im aktuellen Arbeitsblatt 

 Wenn Sie einen Zellbereich zu den Quellbereichen hinzufügen möchten, der 

sich im aktuellen Arbeitsblatt befindet, geben Sie einfach dessen Adresse oder 

Namen ein.  

 Beispiel: D2:G5 

 Tipp: Alternativ können Sie auch von dem Dialog aus in die Tabelle klicken 

und den Zellbereich darin mit der Maus selektieren.  

 Quellbereich in einem anderen Arbeitsblatt 

 Wenn Sie einen Zellbereich hinzufügen möchten, der sich in einem anderen 

Arbeitsblatt befindet, stellen Sie der Adresse wie üblich den Namen des Ar-

beitsblatts und ein Ausrufezeichen voran. 

 Beispiel: Tabelle3!D2:G5 

 Tipp: Auch hier können Sie den Zellbereich einfach mit der Maus selektieren. 

Klicken Sie zuvor im Arbeitsblattregister auf das gewünschte Arbeitsblatt. 

 Quellbereich in einem anderen Dokument 

 Wenn Sie einen Zellbereich hinzufügen möchten, der sich in einem anderen 

Dokument befindet, tragen Sie dessen Adresse so ein, wie es im Abschnitt 

„Externe Zellbezüge“ ab Seite 444 beschrieben wurde. 

 Beispiel: 'C:\Mein Verzeichnis\[Meine Arbeitsmappe.pmd]Tabelle3'!D2:G5 

 Tipp: Den ersten Teil der Adresse, der den Pfad und Dateinamen enthält, brau-

chen Sie nicht von Hand einzugeben. Klicken Sie einfach auf die Schaltfläche 

Datei, worauf ein Dateidialog erscheint, in dem Sie die gewünschte Datei aus-

wählen können. 

Vergessen Sie nicht, nach dem Eingeben der Adresse für einen Quellbereich je-

weils auf Hinzufügen zu klicken. 

Konsolidieren von Daten anhand ihrer Beschriftungen  

Wie in der Einleitung des Abschnitts „Konsolidieren von Daten“ (Seite 121) erläu-

tert, können Sie mit dem Befehl Tabelle > Daten konsolidieren Daten aus einem 
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oder mehreren Zellbereichen konsolidieren – diese Daten also auswerten und bei-

spielsweise die Summe der einzelnen Daten ermitteln. 

Neben dem Konsolidieren von Daten anhand ihrer Position (siehe vorheriger Ab-

schnitt) lassen sich Daten auch anhand ihrer Beschriftungen konsolidieren. Dies 

funktioniert wie folgt: 

Die auszuwertenden Daten können in beliebig vielen „Quellbereichen“ abgelegt 

sein – die allesamt eines gemein haben sollten: Jeder darin enthaltene Wert ist mit 

einer Beschriftung versehen (beispielsweise in der Zelle links von ihm). 

Wenn Sie nun beim Konsolidieren die Option Beschriftungen in linker Spalte 

einschalten, addiert PlanMaker alle Werte, bei denen sich links die gleiche Be-

schriftung befindet.  

Dabei darf die gleiche Beschriftung beliebig oft vorkommen. Die Größe der ein-

zelnen Quellbereiche und die Reihenfolge der Daten darin spielen keinerlei Rolle. 

PlanMaker erkennt schließlich anhand der Beschriftungen, welche Daten konsoli-

diert werden sollen. 

Beispiel 

Ein Obststand bietet verschiedene Sorten Obst an. Jeder einzelne Verkauf im Laufe 

eines Tages wird in einer Tabelle erfasst. Nun soll ausgerechnet werden, wie viel 

insgesamt von jeder Obstsorte verkauft wurde. 
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Die einzelnen Obstsorten kommen hierbei natürlich in völlig zufälliger Reihenfol-

ge vor, aber das stört den Konsolidieren-Befehl überhaupt nicht: 

Rufen Sie einfach Tabelle > Daten konsolidieren auf. Fügen Sie den Zellbereich 

mit den einzelnen Verkäufen als Quellbereich hinzu (hier also B3:C11). Beachten 

Sie: Dieser muss die Zahlen und deren Beschriftungen enthalten! Dann wählen Sie 

einen beliebigen Zielbereich für das Ergebnis (in der Abbildung B14:C16) und 

bestätigen Sie mit OK. 

Ergebnis: Im Zielbereich erscheinen die Summen der Verkäufe der einzelnen Obst-

sorten. 

Durchführen der Konsolidierung 

Um Daten anhand ihrer Beschriftungen zu konsolidieren, gehen Sie wie folgt vor: 

1. Tragen Sie die zu konsolidierenden Daten in einen oder mehrere Zellbereiche 

ein. Deren Aufbau und Größe spielt keine Rolle – allerdings sollten die zu kon-

solidierenden Werte allesamt eine Beschriftung haben: entweder in der Spalte 

links der Werte und/oder in der Zeile oberhalb der Werte. 



 

Handbuch PlanMaker Bearbeiten einer Tabelle    129 

 Die einzelnen Zellbereiche können sich alle auf dem gleichen Arbeitsblatt, in 

mehreren Arbeitsblättern oder sogar in mehreren unterschiedlichen Dokumen-

ten befinden. 

2. Rufen Sie den Befehl Tabelle > Daten konsolidieren auf. 

3. Klicken Sie in das Eingabefeld Quellbereiche. Tragen Sie dort die Adresse des 

Zellbereichs mit den zu konsolidierenden Daten ein. (Siehe auch Anmerkungen 

am Ende des vorherigen Abschnitts.) 

 Tipp: Alternativ können Sie auch von dem Dialog aus in die Tabelle klicken 

und den Zellbereich darin einfach mit der Maus selektieren. 

Wichtig: Jeder Quellbereich muss sowohl die auszuwertenden Daten selbst 

als auch deren Beschriftungen enthalten. Die Beschriftungen müssen sich in 

der äußersten linken Spalte oder in der obersten Zeile des Bereichs befinden. 

4. Klicken Sie auf die Schaltfläche Hinzufügen. 

5. Falls Sie weitere Zellbereiche zu den Quellbereichen hinzuzufügen möchten, 

wiederholen Sie die Schritte 3. und 4.  

6. Tragen Sie bei Zielbereich die Adresse des Zellbereichs ein, in dem das Ergeb-

nis der Konsolidierung erscheinen soll. 

 Tipp: Es genügt, die Adresse der Zelle anzugeben, in der sich die linke obere 

Ecke des Zielbereichs befinden soll. PlanMaker ermittelt die korrekte Größe 

dann automatisch. 

 Tipp: Sie können die gewünschte Zelle auch einfach in der Tabelle anklicken, 

um ihre Adresse in den Dialog zu übertragen. 

7. Wählen Sie bei Funktion, welche Rechenfunktion für die Konsolidierung ver-

wenden werden soll. 

8. Geben Sie bei den Optionen an, wo sich die Beschriftungen der Daten in den 

Quellbereichen befinden: 

 Beschriftungen in linker Spalte: Die Beschriftungen befinden sich jeweils in 

der äußersten linken Spalte der Quellbereiche. (Die zugehörigen Daten müssen 

dann direkt rechts daneben eingetragen sein.) 

 Beschriftungen in oberster Zeile: Die Beschriftungen befinden sich jeweils in 

der obersten Zeile der Quellbereiche. (Die zugehörigen Daten müssen dann di-

rekt darunter eingetragen sein.) 
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 Sie können auch beide Optionen aktivieren, falls Sie Quellbereiche auswerten 

möchten, bei denen sich Beschriftungen in der äußersten linken Spalte und in 

der in der obersten Zeile befinden. 

 Wenn Sie die Option Beschriftungen sortieren einschalten, werden die Ergeb-

nisse der Konsolidierung im Zielbereich nach Beschriftungen sortiert eingetra-

gen. 

9. Klicken Sie auf Anwenden, um den Vorgang zu starten. 

Die Daten aus den Quellbereichen werden nun mit der gewählten Rechenfunktion 

konsolidiert, und das Ergebnis wird im Zielbereich eingefügt. 

Hinweis: Das Ergebnis der Konsolidierung wird in Form von festen Zahlenwer-

ten eingefügt. Diese werden nicht aktualisiert, wenn sich an den Werten in den 

Quellbereichen etwas ändert.  

Dieser Befehl ist also in erster Linie dann nützlich, wenn man den aktuellen 

Stand der Daten auswerten und Änderungen nicht mehr berücksichtigen möchte 

(z.B. bei Monatsberichten etc.). Siehe auch Abschnitt „Bearbeiten und Aktuali-

sieren von Konsolidierungen“, Seite 130. 

Bearbeiten und Aktualisieren von Konsolidierungen 

Wenn Sie mit dem Befehl Tabelle > Daten konsolidieren eine Konsolidierung 

durchführen, merkt sich PlanMaker alle Einstellungen, die Sie im Konsolidieren-

Dialog vorgenommen haben (und zwar pro Arbeitsblatt).  

Dies ermöglicht es Ihnen, diesen Befehl jederzeit erneut aufzurufen, gegebenen-

falls Einstellungen für die Konsolidierung zu ändern und diese dann erneut durch-

zuführen.  

Tipp: Die Einstellungen werden sogar im Dokument gespeichert, sodass sich 

PlanMaker auch beim nächsten Öffnen des Dokuments wieder darin erinnert.  

(Kleine Einschränkung: Die Optionen Zielbereich und Beschriftungen sortie-

ren werden bei Excel-Dateien nicht gespeichert, da Excel dies nicht unterstützt.) 

Einstellungen bearbeiten und Konsolidierung erneut durchführen 

Um die Einstellungen für eine Konsolidierung zu bearbeiten und ihr aktualisiertes 

Ergebnis erneut einzufügen, gehen Sie wie folgt vor: 
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1. Rufen Sie den Befehl Tabelle > Daten konsolidieren auf. 

2. Nehmen Sie die gewünschten Änderungen an den Einstellungen für die Konso-

lidierung vor. Sie können auch neue Quellbereiche hinzufügen oder vorhandene 

entfernen. 

3. Klicken Sie auf die Schaltfläche Anwenden, um die Änderungen zu überneh-

men und die Konsolidierung erneut durchzuführen. 

Die Konsolidierung auf dem aktuellen Arbeitsblatt wird nun erneut durchgeführt 

und ihr aktualisiertes Ergebnis wird in den Zielbereich eingefügt. Die alten Daten 

werden dabei überschrieben. 

Konsolidierung aktualisieren 

Wenn Sie eine Konsolidierung einfach nur aktualisieren möchten (ohne Einstellun-

gen zu ändern), gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Tabelle > Daten konsolidieren auf. 

2. Klicken Sie auf die Schaltfläche Anwenden. 

Die Konsolidierung auf dem aktuellen Arbeitsblatt wird nun, mit genau den glei-

chen Einstellungen wie beim letzten Mal, erneut durchgeführt. 

Fixieren von Zeilen und Spalten 

Mit dem Befehl Ansicht > Fixieren können Sie die ersten Zeilen und/oder Spalten 

einer Tabelle auf dem Bildschirm fixieren. Das bewirkt, dass sich diese beim Blät-

tern in der Tabelle nicht mehr mitbewegen, sondern permanent angezeigt werden. 

Wenn Sie beispielsweise die Zeilen oder Spalten einer Tabelle mit Überschriften 

versehen haben, können Sie diese Beschriftungen fixieren, so dass sie immer zu 

sehen sind. 

Fixieren einschalten 

Um Zeilen oder Spalten zu fixieren, gehen Sie wie folgt vor: 

1. Zunächst müssen Sie festlegen, welche Zeilen und/oder Spalten fixiert werden 

sollen: 
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 Zeilen fixieren: Wenn Sie die ersten Zeilen der Tabelle fixieren möchten, dann 

markieren Sie die Zeile direkt unterhalb der Zeilen, die fixiert werden sollen. 

 Spalten fixieren: Wenn Sie die ersten Spalten fixieren möchten, markieren Sie die 

Spalte rechts dieser Spalten. 

 Zeilen und Spalten fixieren: Wenn Sie sowohl Zeilen als auch Spalten fixieren 

möchten, setzen Sie den Zellrahmen in die Zelle rechts unter dem zu fixieren-

den Bereich. 

2. Anschließend rufen Sie den Befehl Ansicht > Fixieren auf. 

Die Zeilen und/oder Spalten wurden nun fixiert. Beim Blättern durch die Tabelle 

sind diese von nun an stets zu sehen. 

Tipp: Sie können auch das Symbol  in der rechten unteren Ecke des Pro-

grammfensters verwenden, um Titel zu fixieren. Ziehen Sie dieses Symbol dazu 

einfach mit der Maus an die gewünschte Stelle. 

Fixieren aufheben 

Wenn Sie Zeilen oder Spalten fixiert haben und das Menü Ansicht aufrufen, sehen 

Sie ein Häkchen vor dem Befehl Fixieren. Dieses zeigt an, dass das Fixieren ein-

geschaltet ist. Um es wieder auszuschalten, rufen Sie den Befehl Ansicht > Fixie-

ren noch einmal auf. Das Häkchen verschwindet; die Zeilen/Spalten sind nun nicht 

mehr fixiert. 

Tipp: Ein Mausklick auf das Symbol  in der rechten unteren Ecke des Pro-

grammfensters hebt die Fixierung ebenfalls wieder auf. 

Ein Beispiel 

Ihnen liegt folgende Tabelle mit Aktienkursen vor: 
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Wie Sie sehen, sind darin sowohl die Spalten als auch die Zeilen beschriftet. Um 

diese Beschriftungen zu fixieren, gehen Sie wie folgt vor: 

 Die Spaltenbeschriftungen (Höchstkurs, Tiefstkurs etc.) befinden sich in der 

ersten Zeile der Tabelle.  

 Um diese zu fixieren, müssen Sie also die zweite Zeile markieren, indem Sie 

auf ihren Zeilenkopf (die mit „2“ beschriftete Schaltfläche links der Zeile) kli-

cken. Dann rufen Sie den Befehl Ansicht > Fixieren auf. 

 Die Zeilenbeschriftungen (23.10., 24.10. etc.) befinden sich in der ersten Spalte 

der Tabelle.  

 Um diese zu fixieren, markieren Sie die zweite Spalte (Spalte B), indem Sie auf 

ihren Spaltenkopf (die mit „B“ beschriftete Schaltfläche über der Spalte) kli-

cken. Dann rufen Sie Ansicht > Fixieren auf. 

 Um beide Beschriftungen zu fixieren, setzen Sie den Zellrahmen in die Zelle 

B2 und rufen Ansicht > Fixieren auf. 

Wenn Sie die Fixierung wieder aufheben möchten, rufen Sie den Befehl Ansicht > 

Fixieren erneut auf. 

Sonderzeichen einfügen 

Einige Zeichen lassen sich über die Tastatur nicht direkt eingeben – zum Beispiel 

das Copyrightzeichen, das Promillezeichen oder Akzentzeichen aus anderen Spra-

chen. Bei PlanMaker können Sie diese sogenannten Sonderzeichen bequem über 

die integrierte Zeichentabelle einfügen. 

Gehen Sie dazu folgendermaßen vor: 
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1. Rufen Sie den Befehl Einfügen > Sonderzeichen auf. 

2. Es erscheint ein Dialogfenster, das alle in der derzeit gewählten Schrift verfüg-

baren Zeichen anbietet. Über die aufklappbare Liste Schriftart können Sie bei 

Bedarf eine andere Schriftart wählen. 

3. Über die aufklappbare Liste Subset können Sie zu einem bestimmten Bereich 

des Zeichensatzes springen. Wählen Sie beispielsweise Kyrillisch, um zu den 

kyrillischen Zeichen zu gelangen (sofern in der gewählten Schriftart welche 

vorhanden sind). 

 Hinweis: Viele Schriften enthalten nur einen kleinen Teil des verfügbaren Zei-

chensatzes. Ein besonders großes Reservoir an Zeichen ist in den bei Ihrem Be-

triebssystem mitgelieferten Standardschriften vorhanden. Bei Windows sind 

dies zum Beispiel die Schriften Arial, Tahoma und Times New Roman. 

4. Selektieren Sie das einzufügende Zeichen mit den Pfeiltasten und drücken Sie 

die Eingabetaste (¢) oder führen Sie einen Doppelklick auf das Zeichen aus, 

um es in den Text einzufügen. 

5. Sie können nun auf die gleiche Weise noch weitere Zeichen einfügen oder den 

Dialog mit der Schaltfläche Schließen beenden. 

Tipp für Windows-Anwender: Die meisten Windows-Versionen enthalten zwei 

Symbolschriften namens Symbol und Wingdings. Darin finden Sie zahlreiche 

nützliche Symbole (Telefonsymbole, Bullets etc.). 

Tastenkürzel verwenden 

Wenn Sie ein bestimmtes Sonderzeichen besonders häufig benötigen, können Sie 

ihm jederzeit ein Tastenkürzel geben. Dies hat den Vorteil, dass Sie das Zeichen 

dann blitzschnell mit einem einzigen Tastendruck einfügen können. 

Um einem Sonderzeichen ein Tastenkürzel zuzuordnen, gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Einfügen > Sonderzeichen auf. 

2. Wählen Sie das Sonderzeichen, dem Sie ein Tastenkürzel geben möchten. 

3. Klicken Sie neben der Option Tastenkürzel auf die Schaltfläche Ändern. 

4. Es erscheint ein weiterer Dialog. Drücken Sie darin im Eingabefeld Bitte Tas-

tenkürzel drücken das gewünschte Tastenkürzel. 

 Wir empfehlen Ihnen, stets Tastenkombinationen mit den Tasten (Strg) und (ª) 

zu verwenden, da diese normalerweise nicht belegt sind. 
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 Tipp: Falls Sie sich vertippt haben, können Sie das eingegebene Tastenkürzel 

mit der Rücktaste (æ__) wieder löschen. 

5. Nicht vergessen: Klicken Sie auf Hinzufügen, um dem Zeichen dieses Tasten-

kürzel zuzuweisen.  

6. Bestätigen Sie mit OK und verlassen Sie den Hauptdialog mit Schließen. 

Von nun an können Sie dieses Sonderzeichen mit der entsprechenden Tastenkom-

bination einfügen.  

Hinweis: Das Tastenkürzel merkt sich nur das ausgewählte Zeichen, nicht jedoch 

die gewählte Schriftart. 

Weitere Informationen zum Ändern der Tastaturbelegung finden Sie im Abschnitt 

„Tastenkürzel anpassen“ (ab Seite 423). Tipp: Die Tastenkürzel für Sonderzeichen 

können Sie bearbeiten, indem Sie in dem Dialog für das Bearbeiten der Tastaturbe-

legung in der linken Liste den Eintrag Zeichen auswählen. 

Sonderzeichen über ihren Zeichencode einfügen 

Es gibt noch eine andere Methode zum Einfügen eines Sonderzeichens: Tippen Sie 

dazu dessen hexadezimalen Zeichencode (Unicode) ein, und betätigen Sie dann die 

Tastenkombination (Strg)(Alt)(ª)(X).  

Wenn Sie beispielsweise 20AC eingeben und dann diese Tastenkombination drü-

cken, erhalten Sie ein Eurozeichen, da dieses in der Unicode-Zeichentabelle den 

Zeichencode 20AC hat. 
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Gestalten einer Tabelle 

Durch den Einsatz von Diagrammen, Farben, Umrandungen und anderen Gestal-

tungsmöglichkeiten können Sie das Erscheinungsbild Ihrer Tabellen aufwerten und 

die Lesbarkeit erhöhen. 

In diesem Kapitel erfahren Sie alles über das Gestalten ansprechender Tabellen. 

Folgende Themen werden darin behandelt: 

 Zellengröße 

 Zum Festlegen der Zellengröße dienen die Untermenüs der Befehle Tabelle > 

Zeile und Tabelle > Spalte. Sie können die Zellengröße aber auch durch Zie-

hen an den Zeilen- und Spaltenköpfen ändern. 

 Zahlenformat 

 PlanMaker kann Zahlen in den unterschiedlichsten Zahlenformaten anzeigen: 

angefangen bei einfachen Zahlen mit und ohne Nachkommastellen über Wäh-

rungs-, Prozent- und Datumsformate bis hin zu frei definierbaren Formaten. 

Der Befehl Format > Zelle lässt Sie das Format genau festlegen. 

 Umrandung 

 Mit dem Befehl Format > Umrandung können Zellen mit einer Umrandung 

oder einzelnen Linien versehen werden. 

 Schattierung 

 Der Hintergrund von Zellen kann mit einer Schattierung versehen werden. Der 

Befehl Format > Schattierung stellt hierzu verschiedene Farben, Raster und 

Muster zur Verfügung. 

 Ausrichtung 

 Mit dem Befehl Format > Zelle können Sie Zellinhalte unter anderem ausrich-

ten (linksbündig, rechtsbündig etc.) und drehen. 

 Schutz 

 Weiterhin können Sie mit dem Befehl Format > Zelle Zellen schützen, so dass 

diese beispielsweise nicht überschrieben oder verändert werden können. Die-

sem Thema widmet sich auch der Abschnitt „Blattschutz“ ab Seite 355. 
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 Zeichenformat 

 Der Befehl Format > Zeichen lässt Sie das Zeichenformat von Zellen oder 

einzelnen Zeichen festlegen. Dazu gehören Einstellungen wie die Schriftart, 

Textauszeichnungen (fett, kursiv etc.) und die Schriftfarbe. 

 Absatzformat (nur in Textrahmen) 

 Wenn Sie Textrahmen in die Tabelle eingefügt haben, können Sie jederzeit die 

Absatzformatierung (Zeilenabstand, Einzüge etc.) des enthaltenen Textes än-

dern. Dazu dient der Befehl Format > Absatz (nur in Textrahmen verfügbar). 

 Zeichenvorlagen 

 Besonders häufig benötigte Zeichenformate lassen sich in einer Zeichenvorlage 

speichern, die Sie dann beliebig oft anwenden können. 

 Zellenvorlagen 

 Darüber hinaus können Sie Zellenvorlagen erstellen. In diesen lässt sich sowohl 

das Zeichenformat (Schriftart etc.) als auch das Zellenformat (Zahlenformat, 

Umrandung, Schattierung, Ausrichtung und Zellschutz) speichern. 

 Dokumentvorlagen 

 Wenn Sie einen Satz an Zeichen- und Zellenvorlagen erstellt haben und der 

Meinung sind, dass Sie diese auch in Zukunft gut gebrauchen können, können 

Sie diese in einer Dokumentvorlage speichern. 

 AutoFormat 

 Der Befehl Format > AutoFormat ist ein besonders praktischer Helfer: Er 

formatiert einen kompletten Tabellenbereich in einem von zahlreichen vorge-

gebenen Formaten – auf Knopfdruck. 

 Bedingte Formatierung 

 Der Befehl Format > Bedingte Formatierung erlaubt es Ihnen, Zellen mit 

einer alternativen Formatierung zu versehen, wenn eine bestimmte Bedingung 

erfüllt ist – also beispielsweise Zellen rot einzufärben, wenn ihr Inhalt größer 

als 1000 ist. 

 Gültigkeitsprüfung 

 Wenn Sie Zellen mit einer Gültigkeitsprüfung versehen, werden darin nur noch 

bestimmte Arten von Werten (zum Beispiel nur Zahlen) innerhalb der angege-

benen Grenzwerte (zum Beispiel nur Werte zwischen 10 und 20) als gültig er-

achtet. 
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 Format übertragen 

 Mit dem Befehl Format > Format übertragen können Sie die Formatierung 

einer Zelle mit einem „Pinsel“ blitzschnell auf andere Zellen übertragen. 

 Seitenformat 

 Das Seitenformat bestimmt das Erscheinungsbild des Dokuments beim Aus-

druck. Dazu gehören Einstellungen wie das Papierformat, Seitenränder, Kopf- 

und Fußzeilen und vieles mehr. Diese können Sie mit dem Befehl Datei > Seite 

einrichten festlegen. 

Ausführliche Informationen zu diesen Themen finden Sie, in obiger Reihenfolge, 

auf den nächsten Seiten. 

Zellengröße 

Auf den nächsten Seiten lernen Sie die unterschiedlichen Methoden zum Festlegen 

der Größe von Zellen kennen. 

Wichtig: Wenn in einer Zelle statt des Inhalts lauter Doppelkreuze angezeigt 

werden (z.B. ########), liegt das daran, dass die Spalte zu schmal ist, um den 

Zellinhalt darzustellen. Verbreitern Sie die Spalte dann entsprechend. 

Zellengröße per Maus ändern 

Oberhalb der Tabelle finden Sie mit A, B, C etc. beschriftete Schaltflächen, links 

der Tabelle sehen Sie Schaltflächen mit der Beschriftung 1, 2, 3 etc.  

Über diese sogenannten Spaltenköpfe und Zeilenköpfe können Sie die Spaltenbrei-

ten und Zeilenhöhen Ihrer Tabelle ganz einfach mit der Maus ändern: 

 Zum Ändern der Spaltenbreite einer Spalte führen Sie den Mauszeiger auf den 

rechten Rand des zugehörigen Spaltenkopfes. Der Mauszeiger verwandelt sich 

in einen Doppelpfeil. Wenn Sie nun die linke Maustaste drücken und gedrückt 

halten, können Sie die Spaltenbreite durch Ziehen mit der Maus ändern.  

 Zum Ändern der Zeilenhöhe benutzen Sie in gleicher Weise den unteren Rand 

eines Zeilenkopfes. 
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Zellengröße per Menü ändern 

Über die Befehle Tabelle > Spalte und Tabelle > Zeile können Sie die Spalten-

breiten und Zeilenhöhen Ihrer Tabelle per Menü ändern.  

Beim Aufruf eines dieser beiden Befehle klappt ein Untermenü auf, das unter ande-

rem folgende Einträge enthält: 

Breite (beziehungsweise Höhe) 

Mit diesem Befehl können Sie die Breite der Spalte beziehungsweise die Höhe der 

Zeile exakt festlegen. Geben Sie dazu den gewünschten Wert in das Eingabefeld 

ein. 

Optimale Breite (beziehungsweise Optimale Höhe) 

Der Befehl Tabelle > Spalte > Optimale Breite passt die Breite einer Tabellen-

spalte automatisch an ihren Inhalt an. 

Sie können diesen Befehl auf folgende Arten einsetzen: 

 Wenn Sie eine komplette Spalte markieren und diesen Befehl aufrufen, wird die 

Spaltenbreite an diejenige Zelle angepasst, deren Inhalt den meisten Platz benö-

tigt. 

Tipp: Dies geht auch schneller: Führen Sie einfach einen Doppelklick auf den 

Spaltenkopf durch, um eine Spalte auf die optimale Breite zu setzen.  

 Wenn Sie eine einige Zellen innerhalb einer Spalte markieren und diesen Befehl 

dann aufrufen, werden zum Ermitteln der optimalen Spaltenbreite nur diese 

Zellen berücksichtigt. 

 Wenn Sie hingegen gar nichts markieren und diesen Befehl aufrufen, wird die 

Spaltenbreite an den Inhalt der aktuellen Zelle angepasst. 

Entsprechendes gilt den Befehl Tabelle > Zeile > Optimale Höhe, mit dem Sie die 

Höhe einer Zeile automatisch anpassen können. 
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Einblenden und Ausblenden von Zeilen/Spalten 

Sie können einzelne Zeilen und Spalten ausblenden, also unsichtbar machen. Dies 

ist nützlich, wenn deren Inhalt im Augenblick nicht benötigt wird oder verborgen 

bleiben soll. 

Tipp: Wenn Sie den Blattschutz für das aktuelle Arbeitsblatt aktivieren, lassen 

sich ausgeblendete Zellen auf diesem Blatt nicht mehr einblenden. Siehe auch 

Abschnitt „Blattschutz“ ab Seite 355. 

Folgendermaßen blenden Sie Zeilen oder Spalten aus: 

Ausblenden von Zeilen über ihren Zeilenkopf 

Am schnellsten können Sie Zeilen über ihren Zeilenkopf ausblenden. Der Zeilen-

kopf ist die mit der Zeilennummer beschriftete Schaltfläche links von der Zeile. 

Um beispielsweise die Zeile 14 auszublenden, ziehen Sie die untere Begrenzungs-

linie des Zeilenkopfes für diese Zeile so lange nach oben, bis die Zeile komplett 

verschwindet. 

Die Zeile ist nun verborgen. Anstelle ihres Zeilenkopfes erscheint ein kleines Drei-

eck: 

 

Klicken Sie dieses Dreieck an, wird die Zeile wieder eingeblendet. 

Ausblenden von Zeilen über den Befehl Tabelle > Zeile 

Alternativ können Sie Zeilen über den Befehl Tabelle > Zeile ausblenden: 

Markieren Sie dazu die auszublendenden Zeilen und rufen Sie den Befehl Tabelle 

> Zeile > Ausblenden auf. 

Die Zeilen werden daraufhin ausgeblendet. 

Um sie wieder einzublenden, markieren Sie einen Bereich an Zeilen, der die aus-

geblendeten Zeilen enthält und rufen Tabelle > Zeile > Einblenden auf. 
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Ausblenden von Spalten 

Das Aus- und Einblenden von Spalten funktioniert genauso. Hier verwenden Sie 

entsprechend die Spaltenköpfe der Spalten beziehungsweise die Befehle Tabelle > 

Spalte > Ausblenden und Tabelle > Spalte > Einblenden. 

Zahlenformat 

Auf der Karteikarte Zahlenformat im Dialogfenster des Befehls Format > Zelle 

(Tastenkürzel: (Strg)(1)) können Sie das Zahlenformat von Zellen ändern. 

Das Zahlenformat bestimmt, wie Zahlen in diesen Zellen dargestellt werden. Sie 

können beispielsweise ein Zahlenformat auswählen, bei dem die Zahlen mit einem 

Währungssymbol versehen und auf zwei Nachkommastellen gerundet dargestellt 

werden (z.B. € 42,50). 

Beachten Sie: Die Zahlen werden hierbei nur gerundet angezeigt, aber nicht tat-

sächlich gerundet. Sie behalten also auch weiterhin alle Nachkommastellen. 

Wenn Sie eine Zahl tatsächlich runden möchten, sollten Sie Rechenfunktionen 

wie RUNDEN verwenden. 

Um das Zahlenformat von Zellen zu ändern, gehen Sie wie folgt vor: 

1. Markieren Sie die Zellen, deren Zahlenformat geändert werden soll. Soll nur 

eine einzige Zelle formatiert werden, reicht es, wenn Sie diese ansteuern. 

2. Rufen Sie den Befehl Format > Zelle auf. 

3. Wechseln Sie auf die Karteikarte Zahlenformat. 
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4. Legen Sie das gewünschte Format fest (siehe unten). 

5. Bestätigen Sie mit OK. 

In dem Dialogfenster können folgende Einstellungen vorgenommen werden: 

 Kategorie 

 In dieser Liste wählen Sie die gewünschte Art von Zahlenformat. Ausführliche 

Informationen zu den einzelnen Formaten finden Sie im Abschnitt „Liste der 

Zahlenformate“ weiter unten). 

 Format 

 Bei manchen Zahlenformaten stehen außerdem mehrere Unterformate zur 

Wahl. Wählen Sie hier das gewünschte Unterformat. 

 Dezimalstellen 

 Bei manchen Formaten können Sie wählen, mit wie vielen Nachkommastellen 

die Zahlen angezeigt werden sollen. 

 Hinweis: Die Zahlen werden hierbei nur gerundet angezeigt, aber nicht tatsäch-

lich gerundet. Sie behalten also auch weiterhin alle Nachkommastellen.  
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 Tausendertrennzeichen 

 Bei manchen Formaten können Sie wählen, ob Zahlen mit Tausenderpunkten 

(z.B. 5.000.000) oder ohne Tausenderpunkte (z.B. 5000000) angezeigt werden 

sollen. 

 Negative Werte in Rot 

 Bei manchen Formaten können Sie wählen, ob negative Zahlen in roter Farbe 

angezeigt werden sollen. 

 Minuszeichen unterdrücken 

 Bei manchen Formaten können Sie wählen, ob bei negativen Zahlen das Mi-

nuszeichen vor der Zahl unterdrückt werden soll. 

 Null nicht anzeigen 

 Bei manchen Formaten können Sie wählen, ob der Inhalt von Zellen, die den 

Wert „0“ enthalten, nicht angezeigt werden soll. 

Bestätigen Sie mit OK, werden die Zahlen in den markierten Zellen entsprechend 

formatiert dargestellt. 

Liste der Zahlenformate 

Wie im vorherigen Abschnitt beschrieben, können Sie mit dem Befehl Format > 

Zelle das Zahlenformat einer Zelle einstellen und so bestimmen, wie Zahlen in 

dieser Zelle dargestellt werden sollen. 

Hierfür gibt es folgende Zahlenformate: 

Standard 

Stellt die Zahl so dar, wie sie eingegeben wurde.  

Genauer gesagt: Die Zahl wird rechtsbündig angezeigt; ansonsten werden aber 

keine Änderungen an ihrer Formatierung vorgenommen. Sie wird mit so vielen 

Nachkommastellen angezeigt, wie sie tatsächlich besitzt (maximal jedoch mit fünf 

Nachkommastellen). 

Beispiel:  42 
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Zahl 

Entspricht dem Zahlenformat Standard, lässt Sie aber verschiedene Formatie-

rungsoptionen einstellen (siehe vorheriger Abschnitt). Unter anderem können Sie 

festlegen, mit wie vielen Nachkommastellen die Zahl angezeigt werden soll. 

Beispiel:  42,00 

Beachten Sie: Die Zahl wird hierbei nur gerundet angezeigt, aber nicht tatsäch-

lich gerundet. Sie behält also auch weiterhin alle Nachkommastellen. Wenn Sie 

die Zahl tatsächlich runden möchten, sollten Sie eine Rechenfunktion wie RUN-

DEN verwenden. 

Währung 

Zeigt die Zahl mit einem Währungssymbol und zwei Nachkommastellen an.  

Die gewünschte Währung können Sie in der Liste Währung auswählen. 

Beispiel: € 42,00 

Tipp: Sie können dieses Zahlenformat auch über das Symbol  in der Format-

leiste anwenden. 

Buchhaltung 

Entspricht dem Zahlenformat Währung (siehe oben), stellt die Zahl jedoch so dar, 

wie es in der Buchhaltung üblich ist.  

Der Unterschied zum Währungsformat besteht darin, dass bei negativen Beträgen 

das Minuszeichen am linken Zellrand steht, abgetrennt von der Zahl. Außerdem 

werden Währungssymbole bündig untereinander ausgerichtet. 

Beispiel: -€      42,00 

Datum/Zeit 

Stellt die Zahl als Datum und/oder Uhrzeit dar. 

In der Liste Format werden dazu, abhängig von den Ländereinstellungen Ihres 

Systems, zahlreiche unterschiedliche Schreibweisen angeboten.  
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Prozent 

Stellt die Zahl als Prozentwert dar.  

Dazu wird nicht nur ein Prozentzeichen (%) hinter der Zahl angezeigt, sondern die 

Zahl auch mit 100 multipliziert dargestellt. Schließlich entspricht beispielsweise 

0,5 – in Prozent ausgedrückt – 50%. 

Beispiel: 4200% 

Tipp: Sie können dieses Zahlenformat auch über das Symbol  in der Format-

leiste anwenden. 

Wissenschaft 

Stellt die Zahl in wissenschaftlicher Schreibweise (Exponentialschreibweise) dar. 

Beispiele: 5E+03 (entspricht 5 * 10
3
, also 5000) 

 4,2E-01 (entspricht 4,2 * 10
-1

, also 0,42) 

Bruch 

Stellt die Zahl als Bruch dar. 

Das Format des Bruchs ist in der Liste Format wählbar. 

Beachten Sie: Die Zahl wird dazu bei Bedarf gerundet angezeigt. Wenn Sie also 

beispielsweise das Format Als Halbe wählen und dann die Zahl 2,3 eingeben, 

wird diese als 2 1/2 angezeigt. 

Beispiele: 2 1/2 

 5 9/10 

Wahrheitswert 

Stellt den Wert in der Zelle als Wahrheitswert dar. 

Genauer gesagt: Ist der Wert Null, wird FALSCH angezeigt. Für alle anderen Wer-

te wird WAHR angezeigt. 



 

Handbuch PlanMaker Gestalten einer Tabelle    147 

Beispiele: WAHR 

 FALSCH 

Text 

Ein Sonderfall: Dieses Format zwingt PlanMaker dazu, die Zahl in der Zelle wie 

Text zu behandeln – nicht wie eine Zahl.  

Die Zahl wird linksbündig ausgerichtet und exakt so dargestellt, wie sie eingege-

ben wurde. Im Gegensatz zu allen anderen Zahlenformaten werden Zahlen hier 

nach der Eingabe nicht automatisch umformatiert. Es werden also keine führenden 

Nullen entfernt, Datumsangaben werden nicht automatisch formatiert etc. 

Ein Anwendungsgebiet für dieses Format sind Zahlen mit führenden Nullen (z.B. 

Telefonvorwahlen). Tippen Sie in einer Zelle die Telefonvorwahl „089“ ein, ent-

fernt PlanMaker normalerweise automatisch die führende Null. Formatieren Sie die 

Zelle zuvor mit dem Zahlenformat Text, geschieht dies nicht. 

Vorsicht: Dieses Zahlenformat wurde aus Kompatibilitätsgründen genau so wie 

in Microsoft Excel implementiert und liefert deshalb auch in PlanMaker uner-

wartete Ergebnisse bei numerischen Berechnungen:  

Wenn Sie beispielsweise die Zellen A1 und A2 mit diesem Format versehen, lie-

fert die Berechnung A1+A2 die korrekte Summe dieser Zellen. Das Ergebnis der 

Berechnung SUMME (A1:A2) ist hingegen Null. Für die meisten Rechenfunkti-

onen hat Text nämlich generell den Wert Null! 

Benutzerdefiniert 

Stellt die Zahl in einem frei definierbaren Zahlenformat dar. 

Lesen Sie dazu den nächsten Abschnitt. 

Benutzerdefinierte Zahlenformate verwenden 

Bei Bedarf können Sie mit dem Befehl Format > Zelle auch eigene Zahlenformate 

definieren und anwenden. 
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Ein neues Zahlenformat definieren und anwenden 

Folgendermaßen legen Sie ein neues benutzerdefiniertes Zahlenformat an: 

1. Selektieren Sie die Tabellenzellen, auf die Sie das neue Zahlenformat anwen-

den möchten. 

2. Rufen Sie den Befehl Format > Zelle auf und wechseln Sie auf die Karteikarte 

Zahlenformat. 

3. Wählen Sie in der Liste Kategorie den Eintrag Benutzerdefiniert. 

4. Klicken Sie in das Eingabefeld bei Format. 

5. Geben Sie eine Zeichenkette mit Formatcodes ein, um das Format zu bestim-

men.  

 Eine Tabelle aller verfügbaren Codes finden Sie im Abschnitt „Aufbau eines 

benutzerdefinierten Zahlenformats“ weiter unten. 

6. Bestätigen Sie mit OK. 

Das Zahlenformat wurde nun angelegt (und auch gleich auf die markierten Zellen 

angewandt).  

Tipp: Falls Sie ein Zahlenformat erstellen möchten, das so ähnlich wie eines der 

eingebauten Zahlenformate aussehen soll, haben wir einen guten Tipp für Sie: Kli-

cken Sie nach dem Öffnen des Dialogs erst auf das gewünschte eingebaute Zahlen-

format in der Liste Kategorie. Dessen Formatcodes werden dann nämlich als Vor-

gabe in das Eingabefeld für die Formatcodes (Schritt 5.) übertragen. Jetzt müssen 

Sie nur noch die gewünschten Änderungen vornehmen – fertig. 

Benutzerdefinierte Zahlenformate anwenden 

Natürlich können Sie ein einmal definiertes Zahlenformat auch jederzeit auf andere 

Zelle anwenden. Das geht folgendermaßen: 

1. Selektieren Sie die gewünschten Tabellenzellen. 

2. Rufen Sie den Befehl Format > Zelle auf und wechseln Sie auf die Karteikarte 

Zahlenformat. 

3. Wählen Sie in der Liste Kategorie den Eintrag Benutzerdefiniert. 

4. In der Liste Format sind alle benutzerdefinierten Zahlenformate für das aktuel-

le Dokument aufgelistet. Wählen Sie das gewünschte Format darin aus. 
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5. Bestätigen Sie mit OK. 

Das Zahlenformat wird nun auf die markierten Zellen angewandt. 

Benutzerdefinierte Zahlenformate löschen 

Wenn Sie ein benutzerdefiniertes Zahlenformat nicht mehr benötigen, können Sie 

es jederzeit löschen. Gehen Sie dazu wie folgt vor: 

1. Rufen Sie den Befehl Format > Zelle auf und wechseln Sie auf die Karteikarte 

Zahlenformat. 

2. Wählen Sie in der Liste Kategorie den Eintrag Benutzerdefiniert. 

3. Wählen Sie das zu löschende Format in der Liste Format. 

4. Klicken Sie auf die Schaltfläche Löschen. 

5. Verlassen Sie den Dialog (am besten mit der Schaltfläche Abbrechen, da beim 

Klicken auf OK ja sonst das momentan selektierte Zahlenformat auf die aktuel-

le Zelle angewandt werden würde). 

Anmerkung: Die Schaltfläche Löschen ist nur bei benutzerdefinierten Zahlenfor-

maten verfügbar; die eingebauten Formate lassen sich nicht löschen. 

Aufbau eines benutzerdefinierten Zahlenformats 

Beim Anlegen eines neuen Zahlenformats geben Sie (wie im vorherigen Abschnitt 

beschrieben) eine Zeichenkette mit Formatcodes ein. Diese Codes bestimmen, wie 

die Zahl dargestellt wird.  

Ein Beispiel: 

#,00 

Diese Formatcodes bewirken, dass Zahlen wie folgt ausgegeben werden: sämtliche 

Vorkommastellen, dann der Dezimaltrenner, dann genau zwei Nachkommastellen.  

Im Einzelnen sind folgende Formatcodes verfügbar: 

Formatcodes für Zahlen und Text 

Für Zahlen und Text gibt es die folgenden Formatcodes: 
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Code Bedeutung 

# Eine Ziffer der Zahl ausgeben. Falls sich an dieser Position der Zahl 

keine Ziffer befindet, nichts ausgeben. 

 Beispiel: #,## ergibt bei 1,2 beispielsweise 1,2. 

0 Eine Ziffer der Zahl ausgeben. Falls sich an dieser Position der Zahl 

keine Ziffer befindet, stattdessen eine Null ausgeben. 

 Beispiel: #,00 ergibt bei 1,2 beispielsweise 1,20. 

? Eine Ziffer der Zahl ausgeben. Falls sich an dieser Position der Zahl 

keine Ziffer befindet, stattdessen ein Leerzeichen ausgeben. 

 Beispiel: #,?? ergibt bei 1,2 beispielsweise 1,2  (mit einem Leerzei-

chen hinter der 2). 

 Hinweis: Sobald sich vor dem Dezimalkomma mindestens einer der 

obigen drei Formatcodes befindet, werden alle Vorkommastellen 

angezeigt. Der Formatcode 0,00 liefert bei der Zahl 123,456 also 

nicht 3,46 sondern 123,46. 

, (Komma) An dieser Stelle den Dezimaltrenner ausgeben (also Dezimalkomma 

oder Dezimalpunkt, je nach Regionaleinstellungen des System). 

. (Punkt) Die Zahl mit Tausendertrennzeichen ausgeben. Fügen Sie dazu ein-

fach (an einer beliebigen Stelle) einen Punkt in das Zahlenformat 

ein. .0,00 ergibt bei 5000000 beispielsweise 5.000.000,00. 

% An dieser Stelle ein Prozentzeichen ausgeben, und die Zahl außer-

dem mit 100 multiplizieren.  

 Beispiel: 0% ergibt bei 0,5 beispielsweise 50%. 

E+ oder e+ Wissenschaftliche Schreibweise (Exponentialschreibweise) verwen-

den.  

 Beispiel: 0E+00 ergibt bei 50000 beispielsweise 5E+04. 

 Tipp: Technische Schreibweise (mit durch 3 teilbaren Exponenten) 

ist ebenfalls möglich. #00E+00 ergibt beispielsweise bei 50000 nicht 

5E+04 sondern 50E+03. 

E- oder e- Entspricht E+, allerdings wird das Vorzeichen beim Exponenten nur 

ausgegeben, wenn der Exponent negativ ist. (Bei E+ hingegeben 

wird es immer ausgegeben.)  

 Beispiel: 0E-00 ergibt bei 50000 beispielsweise 5E04. 
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Standard Platzhalter für den kompletten Zellinhalt (im Zahlenformat „Stan-

dard“) 

@ Platzhalter für den kompletten Zellinhalt als Text 

\ Das nachfolgende Zeichen nicht als Formatcode interpretieren, son-

dern es einfach ausgeben. 

 Wenn Sie beispielsweise das Zeichen „#“ ausgeben möchten, müs-

sen Sie hierfür \# schreiben (da „#“ ja ein gültiger Formatcode ist). 

"Text" Den Text zwischen den Anführungszeichen nicht als Formatcode 

interpretieren, sondern ihn einfach ausgegeben. 

 Beispiel: "MeinText" 

* (Sternchen) Das nachfolgende Zeichen wiederholen. *x füllt beispielsweise die 

komplette Zelle mit dem Zeichen „x“. 

 Beispiel: Das Zahlenformat "Summe:"* 0,00 gibt links in der Zelle 

den Text „Summe:“ und rechts die Zahl (mit zwei Nachkommastel-

len) aus. Der Raum dazwischen wird mit Leerzeichen aufgefüllt. 

_ (Unterstrich) Einen Leerraum in der Breite des nachfolgenden Zeichens ausgeben.  

 Beispiel: Der Code _- liefert beispielsweise einen Leerraum, der 

exakt breit ist wie ein Minuszeichen.  

 [Rot] Zeigt den Zellinhalt in roter Farbe an. Insgesamt gibt es folgende 

Farbcodes: 

 [Schwarz] [Weiß] [Rot] [Grün] [Blau] [Zyan] [Magenta] [Gelb]  

Formatcodes für Daten und Uhrzeiten 

Für Datumsangaben und Uhrzeiten sind ausschließlich die folgenden Formatcodes 

zulässig: 

Hinweis: Achten Sie genau auf die Groß-/Kleinschreibung der Formatcodes! 

Code Bedeutung 

T Tag (1-31) 

TT Tag, zweistellig (01-31) 

TTT Wochentag, abgekürzt („Mo“ bis „So“) 

TTTT Wochentag („Montag“ bis „Sonntag“) 
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M Monat (1-12) 

MM Monat, zweistellig (01-12) 

MMM Monatsname, abgekürzt („Jan“ bis „Dez“) 

MMMM Monatsname („Januar“ bis „Dezember“) 

MMMMM Monatsname, nur erster Buchstabe („J“ für Januar bis „D“ für De-

zember) 

JJ Jahr, zweistellig (z.B. 13) 

JJJJ Jahr, vierstellig (z.B. 2013) 

Q Quartal (1-4) 

QQ Das Wort „Quartal“ in der Sprache, die in den regionalen Einstellun-

gen des Systems gewählt wurde 

h Stunde (0-23) 

hh Stunde, zweistellig (00-23) 

m Minute (0-59) 

mm  Minute, zweistellig (00-59) 

s Sekunde (0-59) 

ss Sekunde, zweistellig (00-59) 

0 Zehntelsekunden (z.B. hh:mm:ss,0) 

00 Hundertstelsekunden (z.B. hh:mm:ss,00) 

000 Tausendstelsekunden (z.B. hh:mm:ss,000) 

AM/PM Stunden im 12 Stunden-Format ausgegeben und AM beziehungswei-

se PM anhängen. Muss sich am Ende der Zeichenkette mit den For-

matcodes befinden!  

Beispiel: h:mm:ss AM/PM 

am/pm Wie AM/PM, jedoch mit am oder pm (in Kleinbuchstaben) 

a/p Wie AM/PM, jedoch mit a oder p 

[h] Zahl der Stunden im Endlosformat* 

[m] Zahl der Minuten im Endlosformat* 

[mm] dito, aber als zweistellige Zahl* 
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[s] Zahl der Sekunden im Endlosformat* 

[ss] dito, aber als zweistellige Zahl* 

[$-n] Optional: Ländercode für die Sprache, in der Tages- und Monatsna-

men ausgegeben werden. Wenn Sie keinen Ländercode angeben, 

verwendet PlanMaker automatisch die Systemsprache. [$-407] steht 

beispielsweise für Deutsch, [$-409] für Englisch (US). 

* Das Endloszeitformat zeichnet sich dadurch aus, dass es Uhrzeiten nicht nach 24 Stunden auf 0:00 
zurücksetzt. Dadurch eignet es sich besonders für das Rechnen mit Uhrzeiten. Addieren Sie bei-

spielsweise die Uhrzeiten 20:00 und 5:00, ist das Ergebnis normalerweise 1:00. Formatieren Sie die-

ses jedoch im Format [h]:mm, so lautet das Ergebnis 25:00. 

 Weiterhin sind beim Endloszeitformat auch negative Werte möglich: 7:00 - 10:00 ergibt also nicht 

21:00, sondern -3:00. 

 Das gleiche gilt für Minuten und Sekunden: Auch diese werden nicht nach 60 Minuten bzw. 60 Se-

kunden zurückgesetzt. So können Sie das Endloszeitformat sogar für das Umrechnen von Zeitanga-
ben in Minuten oder Sekunden verwenden. Formatieren Sie 02:00:00 beispielsweise als [mm]:ss, 

wird 120:00 ausgegeben; 2 Stunden sind also 120 Minuten. Beim Format [ss] würde 7200 angezeigt; 

2 Stunden sind also 7200 Sekunden. 

Definieren separater Abschnitte für positive Zahlen, negative Zahlen, Nullwerte 

und Text 

Bei Bedarf können Sie die Zeichenkette mit den Formatcodes in bis zu vier Ab-

schnitte unterteilen, die durch Strichpunkte zu trennen sind. Dies ermöglicht das 

Definieren eines eigenen Zahlenformats jeweils für positive Zahlen, negative Zah-

len, den Wert Null und Text – in folgender Form: 

Positiv; Negativ; Null; Text 

Die Anzahl der Abschnitte, die Sie dabei definieren, wirkt sich wie folgt aus: 

Zahl der Abschnitte Auswirkung 

Nur 1 Abschnitt: Die Formatcodes gelten für alle Werte. 

2 Abschnitte: Die Codes im 1. Abschnitt gelten für positive Werte. 

Die Codes im 2. Abschnitt gelten für negative Werte. 

3 Abschnitte: Die Codes im 1. Abschnitt gelten für positive Werte. 

Die Codes im 2. Abschnitt gelten für negative Werte. 

Die Codes im 3. Abschnitt gelten für die Zahl Null. 
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4 Abschnitte: Die Codes im 1. Abschnitt gelten für positive Werte. 

Die Codes im 2. Abschnitt gelten für negative Werte. 

Die Codes im 3. Abschnitt gelten für die Zahl Null. 

Die Codes im 4. Abschnitt gelten für Text. 

Ein Beispiel (mit zwei Abschnitten): 

0,00; -0,00[Rot] 

Dieses Zahlenformat liefert folgende Formatierung: 

Abschnitt 1: 0,00 bedeutet: Positive Zahlen mit zwei Nachkommastellen darstellen. 

Abschnitt 2: -0,00[Rot] bedeutet: Negative Zahlen ebenfalls mit zwei Nachkom-

mastellen darstellen. Minuszeichen davor anzeigen (siehe Hinweis!). Zahl außer-

dem rot einfärben. 

Hinweis: Wenn Sie ein Zahlenformat mit zwei (oder mehr) Abschnitten definie-

ren, müssen Sie in den zweiten Abschnitt explizit ein Minuszeichen einfügen, 

wenn Sie möchten, dass bei negativen Zahlen eines angezeigt wird.  

Im Gegensatz zu Zahlenformaten mit nur einem Abschnitt wird das Minuszeichen 

hier bei negativen Zahlen nämlich nicht automatisch angezeigt.  

Definieren separater Abschnitte mithilfe von Bedingungen 

Alternativ können Sie die Zeichenkette mit den Formatcodes auch in mehrere Ab-

schnitte aufteilen, indem Sie eine Bedingung für jeden Abschnitt angeben.  

Auch hier sind die einzelnen Abschnitte durch Strichpunkte zu trennen. Um die 

Bedingungen zu definieren, fügen Sie einfach jedem Abschnitt die gewünschte 

Vergleichsoperation in eckigen Klammern hinzu – zum Beispiel Bedingungen wie 

[>0], [<=100], [=42] etc. 

Es dürfen maximal zwei Sektionen mit Bedingungen angelegt werden. Dahinter 

sollte außerdem eine Sektion ohne Bedingung hinzugefügt werden. Diese definiert 

dann das Format für Zahlen, die keiner der Bedingungen entsprechen. 

Ein Beispiel: 

[<=0][Blau]0,00; [>30][Rot]0,00; 0,00 

Diese Formatcodes zeigen die Zahlen in Blau an, wenn der Wert kleiner oder 

gleich Null ist – und in Rot, wenn der Wert größer als 30 ist. Trifft keine der beiden 

Bedingungen zu, wird der Wert ohne Einfärbung (also in schwarz) angezeigt. 
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Tipp: Noch komfortabler lassen sich derartige Aufgaben über „bedingte Forma-

tierungen“ lösen. Siehe Abschnitt „Bedingte Formatierung“ (Seite 185). 

Umrandung 

Auf der Karteikarte Umrandung im Dialogfenster des Befehls Format > Zelle 

können Sie Zellen mit einer Umrandung oder einzelnen Linien versehen. 

Alternativ lässt sich dieser Befehl auch über Format > Umrandung aufrufen. 

 

Gehen Sie wie folgt vor: 

1. Selektieren Sie die gewünschten Zellen. 

2. Rufen Sie den Befehl Format > Umrandung auf. 

3. Wählen Sie bei Linienstil, ob einfache oder doppelte Linien gezeichnet werden 

sollen. 

4. Ändern Sie, falls nötig, die Dicke der Linie unter Liniendicke 1. 
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 Bei doppelten Linien können Sie mit Liniendicke 1 die inneren und mit Li-

niendicke 2 die äußeren Linien ändern. Weiterhin lässt sich der Linienabstand 

einstellen. 

5. Auf Wunsch können Sie noch die Farbe der Linien ändern. 

6. Bestätigen Sie mit OK. 

Auf diese Weise versehen Sie alle markierten Zellen insgesamt mit einer Umran-

dung. Lesen Sie weiter, um zu erfahren, wie Sie einzelne Linien anbringen und 

vorhandene Linien bearbeiten. 

Nur einzelne Linien anbringen 

Wie eingangs erwähnt, lassen sich Zellen nicht nur mit einer kompletten Umran-

dung, sondern auch mit Einzellinien oben, unten, links und/oder rechts versehen. 

Selektieren Sie dazu vor dem Einstellen des Linienstils die gewünschten Linien im 

Feld Beispiel des Dialogs. Standardmäßig sind beim Aufruf des Dialogs alle Linien 

im Beispielfeld selektiert. Klicken Sie eine dieser Linien an, wird diese deselek-

tiert. Klicken Sie sie erneut an, wird sie wieder selektiert. 

Tipp: Sie können alle Linien auf einmal deselektieren, indem Sie im Beispielfeld 

in das Innere des Rechtecks zwischen den Linien klicken. Klicken Sie erneut 

dorthin, werden wieder alle Linien selektiert. 

Wenn Sie die zu verändernden Linien selektiert haben, klicken Sie auf den ge-

wünschten Linienstil und wählen die gewünschte Liniendicke. Die Änderung wirkt 

sich dann nur auf die Linien aus, die derzeit im Feld Beispiel selektiert sind. 

Vorhandene Linien ändern oder entfernen 

Um Linienstärke, -stil oder -farbe bei vorhandenen Linien zu ändern, rufen Sie den 

Dialog erneut auf. Selektieren Sie bei Bedarf erst im Feld Beispiel, welche Linien 

verändert werden sollen (siehe oben). Nehmen Sie dann die gewünschten Ände-

rungen vor. 

Um Linien zu entfernen, wählen Sie bei Linienstil die Option Keine Linie. 
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Tipp: Verwenden der Formatleiste 

Sie können alternativ auch das Symbol  ganz rechts in der Formatleiste ver-

wenden, um Umrandungslinien anzubringen. 

Gehen Sie dazu wie folgt vor: 

1. Selektieren Sie die gewünschten Zellen. 

2. Klicken Sie nicht auf das Symbol selbst, sondern auf den Pfeil rechts davon. Es 

öffnet sich ein Menü, in dem Sie gewünschte Art der Umrandung bestimmen 

können. Wählen Sie den gewünschten Umrandungsstil per Mausklick. 

Die Umrandung wird nun angebracht.  

Tipp: Wenn Sie anschließend noch weitere Zellen mit genau der gleichen Art von 

Umrandung versehen möchten, genügt es, diese zu markieren und das Symbol 

selbst (nicht den Pfeil) anzuklicken. PlanMaker wendet dann die zuletzt gewählte 

Art von Umrandung erneut an. 

Schattierung 

Auf der Karteikarte Schattierung im Dialogfenster des Befehls Format > Zelle 

können Sie Zellen mit einer farbigen Schattierung oder einem Muster hinterlegen. 

Alternativ lässt sich dieser Befehl auch über Format > Schattierung aufrufen. 
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Gehen Sie wie folgt vor: 

1. Selektieren Sie die gewünschten Zellen. 

2. Rufen Sie den Befehl Format > Schattierung auf. 

3. Bringen Sie die gewünschte Schattierung an (siehe unten). 

4. Bestätigen Sie mit OK. 

Dabei haben Sie die Wahl zwischen folgenden Arten von Schattierungen: 

 Ein Raster anbringen 

 Um ein Raster anzubringen, klicken Sie auf eine der vorgegebenen Rasterstär-

ken in der Rubrik Raster – oder tragen in dem Eingabefeld unter Raster die 

gewünschte Rasterstärke in Prozent ein. Zulässig sind Werte zwischen 0 (nicht 

sichtbar) und 100 (volle Farbtönung).  

 Mit der Option Vordergrundfarbe können Sie die Farbe für das Raster einstel-

len.  

 Wenn Sie zusätzlich die Hintergrundfarbe auf eine andere Farbe als Weiß 

setzen, erhalten Sie eine Mischung aus Vorder- und Hintergrundfarbe. 
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 Neben den hier angebotenen Farben können Sie jederzeit neue Farben definie-

ren (siehe Abschnitt „Dokumenteigenschaften, Karteikarte Farben“ ab Seite 

400). 

 Ein Muster anbringen 

 Um ein Muster anzubringen, klicken Sie auf eines der Muster in der Rubrik 

Muster. 

 Weiterhin können Sie die Vordergrundfarbe und Hintergrundfarbe für das 

Muster auswählen.  

 Neben den hier angebotenen Farben können Sie jederzeit neue Farben definie-

ren (siehe Abschnitt „Dokumenteigenschaften, Karteikarte Farben“ ab Seite 

400). 

 Raster oder Muster entfernen 

 Möchten Sie ein gewähltes Raster oder Muster wieder entfernen, wählen Sie 

bei Typ die Option Keines. 

Schließlich bestätigen Sie mit OK. 

Tipp: Verwenden der Formatleiste 

Sie können alternativ auch das Symbol  ganz rechts in der Formatleiste ver-

wenden, um eine Schattierung anzubringen. 

Gehen Sie dazu wie folgt vor: 

1. Selektieren Sie die gewünschten Zellen. 

2. Klicken Sie nicht auf das Symbol selbst, sondern auf den Pfeil rechts davon. Es 

öffnet sich ein Menü, in dem Sie gewünschte Farbe bestimmen können. Wählen 

Sie diese per Mausklick. 

Die Schattierung wird nun angebracht.  

Tipp: Wenn Sie anschließend noch weitere Zellen mit der gleichen Schattierung 

versehen möchten, genügt es, diese zu markieren und das Symbol selbst (nicht 

den Pfeil) anzuklicken. PlanMaker wendet dann die zuletzt gewählte Schattie-

rung erneut an. 
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Ausrichtung 

Auf der Karteikarte Ausrichtung im Dialogfenster des Befehls Format > Zelle 

können Sie die Ausrichtung des Zellinhalts innerhalb der Zelle bestimmen. 

Bevor Sie diesen Befehl aufrufen, müssen Sie die gewünschten Zellen markieren. 

Soll nur eine einzige Zelle bearbeitet werden, reicht es, wenn Sie diese ansteuern. 

 

Das Dialogfenster dieses Befehls enthält folgende Optionen: 

Horizontale Ausrichtung 

Bestimmt die horizontale Ausrichtung des Zellinhalts innerhalb der Zellgrenzen: 

Standard: Text linksbündig, Zahlen rechtsbündig, Wahrheitswerte und Fehlerwerte 

zentriert 

Links: Zellinhalt am linken Rand der Zelle ausrichten 

Zentriert: Zellinhalt mittig ausrichten 

Rechts: Zellinhalt am rechten Rand der Zelle ausrichten 
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Blocksatz: Zellinhalt gleichmäßig zwischen linkem und rechten Rand verteilen 

(wirkt sich nur auf Zellen mit mehrzeiligem Inhalt und aktivierter Option Zei-

lenumbruch aus) 

Zentriert über Spalten: Zentriert den Inhalt einer Zelle über mehrere Spalten. 

Markieren Sie dazu die Zelle sowie beliebige viele benachbarte Zellen rechts da-

von (diese müssen leer sein!). Wählen Sie dann die Ausrichtung Zentriert über 

Spalten. 

Vertikale Ausrichtung 

Bestimmt die vertikale Ausrichtung des Zellinhalts innerhalb der Zellgrenzen: 

Unten: Zellinhalt am unteren Rand der Zelle ausrichten 

Zentriert: Zellinhalt vertikal zentrieren 

Oben: Zellinhalt am oberen Rand der Zelle ausrichten 

Vertikaler Blocksatz: Zellinhalt gleichmäßig zwischen oberem und unterem Rand 

verteilen (wirkt sich nur auf Zellen mit mehrzeiligem Inhalt und aktivierter Option 

Zeilenumbruch aus) 

Drehen um ... 

Hier können Sie die komplette Zelle (samt Inhalt) um den gewählten Winkel dre-

hen. 

Schreibrichtung 

Für Text in arabischer Schrift können Sie hier die Schreibrichtung der Zelle auf 

rechts-nach-links ändern.  

Tipp: Bei der Standardeinstellung Kontextabhängig stellt PlanMaker die korrekte 

Schreibrichtung automatisch ein. 

Siehe auch Kapitel „Arbeiten mit arabischem Text“ (ab Seite 371). 

Innenränder 

Hier können Sie die Innenränder der Zelle einstellen. 
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Zeilenumbruch 

Ist diese Option aktiviert, wird der Zellinhalt automatisch in die nächste Zeile um-

brochen, falls die Zellenbreite nicht ausreicht, um ihn in einer einzigen Zeile anzu-

zeigen.  

Tipp: Mit der Tastenkombination (Strg)(¢) können Sie dabei manuell Zeilenum-

brüche innerhalb einer Zelle vornehmen. 

Standardmäßig ist die Option ausgeschaltet. 

Vertikaler Text 

Ist diese Option aktiviert, wird der Zellinhalt nicht von links nach rechts, sondern 

von oben nach unten gezeichnet. 

Zellen verbinden 

Ermöglicht das Verbinden einer Zelle mit ihren benachbarten Zellen. Markieren Sie 

dazu die Zelle sowie beliebige viele direkt benachbarte Zellen und aktivieren Sie 

dann diese Option. 

Verbundene Zellen werden von PlanMaker so behandelt, als ob sie eine einzige 

Zelle wären.  

Hinweis: Wenn Sie Zellen verbinden, verlieren alle Zellen außer der linken oberen 

Zelle ihren Inhalt. 

Um die Verbindung wieder zu lösen, klicken Sie auf die verbundenen Zellen und 

schalten diese Option wieder aus. 

Schutz 

Auf der Karteikarte Schutz im Dialogfenster des Befehls Format > Zelle können 

Sie Zellen mit einem Zellschutz versehen. 

Sämtliche Informationen hierzu finden Sie im Abschnitt „Blattschutz“ ab Seite 

355. 
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Zeichenformat 

Über den Befehl Format > Zeichen (Tastenkürzel: (Strg)(2)) können Sie das Zei-

chenformat (Schriftart, Schriftgröße, Schriftfarbe, Textauszeichnungen etc.) än-

dern. 

Worauf sich dieser Befehl auswirkt, hängt davon ab, was Sie markiert haben, bevor 

Sie ihn aufrufen: 

 Wenn Sie nichts markieren, wirkt sich der Befehl auf die Zelle aus, auf der sich 

der Zellrahmen momentan befindet. 

 Wenn Sie mehrere Zellen markieren, sind alle markierten Zellen von der Ände-

rung betroffen. 

 Sie können auch die Taste (F2) in einer Zelle drücken und dann Zeichen inner-

halb des Zellinhalts markieren, worauf nur die Zeichenformatierung dieser Zei-

chen geändert wird. 

Das Dialogfenster von Format > Zeichen verfügt über drei Karteikarten, zwischen 

denen Sie wechseln können, indem Sie mit der Maus oben auf einen der Karteikar-

tenreiter klicken. 

 

Die einzelnen Karteikarten enthalten folgende Formatierungen: 
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 Karteikarte Schrift 

 Schriftart und Schriftgröße, Textauszeichnungen (fett, kursiv, unterstrichen 

etc.), Schriftfarbe und Hintergrundfarbe wählen 

 Karteikarte Abstand 

 Hoch- und Tiefstellen, Laufweite und Zeichenbreite verändern und Kerning 

(Unterschneidung von Zeichen) ein-/ausschalten 

 Karteikarte Verknüpfung 

 Verknüpfungen (Hyperlinks) anbringen und bearbeiten. Lesen Sie dazu den 

Abschnitt „Verknüpfungen anbringen“ ab Seite 339. 

Ausführliche Informationen zu den einzelnen Formatierungen finden Sie auf den 

nächsten Seiten. 

Schriftart und Schriftgröße 

Um die Schriftart und/oder -größe zu ändern, gehen Sie wie folgt vor: 

1. Markieren Sie die gewünschten Zellen oder den gewünschten Text. 

2. Rufen Sie den Befehl Format > Zeichen auf. 

3. Wechseln Sie auf die Karteikarte Schrift.  

Nun können Sie die gewünschte Schriftart und -größe einstellen: 

 Um die Schriftart zu ändern, wählen Sie die gewünschte Schrift in der auf-

klappbaren Liste Schriftart.  

 In der aufklappbaren Liste Größe werden die gebräuchlichsten Schriftgrößen 

angeboten. Sie können aber jederzeit andere Werte von Hand eintippen. Die 

Schriftgröße lässt sich auf Zehntel genau eingeben – Schriftgrößen wie 11,9 

sind also auch zulässig. 

Verwenden der Formatleiste 

Sie können die Schriftart und -größe auch über die Formatleiste ändern. 

 

In der Formatzeile werden Schriftart und -größe angezeigt. Um diese zu ändern, 

markieren Sie erst den gewünschten Text und öffnen dann die Liste mit den 
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Schriftarten beziehungsweise -größen, indem Sie auf das kleine Pfeilchen rechts 

daneben klicken. Jetzt können Sie eine Schriftart oder -größe per Mausklick aus-

wählen. 

Textauszeichnungen 

Als Textauszeichnungen werden Zeichenformatierungen wie Fettdruck, Kursiv-

schrift etc. bezeichnet.  

Textauszeichnungen können nach Belieben kombiniert werden. 

Um Text mit einer oder mehreren Textauszeichnungen zu versehen, gehen Sie wie 

folgt vor: 

1. Markieren Sie die gewünschten Zellen oder den gewünschten Text. 

2. Rufen Sie den Befehl Format > Zeichen auf. 

3. Wechseln Sie auf die Karteikarte Schrift. 

4. Schalten Sie die gewünschte(n) Textauszeichnung(en) per Mausklick ein bezie-

hungsweise aus. 

Es gibt folgende Textauszeichnungen: 

 Kursiv: Eine schräg liegende Variante der Schrift. 

 Fett: Eine kräftigere („fettere“) Variante der Schrift. 

 KAPITÄLCHEN: Anstelle von Kleinbuchstaben werden verkleinerte Großbuch-

staben ausgegeben. 

 GROSSBUCHSTABEN: Alle Zeichen werden in Großbuchstaben ausgege-

ben. 

 Durchstreichen: Der Text wird durchgestrichen. 

 Blinkend: Der Text blinkt (nur in bestimmten Internet-Browsern zu sehen). 

 Unterstreichen: Sie können Text einfach oder doppelt unterstreichen lassen. 

Die Unterstreichung kann durchgehend oder wortweise erfolgen. 

 Hochstellen (z.B. r
2
) und Tiefstellen (z.B. H20): Diese Auszeichnungen sind 

auf der nächsten Karteikarte zu finden (siehe Abschnitt „Hochstellen und Tief-

stellen“ ab Seite 167). 
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Verwenden der Formatleiste 

Die gebräuchlichsten Textauszeichnungen lassen sich auch über die Formatleiste 

anbringen. 

 

Klicken Sie dazu das Symbol für die Textauszeichnung an, um diese ein- oder wie-

der auszuschalten: Das F steht für Fettdruck, das K für Kursivschrift und das U für 

einfaches Unterstreichen. 

Tipp: Für diese Textauszeichnungen gibt es auch Tastenkürzel: (Strg)(B) für 

Fettdruck, (Strg)(I) für Kursivschrift und (Strg)(U) für einfaches Unterstreichen. 

Schriftfarbe 

Sie können sowohl Text als auch seinen Hintergrund einfärben.  

Gehen Sie dazu wie folgt vor: 

1. Markieren Sie die gewünschten Zellen oder den gewünschten Text. 

2. Rufen Sie den Befehl Format > Zeichen auf. 

3. Wechseln Sie auf die Karteikarte Schrift. 

In der Liste Schriftfarbe können Sie nun die gewünschte Farbe auswählen. 

Tipp: Die Schriftfarbe lässt sich auch über die Farbenliste  in der Format-

leiste ändern. Klicken Sie auf diese Liste, die rechts neben der Schriftgröße zu 

finden ist, und wählen Sie die gewünschte Farbe. 

Über die Liste Hintergrundfarbe können Sie zusätzlich die Hintergrundfarbe än-

dern. Wählen Sie hier anstelle der Standardeinstellung Transparent eine Farbe, 

wird der Text mit dieser Farbe hinterlegt – quasi wie mit einem Textmarker. 

Wichtig: Wenn Sie die Hintergrundfarbe auf diese Weise ändern, betrifft das nur 

die Zeichen innerhalb der Zelle. Möchten Sie hingegen die komplette Zelle ein-

färben, so verwenden Sie stattdessen den Befehl Format > Schattierung. 

Tipp: Farblisten bieten immer nur die gebräuchlichsten Farben an; Sie können aber 

jederzeit auch andere Farben wählen. Klicken Sie dazu auf den Eintrag Andere... 

am Ende der Liste (siehe auch Abschnitt „Dokumenteigenschaften, Karteikarte 

Farben“ ab Seite 400). 
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Hochstellen und Tiefstellen 

Sie können Zeichen auch hochstellen (z.B. r
2
) oder tiefstellen (z.B. H20). 

Gehen Sie dazu wie folgt vor: 

1. Markieren Sie die gewünschten Zellen oder den gewünschten Text. 

 Wenn Sie nur einzelne Zeichen innerhalb einer Zelle ändern wollen, so drücken 

Sie erst die Taste (F2), um einzelne Zeichen markieren zu können. 

2. Rufen Sie den Befehl Format > Zeichen auf. 

3. Wechseln Sie auf die Karteikarte Abstand. 

Nun können Sie die Optionen Hochstellen beziehungsweise Tiefstellen einschal-

ten. 

Auf Wunsch lässt sich zusätzlich bei Position angeben, um wie viel Prozent der 

Text hoch- beziehungsweise tiefgestellt werden soll. Weiterhin können Sie durch 

eine Prozentangabe im Feld Größe bestimmen, wie stark die Schriftgröße vermin-

dert werden soll. Geben Sie beispielsweise 100 Prozent ein, wenn die Schrift nicht 

verkleinert werden soll. 

Tipp: Hierfür gibt es folgende Tastenkürzel: (Strg)(ª)(Num+) (Plustaste auf der 

Zehnertastatur) für das Hochstellen, (Strg)(ª)(Num-) für das Tiefstellen und 
(Strg)(ª)(Num*), um Hoch-/Tiefstellungen wieder abzuschalten. 

Laufweite und Zeichenbreite 

Sie können in PlanMaker sogar die Laufweite und die Zeichenbreite von Zeichen 

ändern. 

Die Laufweite bezeichnet den Abstand zwischen den einzelnen Zeichen. Bei Wer-

ten unter 100% rutschen die Zeichen enger zusammen, bei Werten größer als 100% 

weiter auseinander. 

Wenn Sie die Zeichenbreite ändern, wird nicht der Abstand zwischen den Zeichen, 

sondern die Breite der Zeichen selbst verändert – die Zeichen werden also verzerrt.  

Um diese Einstellungen zu ändern, rufen Sie Format > Zeichen auf, wechseln auf 

die Karteikarte Abstand und tragen die gewünschten Werte bei Laufweite bezie-

hungsweise Zeichenbreite ein. 
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Hinweis: Manche Drucker unterstützen das Ändern der Zeichenbreite bei dru-

ckerinternen Schriften nicht. Die Schrift erscheint dann zwar auf dem Bildschirm 

breiter oder schmaler, nicht jedoch im Ausdruck. 

Kerning (Unterschneidung) 

Bei bestimmten Paaren von Buchstaben sieht das Schriftbild gleichmäßiger aus, 

wenn diese Buchstaben etwas näher zusammen oder weiter auseinander geschoben 

werden. Diesen Ausgleich bezeichnet man als Unterschneiden von Zeichen (eng-

lisch: Kerning). 

Die folgende Abbildung illustriert, was gemeint ist: 

 
Oben: ohne Kerning. Unten: mit Kerning 

Beim oberen Text (ohne Kerning) sieht man, dass die Buchstaben „V“ und „A“ 

normalerweise zu weit auseinander stehen. Beim unteren Text (mit Kerning) wurde 

dies korrigiert. 

Dieser Ausgleich findet vollautomatisch statt. Sie müssen das Kerning lediglich 

aktivieren. Dazu markieren Sie die gewünschten Zellen (oder den gewünschten 

Text), rufen Format > Zeichen auf, wechseln auf die Karteikarte Abstand und 

schalten die Option Kerning verwenden ein.  

PlanMaker korrigiert dann selbstständig den Zeichenabstand von allen Buchsta-

benpaaren, bei denen dies zu einer Verbesserung des Schriftbilds führt. 

Hinweis: Nicht alle Schriften enthalten in ihren Schriftdaten die hierfür erforder-

lichen Kerninginformationen. In diesen ist genau festgelegt, bei welchen Buch-

stabenkombinationen wie viel Ausgleich erforderlich ist. So gut wie alle von 

SoftMaker veröffentlichten Schriftensammlungen sind natürlich mit umfangrei-

chen Kerninginformationen ausgestattet. 
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Zeichenformatierung zurücksetzen 

Einmal angebrachte Zeichenformatierungen lassen sich jederzeit wieder entfernen. 

Gehen Sie dazu wie folgt vor: 

1. Markieren Sie die gewünschten Zellen oder den gewünschten Text. 

2. Rufen Sie den Befehl Format > Standard auf oder betätigen Sie das Tasten-

kürzel für diesen Befehl: (Strg)(Leertaste). 

PlanMaker entfernt nun alle Zeichenformatierungen, die Sie über Format > Zei-

chen oder die Formatleiste angebracht haben. 

Absatzformat (nur in Textrahmen) 

Wenn Sie Textrahmen in die Tabelle eingefügt haben, können Sie die Absatzforma-

tierung (Zeilenabstand, Einzüge etc.) des darin enthaltenen Textes jederzeit abän-

dern. Dazu dient der Befehl Format > Absatz.  

Hinweis: Der Befehl Format > Absatz ist nur in Textrahmen verfügbar. Infor-

mationen zum Arbeiten mit Textrahmen finden Sie im Abschnitt „Textrahmen“ 

ab Seite 233. 

Zu den Absatzformatierungen zählen folgende Einstellungen: 

 Einzüge 

 Zeilenabstand 

 Absatzausrichtung 

 Abstände oberhalb/unterhalb eines Absatzes 

 Trennhäufigkeit der Silbentrennung (siehe Abschnitt „Silbentrennung“ ab 

Seite 318) 

Informationen zum Ändern dieser Formatierungen finden Sie auf den nächsten 

Seiten. 
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Einzüge (nur in Textrahmen) 

Hinweis: Einzüge sind nur auf Text anwendbar, der in einen Textrahmen einge-

fügt wurde. Um Text in Tabellenzellen einzurücken, können Sie die Option In-

nenränder auf der Karteikarte Ausrichtung im Dialogfenster des Befehls For-

mat > Zelle verwenden. 

Mit Hilfe von Einzügen können Sie den linken und rechten Rand von Absätzen in 

Textrahmen ändern, um Text ein- oder auszurücken. Der Einzug für die erste Zeile 

eines Absatzes lässt sich dabei getrennt einstellen. 

Um Einzüge zu verwenden, markieren Sie die gewünschten Absätze in dem Text-

rahmen und rufen dann Format > Absatz auf. 

In der Rubrik Einzüge können Sie die Einzüge Von links, Von rechts und den 

Einzug für die Erste Zeile einstellen. Geben Sie hier die gewünschten Werte ein. 

Sie dürfen auch negative Werte für Einzüge eintragen. 

Zeilenabstand (nur in Textrahmen) 

Hinweis: Der Zeilenabstand ist nur bei Text änderbar, der in einen Textrahmen 

eingefügt wurde. 

Der Zeilenabstand bestimmt den Abstand zwischen den einzelnen Zeilen eines Ab-

satzes in einem Textrahmen. 

Um den Zeilenabstand zu verändern, gehen Sie wie folgt vor: 

1. Setzen Sie die Schreibmarke in den gewünschten Absatz des Textrahmens (oder 

markieren Sie mehrere Absätze darin). 

2. Rufen Sie den Befehl Format > Absatz auf.  

 Die Optionen zum Ändern des Zeilenabstands finden sie in der Rubrik Zeilen-

abstand: 

3. Wählen Sie dort zunächst über die aufklappbare Liste aus, welche Methode 

zum Festlegen des Zeilenabstands verwendet werden soll (siehe unten). 

4. Tragen Sie dann rechts daneben das gewünschte Maß ein. 

Wenn Sie mit OK bestätigen, wird der Zeilenabstand entsprechend geändert. 
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Methoden zum Festlegen des Zeilenabstands 

In der aufklappbaren Liste Zeilenabstand können Sie dabei wählen, welche Me-

thode zum Festlegen des Zeilenabstands verwendet werden soll. 

Die Liste hat folgende Einträge: 

 Einfach 

 Einfacher automatischer Zeilenabstand.  

 Hier wird der optimale Zeilenabstand automatisch ermittelt: 

 Wenn Sie beispielsweise die Schriftgröße in dem Absatz erhöhen, wird auch der 

Zeilenabstand entsprechend vergrößert.  

 Reduzieren Sie die Schriftgröße, wird der Zeilenabstand hingegen automatisch 

verkleinert. 

 Mehrfach 

 Mehrfacher automatischer Zeilenabstand.  

 Entspricht der Option Einfach, liefert also ebenfalls einen automatischen Zei-

lenabstand. Allerdings können Sie diesen bei Bedarf einfach vergrößern oder 

verkleinern, indem Sie in dem Eingabefeld rechts von dieser Option die ge-

wünschte Anzahl an Zeilen angeben. 

 Beispiele: 

 Tragen Sie bei Zeilen „1,5“ ein, um anderthalbfachen automatischen Zeilenab-

stand zu erhalten. 

 Tragen Sie „2“ ein, um zweifachen automatischen Zeilenabstand zu erhalten. 

 Tragen Sie „1“ ein, um einfachen automatischen Zeilenabstand zu erhalten 

(entspricht dem Wählen der Option Einfach). 

 Genau 

 Fester Zeilenabstand. 

 Hier können Sie den Zeilenabstand auf einen festen Wert in Punkt setzen. Der 

Zeilenabstand wird dann nicht mehr automatisch an die Schriftgröße angepasst.  

 Mindestens 

 Mindest-Zeilenabstand. 
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 Diese Einstellung entspricht der Option Einfach, verhindert jedoch, dass der 

angegebene Mindestwert unterschritten wird.  

 Tragen Sie als Mindestwert also 12 Punkt ein, verwendet das Programm norma-

lerweise einen einfachen automatischen Zeilenabstand. Unterschritte dieser je-

doch 12 Punkt (weil Sie eine sehr kleine Schrift verwenden), wird stattdessen 

ein fester Zeilenabstand von 12 Punkt verwendet. 

Standardmäßig ist der Zeilenabstand auf Einfach gesetzt. 

Absatzausrichtung (nur in Textrahmen) 

Hinweis: Die Absatzausrichtung ist nur bei Text einstellbar, der in einen Text-

rahmen eingefügt wurde. Um die Ausrichtung von Text in Tabellenzellen festzu-

legen, rufen Sie den Befehl Format > Zelle auf und wechseln auf die Karteikarte 

Ausrichtung. 

Mit dem Befehl Format > Absatz kann auch die Ausrichtung von Textabsätzen 

geändert werden, die in einen Textrahmen eingefügt wurden. 

Es gibt vier Arten der Absatzausrichtung: 

 Linksbündig 

 Rechtsbündig 

 Zentriert 

 Blocksatz (Wörter gleichmäßig zwischen linkem und rechtem Rand verteilen) 

Ändern der Schreibrichtung (für arabischen Text) 

Für Text in arabischer Schrift gibt es zusätzlich noch die Option Schreibrichtung, 

mit der Sie die Schreibrichtung des Absatzes auf rechts-nach-links setzen können. 

Siehe auch Kapitel „Arbeiten mit arabischem Text“ (ab Seite 371). 

Abstände oberhalb/unterhalb eines Absatzes (nur in 

Textrahmen) 

Hinweis: Der Abstand oberhalb/unterhalb eines Absatzes ist nur bei Text ein-

stellbar, der in einen Textrahmen eingefügt wurde. Um die Abstände zwischen 

Tabellenzellen festzulegen, können Sie jederzeit die Zeilenhöhe der Zellen än-

dern. 
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Neben dem Zeilenabstand können Sie bei Text in einem Textrahmen auch festle-

gen, wie viel Platz oberhalb der ersten Zeile und unterhalb der letzten Zeile eines 

Absatzes freigehalten werden soll.  

Dies können Sie in der Rubrik Abstände im Dialogfenster von Format > Absatz 

einstellen. Es gibt hier folgende Optionen: 

Option Bedeutung 

Oberhalb Geben Sie hier ein, wie viel Abstand zum Ende des vorherigen Ab-

satzes eingehalten werden soll. 

Unterhalb Hier ist einzutragen, wie viel Abstand PlanMaker zum Beginn des 

nächsten Absatzes einhalten soll. 

Zeichenvorlagen 

In einer Zeichenvorlage können Sie ein häufig benötigtes Zeichenformat (Schrift-

art, Schriftgröße, Textauszeichnungen etc.) speichern und es immer wieder auf 

beliebige Zeichen anwenden. 

Möchten Sie beispielsweise kleingedruckte Bereiche in einer anderen Schrift und 

einer kleineren Größe drucken, erstellen Sie sich einfach eine entsprechende Zei-

chenvorlage – nennen wir sie „Kleingedrucktes“ – und wenden diese an den ge-

wünschten Stellen an. 

Anmerkung: Der Unterschied zwischen Zeichenvorlagen und Zellenvorlagen (sie-

he Abschnitt „Zellenvorlagen“ ab Seite 177) liegt darin, dass in Zeichenvorlagen 

nur das Zeichenformat gespeichert wird, in Zellenvorlagen hingegen sowohl das 

Zellenformat (Zahlenformat, Umrandung, Ausrichtung etc.) als auch das Zeichen-

format.  

Weiterhin sind Zeichenvorlagen auch auf einzelne Zeichen anwendbar, Zellenvor-

lagen hingegen nur auf komplette Zellen. 

Ausführlichere Informationen folgen auf den nächsten Seiten. 

Zeichenvorlagen erstellen 

Um eine Zeichenvorlage zu erstellen, gehen Sie wie folgt vor: 

1. Rufen Sie Format > Zeichenvorlage auf. 
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2. Klicken Sie auf die Schaltfläche Neu. 

3. Geben Sie der Zeichenvorlage einen beliebigen Namen und bestätigen Sie mit 

OK. 

4. Es erscheint ein Dialogfenster, das dem des Befehls Format > Zeichen weitge-

hend entspricht. Stellen Sie hier die gewünschte Zeichenformatierung ein (siehe 

Abschnitt „Zeichenformat“ ab Seite 163). 

5. Wurden alle gewünschten Einstellungen vorgenommen, klicken Sie auf OK, 

um die Vorlage zu definieren. 

6. Verlassen Sie das Dialogfenster „Zeichenvorlage“ mit Schließen. 

Die Vorlage ist nun definiert und einsatzbereit. Wie Sie die neue Vorlage in der 

Praxis einsetzen, erfahren Sie im nächsten Abschnitt. 

Tastenkürzel verwenden 

Benötigen Sie eine Formatvorlage besonders häufig, können Sie ihr jederzeit ein 

Tastenkürzel geben. Das hat den Vorteil, dass Sie die Vorlage blitzschnell mit ei-

nem einzigen Tastendruck aktivieren können. 

Um einer Vorlage ein Tastenkürzel zuzuordnen, wechseln Sie im Dialog von For-

mat > Zeichenvorlage auf die Karteikarte Vorlage, setzen die Schreibmarke in 

das Eingabefeld Tastenkürzel und betätigen die gewünschte Tastenkombination.  

Hinweis: Wenn Sie eine Tastenkombination betätigen, die bereits belegt ist, wird 

unter dem Eingabefeld Tastenkürzel angezeigt, womit diese momentan belegt 

ist. Sie sollten dann die Rücktaste (æ__) betätigen, um das Tastenkürzel wieder 

zu löschen und eine andere Tastenkombination verwenden. Andernfalls über-

schreiben Sie die Tastenkombination einer anderen Vorlage oder gar die eines 

PlanMaker-Befehls. 

Wir empfehlen Ihnen, für Formatvorlagen stets Tastenkombinationen mit den Tas-

ten (Strg) und (ª) zu verwenden, da diese normalerweise nicht belegt sind. 

Zeichenvorlagen anwenden 

Um eine Zeichenvorlage anzuwenden, gehen Sie wie folgt vor: 

1. Markieren Sie die gewünschten Zellen. Sie können auch einzelne Zeichen in-

nerhalb einer Zelle markieren, nachdem Sie die Taste (F2) betätigt haben. 
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2. Rufen Sie Format > Zeichenvorlage auf. 

3. Wählen Sie die gewünschte Vorlage. 

4. Klicken Sie auf Anwenden. 

Sofort ändert sich die Formatierung der markierten Zeichen so, wie Sie es in der 

Zeichenvorlage festgelegt hatten.  

Tipp: Sie können Zeichenvorlagen auch aus der Liste der Schriftarten in der 

Formatleiste auswählen. 

Noch schneller: Haben Sie der Formatvorlage ein Tastenkürzel zugewiesen, 

können Sie die Vorlage noch schneller anwenden: Markieren Sie die gewünsch-

ten Zellinhalte und betätigen Sie die gewählte Tastenkombination. 

Zeichenvorlagen ändern 

Selbstverständlich können Sie Zeichenvorlagen jederzeit wieder abändern. 

Wichtig: Wenn Sie die Formatierung einer Zeichenvorlage abändern, ändert sich 

automatisch die Formatierung aller Zeichen, die mit dieser Vorlage formatiert 

wurden. 

Um eine Zeichenvorlage zu bearbeiten, gehen Sie folgendermaßen vor: 

1. Rufen Sie Format > Zeichenvorlage auf. 

2. Wählen Sie die zu ändernde Vorlage aus der Liste. 

3. Klicken Sie auf Bearbeiten. 

4. Nehmen Sie die gewünschten Änderungen an der Vorlage vor. 

5. Klicken Sie auf OK. 

6. Verlassen Sie das Dialogfenster mit Schließen. 

Zeichenvorlagen löschen oder umbenennen 

Die Schaltfläche Löschen im Dialog von Format > Zeichenvorlage löscht die 

gewählte Vorlage im aktuellen Dokument.  
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Um einer Vorlage einen neuen Namen zu geben, klicken Sie auf Umbenennen und 

tippen den neuen Namen ein. Auch dies wirkt sich nur auf das aktuelle Dokument 

aus. 

Um Formatvorlagen einer Dokumentvorlage zu löschen oder umzubenennen, öff-

nen Sie die Dokumentvorlage, nehmen die Änderungen darin vor und speichern die 

Dokumentvorlage. 

Zeichenvorlage Normal 

Die Zeichenvorlage namens „Normal“ existiert standardmäßig in jedem Dokument 

und hat eine besondere Bedeutung. Sie ist die Standardvorlage für alle Zellinhalte. 

Solange Sie in einem neuen Dokument einfach etwas eintippen, wird diesem auto-

matisch die Zeichenvorlage „Normal“ zugewiesen. 

Ändern Sie beispielsweise die Schriftart der Vorlage „Normal“, ändert sich dem-

entsprechend die Schrift in sämtlichen Zellen (außer bei Zellen, die Sie mit For-

mat > Zeichen in einer anderen Schrift formatiert haben). Weiterhin haben Sie auf 

diese Weise die Standardschrift für zukünftige Eingaben geändert. 

Verknüpfte Zeichenvorlagen erstellen 

Wenn Sie, wie zu Beginn dieses Kapitels beschrieben, neue Vorlagen erstellen, 

basieren diese stets auf der Zeichenvorlage „Normal“. Wählen Sie also beispiels-

weise für die Vorlage „Normal“ eine neue Schriftart, ändert sich die Schrift auch in 

allen anderen Vorlagen – sofern dort keine andere Schrift gewählt wurde. 

Also: Normalerweise sind alle Zeichenvorlagen mit der Vorlage „Normal“ ver-

knüpft. Sie können aber beim Erstellen einer neuen Vorlage unter Basierend auf 

eine beliebige andere Zeichenvorlage als Basis angeben. 

Um eine Vorlage zu erstellen und diese auf einer bestimmten anderen Vorlage ba-

sieren zu lassen, gehen Sie folgendermaßen vor: 

1. Rufen Sie Format > Zeichenvorlage auf. 

2. Klicken Sie auf die Schaltfläche Neu. 

3. Geben Sie der Zeichenvorlage einen Namen. 

4. Wählen Sie auf der Karteikarte Vorlage unter Basierend auf die Vorlage, mit 

der die neue Vorlage verknüpft sein soll. 
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5. Nun können Sie die gewünschte Formatierung anbringen etc. 

Relative Schriftgröße 

Wenn Sie eine Vorlage auf einer anderen basieren lassen, können Sie auf Wunsch 

die relative Schriftgröße angeben. Sie können zum Beispiel festlegen, dass die 

Schriftgröße der Vorlage X stets 80% der Schriftgröße von Vorlage Y betragen soll. 

Gehen Sie dazu wie folgt vor: 

1. Rufen Sie Format > Zeichenvorlage auf. 

2. Selektieren Sie eine Vorlage und klicken Sie auf Bearbeiten. 

3. Wechseln Sie auf die Karteikarte Vorlage. 

4. Schalten Sie die Option Größe ein. 

5. Tragen Sie den gewünschten Faktor in Prozent ein – zum Beispiel 80. 

6. Bestätigen Sie mit OK. 

Die Schriftgröße einer so bearbeiteten Vorlage wird nun stets 80% der Vorlage be-

tragen, auf der sie basiert. 

Zellenvorlagen 

In einer Zellenvorlage können Sie ein häufig benötigtes Zellenformat (Zahlenfor-

mat, Umrandung, Ausrichtung etc.) speichern und es immer wieder auf beliebige 

Zellen anwenden. 

Möchten Sie beispielsweise regelmäßig Zellen mit dem Zahlenformat „Währung“ 

und einer anderen Schriftart formatieren, erstellen Sie sich einfach eine entspre-

chende Zellenvorlage und wenden diese auf die gewünschten Zellen an. 

Anmerkung: Der Unterschied zwischen Zeichenvorlagen (siehe Abschnitt 

„Zeichenvorlagen“ ab Seite 173) und Zellenvorlagen liegt darin, dass in Zeichen-

vorlagen nur das Zeichenformat gespeichert wird, in Zellenvorlagen hingegen so-

wohl das Zellenformat (Zahlenformat, Umrandung, Ausrichtung etc.) als auch das 

Zeichenformat (Schriftart, Textauszeichnungen etc.). 

Weiterhin sind Zeichenvorlagen auch auf einzelne Zeichen anwendbar, Zellenvor-

lagen hingegen nur auf komplette Zellen. 



 

178    Gestalten einer Tabelle Handbuch PlanMaker 

Ausführlichere Informationen folgen auf den nächsten Seiten. 

Zellenvorlagen erstellen 

Um eine Zellenvorlage zu erstellen, gehen Sie wie folgt vor: 

1. Rufen Sie Format > Zellenvorlage auf. 

2. Klicken Sie auf die Schaltfläche Neu. 

3. Geben Sie der Zellenvorlage einen beliebigen Namen und bestätigen Sie mit 

OK. 

4. Die Vorlage wurde nun angelegt, und Sie können sie wie folgt bearbeiten: 

 Klicken Sie auf Zeichenformat, wenn Sie das Zeichenformat der Vorlage än-

dern möchten. Dazu erscheint ein Dialogfenster, das dem des Befehls Format 

> Zeichen weitgehend entspricht (siehe Abschnitt „Zeichenformat“ ab Seite 

163). 

 Klicken Sie auf Zellenformat, wenn Sie das Zellenformat der Vorlage ändern 

möchten. Dazu erscheint ein Dialogfenster, das dem des Befehls Format > Zel-

le weitgehend entspricht (siehe Abschnitte „Zahlenformat“ ab Seite 142 und 

folgende). 

5. Ist alles wunschgemäß, verlassen Sie das Dialogfenster „Zellenvorlage“ mit 

Schließen. 

Die Vorlage ist nun definiert und einsatzbereit. Wie Sie diese Vorlage in der Praxis 

einsetzen, erfahren Sie im nächsten Abschnitt. 

Tastenkürzel verwenden 

Benötigen Sie eine Zellenvorlage besonders häufig, können Sie ihr jederzeit ein 

Tastenkürzel geben. Das hat den Vorteil, dass Sie die Vorlage blitzschnell mit ei-

nem einzigen Tastendruck aktivieren können. 

Um einer Vorlage ein Tastenkürzel zuzuordnen, rufen Sie den Befehl Format > 

Zellenvorlage auf und selektieren die gewünschte Vorlage in der Liste. Dann kli-

cken Sie in das Eingabefeld Tastenkürzel und betätigen die gewünschte Tasten-

kombination.  
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Hinweis: Wenn Sie eine Tastenkombination betätigen, die bereits belegt ist, wird 

unter dem Eingabefeld Tastenkürzel angezeigt, womit diese momentan belegt 

ist. Sie sollten dann die Rücktaste (æ__) betätigen, um das Tastenkürzel wieder 

zu löschen und eine andere Tastenkombination verwenden. Andernfalls über-

schreiben Sie die Tastenkombination einer anderen Vorlage oder gar die eines 

PlanMaker-Befehls. 

Wir empfehlen Ihnen, für Formatvorlagen stets Tastenkombinationen mit den Tas-

ten (Strg) und (ª) zu verwenden, da diese normalerweise nicht belegt sind. 

Zellenvorlagen anwenden 

Um eine Zellenvorlage anzuwenden, gehen Sie wie folgt vor: 

1. Markieren Sie die gewünschten Zellen. Wenn Sie nichts markieren, wird die 

Vorlage auf die aktuelle Zelle angewandt. 

2. Rufen Sie Format > Zellenvorlage auf. 

3. Wählen Sie die gewünschte Vorlage. 

4. Klicken Sie auf Anwenden. 

Sofort ändert sich die Formatierung der markierten Zellen so, wie Sie es in der 

Zellenvorlage festgelegt hatten.  

Tipp: In der Formatleiste wird ganz links stets die für die aktuelle Zelle gewählte 

Zellenvorlage angezeigt. Wenn Sie diese Liste durch einen Mausklick auf das 

Pfeilchen rechts daneben öffnen, können Sie hier eine Vorlage auswählen. 

Noch schneller: Haben Sie der Vorlage ein Tastenkürzel zugewiesen, können Sie 

diese noch schneller anwenden: Betätigen Sie einfach die gewählte Tastenkom-

bination. 

Zellenvorlagen ändern 

Selbstverständlich können Sie Zellenvorlagen jederzeit wieder abändern. 

Wichtig: Wenn Sie die Formatierung einer Zellenvorlage abändern, ändert sich 

automatisch die Formatierung aller Zellinhalte, die mit dieser Vorlage formatiert 

wurden. 
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Um eine Zellenvorlage zu bearbeiten, gehen Sie folgendermaßen vor: 

1. Rufen Sie Format > Zellenvorlage auf. 

2. Wählen Sie die zu ändernde Vorlage aus der Liste. 

3. Klicken Sie auf Zeichenformat, wenn Sie ihr Zeichenformat ändern möchten 

beziehungsweise auf Zellenformat, wenn Sie ihr Zellenformat ändern möch-

ten. 

4. Nehmen Sie die gewünschten Änderungen an der Vorlage vor und bestätigen 

Sie mit OK. 

5. Verlassen Sie das Dialogfenster mit Schließen. 

Zellenvorlagen löschen oder umbenennen 

Die Schaltfläche Löschen im Dialog von Format > Zellenvorlage löscht die ge-

wählte Vorlage im aktuellen Dokument.  

Um einer Vorlage einen neuen Namen zu geben, klicken Sie auf Umbenennen und 

tippen den neuen Namen ein. Auch dies wirkt sich nur auf das aktuelle Dokument 

aus. 

Um Formatvorlagen einer Dokumentvorlage zu löschen oder umzubenennen, öff-

nen Sie die Dokumentvorlage, nehmen die Änderungen darin vor und speichern die 

Dokumentvorlage. 

Zellenvorlage Normal 

Die Zellenvorlage namens „Normal“ existiert standardmäßig in jedem Dokument 

und hat eine besondere Bedeutung. Sie ist die Standardvorlage für alle Zellen. So-

lange Sie einer Zelle also keine andere Vorlage zuweisen, ist Sie immer in der Zel-

lenvorlage „Normal“ formatiert. 

Ändern Sie nun beispielsweise das Zahlenformat der Vorlage „Normal“, ändert 

sich das Zahlenformat aller Zellen (außer bei Zellen, denen Sie mit Format > Zelle 

ein anderes Zahlenformat „von Hand“ zugewiesen haben). 

Verknüpfte Zellenvorlagen erstellen 

Wenn Sie, wie zu Beginn dieses Kapitels beschrieben, neue Vorlagen erstellen, 

basieren diese stets auf der Zellenvorlage „Normal“. Wählen Sie also beispielswei-
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se für die Vorlage „Normal“ ein anderes Zahlenformat, ändert sich das Zahlenfor-

mat auch in allen anderen Vorlagen – sofern dort nicht explizit ein anderes Zahlen-

format gewählt wurde. 

Also: Normalerweise sind alle Zellenvorlagen mit der Vorlage „Normal“ ver-

knüpft. Sie können aber beim Erstellen einer neuen Vorlage unter Basierend auf 

eine beliebige andere Zellenvorlage als Basis angeben. 

Um eine Vorlage zu erstellen und diese auf einer bestimmten anderen Vorlage ba-

sieren zu lassen, gehen Sie folgendermaßen vor: 

1. Rufen Sie Format > Zellenvorlage auf. 

2. Klicken Sie auf die Schaltfläche Neu. 

3. Geben Sie der Zellenvorlage einen Namen. 

4. Wählen Sie unter Basierend auf die Vorlage, mit der die neue Vorlage ver-

knüpft sein soll. 

5. Nun können Sie die gewünschte Formatierung anbringen etc. 

Dokumentvorlagen 

Wie Sie in den letzten beiden Abschnitten erfahren haben, werden Zeichen- und 

Zellenvorlagen in dem Dokument gespeichert, in dem sie erstellt wurden. Wenn 

Sie solche Formatvorlagen auch in anderen Dokumenten verwenden möchten, soll-

ten Sie diese in einer Dokumentvorlage speichern.  

Jedes Mal, wenn Sie Datei > Neu aufrufen, lässt Sie PlanMaker nämlich auswäh-

len, auf welcher Dokumentvorlage das neue Dokument basieren soll. Wählen Sie 

hier eine von Ihnen erstellte Dokumentvorlage, stehen in dem neuen Dokument 

genau die Zeichen- und Zellenvorlagen zur Verfügung, die in der Dokumentvorlage 

vorhanden sind. 

Dokumentvorlagen können übrigens nicht nur Ihre bevorzugten Formatvorlagen 

enthalten, sondern auch mit Text, Werten etc. vorgefüllt sein. Erstellen Sie also Ihre 

„Schablonen“ für Rechnungen, Jahresberichte, Kostengegenüberstellungen etc. – 

schon wird das Erstellen neuer Tabellen zum Kinderspiel: einfach Datei > Neu 

aufrufen, die Vorlage auswählen und die Tabelle fertig ausfüllen. 

Ausführlichere Informationen folgen auf den nächsten Seiten. 
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Dokumentvorlagen erstellen 

Um eine neue Dokumentvorlage zu erstellen, gehen Sie folgendermaßen vor: 

1. Beginnen Sie ein neues Dokument oder öffnen Sie das Dokument beziehungs-

weise die Dokumentvorlage, auf deren Basis die neue Dokumentvorlage erstellt 

werden soll.  

2. Erstellen Sie die gewünschten Zeichen- und Zellenvorlagen und/oder tragen Sie 

Text, Werte etc. ein, um die Vorlage zu erstellen. 

3. Rufen Sie Datei > Speichern unter auf. 

4. Wählen Sie in der Liste Dateityp den Eintrag PlanMaker-Vorlage. 

5. PlanMaker wechselt nun automatisch in den Ordner, in dem sich die Doku-

mentvorlagen befinden. 

6. Tippen Sie bei Dateiname einen Namen für die Vorlage ein. 

7. Bestätigen Sie mit OK. 

Die Vorlage wird nun gespeichert. 

Dokumentvorlagen anwenden 

Um eine Dokumentvorlage zu verwenden, beginnen Sie einfach mit Datei > Neu 

ein neues Dokument. PlanMaker fragt Sie dabei automatisch, auf welcher Doku-

mentvorlage dieses basieren soll: 

1. Rufen Sie Datei > Neu auf. 

2. Wählen Sie die gewünschte Dokumentvorlage aus der Liste Vorlage.  

3. Klicken Sie auf OK. 

Es wird nun ein neues Dokument angelegt, in dem Ihnen alle in der Dokumentvor-

lage gespeicherten Zeichen- und Zellenvorlagen zur Verfügung stehen. Enthält die 

Dokumentvorlage auch ausgefüllte Zellen, werden diese entsprechend angezeigt 

und können ganz normal bearbeitet werden. 
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Dokumentvorlagen ändern 

Das Ändern einer Dokumentvorlage unterscheidet sich nicht weiter vom Bearbei-

ten eines normalen Dokuments. Sie öffnen die Vorlage, nehmen Ihre Änderungen 

vor und speichern die Dokumentvorlage. 

Wichtig: Das Ändern einer Dokumentvorlage wirkt sich auf alle Dokumente aus, 

die anschließend mit dieser Vorlage erstellt werden. 

Um eine Dokumentvorlage zu ändern, gehen Sie folgendermaßen vor: 

1. Rufen Sie Datei > Öffnen auf. 

2. Wählen Sie in der Liste Dateityp den Eintrag PlanMaker-Vorlage. 

3. Suchen Sie sich die zu ändernde Vorlage aus und bestätigen Sie mit OK. 

4. Machen Sie die gewünschten Änderungen an den Zellen und/oder Vorlagen 

dieser Dokumentvorlage. 

5. Rufen Sie Datei > Speichern auf, um geänderte Vorlage zu speichern. 

Sie können die Vorlage natürlich auch mit Datei > Speichern unter unter einem 

anderen Namen sichern, wenn das Original nicht überschrieben werden soll. 

Dokumentvorlage Normal.pmv 

Die Dokumentvorlage NORMAL.PMV ist die Standardvorlage für neue Dokumente. 

Wenn Sie Datei > Neu aufrufen, wird stets diese Vorlage vorgegeben. Sie ist gänz-

lich leer und enthält lediglich die Standardzeichenvorlage „Normal“ sowie die 

Standardzellenvorlage „Normal“. 

Dementsprechend eignet sich die Dokumentvorlage NORMAL.PMV als Basis, wenn 

Sie eine völlig neue Vorlage erstellen möchten, in der zu Beginn nichts eingetragen 

sein soll. 

Wichtig: Die Standardvorlage NORMAL.PMV sollten Sie normalerweise nicht än-

dern. Wenn Sie dies trotzdem tun möchten, sollten Sie sich bewusst sein, dass 

sich diese Änderungen auf alle Dokumente auswirken, die anschließend auf Ba-

sis dieser Vorlage angelegt werden. 

Möchten Sie also beispielsweise das Seitenformat für alle Dokumente ändern, die 

zukünftig auf Basis der Vorlage NORMAL.PMV erstellt werden, dann öffnen Sie die-

se Vorlage, ändern das Seitenformat und speichern die Vorlage. 
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Übrigens können Sie für neue Dateien auch eine andere Standardvorlage wählen. 

Rufen Sie dazu Datei > Neu auf, wählen Sie die gewünschte Vorlage und klicken 

Sie auf Neuer Standard. Ab jetzt bietet Ihnen PlanMaker beim Anlegen neuer 

Dokumente stets diese Vorlage als Standardvorlage an. 

AutoFormat 

Mit dem Befehl Format > AutoFormat können Sie das Layout ganzer Tabellenbe-

reiche auf einmal ändern. 

 

Der Dialog zu diesem Befehl zeigt Ihnen eine Liste mit vorgefertigten „AutoFor-

mat-Vorlagen“, deren Aussehen Sie im Feld Beispiel vorab begutachten können. 

Zur Anwendung einer AutoFormat-Vorlage genügt es, einen Tabellenbereich zu 

markieren, obigen Befehl aufzurufen, die gewünschte Vorlage auszuwählen und 

auf OK zu klicken. 

Über die Optionen im Bereich Anwenden können Sie dabei bestimmen, welche 

Formatierungen der Vorlage angebracht werden sollen. Schalten Sie beispielsweise 

alle Optionen bis auf Umrandungen aus, werden nur die Umrandungen der Auto-

Format-Vorlage angewandt; alle anderen Formatierungen der Tabelle bleiben erhal-

ten. 
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Bedingte Formatierung 

Mit dem Befehl Format > Bedingte Formatierung können Sie Zellen mit einer 

bedingten Formatierung versehen.  

Bedingte Formatierungen werden nur dann angebracht, wenn eine bestimmte Be-

dingung erfüllt ist. Bedingung und Formatierung können Sie frei festlegen. 

Ein Beispiel: Sie möchten, dass der Inhalt einer Zelle rot dargestellt werden soll, 

wenn ihr Inhalt größer als 1000 ist. Gehen Sie dazu wie folgt vor: 

1. Klicken Sie die gewünschte Zelle an. Sie können natürlich auch einen Zellbe-

reich markieren, wenn Sie gleich mehrere Zellen mit einer bedingten Formatie-

rung versehen möchten. 

2. Rufen Sie Format > Bedingte Formatierung auf. 

3. Geben Sie die Bedingung ein. In diesem Falle wählen Sie bei Bedingung 1 also 

Zellwert, wählen rechts daneben größer als und tragen dann die Zahl 1000 ein. 

4. Klicken Sie auf die Schaltfläche Format und wählen Sie die Formatierung, die 

angebracht werden soll, wenn die Bedingung zutrifft. In diesem Falle stellen 

Sie also als Schriftfarbe Rot ein und bestätigen mit OK. 

5. Schließen Sie den Dialog mit OK. 

In unserem Beispiel ergäbe dies das folgende Resultat: 

 Ist der Zellwert kleiner oder gleich 1000, wird die ursprüngliche Formatierung 

der Zelle angezeigt. 

 Ist der Zellwert größer als 1000, wird die bedingte Formatierung der Zelle an-

gezeigt, der Zellinhalt also rot dargestellt. 

Sie können übrigens auch mehrere bedingte Formatierungen gleichzeitig anbrin-

gen, also beispielsweise als Bedingung 2 angeben, dass die Zelle kursiv dargestellt 

werden soll, wenn der Zellwert kleiner als Null ist. 

Mit der Schaltfläche Löschen in dem Dialog können Sie die einzelnen Bedingun-

gen bei Bedarf wieder löschen. 

Formulieren komplexerer Bedingungen 

Beim Formulieren von Bedingungen für bedingte Formatierungen sind Sie nicht 

auf feste Zahlenwerte beschränkt, sondern können auch Formeln verwenden: 
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 Verwendung von Formeln für Bedingungen mit dem Zellwert 

 In die Eingabefelder des obigen Dialogs lassen sich nicht nur feste Werte, son-

dern auch beliebige Formeln eingeben.  

 Sie können also nicht nur Bedingungen wie „Zellwert größer als 1000“ formu-

lieren, sondern auch komplexere Bedingungen wie „Zellwert größer als 

SIN($A$1)“. In diesem Falle würde die bedingte Formatierung angebracht, 

wenn der Zellwert größer als der Sinus des Wertes in Zelle A1 ist. 

 Verwendung freier Formeln 

 Wenn Sie im obigen Dialog statt Zellwert die Option Formel wählen, lassen 

sich auch völlig freie Formeln als Bedingung eingeben. Sie müssen lediglich 

darauf achten, dass diese einen Wahrheitswert (also WAHR oder FALSCH) als 

Ergebnis haben. 

 Beispiele: 

 Bei der Formel „SUMME($A$1:$C$3) > 42“ wird die bedingte Formatierung 

angebracht, wenn die Summe des Zellbereichs A1:C3 größer als 42 ist. 

 Bei der Formel „ISTGERADE(ZEILE())“ wird die bedingte Formatierung an-

gebracht, wenn sich die Zelle in einer Zeile mit gerader Zeilennummer befin-

det. 

 Absolute und relative Adressen 

 Beachten Sie, dass in solchen Formeln nicht nur absolute Zellbezüge (wie in 

den obigen Beispielen), sondern auch relative Zellbezüge verwendet werden 

können: 

 Absolute Zellbezüge wie $A$1 beziehen sich immer auf die Zelle A1. 

 Relative Zellbezüge wie A1 beziehen sich hingegen auf die Zelle in der linken 

oberen Ecke der Markierung. Wenden Sie eine bedingte Formatierung auf nur 

eine Zelle an, bezieht sich A1 also auf eben diese Zelle. Hatten Sie zuvor einen 

Bereich von Zellen markiert, bezieht sich A1 auf die Zelle in der linken oberen 

Ecke, A2 auf die Zelle darunter etc. 

Gültigkeitsprüfung 

Wenn Sie Zellen mit einer Gültigkeitsprüfung versehen, können Sie damit folgen-

des erreichen: 
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 Festlegen, dass in diesen Zellen nur noch bestimmte Arten von Werten (zum 

Beispiel nur Zahlen) innerhalb bestimmter Grenzwerte (zum Beispiel nur Werte 

zwischen 10 und 20) als gültig erachtet werden. 

 Einen Infotext zum Ausfüllen der Zellen anzeigen lassen, sobald der Anwender 

diese Zelle ansteuert (zum Beispiel „Hier bitte nur Zahlen zwischen 10 und 20 

eingeben!“). 

 Eine Fehler-, Warn- oder Infomeldung ausgeben lassen, wenn der Anwender 

dennoch Werte eingibt, die der Gültigkeitsprüfung nicht entsprechen. 

Dies ist nützlich, wenn Sie Tabellen erstellen, die von anderen Anwendern ausge-

füllt werden sollen, und Sie verhindern möchten, dass in diesen Zellen falsche Wer-

te eingetippt werden können. 

Wenn Sie beispielsweise möchten, dass in bestimmten Zellen nur noch Zahlen zwi-

schen 10 und 20 als gültig erachtet werden, gehen Sie dazu wie folgt vor: 

1. Selektieren Sie die gewünschten Zellen. 

2. Rufen Sie den Befehl Format > Gültigkeitsprüfung auf. 

3. Auf der Karteikarte Einstellungen können Sie bestimmen, welche Arten von 

Werten für die Zellen als gültig erachtet werden sollen und Grenzwerte für die 

zulässigen Werte festlegen.  

 In unserem Beispiel wäre also einzustellen:  

 Zulässig sind: „Dezimalzahlen“ 

 Mit Werten: „zwischen“ 

 Minimum: 10 

 Maximum: 20 

4. Auf der Karteikarte Eingabemeldung können Sie (auf Wunsch) einen Infotext 

eintragen, der angezeigt wird, sobald der Anwender eine dieser Zellen ansteu-

ert.  

 Tragen Sie beispielsweise „Hier bitte nur Zahlen zwischen 10 und 20 einge-

ben!“ ein. Sie können die Eingabemeldung natürlich auch leer lassen. 

5. Auf der Karteikarte Fehlermeldung können Sie festlegen, was für eine Mel-

dung erscheinen soll, wenn der Anwender in die Zellen ungültige Werte ein-

tippt. 

 Über die Symbole im Bereich Typ bestimmen Sie zunächst die Art der Fehler-

meldung (siehe Erläuterungen weiter unten).  
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Wichtig: Der Typ der Meldung bestimmt auch, ob es dem Anwender erlaubt 

sein soll, dennoch ungültige Eingaben zu machen. Nur beim Typ Fehlermel-

dung (erstes Symbol) weist PlanMaker ungültige Eingaben strikt zurück! 

 Weiterhin können Sie den Text der Meldung angeben. Wenn Sie nichts einge-

ben, wird eine Standardmeldung ausgegeben. 

 Wählen Sie hier beispielsweise den Typ Fehlermeldung (erstes Symbol) und 

tragen Sie auf Wunsch eine geeignete Meldung ein (zum Beispiel mit dem Titel 

„Eingabefehler“ und dem Text „Hier dürfen nur Zahlen zwischen 10 und 20 

eingegeben werden!“). 

6. Bestätigen Sie mit OK. 

In den gewählten Zellen werden jetzt nur noch Zahlen zwischen 10 und 20 als gül-

tig erachtet. Gibt der Anwender etwas anderes ein, erscheint eine Fehlermeldung. 

Hinweis: Beachten Sie dabei, dass die Gültigkeitsprüfung nur dann aktiv wird, 

wenn der Anwender Werte eintippt. Fügt der Anwender hingegen ungültige Wer-

te durch Kopieren und Einfügen ein (zum Beispiel mit Bearbeiten > Einfügen), 

schlägt die Gültigkeitsprüfung nicht Alarm! 

Wenn Sie die Gültigkeitsprüfung wieder abschalten möchten, markieren Sie die 

betroffenen Zellen und wenden den Befehl Bearbeiten > Selektiv löschen > Gül-

tigkeitsprüfung an. Alternativ können Sie auch erneut Format > Gültigkeitsprü-

fung aufrufen und bei Zulässig sind: wieder „Alle Werte“ auswählen. 

Das Dialogfenster des obigen Befehls verfügt über folgende Optionen: 

Karteikarte Einstellungen 

 Zulässig sind: 

 Mit dieser Option bestimmen Sie, welche Arten von Werten zulässig sind: 

Option Erläuterung 

Alle Werte Alle Arten von Werten zulassen (die Gültigkeitsprü-

fung also deaktivieren) 

Ganze Zahlen Nur ganze Zahlen zulassen 

Dezimalzahlen Nur Zahlen zulassen 

Feste Listeneinträge Nur Einträge aus einer Liste von zulässigen Einträ-

gen zulassen. 
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 Tragen Sie dazu in das Feld Quelle eine durch 

Strichpunkte getrennte Liste der erlaubten Werte ein 

– zum Beispiel Hund;Katze;Maus oder 1;2;3;4;5;6. 

 Alternativ können Sie auch ein Gleichheitszeichen 

und dahinter einen Zellbereich eintragen, der alle 

gültigen Einträge enthält. Enthalten die Zellen C1 

bis C3 also z.B. „Hund“, „Katze“ und „Maus“ und 

Sie geben bei Quelle =C1:C3 ein, sind nur noch 

diese drei Begriffe zulässig. 

 Über die Schaltfläche Einstellungen können Sie 

zusätzliche Optionen einstellen. 

Datumswerte Nur Datumsangaben zulassen 

Zeitwerte Nur Uhrzeiten zulassen 

Textlänge Nur Einträge (auch Zahlen) mit der angegebenen 

Textlänge zulassen 

Benutzerdefiniert Nur Einträge zulassen, die der angegebenen Bedin-

gung entsprechen. Tragen Sie diese anschließend im 

Feld Berechnung ein. Weitere Informationen dazu 

finden Sie am Ende dieses Abschnitts. 

 Mit Werten 

 Hier können Sie die zulässigen Werte weiter eingrenzen. Wählen Sie beispiels-

weise die Option Zwischen, können Sie darunter das Minimum und Maximum 

angeben, zwischen dem die Werte liegen müssen. 

 Minimum, Maximum etc. 

 Darunter legen Sie die Grenzwerte für die Eingaben fest. Tragen Sie beispiels-

weise als Minimum 10 und als Maximum 20 ein, werden nur noch Werte zwi-

schen 10 und 20 akzeptiert. 

 Sie können hier übrigens auch Rechenformeln verwenden. Tragen Sie bei Mi-

nimum zum Beispiel C1 ein, muss der Zellinhalt größer als der Inhalt der Zelle 

C1 sein. Tragen Sie SUMME(D2:D8) ein, muss der Zellinhalt größer als die 

Summe der Zellen D2 bis D8 sein etc. 

 Auswahlliste verwenden 

 Nur verfügbar, wenn bei Zulässig sind der Eintrag Feste Listenwerte gewählt 

wurde. Ist diese Option aktiviert, erscheint ein Pfeilchen am rechten Rand der 

Tabellenzelle, wenn der Anwender sie ansteuert. Wird dieses Pfeilchen ange-

klickt, erscheint eine Liste aller zulässigen Werte zur Auswahl. 
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 Leere Zellen ignorieren 

 Ist diese Option aktiviert, wird bei leeren Zellen keine Gültigkeitsprüfung vor-

genommen. Löscht der Anwender also beispielsweise den Zellinhalt, wird in 

der Zelle keine Gültigkeitsprüfung mehr vorgenommen (bis wieder ein Wert 

eintragen wird). 

Karteikarte Eingabemeldung 

Auf dieser Karteikarte können Sie einen Infotext zum Ausfüllen der Zellen anzei-

gen lassen (zum Beispiel „Hier bitte nur Zahlen zwischen 10 und 20 eingeben!“). 

Dieser wird angezeigt, wenn der Anwender diese Zelle ansteuert. 

Es gibt hierfür folgende Optionen: 

 Eingabemeldung anzeigen, wenn die Zelle markiert ist 

 Bestimmt, ob die Eingabemeldung angezeigt werden soll oder nicht. 

 Titel 

 Hier können Sie den Titel der Meldung angeben. 

 Meldung 

 Hier können Sie den Meldungstext angeben. 

Karteikarte Fehlermeldung 

Auf dieser Karteikarte können Sie die Fehler-, Warn- oder Infomeldung festlegen, 

die erscheinen soll, wenn der Anwender Daten eingibt, die der Gültigkeitsprüfung 

nicht entsprechen. 

Es gibt hierfür folgende Optionen: 

 Fehlermeldung anzeigen, wenn ungültige Daten eingegeben wurden 

 Bestimmt, ob die Fehlermeldung angezeigt werden soll oder nicht. 

 Anmerkung: Normalerweise sollten Sie diese Option eingeschaltet lassen, da 

eine Gültigkeitsprüfung in der Regel wenig Sinn macht, wenn der Anwender 

nicht darauf hingewiesen wird, sobald er ungültige Daten eingibt. 
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 Typ 

 Hier können Sie den Typ der Meldung festlegen. Klicken Sie dazu auf das ge-

wünschte Symbol. 

Wichtig: Der Typ der Meldung bestimmt auch, ob es dem Anwender erlaubt 

sein soll, dennoch ungültige Eingaben zu machen. Nur beim Typ Fehlermel-

dung (erstes Symbol) weist PlanMaker ungültige Eingaben strikt zurück! 

 Folgende Arten von Meldungen stehen zur Wahl: 

 Fehlermeldung (erstes Symbol): PlanMaker gibt eine Fehlermeldung aus. Der 

Anwender ist gezwungen, einen gültigen Wert anzugeben; ungültige Werte 

werden nicht akzeptiert. 

 Warnmeldung (zweites Symbol): PlanMaker gibt eine Warnmeldung aus. Der 

Anwender kann selbst entscheiden, ob er den ungültigen Wert dennoch in das 

Arbeitsblatt übernehmen möchte. 

 Infomeldung (drittes Symbol): PlanMaker gibt nur eine Infomeldung aus. Der 

Anwender muss diese lediglich bestätigen, und der ungültige Wert wird über-

nommen (sofern der Anwender nicht auf Abbrechen klickt). 

 Titel 

 Hier können Sie den Titel der Meldung angeben.  

 Wenn Sie nichts eintragen, wird ein Standardtext ausgegeben. 

 Meldung 

 Hier können Sie den Meldungstext angeben. 

 Wenn Sie nichts eintragen, wird ein Standardtext ausgegeben. 

Tipp: Wenn Sie im Meldungstext das festgelegte Minimum und/oder Maxi-

mum für die Zelle ausgeben möchten, verwenden Sie darin einfach die Platz-

halter %min und %max. Beispiel: „Fehler – hier sind nur Werte zwischen 

%min und %max erlaubt!“. 

Beispiele 

Abschließend einige Beispiele zur Verwendung dieser Funktion: 
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 Nur Werte innerhalb der angegebenen Grenzen zulassen 

 Wählen Sie auf der Karteikarte Einstellungen zunächst den gewünschten Typ 

von Werten. Sollen beispielsweise nur Datumsangaben zulässig sein, setzen Sie 

die Option Zulässig sind auf „Datumswerte“. Sollen nur Zahlen zulässig sein, 

verwenden Sie die Option „Dezimalzahlen“ etc. 

 Danach können Sie mit der Option Mit Werten die zulässigen Grenzwerte fest-

legen. Sollen beispielsweise nur Werte größer als Eins zulässig sein, wählen Sie 

dort den Eintrag „größer als“ und tragen darunter bei Minimum eine 1 ein. 

 Nur Werte mit einer bestimmten Länge zulassen 

 Wenn Sie beispielsweise verhindern möchten, dass Anwender einen Wert mit 

mehr als 40 Zeichen eingeben können, wählen Sie folgende Einstellungen:  

 Zulässig sind: „Textlänge“ 

 Mit Werten: „kleiner oder gleich“ 

 Maximum: 40. 

 Hinweis: Hierbei gelten Ziffern, Punkte, Kommas, Vorzeichen etc. genauso als 

ein Zeichen wie Buchstaben. 

 Eigene Formeln für die Gültigkeitsprüfung verwenden 

 Fortgeschrittene Anwender können bei Zulässig sind: auch die Option „Benut-

zerdefiniert“ wählen und dann eine beliebige Formel für die Gültigkeitsprüfung 

angeben.  

 Verwenden Sie dazu eine Formel, die einen Wahrheitswert (also entweder 

WAHR oder FALSCH) zurückliefert. Ist das Resultat der Formel WAHR, er-

achtet PlanMaker den Eintrag als gültig, ansonsten wird er als ungültig erachtet. 

 Ein Beispiel: Wenn Sie die Formel SUMME($A$1:$C$3) > 42 eintragen, wird 

die Eingabe nur dann als gültig erachtet, wenn die Summe des Zellbereichs 

A1:C3 größer als 42 ist. 

 Hinweis: Beachten Sie, dass in solchen Formeln nicht nur absolute Zellbezüge 

(wie im obigen Beispiel), sondern auch relative Zellbezüge verwendet werden 

können: 

 Absolute Zellbezüge wie $A$1 beziehen sich immer auf die Zelle A1. 

 Relative Zellbezüge wie A1 beziehen sich hingegen auf die Zelle in der linken 

oberen Ecke der Markierung. Wenden Sie eine Gültigkeitsprüfung auf nur eine 

Zelle an, bezieht sich A1 also auf eben diese Zelle. Hatten Sie zuvor einen Be-
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reich von Zellen markiert, bezieht sich A1 auf die Zelle in der linken oberen 

Ecke, A2 auf die Zelle darunter etc. 

Format übertragen 

Mit dem Befehl Format > Format übertragen können Sie blitzschnell die Forma-

tierung von Zellen auf andere Zellen übertragen. 

Gehen Sie dazu wie folgt vor: 

1. Klicken Sie zuerst die Zelle an, deren Format Sie auf andere Zellen übertragen 

möchten. 

2. Rufen Sie Format > Format übertragen auf. 

 Der Mauszeiger ändert sich nun in ein Fadenkreuz mit einem Pinsel:  

3. Ziehen Sie die Maus nun (bei gedrückter Maustaste) über die Zellbereiche, auf 

die das Format übertragen werden soll. Sie können diese Funktion dabei auf be-

liebig viele Zellbereiche oder Einzelzellen anwenden (Einzelzellen dazu ein-

fach anklicken). 

4. Wenn Sie fertig sind, rufen Sie Format > Format übertragen erneut auf oder 

drücken einfach die Taste (Esc). 

Übertragen wird dabei sowohl das Zeichenformat (Schriftart, Textauszeichnungen 

etc.) als auch das Zellenformat (Zahlenformat, Ausrichtung etc.). 

Übertragen des Formats ganzer Zellbereiche 

Sie können auch das Format ganzer Zellbereiche auf andere Zellen übertragen. 

Verfahren Sie dazu wie oben beschrieben, markieren jedoch bei Punkt 1. den Zell-

bereich, dessen Format übertragen werden soll. 

Markieren Sie beispielsweise drei Zellen, die mit rotem, grünem und blauem Hin-

tergrund formatiert sind, und übertragen deren Format auf einen anderen Zellbe-

reich, wird dieser Bereich abwechselnd mit rotem, grünem und blauem Hinter-

grund formatiert. 
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Seitenformat 

In diesem Abschnitt erfahren Sie, welche Möglichkeiten es gibt, ein Arbeitsblatt 

für den Ausdruck zu formatieren. 

Folgende Themen werden darin behandelt: 

 Seitenformat einstellen 

 Über den Befehl Datei > Seite einrichten können Sie unter anderem das Sei-

tenformat für das aktuelle Arbeitsblatt festlegen. Dazu zählen Einstellungen wie 

Papiergröße, Papierausrichtung (Hoch- oder Querformat) und die Seitenränder. 

 Optionen zum Seitenformat einstellen 

 Auf der Karteikarte Optionen desselben Befehls finden Sie verschiedene Opti-

onen für die Seitennummerierung, Druckrichtung etc. und können festlegen, 

welche Bestandteile des Arbeitsblatts gedruckt werden sollen. 

 Kopf- und Fußzeile einrichten 

 Auf der Karteikarte Kopf- und Fußzeilen können Sie das Dokument mit einer 

Kopfzeile und/oder Fußzeile versehen, die am Anfang beziehungsweise am En-

de jeder Druckseite des Arbeitsblatts ausgegeben wird. 

 Seitenumbruch manuell beeinflussen 

 Zur Seitenformatierung zählt weiterhin die Möglichkeit, den automatischen 

Seitenumbruch bei Bedarf von Hand zu beeinflussen. Hierzu dient der Befehl 

Einfügen > Seitenumbruch. 

Auf den nächsten Seiten erfahren Sie alles Wissenswerte zu diesen Themen. 

Seitenformat einstellen 

Mit dem Befehl Datei > Seite einrichten können Sie unter anderem das Seiten-

format eines Arbeitsblatts festlegen. Dazu zählen Einstellungen wie Papierformat 

und -ausrichtung (Hochformat oder Querformat). 

Hinweis: Das Seitenformat kann für jedes Arbeitsblatt eines Dokuments anders 

eingestellt werden. Sie können also beispielsweise für ein Arbeitsblatt das Hoch-

format wählen und für ein anderes das Querformat. 
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Um das Seitenformat eines Arbeitsblatts zu ändern, rufen Sie den Befehl Datei > 

Seite einrichten auf, wechseln auf die Karteikarte Seitenformat und nehmen dann 

die gewünschten Einstellungen vor: 

Ausrichtung 

Hier können Sie die Ausrichtung der Druckseiten festlegen: Hochformat oder 

Querformat. 

Papiergröße 

Hier bestimmen Sie das Format der Druckseiten. In der aufklappbaren Liste Pa-

piergröße werden alle vom derzeit gewählten Drucker unterstützten Papierformate 

angeboten; Sie können aber unter Breite und Höhe auch eigene Werte von Hand 

angeben. 

Ränder 

Hier können Sie die Seitenränder einstellen. 

Abstand zur Blattkante 

Hier können Sie bestimmen, wie viel Abstand zwischen Kopf- und Fußzeilen und 

der oberen beziehungsweise unteren Blattkante freigelassen werden soll. 

Hinweis: Kopf- und Fußzeilen werden stets in den oberen beziehungsweise unteren 

Seitenrand gedruckt. 

Papierschächte 

Nur unter Windows verfügbar: Falls Ihr Drucker über mehrere Papierschächte 

verfügt, können Sie hier einstellen, aus welchem Schacht der Drucker das Papier 

einziehen soll. Ist die Standardeinstellung Aus Druckereinstellung gewählt, 

nimmt PlanMaker keinen Einfluss auf den Papiereinzug. Soll beispielsweise die 

erste Seite aus Schacht 1 und alle weiteren aus Schacht 2 eingezogen werden, än-

dern Sie diese Einstellung einfach entsprechend. 
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Optionen zum Seitenformat einstellen 

Auf der Karteikarte Optionen des Befehls Datei > Seite einrichten können Sie 

Einstellungen vornehmen, die den Ausdruck des aktuellen Arbeitsblatts betreffen: 

Seitennummer 

Hier können Sie die Seitennummerierung beeinflussen: 

Automatisch: Die Druckseiten werden mit 1 beginnend durchnummeriert. 

Wert: Die Druckseiten werden mit dem hier eingetragenen Wert beginnend durch-

nummeriert. 

Tipp: Um auf einem Arbeitsblatt die Seitennummer ausgeben zu lassen, fügen 

Sie das Feld Seitennummer in eine Kopf- oder Fußzeile ein (siehe nächster Ab-

schnitt). 

Druckbereich 

Hier können Sie den Bereich des aktuellen Arbeitsblatts festlegen, der gedruckt 

werden soll.  

Standardmäßig ist diese Einstellung auf [Alles] gesetzt; es wird also das gesamte 

Arbeitsblatt gedruckt. Wenn Sie hier allerdings einen Zellbereich (zum Beispiel 

A1:D20) oder den Namen eines benannten Bereichs angeben, erscheint im Aus-

druck nur noch dieser Bereich. 

Der Druckbereich kann für jedes Arbeitsblatt einer Tabelle gesondert angegeben 

werden. 

Wichtig: Diese Einstellung wird permanent im Dokument gespeichert. Wenn Sie 

das Dokument also das nächste Mal öffnen, es ausdrucken und sich wundern, 

dass nur ein Teil des Arbeitsblatts ausgegeben wird, dann liegt das in der Regel 

daran, dass Sie einen Druckbereich festgelegt haben. Wählen Sie also den 

Druckbereich [Alles], wenn wieder das gesamte Arbeitsblatt ausgedruckt werden 

soll. 

Tipp: Alternativ können Sie den Druckbereich auch mit dem Befehl Datei > 

Druckbereich > Druckbereich festlegen definieren. Markieren Sie zuvor den 

gewünschten Bereich im Arbeitsblatt. Mit dem Befehl Datei > Druckbereich > 

Druckbereich entfernen können Sie den Druckbereich wieder entfernen. 
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Druckrichtung 

Hier bestimmen Sie, in welcher Reihenfolge PlanMaker Arbeitsblätter, die breiter 

als eine Druckseite sind, ausgeben soll. 

 Von links nach rechts 

 Es wird erst von links nach rechts und anschließend von oben nach unten ge-

druckt. 

 Von oben nach unten 

 Es wird erst von oben nach unten und anschließend von links nach rechts ge-

druckt. 

Wiederholungszeilen/Wiederholungsspalten 

Falls das Arbeitsblatt Zeilenbeschriftungen oder Spaltenbeschriftungen enthält, und 

Sie möchten, dass diese auf allen Druckseiten wiederholt werden, dann tragen Sie 

diese hier ein.  

Verwenden Sie dazu die Schreibweise Startzeile:Endzeile beziehungsweise Start-

spalte:Endspalte. 

Enthält beispielsweise die erste Zeile einer langen Liste von Daten eine Beschrif-

tung, die auf allen Seiten wiederholt werden soll, so ist bei Wiederholungszeilen 

1:1 einzutragen. 

Möchten Sie hingegen, dass die Spalten A bis C auf jeder Seite wiederholt werden 

sollen, so tragen Sie bei Wiederholungsspalten A:C ein. 

Drucken 

Hier können Sie bestimmen, ob die folgenden Komponenten der Tabelle im Aus-

druck erscheinen sollen: 

 Zeilen- und Spaltenköpfe (die mit 1, 2, 3... beziehungsweise A, B, C... be-

schrifteten Schaltflächen links und oberhalb der Tabelle) 

 Gitternetz (die grauen Gitternetzlinien zwischen den Zellen) 

 Kommentare (mit dem Befehl Einfügen > Kommentar an Zellen angebrachte 

Kommentare). 

Außerdem lässt sich über die Option Farben festlegen, ob der Ausdruck in Farbe 

erfolgen soll: 
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 Originalfarben: Der Ausdruck erfolgt farbig. 

 Graustufen: Farbiger Text wird in schwarz/weiß ausgegeben; farbige Objekte 

(Grafiken, Diagramme etc.) werden in Grautöne umgewandelt. 

 Nur Umrisse: Farbiger Text wird in schwarz/weiß ausgegeben; von Objekten 

werden nur die Umrisslinien (in schwarz/weiß) ausgegeben. 

Zentrierungsoptionen 

Schalten Sie die Option Horizontal zentrieren ein, wird der zu druckende Tabel-

leninhalt horizontal auf der Druckseite zentriert. 

Analog zentriert die Option Vertikal zentrieren den Tabelleninhalt vertikal auf der 

Druckseite. 

Skalierungsoptionen 

Mit diesen beiden Optionen können Sie den Ausdruck verkleinern oder vergrößern.  

Bei der Option Skalierung können Sie die gewünschte Vergrößerungsstufe in Pro-

zent festlegen. Es lassen sich Werte zwischen 20 und 200 Prozent eingeben. Bei 

50% wird der Ausdruck beispielsweise halb so groß, bei 200% doppelt so groß. 

Bei der Option Auf Seiten einpassen können Sie hingegen angeben, wie viele Sei-

ten der Ausdruck insgesamt umfassen soll. PlanMaker ermittelt die passende Ver-

größerungsstufe dann automatisch. 

Kopf- und Fußzeile einrichten 

Sie können Arbeitsblätter auf Wunsch mit einer Kopfzeile und/oder einer Fußzeile 

versehen. Das sind Zeilen, die am oberen beziehungsweise unteren Ende jeder Sei-

te des Arbeitsblatts gedruckt werden. 

Hinweis: Kopf- und Fußzeilen können für jedes Arbeitsblatt separat definiert 

werden. 

Um beispielsweise die Kopfzeile des aktuellen Arbeitsblatts zu bearbeiten, gehen 

Sie wie folgt vor: 

1. Rufen Sie den Befehl Datei > Seite einrichten auf und wechseln Sie auf die 

Karteikarte Kopf- und Fußzeilen. 
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 Alternativ können Sie auch den Befehl Einfügen > Kopf- und Fußzeile aufru-

fen, der genau das gleich tut. 

  

2. Um eine der vordefinierten Arten von Kopfzeilen zu verwenden, wählen Sie 

diese in der aufklappbaren Liste im oberen Teil des Dialogs. 

 Um die Kopfzeile nach Ihren Wünschen anzupassen, klicken Sie auf die Schalt-

fläche Bearbeiten (siehe Abschnitt „Bearbeiten von Kopf- und Fußzeilen“ wei-

ter unten). 

 Um das Format der Kopfzeile zu ändern, klicken Sie auf die Schaltfläche For-

mat (siehe Abschnitt „Formatieren von Kopf- und Fußzeilen“ weiter unten). 

3. Bestätigen Sie mit OK. 

Die Kopfzeile wurde nun entsprechend geändert. 

Das Bearbeiten der Fußzeile funktioniert genauso (mit den Dialogelementen im 

unteren Teil des Dialogs). 

Tipp: Kopf- und Fußzeilen werden nicht im Dokumentfenster auf dem Bild-

schirm angezeigt – sie erscheinen nur im Ausdruck. Sie können aber jederzeit 

den Befehl Datei > Druckvorschau aufrufen, um das Aussehen der Kopf- und 

Fußzeile zu begutachten. 
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Bearbeiten von Kopf- und Fußzeilen 

Wenn Sie in obigem Dialogfenster auf die Schaltfläche Bearbeiten klicken, kön-

nen Sie die Kopfzeile bzw. Fußzeile des Arbeitsblatts nach Belieben bearbeiten. 

 

Hierzu einige Anmerkungen: 

 Kopf- und Fußzeilen können aus bis zu drei Teilen bestehen 

 Die Eingabefelder in diesem Dialog sind dreigeteilt. Das liegt daran, dass Kopf- 

und Fußzeilen aus bis zu drei Teilen bestehen können: einem linken (linksbün-

digen), einem mittleren (zentrierten) und einem rechten (rechtsbündigen Be-

reich). So können Sie beispielsweise links das Datum, in der Mitte den Datei-

namen und rechts die Seitennummer ausgeben lassen. 

 Natürlich können Sie auch nur einen der drei Bereiche ausfüllen, wenn Sie bei-

spielsweise nur links den Dateinamen ausgeben lassen möchten. 

 Verwenden von Feldern für die Seitennummer etc. 

 Über die Schaltfläche Felder können Sie Felder in die Kopf- beziehungsweise 

Fußzeile einfügen. 

 Felder sind Platzhalter, die symbolisch für bestimmte Informationen stehen. 

Fügen Sie beispielsweise ein Feld für die Seitennummer ein, steht der Platzhal-

ter {\SEITENNUMMER} in dem Eingabefeld. Beim Ausdruck wird diese 

symbolische Angabe dann automatisch durch die Seitennummer ersetzt. 

 Es stehen folgende Felder zur Verfügung: 
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Feldname Funktion 

Name des Dokuments Dateiname des Dokuments (z.B. „Meine Tabel-

le.pmd“) 

Name und Pfad des Dokuments Dateiname und Pfad des Dokuments (z.B. 

„C:\Tabellen\Meine Tabelle.pmd“) 

Name des Arbeitsblatts Name des aktuellen Arbeitsblatts 

Seitennummer Seitennummer 

Seitenzahl Gesamtzahl der Seiten 

Druckdatum Aktuelles Datum (zum Zeitpunkt des Druckens) 

Druckzeit Aktuelle Uhrzeit (zum Zeitpunkt des Druckens) 

Änderungsdatum Datum, an dem das Dokument zuletzt geändert 

und (sprich: gespeichert) wurde 

Erstelldatum Datum, an dem das Dokument erstellt wurde 

 Um eines dieser Felder einzufügen, klicken Sie auf die Schaltfläche Felder und 

dann auf das gewünschte Feld. 

 Ändern der Zeichenformatierung 

 Über die Bedienelemente im oberen Teil des Dialogs können Sie das Zeichen-

format (Schriftart, Schriftgröße etc.) der Einträge ändern.  

 Hinweis: Markieren Sie zuvor den zu formatierenden Text (in einem der drei 

Eingabefelder). 

Formatieren von Kopf- und Fußzeilen 

Abgesehen von der Zeichenformatierung in Kopf- und Fußzeilen (siehe oben), 

können Sie auch Umrandungen und Schattierungen anbringen sowie Ausrichtung 

und Ränder abändern. Klicken Sie dazu im Hauptdialog des Befehls Einfügen > 

Kopf- und Fußzeile auf die Schaltfläche Format. 

Es erscheint ein Dialogfenster mit folgenden Karteikarten: 

 Karteikarte Schattierung 

 Hier können Sie die Kopf-/Fußzeile mit einer farbigen Schattierung oder einem 

Muster versehen. Die Bedienung der Optionen entspricht der im Abschnitt 

„Schattierung“ ab Seite 157. 
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 Karteikarte Umrandung 

 Hier können Sie die Kopf-/Fußzeile mit einer Umrandung oder einzelnen Um-

randungslinien versehen. Die Bedienung der Optionen entspricht der im Ab-

schnitt „Umrandung“ ab Seite 155. 

 Karteikarte Ausrichtung 

 Hier können Sie die Innenränder der Kopf-/Fußzeile ändern und die vertikale 

Ausrichtung festlegen. 

Tipp: Der Abstand der Kopf-/Fußzeile zur oberen/unteren Blattkante lässt sich 

nicht hier, sondern auf der Karteikarte Seitenformat einstellen. 

Kopf- und Fußzeilen vorübergehend deaktivieren 

Wenn Sie ein Dokument einmal ohne die definierten Kopf- oder Fußzeilen ausdru-

cken möchten, rufen Sie Einfügen/Kopf- und Fußzeile auf und schalten die Opti-

on Drucken aus. Die Kopf- oder Fußzeile bleibt dann erhalten, sie wird aber nicht 

mehr ausgedruckt. 

Möchten Sie die Kopf- und Fußzeilen später wieder ausgedruckt haben, schalten 

Sie die Option Drucken einfach wieder an. 

Seitenumbruch manuell beeinflussen 

Zur Seitenformatierung zählt weiterhin die Möglichkeit, den automatischen Sei-

tenumbruch bei Bedarf von Hand zu beeinflussen. 

Normalerweise erledigt PlanMaker den Seitenumbruch ohne Ihr Zutun: Er fügt 

automatisch einen Seitenumbruch ein, sobald das Ende der Druckseite erreicht ist. 

Auf dem Bildschirm wird dies sichtbar gemacht durch einen dunklen horizontalen 

beziehungsweise vertikalen Strich zwischen den Zellen. Hieran erkennen Sie, wo 

die Druckseite beim Ausdrucken unten beziehungsweise rechts abgeschnitten wird. 

Bei Bedarf haben Sie die Möglichkeit, einen Seitenumbruch manuell herbeizufüh-

ren. Rufen Sie dazu den Befehl Einfügen > Seitenumbruch auf. Es öffnet sich ein 

Untermenü mit folgenden Befehlen: 

 Mit Vor Zeile einfügen fügen Sie vor der aktuellen Zeile einen horizontalen 

Seitenumbruch ein.  
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 Über den Befehl Vor Zeile löschen können Sie einen solchen Umbruch wieder 

entfernen. Der Zellrahmen muss sich dabei direkt unter dem Umbruch befin-

den. 

 Vor Spalte einfügen fügt dagegen vor der aktuellen Spalte einen vertikalen 

Seitenumbruch ein.  

 Über den Befehl Vor Spalte löschen können Sie einen solchen Umbruch wie-

der entfernen. Der Zellrahmen muss sich dabei direkt rechts neben dem Um-

bruch befinden. 
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Suchen und Ersetzen 
In diesem Kapitel lernen Sie alle Funktionen zum Suchen und Ersetzen in Tabellen 

kennen: 

 Suchen und Ersetzen 

 Mit den Suchfunktionen von PlanMaker können Sie eine Tabelle nach einem 

bestimmten Suchbegriff durchsuchen – und die Fundstellen bei Bedarf durch 

etwas anderes ersetzen lassen. 

 Springen zu bestimmten Zelladressen 

 Mit dem Befehl Gehe zu ... können Sie zu bestimmten Zellen, Zellbereichen 

oder benannten Bereichen springen. 

 Springen zu bestimmten Bestandteilen einer Tabelle 

 Mit den drei Schaltflächen in der rechten unteren Ecke des Dokumentfensters 

können Sie zu bestimmten Bestandteilen einer Tabelle springen (zum Beispiel 

zum nächsten Fehlerwert oder Kommentar). 

Alles Weitere zu diesen Themen erfahren Sie auf den nächsten Seiten. 

Suchen 

Mit dem Befehl Bearbeiten > Suchen (Tastenkürzel: (Strg)(F)) können Sie ein 

Dokument nach einem bestimmten Suchbegriff durchsuchen lassen. 

Gehen Sie dazu wie folgt vor: 

1. Falls Sie nur einen bestimmten Zellbereich durchsuchen möchten, müssen Sie 

diesen erst markieren. Wenn Sie nichts markieren, wird das komplette Arbeits-

blatt durchsucht. 

2. Rufen Sie den Befehl Bearbeiten > Suchen auf. 

3. Geben Sie bei Suchen nach: den Suchbegriff ein. 

4. Stellen Sie bei Bedarf die gewünschten Optionen für die Suche ein (siehe Ab-

schnitt „Erweiterte Suchfunktionen“ ab Seite 207). 

5. Betätigen Sie die Schaltfläche Suchen, um die Suche zu beginnen. 
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Wenn der Suchbegriff gefunden wird, setzt PlanMaker den Zellrahmen auf die Zel-

le, die den Suchbegriff enthält. 

Sie haben nun folgende Möglichkeiten: 

A) Sie klicken auf Weitersuchen, um zur nächsten Fundstelle zu gelangen. 

B) Sie beenden den Suchen-Dialog mit Schließen.  

Ersetzen 

Manchmal geht es nicht nur darum, einen Suchbegriff wiederzufinden, sondern 

man möchte ihn auch gleich durch etwas anderes austauschen. Hierzu dient der 

Befehl Bearbeiten > Ersetzen (Tastenkürzel (Strg)(H)). 

Diesen setzen Sie wie folgt ein: 

1. Falls Sie nur einen bestimmten Zellbereich durchsuchen möchten, müssen Sie 

diesen erst markieren. Wenn Sie nichts markieren, wird das komplette Arbeits-

blatt durchsucht. 

2. Rufen Sie den Befehl Bearbeiten > Ersetzen auf. 

3. Geben Sie bei Suchen nach: den Suchbegriff ein. 

4. Geben Sie bei Ersetzen durch: den Begriff ein, durch den der Suchbegriff er-

setzt werden soll. 

5. Stellen Sie bei Bedarf die gewünschten Optionen für die Suche ein (siehe Ab-

schnitt „Erweiterte Suchfunktionen“ ab Seite 207). 

6. Betätigen Sie die Schaltfläche Suchen, um die Suche zu beginnen. 

Wenn der Suchbegriff gefunden wird, setzt PlanMaker den Zellrahmen auf die Zel-

le, die den Suchbegriff enthält. 

Sie haben nun folgende Möglichkeiten: 

A) Sie klicken auf Ersetzen, woraufhin der Suchbegriff durch den Ersatzbegriff 

ersetzt wird und PlanMaker zur nächsten Fundstelle springt. 

B) Sie klicken auf Weitersuchen, woraufhin PlanMaker zur nächsten Fundstelle 

springt – ohne den Begriff zu ersetzen. 
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C) Sie klicken auf Alle ersetzen, woraufhin PlanMaker alle Vorkommen des 

Suchbegriffs ersetzt. 

D) Sie beenden den Suchen-Dialog mit Schließen.  

Suchen/Ersetzen wiederholen 

Um einen Such- oder Ersetzungsvorgang zu wiederholen oder ihn nach Abbruch 

fortzuführen, rufen Sie den Befehl Bearbeiten > Suchen wiederholen bezie-

hungsweise Bearbeiten > Ersetzen wiederholen auf oder drücken einfach die 

Taste (F3).  

PlanMaker setzt die Suche nun fort und zeigt die nächste Fundstelle an. 

Erweiterte Suchfunktionen 

Wenn Sie im Dialog von Bearbeiten > Suchen oder Bearbeiten > Ersetzen auf 

die Schaltfläche Erweitern klicken, wird der Suchen-Dialog vergrößert und bietet 

zusätzliche Optionen an. 

Mit der Schaltfläche Reduzieren lässt sich der Dialog wieder verkleinern. So kön-

nen Sie selbst bestimmen, ob Sie lieber viele Einstellmöglichkeiten haben oder bei 

der Suche möglichst viel von der Tabelle sehen möchten.  

Der erweiterte Suchen/Ersetzen-Dialog bietet folgende Optionen zusätzlich: 

Rubrik „Suchen in“ 

Hier können Sie genau festlegen, wie die Tabelle durchsucht werden soll: 

 Suchen in 

 Über die aufklappbare Liste oben können Sie wählen, welche Bestandteile der 

Tabelle durchsucht werden sollen: die Zellen der Tabelle, deren Kommentare 

oder alle Rahmen (Textrahmen und Zeichnungen, die Text enthalten). 

 Formeln 

 Ist diese Option aktiviert, werden alle Rechenformeln in Zellen durchsucht.  
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 So können Sie beispielsweise nach „Summe“ suchen, um alle Zellen zu finden, 

in denen die Rechenfunktion SUMME verwendet wird. 

 Ergebnissen 

 Ist diese Option aktiviert, werden auch alle Ergebnisse von Rechenformeln 

durchsucht.  

 Suchen Sie also beispielsweise nach „4“, werden auch Zellen gefunden, in de-

nen die Berechnung =2+2 eingetragen ist. 

 (Diese Option ist nur beim Suchen verfügbar, nicht jedoch beim Ersetzen.) 

 Werten 

 Ist diese Option aktiviert, werden alle fest eingegeben Werte durchsucht (also 

von Hand eingetragene Zahlen, Zeichenketten etc.). 

 Gesamtes Dokument 

 Ist diese Option aktiviert, werden alle Arbeitsblätter des Dokuments durch-

sucht.  

 Ist sie ausgeschaltet, wird nur das aktuelle Arbeitsblatt durchsucht (bezie-

hungsweise alle Arbeitsblätter, die derzeit im Arbeitsblattregister markiert 

sind.) 

 Spaltenweise suchen 

 Ist diese Option aktiviert, wird die Tabelle Spalte für Spalte durchsucht. 

 Ist sie ausgeschaltet, wird die Tabelle Zeile für Zeile durchsucht. 

Rubrik „Optionen“ 

Hier können Sie weitere Einstellungen zum Suchvorgang vornehmen: 

 Groß-/Kleinschreibung beachten 

 Normalerweise wird die Groß-/Kleinschreibung des Suchbegriffs ignoriert. Bei 

der Suche nach „haus“ wird also gleichermaßen „Haus“, „haus“, „HAUS“, 

„HaUs“ etc. gefunden.  

 Schalten Sie diese Option jedoch ein, wird nur dann etwas gefunden, wenn die 

Groß-/Kleinschreibung der Fundstelle genau mit der des Suchbegriffs überein-

stimmt. Bei der Suche nach „haus“ wird dann also nur noch „haus“ gefunden.  
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 Ganze Zelle muss übereinstimmen 

 Normalerweise findet PlanMaker alle Zellen, die den Suchbegriff an irgendei-

ner Position enthalten. Suchen Sie also nach „Steuer“, werden auch Zellen ge-

funden, die den Inhalt „Steuererklärung“ oder „Einkommensteuer“ haben. 

 Schalten Sie diese Option hingegen ein, muss der gesamte Zellinhalt mit dem 

Suchbegriff übereinstimmen. Bei der Suche nach „Steuer“ werden dann also 

nur noch Zellen gefunden, die exakt den Inhalt „Steuer“ haben.  

Schaltfläche „Sonstiges“ 

Die Schaltfläche Sonstiges ermöglicht es Ihnen, die nachfolgenden Platzhalter im 

Suchbegriff zu verwenden: 

 Einzelnes beliebiges Zeichen (^?) 

 Dieser Platzhalter steht für ein einzelnes beliebiges Zeichen. Bei der Suche 

nach „M^?ller“, wird beispielsweise „Müller“, „Möller“, „Miller“ etc gefunden. 

 Mehrere beliebige Zeichen (^*) 

 Dieser Platzhalter steht für beliebig viele beliebige Zeichen. Bei der Suche nach 

„M^*er“ wird beispielsweise „Müller“, „Maier“, „Mittermayer“ etc. gefunden. 

 Caret (^^) 

 Sucht nach dem Zeichen „^“ (Zirkumflex oder Caret). 

Um einen dieser Platzhalter in den Suchbegriff einzufügen, klicken Sie die Schalt-

fläche Sonstiges an und wählen dann den gewünschten Platzhalter per Mausklick. 

Sie können Platzhalter in Ihrem Suchbegriff nach Belieben wiederholen und kom-

binieren. Weiterhin können Sie sie natürlich mit normalem Text mischen. 

Schaltfläche „Alle suchen“ 

Wenn Sie die Schaltfläche Alle suchen anklicken, wird eine Liste aller Vorkom-

men des Suchbegriffs angezeigt. Klicken Sie einen der Einträge an, springt Plan-

Maker zur entsprechenden Fundstelle im Dokument. 

Hinweis: Diese Schaltfläche steht nur zur Verfügung, wenn Sie bei Suchen in die 

Option Zellen gewählt haben. 
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Springen zu bestimmten Zelladressen 

Der Befehl Bearbeiten > Gehe zu dient dazu, den Zellrahmen auf eine bestimmte 

Zelle in der Tabelle zu setzen. 

Es erscheint dazu ein Dialogfenster, in dem Sie die gewünschte Zelladresse ange-

ben. Es ist sowohl eine einzelne Zelladresse (zum Beispiel D2) als auch ein Zellbe-

reich zulässig (zum Beispiel D2:D4). 

In der Liste unterhalb des Eingabefelds werden weiterhin alle mit dem Befehl Ta-

belle > Namen benannten Bereiche der Tabelle aufgeführt, so dass auch diese so-

fort angesprungen werden können. 

Wenn Sie mit OK bestätigen, markiert PlanMaker sofort die entsprechende Zelle 

beziehungsweise den entsprechenden Zellbereich. 

Tipp: Eine schnellere Methode 

Es gibt auch eine schnellere Methode: In der Bearbeitungsleiste (oberhalb des Ta-

bellenfensters) befindet sich links eine aufklappbare Liste, die normalerweise an-

zeigt, in welcher Zelle sich der Zellrahmen gerade befindet.  

 

Hier können Sie – genau wie im Dialogfenster des Befehls Bearbeiten > Gehe zu 

– die Adresse einer Zelle oder eines Zellbereichs eintippen. Drücken Sie anschlie-

ßend die Eingabetaste (¢), markiert PlanMaker die entsprechende(n) Zelle(n). 

Und: Wenn Sie einen Mausklick auf das kleine Pfeilchen rechts neben der Liste 

durchführen, öffnet sich diese und bietet alle Bereichsnamen zur Auswahl an. Kli-

cken Sie einen Namen an, wird der entsprechende Bereich sofort markiert. 
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Springen zu bestimmten Bestandteilen einer 

Tabelle 

Mit den drei Schaltflächen in der rechten unteren Ecke des Dokumentfensters kön-

nen Sie zu bestimmten Bestandteilen einer Tabelle springen (zum Beispiel zum 

nächsten Fehlerwert oder Kommentar). 

 

Setzen Sie diese wie folgt ein: 

 Klicken Sie auf die Schaltfläche mit dem roten Punkt, erscheint ein kleines 

Menü. Darin können Sie auswählen, wonach gesucht werden soll (siehe unten). 

 Klicken Sie auf die Schaltfläche mit dem Pfeil nach oben, springt PlanMaker 

zur vorherigen Fundstelle. Haben Sie in dem Menü also beispielsweise „Feh-

lerwert“ gewählt, wird die vorherige Zelle mit einem Fehlerwert angezeigt. 

 Klicken Sie auf die Schaltfläche mit dem Pfeil nach unten, springt PlanMaker 

zur nächsten Fundstelle, also beispielsweise zur nächsten Zelle mit einem Feh-

lerwert. 

Über das Menü, das sich nach einem Klick auf den roten Punkt öffnet, bestimmen 

Sie also, wonach gesucht werden soll. Dieses Menü hat folgende Einträge: 

Menüeintrag Erläuterung 

Formel Springe zu Zellen, die eine Rechenformel enthalten 

Matrixformel Springe zu Zellen, die eine Matrixformel enthalten 

Konstante Springe zu Zellen, die einen festen Wert enthalten 

Fehlerwert Springe zu Zellen, die einen Fehlerwert enthalten 

(siehe auch Abschnitt „Fehlerwerte“ ab Seite 448) 

Fehlerhafte Zelle Springe zu Zellen, die fehlerhaft importiert worden 

sind – also beispielsweise Zellen, die eine der Micro-

soft Excel-Rechenfunktionen enthalten, die von 

PlanMaker nicht unterstützt werden. 

Kommentar Springe zu Zellen, die einen Kommentar enthalten 

Bedingte Formatierung Springe zu Zellen, bei denen eine bedingte Formatie-

rung angebracht ist 
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Gültigkeitsprüfung Springe zu Zellen, bei denen die eine Gültigkeitsprü-

fung angebracht ist 

Alle Blätter durchsuchen Ist diese Option aktiviert, durchsucht PlanMaker alle 

Arbeitsblätter, ansonsten nur das aktuelle Blatt. 



 

Handbuch PlanMaker Objekte    213 

Objekte 

Sie können in ihre Dokumente verschiedene Arten von Objekten einfügen – zum 

Beispiel Diagramme, Grafiken, Textrahmen, Zeichnungen etc.  

In diesem Kapitel erfahren Sie alles Wissenswerte zum Umgang mit Objekten. Es 

ist in folgende Abschnitte gegliedert: 

 Objekte – Allgemeines (ab Seite 213) 

 Hier lernen Sie grundlegende Funktionen wie das Einfügen, Selektieren und 

Bearbeiten von Objekten kennen. 

 Objekte – fortgeschrittene Funktionen (ab Seite 230) 

 Dieser Abschnitt richtet sich an fortgeschrittene Anwender. Sie erfahren darin, 

wie man Objekte verbirgt, gruppiert etc. 

Im Anschluss stellen wir Ihnen die einzelnen Arten von Objekten im Detail vor: 

 Diagramme (siehe dazu Kapitel „Diagramme“ ab Seite 257) 

 Textrahmen (ab Seite 233) 

 Grafiken (ab Seite 236) 

 OLE-Objekte (ab Seite 241) 

 Zeichnungen (ab Seite 248) 

Objekte – Allgemeines 

In diesem Abschnitt finden Sie grundlegende Informationen zum Arbeiten mit Ob-

jekten: 

 Objekte einfügen 

 Selektieren von Objekten 

 Der Objektmodus 

 Position und Größe von Objekten ändern 

 Rotieren und Kippen von Objekten 

 Ausrichten und Verteilen von Objekten 

 Duplizieren von Objekten 

 Eigenschaften von Objekten ändern 
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Anschließend – im Abschnitt „Objekte – fortgeschrittene Funktionen“ – werden 

Funktionen für fortgeschrittene Anwender vorgestellt. 

Objekte einfügen 

Um beispielsweise eine Grafikdatei einzufügen, gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Objekt > Neuer Grafikrahmen auf. 

2. Ziehen Sie mit der Maus im Dokument ein Rechteck auf, das die gewünschte 

Position und Größe hat. 

 Oder: Wahlweise können Sie auch einfach nur an die Stelle klicken, an der die 

linke obere Ecke der Grafik zu liegen kommen soll. Die Grafik wird dann in ih-

rer Originalgröße eingefügt. 

3. Nun erscheint ein Dialog, in dem Sie angeben, welche Grafik eingefügt werden 

soll. Wählen Sie darin die gewünschte Grafikdatei und bestätigen Sie mit OK. 

Die Grafik wird nun eingefügt. 

Auf ähnliche Weise verfahren Sie auch bei allen anderen Arten von Objekten.  

Informationen zu den einzelnen Arten von Objekten finden Sie in den Abschnitten 

„Diagramme“, „Textrahmen“ etc. (ab Seite 233). 

Selektieren von Objekten 

Wenn Sie ein Objekt bearbeiten möchten, müssen Sie es erst auswählen, sprich 

selektieren. Klicken Sie das gewünschte Objekt dazu einfach an. Es erscheint ein 

roter Rahmen um das Objekt, um anzuzeigen, dass es nun selektiert ist. 

Hinweis: Dies funktioniert allerdings nicht bei Textrahmen und anderen Objek-

ten mit transparenter Füllung. Um ein solches Objekt zu selektieren, klicken Sie 

auf die Umrandung, die es umgibt, oder wechseln in den Objektmodus (siehe 

nächster Abschnitt), in dem sich alle Arten von Objekten einfach per Mausklick 

selektieren lassen. 

Wenn ein Objekt selektiert wurde, können Sie nichts mehr in die Tabellenzellen 

eingeben, sondern nur noch das selektierte Objekt bearbeiten. Möchten Sie wieder 

Tabellenzellen bearbeiten, klicken Sie einfach mit der Maus in die gewünschte 

Zelle. Die Selektion des Objekts wird dadurch aufgehoben. 
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Der Objektmodus 

Am einfachsten gestaltet sich das Arbeiten mit Objekten im Objektmodus. 

Normalerweise arbeiten Sie mit PlanMaker im Editiermodus. In diesem Modus 

können Sie Daten oder Berechnungen in Tabellenzellen eingeben, diese bearbeiten, 

formatieren usw. 

Schalten Sie in den Objektmodus um, können Sie die Tabellenzellen nicht mehr 

bearbeiten. Dafür bietet dieser Modus viele Funktionen, die das Arbeiten mit Ob-

jekten erleichtern. So können Sie im Objektmodus beispielsweise alle Arten von 

Objekten einfach per Mausklick selektieren. 

Wichtig: Solange Sie sich im Objektmodus befinden, stehen Ihnen ausschließlich 

Funktionen zum Anlegen und Bearbeiten von Objekten zur Verfügung. Sie kön-

nen keine Zellen mehr bearbeiten, und ein Großteil der entsprechenden Menübe-

fehle ist nicht verfügbar. 

Wechseln zwischen Editiermodus und Objektmodus 

Es gibt zahlreiche Möglichkeiten, um zwischen Editiermodus und Objektmodus zu 

wechseln: 

 Rufen Sie den Befehl Ansicht > Objektmodus auf, um in den Objektmodus zu 

gelangen. Rufen Sie den Befehl noch einmal auf, um wieder im Editiermodus 

zu landen. 

 Klicken Sie das Symbol  in der Formatleiste an, um in den Objektmodus zu 

wechseln. Klicken Sie es erneut an, gelangen Sie zurück in den Editiermodus. 

 Sie können auch mit der rechten Maustaste auf eine beliebige Position im Do-

kumentfenster klicken. Es öffnet sich dann ein Kontextmenü, aus dem Sie den 

Befehl Objektmodus beziehungsweise Objektmodus verlassen auswählen. 

 Am schnellsten geht folgende Methode: Zeigen Sie mit der Maus auf eine be-

liebige freie Position im Dokumentfenster und führen Sie einen Doppelklick 

mit der rechten Maustaste durch, um zwischen Editier- und Objektmodus zu 

wechseln. 

Die Objektleiste 

Wenn Sie den Objektmodus aktivieren, wird die Formatleiste ausgeblendet. An 

ihrer Stelle erscheint die Objektleiste. 
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Die Objektleiste 

Die Symbole in dieser Leiste dienen zum Anlegen und Bearbeiten von Objekten. 

Von links nach rechts: 

 Zwischen Objektmodus/Editiermodus wechseln 

 Diagrammrahmen einfügen 

 Textrahmen einfügen 

 Grafikrahmen einfügen 

 OLE-Objektrahmen einfügen 

 OLE-Objektrahmen mit dem SoftMaker Formeleditor* einfügen 

 Linie einfügen 

 Freihandlinie einfügen 

 Kurve einfügen 

 Pfeil einfügen 

 Gerade Verbindung einfügen 

 Gewinkelte Verbindung einfügen 

 Gekrümmte Verbindung einfügen 

 Rechteck einfügen 

 Rechteck mit abgerundeten Ecken einfügen 

 Ellipse oder Kreis einfügen 

 AutoForm einfügen 

 TextArt-Objekt einfügen 

 Selektierte Objekte gruppieren 

 Eigenschaften des selektierten Objekts bearbeiten 

 Objektliste (eine Liste aller Objekte im Dokument, siehe unten) 

* Nicht in allen PlanMaker-Versionen enthalten 

Tipp: Wenn Sie den Mauszeiger auf eines dieser Symbole bewegen, wird dessen 

Funktion in der Statuszeile angezeigt. 

Objektliste: Ganz rechts in der Leiste sehen Sie die Objektliste. In dieser sind alle 

im aktuellen Dokument enthaltenen Objekte aufgelistet. Sie können darin ein Ob-

jekt anhand seines Namens auswählen: Klicken Sie auf die Liste, um sie zu öffnen, 

und wählen Sie dann das gewünschte Objekt per Mausklick. Dieses wird daraufhin 

selektiert.  

Selektieren im Objektmodus 

Im Objektmodus können Sie alle Arten von Objekten einfach per Mausklick selek-

tieren. 
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Dies ist besonders bei Objekten mit transparenter Füllung (z.B. Textrahmen) sehr 

praktisch, da sich derartige Objekte im Editiermodus nur durch einen gezielten 

Mausklick auf den Rand des Objekts selektieren lassen. Im Objektmodus können 

Sie solche Objekte hingegen einfach an einer beliebigen Stelle anklicken, um sie zu 

selektieren. 

Um mehrere Objekte auf einmal zu selektieren, ziehen Sie mit der Maus einen 

Rahmen um die gewünschten Objekte. Alternativ können Sie auch bei gedrückter 

Umschalttaste (ª) mehrere Objekte nacheinander anklicken, um diese zu selektie-

ren. 

Springen von Objekt zu Objekt  

Sie können im Objektmodus auch zwischen den Objekten „hin- und herspringen“. 

Verwenden Sie dazu folgende Tasten: 

Taste Funktion 

(Tab) Nächstes Objekt selektieren 

(ª)(Tab) Vorheriges Objekt selektieren 

Betätigen Sie also beispielsweise die Taste (Tab), selektiert PlanMaker das nächste 

Objekt im Dokument. 

Position und Größe von Objekten ändern 

Folgendermaßen ändern Sie die Position und Größe von Objekten: 

Position von Objekten ändern 

Um die Position eines Objekts zu ändern, selektieren Sie es per Mausklick und 

betätigen dann die Richtungstasten auf der Tastatur oder ziehen es bei gedrückter 

Maustaste mit der Maus an die gewünschte Stelle. 

Hinweis: Objekte sind in der Regel mit der Zelle unterhalb ihrer linken oberen 

Ecke verankert. Ein Objekt lässt sich zwar nach Belieben verschieben, sobald Sie 

es aber an der Zielposition „abgesetzt“ haben, verankert es sich automatisch in 

der Zelle, die sich unter seiner linken oberen Ecke befindet. 

Das bedeutet: Fügen Sie oberhalb des Objekts eine neue Zeile ein, wandert auch 

das Objekt eine Zeile weiter nach unten, damit sich seine linke obere Ecke weiter-
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hin in der verankerten Zelle befindet. Das Gleiche passiert, wenn Sie beispielswei-

se die Höhe von Zeilen oberhalb des Objekts ändern. 

Bei Bedarf können Sie dieses Verhalten ändern, indem Sie das Objekt selektieren, 

den Befehl Objekt > Eigenschaften aufrufen, auf die Karteikarte Format wech-

seln und die Option Positionierung ändern. Wählen Sie dort beispielsweise Von 

Zellposition und -größe unabhängig, bleibt das Objekt unbehelligt, wenn Sie 

Zellen oberhalb des Objekts einfügen oder löschen. Siehe dazu auch Abschnitt 

„Objekt-Eigenschaften, Karteikarte Format“ ab Seite 220. 

Größe von Objekten ändern 

Um die Größe eines Objekts zu ändern, selektieren Sie es per Mausklick und zie-

hen dann mit der Maus an den rot eingefärbten Begrenzungslinien (oder den „Grei-

fern“ an den Ecken der Begrenzungslinien), bis es die gewünschte Größe erreicht 

hat. 

Rotieren und Kippen von Objekten 

Hinweis: Nur Zeichnungen und Grafiken lassen sich rotieren und kippen; bei an-

deren Arten von Objekten ist dies nicht möglich. 

Wenn Sie ein Objekt selektieren, das sich drehen lässt, erscheint ein Doppelpfeil-

Symbol  auf dem Rahmen, der es umgibt. Ziehen Sie mit der Maus an diesem 

Symbol, wird das Objekt rotiert. 

 

Alternativ können Sie den Drehwinkel auch von Hand festlegen. Selektieren Sie 

das Objekt dazu, rufen Sie den Befehl Objekt > Eigenschaften auf, wechseln Sie 

auf die Karteikarte Format und tragen Sie den gewünschten Winkel in der Rubrik 

Drehung ein. 
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Schließlich können Sie Zeichnungen und Grafiken auch über die Befehle des Me-

nüs Objekt > Drehen oder Kippen drehen und kippen. 

Ausrichten und Verteilen von Objekten 

Um zwei oder mehr Objekte auszurichten oder gleichmäßig zu verteilen, selektie-

ren Sie diese und rufen dann den Befehl Objekt > Ausrichten oder verteilen auf.  

Es erscheint ein Untermenü, aus dem Sie die gewünschte Ausrichtung bezie-

hungsweise Verteilung auswählen können: 

 Linksbündig ausrichten 

 Horizontal zentrieren 

 Rechtsbündig ausrichten 

 Oben ausrichten 

 Vertikal zentrieren 

 Unten ausrichten 

 Horizontal verteilen 

 Vertikal verteilen 

Die letzten beiden Befehle funktionieren nur, wenn mindestens drei Objekte selek-

tiert sind. Sie sorgen dafür, dass die Objekte gleichmäßig verteilt werden (so dass 

anschließend alle den gleichen Abstand voneinander haben). 

Duplizieren von Objekten 

Um eine Kopie eines Objekts zu erhalten, kopieren Sie dieses üblicherweise in die 

Zwischenablage und fügen es von dort aus wieder ein.  

Alternativ können Sie auch den Befehl Bearbeiten > Duplizieren verwenden. 

Dieser erstellt sofort eine Kopie des selektierten Objekts. 

Tipp: Noch schneller geht das Duplizieren mit der Maus: Wenn Sie die Taste 
(Strg) gedrückt halten und mit der Maus an einem Objekt ziehen, erhalten Sie 

ein Duplikat von diesem Objekt. 
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Eigenschaften von Objekten ändern 

Zu den Eigenschaften eines Objekts zählt man beispielsweise dessen Größe, Fül-

lung, Umrandung etc. Diese lassen sich zentral mit dem Befehl Objekt > Eigen-

schaften bearbeiten. 

Um die Eigenschaften eines Objekts zu bearbeiten, selektieren Sie dieses zunächst 

per Mausklick. Dann rufen Sie den Befehl Objekt > Eigenschaften auf, worauf 

ein entsprechender Dialog erscheint. 

Tipp: Bei den meisten Arten von Objekten können Sie diesen Dialog auch blitz-

schnell mit einem Doppelklick auf das Objekt öffnen. 

Der Dialog verfügt über mehrere Karteikarten, zwischen denen Sie wechseln kön-

nen, indem Sie oben auf einen der Karteikartenreiter klicken. 

Auf den nächsten Seiten werden alle Karteikarten mit allen darin enthaltenen Opti-

onen ausführlich beschrieben. 

Objekt-Eigenschaften, Karteikarte Format 

Auf der Karteikarte Format können Sie Einstellungen zum Format des Objekts 

vornehmen, also beispielsweise seine Größe ändern. 

Verfügbare Optionen: 

 Rubriken Größe und Skalierung 

 Hier lässt sich die Größe des Objekts ändern. Tragen Sie dazu die gewünschte 

Breite und Höhe ein. Alternativ können Sie bei Horz. Faktor und Vert. Fak-

tor angeben, auf wie viel Prozent seiner Originalgröße das Objekt vergrö-

ßert/verkleinert werden soll. 

 Haben Sie dabei die Option Seitenverhältnis beibehalten eingeschaltet, wir-

ken sich Änderungen an der Höhe automatisch auf die Breite aus (und umge-

kehrt). 

 Bei OLE-Objekten gibt es zusätzlich eine Option namens Skalierung beibe-

halten. Ist diese eingeschaltet ist, wirken sich Änderungen an der Größe eines 

OLE-Objekts innerhalb seiner Quellanwendung automatisch auch auf das Ob-

jekt in PlanMaker aus. Ist sie ausgeschaltet, bleibt das Objekt in PlanMaker 

immer gleich groß. (Hinweis: Nicht alle OLE-Quellanwendungen unterstützen 

dieses Feature.) 
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 Rubrik Positionierung 

 Diese Option bestimmt, wie sehr das Objekt (was seine Position und Größe 

betrifft) von den Tabellenzellen abhängen soll, die sich unter ihm befinden. 

 Von Zellposition und -größe abhängig: Das Objekt verhält sich, als ob es in 

der Zelle unter seiner linken oberen Ecke verankert wäre. Fügen Sie also ober-

halb dieser Zelle neue Zeilen ein, wird das Objekt entsprechend nach unten ge-

schoben. 

 Darüber hinaus ändert das Objekt seine Größe mit den darunter befindlichen 

Zellen. Erhöhen Sie also die Breite dieser Zellen, wächst das Objekt entspre-

chend mit. 

 Nur von Zellposition abhängig: Auch hier verhält sich das Objekt, als ob es in 

der Zelle unter seiner linken oberen Ecke verankert wäre. Seine Größe ändert 

sich jedoch nicht, wenn Sie die Größe der Zellen unter dem Objekt ändern. 

 Von Zellposition und -größe unabhängig: Das Objekt behält seine ursprüng-

liche Position und Größe stets bei – unabhängig von den Zellen unter dem Ob-

jekt. 

 Rubrik Drehung 

 Nur bei Zeichnungen und Grafiken verfügbar.  

 Hier können Sie das Objekt drehen. Tragen Sie dazu den Winkel ein, um den 

das Objekt im Uhrzeigersinn gedreht werden soll. 

 Rubrik Kippen 

 Nur bei Zeichnungen und Grafiken verfügbar.  

 Hier können Sie das Objekt vertikal oder horizontal kippen. 

Objekt-Eigenschaften, Karteikarte Füllung 

Hinweis: Diese Karteikarte ist nicht bei allen Arten von Objekten verfügbar. Und: 

Bei Grafiken wirken sich Änderungen an der Füllung nur auf die transparenten 

Teile der Grafik aus. 

Auf der Karteikarte Füllung können Sie festlegen, womit das Objekt ausgefüllt 

werden soll.  

Wählen Sie zunächst in der Liste Fülltyp die gewünschte Art der Füllung. An-

schließend können Sie zu jedem Fülltyp noch diverse Einstellungen vornehmen. 



 

222    Objekte Handbuch PlanMaker 

Nachfolgend eine Liste aller Fülltypen inklusive ihrer Einstellungen: 

 Keine Füllung 

 Wenn Sie den ersten Fülltyp in der Liste wählen, wird das Objekt nicht gefüllt, 

ist also transparent. 

 Farbe 

 Bei diesem Fülltyp wird das Objekt mit einer Farbe gefüllt. Wählen Sie die 

gewünschte Farbe dazu in der Liste Farben.  

 Tipp: Farblisten bieten immer nur die gebräuchlichsten Farben an; Sie können 

aber jederzeit auch andere Farben wählen. Klicken Sie dazu auf die Schaltflä-

che Weitere Farben (siehe auch Abschnitt „Dokumenteigenschaften, Kartei-

karte Farben“ ab Seite 400). 

 Mit der Option Transparenz können Sie auf Wunsch die Transparenz der Fül-

lung ändern. Zulässig sind Werte zwischen 0% (nicht transparent) und 100% 

(völlig durchsichtig). Setzen Sie diesen Wert also beispielsweise auf 75, ist die 

Füllung zu 75% durchsichtig. 

 Raster 

 Hier wird das Objekt mit einem Raster gefüllt. Wählen Sie dazu in der Liste 

Raster die Art des Rasters und stellen Sie dann die gewünschte Farbe für Vor-

dergrund und Hintergrund ein. 

 Mit der Option Transparenz können Sie auf Wunsch die Transparenz der Fül-

lung ändern. Zulässig sind Werte zwischen 0% (nicht transparent) und 100% 

(völlig durchsichtig). 

 Grafik 

 Hier wird das Objekt mit einer Grafik gefüllt. Über die Schaltfläche Öffnen 

können Sie bestimmen, welche Grafikdatei dies sein soll. Die zuletzt verwende-

ten Grafiken werden außerdem in der Liste Grafiken angezeigt und lassen sich 

dort per Mausklick auswählen. 

 Weitere Optionen: 

 Mit dem Objekt drehen: Wenn Sie diese Option einschalten, dreht sich die 

Grafik mit, wenn Sie das zu füllende Objekt rotieren. 

 Spiegelung: Mit dieser Option können Sie die Grafik horizontal oder vertikal 

spiegeln. 
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 Transparenz: Mit dieser Option können Sie auf Wunsch die Transparenz der 

Füllung ändern. Zulässig sind Werte zwischen 0% (nicht transparent) und 100% 

(völlig durchsichtig). 

 Als Textur kacheln: Wenn diese Option aktiviert ist, wird die Grafik in dem 

Objekt wie ein Kachelmuster wiederholt. 

 Über die Einstellungen in der Rubrik Kacheloptionen können Sie dann die 

Größe und Position der Kacheln ändern: Mit X-Skalierung und Y-Skalierung 

ändern Sie die Größe (in Prozent). Mit X-Versatz und Y-Versatz ändern Sie die 

Position. Die Option Ausrichtung bestimmt, an welcher Kante oder Ecke des 

zu füllenden Objekts die Kacheln ausgerichtet werden sollen. 

 Ist die Option Als Textur kacheln deaktiviert, lassen sich hier lediglich die 

Abstände zu den Kanten des zu füllenden Objekts einstellen. 

 Speichern: Mit dieser Schaltfläche können Sie die momentan ausgewählte 

Grafikdatei exportieren, also eine Kopie der Grafik unter einem beliebigen 

Namen auf Festplatte speichern. 

 Linearer Farbverlauf, Rechteckiger Farbverlauf etc. 

 Die untersten fünf Fülltypen sind verschiedene Arten von Farbverläufen. Wäh-

len Sie zunächst den gewünschten Typ von Farbverlauf in der Liste Fülltyp und 

dann einen der angebotenen Untertypen in der Liste Varianten. 

 In der Rubrik Optionen lässt sich das Aussehen des Farbverlaufs noch genauer 

festlegen: 

 Mit X-Versatz und Y-Versatz können Sie das Zentrum des Farbverlaufs ver-

schieben. Weiterhin lässt sich der Drehwinkel einstellen. 

Tipp: Sie können auch das Steuerkreuz im Feld Beispiel mit der Maus ver-

schieben oder rotieren, um diese Einstellungen zu ändern. 

 Aktivieren Sie die Option Doppelter Farbverlauf, verläuft die Farbe bei-

spielsweise nicht nur von der Ausgangsfarbe zur Endfarbe, sondern auch wie-

der zurück zur Ausgangsfarbe. 

 In der Rubrik Farben können Sie die Farben für den Verlauf ändern: 

 Um eine Farbe zu ändern, klicken Sie zunächst auf eines der kleinen Dreiecke 

unter dem Balken für den Farbverlauf. Das linke Dreieck steht für die Aus-

gangsfarbe, das rechte Dreieck für die Endfarbe: 
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 Wählen Sie dann die gewünschte Farbe aus der Liste Farbe darunter.  

 Mit der Option Transparenz lässt sich auf Wunsch die Transparenz für die 

gewählte Farbe ändern. Zulässig sind Werte zwischen 0% (nicht transparent) 

und 100% (völlig durchsichtig). 

 Sie können dem Farbverlauf sogar noch weitere Farben hinzufügen, indem Sie 

einen Doppelklick auf die gewünschte Position in dem Balken durchführen und 

dann eine Farbe auswählen. Auf die gleiche Weise, nämlich mit einem Doppel-

klick auf das Dreieck, lassen sich zusätzliche Farben auch wieder aus dem Ver-

lauf löschen. 

Objekt-Eigenschaften, Karteikarte Linien 

Hinweis: Diese Karteikarte ist nicht bei allen Arten von Objekten verfügbar.  

Auf der Karteikarte Linien können Sie festlegen, welche Art von Linien für das 

Objekt verwendet werden soll. Bei Zeichnungen betrifft dies die Linien, mit denen 

das Objekt gezeichnet wird; bei allen anderen Objekten die Linien, mit denen das 

Objekt umrandet wird. 

Verfügbare Optionen: 

 Varianten 

 Hier können Sie den gewünschten Linienstil auswählen.  

 Die Einträge in dieser Liste sind lediglich Vorgaben; über die weiteren Optio-

nen des Dialogs können Sie das Aussehen der Linien bei Bedarf noch genauer 

festlegen. 

 Farbe 

 Lässt Sie die Farbe der Linien festlegen. 

 Strich 

 Hier können Sie festlegen, ob durchgezogene Linien oder gestrichelte Linien 

gezeichnet werden sollen. 

 Liniendicke 

 Hier können Sie die Liniendicke exakt in Zehntelpunkt angeben. 
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 Transparenz 

 Mit der Option Transparenz können Sie auf Wunsch die Transparenz der Li-

nien ändern. Zulässig sind Werte zwischen 0% (nicht transparent) und 100% 

(völlig durchsichtig). 

 Startpunkt und Endpunkt 

 Nur bei Linien, Kurven und Verbindungslinien verfügbar. 

 Hier können Sie festlegen, ob am Startpunkt beziehungsweise Endpunkt der 

Linie ein Symbol gezeichnet werden soll. Wählen Sie beispielsweise für den 

Endpunkt einer Linie das Pfeilsymbol, sieht die Linie aus wie ein Pfeil. Bei Be-

darf können Sie weiterhin die Breite und die Höhe des Symbols ändern. 

Objekt-Eigenschaften, Karteikarte Schatten 

Hinweis: Diese Karteikarte ist nicht bei allen Arten von Objekten verfügbar.  

Mit Hilfe der Karteikarte Schatten können Sie das Objekt mit einem Schatten ver-

sehen. 

Verfügbare Optionen: 

 Varianten 

 Hier können Sie den gewünschten Typ von Schatten auswählen.  

 Die Einträge in dieser Liste sind lediglich Vorgaben; über die weiteren Optio-

nen des Dialogs können Sie das Aussehen des Schattens bei Bedarf noch ge-

nauer festlegen.  

 Skalierung 

 Hier können Sie die Größe des Schattens (im Verhältnis zur Größe des Objekts) 

ändern. 

 Versatz 

 Hier können Sie die Position des Schattens ändern. 

 Perspektive 

 Hier können Sie den Neigungswinkel des Schattens ändern. 

 Bei bestimmten Varianten des Typs „Perspektivische Schatten“ lässt sich au-

ßerdem der Horizont ändern, was den Schatten perspektivisch verzerrt. Ist Ho-
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rizont ein positiver Wert, liegt der Schatten vor dem Objekt; bei negativen 

Werten liegt er hinter dem Objekt.  

 Farbe 

 Hier können Sie die Farbe des Schattens ändern. 

 Unschärfe 

 Wenn Sie hier einen Wert größer als Null eintragen, wird der Schatten mit ei-

nem Unschärfeeffekt versehen. Je größer der Wert ist, desto weicher werden die 

Kanten des Schattens gezeichnet. 

 Transparenz 

 Hier können Sie die Transparenz des Schattens ändern. Zulässig sind Werte 

zwischen 0% (nicht transparent) und 100% (völlig durchsichtig). Bei einem 

Wert von 75 ist der Schatten also beispielsweise zu 75% durchsichtig. 

Objekt-Eigenschaften, Karteikarte 3D 

Hinweis: Diese Karteikarte ist nur bei Textrahmen und Zeichnungen verfügbar. 

Mit Hilfe der Karteikarte 3D können Sie das Objekt mit einem 3D-Effekt versehen. 

Verfügbare Optionen: 

 Varianten 

 Hier können Sie den gewünschten Typ von 3D-Effekt auswählen.  

 Die Einträge in dieser Liste sind lediglich Vorgaben; über die weiteren Optio-

nen des Dialogs können Sie das Aussehen des Effekts bei Bedarf noch genauer 

festlegen.  

 Rubrik Optionen 

 Hier können Sie die Winkel, um die das Objekt um die Achsen rotiert werden 

soll, und die Tiefe des 3D-Effekts einstellen. 

 Rubrik 3D-Oberfläche 

 Seitenflächen: Die Farbe für die Seitenflächen des Objekts wird normalerweise 

automatisch eingestellt. Falls Sie eine andere Farbe verwenden möchten, akti-

vieren Sie die Option Seitenflächen und wählen darunter die gewünschte Far-

be. 
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 Vorderfläche anpassen: Wenn diese Option aktiviert ist, wird auch die Vorder-

fläche des Objekts den Beleuchtungseinstellungen des 3D-Effekts entsprechend 

abgedunkelt. Die Beleuchtung können Sie mit der Schaltfläche Weiteres beein-

flussen. 

 Drahtmodell: Wenn Sie diese Option aktivieren, wird das Objekt wie ein 

Drahtgittermodell dargestellt. 

 Schaltfläche Weiteres 

 Klicken Sie auf diese Schaltfläche, können Sie auf die Beleuchtung für den 3D-

Effekt Einfluss nehmen. Es erscheint dazu ein eigener Dialog. Klicken Sie im 

Feld Beleuchtung auf die Position, an der sich die Lichtquelle befinden soll. 

Darüber hinaus können Sie die Intensität einstellen und bestimmen, welche Art 

von Oberfläche der 3D-Effekt simulieren soll. 

Objekt-Eigenschaften, Karteikarte Effekte 

Hinweis: Diese Karteikarte ist nicht bei allen Arten von Objekten verfügbar.  

Mit Hilfe der Karteikarte Effekte können Sie das Objekt mit diversen Effekten 

versehen. 

Verfügbare Effekte und Optionen: 

 Spiegelung 

 Wenn Sie die Option Spiegelungseffekt verwenden aktivieren, wird das Ob-

jekt so dargestellt, als ob es auf einer spiegelnden Oberfläche stehen würde. 

 Optionen: 

 Sichtbarer Teil des Objekts: Bestimmt, wie viel von dem Objekt in der Spie-

gelung zu sehen sein soll (in Prozent). 

 Transparenz beginnt bei: Die Spiegelung wird nach unten hin weich ausge-

blendet. Dieser Wert bestimmt, wie transparent die Spiegelung ganz oben sein 

soll (in Prozent). 

 Y-Versatz: Verschiebt die Spiegelung nach oben oder unten. 

 Weiche Kanten 

 Wenn Sie die Option Weiche Kanten-Effekt verwenden aktivieren, werden 

die Umrandungslinien des Objekts mit einem Weichzeichner-Effekt versehen. 

 Optionen: 
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 Breite: Bestimmt, wie stark der Effekt ausfallen soll. 

 Leuchteffekt 

 Wenn Sie die Option Leuchteffekt verwenden aktivieren, werden die Umran-

dungslinien des Objekts mit einem Leuchteffekt umgeben. 

 Optionen: 

 Breite: Bestimmt, wie stark der Leuchteffekt ausfallen soll. 

 Farbe: Ändert die Farbe für den Leuchteffekt. 

Objekt-Eigenschaften, Karteikarte Eigenschaften 

Auf der Karteikarte Eigenschaften lassen sich allgemeine Einstellungen für ein 

Objekt ändern. 

Verfügbare Optionen: 

 Name 

 Jedes Objekt in einem Dokument bekommt von PlanMaker automatisch einen 

eindeutigen Namen zugewiesen. Auf Wunsch können Sie hier einen anderen 

Namen eintragen.  

 Tipp: Der Name des momentan selektierten Objekts wird in der Objektleiste 

angezeigt. Klicken Sie in der Objektleiste auf den Namen, wird eine Liste aller 

vorhandenen Objekte geöffnet. Klicken Sie einen der anderen Namen an, wird 

das entsprechende Objekt selektiert. Auf diese Weise können Sie Objekte also 

anhand ihres Namens selektieren. 

 Sichtbar 

 Diese Option ist standardmäßig aktiviert. Sie bewirkt, dass das Objekt auf dem 

Bildschirm angezeigt wird (siehe auch Abschnitt „Verbergen von Objekten“ ab 

Seite 231). 

 Schalten Sie diese Option aus, wird das Objekt unsichtbar. 

 Drucken 

 Diese Option ist standardmäßig aktiviert. Sie bewirkt, dass das Objekt im Aus-

druck erscheint, wenn Sie das Arbeitsblatt ausdrucken (siehe auch Abschnitt 

„Verbergen von Objekten“ ab Seite 231). 
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 Sperren 

 Diese Option ist standardmäßig aktiviert. Sie bewirkt, dass sich Größe, Position 

und auch alle andere Eigenschaften des Objekts nicht mehr ändern lassen, wenn 

Sie den Blattschutz einschalten (siehe auch Abschnitt „Blattschutz“ ab Seite 

355).  

 Text sperren 

 Nur bei Textrahmen und Zeichnungen, die Text enthalten, verfügbar. 

 Diese Option ist standardmäßig aktiviert. Sie bewirkt, dass sich der in diesem 

Objekt enthaltene Text nicht mehr bearbeiten lässt, wenn Sie den Blattschutz 

einschalten (siehe auch Abschnitt „Blattschutz“ ab Seite 355).  

 Verknüpfung 

 Hier können Sie eine Internet-Verknüpfung (einen Link) anbringen – zum Bei-

spiel auf eine Internetseite. Klicken Sie dazu auf die Schaltfläche Wählen, 

wählen Sie die Art von Verknüpfung und geben Sie die Zielstelle ein. 

Weitere Karteikarten 

Bei manchen Arten von Objekten erscheinen zusätzliche Karteikarten mit weiteren 

Optionen. Informationen zu diesen Karteikarten finden Sie im Abschnitt über das 

betreffende Objekt. 

Standardeinstellungen für Objekte ändern 

Sie können die Standardeinstellungen für Objekte (Zeichnungen, Grafiken etc.) 

jederzeit ändern.  

Wenn Ihnen beispielsweise die voreingestellte Liniendicke für Zeichnungen nicht 

gefällt, legen Sie einfach eine andere Liniendicke als Standard fest. Auch andere 

Standard-Eigenschaften lassen sich ändern – zum Beispiel die Füllung (von Zeich-

nungen) und die Einstellungen für Schatten- und 3D-Effekte. 

Hinweis: Änderungen an den Standardeinstellungen für Objekte betreffen nur 

Objekte, die Sie danach einfügen. Bereits vorhandene Objekte bleiben hingegen 

unberührt. 

Um die Standardeinstellungen für Objekte zu verändern, verwenden Sie die Schalt-

fläche Standard im Dialogfenster des Befehls Objekt > Eigenschaften.  



 

230    Objekte Handbuch PlanMaker 

Die Standard-Liniendicke für Zeichnungen lässt sich beispielsweise folgenderma-

ßen ändern: 

1. Fügen Sie eine neue Zeichnung ein (oder klicken Sie auf eine vorhandene 

Zeichnung). 

2. Rufen Sie den Befehl Objekt > Eigenschaften auf. 

3. Nehmen Sie die gewünschten Einstellungen vor. Um also beispielsweise die 

Voreinstellung für die Liniendicke zu ändern, stellen Sie einfach auf der Kartei-

karte Linien die gewünschte Liniendicke ein. 

4. Jetzt kommt der entscheidende Schritt: Klicken Sie nicht auf OK, sondern auf 

die Schaltfläche Standard. 

5. Es erscheint ein Dialog, in dem Sie bei Bedarf noch eingrenzen können, welche 

Standardeinstellungen geändert werden sollen. In der Regel ist dies aber nicht 

nötig. 

6. Wenn Sie mit OK bestätigen, werden die aktuell im Dialog gemachten Einstel-

lungen als Standardeinstellungen für neue Zeichnungen festgelegt. 

7. Bestätigen Sie noch einmal mit OK, um den Dialog ganz zu verlassen. 

Alle Zeichnungen, die Sie von nun an einfügen, verwenden standardmäßig die so 

festgelegte Liniendicke. 

Hinweis: Die Standardeinstellungen für Objekte lassen sich für jedes Dokument 

getrennt festlegen. 

Objekte – fortgeschrittene Funktionen 

Die nächsten Seiten enthalten Informationen zu den etwas ausgefalleneren Funkti-

onen zum Bearbeiten von Objekten. Folgende Themen werden darin behandelt: 

 Verbergen von Objekten 

 Reihenfolge von Objekten ändern 

 Gruppieren von Objekten 
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Verbergen von Objekten 

Sie können ein Objekt bei Bedarf verbergen. Es wird dann auf dem Bildschirm 

und/oder im Ausdruck nicht mehr dargestellt. 

Selektieren Sie das gewünschte Objekt dazu, rufen Sie Objekt > Eigenschaften 

auf, wechseln Sie auf die Karteikarte Eigenschaften und gehen Sie dann wie folgt 

vor: 

 Schalten Sie Option Sichtbar aus, wird das Objekt auf dem Bildschirm nicht 

mehr angezeigt. 

 Schalten Sie Option Drucken aus, erscheint das Objekt nicht mehr im Aus-

druck. 

Tipp: Wenn Sie ein Objekt einmal versehentlich unsichtbar gemacht haben, können 

Sie jederzeit Datei > Eigenschaften aufrufen und die Option Verborgene Objekte 

anzeigen auf der Karteikarte Optionen einschalten. Nun werden alle unsichtbaren 

Objekte wieder angezeigt. Sie können das Objekt also wieder selektieren und die 

Option Sichtbar wieder einschalten. 

Reihenfolge von Objekten ändern 

Wenn sich mehrere Objekte überlappen, können Sie bestimmen, in welcher Rei-

henfolge diese hintereinander angeordnet sein sollen – also welches Objekt im 

Vordergrund ist, welches im Hintergrund etc.  

Gehen Sie dazu folgendermaßen vor: 

1. Selektieren Sie das gewünschte Objekt. 

2. Rufen Sie den Befehl Objekt > Reihenfolge auf. Es öffnet sich ein Untermenü 

mit folgenden Befehlen: 

 In den Vordergrund: Bringt das Objekt vor alle anderen Objekte. 

 In den Hintergrund: Bringt das Objekt hinter alle anderen Objekte. 

 Eine Ebene nach vorne: Bringt das Objekt eine Ebene weiter nach vorne. 

 Eine Ebene nach hinten: Bringt das Objekt eine Ebene weiter nach hinten. 
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Gruppieren von Objekten 

Wenn Sie mehrere Objekte gruppieren, fassen Sie diese zu einer Einheit zusam-

men, die wie ein einzelnes Objekt selektiert und manipuliert werden kann.  

Das bedeutet in der Praxis:  

Selektieren Sie ein Objekt, das zu einer Gruppe gehört, wird stets die gesamte 

Gruppe selektiert. Verschieben Sie dieses Objekt, werden alle Objekte der Gruppe 

mitbewegt. Das Gruppieren verhindert außerdem, dass zusammengehörende Ob-

jekte versehentlich mit der Maus gegeneinander verschoben werden können. 

Um Objekte zu gruppieren, gehen Sie folgendermaßen vor: 

1. Selektieren Sie die zu gruppierenden Objekte. 

 Klicken Sie die Objekte dazu bei gedrückter Umschalttaste (ª) nacheinander 

an – oder wechseln Sie in den Objektmodus und ziehen Sie dann bei gedrückter 

Maustaste ein Rechteck um alle zu selektierenden Objekte auf. 

2. Klicken Sie auf das Symbol  in der Objektleiste oder rufen Sie den Befehl 

Objekt > Gruppieren auf, um die Objekte zu gruppieren. 

Gruppierung wieder aufheben 

Um die Gruppierung von Objekten wieder aufzuheben, gehen Sie folgendermaßen 

vor: 

1. Selektieren Sie die Gruppe, indem Sie eines der darin enthaltenen Objekte an-

klicken. 

2. Rufen Sie den Befehl Objekt > Gruppierung aufheben auf. 

 

Die allgemeinen Informationen zu Objekten sind hiermit abgeschlossen. In den 

nächsten Abschnitten werden die einzelnen Arten von Objekten ausführlich vorge-

stellt: 

 Diagramme (siehe dazu Kapitel „Diagramme“ ab Seite 257) 

 Textrahmen (ab Seite 233) 

 Grafiken (ab Seite 236) 

 OLE-Objekte (ab Seite 241) 
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 Zeichnungen (ab Seite 248) 

Diagramme 

Mit Hilfe von Diagrammen können Sie die Zahlenwerte in einer Tabelle grafisch 

darstellen und somit die „nackten Zahlen“ anschaulich und übersichtlich präsentie-

ren. 

Dem Arbeiten mit Diagrammen widmet sich ein eigenes Kapitel: das Kapitel 

„Diagramme“ ab Seite 257. Alle Informationen zu Diagrammen finden Sie dort. 

Textrahmen 

Mit Hilfe von Textrahmen können Sie einen Textkasten in die Tabelle setzen. In 

Textrahmen lässt sich nach Belieben Text eingeben, bearbeiten und formatieren.  

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit Textrahmen. 

Folgende Themen werden darin behandelt: 

 Textrahmen einfügen 

 Eigenschaften von Textrahmen ändern 

Lesen Sie dazu die nächsten Seiten. 

Textrahmen einfügen 

Um einen Textrahmen einzufügen, gehen Sie folgendermaßen vor: 

1. Rufen Sie den Befehl Objekt > Neuer Textrahmen auf. 

 Alternativ können Sie das Symbol  in der Objektleiste anklicken, sofern Sie 

den Objektmodus aktiviert haben. 

2. Ziehen Sie im Dokument mit der Maus ein Rechteck auf, das die gewünschte 

Position und Größe hat. 

Der Textrahmen wurde nun erstellt, und Sie können sofort mit der Eingabe von 

Text beginnen.  
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Wenn Sie mit der Texteingabe fertig sind, klicken Sie eine beliebige Tabellenzelle 

an, um den Rahmen zu verlassen. Nun können Sie wieder Tabellenzellen bearbei-

ten. Umgekehrt gelangen Sie in den Textrahmen zurück, indem Sie in den Rahmen 

hineinklicken. 

Wichtig: Wenn PlanMaker am unteren Rand eines Textrahmens einen roten Bal-

ken anzeigt, zeigt dies an, dass der enthaltene Text nicht vollständig in den Rah-

men passt. Vergrößern Sie in diesem Falle also den Rahmen oder verringern Sie 

die Textmenge. 

Eigenschaften von Textrahmen ändern 

Um die Eigenschaften eines Textrahmens zu bearbeiten, selektieren Sie diesen zu-

nächst. Klicken Sie dazu die Umrandung an, die den Textrahmen umgibt, oder kli-

cken Sie ihn im Objektmodus einfach an. Dann rufen Sie den Befehl Objekt > 

Eigenschaften auf, worauf ein entsprechender Dialog erscheint. 

Tipp: Wenn Sie den Objektmodus aktiviert haben, können Sie diesen Dialog 

auch mit einem Doppelklick auf den Textrahmen öffnen. 

In dem Dialog lassen sich folgende Einstellungen vornehmen: 

Karteikarten Format, Füllung, Linien etc. 

Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie die-

nen zum Ändern folgender Einstellungen: 

 Format: Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. 

Siehe Abschnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 220. 

 Füllung: Hier können Sie die Füllung ändern. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Füllung“ ab Seite 221. 

 Linien: Hier können Sie Umrandungslinien anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Linien“ ab Seite 224. 

 Schatten: Hier können Sie einen Schatten anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Schatten“ ab Seite 225. 

 3D: Hier können Sie einen 3D-Effekt anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte 3D“ ab Seite 226. 
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 Effekte: Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt 

„Objekt-Eigenschaften, Karteikarte Effekte“ ab Seite 227. 

 Eigenschaften: Hier können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 228. 

Weiterhin erscheinen bei Textrahmen zwei zusätzliche Karteikarten mit weiteren 

Optionen: 

Karteikarte Innentext 

Auf dieser Karteikarte können Sie Einstellungen zu dem enthaltenen Text ändern.  

Verfügbare Optionen: 

 Rubrik Innenränder 

 Hier können Sie die Ränder zwischen dem Textrahmen und dem darin enthalte-

nen Text ändern. Schalten Sie die Option Automatisch ein, ermittelt das Pro-

gramm automatisch geeignete Ränder. 

 Rubrik Überlappende Objekte 

 Diese Einstellung bestimmt, was passieren soll, wenn sich der Textrahmen mit 

einem anderen Rahmen überlappt.  

 Bei der Standardeinstellung Objekt ignorieren greift PlanMaker nicht ein. In 

dem sich überlappenden Bereich wird also der Inhalt beider Rahmen überei-

nander gedruckt.  

 Wählen Sie hingegen die Option Text umbrechen, wird der Text in diesem 

Rahmen automatisch neu umbrochen, so dass er die Überlappung umfließt. 

 Rubrik Drehen um ... 

 Hier können Sie den Text um den angegebenen Winkel drehen. 

 Rubrik Vertikale Ausrichtung 

 Diese Einstellung bestimmt, wie der enthaltene Text zwischen Ober- und Un-

terkante des Rahmens ausgerichtet werden soll: 

Option Erläuterung 

Oben Der Text wird an der Oberkante des Rahmens ausge-

richtet. (Dies ist die Standardeinstellung.) 
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Unten Der Text wird an der Unterkante des Rahmens aus-

gerichtet. 

Zentriert Der Text wird zwischen Ober- und Unterkante 

zentriert. 

Vertikaler Blocksatz Der Abstand zwischen den Textzeilen wird gleich-

mäßig so erweitert, dass der Text an der Oberkante 

des Rahmens beginnt und an der Unterkante endet. 

Karteikarte AutoFormen 

Ein Textrahmen ist im Prinzip nichts anderes als eine AutoForm, der Text hinzuge-

fügt wurde. Standardmäßig wird hierzu ein einfaches Rechteck als AutoForm ver-

wendet. Sie können dem Textrahmen jedoch jederzeit eine andere AutoForm zu-

weisen, also beispielsweise aus dem Rechteck eine Sprechblase oder eine beliebige 

andere Form machen. 

Wählen Sie dazu einfach auf der Karteikarte AutoForm die gewünschte Form aus. 

Ausführliche Informationen zu AutoFormen finden Sie im Abschnitt 

„Zeichnungen“ ab Seite 248. 

Grafiken 

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Einfügen und Bearbeiten 

von Grafiken. Folgende Themen werden darin behandelt: 

 Grafiken einfügen 

 Grafiken einscannen 

 Eigenschaften von Grafiken ändern 

Lesen Sie dazu die nächsten Seiten. 

Grafiken einfügen 

Um eine Grafik einzufügen, gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Objekt > Neuer Grafikrahmen auf. 
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 Alternativ können Sie das Symbol  in der Objektleiste anklicken, sofern Sie 

den Objektmodus aktiviert haben.  

2. Ziehen Sie im Dokument mit der Maus ein Rechteck auf, das die gewünschte 

Position und Größe hat. 

 Oder: Wahlweise können Sie auch einfach nur an die Stelle klicken, an der die 

linke obere Ecke der Grafik zu liegen kommen soll. Die Grafik wird dann in ih-

rer Originalgröße eingefügt. 

3. Nun erscheint ein Dialog, in dem Sie bestimmen, welche Grafik in dem Grafik-

rahmen erscheinen soll. Tippen Sie dazu den Dateinamen ein oder wählen Sie 

eine Datei aus der Liste.  

 Tipp: Wenn Sie die Option Vorschau einschalten, zeigt der Dialog eine kleine 

Vorschau auf die momentan selektierte Grafikdatei an. 

4. Bestätigen Sie mit OK. 

Der Grafikrahmen wird nun eingefügt. 

Optionen des Dialogs 

Die Optionen in obigem Dialogfenster haben folgende Bedeutung: 

 Im Dokument ablegen 

 Ist diese Option eingeschaltet, speichert PlanMaker eine Kopie der Grafik im 

Dokument ab und verwendet dieses anstelle des Originals. 

 Ist sie ausgeschaltet, wird im Dokument nur ein Verweis auf die originale Gra-

fikdatei gespeichert. 

 In den Ordner des Dokuments kopieren 

 Ist diese Option eingeschaltet, erzeugt PlanMaker eine Kopie der Grafikdatei in 

dem Ordner, in dem sich das Dokument befindet, und verwendet diese anstelle 

des Originals. 

 Diese Option ist nur verfügbar, wenn das Dokument schon einmal gespeichert 

wurde. 
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Grafiken einscannen 

Hinweis: Das direkte Einscannen von Grafiken ist nur mit der Windows-Version 

von PlanMaker möglich. 

Mit PlanMaker für Windows lassen sich Vorlagen direkt in ein Dokument einscan-

nen. Sie müssen dazu einen Scanner an Ihren Rechner angeschlossen und die mit-

gelieferte Software installiert haben. Die Scanner-Software muss TWAIN-

kompatibel sein, was bei praktisch allen Scannern der Fall ist. 

Um etwas direkt in ein Dokument einzuscannen, gehen Sie wie folgt vor: 

1. Schalten Sie den Scanner ein und legen Sie die Vorlage ein. 

2. Rufen Sie den Befehl Datei > Holen auf. 

PlanMaker aktiviert nun die Scan-Software Ihres Scanners. Nehmen Sie darin die 

gewünschten Einstellungen vor (siehe Handbuch zum Scanner) und starten Sie den 

Scanvorgang. Wenn dieser abgeschlossen ist, erscheint das Ergebnis als Grafik im 

Dokument. 

Andere Quelle wählen 

Wenn an Ihren PC mehrere Scanner angeschlossen sind, können Sie mit dem Be-

fehl Datei > Quelle wählen zwischen diesen wechseln.  

Rufen Sie den Befehl dazu auf, wählen Sie das gewünschte Gerät und bestätigen 

Sie mit OK. 

Eigenschaften von Grafiken ändern 

Sämtliche Eigenschaften eines Objekts lassen sich zentral mit dem Befehl Objekt 

> Eigenschaften bearbeiten. Zu den Eigenschaften zählt man beispielsweise Grö-

ße, Ränder und zahlreiche weitere Einstellmöglichkeiten. 

Um die Eigenschaften einer Grafik zu bearbeiten, selektieren Sie diese zunächst 

per Mausklick. Dann rufen Sie den Befehl Objekt > Eigenschaften auf, worauf 

ein entsprechender Dialog erscheint. 

Tipp: Sie können diesen Dialog auch über einen Doppelklick auf die Grafik auf-

rufen. 

In dem Dialog lassen sich folgende Einstellungen vornehmen: 
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Karteikarten Format, Füllung, Linien etc. 

Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie die-

nen zum Ändern folgender Einstellungen: 

 Format: Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. 

Siehe Abschnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 220. 

 Füllung: Hier können Sie die Füllung ändern. Nur bei Grafiken mit transparenten 

Bereichen sichtbar. Siehe Abschnitt „Objekt-Eigenschaften, Karteikarte Fül-

lung“ ab Seite 221. 

 Linien: Hier können Sie Umrandungslinien anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Linien“ ab Seite 224. 

 Schatten: Hier können Sie einen Schatten anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Schatten“ ab Seite 225. 

 Effekte: Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt 

„Objekt-Eigenschaften, Karteikarte Effekte“ ab Seite 227. 

 Eigenschaften: Hier können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 228. 

Weiterhin erscheint bei Grafiken eine zusätzliche Karteikarte mit weiteren Optio-

nen: 

Karteikarte Grafik 

Auf der Karteikarte Grafik können Sie Einstellungen zur Grafik selbst vornehmen.  

Verfügbare Optionen: 

 Varianten 

 In dieser Liste werden einige vorgefertigte Variationen der Grafik angeboten – 

zum Beispiel andere Farbmodi (Graustufen, schwarz/weiß etc.) und Varianten, 

bei denen das Bild eingefärbt wurde. 

 Klicken Sie die gewünschte Variante einfach an. Die Optionen in dem Dialog 

werden dann automatisch auf entsprechende Einstellungen gesetzt. 

 Rubrik Optionen 

 Hier können Sie Helligkeit, Kontrast, Sättigung und Gamma-Wert (eine alterna-

tive Möglichkeit zum Ändern der Helligkeit) ändern. 
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 Schaltfläche Weiteres 

 Diese Schaltfläche öffnet einen Dialog mit zusätzlichen Einstellungen: 

 Wenn Sie die Option Einfärben aktivieren und darunter eine Farbe auswählen, 

wird die Grafik entsprechend eingefärbt. 

 Mit den Optionen in der Rubrik Beschnitt können Sie die Grafik zuschneiden. 

Dies ist nützlich, wenn Sie nur einen Ausschnitt der Grafik benötigen. Soll bei-

spielsweise das obere Viertel der Grafik abgeschnitten werden, geben Sie bei 

Oben die Zahl „25“ (Prozent) ein.  

 Rubrik Transparenz 

 Hier können Sie Einstellungen zur Transparenz der Grafik vornehmen: 

 Automatisch erkennen: PlanMaker liest aus der Grafikdatei aus, welche Teile 

der Grafik als transparent gekennzeichnet wurden, und stellt die Grafik entspre-

chend dar. Hinweis: Nur Grafiken im GIF- oder PNG-Format enthalten solche 

Transparenz-Informationen. 

 Keine Transparenz: Die Grafik wird nicht transparent dargestellt – selbst 

wenn es sich im eine Grafikdatei mit Transparenz-Informationen handelt. 

 Farbe: Lässt Sie die Farbe auswählen, die als transparente Farbe verwendet 

werden soll. Wählen Sie beispielsweise die Farbe Weiß, werden alle weißen 

Bereiche der Grafik transparent dargestellt. 

 Schaltfläche Datei 

 Über diese Schaltfläche können Sie eine andere Grafikdatei auswählen. 

 Schaltfläche Exportieren 

 Nur bei Grafiken verfügbar, die im Dokument gespeichert sind. Mit dieser 

Schaltfläche können Sie die Grafikdatei exportieren, also eine Kopie der Grafik 

unter einem beliebigen Namen auf Festplatte speichern. 

 Schalten Sie dabei die Option Verknüpfung zu Datei herstellen ein, ersetzt 

PlanMaker außerdem die im Dokument gespeicherte Grafik durch einen Ver-

weis auf die Zieldatei. Die Grafik ist dann also nicht mehr im Dokument ge-

speichert. 
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OLE-Objekte 

Hinweis: Die Verwendung von OLE-Objekten ist nur mit der Windows-Version 

von PlanMaker möglich. 

Bei PlanMaker für Windows können Sie in Ihre Dokumente Objekte (Zeichnun-

gen, Grafiken usw.) einbetten, die mit einer anderen Applikation erzeugt wurden. 

Ein Beispiel: Mit Objekt > Neuer OLE-Objektrahmen können Sie von PlanMa-

ker aus das Windows-Malprogramm Paint starten lassen und darin etwas zeichnen. 

Beenden Sie Paint, erscheint diese Zeichnung im PlanMaker-Dokument. Sie ist 

jetzt in das Dokument eingebettet. 

Vorteil: Sie müssen auf die Zeichnung im PlanMaker-Dokument nur einen Dop-

pelklick ausführen – schon wird Paint automatisch erneut gestartet. Wenn Sie die 

Zeichnung darin nun bearbeiten und Paint wieder beenden, werden die Änderun-

gen auch von PlanMaker übernommen.  

Damit dies funktioniert, muss die aufzurufende Applikation OLE unterstützen. 

OLE steht für „Object Linking and Embedding“ („Verknüpfen und Einbetten von 

Objekten“). Das Objekt, das von der anderen Applikation zu PlanMaker gereicht 

wird, nennt man ein OLE-Objekt. 

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit OLE-

Objektrahmen. Folgende Themen werden darin behandelt: 

 OLE-Objekte einfügen 

 OLE-Objekte bearbeiten 

 Verknüpfungen von OLE-Objekten bearbeiten 

 Eigenschaften von OLE-Objekten ändern 

 Verwendung des SoftMaker Formeleditors 

Lesen Sie dazu die nächsten Seiten. 

OLE-Objekte einfügen 

Hinweis: Die Verwendung von OLE-Objekten ist nur mit der Windows-Version 

von PlanMaker möglich. 
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Mit dem Befehl Objekt > Neuer OLE-Objektrahmen können Sie ein OLE-

Objekt in das Dokument einbetten. 

Der Befehl öffnet ein Dialogfenster. Dieses enthält eine Liste aller Anwendungen, 

mit denen sich OLE-Objekte erstellen lassen. Welche Einträge darin angeboten 

werden, hängt davon ab, welche OLE-fähigen Programme auf Ihrem System instal-

liert sind. 

Wenn Sie beispielsweise den Eintrag „Paintbrush-Bild“ wählen, öffnet sich das 

Windows-Malprogramm Paintbrush (oder Paint) mit einem leeren Fenster. Zeich-

nen Sie darin ein Bild und beenden Sie Paint dann einfach. Das Bild ist nun in Ihr 

Dokument eingebettet. Es wird nicht nur darin angezeigt, sondern kann jederzeit 

auch bearbeitet werden. Führen Sie zum Bearbeiten einfach einen Doppelklick auf 

das Bild im Dokument aus. 

Im Einzelnen gehen Sie zum Einfügen eines OLE-Objekts in ein Dokument wie 

folgt vor: 

1. Rufen Sie den Befehl Objekt > Neuer OLE-Objektrahmen auf. 

2. Ziehen Sie im Dokument mit der Maus ein Rechteck auf, das die gewünschte 

Position und Größe hat. 

 Oder: Wahlweise können Sie auch einfach nur an die Stelle klicken, an der die 

linke obere Ecke des Objekts zu liegen kommen soll. Das Objekt wird dann in 

seiner Originalgröße eingefügt. 

3. Es erscheint ein Dialogfenster. Wählen Sie darin aus der Liste Objekttyp die 

Quellanwendung aus, von der PlanMaker das OLE-Objekt erhalten soll. 

4. Bestätigen Sie mit OK, worauf die zum gewählten Objekttyp gehörende An-

wendung gestartet wird. 

5. Erstellen Sie das Objekt in der Anwendung. 

6. Beenden Sie die Anwendung. 

7. Die Anwendung fragt nun möglicherweise nach, ob Sie das Objekt im PlanMa-

ker-Dokument aktualisieren möchten. Bestätigen Sie dies mit „Ja“. 

Das in der anderen Anwendung erstellte OLE-Objekt ist nun in das PlanMaker-

Dokument eingebettet.  

OLE-Objekte aus einer Datei erstellen 

Möchten Sie kein neues OLE-Objekt erstellen, sondern ein bereits vorhandenes 

Dokument einer anderen Anwendung als OLE-Objekt einbetten, rufen Sie eben-



 

Handbuch PlanMaker Objekte    243 

falls Objekt > Neuer OLE-Objektrahmen auf, wählen im Dialogfenster jedoch 

die Option Aus Datei erstellen.  

Das Aussehen des Dialogs ändert sich: Statt der Liste Objekttyp finden Sie nun-

mehr das Eingabefeld Datei vor. Geben Sie hier den kompletten Dateinamen an 

oder klicken Sie auf die Schaltfläche Durchsuchen, um ein Dialogfenster zu erhal-

ten, mit dem Sie Ihre Festplatte nach dem Dokument durchforsten können.  

Bestimmen Sie eine Datei und bestätigen Sie mit OK, wird diese als OLE-Objekt 

eingefügt.  

Dabei prüft Windows, ob es mit der Namenserweiterung dieser Datei etwas anfan-

gen kann, und reagiert entsprechend. Ist die Namenserweiterung nicht registriert, 

erscheint lediglich ein Symbol für die eingebettete Datei. Kann Windows die Na-

menserweiterung hingegen einem OLE-fähigen Programm zuordnen, wird der In-

halt der Datei angezeigt.  

Verknüpfung mit der Originaldatei herstellen 

Im oben beschriebenen Dialogfenster können Sie zusätzlich auswählen, ob die ein-

zufügende Datei eingebettet oder verknüpft werden soll. Lassen Sie die Option 

Verknüpfen ausgeschaltet, fügt PlanMaker eine Kopie der Datei als OLE-Objekt 

ein und speichert diese im Dokument – das OLE-Objekt wird also wie gewohnt 

eingebettet.  

Schalten Sie hingegen die Option Verknüpfen ein, stellt PlanMaker eine Verknüp-

fung mit der Originaldatei für das OLE-Objekt her. Von der Bedienung her ändert 

sich dadurch nichts. Ändern Sie jedoch später die Originaldatei des OLE-Objekts 

mit einem anderen Programm und öffnen das PlanMaker-Dokument erneut, hat 

sich auch das OLE-Objekt entsprechend geändert – das OLE-Objekt ist also mit 

der Originaldatei verknüpft. 

OLE-Objekte bearbeiten 

Tipp: Um ein OLE-Objekt zu editieren, führen Sie einfach einen Doppelklick auf 

das OLE-Objekt durch. Es wird sofort in der zugehörigen Applikation geöffnet 

und kann darin bearbeitet werden. 

Alternativ können Sie auch das Menü verwenden, um ein OLE-Objekt zu editieren. 

Gehen Sie folgendermaßen vor: 

1. Klicken Sie das OLE-Objekt an, um es zu selektieren. 
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2. Rufen Sie das Menü Bearbeiten auf. Am Ende dieses Menüs finden Sie einen 

Menüeintrag mit dem Namen des Objekts (zum Beispiel Bitmap-Objekt). Das 

Auswählen dieses Menüeintrags öffnet ein Untermenü mit allen für dieses O-

LE-Objekt zuständigen OLE-Befehlen. Der Befehl Bearbeiten oder Edit ist für 

das Bearbeiten zuständig. Rufen Sie diesen auf. 

3. Die zu dem OLE-Objekt gehörende Quellanwendung wird nun gestartet. Neh-

men Sie die gewünschten Änderungen vor. 

Um wieder zu PlanMaker zurückzukehren, beenden Sie die Anwendung einfach. 

Beim Beenden mancher Quellanwendungen wird dabei nachgefragt, ob Sie das 

Objekt im PlanMaker-Dokument aktualisieren möchten. Antworten Sie mit „Ja“ – 

andernfalls werden Ihre Änderungen verworfen. 

Verknüpfungen von OLE-Objekten bearbeiten 

Haben Sie ein OLE-Objekt aus einer Datei erstellt und dabei die Option Verknüp-

fung aktiviert, können Sie diese Verknüpfung zu der Quelldatei mit dem Befehl 

Bearbeiten > Verknüpfungen bearbeiten.  

Rufen Sie diesen Befehl dazu auf. Es erscheint ein Dialogfenster, in dem alle im 

aktuellen Dokument vorhandenen Verknüpfungen aufgelistet sind. Wenn Sie eine 

Verknüpfung selektieren, wird im unteren Teil des Dialogfensters Dateiname und 

Typ der zugehörigen Quelldatei angezeigt. 

Mit den Schaltflächen des Dialogfensters lassen sich folgende Aktionen ausführen: 

Schaltfläche Funktion 

Jetzt aktualisieren Aktualisiert das OLE-Objekt. Verwenden Sie diese Schalt-

fläche, falls die Quelldatei von einem anderen Programm 

verändert wurde und die Änderungen im PlanMaker-

Dokument nicht sichtbar werden.  

Quelle öffnen Startet die zu dem OLE-Objekt gehörende Anwendung und 

lässt Sie das Objekt darin bearbeiten. Tipp: Dies ist auch mit 

einem Doppelklick auf das Objekt erreichbar. 

Quelle ändern Lässt Sie eine andere Datei als Quelle für das OLE-Objekt 

auswählen. 

Verknüpfung lösen Trennt die Verbindung mit der Quelldatei. Das Objekt ist 

anschließend fest in das PlanMaker-Dokument eingebettet; 

Änderungen an der Quelldatei wirken sich nicht mehr aus. 

Das Objekt lässt sich aber nach wie vor per Doppelklick 

bearbeiten. 
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Eigenschaften von OLE-Objekten ändern 

Sämtliche Eigenschaften eines Objekts lassen sich zentral mit dem Befehl Objekt 

> Eigenschaften bearbeiten. Zu den Eigenschaften zählt man beispielsweise Grö-

ße, Ränder und zahlreiche weitere Einstellmöglichkeiten. 

Um die Eigenschaften eines OLE-Objekts zu bearbeiten, selektieren Sie dieses 

zunächst per Mausklick. Dann rufen Sie den Befehl Objekt > Eigenschaften auf, 

worauf ein entsprechender Dialog erscheint. 

In dem Dialog lassen sich folgende Einstellungen vornehmen: 

Karteikarten Format, Füllung, Linien etc. 

Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie die-

nen zum Ändern folgender Einstellungen: 

 Format: Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. 

Siehe Abschnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 220. 

 Füllung: Hier können Sie die Füllung ändern. Diese Funktion wird allerdings 

nicht von allen OLE-Anwendungen unterstützt. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Füllung“ ab Seite 221. 

 Linien: Hier können Sie Umrandungslinien anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Linien“ ab Seite 224. 

 Schatten: Hier können Sie einen Schatten anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Schatten“ ab Seite 225. 

 Effekte: Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt 

„Objekt-Eigenschaften, Karteikarte Effekte“ ab Seite 227. 

 Eigenschaften: Hier können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 228. 

Weiterhin erscheint bei OLE-Objekten eine zusätzliche Karteikarte mit weiteren 

Optionen: 

Karteikarte Grafik 

Auf der Karteikarte Grafik können Sie Einstellungen zur grafischen Darstellung 

des Objekts vornehmen. 
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Hinweis: Abhängig vom Typ des OLE-Objekts sind manche dieser Optionen 

möglicherweise ohne Funktion. 

Verfügbare Optionen: 

 Varianten 

 In dieser Liste werden einige vorgefertigte Variationen angeboten – zum Bei-

spiel andere Farbmodi (Graustufen, schwarz/weiß etc.) und Varianten, bei de-

nen das Objekt eingefärbt wurde. 

 Klicken Sie die gewünschte Variante einfach an. Die Optionen in dem Dialog 

werden dann automatisch auf entsprechende Einstellungen gesetzt. 

 Rubrik Optionen 

 Hier können Sie Helligkeit, Kontrast, Sättigung und Gamma-Wert (eine alterna-

tive Möglichkeit zum Ändern der Helligkeit) ändern. 

 Schaltfläche Weiteres 

 Diese Schaltfläche öffnet einen Dialog mit zusätzlichen Einstellungen: 

 Wenn Sie die Option Einfärben aktivieren und darunter eine Farbe auswählen, 

wird das Objekt entsprechend eingefärbt. 

 Mit den Optionen in der Rubrik Beschnitt können Sie das Objekt zuschneiden. 

Dies ist nützlich, wenn Sie nur einen Ausschnitt des Objekts benötigen. Soll 

beispielsweise das obere Viertel des Objekts abgeschnitten werden, geben Sie 

bei Oben die Zahl „25“ (Prozent) ein.  

 Schaltfläche Exportieren 

 Mit dieser Schaltfläche können Sie eine Kopie der grafischen Repräsentation 

des Objekts exportieren, also ein Abbild des Objekts unter einem beliebigen 

Namen auf Festplatte speichern. 

Verwendung des SoftMaker Formeleditors 

Hinweis: Der SoftMaker-Formeleditor ist nur unter Windows verfügbar und 

nicht in allen Versionen von PlanMaker enthalten. 

Mit dem SoftMaker Formeleditor können Sie mathematische und technische For-

meln grafisch darstellen. 
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Den Formeleditor sprechen Sie, wie in den vorherigen Abschnitten beschrieben, 

über OLE an. Um also eine Formel grafisch darzustellen, fügen Sie in das Doku-

ment ein OLE-Objekt ein, das als Quellanwendung den Formeleditor verwendet. 

Dazu gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Objekt > Neuer OLE Objektrahmen auf. 

2. Klicken Sie an die Stelle, an der das Objekt eingefügt werden soll. 

3. Wählen Sie in der Liste Objekttyp den Eintrag SoftMaker Formeleditor. 

4. Bestätigen Sie mit OK, worauf der Formeleditor gestartet wird. 

5. Erstellen Sie die gewünschte Formel. 

6. Wenn die Formel fertiggestellt ist, beenden Sie den Formeleditor einfach. 

Die Formel ist nun als OLE-Objekt in das PlanMaker-Dokument eingebettet. 

Sie können Formeleditor-Objekte jederzeit nachträglich bearbeiten, indem Sie ei-

nen Doppelklick darauf ausführen. Der Formeleditor wird daraufhin wieder gestar-

tet und öffnet die Formel. Nehmen Sie die gewünschten Änderungen vor und be-

enden Sie den Formeleditor dann einfach wieder. 

Mit dem Befehl Objekt > Eigenschaften können Sie weiterhin die Eigenschaften 

des Formeleditor-Objekts ändern, nachdem Sie es mit einem (einfachen!) Maus-

klick selektiert haben. 

Informationen vom Hersteller des Formeleditors 

Der SoftMaker Formeleditor ist eine spezielle Version des Programms MathType der Firma Design 

Science. Falls Sie häufig Formeln in Ihren Dokumenten verwenden, werden Sie in MathType eine Lö-

sung finden, die Ihren Ansprüchen noch besser genügt. MathType ist genauso einfach zu bedienen wie 

der SoftMaker Formeleditor, hat jedoch zahlreiche zusätzliche Funktionen, die Ihnen helfen, produkti-

ver zu sein und anspruchsvollere Formeln zu gestalten. 

MathType ist in Deutsch, Französisch, Englisch und Japanisch erhältlich. Informationen über den Bezug 

von MathType erhalten Sie bei Ihrem Softwarehändler oder direkt bei Design Science. 

Design Science, Inc. 

4028 Broadway 
Long Beach, CA 90803 

USA 

Telefon (USA): (800) 827-0685 (für Kunden aus USA und Kanada) 
 (562) 433-0685 (für internationale Kunden) 

Telefax (USA): (562) 433-6969 

E-Mail (englisch): sales@mathtype.com 
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Internet: www.mathtype.com 

Zeichnungen 

PlanMaker bietet mehrere Werkzeuge zum Erstellen von Zeichnungen an. Sie kön-

nen in Ihre Dokumente folgende Arten von Zeichnungsobjekten einfügen: 

 Linien 

 Freihandformen (zum Zeichnen wie mit einem Stift) 

 Kurven 

 Pfeile 

 Verbindungen (zum Verbinden von Objekten, z.B. für Flussdiagramme) 

 Rechtecke und Ellipsen 

 AutoFormen (vorgefertigte Formen unterschiedlichster Art) 

 TextArt-Objekte (mit Effekten versehene Schriftzüge) 

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit Zeichnun-

gen. Folgende Themen werden darin behandelt: 

 Zeichnungen einfügen 

 Text zu AutoFormen hinzufügen 

 Eigenschaften von Zeichnungen ändern 

Lesen Sie dazu die nächsten Seiten. 

Zeichnungen einfügen 

Um eine Zeichnung einzufügen, wählen Sie zunächst das gewünschte Zeichen-

werkzeug und bringen die Zeichnung dann an.  

Um also beispielsweise ein Rechteck zu zeichnen, gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Objekt > Neue Zeichnung auf. Es öffnet sich ein Un-

termenü, aus dem Sie das Zeichenwerkzeug auswählen – hier also das Werk-

zeug Rechteck. 

 Alternativ können Sie auch das entsprechende Symbol in der Objektleiste an-

klicken, sofern Sie den Objektmodus aktiviert haben. 
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2. Ziehen Sie im Dokument mit der Maus ein Rechteck auf, das die gewünschte 

Position und Größe hat. 

Das Rechteck wird nun eingefügt. 

Das Anbringen von Zeichnungen unterscheidet sich je nach verwendetem Zei-

chenwerkzeug etwas. Nachfolgend daher eine Liste aller verfügbaren Arten von 

Zeichnungsobjekten mit Tipps zu deren Handhabung: 

Linie 

Mit dem Werkzeug  Linie können Sie eine gerade Linie zeichnen. 

Ziehen Sie dazu bei gedrückter Maustaste einfach eine Linie im Dokument.  

Tipp: Wenn Sie dabei die Umschalttaste (ª) gedrückt halten, ist die Linie auf 45°-

Winkel beschränkt. 

Freihandform 

Mit dem Werkzeug  Freihandform können Sie Kurven wie mit einem Zei-

chenstift zeichnen. 

Bewegen Sie die Maus dazu auf den gewünschten Ausgangspunkt und beginnen 

Sie bei gedrückter Maustaste zu zeichnen – wie mit einem Stift. Alternativ können 

Sie die Maustaste auch loslassen und eine andere Stelle anklicken, worauf eine 

gerade Linie dorthin gezeichnet wird. 

Wenn Sie die Kurve an ihrem Ausgangspunkt enden lassen, wird die Zeichnung 

automatisch zu einer geschlossenen Kurve. Möchten Sie hingegen eine offene Kur-

ve erhalten, müssen Sie die Zeichnung mit einem Doppelklick beenden. 

Kurve 

Mit dem Werkzeug  Kurve können Sie Bezierkurven zeichnen. 

Klicken Sie dazu auf den Ausgangspunkt und anschließend auf beliebig viele ande-

re Positionen. Die Kurve „folgt“ Ihren Mausklicks automatisch. 

Wenn Sie die Kurve an ihrem Ausgangspunkt enden lassen, wird die Zeichnung 

automatisch zu einer geschlossenen Kurve. Möchten Sie hingegen eine offene Kur-

ve erhalten, müssen Sie die Zeichnung mit einem Doppelklick beenden. 
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Pfeil 

Mit dem Werkzeug  Pfeil können Sie Pfeile zeichnen. 

Ziehen Sie dazu bei gedrückter Maustaste einfach eine Linie im Dokument.  

Tipp: Wenn Sie dabei die Umschalttaste (ª) gedrückt halten, ist die Linie auf 45°-

Winkel beschränkt. 

Anmerkung: Pfeile sind nichts weiter als gewöhnliche Linien (siehe oben), bei de-

nen in den Objekteigenschaften (Karteikarte Linien) für die Option Endpunkt 

eine Pfeilspitze gewählt wurde. 

Verbindung (gerade, gewinkelte und gekrümmte) 

Mit den drei Werkzeugen  Gerade Verbindung, Gewinkelte Verbin-

dung und Gekrümmte Verbindung können Sie Verbindungslinien zwischen zwei 

Objekten ziehen. Den Unterschied zwischen diesen drei Arten von Verbindungsli-

nien sehen Sie in folgender Abbildung: 

 

Wählen Sie eines dieser Werkzeuge und ziehen Sie dann den Mauszeiger bei ge-

drückter Maustaste vom einen Objekt zum anderen. Tipp: Es erscheinen hierbei 

kleine blaue Rechtecke am Objekt. Diese zeigen, an welchen Stellen des Objekts 

die Linie „andocken“ kann. 

Rechteck, abgerundetes Rechteck und Ellipse 

Mit den drei Werkzeugen  Rechteck, Abgerundetes Rechteck und 

Ellipse können Sie Rechtecke beziehungsweise Ellipsen zeichnen. 

Ziehen Sie dazu mit der Maus ein Rechteck auf, das die gewünschte Position und 

Größe hat. Tipp: Wenn Sie dabei die Umschalttaste (ª) gedrückt halten, entsteht 

ein Quadrat beziehungsweise ein Kreis. 
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Bei abgerundeten Rechtecken können Sie anschließend noch die Rundung der 

Ecken ändern. Selektieren Sie das Rechteck dazu, worauf gelbe Dreiecke an einer 

der Ecken erscheinen. Ziehen Sie an einem dieser Dreiecke, ändert sich die Run-

dung entsprechend. 

AutoForm 

Mit dem Werkzeug  AutoForm können Sie AutoFormen zeichnen. Das sind 

vorgefertigte Formen für die unterschiedlichsten Einsatzzwecke – Standardformen 

wie Rechtecke und Ellipsen sowie Pfeile, Symbole für Flussdiagramme, Sterne, 

Sprechblasen etc. 

Wenn Sie dieses Werkzeug aktivieren, erscheint ein Dialog. Wählen Sie darin aus, 

welche Art von AutoForm gezeichnet werden soll. Ziehen Sie dann mit der Maus 

ein Rechteck auf, das die gewünschte Position und Größe hat.  

Hinweis: In einigen Arten von AutoFormen werden gelbe Dreiecke angezeigt, 

wenn Sie diese selektieren. Ziehen Sie an einem dieser Dreiecke, ändert das Objekt 

bestimmte Parameter seines Aussehens. Bei Sternen lässt sich auf diese Weise bei-

spielsweise die Länge der Zacken ändern. 

Tipp: Sie können sogar Text innerhalb einer AutoForm eingeben – genau wie bei 

einem Textrahmen. Informationen dazu finden Sie im Abschnitt „Text zu Auto-

Formen hinzufügen“ ab Seite 251. 

TextArt 

Mit dem Werkzeug  TextArt können Sie TextArt-Objekte einfügen. Das sind 

Schriftzüge, die mit diversen Effekten versehen werden können. 

Wenn Sie dieses Werkzeug aktivieren, erscheint ein Dialog. Geben Sie darin den 

Text ein und klicken Sie auf Varianten, um einen der vorgefertigten Effekte aus-

zuwählen. Bestätigen Sie dann mit OK und ziehen Sie mit der Maus ein Rechteck 

auf, das die gewünschte Position und Größe hat.  

Text zu AutoFormen hinzufügen 

Sie können AutoFormen auf Wunsch Text hinzufügen. Dieser Text wird dann in-

nerhalb der AutoForm angezeigt – genau wie bei einem Textrahmen. 

Gehen Sie dazu wie folgt vor: 
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1. Selektieren Sie die gewünschte AutoForm. 

2. Rufen Sie mit einem Rechtsklick das Kontextmenü auf. 

3. Wählen Sie darin den Befehl Text hinzufügen. 

Nun blinkt die Schreibmarke in der AutoForm; Sie können jetzt also Text eingeben.  

Tipp: Es gibt noch einen schnelleren Weg, Text zu einer AutoForm hinzuzufü-

gen: Selektieren Sie die AutoForm dazu und beginnen Sie dann einfach mit dem 

Tippen. 

Mit den Befehlen Format > Zeichen und Format > Absatz lässt sich bei Bedarf 

die gewünschte Formatierung einstellen. 

Wenn Sie mit der Eingabe fertig sind, klicken Sie auf eine beliebige Stelle außer-

halb des Objekts. Möchten Sie den Text später noch einmal bearbeiten, selektieren 

Sie die AutoForm erneut und wählen den Befehl Text bearbeiten aus dem Kon-

textmenü. 

Wichtig: Wenn PlanMaker am unteren Rand des Textes einen roten Balken an-

zeigt, zeigt dies an, dass der Text nicht vollständig in den zur Verfügung stehen-

den Platz passt. Vergrößern Sie in diesem Falle also das Objekt oder verringern 

Sie die Textmenge. 

Hinweis: Die weiter vorne in diesem Kapitel vorgestellten Textrahmen sind übri-

gens nichts anderes als AutoFormen (in diesem Falle einfache Rechtecke), denen 

Text hinzugefügt wurde. Alle Informationen im Abschnitt „Textrahmen“ (ab Seite 

233) gelten also im gleichen Maße auch für AutoFormen, denen Text hinzugefügt 

wurde. 

Eigenschaften von Zeichnungen ändern 

Um die Eigenschaften einer Zeichnung zu bearbeiten, selektieren Sie diese zu-

nächst per Mausklick. Dann rufen Sie den Befehl Objekt > Eigenschaften auf, 

worauf ein entsprechender Dialog erscheint. 

Tipp: Sie können diesen Dialog auch über einen Doppelklick auf die Zeichnung 

aufrufen. 

In dem Dialog lassen sich folgende Einstellungen vornehmen: 
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Karteikarten Format, Füllung, Linien etc. 

Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie die-

nen zum Ändern folgender Einstellungen: 

 Format: Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. 

Siehe Abschnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 220. 

 Füllung: Hier können Sie die Füllung ändern. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Füllung“ ab Seite 221. 

 Linien: Hier können Sie den Linienstil der Linien, mit denen das Objekt ge-

zeichnet wird, ändern. Siehe Abschnitt „Objekt-Eigenschaften, Karteikarte Li-

nien“ ab Seite 224. 

 Schatten: Hier können Sie einen Schatten anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Schatten“ ab Seite 225. 

 3D: Hier können Sie einen 3D-Effekt anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte 3D“ ab Seite 226. 

 Effekte: Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt 

„Objekt-Eigenschaften, Karteikarte Effekte“ ab Seite 227. 

 Eigenschaften: Hier können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 228. 

Weiterhin erscheinen bei einigen Arten von Zeichnungen zusätzliche Karteikarten 

mit weiteren Optionen (siehe nachfolgende Seiten). 

Karteikarte AutoFormen (nur bei AutoFormen) 

Diese Karteikarte erscheint nur bei AutoFormen. 

Auf dieser Karteikarte können Sie dem Objekt eine andere AutoForm zuweisen, 

also beispielsweise aus einem Rechteck eine Sprechblase oder eine beliebige ande-

re Form machen. 

Wählen Sie dazu einfach die gewünschte AutoForm aus. 



 

254    Objekte Handbuch PlanMaker 

Karteikarte Innentext (nur bei AutoFormen, denen Text hinzugefügt 

wurde) 

Diese Karteikarte erscheint nur bei Textrahmen und bei AutoFormen, denen Text 

hinzugefügt wurde (siehe Abschnitt „Text zu AutoFormen hinzufügen“ ab Seite 

251).  

Auf dieser Karteikarte können Sie Einstellungen zu dem enthaltenen Text ändern. 

Verfügbare Optionen: 

 Rubrik Innenränder 

 Hier können Sie die Innenränder für den Text ändern. Schalten Sie die Option 

Automatisch ein, ermittelt das Programm die Ränder automatisch. 

 Rubrik Überlappende Objekte 

 Diese Einstellung bestimmt, was passieren soll, wenn sich das Objekt mit ei-

nem anderen Objekt überlappt.  

 Bei der Standardeinstellung Objekt ignorieren greift PlanMaker nicht ein. In 

dem sich überlappenden Bereich wird also der Inhalt beider Objekte übereinan-

der gedruckt.  

 Wählen Sie hingegen die Option Text umbrechen, wird der in diesem Objekt 

enthaltene Text automatisch neu umbrochen, so dass er die Überlappung um-

fließt. 

 Rubrik Drehen um ... 

 Hier können Sie den Text um den angegebenen Winkel drehen. 

 Rubrik Vertikale Ausrichtung 

 Diese Einstellung bestimmt, wie der enthaltene Text zwischen Ober- und Un-

terkante der Zeichnung ausgerichtet werden soll: 

Option Erläuterung 

Oben Der Text wird an der Oberkante des Objekts ausge-

richtet. (Dies ist die Standardeinstellung.) 

Unten Der Text wird an der Unterkante des Objekts ausge-

richtet. 

Zentriert Der Text wird zwischen Ober- und Unterkante 

zentriert. 
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Vertikaler Blocksatz Der Abstand zwischen den Textzeilen wird gleich-

mäßig so erweitert, dass der Text an der Oberkante 

des Objekts beginnt und an der Unterkante endet. 

Karteikarte Text (nur bei TextArt-Objekten) 

Diese Karteikarte erscheint nur bei TextArt-Objekten. 

Sie können darin den gewünschten Effekt auswählen sowie den anzuzeigenden 

Text eingeben und formatieren. 

Verfügbare Optionen: 

 Text 

 Hier können Sie den Text eintippen, der angezeigt werden soll. 

 Varianten 

 In dieser Liste können Sie auswählen, mit welchem Effekt der Text dargestellt 

werden soll. 

 Rubrik Schrift 

 Hier können Sie die Schriftart ändern und die Textauszeichnungen Fett und 

Kursiv ein-/ausschalten. 

 Aktivieren Sie die Option Gleiche Höhe, werden alle Buchstaben (inklusive 

Kleinbuchstaben) auf eine einheitliche Höhe gestreckt. 

 Rubrik Abstände 

 Die Option Zeichen ändert den Abstand zwischen den Zeichen. Bei Werten 

kleiner als 100% sind die Zeichen enger zusammen, bei Werten größer als 

100% weiter auseinander. 

 Die Option Zeilen ändert den Zeilenabstand. Dies wirkt sich nur auf Text aus, 

der aus mehreren Zeilen besteht. 

 Rubrik Ausrichtung 

 Hier können Sie die Ausrichtung des Textes ändern. Dies wirkt sich nur auf 

Text aus, der aus mehreren Zeilen besteht. 
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 Rubrik Platzierung 

 Aktivieren Sie die Option Vertikaler Text, werden die Buchstaben des Textes 

um 90° gedreht. 

Karteikarte Deformation (nur bei TextArt-Objekten) 

Diese Karteikarte erscheint nur bei TextArt-Objekten. 

Sie können darauf festlegen, mit welcher Art von Verzerrung der Schriftzug darge-

stellt werden soll. Wählen Sie dazu die gewünschte Art von Deformation aus der 

Liste. 
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Diagramme 

Mit Hilfe von Diagrammen können Sie die Zahlenwerte einer Tabelle grafisch dar-

stellen und somit die „nackten Zahlen“ anschaulicher und übersichtlicher präsen-

tieren. In diesem Kapitel erfahren Sie alles Wissenswerte über das Arbeiten mit 

Diagrammen. 

Folgende Themen werden darin behandelt: 

 Diagramme einfügen 

 Als erstes erfahren Sie, wie man ein Diagramm anlegt: Zellen mit den darzu-

stellenden Daten markieren, Objekt > Neuer Diagrammrahmen aufrufen, Di-

agrammtyp wählen, ein Rechteck in der gewünschten Größe aufziehen – fertig. 

 Diagramme bearbeiten 

 Der nächste Abschnitt enthält alle Informationen zum Bearbeiten von Dia-

grammen. Sie erfahren darin, wie man den Diagrammtyp und die Anordnung 

der Datenreihen ändert, wie man mit den einzelnen Diagrammelementen (Da-

tenreihen, Achsen, Legende etc.) arbeitet und wie man die allgemeinen Dia-

grammeigenschaften verändert. 

 Diagramme aktualisieren 

 Ein Diagramm holt sich die darzustellenden Werte stets aus den Zellen, die 

beim Erstellen des Diagramms markiert waren. Ändern sich also Werte in die-

sen Zellen, wird das Diagramm sofort aktualisiert. Bei Bedarf können Sie diese 

automatische Aktualisierung jedoch abschalten. 

 Diagramme auf ein anderes Arbeitsblatt verschieben 

 Mit dem Befehl Objekt > Diagramm > Position des Diagramms ändern 

können Sie ein Diagramm auf ein anderes Arbeitsblatt verschieben oder gar ein 

eigenes Diagramm-Arbeitsblatt dafür anlegen. Dieses enthält keinerlei Tabel-

lenzellen, sondern nur das Diagramm in voller Größe. 

 Diagramme als Grafik speichern 

 Der Befehl Objekt > Diagramm > Als Grafik speichern ermöglicht es Ihnen, 

ein Abbild eines Diagramms in einer Grafikdatei zu speichern. 



 

258    Diagramme Handbuch PlanMaker 

Diagramme einfügen 

Mit dem Befehl Objekt > Neuer Diagrammrahmen können Sie neue Diagramme 

in das Dokument einfügen. 

Gehen Sie dazu wie folgt vor: 

1. Markieren Sie die Zellen, deren Inhalte in dem Diagramm dargestellt werden 

sollen. 

 Tipp: Wenn Sie dabei Spalten- und Zeilenüberschriften mitmarkieren, werden 

diese zur Beschriftung der Achsen und der Legende herangezogen. 

2. Rufen Sie den Befehl Objekt > Neuer Diagrammrahmen auf. 

 Alternativ können Sie diesen Befehl auch über das Symbol  in der Funkti-

onsleiste aufrufen. 

3. Es erscheint ein Dialog, in dem Sie bestimmen können, welche Art von Dia-

gramm eingefügt werden soll. Wählen Sie dazu den gewünschten Diagramm-

typ und Untertyp. Informationen zu den einzelnen Diagrammtypen finden Sie 

im Abschnitt „Diagrammtyp ändern“ ab Seite 259. 

4. Ziehen Sie bei gedrückter Maustaste ein Rechteck in der Tabelle auf, um die 

Position und Größe des Diagramms festzulegen. 

 Oder: Wahlweise können Sie auch einfach nur an die Stelle klicken, an der die 

linke obere Ecke des Diagramms zu liegen kommen soll. Das Diagramm wird 

dann in einer Standardgröße eingefügt. 

5. Bestätigen Sie mit OK. 

Das Diagramm wird nun eingefügt. 

Diagramme bearbeiten 

In den nächsten Abschnitten erfahren Sie, wie Sie Diagramme bearbeiten können. 

Folgende Themen werden darin behandelt: 

 Diagrammtyp ändern (Seite 259) 

 Anordnung der Datenreihen ändern (Seite 265) 

 Diagrammelemente bearbeiten (Seite 265) 
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 Diagrammeigenschaften ändern (Seite 286) 

Hinweis: Grundlegende Informationen zum Arbeiten mit Objekten finden Sie au-

ßerdem im Abschnitt „Objekte“ ab Seite 213.  

Tipp: Verwenden der Diagrammleiste 

Wenn Sie ein Diagramm selektieren, erscheint ein nützlicher Helfer auf dem Bild-

schirm: die Diagrammleiste. 

 
Die Diagrammleiste 

Diese Leiste enthält Symbole für die wichtigsten Funktionen zum Bearbeiten von 

Diagrammen. Von links nach rechts: 

 Diagrammtyp auswählen 

 Untertyp auswählen 

 Liste aller Diagrammelemente, die das Diagramm enthält 

 Eigenschaften des gewählten Diagrammelements bearbeiten 

 Allgemeine Eigenschaften des gesamten Diagramms bearbeiten 

 Datenreihen spaltenweise anordnen 

 Datenreihen zeilenweise anordnen 

 Trendlinie hinzufügen 

 Legende ein-/ausblenden 

 Vertikale Gitternetzlinien ein-/ausblenden 

 Horizontale Gitternetzlinien ein-/ausblenden 

Informationen zur Funktion der einzelnen Symbole folgen auf den nächsten Seiten. 

Tipp: Wenn Sie mit der Maus auf eines dieser Symbole zeigen (ohne zu klicken), 

erscheint ein Infotext, der die Funktion des Symbols angibt. 

Diagrammtyp ändern 

Der Diagrammtyp bestimmt, in welcher Form die Daten im Diagramm dargestellt 

werden – zum Beispiel als Balken, als Linien, in Form eines Tortendiagramms etc. 

etc. 

Um den Diagrammtyp zu ändern, gehen Sie wie folgt vor. 

1. Selektieren Sie das Diagramm per Mausklick. 
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2. Rufen Sie den Befehl Objekt > Eigenschaften auf. 

3. Wechseln Sie auf die Karteikarte Diagrammtyp. 

4. Wählen Sie den gewünschten Diagrammtyp und Untertyp. 

Tipp: Alternativ können Sie die ersten beiden Symbole in der Diagrammleiste 

verwenden: das erste Symbol bestimmt den Diagrammtyp, das zweite den Unter-

typ (sofern vorhanden). 

Es gibt folgende Diagrammtypen: 

   Säulendiagramm  

Säulendiagramme eignen sich gut dazu, Werte miteinander zu vergleichen. Jeder 

Wert wird durch eine entsprechend hohe Säule dargestellt. 

   Balkendiagramm 

Balkendiagramme entsprechen Säulendiagrammen; die Werte werden allerdings 

nicht vertikal, sondern horizontal abgebildet. 

   Liniendiagramm 

Bei einem Liniendiagramm werden die Werte als Punkte und/oder Linien zwi-

schen diesen Punkten dargestellt. 

   Flächendiagramm 

Ein Flächendiagramm ist ein Liniendiagramm, bei dem der Zwischenraum zwi-

schen X-Achse und den einzelnen Linien ausgefüllt wird. 
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   XY-Punktdiagramm 

XY-Punktdiagramme stellen die Werte als Punkte und/oder Linien dar. Anders als 

bei Liniendiagrammen muss der Datenbereich dabei jedoch sowohl die x- als auch 

die y-Koordinaten der Datenpunkte enthalten. 

   Blasendiagramm 

Blasendiagramme stellen Daten als ausgefüllte Kreise („Blasen“) dar. Für ein 

Blasendiagramm verwendet man üblicherweise Datenreihen mit drei Werten: x-

Koordinate, y-Koordinate und Blasengröße. 

   Netzdiagramm 

Ein Netzdiagramm stellt die Werte auf einem Netz dar. Der Nullpunkt liegt dabei 

in der Mitte des Netzes. 

   Oberflächendiagramm 

Bei einem Oberflächendiagramm werden die Werte zu einer dreidimensional 

dargestellten Oberfläche verbunden. Bereiche, die in der gleichen Farbe gezeichnet 

werden, zeigen an, dass sie ähnliche Werte enthalten.  

Die darzustellenden Daten sollten dabei folgende Struktur haben: 

 

(Die z-Werte sind die Höhenwerte.) 
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   Kreisdiagramm (Tortendiagramm) 

Kreisdiagramme (oder Tortendiagramme) sind gut dazu geeignet, den Anteil 

von Einzelwerten am Gesamtwert darzustellen. Die Größe jedes einzelnen „Torten-

stücks“ zeigt das Verhältnis des Werts zur Gesamtsumme und zu den anderen Wer-

ten. 

Tipp: Sie können Werte besonders hervorheben, indem Sie das dazugehörige Tor-

tenstück aus der Torte herausziehen. Selektieren Sie das Tortenstück dazu und zie-

hen Sie es mit der Maus heraus. 

   Ringdiagramm 

Ringdiagramme zeigen, genau wie Kreisdiagramme, den Anteil von Einzelwerten 

am Gesamtwert. Im Gegensatz zu Kreisdiagramme können Sie jedoch nicht nur 

eine einzige Datenreihe darstellen, sondern beliebige viele Datenreihen (= Ringe). 

   Zylinder-, Kegel- und Pyramidendiagramm 

Zylinder-, Kegel- und Pyramidendiagramme entsprechen Säulen- und Balkendi-

agrammen. Anstelle von Säulen/Balken verwenden sie jedoch Zylinder, Kegel oder 

Pyramiden zur Darstellung der Werte. 

   Kursdiagramm 

Kursdiagramme (auch Börsendiagramme oder allgemein Hoch-Tief-

Diagramme genannt) eignen sich unter anderem zum Darstellen von Aktienkur-

sen. Es lassen sich darin beispielsweise der höchste Kurs, der tiefste Kurs und der 

Schlusskurs auf einen Blick ablesen. 

Es gibt folgende Untertypen: 

 Kursdiagramm (Höchst-, Tiefst-, Schlusskurs) 

 Stellt folgende Werte dar: 

 Höchstkurs, Tiefstkurs, Schlusskurs 

 Benötigt 3 Datenreihen in obiger Reihenfolge.  
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 Ein Beispiel für einen möglichen Aufbau der Daten (in Spalte A ist hier zusätz-

lich das Datum eingetragen): 

  

 Kursdiagramm (Eröffnungs-, Höchst-, Tiefst-, Schlusskurs) 

 Stellt folgende Werte dar: 

 Eröffnungskurs, Höchstkurs, Tiefstkurs, Schlusskurs 

 Benötigt 4 Datenreihen in obiger Reihenfolge. 

 Kursdiagramm (Volumen; Höchst-, Tiefst-, Schlusskurs) 

 Stellt folgende Werte dar: 

 Handelsvolumen, Höchstkurs, Tiefstkurs, Schlusskurs 

 Benötigt 4 Datenreihen in obiger Reihenfolge.  

 Das Handelsvolumen wird dabei in einer zusätzlichen Säule dargestellt, die 

über ihre eigene Größenachse verfügt. 

 Kursdiagramm (Volumen; Eröffnungs-, Höchst-, Tiefst-, Schlusskurs) 

 Stellt folgende Werte dar: 

 Handelsvolumen, Eröffnungskurs, Höchstkurs, Tiefstkurs, Schlusskurs 

 Benötigt 5 Datenreihen in obiger Reihenfolge.  

 Das Handelsvolumen wird dabei in einer zusätzlichen Säule dargestellt, die 

über ihre eigene Größenachse verfügt. 
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   Boxplot-Diagramm 

Boxplots (oder Box-Whisker-Plots) sind hilfreich bei der Datenanalyse in der 

Statistik. Ihre Anwendung hier im Detail zu erläutern würde den Rahmen dieses 

Handbuchs sprengen; bei Bedarf finden Sie weiterführende Informationen mit der 

Suchmaschine Ihrer Wahl. 

Es gibt zwei Untertypen: Horizontal und Vertikal. 

Abhängig davon, wie viele Datenreihen Sie dem Diagramm übergeben, werden 

unterschiedliche Varianten von Boxplots geliefert: 

(Hinweis: Welche Arten von Werten Sie in einem Boxplot darstellen möchten, ist 

völlig Ihnen überlassen. Die nachfolgenden Listen zeigen lediglich Beispiele.) 

 3 Punkte-Boxplot 

 Stellt beispielsweise folgende Werte dar: 

 Unteres Quartil (untere Kante der Box) 

 Median (Position des Strichs innerhalb der Box) 

 Oberes Quartil (obere Kante der Box) 

 Benötigt genau 3 Datenreihen in obiger Reihenfolge. 

 5 Punkte-Boxplot 

 Stellt beispielsweise folgende Werte dar: 

 Unterer Whisker (Linie unter der Box) 

 Unteres Quartil (untere Kante der Box) 

 Median (Position des Strichs innerhalb der Box) 

 Oberes Quartil (obere Kante der Box) 

 Oberer Whisker (Linie oberhalb der Box) 

 Benötigt genau 5 Datenreihen in obiger Reihenfolge. 

7 Punkte-Boxplot 

 Stellt beispielsweise folgende Werte dar: 

 Minimum (als einzelner Marker) 

 Unterer Whisker (Linie unter der Box) 

 Unteres Quartil (untere Kante der Box) 

 Median (Position des Strichs innerhalb der Box) 

 Oberes Quartil (obere Kante der Box) 

 Oberer Whisker (Linie oberhalb der Box) 
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 Maximum (als einzelner Marker) 

 Benötigt genau 7 Datenreihen in obiger Reihenfolge. 

Anordnung der Datenreihen ändern 

Mit den zwei Symbolen  in der Diagrammleiste können Sie festlegen, ob 

die darzustellenden Daten spaltenweise oder zeilenweise ausgewertet werden sol-

len: 

 Spaltenweise 

 Normalerweise ist das erste Symbol aktiv, das Diagramm liest die markierten 

Werte also Spalte für Spalte. Die Werte aus der ersten Spalte bilden demnach 

Datenreihe 1, die aus der zweiten Spalte Datenreihe 2 etc. 

 Zeilenweise 

 Aktivieren Sie hingegen das zweite Symbol, werden die Daten zeilenweise 

ausgelesen. Die Zuordnung der Zeilen/Spalten in der Tabelle zur X-Achse/Y-

Achse im Diagramm wird also vertauscht. 

Alternativ können Sie diese Einstellung auch über die Befehle Objekt > Dia-

gramm > Daten in Spalten beziehungsweise Daten in Zeilen festlegen.  

Diagrammelemente bearbeiten 

Jedes Diagramm besteht aus verschiedenen Elementen, also beispielsweise den 

Achsen, der Legende etc. Diese nennt man die Diagrammelemente. 

Welche Diagrammelemente es gibt, zeigt die folgende Abbildung: 
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Reihe 1, Reihe 2 etc. sind die Datenreihen des Diagramms. 

Bei dreidimensionalen Diagrammtypen kommen noch Elemente wie Bodenfläche, 

Wände etc. hinzu, die ebenfalls auf den nachfolgenden Seiten beschrieben werden. 

Jedes dieser Diagrammelemente lässt sich bei Bedarf einzeln selektieren und dann 

bearbeiten. 

Selektieren von Diagrammelementen 

Um ein Diagrammelement zu selektieren, selektieren Sie zunächst das Diagramm 

selbst (durch Anklicken) und klicken dann auf das gewünschte Diagrammelement.  

Klicken Sie beispielsweise auf eine Datenreihe, wird diese selektiert. Möchten Sie 

einen Einzelwert innerhalb dieser Datenreihe selektieren, klicken Sie anschließend 

den gewünschten Einzelwert an. 

Tipp: Alternativ können Sie Diagrammelemente selektieren, indem Sie die Liste 

der Elemente in der Mitte der Diagrammleiste aufklappen und darin das ge-

wünschte Element auswählen. 
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Position und Größe von Diagrammelementen ändern 

Bei machen Diagrammelementen lässt sich die Position und Größe ändern. Selek-

tieren Sie das Element dazu und ziehen Sie es anschließend an die gewünschte 

Position. Um die Größe zu ändern, ziehen Sie wie gewohnt an seinen Begren-

zungslinien. 

Eigenschaften von Diagrammelementen ändern 

Sie können nicht nur, wie später im Abschnitt „Diagrammeigenschaften ändern“ ab 

Seite 286 beschrieben, die Eigenschaften des Diagrammrahmens selbst ändern, 

sondern auch die Eigenschaften einzelner Diagrammelemente bearbeiten. 

Um beispielsweise die Eigenschaften der Legende des Diagramms zu ändern, se-

lektieren Sie die Legende und rechtsklicken darauf, um das Kontextmenü aufzuru-

fen. Wählen Sie darin dann nicht den Befehl Diagramm: Eigenschaften, sondern 

den Befehl Legende: Eigenschaften aus. Es erscheint ein Dialog, in dem Sie die 

gewünschten Einstellungen vornehmen können. 

Tipp: Alternativ können Sie diesen Dialog auch über das Symbol  in der Dia-

grammleiste aufrufen. 

Noch schneller: Darüber hinaus können Sie den Dialog mit einem Doppelklick 

auf das gewünschte Element öffnen. 

Welche Eigenschaften sich in diesem Dialog ändern lassen, hängt davon ab, für 

welche Art von Diagrammelement Sie ihn aufrufen. In den nächsten Abschnitten 

finden Sie Informationen zu allen verfügbaren Diagrammelementen und ihren je-

weiligen Eigenschaften: 

 Diagrammfläche (Seite 268) 

 Zeichnungsfläche (Seite 269) 

 Wände (nur bei dreidimensionalen Diagrammtypen) (Seite 270) 

 Bodenfläche (nur bei dreidimensionalen Diagrammtypen) (Seite 270) 

 Ecken (nur bei dreidimensionalen Diagrammtypen) (Seite 271) 

 Datenreihen und Datenpunkte (Seite 272) 

 Trendlinien (Seite 276) 

 Rubrikenachse (X-Achse) (Seite 278) 
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 Größenachse (Y-Achse) (Seite 280) 

 Reihenachse (Z-Achse) (Seite 282) 

 Gitternetzlinien (Seite 283) 

 Legende (Seite 285) 

Diagrammfläche 

Als Diagrammfläche wird die gesamte Fläche eines Diagrammrahmens bezeichnet. 

Eigenschaften bearbeiten: Um die Eigenschaften der Diagrammfläche zu ändern, 

selektieren Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen 

darin den Befehl Diagrammfläche: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Diagrammfläche aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 

Karteikarte Format 

 Rubrik Umrandung 

 Hier lässt sich das gesamte Diagramm mit einer Umrandung versehen. Wählen 

Sie dazu die gewünschte Linienart.  

 Wenn Sie die Option Schatten aktivieren, wird der Diagrammrahmen außer-

dem mit einem Schatten hinterlegt. Über die Schaltfläche Anpassen können Sie 

zusätzliche Einstellungen zum Aussehen des Schatteneffekts machen. 

 Rubrik Füllung 

 Hier können Sie die Füllung der Diagrammfläche ändern. Wählen Sie dazu die 

gewünschte Art von Füllung.  

 Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen kli-

cken, erscheint ein Dialog, über den Sie auch komplexere Füllungen (z.B. einen 

Farbverlauf) anbringen können. Die Bedienung dieses Dialogs ist im Abschnitt 

„Objekt-Eigenschaften, Karteikarte Füllung“ ab Seite 221 beschrieben. 
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Karteikarte Schrift 

Hier können Sie die Textformatierung für alle Diagrammelemente ändern. 

Wählen Sie dazu die gewünschte Schriftart, Schriftgröße, Ausrichtung etc. 

Wichtig: Änderungen wirken sich, wie gesagt, auf alle Diagrammelemente aus – 

auch wenn diese zuvor in einer anderen Schrift formatiert waren. 

Zeichnungsfläche 

Als Zeichnungsfläche wird der Bereich eines Diagramms bezeichnet, in dem die 

Datenreihen, die Achsen und die Gitternetzlinien gezeichnet werden. 

Eigenschaften bearbeiten: Um die Eigenschaften der Zeichnungsfläche zu ändern, 

selektieren Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen 

darin den Befehl Zeichnungsfläche: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Zeichnungsfläche aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 

Karteikarte Format 

 Rubrik Umrandung 

 Hier lässt sich die Zeichnungsfläche mit einer Umrandung versehen. Wählen 

Sie dazu die gewünschte Linienart.  

 Rubrik Füllung 

 Hier können Sie die Füllung der Zeichnungsfläche ändern. Wählen Sie dazu die 

gewünschte Art von Füllung.  

 Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen kli-

cken, erscheint ein Dialog, über den Sie auch komplexere Füllungen (z.B. einen 

Farbverlauf) anbringen können. Die Bedienung dieses Dialogs ist im Abschnitt 

„Objekt-Eigenschaften, Karteikarte Füllung“ ab Seite 221 beschrieben. 
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Wände (nur bei dreidimensionalen Diagrammtypen) 

Als Wände bezeichnet man die rückwärtigen Wände von Diagrammen, die einen 

dreidimensionalen Diagrammtyp verwenden. 

Eigenschaften bearbeiten: Um die Eigenschaften der Wände zu ändern, selektieren 

Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen darin den Be-

fehl Wände: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Wände aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 

Karteikarte Format 

 Rubrik Umrandung 

 Hier lassen sich die Wände mit einer Umrandung versehen. Wählen Sie dazu 

die gewünschte Linienart.  

 Rubrik Füllung 

 Hier können Sie die Füllung der Wände ändern. Wählen Sie dazu die ge-

wünschte Art von Füllung.  

 Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen kli-

cken, erscheint ein Dialog, über den Sie auch komplexere Füllungen (z.B. einen 

Farbverlauf) anbringen können. Die Bedienung dieses Dialogs ist im Abschnitt 

„Objekt-Eigenschaften, Karteikarte Füllung“ ab Seite 221 beschrieben. 

Karteikarte 3D-Ansicht 

Hier können Sie den 3D-Effekt für das gesamte Diagramm einstellen. Informatio-

nen dazu finden Sie im Abschnitt „Diagrammeigenschaften, Karteikarte 3D-

Ansicht“ ab Seite 290. 

Bodenfläche (nur bei dreidimensionalen Diagrammtypen) 

Als Bodenfläche bezeichnet man den Boden von Diagrammen, die einen dreidi-

mensionalen Diagrammtyp verwenden. 
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Eigenschaften bearbeiten: Um die Eigenschaften der Bodenfläche zu ändern, selek-

tieren Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen darin 

den Befehl Bodenfläche: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Bodenfläche aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 

Karteikarte Format 

 Rubrik Umrandung 

 Hier lässt sich die Bodenfläche mit einer Umrandung versehen. Wählen Sie 

dazu die gewünschte Linienart.  

 Rubrik Füllung 

 Hier können Sie die Füllung der Bodenfläche ändern. Wählen Sie dazu die ge-

wünschte Art von Füllung.  

 Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen kli-

cken, erscheint ein Dialog, über den Sie auch komplexere Füllungen (z.B. einen 

Farbverlauf) anbringen können. Die Bedienung dieses Dialogs ist im Abschnitt 

„Objekt-Eigenschaften, Karteikarte Füllung“ ab Seite 221 beschrieben. 

Karteikarte 3D-Ansicht 

Hier können Sie den 3D-Effekt für das gesamte Diagramm einstellen. Informatio-

nen dazu finden Sie im Abschnitt „Diagrammeigenschaften, Karteikarte 3D-

Ansicht“ ab Seite 290. 

Ecken (nur bei dreidimensionalen Diagrammtypen) 

Als Ecken bezeichnet man sämtliche Ecken von Diagrammen, die einen dreidi-

mensionalen Diagrammtyp verwenden. 

Eigenschaften bearbeiten: Um die Eigenschaften der Ecken zu ändern, selektieren Sie 

diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen darin den Befehl 

Ecken: Eigenschaften auf.  
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Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 

Karteikarte 3D-Ansicht 

Hier können Sie den 3D-Effekt für das gesamte Diagramm einstellen. Informatio-

nen dazu finden Sie im Abschnitt „Diagrammeigenschaften, Karteikarte 3D-

Ansicht“ ab Seite 290. 

Datenreihen und Datenpunkte 

Die Datenreihen sind die wichtigsten Bestandteile eines Diagramms. Sie stellen die 

auszuwertenden Daten dar – je nach gewähltem Diagrammtyp in Form von Säulen, 

Balken, Linien, Kreissegmenten etc. 

Eine Datenreihe ist die grafische Repräsentation von einer Spalte beziehungsweise 

einer Zeile der Zellwerte, auf denen das Diagramm basiert. Jede Datenreihe besteht 

wiederum aus mehreren Datenpunkten, also den einzelnen Zellwerten. 

Eigenschaften bearbeiten: Um die Eigenschaften von Datenreihen und -punkten zu 

ändern, gehen Sie wie folgt vor: 

 Klicken Sie auf einen beliebigen Datenpunkt einer Datenreihe, wird zunächst 

die gesamte Datenreihe selektiert. Mit dem Befehl Reihe: Eigenschaften im 

Kontextmenü können Sie nun die Eigenschaften dieser Datenreihe bearbeiten. 

 Klicken Sie den Datenpunkt jedoch erneut an, wird nur der einzelne Daten-

punkt selektiert. Der Befehl im Kontextmenü heißt dann dementsprechend Da-

tenpunkt: Eigenschaften. 

Es lassen sich folgende Einstellungen vornehmen: 

Karteikarte Format 

 Rubrik Umrandung (beziehungsweise Linie) 

 Hier lässt sich das Aussehen der Linien ändern, mit denen die Daten gezeichnet 

werden.  
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 Wenn Sie dabei die Option Schatten aktivieren, wird der Graph außerdem mit 

einem Schatten hinterlegt. Über die Schaltfläche Anpassen können Sie weitere 

Einstellungen zum Aussehen des Schatteneffekts machen. 

 Rubrik Füllung 

 Hier können Sie die Füllung der Datenreihen/Datenpunkte ändern. Wählen Sie 

dazu die gewünschte Art von Füllung.  

 Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen kli-

cken, erscheint ein Dialog, über den Sie auch komplexere Füllungen (z.B. einen 

Farbverlauf) anbringen können. Die Bedienung dieses Dialogs ist im Abschnitt 

„Objekt-Eigenschaften, Karteikarte Füllung“ ab Seite 221 beschrieben. 

 Rubrik Markierung (nur bei bestimmten Diagrammtypen verfügbar) 

 Bei Diagrammtypen, bei denen für die einzelnen Datenpunkte Markierungen 

gezeichnet werden, können Sie hier das Aussehen dieser Markierungen anpas-

sen. 

Karteikarte 3D-Format 

Hinweis: Die Optionen auf dieser Karteikarte sind nicht bei allen Diagrammty-

pen verfügbar.  

Mit Hilfe dieser Karteikarte können Sie die darzustellenden Datenpunkte mit Be-

leuchtungseffekten und abgerundeten Kanten versehen. 

 Material 

 Hier können Sie das Material wählen, das für die Darstellung der Datenpunkte 

simuliert werden soll. 

 Beleuchtung 

 Hier können Sie auswählen, welche Art von Beleuchtung simuliert werden soll. 

 Drehwinkel 

 Hier lässt sich der Winkel ändern, in dem das Licht einfallen soll. 

Tipp: Obige Effekte kommen besser zur Geltung, wenn Sie zusätzlich die 

nachfolgenden Optionen zum Abrunden der Kanten einsetzen. 
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 Rubrik Abgeschrägte Kanten 

 Hier können Sie die Kanten der grafischen Repräsentation der Datenpunkte 

abrunden lassen. Wenden Sie diese Optionen beispielsweise auf ein Balkendia-

gramm an, werden die Kanten der Balken abgerundet. Je größer der Wert, desto 

stärker die Abrundung. 

Karteikarte Datenbeschriftungen 

Auf dieser Karteikarte können Sie Datenpunkte mit Beschriftungen versehen, also 

beispielsweise den genauen Wert der Datenpunkte im Diagramm anzeigen lassen. 

 Rubrik Anzeige 

 Hier können Sie die Art der Beschriftung wählen. Voreingestellt ist die Option 

Keine, es wird also keine Beschriftung angezeigt. Wählen Sie beispielsweise 

die Option Wert anzeigen, wird der Wert der betreffenden Datenpunkte ange-

zeigt, bei der Option Datenpunkt anzeigen sein Name etc. 

 Legendensymbol bei Beschriftung 

 Wenn Sie diese Option aktivieren, werden vor den Beschriftungen die Legen-

densymbole der betreffenden Datenpunkte angezeigt – in der Regel also ein 

Kästchen in der Farbe des Datenpunkts. 

 Rubrik Platzierung 

 Hier können Sie bestimmen, wo die Beschriftung platziert werden soll (relativ 

zum jeweiligen Datenpunkt). 

Hinweis: Wenn Sie Datenpunkte mit einer Beschriftung versehen, sind diese Be-

schriftungen selbst ebenfalls im Diagramm anklickbar. Sie können also deren Ei-

genschaften verändern und beispielsweise eine andere Schriftart wählen oder den 

anzuzeigenden Text ändern.  

Auch hier gilt: 1x anklicken selektiert alle Beschriftungen einer Datenreihe, noch-

mals anklicken selektiert eine einzelne Beschriftung. 

Karteikarte Fehlerindikator Y 

Hinweis: Diese Karteikarte ist nur bei bestimmten zweidimensionalen Dia-

grammtypen (u.a. Säulen-, Balken und Liniendiagrammen) verfügbar. 
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Mit Hilfe dieser Karteikarte können Sie Fehlerindikatoren für die Datenpunkte 

einer Datenreihe zeichnen lassen. Diese stellen den möglichen/zulässigen Fehler 

der Werte in Form einer Linie mit einem Querstrich am Ende dar. 

 
Diagramm mit Fehlerindikatoren „Plus“ und „Minus“ 

Bestimmen Sie dazu in der Rubrik Anzeige, welche Art von Indikatoren angezeigt 

werden sollen: Plus zeichnet eine Indikatorlinie nach oben, Minus nach unten, 

Plus und Minus zeichnet beide Linien. 

Mit Anzeigen als... können Sie das Aussehen der Indikatorlinien bestimmen: mit 

oder ohne Querstrich am Ende. 

In der Rubrik Wert können Sie die Länge der Indikatorlinie ändern. Wählen Sie 

beispielsweise die Option Fest, hat die Linie immer die angegebene Länge, bei der 

Option Prozentual entspricht ihre Länge dem angegebenen prozentualen Anteil 

vom jeweiligen Y-Wert etc. 

Karteikarte Fehlerindikator X 

Hinweis: Diese Karteikarte ist nur bei XY-Punkt- und Blasendiagrammen ver-

fügbar. 

Entspricht Fehlerindikator Y (siehe oben), zeichnet jedoch Indikatorlinien für die 

X-Werte statt der Y-Werte. 

Karteikarte Hilfslinien 

Hinweis: Diese Karteikarte ist nur bei bestimmten zweidimensionalen Dia-

grammtypen (u.a. Säulen-, Balken und Liniendiagrammen) verfügbar. 

Mit Hilfe dieser Karteikarte können Sie verschiedene Hilfslinien im Diagramm 

einblenden lassen. Schalten Sie beispielsweise die Hilfslinie Durchschnitt ein, 



 

276    Diagramme Handbuch PlanMaker 

erscheint im Diagramm eine gestrichelte Linie, die anzeigt, wo der Durchschnitt 

der Werte dieser Datenreihe liegt. 

Sie können Hilfslinien für Durchschnitt, Standardabweichung und Mini-

mum/Maximum sowie eine Ausgleichsgerade (linearer Trend) aktivieren.  

Tipp: Über den Befehl Objekt > Diagramm > Trendlinie hinzufügen lassen sich 

bei Bedarf noch weitere Arten von Trendlinien im Diagramm einblenden. Siehe 

dazu Abschnitt „Trendlinien“ weiter unten. 

Karteikarte Optionen 

Auf dieser Karteikarte erscheinen je nach Diagrammtyp unterschiedliche Optionen 

zur Darstellung der Datenreihen/Datenpunkte. 

Trendlinien 

Hinweis: Trendlinien können nur in bestimmten zweidimensionalen Diagramm-

typen (u.a. Säulen-, Balken und Liniendiagrammen) verwendet werden. 

Sie können auf Wunsch zu jeder Datenreihe des Diagramms eine Trendlinie ein-

blenden lassen.  

Eine Trendlinie stellt den Trend der Datenreihe grafisch dar, zeigt also beispiels-

weise an, in welchem Maße die Werte im Mittel steigen/fallen. Sie können Trendli-

nien auch über die vorhandenen Daten hinaus verlängern lassen und so beispiels-

weise eine Prognose für zukünftige Werte erhalten. 

Die Position und Steigung der Trendlinie wird dabei mit Hilfe eines Regressions-

verfahrens ermittelt. 

Trendlinie hinzufügen: Um einer Datenreihe eine Trendlinie hinzuzufügen, selektie-

ren Sie diese Datenreihe, öffnen mit einem Rechtsklick das Kontextmenü und ru-

fen darin den Befehl Trendlinie hinzufügen auf. 

Tipp: Alternativ können Sie auch auf das Symbol  in der Diagrammleiste kli-

cken oder den Menübefehl Objekt > Diagramm > Trendlinie hinzufügen auf-

rufen. 

Trendlinie entfernen: Um eine Trendlinie wieder zu entfernen, selektieren Sie diese 

und drücken die Taste (Entf). 
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Eigenschaften bearbeiten: Um die Eigenschaften einer Trendlinie zu ändern, selektie-

ren Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen darin den 

Befehl Trendlinie: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Trendlinie aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 

Karteikarte Format 

 Rubrik Linie 

 Hier lässt sich das Aussehen der Linie ändern.  

Karteikarte Trend 

 Rubrik Typ 

 Hier können Sie den Typ des darzustellenden Trends wählen. Neben linearen 

Trends (also einfachen Ausgleichsgeraden) lassen sich beispielsweise auch ex-

ponentielle oder polynomische Trends darstellen. 

 Für die einzelnen Arten von Trends werden folgende Formeln verwendet: 

Linear: 
  y = ax + b 

  

Polynomisch: 
  y = b + c1x + c2x

2 + c3x
3 + ... + c6x

6
 
  

Exponentiell: 
  y = cebx   (e = Eulersche Zahl) 

  

Logarithmisch: 
  y = c ln(x) + b 

  

Potentiell: 
  y = cxb

 
  

Gleitender Durchschnitt: 
  f(xi) = (xi + xi-1 + xi-2 + ... + xi-n+1) / n 

  

 Basiert auf Reihe 

 Hier können Sie festlegen, für welche Datenreihe die Trendlinie gezeichnet 

werden soll. 

 Rubrik Trend 

 Hier können Sie die Trendlinie über die vorhandenen Datenpunkte hinaus ver-

längern. 
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 Sind beispielsweise 3 Datenpunkte vorhanden (zum Beispiel die Verkaufser-

gebnisse für das 1., 2. und 3. Jahr), können Sie bei Vorwärts eine 1 eingeben. 

Die Linie wird dann um eine zusätzliche Periode (= einen Datenpunkt) verlän-

gert, zeigt also eine Prognose für die Verkäufe im 4. Jahr an. 

 Schnittpunkt 

 Hier können Sie erzwingen, dass die Trendlinie die Y-Achse bei einer bestimm-

ten y-Koordinate schneiden soll. Nur bei bestimmten Arten von Trendlinien 

verfügbar. 

 Formel im Diagramm anzeigen 

 Blendet im Diagramm die Gleichung an, auf der die Trendlinie basiert. 

 Korrelationsmaß anzeigen 

 Blendet im Diagramm das Korrelationsmaß (Bestimmtheitsmaß) R
2
 ein. 

 Rubrik Name 

 Hier können Sie auf Wunsch den Namen der Trendlinie ändern. Dieser wird in 

der Legende angezeigt. Wählen Sie dazu die Option Benutzerdefiniert und 

tragen Sie den gewünschten Namen ein. 

Rubrikenachse (X-Achse) 

Die X-Achse eines Diagramms wird auch als Rubrikenachse bezeichnet. 

Achsen ein-/ausblenden: Um Achsen ein- oder auszublenden, selektieren Sie das Di-

agramm, rufen Objekt > Eigenschaften auf und wechseln auf die Karteikarte 

Elemente. Klicken Sie nun auf das Kontrollkästchen vor X-Achse, um beispiels-

weise die Anzeige der Rubrikenachse ein- oder auszuschalten. 

Eigenschaften bearbeiten: Um die Eigenschaften der Rubrikenachse zu ändern, selek-

tieren Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen darin 

den Befehl Rubrikenachse: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Achse aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 
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Karteikarte Format 

 Rubrik Linie 

 Hier können Sie das Aussehen der Linie ändern, mit der die Achse gezeichnet 

wird. 

 Rubriken Hauptstriche und Hilfsstriche 

 Hier können Sie bestimmen, ob zur Einteilung der Achse kleine Teilstriche an-

gezeigt werden sollen und wie diese aussehen sollen. 

 Rubrik Strichbeschriftungen 

 Hier können Sie bestimmen, ob bei den Teilstrichen Beschriftungen angezeigt 

werden sollen und wo diese platziert werden sollen. 

Karteikarte Skalierung 

Auf dieser Karteikarte können Sie die Skalierung der Achse ändern. 

Erläuterung: Unter den Rubriken eines Diagramm versteht man jeweils den ers-

ten, zweiten, dritten etc. Datenpunkt aller Datenreihen. 

 Rubrik Achse endet... 

 Diese Option bestimmt, wo die beiden Enden des sichtbaren Abschnitts der 

Achse liegen sollen: Bei den Rubriken oder Zwischen den Rubriken. 

 Rubrik Anzahl der Rubriken zwischen... 

 Standardmäßig macht PlanMaker bei jeder Rubrik einen Teilstrich auf der Ach-

se und versieht diesen mit einer Beschriftung. Über folgende Optionen können 

Sie diese Intervalle ändern: 

 Teilstrichen: Bestimmt, welche Rubriken mit einem Teilstrich versehen wer-

den. Geben Sie 1 ein, wird jede Rubrik mit einem Teilstrich versehen, bei 2 je-

de zweite etc.  

 Teilstrichbeschriftungen: Bestimmt, welche Teilstriche beschriftet werden 

sollen. Geben Sie 1 ein, wird jeder Teilstrich beschriftet, bei 2 jeder zweite 

Teilstrich etc. 

 Rubrik Schnittpunkt zwischen X- und Y-Achse 

 Mit dieser Option können Sie bestimmen, wo der Schnittpunkt zwischen X-

Achse (Rubrikenachse) und Y-Achse (Größenachse) liegen soll: Am unteren 
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Ende (also am Beginn der Rubrikenachse), Am oberen Ende (also am Ende 

der Rubrikenachse) oder bei einer bestimmten Rubrik. 

 Achse in umgekehrter Richtung 

 Wird diese Option aktiviert, läuft die Achse in umgekehrter Richtung. Dement-

sprechend wird auch die Reihenfolge der Rubriken umgekehrt; das Diagramm 

beginnt also mit der letzen Rubrik und endet mit der ersten Rubrik. 

Karteikarte Schrift 

Auf dieser Karteikarte können Sie die Formatierung der Beschriftungen der Achse 

ändern. 

Neben Schriftart, Schriftgröße und Textauszeichnungen können Sie auch die Aus-

richtung einstellen, die Beschriftungen drehen lassen und das Zahlenformat ändern. 

Größenachse (Y-Achse) 

Die Y-Achse eines Diagramms wird auch als Größenachse bezeichnet. 

Achsen ein-/ausblenden: Um Achsen ein- oder auszublenden, selektieren Sie das Di-

agramm, rufen Objekt > Eigenschaften auf und wechseln auf die Karteikarte 

Elemente. Klicken Sie nun auf das Kontrollkästchen vor Y-Achse, um beispiels-

weise die Anzeige der Größenachse ein- oder auszuschalten. 

Eigenschaften bearbeiten: Um die Eigenschaften der Größenachse zu ändern, selek-

tieren Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen darin 

den Befehl Größenachse: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Achse aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 

Karteikarte Format 

 Rubrik Linie 

 Hier können Sie das Aussehen der Linie ändern, mit der die Achse gezeichnet 

wird. 
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 Rubriken Hauptstriche und Hilfsstriche 

 Hier können Sie bestimmen, ob zur Einteilung der Achse kleine Teilstriche an-

gezeigt werden sollen und wie diese aussehen sollen. 

 Rubrik Strichbeschriftungen 

 Hier können Sie bestimmen, ob Achsenbeschriftungen angezeigt werden sollen 

und wo diese platziert werden sollen. 

Karteikarte Skalierung 

Auf dieser Karteikarte können Sie die Skalierung der Achse ändern. 

 Rubriken Minimalwert und Maximalwert 

 Diese Optionen bestimmen, wo der sichtbare Ausschnitt der Achse beginnen 

und wo er enden soll. Wählen Sie entweder die Option Auto, worauf PlanMa-

ker die geeignetsten Werte automatisch ermittelt oder wählen Sie Benutzerde-

finiert und geben den gewünschten Wert selbst ein. 

 Rubrik Schnittpunkt zwischen X- und Y-Achse 

 Mit dieser Option können Sie bestimmen, wo der Schnittpunkt zwischen X-

Achse (Rubrikenachse) und Y-Achse (Größenachse) liegen soll:  

 Bei Auto ermittelt PlanMaker den geeignetsten Wert automatisch, bei Maxi-

maler Wert wird die X-Achse am Ende der Y-Achse platziert, bei Benutzerde-

finiert bei dem von Ihnen angegebenen Y-Wert. 

 Rubrik Hauptintervall 

 Hier können Sie das Intervall für die Teilstriche und Beschriftungen auf der 

Achse festlegen. Bei der Option Auto ermittelt PlanMaker die geeignetsten 

Werte automatisch. 

 Rubrik Hilfsintervall 

 Hier können Sie das Intervall für die Hilfsstriche auf der Achse festlegen. Bei 

der Option Auto ermittelt PlanMaker die geeignetsten Werte automatisch. 

 Achse in umgekehrter Richtung 

 Wenn Sie diese Option aktivieren, läuft die Achse in umgekehrter Richtung. 

Bei einem Säulendiagramm werden die Säulen also beispielsweise nicht mehr 

von unten nach oben, sondern von oben nach unten gezeichnet. 
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 Logarithmische Skalierung 

 Wenn Sie diese Option aktivieren, wird die Achse nicht mehr linear, sondern 

logarithmisch (also in Zehnerpotenzen, z.B. 10, 100, 1000 etc.) eingeteilt. 

Karteikarte Schrift 

Auf dieser Karteikarte können Sie die Formatierung der Beschriftungen der Achse 

ändern. 

Neben Schriftart, Schriftgröße und Textauszeichnungen können Sie auch die Aus-

richtung einstellen, die Beschriftungen drehen lassen und das Zahlenformat ändern. 

Reihenachse (Z-Achse) 

Die Z-Achse eines Diagramms wird auch als Reihenachse bezeichnet. Sie ist nur 

bei bestimmten dreidimensionalen Diagrammtypen vorhanden. 

Achsen ein-/ausblenden: Um Achsen ein- oder auszublenden, selektieren Sie das Di-

agramm, rufen Objekt > Eigenschaften auf und wechseln auf die Karteikarte 

Elemente. Klicken Sie nun auf das Kontrollkästchen vor Z-Achse, um beispiels-

weise die Anzeige der Reihenachse ein- oder auszuschalten. 

Eigenschaften bearbeiten: Um die Eigenschaften der Reihenachse zu ändern, selek-

tieren Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen darin 

den Befehl Reihenachse: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Achse aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 

Karteikarte Format 

 Rubrik Linie 

 Hier können Sie das Aussehen der Linie ändern, mit der die Achse gezeichnet 

wird. 

 Rubriken Hauptstriche und Hilfsstriche 

 Hier können Sie bestimmen, ob zur Einteilung der Achse kleine Teilstriche an-

gezeigt werden sollen und wie diese aussehen sollen. 
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 Rubrik Strichbeschriftungen 

 Hier können Sie bestimmen, ob bei den Teilstrichen Beschriftungen angezeigt 

werden sollen und wo diese platziert werden sollen. 

Karteikarte Skalierung 

Auf dieser Karteikarte können Sie die Skalierung der Achse ändern. 

 Rubrik Anzahl der Reihen zwischen... 

 Standardmäßig macht PlanMaker bei jeder Datenreihe einen Teilstrich auf der 

Achse und versieht diesen mit einer Beschriftung. Über folgende Optionen 

können Sie diese Intervalle ändern: 

 Teilstrichen: Bestimmt, welche Datenreihen mit einem Teilstrich versehen 

werden. Geben Sie 1 ein, wird jede Reihe mit einem Teilstrich versehen, bei 2 

jede zweite etc.  

 Teilstrichbeschriftungen: Bestimmt, welche Teilstriche beschriftet werden 

sollen. Geben Sie 1 ein, wird jeder Teilstrich beschriftet, bei 2 jeder zweite 

Teilstrich etc. 

 Achse in umgekehrter Richtung 

 Wird diese Option aktiviert, läuft die Achse in umgekehrter Richtung. Dement-

sprechend wird auch die Reihenfolge der Datenreihen umgekehrt; das Dia-

gramm beginnt also mit der letzen Reihe und endet mit der ersten Reihe. 

Karteikarte Schrift 

Auf dieser Karteikarte können Sie die Formatierung der Beschriftungen der Achse 

ändern. 

Neben Schriftart, Schriftgröße und Textauszeichnungen können Sie auch die Aus-

richtung einstellen, die Beschriftungen drehen lassen und das Zahlenformat ändern. 

Gitternetzlinien 

Sie können zum besseren Ablesen der Werte in einem Diagramm Gitternetzlinien 

einblenden lassen. Unter Gitternetzlinien versteht man ein Netz aus Linien, die – 

ausgehend von einer der Achsen des Diagramms – über die Zeichnungsfläche lau-

fen. 
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Es gibt folgende Arten von Gitternetzen: 

 Das Hauptgitternetz besteht aus Linien, die jeweils von den Teilstrichen auf der 

Achse ausgehen. 

 Das Hilfsgitternetz unterteilt das Hauptgitternetz bei Bedarf in ein noch feineres 

Gitternetz. 

Gitternetzlinien ein-/ausblenden: Sie können Gitternetzlinien für jede Achse getrennt 

einschalten. Selektieren Sie dazu das Diagramm, rufen Sie Objekt > Eigenschaf-

ten auf, wechseln Sie auf die Karteikarte Elemente und schalten Sie bei den ge-

wünschten Achsen die Option Hauptgitternetz und/oder Hilfsgitternetz ein. 

Tipp: Alternativ können Sie auch die beiden Symbole  in der Diagramm-

leiste oder die Befehle Objekt > Diagramm > Vertikale Gitternetzlinien an-

zeigen beziehungsweise Horizontale Gitternetzlinien anzeigen verwenden, um 

Gitternetzlinien ein-/auszuschalten. 

Eigenschaften bearbeiten: Um beispielsweise die Eigenschaften der Hauptgitternetz-

linien der Größenachse zu ändern, selektieren Sie eine dieser Linien, öffnen mit 

einem Rechtsklick das Kontextmenü und rufen darin den Befehl Hauptgitternetz 

des Größenachse: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 

Karteikarte Format 

 Rubrik Linie 

 Hier können Sie das Aussehen der Gitternetzlinien anpassen. 

Skalierung der Gitternetzlinien ändern 

Um die Abstände zwischen den Gitternetzlinien zu ändern, selektieren Sie die zu-

gehörige Achse, rufen deren Eigenschaften auf und nehmen die gewünschten Än-

derungen auf der Karteikarte Skalierung vor. 
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Legende 

Auf Wunsch können Sie im Diagramm eine Legende einblenden. Dies ist ein klei-

ner Kasten, in dem angezeigt wird, welche Datenreihen in welcher Farbe/Muste-

rung dargestellt werden. 

Legende ein-/ausblenden: Selektieren Sie das Diagramm, rufen Sie Objekt > Eigen-

schaften auf und wechseln Sie auf die Karteikarte Elemente. Nun können Sie über 

die Option Legende bestimmen, wo die Legende positioniert werden soll. Wenn 

Sie die Option Benutzerdefiniert wählen, lässt sich die Legende frei mit der Maus 

verschieben. Wählen Sie die Option Keine, wird keine Legende mehr angezeigt. 

Tipp: Alternativ können Sie die Legende auch über das Symbol  in der Dia-

grammleiste oder über den Befehl Objekt > Diagramm > Legende anzeigen 

ein-/ausschalten. 

Eigenschaften bearbeiten: Um die Eigenschaften der Legende zu ändern, selektieren 

Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen darin den Be-

fehl Diagrammfläche: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Legende aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 

Karteikarte Format 

 Rubrik Umrandung 

 Hier lässt sich die Linienart für die Umrandung der Legende ändern. 

 Wenn Sie die Option Schatten aktivieren, wird die Legende zusätzlich mit ei-

nem Schatten hinterlegt.  

 Rubrik Füllung 

 Hier können Sie die Füllung der Legende ändern. Wählen Sie dazu die ge-

wünschte Art von Füllung.  

 Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen kli-

cken, erscheint ein Dialog, über den Sie auch komplexere Füllungen (z.B. einen 

Farbverlauf) anbringen können. Die Bedienung dieses Dialogs ist im Abschnitt 

„Objekt-Eigenschaften, Karteikarte Füllung“ ab Seite 221 beschrieben. 
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Karteikarte Schrift 

Auf dieser Karteikarte können Sie das Zeichenformat für die Legende wählen 

(Schriftart, Schriftgröße und Textauszeichnungen). 

Karteikarte Legende 

Hier können Sie bestimmen, an welcher Position die Legende angezeigt werden 

soll. 

Wenn Sie die Option Benutzerdefiniert wählen, lässt sich die Legende nach Be-

lieben mit der Maus verschieben.  

Wenn Sie Keine wählen, wird die Legende ausgeblendet. 

Diagrammeigenschaften ändern 

In den vorhergehenden Abschnitten wurde beschrieben, wie sie die Eigenschaften 

einzelner Elemente eines Diagramms bearbeiten. In diesem Abschnitt geht es um 

die Eigenschaften des Diagrammrahmens selbst – die Diagrammeigenschaften.  

Um die Diagrammeigenschaften zu ändern, selektieren Sie das Diagramm per 

Mausklick und rufen den Befehl Objekt > Eigenschaften auf. 

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste aufrufen. 

Welche Einstellungen sich hier vornehmen lassen, erfahren Sie auf den nächsten 

Seiten. 

Diagrammeigenschaften, Karteikarte Format 

Auf der Karteikarte Format können Sie die Größe und Position von Diagrammen 

ändern. 

Informationen dazu finden Sie im Abschnitt „Objekt-Eigenschaften, Karteikarte 

Format“ (ab Seite 220). 



 

Handbuch PlanMaker Diagramme    287 

Diagrammeigenschaften, Karteikarte Eigenschaften 

Auf der Karteikarte Eigenschaften können Sie allgemeine Eigenschaften von Dia-

grammen ändern.  

Informationen dazu finden Sie im Abschnitt „Objekt-Eigenschaften, Karteikarte 

Eigenschaften“ (ab Seite 228). 

Diagrammeigenschaften, Karteikarte Diagrammtyp 

Auf der Karteikarte Diagrammtyp können Sie den Diagrammtyp für das Dia-

gramm auswählen: 

Wählen Sie zunächst links den gewünschten Diagrammtyp und dann rechts den 

gewünschten Untertyp. 

Informationen zu den verfügbaren Diagrammtypen finden Sie im Abschnitt 

„Diagrammtyp ändern“ ab Seite 259. 

Diagrammeigenschaften, Karteikarte Datenquelle 

Auf der Karteikarte Datenquelle können Sie Einstellungen zu dem Datenbereich 

vornehmen, auf dem das Diagramm basiert: 

 Datenbereich 

 Hier können Sie festlegen, welchen Zellbereich der Tabelle das Diagramm dar-

stellen soll. Standardmäßig wird der Zellbereich verwendet, den Sie beim Er-

stellen des Diagramms markiert hatten. Normalerweise müssen Sie hier also 

nichts ändern. 

 Rubrik Anordnung der Daten 

 Hier können Sie festlegen, ob der gewählte Datenbereich im Diagramm spal-

tenweise oder zeilenweise dargestellt werden soll. Siehe auch Abschnitt 

„Anordnung der Datenreihen ändern“ ab Seite 265. 

 Rubrik Datenbereich enthält 

 Hier können Sie angeben, welche Arten von Daten der Datenbereich enthält. 

 Tipp: Besteht die oberste Zeile des Datenbereichs aus Überschriften (für die 

jeweils darunter liegenden Werte), so sollte die Option Namen eingeschaltet 
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werden. PlanMaker beschriftet die Datenreihen im Diagramm dann automatisch 

mit diesen Überschriften. 

 Auch verborgene Zellen verwenden 

 Wenn der Datenbereich Zellen enthält, die verborgen wurden, werden diese 

normalerweise nicht im Diagramm dargestellt. Schalten Sie diese Option ein, 

wenn Sie möchten, dass auch verborgene Zellen dargestellt werden sollen. 

Diagrammeigenschaften, Karteikarte Datenreihen 

Auf der Karteikarte Datenreihen können Sie Einstellungen zu den Datenreihen des 

Diagramms vornehmen. 

Wählen Sie dazu in der Liste Datenreihen die Datenreihe aus, deren Einstellungen 

Sie verändern möchten, und nehmen Sie dann die gewünschten Einstellungen vor. 

 Datenreihen 

 In der Liste Datenreihen sind alle Datenreihen aufgelistet, die das Diagramm 

verwendet. Sie können darin die Datenreihe wählen, deren Einstellungen geän-

dert werden sollen.  

 Mit Hilfe der Pfeil-Schaltflächen rechts der Liste können Sie die Reihenfolge 

der Datenreihen bei Bedarf ändern. Weiterhin können Sie mit den Schaltflächen 

Hinzufügen und Löschen Datenreihen hinzufügen beziehungsweise entfernen. 

 Rubrik Datenquellen 

 Hier lässt sich bestimmen, aus welchen Daten sich die gewählte Datenreihe 

aufbaut. Diese Felder werden anhand des Zellbereichs, den Sie von dem Einfü-

gen des Diagramms markiert hatten, automatisch ausgefüllt. Bei Bedarf können 

sie jedoch verändert werden. Es gibt folgende Optionen: 

 Name: Hier lässt sich der Name der Datenreihe festlegen. Dies kann ein Zell-

bezug auf eine Zelle sein, die den Namen enthält, oder einfach ein fest einge-

tragener Text. Dieses Feld kann auch leer gelassen werden, worauf PlanMaker 

der Datenreihe einen automatisch erzeugten Namen gibt (z.B. „Reihe 1“, „Rei-

he 2“ etc.). 

 Y-Werte: Hier lässt sich bestimmen, aus welchem Zellbereich die Datenreihe 

die Y-Werte für die Datenpunkte beziehen soll. 

 Erläuterung: Bei den meisten Diagrammtypen sind die Y-Werte die Werte, die 

im Diagramm dargestellt werden sollen. Sie bestimmen also beispielsweise die 

Höhe der Säule, die im Diagramm gezeichnet wird. Eine Ausnahme bilden XY-
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Punktdiagramme und Blasendiagramme: hier bestimmen die Y-Werte die Y-

Koordinate der Datenpunkte. 

 X-Werte: Analog zur Option Y-Werte lässt sich hier bestimmen, aus welchem 

Zellbereich die X-Werte für die Datenreihe stammen sollen. 

 Erläuterung: Bei den meisten Diagrammtypen werden die X-Werte lediglich 

zur Beschriftung der Rubrikenachse (X-Achse) verwendet. Eine Ausnahme bil-

den XY-Punktdiagramme und Blasendiagramme: hier bestimmen die X-Werte 

die X-Koordinate der Datenpunkte. 

 Blasengrößen: Bei Blasendiagrammen gibt es neben X- und Y-Werten noch 

einen dritten Parameter: die Größe der Blasen für die einzelnen Datenpunkte. 

Geben Sie dazu einen Zellbezug auf die Zellen ein, die diese Werte enthalten. 

Wird dieses Feld leer gelassen, werden alle Blasen in der gleichen Größe ge-

zeichnet. 

 Rubrik Diese Datenreihe darstellen als 

 Hier können Sie festlegen, wie die Datenreihe dargestellt werden soll. Haben 

Sie als Diagrammtyp beispielsweise ein Säulendiagramm gewählt, möchten 

aber, dass eine bestimmte Datenreihe in Form von Linien dargestellt wird, so 

wählen Sie für diese Datenreihe die Option Linien. 

 Sekundäre Achse für diese Datenreihe 

 Aktivieren Sie diese Option, wird dem Diagramm für diese Datenreihe eine 

sekundäre Größenachse (Y-Achse) hinzugefügt. Die sekundäre Größenachse 

kann einen anderen Maßstab als die primäre Größenachse haben. 

 Erläuterung: Das Darstellen von bestimmten Datenreihen auf einer sekundären 

Achse ist sinnvoll, wenn diese Datenreihen eine Achse mit einem völlig ande-

ren Maßstab benötigen, da sie beispielsweise erheblich größere Werte enthalten 

als die anderen Datenreihen. 

Diagrammeigenschaften, Karteikarte Elemente 

Auf der Karteikarte Elemente können Sie die verschiedenen Diagrammelemente 

ein-/ausblenden und beschriften: 

 Diagrammtitel 

 Hier können Sie dem Diagramm einen Titel geben. Dieser wird oberhalb des 

Diagramms angezeigt. 
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 Rubrik Primäre Achsen 

 Hier können Sie Einstellungen zu den primären Achsen vornehmen: 

 Mit dem Kontrollkästchen vor der jeweiligen Achse können Sie die Anzeige 

dieser Achse ein-/ausschalten. 

 Rechts daneben können Sie der Achse einen Namen geben. Dieser wird unter-

halb/neben der Achse angezeigt. 

 Die Optionen Hauptgitternetz und Hilfsgitternetz bestimmen, ob Gitternetz-

linien im Hintergrund des Diagramms angezeigt werden sollen. Diese erleich-

tern das Ablesen der Werte. Weitere Informationen dazu finden Sie im Ab-

schnitt „Gitternetzlinien“ ab Seite 283. 

 Rubrik Sekundäre Achsen 

 Sofern das Diagramm über sekundäre Achsen verfügt, können Sie diese hier, 

analog zu den primären Achsen (siehe oben), konfigurieren. 

 Legende 

 Hier können Sie die Position der Legende bestimmen. Dies ist ein kleiner Kas-

ten, in dem angezeigt wird, welche Datenreihen in welcher Farbe/Musterung 

dargestellt werden. Weitere Informationen dazu finden Sie im Abschnitt 

„Legende“ ab Seite 285. 

Diagrammeigenschaften, Karteikarte 3D-Ansicht 

Hinweis: Diese Karteikarte erscheint nur bei dreidimensionalen Diagrammtypen. 

Auf der Karteikarte 3D-Ansicht können Sie (bei dreidimensionalen Diagrammty-

pen) den 3D-Effekt für das Diagramm verändern. 

 Drehwinkel und Betrachtungswinkel 

 Hier können Sie den Blickwinkel (in Grad) einstellen, von dem aus der Be-

trachter das Diagramm sieht. Drehwinkel dreht den Betrachter um die vertikale 

Achse, Betrachtungswinkel um die horizontale Achse. 

 Perspektive 

 Ist diese Option aktiviert, wird das Diagramm perspektivisch verzerrt. Daneben 

können Sie die Stärke der Verzerrung angeben (von 0 bis 100%). 



 

Handbuch PlanMaker Diagramme    291 

 Höhe und Tiefe 

 Hier können Sie die Höhe und Tiefe des Diagramms (in Prozent der Original-

maße) ändern. 

Diagrammeigenschaften, Karteikarte Netz 

Hinweis: Diese Karteikarte erscheint nur bei Netzdiagrammen. 

Auf der Karteikarte Netz können Sie (bei Netzdiagrammen) zusätzliche Einstel-

lungen zur Darstellung des Diagramms vornehmen. 

 Startwinkel 

 Rotiert das Diagramm um den angegebenen Winkel. 

 Orientierung 

 Bestimmt, ob die Werte im Uhrzeigersinn oder gegen den Uhrzeigersinn einge-

zeichnet werden sollen. 

 Netz abrunden 

 Zeichnet das Diagramm nicht mit Linien sondern mit Kreissegmenten zwischen 

den Achsen. 

 Polarkoordinaten 

 Verwendet Polarkoordinaten statt kartesischer Koordinaten. Nur verfügbar, 

wenn Netz abrunden (siehe oben) aktiviert ist. 

 Setzen Sie dabei den Winkel zwischen Achsen auf x, wird alle x Grad eine 

Achse eingezeichnet. 

 Setzen Sie den Winkel zwischen Achsenbeschriftungen auf x, wird alle x 

Grad eine Achsenbeschriftung eingezeichnet. 

 Zeichnungsfläche auf Netzform begrenzen 

 Ist diese Option aktiviert, wird nur die Fläche innerhalb des Netzes mit der 

Füllung der Zeichnungsfläche gefüllt. Ist sie deaktiviert, wird das gesamte 

Rechteck um das Netz herum gefüllt. 
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Diagramme aktualisieren 

Ein Diagramm holt sich die darzustellenden Werte stets aus den Zellen, die beim 

Erstellen des Diagramms markiert waren. Ändern sich also Werte in diesen Zellen, 

wird das Diagramm automatisch aktualisiert und gibt sofort die veränderten Werte 

wieder. 

Automatische Aktualisierung von Diagrammen deaktivieren 

Bei Bedarf können Sie diese automatische Aktualisierung deaktivieren. Rufen Sie 

dazu den Befehl Datei > Eigenschaften auf, wechseln Sie auf die Karteikarte Be-

rechnen und deaktivieren Sie die Option Automatisch aktualisieren in der 

Rubrik Diagramme. 

Ist diese Option abgeschaltet, werden die Diagramme im aktuellen Dokument nur 

dann aktualisiert, wenn Sie den Befehl Weiteres > Diagramme aktualisieren 

(Tastenkürzel: (F8)) aufrufen. 

Diagramme auf ein anderes Arbeitsblatt 

verschieben 

Wenn Sie ein neues Diagramm anlegen, wird dieses stets als Objekt in das aktuelle 

Arbeitsblatt eingefügt. Sie können die Position eines Diagramms aber jederzeit 

ändern: 

Um ein Diagramm innerhalb des aktuellen Arbeitsblatts zu verschieben, klicken 

Sie es einfach an und ziehen es mit der Maus an die gewünschte Position. 

Wenn Sie das Diagramm hingegen auf ein anderes Arbeitsblatt verschieben möch-

ten, gehen Sie wie folgt vor: 

1. Selektieren Sie das gewünschte Diagramm per Mausklick. 

2. Rufen Sie den Befehl Objekt > Diagramm > Position des Diagramms än-

dernauf. 

3. Treffen Sie die gewünschte Wahl (siehe unten) und bestätigen Sie mit OK. 

Das Diagramm wird daraufhin entsprechend verschoben. 
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Verfügbare Optionen: 

 Als neues Blatt 

 Wählen Sie diese Option, erhält das Diagramm sein eigenes Diagramm-

Arbeitsblatt. Dazu entfernt PlanMaker das Diagramm aus dem aktuellen Blatt, 

legt ein neues Diagramm-Arbeitsblatt an und fügt das Diagramm darin ein. 

 Ein „Diagramm-Arbeitsblatt“ ist eine besondere Art von Arbeitsblatt, das kei-

nerlei Tabellenzellen, sondern ausschließlich das Diagramm in seiner vollen 

Größe enthält. Es stehen darin auch nur Befehle zum Bearbeiten von Diagram-

men zur Verfügung. 

 Als Objekt in ... 

 Wählen Sie hingegen diese Option, erscheint das Diagramm wie üblich als ein 

Objekt im gewählten Arbeitsblatt. 

Diagramme als Grafik speichern 

Sie können jederzeit ein Abbild eines Diagramms als Grafikdatei speichern. Dies 

erleichtert die Weitergabe an andere und das Einfügen in Webseiten oder andere 

Dokumente. 

Gehen Sie dazu wie folgt vor: 

1. Selektieren Sie das gewünschte Diagramm per Mausklick. 

2. Rufen Sie den Befehl Objekt > Diagramm > Als Grafik speichernauf. 

3. Wählen Sie in der Liste Dateityp das gewünschte Grafikformat. 

 Tipp: Das PNG-Format ist hier immer eine gute Wahl, da es eine gute und dabei völlig verlustfreie 

Komprimierung bietet. 

4. Geben Sie den Dateinamen an, unter dem die Grafik gespeichert werden soll, 

und bestätigen Sie mit OK. 

5. Es erscheint ein weiterer Dialog. Wählen Sie darin die gewünschte Auflösung 

für die Grafik oder tragen Sie eigene Werte für die Breite und Höhe von Hand 

ein. Bestätigen Sie dann mit OK. 

PlanMaker legt nun eine entsprechende Grafikdatei mit einem Abbild des Dia-

gramms an.  
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Formulare 

Sie können in Ihre Tabellen Formularobjekte einfügen und auf diese Weise Formu-

lare herstellen. 

 

Es gibt folgende Arten von Formularobjekten: 

 Kontrollkästchen zum Ankreuzen 

 Optionsfelder zur Auswahl einer von mehreren Alternativen 

 Auswahllisten zur Auswahl aus einer aufklappbaren Liste 

 Listen zur Auswahl aus einer Liste 
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 Schaltflächen zum Anklicken 

 Drehfelder zum Erhöhen/Reduzieren von Werten per Mausklick 

 Bildlaufleisten zum Erhöhen/Reduzieren von Werten per Mausklick 

 Bezeichnungen für unveränderliche Beschriftungen 

 Gruppenfelder zum optischen Zusammenfassen zusammengehörender Optio-

nen 

Formularobjekte haben stets eine Ausgabezelle. In dieser Tabellenzelle wird der 

Wert abgelegt, den das Formularobjekt zurückliefert. Welche Zelle dies ist, können 

Sie für jedes Formularobjekt getrennt festlegen. 

Fügen Sie beispielsweise eine Liste mit einigen Einträgen ein, erscheint in der 

Ausgabezelle eine 1, wenn der erste Eintrag angeklickt wurde, eine 2, wenn der 

zweite Eintrag gewählt wurde etc. 

Ausführliche Informationen zum Arbeiten mit Formularen finden Sie in diesem 

Kapitel. Es besteht aus folgenden Abschnitten: 

 Formularobjekte verwenden 

 Der erste Abschnitt enthält allgemeine Informationen zum Arbeiten mit Formu-

larobjekten. Sie erfahren darin, wie man Formularobjekte einfügt, bearbeitet 

und auswertet. 

 Formularobjekte im Detail 

 Der zweite Abschnitt befasst sich mit den einzelnen Arten von Formularobjek-

ten im Detail. 

Formularobjekte verwenden 

In den nächsten Abschnitten finden Sie zunächst allgemeine Informationen zum 

Arbeiten mit Formularobjekten: 

 Formularobjekte einfügen 

 Formularobjekte bearbeiten 

 Formularobjekte bedienen und auswerten 

 Formularobjekte und Excel-Makros und -Scripts 
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Danach, im Abschnitt „Formularobjekte im Detail“, stellen wir Ihnen die einzelnen 

Arten von Formularobjekten ausführlich vor. 

Formularobjekte einfügen 

Das Einfügen von Formularobjekten unterscheidet sich nicht wesentlich vom Ein-

fügen anderer Arten von Objekten (siehe dazu auch Kapitel „Objekte“ ab Seite 

213). 

Um ein Formularobjekt einzufügen, gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Objekt > Neues Formularobjekt auf.  

2. Es öffnet sich ein Untermenü. Wählen Sie darin die gewünschte Art von Ob-

jekt. 

3. Ziehen Sie mit der Maus im Dokument ein Rechteck auf, das die gewünschte 

Position und Größe hat. 

 Oder: Wahlweise können Sie auch einfach nur an die Stelle klicken, an der die 

linke obere Ecke des Objekts zu liegen kommen soll. Das Objekt wird dann in 

einer Standardgröße eingefügt. 

Das Objekt wird nun eingefügt. 

Weitere Informationen zu den einzelnen Arten von Formularobjekten finden Sie im 

Abschnitt „Formularobjekte im Detail“ ab Seite 299. 

Verwenden der Formularleiste 

Sie können zum Einfügen von Formularobjekten auch die Formularleiste verwen-

den. Um diese ein-/auszuschalten, rufen Sie den Befehl Ansicht > Symbolleisten 

auf und klicken auf das Kästchen vor Formular. 

 

Die Formularleiste enthält folgende Symbole (von links nach rechts): 

 Textrahmen einfügen 

 Kontrollkästchen einfügen 

 Optionsfeld einfügen 

 Auswahlliste einfügen 

 Liste einfügen 
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 Schaltfläche einfügen 

 Drehfeld einfügen 

 Bildlaufleiste einfügen 

 Bezeichnung einfügen 

 Gruppenfeld einfügen 

 Zelle schützen ein/aus (siehe auch Abschnitt „Blattschutz“ ab Seite 355) 

 Blattschutz ein/aus (siehe auch Abschnitt „Blattschutz“ ab Seite 355) 

Tipp: Wenn Sie mit der Maus auf eines der Symbole zeigen (ohne zu klicken), 

erscheint ein Infotext, der die Funktion des Symbols angibt. 

Formularobjekte bearbeiten 

Das Bearbeiten von Formularobjekten unterscheidet sich nicht wesentlich vom 

Arbeiten mit anderen Arten von Objekten (siehe dazu Kapitel „Objekte“ ab Seite 

213). 

Einen wichtigen Unterschied gibt es allerdings: 

Wichtig: Formularobjekte können nicht per Linksklick mit der Maus selektiert 

werden. Um ein Formularobjekt zu selektieren, klicken Sie mit der rechten 

Maustaste darauf.  

Alternativ können Sie auch mit Ansicht > Objektmodus in den Objektmodus 

wechseln, in dem sich auch Formularobjekte per Linksklick selektieren lassen. 

Wenn Sie ein Formularobjekt selektiert haben, können Sie es wie jede andere Art 

von Objekt bearbeiten – also beispielsweise mit der Maus verschieben, seine Größe 

ändern, mit dem Befehl Objekt > Eigenschaften seine Eigenschaften modifizieren 

etc. 

Informationen zu den Eigenschaften von Formularobjekten finden Sie im Abschnitt 

„Formularobjekte im Detail“ ab Seite 299. 

Formularobjekte bedienen und auswerten 

Die Bedienung von Formularobjekten entspricht der von Bedienungselementen in 

Dialogfenstern. In Kontrollkästchen lässt sich beispielsweise per Mausklick ein 

Häkchen setzen/entfernen. In Listen kann per Mausklick einer der Einträge ausge-

wählt werden etc. 
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Auswerten von Formularobjekten 

Das Auswerten von Formularobjekten geschieht über die Ausgabezelle des Ob-

jekts. In dieser Tabellenzelle wird der Wert ausgegeben, den das Formularobjekt 

zurückliefert.  

Welche Zelle dies ist, können Sie für jedes Formularobjekt getrennt festlegen: Se-

lektieren Sie das Objekt dazu per Rechtsklick und rufen Sie in dem Menü, das da-

raufhin erscheint, den Befehl Eigenschaften auf. Wechseln Sie dann auf die Kar-

teikarte Formularelement und tragen Sie bei Ausgabezelle die gewünschte 

Zelladresse ein. 

Ein Beispiel: Sie haben einer Liste die Ausgabezelle D4 zugewiesen. Klicken Sie 

nun in der Liste den ersten Eintrag an, trägt PlanMaker in der Zelle D4 eine 1 ein, 

klicken Sie den fünften Listeneintrag an, erscheint darin eine 5 etc. 

Die Beziehung zwischen einem Formularobjekt und seiner Ausgabezelle ist übri-

gens beidseitig: Tragen Sie also in die Ausgabezelle von Hand eine 3 ein, wird in 

der Liste automatisch der dritte Eintrag selektiert. 

Formularobjekte und Excel-Makros und -Scripts 

Microsoft Excel-Dateien können Makros und VBA-Scripts enthalten, die sich auf 

Formularobjekte anwenden lassen. Dies ist in PlanMaker nicht möglich, aber: 

Wichtig: Wenn Sie in PlanMaker eine Excel-Datei öffnen, die Makros oder 

Scripts enthält, können diese zwar nicht ausgeführt werden, sie bleiben aber er-

halten. Wenn Sie eine solche Excel-Datei also mit PlanMaker öffnen und bear-

beiten, gehen die Makros und Scripts beim Speichern nicht verloren. 

Formularobjekte im Detail 

In diesem Abschnitt stellen wir Ihnen die einzelnen Arten von Formularobjekten 

im Detail vor. Folgende Objekte werden darin behandelt: 

 Kontrollkästchen 

 Optionsfelder 

 Auswahllisten 

 Listen 

 Schaltflächen 

 Drehfelder 
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 Bildlaufleisten 

 Bezeichnungen und Gruppenfelder 

Kontrollkästchen 

Mit dem Befehl Objekt > Neues Formularobjekt > Kontrollkästchen fügen Sie 

ein Kontrollkästchen ein.  

Kontrollkästchen können in Formularen für Ja/Nein-Angaben verwendet werden. 

Wird das Kästchen angekreuzt, steht das für Ja; wird es nicht angekreuzt, bedeutet 

das Nein. 

Bedienung von Kontrollkästchen 

Klicken Sie das Kästchen an, um es mit einem Häkchen zu versehen – sprich: es 

anzukreuzen. Wenn Sie es erneut anklicken, wird das Häkchen wieder entfernt. 

Eigenschaften von Kontrollkästchen ändern 

Um die Eigenschaften eines Kontrollkästchens zu ändern, selektieren Sie es (zum 

Beispiel durch Anklicken mit der rechten Maustaste) und rufen dann den Befehl 

Objekt > Eigenschaften auf. 

Es erscheint ein Dialogfenster mit folgenden Optionen: 

Karteikarte Format 

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 220. 

Karteikarte Eigenschaften 

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 228. 
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Karteikarte Formularelement 

Auf dieser Karteikarte können Sie Einstellungen zu dem Kontrollkästchen selbst 

vornehmen: 

 Text 

 Hier können Sie den Text angeben, der rechts neben dem Kästchen angezeigt 

werden soll. 

 Wert 

 Hier können Sie festlegen, ob das Kästchen angekreuzt sein soll oder nicht. 

Entspricht dem Ankreuzen des Kästchens direkt im Dokument. 

 Ausgabezelle 

 Hier bestimmen Sie, in welcher Tabellenzelle der Zustand des Kontrollkäst-

chens ausgegeben werden soll.  

 In dieser Zelle erscheint dann einer der folgenden Werte: 

 WAHR, wenn das Kontrollkästchen angekreuzt ist. 

 FALSCH, wenn das Kontrollkästchen nicht angekreuzt ist. 

 Der Fehlerwert #NV, wenn der Zustand des Kontrollkästchen unbestimmt 

ist. 

 Rubrik Aussehen 

 Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) für den Text 

festlegen. 

 3D-Effekt 

 Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet. 

Optionsfelder 

Mit dem Befehl Objekt > Neues Formularobjekt > Optionsfeld fügen Sie ein 

Optionsfeld ein.  

Optionsfelder können in Formularen zur Auswahl einer von mehreren Optionen 

verwendet werden. 
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Verwendung von Gruppenfeldern zum Kombinieren von Optionsfeldern 

Wichtig: Optionsfelder müssen stets in Gruppen von mindestens zwei Options-

feldern verwendet werden. 

Damit PlanMaker hierbei weiß, welche Optionsfelder zu einer Gruppe gehören, 

umgeben Sie diese mit einem Gruppenfeld.  

 

Fügen Sie also erst die zusammengehörenden Optionsfelder in das Dokument ein 

(zum Beispiel untereinander) und ziehen Sie dann mit Einfügen > Neues Formu-

larobjekt > Gruppenfeld ein Gruppenfeld um sie herum. 

Bedienung von Optionsfeldern 

Klicken Sie eines der zusammengehörenden Optionsfelder an, um es auszuwählen. 

Innerhalb einer Gruppe von Optionsfeldern kann immer nur ein Optionsfeld aus-

gewählt sein. 

Eigenschaften von Optionsfeldern ändern 

Um die Eigenschaften eines Optionsfelds zu ändern, selektieren Sie es (zum Bei-

spiel durch Anklicken mit der rechten Maustaste) und rufen dann den Befehl Ob-

jekt > Eigenschaften auf. 

Es erscheint ein Dialogfenster mit folgenden Optionen: 

Karteikarte Format 

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 220. 
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Karteikarte Eigenschaften 

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 228. 

Karteikarte Formularelement 

Auf dieser Karteikarte können Sie Einstellungen zu dem Optionsfeld selbst vor-

nehmen: 

 Text 

 Hier können Sie den Text angeben, der in dem Optionsfeld angezeigt werden 

soll. 

 Wert 

 Hier können Sie festlegen, ob das Optionsfeld ausgewählt sein soll oder nicht. 

Entspricht dem Auswählen des Optionsfelds direkt im Dokument. 

 Ausgabezelle 

 Hier bestimmen Sie, in welcher Tabellenzelle der Zustand des Optionsfelds 

ausgegeben werden soll.  

 Wie eingangs erwähnt, müssen Optionsfelder immer in Gruppen von mindes-

tens zwei Optionsfeldern verwendet werden. In der Ausgabezelle wird dann 

ausgegeben, welches der Optionsfelder in der Gruppe ausgewählt ist. Wenn das 

erste Feld gewählt ist, erscheint darin eine 1, wenn das zweite Feld gewählt ist, 

erscheint eine 2, etc. 

 Rubrik Aussehen 

 Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) für den Text 

festlegen. 

 3D-Effekt 

 Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet. 

Auswahllisten 

Mit dem Befehl Objekt > Neues Formularobjekt > Auswahlliste fügen Sie eine 

aufklappbare Auswahlliste ein. 
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Auswahllisten kennen Sie aus vielen Dialogfenstern. Wenn man sie aufklappt, zei-

gen Sie eine Liste von Einträgen, von denen ein Eintrag ausgewählt werden kann. 

Dies ist natürlich ideal für Formulare, da es beim Ausfüllen Tipparbeit spart und 

Tippfehler unmöglich macht. 

Bedienung von Auswahllisten 

Klicken Sie das Pfeilchen rechts der Liste an, um die Liste zu öffnen. Nun können 

Sie einen Eintrag auswählen, indem sie ihn anklicken. 

Eigenschaften von Auswahllisten ändern 

Um die Eigenschaften einer Auswahlliste zu ändern, selektieren Sie diese (zum 

Beispiel durch Anklicken mit der rechten Maustaste) und rufen dann den Befehl 

Objekt > Eigenschaften auf. 

Es erscheint ein Dialogfenster mit folgenden Optionen: 

Karteikarte Format 

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 220. 

Karteikarte Eigenschaften 

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 228. 

Karteikarte Formularelement 

Auf dieser Karteikarte können Sie Einstellungen zu der Auswahlliste selbst vor-

nehmen: 

 Zeilen (max.) 

 Hier können Sie festlegen, wie viele Einträge die Liste höchstens anzeigen soll, 

wenn sie aufgeklappt wird. 
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 Listenbereich 

 Hier bestimmen Sie, welcher Zellbereich der Tabelle die Listeneinträge enthält, 

die in der Auswahlliste erscheinen sollen. 

 Wenn Sie beispielsweise die Zellen F5 bis F7 mit den Werten „Hund“, „Katze“ 

und „Maus“ ausfüllen und als Listenbereich F5:F7 angeben, erscheinen in der 

Liste genau diese drei Werte. 

 Ausgabezelle 

 Hier bestimmen Sie, in welcher Tabellenzelle der Zustand der Auswahlliste 

ausgegeben werden soll.  

 In der Ausgabezelle wird ausgegeben, welcher der Listeneinträge ausgewählt 

wurde. Wenn der erste Eintrag gewählt ist, erscheint darin eine 1, wenn der 

zweite Eintrag gewählt ist, erscheint eine 2, etc. 

 Rubrik Aussehen 

 Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) für den Text 

festlegen. 

 3D-Effekt 

 Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet. 

Listen 

Mit dem Befehl Objekt > Neues Formularobjekt > Liste fügen Sie eine Liste ein. 

Solche Listen kennen Sie aus vielen Dialogfenstern. Sie bieten mehrere Einträge 

zur Wahl, von denen per Mausklick ein Eintrag ausgewählt werden kann. Dies ist 

natürlich ideal für Formulare, da es beim Ausfüllen Tipparbeit spart und Tippfehler 

unmöglich macht. 

Eigenschaften von Listen ändern 

Um die Eigenschaften einer Liste zu ändern, selektieren Sie diese (zum Beispiel 

durch Anklicken mit der rechten Maustaste) und rufen dann den Befehl Objekt > 

Eigenschaften auf. 

Es erscheint ein Dialogfenster mit folgenden Optionen: 
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Karteikarte Format 

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 220. 

Karteikarte Eigenschaften 

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 228. 

Karteikarte Formularelement 

Auf dieser Karteikarte können Sie Einstellungen zu der Liste selbst vornehmen: 

 Markierungsart 

 Verwenden Sie hier stets die Option Einfach. 

 Die beiden anderen Einträge Mehrfach und Erweitert erlauben Mehrfachse-

lektionen in der Liste; es wird dann aber kein Resultat mehr in der Ausgabezel-

le ausgegeben. Sie sind nur aus Gründen der Excel-Kompatibilität vorhanden. 

 Listenbereich 

 Hier bestimmen Sie, welcher Zellbereich der Tabelle die Listeneinträge enthält, 

die in der Liste erscheinen sollen. 

 Wenn Sie beispielsweise die Zellen F5 bis F7 mit den Werten „Hund“, „Katze“ 

und „Maus“ ausfüllen und als Listenbereich F5:F7 angeben, erscheinen in der 

Liste genau diese drei Werte. 

 Ausgabezelle 

 Hier bestimmen Sie, in welcher Tabellenzelle der Zustand der Liste ausgegeben 

werden soll.  

 In der Ausgabezelle wird ausgegeben, welcher der Listeneinträge ausgewählt 

wurde. Wenn der erste Eintrag gewählt ist, erscheint darin eine 1, wenn der 

zweite Eintrag gewählt ist, erscheint eine 2, etc. 

 Rubrik Aussehen 

 Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) für den Text 

festlegen. 
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 3D-Effekt 

 Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet. 

Schaltflächen 

Mit dem Befehl Objekt > Neues Formularobjekt > Schaltfläche fügen Sie eine 

Schaltfläche ein. 

Hinweis: Schaltflächen können in PlanMaker nicht zum Starten von Makros oder 

VBA-Scripts verwendet werden; sie sind lediglich aus Gründen der Excel-

Kompatibilität vorhanden. 

Eigenschaften von Schaltflächen ändern 

Um die Eigenschaften einer Schaltfläche zu ändern, selektieren Sie diese (zum 

Beispiel durch Anklicken mit der rechten Maustaste) und rufen dann den Befehl 

Objekt > Eigenschaften auf. 

Es erscheint ein Dialogfenster mit folgenden Optionen: 

Karteikarte Format 

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 220. 

Karteikarte Eigenschaften 

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 228. 

Karteikarte Formularelement 

Auf dieser Karteikarte können Sie Einstellungen zu der Schaltfläche selbst vor-

nehmen: 

 Text 

 Hier können Sie den Text angeben, der auf der Schaltfläche erscheinen soll. 
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 Rubrik Aussehen 

 Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) für den Text 

festlegen. 

Drehfelder 

Mit dem Befehl Objekt > Neues Formularobjekt > Drehfeld fügen Sie ein Dreh-

feld ein. 

Mit Drehfeldern lassen sich Werte per Mausklick schrittweise erhöhen oder redu-

zieren. Ein Klick auf das Pfeilchen nach oben erhöht den Wert in der Ausgabezelle; 

das Pfeilchen nach unten reduziert den Wert. 

Eigenschaften von Drehfeldern ändern 

Um die Eigenschaften eines Drehfelds zu ändern, selektieren Sie es (zum Beispiel 

durch Anklicken mit der rechten Maustaste) und rufen dann den Befehl Objekt > 

Eigenschaften auf. 

Es erscheint ein Dialogfenster mit folgenden Optionen: 

Karteikarte Format 

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 220. 

Karteikarte Eigenschaften 

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 228. 

Karteikarte Formularelement 

Auf dieser Karteikarte können Sie Einstellungen zu dem Drehfeld selbst vorneh-

men: 

 Rubrik Parameter 

 Hier können Sie folgende Parameter festlegen: 
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 Aktueller Wert: Der aktuelle Wert (entspricht dem manuellen Ändern des 

Wertes in der Ausgabezelle). 

 Mindestwert: Der Mindestwert, der nicht unterschritten werden darf. 

 Maximalwert: Der Höchstwert, der nicht überschritten werden darf. 

 Schrittweite: Der Wert, der hinzugezählt bzw. abgezogen werden soll, wenn 

auf eines der beiden Pfeilchen geklickt wird. 

 Ausgabezelle 

 Hier bestimmen Sie, in welcher Tabellenzelle der resultierende Wert ausgege-

ben werden soll.  

 3D-Effekt 

 Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet. 

Bildlaufleisten 

Mit dem Befehl Objekt > Neues Formularobjekt > Bildlaufleiste fügen Sie eine 

Bildlaufleiste ein. 

Mit Bildlaufleisten lassen sich Werte per Mausklick erhöhen oder reduzieren. Ein 

Klick auf das Pfeilchen nach oben erhöht den Wert in der Ausgabezelle um die 

angegebene Schrittweite; das Pfeilchen nach unten reduziert den Wert entspre-

chend.  

Weiterhin können Sie den „Schieber“ in der Mitte der Bildlaufleiste mit der Maus 

verschieben, um größere Sprünge machen. 

Eigenschaften von Bildlaufleisten ändern 

Um die Eigenschaften einer Bildlaufleiste zu ändern, selektieren Sie diese (zum 

Beispiel durch Anklicken mit der rechten Maustaste) und rufen dann den Befehl 

Objekt > Eigenschaften auf. 

Es erscheint ein Dialogfenster mit folgenden Optionen: 
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Karteikarte Format 

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 220. 

Karteikarte Eigenschaften 

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 228. 

Karteikarte Formularelement 

Auf dieser Karteikarte können Sie Einstellungen zu der Bildlaufleiste selbst vor-

nehmen: 

 Rubrik Parameter 

 Hier können Sie folgende Parameter festlegen: 

 Aktueller Wert: Der aktuelle Wert (entspricht dem manuellen Ändern des 

Wertes in der Ausgabezelle). 

 Mindestwert: Der Mindestwert, der nicht unterschritten werden darf. 

 Maximalwert: Der Höchstwert, der nicht überschritten werden darf. 

 Schrittweite: Der Wert, der hinzugezählt bzw. abgezogen werden soll, wenn 

auf eines der beiden Pfeilchen geklickt wird. 

 Seitenwechsel: Der Wert, der hinzugezählt bzw. abgezogen werden soll, wenn 

zwischen den Schieber in der Mitte der Bildlaufleiste und eines der Pfeilchen 

geklickt wird. 

 Ausgabezelle 

 Hier bestimmen Sie, in welcher Tabellenzelle der resultierende Wert ausgege-

ben werden soll.  

 3D-Effekt 

 Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet. 
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Bezeichnungen und Gruppenfelder 

Neben den zuvor beschriebenen Formularobjekten gibt es zusätzlich zwei Arten 

von Formularobjekten, die sich nicht ausfüllen lassen, sondern lediglich für das 

Anbringen von Beschriftungen gedacht sind: 

 Bezeichnungen 

 In Bezeichnungen kann eine beliebige Beschriftung eingegeben werden, die im 

Formular angezeigt werden soll. 

 Gruppenfelder 

 Gruppenfelder sind Rechtecke, die sich links oben mit einer Beschriftung ver-

sehen lassen. Sie können dazu verwendet werden, zusammengehörige Teile ei-

nes Formulars optisch zu einer Gruppe zusammenzufassen.  

Um eine Bezeichnung oder ein Gruppenfeld einzufügen, rufen Sie Objekt > Neues 

Formularobjekt > Bezeichnung beziehungsweise Objekt > Neues Formularob-

jekt > Gruppenfeld auf. Anschließend ziehen Sie mit der Maus im Dokument ein 

Rechteck auf, das die gewünschte Position und Größe hat. 

Eigenschaften von Bezeichnungen und Gruppenfeldern ändern 

Um die Eigenschaften einer Bezeichnung oder eines Gruppenfelds zu ändern, se-

lektieren Sie dieses (zum Beispiel durch Anklicken mit der rechten Maustaste) und 

rufen dann den Befehl Objekt > Eigenschaften auf. 

Es erscheint ein Dialogfenster mit folgenden Optionen: 

Karteikarte Format 

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 220. 

Karteikarte Eigenschaften 

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 228. 
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Karteikarte Formularelement 

Auf dieser Karteikarte können Sie Einstellungen zu dem Text vornehmen, den die 

Bezeichnung beziehungsweise das Gruppenfeld anzeigen soll: 

 Rubrik Text 

 Hier geben Sie den anzuzeigenden Text ein. 

 Rubrik Aussehen 

 Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) des Textes 

festlegen. 

 3D-Effekt 

 Nur bei Gruppenfeldern verfügbar. Schalten Sie diese Option ein, wird das 

Gruppenfeld mit einem 3D-Effekt gezeichnet. 
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Sprachwerkzeuge 

PlanMaker verfügt über eine leistungsfähige Rechtschreibprüfung. Diese ermög-

licht es Ihnen, die Rechtschreibung von Text überprüfen und korrigieren zu lassen. 

Außerdem steht eine automatische Silbentrennung zur Verfügung. 

In diesem Kapitel erfahren Sie alles Wissenswerte dazu. Es besteht aus folgenden 

Abschnitten: 

 Sprache einstellen 

 Die Sprache für Rechtschreibprüfung und Silbentrennung lässt sich über den 

Befehl Weiteres > Einstellungen (Karteikarte Sprache) einstellen. 

 Rechtschreibprüfung 

 Die Rechtschreibprüfung überprüft den Text in einem Dokument auf Tippfehler 

und macht bei Fehlern Korrekturvorschläge. 

 Silbentrennung 

 Die automatische Silbentrennung trennt lange Wörter am Zeilenende nach de-

ren Sprechsilben. Sie wird standardmäßig nur in Textrahmen aktiv, kann auf 

Wunsch aber auch mehrzeiligen Text in Tabellenzellen trennen.  

 Textbausteine 

 Über Textbausteine können Sie Ihre „Lieblingstippfehler“ automatisch korrigie-

ren lassen und Kürzel für häufig benötigte Floskeln definieren – zum Beispiel 

„Lst“ für „Lohnsteuer“. 

Sprache einstellen 

Wenn Sie mehrere Sprachen installiert haben, können Sie die Sprache für Recht-

schreibprüfung und Silbentrennung jederzeit wechseln. 

Gehen Sie dazu wie folgt vor: 

1. Rufen Sie den Befehl Weiteres > Einstellungen auf. 

2. Wechseln Sie auf die Karteikarte Sprache. 

3. Wählen Sie die gewünschte Sprache aus der Liste Sprache. 
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Hinweis: Beachten Sie dabei, dass es für Deutsch zwei Einträge in dieser Liste 

gibt: Wählen Sie „Deutsch (Deutschland)“ für die neue Rechtschreibung oder 

„Deutsch (Deutschland, alt)“ für die alte Rechtschreibung. Entsprechendes gilt 

für „Deutsch (Schweiz)“. 

Rechtschreibprüfung 

Die Rechtschreibprüfung überprüft den Text in einem Dokument auf Tippfehler 

und macht bei Fehlern Korrekturvorschläge. 

In diesem Abschnitt stellen wir Ihnen die einzelnen Werkzeuge der Rechtschreib-

prüfung ausführlich vor. Folgende Themen werden darin behandelt: 

 Rechtschreibprüfung nachträglich 

 Die nachträgliche Rechtschreibprüfung lässt Sie ein Dokument en bloc über-

prüfen und korrigieren. 

 Rechtschreibprüfung während des Tippens 

 Die Rechtschreibkorrektur während des Tippens prüft jedes Wort direkt nach 

der Eingabe. Bei Tippfehlern meldet sich sofort ein Dialogfenster zur Korrek-

tur. 

 Benutzerwörterbücher bearbeiten 

 Wenn Sie die Rechtschreibprüfung Wörter lernen lassen, werden diese in das 

Benutzerwörterbuch aufgenommen. Dieses können Sie jederzeit bearbeiten, um 

fälschlicherweise aufgenommene Einträge zu löschen. 

Tipp: Falls Sie ein Wörterbuch für eine bestimmte Sprache benötigen, dieses 

momentan aber nicht installiert ist, können Sie es jederzeit nachinstallieren. Le-

sen Sie dazu den Abschnitt „Installieren zusätzlicher Wörterbücher“ (Seite 431). 

Ausführliche Informationen zu diesen Themen finden Sie, in obiger Reihenfolge, 

auf den nächsten Seiten. 
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Rechtschreibprüfung nachträglich 

Hinweis: Tabellenzellen, die mit einem Gleichheitszeichen = beginnen (also eine 

Berechnung enthalten), werden von der Rechtschreibprüfung automatisch über-

sprungen. 

Mit dem Befehl Weiteres > Rechtschreibprüfung starten Sie die nachträgliche 

Rechtschreibprüfung. Diese überprüft das aktuelle Arbeitsblatt Wort für Wort auf 

Rechtschreibfehler.  

Wenn Sie diesen Befehl aufrufen, erscheint zunächst ein Dialog, in dem Sie aus-

wählen können, welche Bestandteile des Arbeitsblatts überprüft werden sollen: 

 Ist die Option Arbeitsblatt prüfen aktiviert, werden alle Tabellenzellen über-

prüft. 

 Ist die Option Alle Rahmen prüfen aktiviert, werden zusätzlich alle Textrah-

men und alle Zeichnungen, die Text enthalten, überprüft. 

Treffen Sie Ihre Wahl und starten Sie die Rechtschreibprüfung dann mit OK. 

PlanMaker geht den Text nun Wort für Wort durch. Bei einem unbekannten Wort 

hält die Rechtschreibprüfung an und zeigt das Wort in einem Dialogfenster an. 

 

In der Liste unter Ändern auf macht PlanMaker Vorschläge für die korrekte 

Schreibweise des Wortes (sofern welche gefunden werden). 

Anhand der Schaltflächen können Sie bestimmen, was mit dem unbekannten Wort 

geschehen soll: 
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Schaltfläche Funktion 

Ändern Lässt Sie das Wort korrigieren. Tippen Sie, bevor Sie diese 

Schaltfläche betätigen, die korrekte Schreibweise im Eingabefeld 

Ändern auf ein oder wählen Sie einen der Wortvorschläge aus 

der Liste. 

Alle ändern Funktioniert wie Ändern, ändert jedoch alle Vorkommen des 

Wortes im gesamten Dokument auf die angegebene Schreibwei-

se. 

Ignorieren Weist PlanMaker an, diesen Rechtschreibfehler zu ignorieren 

und die Rechtschreibprüfung fortzuführen. 

Alle ignorieren Weist PlanMaker an, fortan alle Vorkommen dieses Wortes zu 

ignorieren. 

 Hinweis: Die Liste der ignorierten Wörter merkt sich PlanMaker 

nur vorübergehend; beim nächsten Programmstart hat er sie 

wieder vergessen. Wenn Sie PlanMaker Wörter permanent ler-

nen lassen möchten, verwenden Sie stattdessen den Befehl Ler-

nen. 

Lernen Weist PlanMaker an, das Wort in das Benutzerwörterbuch aufzu-

nehmen und damit den ihm bekannten Wortschatz zu vergrößern. 

 Verwenden Sie diese Option bei richtig geschriebenen Wörtern, 

die PlanMaker noch nicht kennt. Diese Wörter merkt sich Plan-

Maker permanent, also auch nach einem Neustart. 

Wenn Sie die Rechtschreibprüfung beenden möchten, bevor das Ende des Arbeits-

blatts erreicht ist, klicken Sie auf Schließen. 

Rechtschreibprüfung während des Tippens 

Wenn Sie die Rechtschreibkorrektur während des Tippens aktivieren, überprüft 

PlanMaker unbemerkt bei jedem Wort, das Sie eintippen, die Rechtschreibung und 

meldet sich bei einem Tippfehler sofort: Es erscheint ein Dialogfenster zum Korri-

gieren der Schreibweise. 

Hinweis: Wenn Sie die Eingabe in eine Zelle mit einem Gleichheitszeichen (=) 

beginnen (also eine Berechnung eingeben), werden die Eingaben in diese Zelle 

nicht geprüft. Das wäre bei Rechenformeln ja auch nicht sinnvoll. 
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Um diese Form der Rechtschreibprüfung zu aktivieren, rufen Sie Weiteres > Ein-

stellungen auf, wechseln auf die Karteikarte Sprache und schalten dort die Option 

Rechtschreibkorrektur während des Tippens ein. 

PlanMaker sieht nun jedes Mal, wenn Sie ein Wort eintippen, blitzschnell in seinen 

Wörterbüchern nach, ob es sich darin befindet. Solange Sie Wörter tippen, die die 

Rechtschreibprüfung kennt, passiert nichts Sichtbares. Kann PlanMaker mit einem 

Wort aber nichts anfangen, erscheint sofort ein Dialogfenster. 

Dieses Dialogfenster entspricht dem der nachträglichen Rechtschreibprüfung, das 

im vorherigen Abschnitt vorgestellt wurde. Lesen Sie dort nach, wie das Dialog-

fenster bedient wird. 

Sie werden bemerken, dass es in dem Dialogfenster zusätzlich die Schaltfläche 

Textbaustein zum Anlegen von Textbausteinen gibt. Was es damit auf sich hat, 

erfahren Sie im Abschnitt „Textbausteine“ ab Seite 320. 

Benutzerwörterbücher bearbeiten 

Gelegentlich kann es passieren, dass man die Rechtschreibprüfung versehentlich 

ein Wort lernen lässt, dessen Schreibweise nicht korrekt ist. Für diesen Fall ist der 

Befehl Weiteres > Wörterbücher bearbeiten gedacht. Damit können Sie einmal 

gelernte Wörter wieder aus dem Sprachschatz von PlanMaker entfernen. 

Rufen Sie dazu Weiteres > Wörterbücher bearbeiten auf, selektieren Sie das zu 

löschende Wort und klicken Sie auf Löschen. Das Wort ist nun aus dem Benutzer-

wörterbuch entfernt; die Rechtschreibprüfung wird es zukünftig also wieder als 

falsch geschrieben ansehen. 

Sie können mit dieser Funktion nur Wörter löschen, die Sie PlanMaker selbst bei-

gebracht haben. Wörter aus den mitgelieferten Wörterbüchern lassen sich nicht 

entfernen. 

Es gibt zu jeder Sprache ein eigenes Benutzerwörterbuch. Über die aufklappbare 

Liste Sprache können Sie auswählen, welches Benutzerwörterbuch bearbeitet 

werden soll. 

Hinweis: Beachten Sie dabei, dass es für Deutsch zwei Einträge in dieser Liste 

gibt: Wählen Sie „Deutsch (Deutschland)“ für die neue Rechtschreibung oder 

„Deutsch (Deutschland, alt)“ für die alte Rechtschreibung. Entsprechendes gilt 

für „Deutsch (Schweiz)“. 
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Silbentrennung 

Die automatische Silbentrennung trennt lange Wörter am Zeilenende nach deren 

Sprechsilben. Dies geschieht völlig automatisch, während Sie tippen.  

Die Silbentrennung ist allerdings nur in zwei Fällen verfügbar: 

 Silbentrennung in Textrahmen 

 In Textrahmen ist die automatische Silbentrennung standardmäßig aktiviert. 

 Silbentrennung in Tabellenzellen 

 In Tabellenzellen ist die automatische Silbentrennung standardmäßig nicht ak-

tiviert. Bei Zellen, die mehrzeiligen Text enthalten, können Sie diese aber auf 

Wunsch einschalten.  

Ausführliche Informationen dazu finden Sie auf den nächsten Seiten. 

Wichtig: Die Silbentrennung liefert natürlich nur dann korrekte Resultate, wenn 

Sie in den Programmeinstellungen die richtige Sprache eingestellt haben. Um die 

Sprache einzustellen, rufen Sie Weiteres > Einstellungen auf, wechseln auf die 

Karteikarte Sprache und wählen die Sprache aus der Liste Sprache. 

Silbentrennung in Textrahmen 

Wenn Sie Text in einen Textrahmen einfügen, führt PlanMaker darin automatisch 

Silbentrennungen durch. Dies geschieht völlig automatisch im Hintergrund, Sie 

brauchen sich normalerweise also überhaupt nicht darum zu kümmern.  

Sie sollten lediglich darauf achten, dass Sie in den Einstellungen die korrekte 

Sprache gewählt haben, da die Silbentrennung sonst natürlich fehlerhafte Resultate 

liefert (siehe Abschnitt „Sprache einstellen“ ab Seite 313). 

Trennhäufigkeit einstellen 

Auf Wunsch können Sie einstellen, wie häufig die Silbentrennungsfunktion Wörter 

trennen soll – oder die Silbentrennung ganz abschalten. Diese Einstellung lässt sich 

für jeden Absatz in einem Textrahmen getrennt festlegen. 

Markieren Sie dazu die betreffenden Absätze in dem Textrahmen, rufen Sie For-

mat > Absatz auf und wählen Sie bei Silbentrennung die gewünschte Einstellung. 
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Folgende Optionen stehen zur Wahl: 

Einstellung Effekt 

Keine Keine Silbentrennungen durchführen 

Stets Beliebig viele aufeinander folgende Silbentrennungen versu-

chen. Dies ist die Standardeinstellung. 

2-Zeilen-Trennung Silbentrennung nur in jeder zweiten Zeile versuchen 

3-Zeilen-Trennung Silbentrennung nur in jeder dritten Zeile versuchen 

Mit Keine schalten Sie die Silbentrennung für die selektierten Absätze also ganz 

ab, wogegen Stets in jeder beliebigen Zeile eines Absatzes versucht, eine Silben-

trennung durchzuführen.  

Wozu aber dienen die zwei anderen Optionen? Nun, es ist nicht immer erstrebens-

wert, alle denkbaren Silbentrennungen durchzuführen. Denn das kann beispiels-

weise bei schmalen Textspalten dazu führen, dass in fast jeder Zeile getrennt wird, 

was die Lesbarkeit des Dokuments absenkt. Deshalb können Sie PlanMaker mit 

Hilfe der Optionen 2- und 3-Zeilen-Trennung anweisen, eine Silbentrennung nur 

in jeder zweiten beziehungsweise dritten Zeile zu versuchen. 

Silbentrennung in Tabellenzellen 

In Tabellenzellen ist die automatische Silbentrennung normalerweise nicht akti-

viert, sie können Sie aber auf Wunsch einschalten. Silbentrennungen werden dann 

aber natürlich nur in Zellen durchgeführt, die mehrzeiligen Text enthalten.  

Um Silbentrennungen in Zellen zu erhalten, sind also zwei Schritte erforderlich: 

Schritt 1: Silbentrennung für Zellen aktivieren 

Damit in Zellen überhaupt Silbentrennungen durchgeführt werden, müssen Sie erst 

die Silbentrennung für Zellen aktivieren. Diese ist standardmäßig nämlich ausge-

schaltet. Um sie einzuschalten, gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Datei > Eigenschaften auf. 

2. Wechseln Sie auf die Karteikarte Optionen. 

3. Schalten Sie die Option Silbentrennung ein. 

Von nun an wird die Silbentrennung automatisch auch in Tabellenzellen aktiv. 
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Hinweis: Dies ist eine Dokumentoption, sie kann also für jedes Dokument indivi-

duell ein- oder ausgeschaltet werden. 

Schritt 2: In den betreffenden Zellen den Zeilenumbruch einschalten 

In Tabellenzellen werden nur dann Silbentrennungen durchgeführt, wenn für die 

betreffende Zelle die Option Zeilenumbruch eingeschaltet ist. Diese sorgt dafür, 

dass langer Text automatisch am rechten Zellenrand umbrochen wird, um ihn auf 

mehrere Zeilen zu verteilen.  

Um die Option Zeilenumbruch zu aktivieren, geben Sie wie folgt vor: 

1. Markieren Sie die gewünschten Zellen. 

2. Rufen Sie den Befehl Format > Zelle auf. 

3. Wechseln Sie auf die Karteikarte Ausrichtung. 

4. Schalten Sie die Option Zeilenumbruch ein. 

In diesen Zellen werden nun (sofern sie mehrzeiligen Text enthalten) bei Bedarf 

automatische Silbentrennungen durchgeführt. 

Textbausteine 

Textbausteine bieten eine enorme Arbeitserleichterung: Sie können sich Textbau-

steine für häufig benötigte Floskeln anlegen und diese dann blitzschnell im Text 

abrufen. 

Legen Sie beispielsweise einen Textbaustein namens „Lst“ mit dem Inhalt „Lohn-

steuer“ an. Nun können Sie diesen Baustein jederzeit abrufen. Tippen Sie dazu im 

Dokument einfach „Lst“ und dann die Leertaste, die Eingabetaste (¢) oder ein 

Satzzeichen. Sofort wird „Lst“ durch „Lohnsteuer“ ersetzt. 

Auf diese Weise können Sie sich mit PlanMaker Ihr persönliches „Computersteno“ 

zusammenstellen und beim Tippen viel Zeit sparen. 

In diesem Abschnitt erfahren Sie alles über das Arbeiten mit Textbausteinen: 

 Textbausteine anlegen 

 Neue Textbausteine können dialoggesteuert mit Einfügen > Textbaustein oder 

über die Rechtschreibprüfung angelegt werden. Für jeden Textbaustein muss 
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ein Name (z.B. „Lst“) der gewünschte Inhalt angegeben werden (z.B. „Lohn-

steuer“). 

 Textbausteine abrufen 

 Wenn in den Einstellungen die Option Textbausteine automatisch ersetzen 

aktiviert ist, lassen sich Textbausteine ganz einfach abrufen: Tippen Sie dazu 

den Namen des Bausteins und anschließend die Leertaste, die Eingabetaste (¢) 

oder ein Satzzeichen. Sofort wird der Name durch den Inhalt ersetzt. 

 Alternativ lassen sich Bausteine mit dem Befehl Einfügen > Textbaustein von 

Hand einfügen. 

 Textbausteine bearbeiten 

 Mit dem Befehl Einfügen > Textbaustein lassen sich nicht nur neue Textbau-

steine anlegen, sondern auch vorhandene Bausteine bearbeiten, umbenennen 

oder löschen. 

Ausführliche Informationen hierzu folgen auf den nächsten Seiten. 

Textbausteine anlegen 

Sie können Textbausteine wahlweise a) dialoggesteuert anlegen oder b) die Recht-

schreibkorrektur während des Tippens dazu verwenden: 

A) Mit dem Befehl Einfügen > Textbaustein 

Um beispielsweise einen Baustein mit dem Namen „Lst“ und dem Inhalt „Lohn-

steuer“ anzulegen, gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Einfügen > Textbaustein auf. 

2. Klicken Sie auf die Schaltfläche Neu, um einen neuen Baustein anzulegen. 

3. Geben Sie dem Baustein einen Namen (in unserem Beispiel also „Lst“).  

 Anhand seines Namens kann der Baustein später abgerufen werden. 

4. Bestätigen Sie mit OK. 

5. Tippen Sie nun in dem großen Eingabefeld rechts den Text für den Baustein ein 

(in unserem Beispiel also „Lohnsteuer“). 

6. Klicken Sie auf Speichern, um Ihren neuen Textbaustein zu speichern. 
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7. Verlassen Sie den Dialog mit Schließen. 

Der Baustein ist nun angelegt. Wie Sie ihn abrufen können, erfahren Sie im nächs-

ten Abschnitt („Textbausteine abrufen“ ab Seite 322). 

B) Über die Rechtschreibkorrektur während des Tippens 

Alternativ lassen sich Textbausteine auch über die Rechtschreibkorrektur während 

des Tippens anlegen.  

Der Vorteil dieser Methode ist, dass sich Bausteine damit schneller anlegen lassen, 

falls Sie die Rechtschreibkorrektur während des Tippens ohnehin permanent 

eingeschaltet haben. Wenn Sie diese jedoch nicht verwenden, ist die oben be-

schriebene Methode praktischer. 

Gehen Sie wie folgt vor: 

1. Vergewissern Sie sich, dass auf der Karteikarte Sprache im Dialogfenster von 

Weiteres > Einstellungen die Option Rechtschreibkorrektur während des 

Tippens aktiviert ist. 

2. Tippen Sie die drei Buchstaben „Lst“ und betätigen Sie die Leertaste. 

3. Es erscheint das Dialogfenster der Rechtschreibkorrektur, da PlanMaker das 

Wort „Lst“ nicht kennt. 

4. Klicken Sie auf die Schaltfläche Textbaustein. 

5. Tippen Sie „Lohnsteuer“ ein. 

6. Bestätigen Sie mit OK. 

Das Ergebnis ist das Gleiche: Der Baustein „Lst“ ist nun angelegt worden. 

Weitere Informationen zur Rechtschreibkorrektur während des Tippens finden Sie 

im Abschnitt „Rechtschreibprüfung während des Tippens“ ab Seite 316. 

Textbausteine abrufen 

Jetzt können Sie den im vorherigen Abschnitt definierten Textbaustein jederzeit 

abrufen.  

Dies geht denkbar einfach: Tippen Sie in einer Zelle oder einem Textrahmen den 

Namen des Bausteins – in unserem Beispiel also „Lst“ – und dann ein Leerzeichen, 



 

Handbuch PlanMaker Sprachwerkzeuge    323 

ein Satzzeichen oder die Eingabetaste (¢). Sofort ersetzt PlanMaker „Lst“ durch 

den Inhalt des Bausteins: „Lohnsteuer“. 

Hinweis: Sollte dies nicht funktionieren, haben Sie die Option Textbausteine 

automatisch ersetzen deaktiviert. Rufen Sie den Befehl Weiteres > Einstellun-

gen auf, wechseln Sie auf die Karteikarte Sprache und schalten Sie diese Option 

wieder ein. 

Alternativ können Sie den Baustein auch per Dialog in den Text einfügen, indem 

Sie den Befehl Einfügen > Textbaustein aufrufen, den gewünschten Baustein 

auswählen und dann die Schaltfläche Einfügen betätigen. 

Textbausteine bearbeiten 

Mit dem Befehl Einfügen > Textbaustein können Sie weiterhin die bereits ange-

legten Textbausteine bearbeiten: 

 Neuen Baustein anlegen 

 Betätigen Sie die Schaltfläche Neu, um einen neuen Textbaustein anzulegen 

(siehe Abschnitt „Textbausteine anlegen“ ab Seite 321). 

 Baustein löschen 

 Um einen Textbaustein zu löschen, selektieren Sie ihn in der Liste Textbau-

steine und betätigen dann die Schaltfläche Löschen. 

 Baustein umbenennen 

 Möchten Sie den Namen eines Bausteins ändern, selektieren Sie ihn in der Liste 

und klicken auf die Schaltfläche Umbenennen. Es erscheint ein Dialogfenster, 

in das Sie den neuen Namen eingeben können. 

 Baustein bearbeiten 

 Um einen Baustein zu bearbeiten, selektieren Sie ihn in der Liste und klicken 

dann in das große Eingabefeld rechts daneben. Nun können Sie den Inhalt des 

Bausteins abändern. 

 Wenn Sie die gewünschten Änderungen angebracht haben, klicken Sie auf die 

Schaltfläche Speichern. 
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 Baustein einfügen 

 Um einen Baustein in den Text einzufügen, selektieren Sie ihn in der Liste und 

klicken auf die Schaltfläche Einfügen (siehe auch Abschnitt „Textbausteine ab-

rufen“ ab Seite 322). 

 Dialog schließen 

 Mit der Schaltfläche Schließen können Sie den Dialog schließlich verlassen. 
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Dokumentverwaltung 
PlanMaker verfügt über Funktionen, die es Ihnen erleichtern, Ihre Dokumente zu 

verwalten und schneller auf sie zuzugreifen: 

 Schnellwahlpfade 

 Sie können in PlanMaker Schnellwahlpfade anlegen, um beim Öffnen oder 

Speichern von Dateien blitzschnell in häufig verwendete Ordner wechseln zu 

können. 

 Dokumentinfos 

 In jedem Dokument können Sie Dokumentinfos ablegen, die sich über die Kar-

teikarte Infos im Dialogfenster des Befehls Datei > Eigenschaften anzeigen 

und bearbeiten lassen. Sie können Titel, Thema und Autor des Dokuments ein-

tragen, Stichwörter für die Suchfunktion des Dateimanagers angeben und eine 

kurze Inhaltsangabe verfassen. 

 Dateimanager 

 Mit dem integrierten Dateimanager können Sie bequem auf Ihre Dokumente 

zugreifen. Sie sehen darin die Namen und Dokumentinfos aller Dokumente auf 

einen Blick und können Dokumente auf Knopfdruck betrachten, öffnen, aus-

drucken oder löschen. Die Suchfunktion lässt Sie Dokumente nicht nur anhand 

des Dateinamens finden, sondern erlaubt auch die Suche nach Thema, Titel, 

Autor etc. 

Ausführliche Informationen hierzu finden Sie auf den nächsten Seiten. 

Schnellwahlpfade 

Sie können mit PlanMaker bis zu zwanzig Schnellwahlpfade anlegen, um beim 

Öffnen oder Speichern von Dateien blitzschnell in einen bestimmten Ordner wech-

seln zu können. 

Ein Schnellwahlpfad ist eine symbolische Angabe wie „Reisekosten“, die für einen 

bestimmten Ordner auf der Festplatte steht (zum Beispiel den Ordner 

C:\BUCHHALTUNG\REISEKOSTEN).  

Wenn Sie nun eine Datei aus diesem Ordner öffnen möchten, brauchen Sie im Dia-

logfenster von Datei > Öffnen nur auf die Schaltfläche Schnellwahlpfad zu kli-
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cken und den Schnellwahlpfad „Reisekosten“ auszuwählen. Der Dialog wechselt 

sofort in den Ordner C:\BUCHHALTUNG\REISEKOSTEN. 

Schnellwahlpfade stehen nicht nur im Dialogfenster von Datei > Öffnen zur Ver-

fügung, sondern in allen Dialogfenstern, die zum Öffnen oder Speichern von Da-

teien dienen. 

Ausführlichere Informationen folgen auf den nächsten Seiten. 

Anlegen von Schnellwahlpfaden 

Um einen neuen Schnellwahlpfad anzulegen, gehen Sie wie folgt vor: 

1. Rufen Sie einen beliebigen Dateidialog auf (zum Beispiel mit dem Befehl Da-

tei > Öffnen). 

2. Betätigen Sie die Schaltfläche Schnellwahlpfad. 

3. Es öffnet sich ein Menü unter der Schaltfläche. Wählen Sie darin die Funktion 

Schnellwahlpfad neu anlegen. 

4. Tragen Sie bei Name einen beliebigen Namen für den Schnellwahlpfad ein – 

zum Beispiel „Reisekosten“. 

5. Tragen Sie bei Pfad den gewünschten Ordner ein – zum Beispiel 

„c:\buchhaltung\reisekosten“. 

6. Bestätigen Sie mit OK. 

PlanMaker weiß nun, dass der Schnellwahlpfad „Reisekosten“ in den Ordner 

C:\BUCHHALTUNG\REISEKOSTEN wechseln soll. 

Schnellwahlpfade mit Dateimasken: Sie können nicht nur reine Pfadangaben wie 

„c:\buchhaltung\reisekosten“ machen, sondern zusätzlich auch eine Dateimaske 

angeben. Definieren Sie beispielsweise einen Schnellwahlpfad auf 

„c:\buchhaltung\reisekosten\a*.*“, wird damit in den Ordner 

C:\BUCHHALTUNG\REISEKOSTEN gewechselt und darin alle Dateien angezeigt, die 

mit „a“ beginnen. 

Kennbuchstaben: Im Namen für Schnellwahlpfade kann das &-Zeichen verwendet 

werden, um dem Pfad einen Kennbuchstaben zu geben. Wird als Name beispiels-

weise „&Finanzen“ eingetragen, kann der Pfad in der geöffneten Liste der 

Schnellwahlpfade durch Drücken der Taste (F) aufgerufen werden. 
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Verwenden von Schnellwahlpfaden 

Schnellwahlpfade stehen in allen Dateidialogen zur Verfügung – zum Beispiel im 

Dialog des Befehls Datei > Öffnen. 

Um einen Schnellwahlpfad einzusetzen, gehen Sie wie folgt vor: 

1. Klicken Sie in einem Dateidialog auf die Schaltfläche Schnellwahlpfad. 

2. Es öffnet sich ein Menü mit allen bisher eingerichteten Schnellwahlpfaden. 

Wählen Sie den gewünschten Schnellwahlpfad aus. 

PlanMaker wechselt nun in den im Schnellwahlpfad festgelegten Ordner. 

Schnellwahlpfade bearbeiten und löschen 

Um einen vorhandenen Schnellwahlpfad zu bearbeiten oder ihn zu entfernen, ge-

hen Sie wie folgt vor: 

1. Klicken Sie in einem Dateidialog auf die Schaltfläche Schnellwahlpfad. 

2. Es öffnet sich ein Menü. Wählen Sie darin den Befehl Schnellwahlpfade än-

dern. 

3. Es erscheint ein Dialogfenster. Selektieren Sie darin den gewünschten Schnell-

wahlpfad.  

4. Klicken Sie auf Ändern, um den Namen und Pfad zu bearbeiten oder auf Lö-

schen, um den Schnellwahlpfad zu entfernen. 

Dokumentinfos 

Über den Befehl Datei > Eigenschaften lassen sich nicht nur dokumentspezifische 

Einstellungen vornehmen, sondern auch die Dokumentinfos eintragen. 

Dokumentinfos sind Zusatzinformationen (wie Thema, Autor, Stichwörter etc.) zu 

einem Dokument. Um diese einzusehen oder sie zu bearbeiten, rufen Sie den Be-

fehl Datei > Eigenschaften auf und wechseln auf die Karteikarte Infos. 

Nehmen Sie die gewünschten Eintragungen vor und bestätigen Sie mit OK. 
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Tipp: Im Dateimanager (siehe nächster Abschnitt) können Sie Dokumente nach 

den Dokumentinfos durchsuchen lassen, um beispielsweise alle Dokumente zu 

einem bestimmten Thema zu finden. 

Beim Speichern automatisch nach Dokumentinfo fragen: Auf Wunsch bittet Sie PlanMa-

ker bei jedem neuen Dokument automatisch um das Ausfüllen der Dokumentinfos. 

Rufen Sie dazu den Befehl Weiteres > Einstellungen auf, wählen Sie die Kartei-

karte Dateien und schalten Sie die Option Beim Speichern nach Dokumentinfo 

fragen ein. Nun erscheint jedes Mal, wenn Sie ein neues Dokument zum ersten 

Mal speichern, das Dialogfenster zur Eingabe der Dokumentinfos. 

Dateimanager 

Der Dateimanager zeigt eine Liste von Dokumenten aus einem oder mehreren 

Ordnern an und lässt Sie diese per Mausklick öffnen, drucken, löschen oder anse-

hen.  

Sie starten den Dateimanager mit dem Befehl Datei > Dateimanager. 

 

Das Fenster des Dateimanagers kann nach Belieben vergrößert oder verkleinert 

werden. Die Spaltenbreiten lassen sich durch Ziehen der Trennlinien zwischen den 

Spaltenüberschriften verändern.  

Durch Klicken auf eine der Spaltenüberschriften können Sie bestimmen, nach wel-

cher Spalte die Dateien sortiert werden sollen. 

Mit den Steuerungstasten oder per Mausklick können Sie eine Datei selektieren 

und dann auf eine der Schaltflächen klicken, deren Funktionen im nächsten Ab-

schnitt beschrieben werden. 
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Über die Schaltfläche Suchen können Sie zu einem anderen Ordner wechseln. 

Weiterhin erlauben die Suchfunktionen, die sich hinter dieser Schaltfläche verber-

gen, auch die Suche innerhalb der Dokumentinfos, so dass Sie nach einem bestim-

men Titel, Thema, Autor, Schlagwort etc. suchen können. 

Ausführlichere Informationen dazu finden Sie auf den nächsten Seiten. 

Schaltflächen im Dateimanager 

Die Schaltflächen im Dateimanager haben folgende Funktionen: 

 Öffnen 

 Klicken Sie auf diese Schaltfläche, öffnet PlanMaker die selektierte Datei. 

Tipp: Sie können alternativ auch einen Doppelklick auf einen Dateinamen 

ausführen, um die Datei zu öffnen. 

 Schließen 

 Diese Schaltfläche beendet den Dateimanager. 

 Suchen 

 Klicken Sie diese Schaltfläche an, um nach bestimmten Dateien zu suchen oder 

einfach nur den Ordner auszuwählen, der im Dateimanager angezeigt werden 

soll. Ausführliche Informationen zum Thema „Suchen mit dem Dateimanager“ 

finden Sie im nächsten Abschnitt. 

 Ausgabe 

 Verwenden Sie diese Schaltfläche, um das selektierte Dokument auszugeben. 

Es öffnet sich dazu ein kleines Menü, das folgende Funktionen enthalten kann 

(anhängig vom verwendeten Betriebssystem): 

 E-Mail: Dokument per E-Mail versenden 

 Drucken: Dokument ausdrucken 

 Umbenennen 

 Klicken Sie diese Schaltfläche an, können Sie die selektierte Datei umbenen-

nen. 
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 Löschen 

 Klicken Sie diese Schaltfläche an, wird die selektierte Datei (nach Rückfrage) 

gelöscht. 

 Vorschau 

 Ein Mausklick auf diese Schaltfläche öffnet ein Fenster, in dem Sie das selek-

tierte Dokument betrachten können, ohne es dazu öffnen zu müssen. 

 Um dieses Dokument dann tatsächlich zu öffnen, klicken Sie auf die Schaltflä-

che Öffnen in der Vorschau. Um das Vorschaufenster hingegen zu verlassen, 

betätigen Sie die Schaltfläche Abbrechen. 

Suchen mit dem Dateimanager 

Mit Hilfe der Schaltfläche Suchen im Dateimanager können Sie PlanMaker nach 

bestimmten Dateien suchen lassen oder einfach nur den Ordner wählen, der im 

Dateimanager angezeigt werden soll. 

 

Sie können Dateien nach folgenden Kriterien suchen lassen: Dateiname, Ordner, 

Dateityp und den Angaben in den Dokumentinfos (Titel, Thema, Autor, Schlüssel-

wörter).  

Dabei lassen sich auch mehrere Suchkriterien kombinieren. Wählen Sie im Su-

chen-Dialog beispielsweise einen bestimmten Ordner, zeigt PlanMaker alle Doku-

mente in diesem Ordner an. Tragen Sie zusätzlich im Feld Titel einen Suchbegriff 

ein, findet PlanMaker alle Dokumente, die 1. im gewählten Ordner sind und 2. den 

angegebenen Suchbegriff im Feld Titel der Dokumentinfos enthalten. 

Mit dem oben abgebildeten Dialogfenster steuern Sie die Suchfunktion: 
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 Dateiname 

 Mit Hilfe dieses Eingabefelds können Sie nach bestimmten Dateien suchen. 

 Wenn Sie hier nichts eintragen (also die Vorgabe übernehmen), findet die Such-

funktion alle Dokumente des gewählten Dateityps im gewählten Ordner. 

 Wenn Sie einen eindeutigen Dateinamen wie LOHNSTEUER.PMD eintippen, wer-

den nur Dokumente mit exakt diesem Namen gefunden. 

 Wenn Sie einen mehrdeutigen Dateinamen wie LOHN*.PMD eintippen, findet 

die Suche alle Dokumente, deren Dateiname mit „Lohn“ beginnt.  

 Dateityp 

 Über diese Liste können Sie wählen, nach welchem Typ von Dateien gesucht 

werden soll. Möchten Sie beispielsweise nach Dateien im Excel-Format su-

chen, wählen Sie dieses Format in der Liste Dateityp. 

 Titel, Thema, Autor etc. 

 Durch Eingaben in diese Felder können Sie die Dokumentinfos (siehe hierzu 

auch Abschnitt „Dokumentinfos“) Ihrer Dokumente durchsuchen lassen.  

 Wenn Sie mehrere Felder ausfüllen, sucht PlanMaker nach Dokumenten in de-

nen alle diese Bedingungen zutreffen. Tragen Sie beispielsweise bei Schlüs-

selwörter „Steuer“ und bei Autor „Schmidt“ ein, werden nur Dokumente ge-

funden, bei denen die entsprechenden Felder der Dokumentinfos diese Texte 

enthalten. 

 Sie können auch nur Teile des gesuchten Begriffs angeben. Haben Sie also 

beim Feld Schlüsselwörter den Suchbegriff „Steuer“ eingetippt, werden alle 

Dokumente gefunden, bei denen Schlüsselwörter den Begriff „Steuer“ enthält 

– „Steuererhöhung“ wird also genauso gefunden wie „Meine Steuererklärung“. 

 Groß/Kleinschreibung spielt bei Ihren Eingaben keine Rolle – Dokumente mit 

dem Schlüsselwort „Einkommenssteuererklärung“ werden also auch gefunden, 

wenn der Suchbegriff „Steuer“ lautet. 

 Ordner 

 Hier können Sie wählen, in welchem Ordner PlanMaker die Suche durchführen 

soll. 

 Untergeordnete Ordner einbeziehen 

 Ist dieser Schalter aktiviert, durchsucht PlanMaker nicht nur den aktuellen Ord-

ner, sondern auch alle ihm untergeordneten Ordner. 
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 Schaltfläche Neue Dateiliste 

 Startet eine neue Suche mit den aktuellen Einstellungen.  

 Schaltfläche Liste ergänzen 

 Hier wird ebenfalls mit der Suche begonnen – mit dem Unterschied, dass die 

Liste der bei der letzten Suche gefundenen Dateien nicht zuvor geleert wird. 
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Gliederungen 

Bei umfangreichen Tabellen kann es sich lohnen, diese mit einer Gliederung zu 

versehen. Sie können dann nämlich bequem per Mausklick bestimmen, ob nur die 

wichtigsten Daten oder auch Detaildaten angezeigt werden sollen. 

Um eine Tabelle zu gliedern, gruppieren Sie die zusammengehörenden Detailda-

ten. Enthält die Tabelle beispielsweise die Umsätze für mehrere Jahre, jeweils un-

terteilt in die Umsätze pro Monat, selektieren Sie jeweils die Zeilen mit den Mona-

ten eines Jahres und fassen diese zu einer Gruppe zusammen. Fortan können Sie 

diese per Mausklick ein- und ausblenden – je nachdem, ob Sie nur die Jahresum-

sätze oder auch die Monatsumsätze betrachten möchten. 

Gliederungen dürfen übrigens auch mehrere Ebenen enthalten – Sie können also 

innerhalb einer Gruppe von Daten nochmals Daten gruppieren. 

Das Gliederungsfeld 

Sobald eine Tabelle gruppierte Daten enthält, erscheint links der Tabelle ein Glie-

derungsfeld: 
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Über dieses Gliederungsfeld können Sie nun per Mausklick bestimmen, welche 

Detaildaten angezeigt werden sollen: 

 Durch Anklicken der Plus-Symbole  und Minus-Symbole  im Gliederungs-

feld können Sie beliebige Gruppen von Detaildaten individuell ein- und aus-

blenden. 

 Mit Hilfe der Schaltflächen  ganz oben können Sie bestimmen, dass 

generell nur Detaildaten ab einer bestimmten Ebene angezeigt werden sollen. 

Klicken Sie beispielsweise auf die 2, werden nur Zeilen der ersten und zweiten 

Gliederungsebene angezeigt. 

Eine Gliederung kann übrigens nicht nur zeilenweise, sondern auch spaltenweise 

erfolgen. Sie gruppieren dabei also nicht Zeilen, sondern Spalten. Das Gliede-

rungsfeld erscheint in diesem Falle oberhalb der Tabelle. 
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Verwenden der Gliederungsleiste 

Sobald eine Tabelle gruppierte Zellen enthält, erscheint nicht nur das Gliederungs-

feld, sondern auch eine Gliederungsleiste. 

 

Diese enthält die wichtigsten Symbole zum Arbeiten mit Gliederungen (von links 

nach rechts): 

 Gliederungsfeld einschalten (funktioniert nur, wenn die Tabelle gruppierte Zel-

len enthält) oder ausschalten 

 Die markierten Zellen gruppieren 

 Gruppierung der markierten Zellen aufheben 

 Gliederung für die markierten Zellen gänzlich entfernen 

 Details einblenden (entspricht einem Klick auf das Plus-Symbol im Gliede-

rungsfeld) 

 Details ausblenden (entspricht einem Klick auf das Minus-Symbol im Gliede-

rungsfeld) 

Ausführlichere Informationen zum Arbeiten mit Gliederungen finden Sie auf den 

nächsten Seiten. 

Gruppieren von Zellen 

Um eine Tabelle mit einer Gliederung zu versehen, gruppieren Sie die Zeilen (oder 

wahlweise Spalten), die Detaildaten enthalten. Diese können Sie später dann je 

nach Bedarf per Mausklick ein- und ausblenden. 

Um Tabellenzellen zu gruppieren, gehen Sie wie folgt vor: 

1. Markieren Sie die Zeilen oder Spalten, die gruppiert werden sollen. 

2. Rufen Sie den Befehl Tabelle > Gliederung > Gruppieren auf. 

 Alternativ können Sie diesen Befehl auch über das Symbol  in der Gliede-

rungsleiste aufrufen. 
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Die Zellen sind nun gruppiert. 

Anmerkung: Nicht gruppierte Zellen haben eine Gliederungsebene von 1. Gruppie-

ren Sie Zellen, wird deren Gliederungsebene auf 2 erhöht. Sie können sogar einen 

Teil einer Gruppe von Zellen nochmals gruppieren, worauf diese auf Gliederungs-

ebene 3 gesetzt werden etc. Insgesamt sind maximal 8 Ebenen zulässig. 

Aufheben der Gruppierung von Zellen 

Sie können die Gruppierung von Zellen jederzeit wieder aufheben.  

Gehen Sie dazu wie folgt vor: 

1. Markieren Sie die Zeilen oder Spalten, deren Gruppierung aufgehoben werden 

soll. 

2. Rufen Sie den Befehl Tabelle > Gliederung > Gruppierung aufheben auf. 

 Alternativ können Sie diesen Befehl auch über das Symbol  in der Gliede-

rungsleiste aufrufen. 

Die Zellen sind nun nicht mehr gruppiert – genauer gesagt: ihre Gliederungsebene 

wird um eine Stufe reduziert. Wenden Sie diesen Befehl also auf Zellen mit Gliede-

rungsebene 3 an (sprich: gruppierte Zellen innerhalb bereits gruppierter Zellen), 

wird ihre Gliederungsebene auf 2 reduziert. 

Komplettes Entfernen der Gliederung von Zellen 

Möchten Sie die Gliederung von Zellen komplett entfernen, gehen Sie wie folgt 

vor: 

1. Markieren Sie die Zeilen oder Spalten, deren Gruppierung aufgehoben werden 

soll. Hinweis: Wenn Sie nichts markieren, wird die Gliederung der gesamten 

Tabelle entfernt. 

2. Rufen Sie den Befehl Tabelle > Gliederung > Gliederung entfernen auf. 

 Alternativ können Sie diesen Befehl auch über das Symbol  in der Gliede-

rungsleiste aufrufen. 

Die Gliederung der Zellen wurde nun vollständig entfernt, ihre Gliederungsebene 

ist also wieder auf 1 gesetzt. 
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Ein- und Ausblenden von gruppierten Zellen 

Wenn Sie, wie im vorherigen Abschnitt beschrieben, eine Tabelle mit einer Gliede-

rung versehen haben, können Sie Detaildaten (also gruppierte Zellen) bei Bedarf 

jederzeit ein- oder ausblenden. 

Verwenden Sie dazu das Gliederungsfeld, das automatisch links (beziehungsweise 

oberhalb) der Tabelle angezeigt wird, wenn die Tabelle gruppierte Zellen enthält. 

Sollte das Feld nicht eingeblendet werden, rufen Sie den Befehl Tabelle > Gliede-

rung > Gliederungsfeld automatisch einblenden auf. 

Folgendermaßen blenden Sie mit dem Gliederungsfeld gruppierte Zellen ein und 

aus: 

 Neben gruppierten Zellen erscheint ein Balken mit einem Minus-Symbol  im 

Gliederungsfeld. Klicken Sie dieses an, werden die gruppierten Zellen ausge-

blendet. 

 Neben ausgeblendeten Zellen erscheint ein Plus-Symbol  im Gliederungsfeld. 

Klicken Sie dieses an, werden die gruppierten Zellen wieder eingeblendet. 

 Mit Hilfe der Schaltflächen  ganz oben können Sie bestimmen, dass 

generell nur Detaildaten ab einer bestimmten Ebene angezeigt werden sollen. 

Klicken Sie beispielsweise auf die 2, werden nur Zeilen der ersten und zweiten 

Gliederungsebene angezeigt. 

Hinweis: Wenn Sie gruppierte Zellen ausblenden, werden diese nicht nur auf dem 

Bildschirm ausgeblendet, sondern auch in Diagrammen nicht mehr berücksichtigt. 

Einstellungen zur Gliederung ändern 

Mit dem Befehl Tabelle > Gliederung > Optionen können Sie folgende Einstel-

lungen zur Gliederung der aktuellen Tabelle vornehmen: 

 Titelzeile unterhalb Gruppenzeilen 

 Als Titelzeile bezeichnet man eine Zeile direkt oberhalb oder unterhalb von 

gruppierten Zellen, die beispielsweise eine Überschrift oder eine Zusammen-

fassung (zum Beispiel die Summe der Werte) enthalten kann.  

 Schalten Sie diese Option ein, wenn sich diese Titelzeile unterhalb der grup-

pierten Zellen befindet. Schalten Sie sie aus, wenn diese sich oberhalb der Zel-

len befindet. 
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 Diese Option bestimmt im Prinzip lediglich, ob im Gliederungsfeld die Minus-

symbole oberhalb oder unterhalb des Balkens für gruppierte Zellen angezeigt 

werden sollen. 

 Titelspalte rechts von Gruppenspalten 

 Diese Option entspricht der obigen Option; sie bezieht sich jedoch auf Tabellen, 

bei denen nicht Zeilen, sondern Spalten gruppiert wurden. Sie können damit 

festlegen, ob sich die Titelspalte links oder rechts der gruppierten Zellen befin-

det. 

 Gliederungsfeld automatisch anzeigen 

 Diese Option bestimmt, ob automatisch das Gliederungsfeld angezeigt werden 

soll, wenn die Tabelle gruppierte Zellen enthält.  

 Ist diese Option aktiviert, erscheint dieses Feld automatisch, sobald die Tabelle 

mindestens eine Gruppe von Zellen enthält. Ist sie deaktiviert, erscheint das 

Gliederungsfeld nicht. 

 Tipp: Alternativ können Sie diese Option über den Befehl Tabelle > Gliede-

rung > Gliederungsfeld automatisch anzeigen ein- und ausschalten. 

 Gliederungsansicht schützen 

 Wenn diese Option aktiviert ist, wird die Gliederung geschützt, wenn Sie den 

Blattschutz für das Arbeitsblatt aktivieren (siehe dazu auch Abschnitt 

„Blattschutz“ ab Seite 355). 

 Bei aktiviertem Blattschutz wird also der aktuelle Zustand der Gliederung „ein-

gefroren“. Der Anwender kann weder gruppierte Zellen ein- oder ausblenden, 

noch Zellen gruppieren oder ihre Gruppierung aufheben. 
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Internet-Funktionen 
PlanMaker ist mit folgenden Internet-Funktionen ausgestattet: 

 Verknüpfungen anbringen 

 Sie können in Dokumente Verknüpfungen („Links“) einfügen, die per Maus-

klick eine Internetadresse oder ein anderes PlanMaker-Dokument öffnen. 

 Dokumente im HTML-Format speichern 

 Sie können PlanMaker-Dokumente im HTML-Format speichern. Rufen Sie 

dazu den Befehl Datei > Speichern unter auf und wählen Sie in der Liste Da-

teityp das Format HTML. 

Ausführliche Informationen dazu folgen auf den nächsten Seiten. 

Verknüpfungen anbringen 

Mit dem Befehl Format > Verknüpfung können Sie in PlanMaker-Dokumenten 

Verknüpfungen (auch „Links“ genannt) anlegen und diese dann per Mausklick auf-

rufen.  

So können Sie beispielsweise einen Link auf eine Webseite anlegen. Klickt der 

Anwender diesen an, wird automatisch sein Internet-Browser gestartet und diese 

Seite darin angezeigt.  

Weiterhin lassen sich unter anderem Links auf ein anderes PlanMaker-Dokument 

einfügen, das beim Anklicken dieses Links automatisch geöffnet wird. 

Verknüpfung erstellen 

Um eine Verknüpfung zu erstellen, gehen Sie wie folgt vor: 

1. Markieren Sie den Text oder die Zelle, an dem/der eine Verknüpfung ange-

bracht werden soll. 

2. Rufen Sie den Befehl Format > Verknüpfung auf. 
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3. Geben Sie bei URL oder Datei das Ziel für die Verknüpfung an: Tragen Sie 

dazu den Pfad und Namen der Internet-Ressource oder Datei ein, auf die der 

markierte Text verweisen soll. 

 Für Links auf Internet-Seiten muss „http://“ und die Adresse der Seite eingetra-

gen werden – zum Beispiel „http://www.softmaker.de/index.htm“.  

4. Darunter können Sie auf Wunsch noch ein Sprungziel (eine Textmarke oder 

eine Zelladresse) in dem zu öffnenden Dokument angeben (siehe unten). Nor-

malerweise lassen Sie dieses Eingabefeld jedoch leer. 

5. Bestätigen Sie mit OK. 

Die Verknüpfung wird nun erstellt. Sie erkennen das daran, dass sich die Farbe des 

Textes ändert, um das Vorhandensein eines Links anzuzeigen. 

Tipp: Alternativ können Links auch mit der Tabellenfunktion HYPERLINK ein-

gefügt werden, die wesentlich flexibler in der Anwendung ist. 

Springen zu einer bestimmten Textmarke oder Zelladresse 

Im obigen Dialog können Sie bei Bedarf auch ein Sprungziel im zu öffnenden Do-

kument angeben. Tragen Sie dazu bei Sprungziel die Textmarke (bei HTML-

Dokumenten) beziehungsweise die Zelladresse (bei PlanMaker-Dokumenten) ein, 

zu der gesprungen werden soll. 

Tragen Sie beispielsweise bei Datei oder URL „Umsätze.pmd“ ein und bei 

Sprungziel die Adresse D42, wird beim Aufrufen dieses Links die Datei UMSÄT-

ZE.PMD geöffnet und der Zellrahmen darin auf die Zelle D42 gesetzt. 

Platzhalter in Verknüpfungen 

Tipp: Sie können in Verknüpfungen den Platzhalter * verwenden. Dieser steht 

stellvertretend für den Zellinhalt. 

Ein Beispiel: 

Sie rufen bei einer noch leeren Zelle den Befehl Format > Verknüpfung auf und 

tragen bei Datei oder URL http://* ein. Geben Sie in diese Zelle nun beispielswei-

se www.softmaker.de ein, zeigt die Verknüpfung auf die Adresse 

http://www.softmaker.de. 
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Verknüpfung aufrufen 

Um eine Verknüpfung aufzurufen, setzen Sie die Schreibmarke auf ein beliebiges 

Zeichen des Verknüpfungstextes. Dann rufen Sie den Befehl Bearbeiten > Gehe 

zur Verknüpfung auf. PlanMaker öffnet daraufhin das verknüpfte Dokument. 

Tipp: Sie können Verknüpfungen auch durch einfaches Anklicken des Verknüp-

fungstextes mit der Maus aufrufen. 

Verknüpfung bearbeiten oder entfernen 

Um eine bestehende Verknüpfung zu bearbeiten, markieren Sie zunächst den Ver-

knüpfungstext. Dann rufen Sie den Befehl Format > Verknüpfung auf. Es er-

scheint ein Dialogfenster, das dem oben beschriebenen Dialog entspricht. Hierin 

können Sie das Ziel für die Verknüpfung bearbeiten. 

Um eine Verknüpfung zu entfernen, gehen Sie wie folgt vor: 

 Verknüpfungstext samt Verknüpfung löschen 

 Wenn Sie den Text löschen, an dem eine Verknüpfung angebracht wurde, wird 

auch die Verknüpfung entfernt. 

 Nur Verknüpfung entfernen 

 Soll nur die Verknüpfung entfernt werden, der Text jedoch erhalten bleiben, 

markieren Sie diesen und rufen Format > Verknüpfung entfernen auf. 

Dokumente im HTML-Format speichern 

Um ein Dokument im HTML-Format zu speichern, gehen Sie folgendermaßen vor: 

1. Rufen Sie den Befehl Datei > Speichern unter auf. 

2. Wählen Sie in der Liste Dateityp das Format HTML. 

3. Geben Sie den Dateinamen an, unter dem die Datei gespeichert werden soll, 

und bestätigen Sie mit OK. 

Das Dokument wird nun im HTML-Format gespeichert.  

Dabei werden alle nicht vom HTML-Format unterstützten Formatierungen und 

Funktionen entfernt. Unter anderem bedeutet dies: 
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 Formatierungen, die das HTML-Format nicht kennt, werden nicht gespeichert. 

 Weiterhin sind HTML-Dateien nicht in der Lage, selbstständig Berechnungen 

durchzuführen. Deshalb rechnet PlanMaker beim Speichern im HTML-Format 

das komplette Arbeitsblatt durch und ersetzt alle Rechenformeln durch ihre Er-

gebnisse. 

Tipp: Öffnen Sie das Dokument nach dem Speichern mit Ihrem Internet-

Browser, um das endgültige Aussehen zu prüfen. 
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Ausgeben von Dokumenten 
In diesem Kapitel finden Sie Informationen darüber, wie Sie Ihre Dokumente mit 

PlanMaker ausgeben können. 

Das Kapitel enthält folgende Abschnitte: 

 Druckvorschau 

 Im ersten Abschnitt geht es um den Befehl Datei > Druckvorschau. Dieser 

stellt das Dokument exakt so auf dem Bildschirm dar, wie es beim Ausdruck er-

scheinen wird, und erspart so unnötige Probedrucke. 

 Drucken eines Dokuments 

 Um das aktuelle Dokument dann tatsächlich auf dem Drucker auszugeben, ru-

fen Sie den Befehl Datei > Drucken auf. 

 Exportieren eines Dokuments als PDF-Datei 

 Sie können ein Dokument auch in eine PDF-Datei ausgeben, indem Sie den 

Befehl Datei > Als PDF-Dokument exportieren aufrufen. 

 PDF-Dateien lassen sich auf praktisch jedem Computer betrachten, sofern dort 

ein geeignetes Anzeigeprogramm installiert ist. Alle Formatierungen und Ob-

jekte des Dokuments werden dabei originalgetreu wiedergegeben. 

 Mailen eines Dokuments 

 Schließlich lassen sich Dokumente auch per E-Mail versenden. Hierfür ist der 

Befehl Datei > Versenden zuständig. 

Ausführliche Informationen zu diesen Funktionen folgen auf den nächsten Seiten. 

Druckvorschau 

Die Druckvorschau gibt ein Dokument exakt so auf dem Bildschirm wieder, wie es 

im Ausdruck aussehen wird. Dies erspart unnötige Probeausdrucke. 

Um die Druckvorschau zu starten, rufen Sie den Befehl Datei > Druckvorschau 

auf.  
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Um sie wieder zu beenden, klicken Sie auf die Schaltfläche Schließen oder betäti-

gen die Taste (Esc). 

Die Symbolleiste der Druckvorschau 

Die Druckvorschau erscheint in einem eigenen Fenster. Dieses enthält eine Sym-

bolleiste mit folgenden Funktionen: 

 

Diese Schaltflächen dienen zum Blättern von Seite zu Seite. Die erste Schaltfläche 

ruft die erste Seite auf, die Schaltfläche ganz rechts die letzte Seite. Die beiden 

Schaltflächen mit einfachen Pfeilen blättern je eine Seite vor oder zurück.  

Das Eingabefeld in der Mitte erlaubt das gezielte Aufschlagen einer bestimmten 

Seite. Klicken Sie dazu in dieses Eingabefeld, tippen Sie die Seitenzahl ein und 

drücken Sie die Eingabetaste (¢). 

 

Die nächsten drei Schaltflächen haben folgende Funktionen: 

 Die linke Schaltfläche ruft den Befehl Datei > Seite einrichten auf, mit dem 

Sie das Seitenformat (Papiergröße, Ausrichtung, Kopf- und Fußzeilen etc.) fest-

legen können. Siehe auch Abschnitt „Seitenformat einstellen“ ab Seite 194. 

 Die mittlere Schaltfläche ruft den Befehl Datei > Drucken auf, mit dem Sie 

das Dokument ausdrucken können. Siehe auch Abschnitt „Drucken eines Do-

kuments“ ab Seite 345. 

 Die rechte Schaltfläche ruft den Befehl Datei > Als PDF-Dokument exportie-

ren auf, mit dem Sie aus dem Dokument eine PDF-Datei erzeugen können. 

Siehe auch Abschnitt „Exportieren eines Dokuments als PDF-Datei“ ab Seite 

348. 

 

In diesem Bereich können Sie die Vergrößerungsstufe ändern. Tragen Sie dazu in 

das Eingabefeld den gewünschten Prozentwert ein und drücken Sie die Eingabetas-

te (¢). Oder verwenden Sie die Schaltflächen rechts daneben, mit denen Sie fol-

gende Vergrößerungsstufen einstellen können: 

 Originalgröße (Vergrößerungsstufe 100%) 

 Auf Seitenhöhe zoomen 
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 Auf Seitenbreite zoomen 

Die Schaltfläche Schließen beendet die Druckvorschau. 

Drucken eines Dokuments 

Um das aktuelle Dokument auszudrucken, rufen Sie den Befehl Datei > Drucken 

auf oder betätigen das Tastenkürzel für diesen Befehl: (Strg)(P). 

 

Es erscheint ein Dialogfenster, in dem folgende Einstellungen gemacht werden 

können: 

Drucker 

Wählen Sie hier, auf welchem der installierten Drucker der Ausdruck erfolgen soll. 
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Die Schaltfläche Einrichten öffnet ein Fenster zum Einrichten und Konfigurieren 

von Druckern. Informationen hierzu finden Sie im Handbuch zu Ihrem Drucker.  

Linux-Anwender können hier außerdem das Kommando eintragen, das den 

Druckvorgang einleiten soll. 

Zu druckender Bereich 

Bestimmen Sie hier, welcher Teil des Dokuments gedruckt werden soll: 

 Gesamtes Dokument 

 Das gesamte Dokument (mit allen Arbeitsblättern) drucken. 

 Nur markierte Zellen 

 Nur die Zellen drucken, die derzeit im aktuellen Arbeitsblatt markiert sind. 

 Aktuelles Arbeitsblatt 

 Nur das aktuelle Arbeitsblatt drucken. 

 Nur markierte Arbeitsblätter 

 Nur diejenigen Arbeitsblätter drucken, die derzeit im Arbeitsblattregister mar-

kiert sind. 

 Nur folgende Arbeitsblätter 

 Nur bestimmte Arbeitsblätter drucken. Um diese auszuwählen, verwenden Sie 

die Liste unterhalb dieser Option. Setzen Sie darin per Mausklick ein Häkchen 

vor jedes Arbeitsblatt, das gedruckt werden sollen. 

Seiten 

Bestimmen Sie hier, welche Seiten gedruckt werden sollen: 

 Alle 

 Alle Seiten drucken. 

 Seiten: 

 Nur die angegebenen Seiten drucken. Tragen Sie dazu die gewünschten Seiten-

nummern ein. Einige Beispiele: 

12 Drucke nur Seite 12 
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12-15 Drucke die Seiten 12 bis 15 

12- Drucke alle Seiten ab Seite 12 

-12 Drucke die Seiten 1 bis 12 

 Sie auch mehrere solche Seitenangaben eintragen, indem Sie diese durch 

Kommata trennen: 

2-5, 12 Drucke die Seiten 2 bis 5 und die Seite 12 

etc.  

 Außerdem können Sie über die Option Zu druckende Seiten festlegen, ob alle 

gewählten Seiten oder nur die Seiten mit gerader beziehungsweise ungerader 

Seitennummer gedruckt werden sollen. 

 Bei Seiten pro Blatt können Sie bestimmen, wie viele Seiten auf ein Blatt Pa-

pier gedruckt werden sollen. Normalerweise druckt PlanMaker pro Blatt nur ei-

ne Seite aus; Sie können das Programm aber anweisen, pro Blatt beispielsweise 

vier (entsprechend verkleinerte) Seiten auf einmal auszugeben. 

Optionen 

Dieser Bereich enthält zusätzliche Optionen zum Drucken: 

 Exemplare 

 Hier lässt sich einstellen, wie viele Kopien des Dokuments gedruckt werden 

sollen. 

 Kopien sortieren 

 Diese Option bestimmt, ob die Druckausgabe beim Drucken mehrerer Kopien 

eines Dokuments nach Seitennummern sortiert werden soll. 

 Ist die Option eingeschaltet, werden beim Drucken mehrerer Kopien eines z.B. 

dreiseitigen Dokuments folgende Seiten ausgegeben: 1-2-3, 1-2-3, 1-2-3, ... 

 Wird sie ausgeschaltet, ist die Reihenfolge hingegen: 1-1-1..., 2-2-2..., 3-3-3... 

 Hinweis: Einige Drucker unterstützen dieses Feature nicht. 

 In Datei drucken 

 Lenkt die Druckausgabe in eine Datei um. 
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 Ohne Bilder 

 Überspringt beim Ausdruck alle Grafiken und Zeichnungen (nützlich für 

schnelle Testausdrucke). 

 Umgekehrte Reihenfolge 

 Druckt erst die letzte zu druckende Seite, dann die vorletzte etc. 

Den Ausdruck starten Sie mit OK. 

Tipp: Bevor Sie etwas tatsächlich ausdrucken, können Sie den Befehl Datei > 

Druckvorschau aufrufen, um eine Vorschau des Ausdrucks auf dem Bildschirm 

zu erhalten. Dies erspart Ihnen unnötige Probedrucke. 

Exportieren eines Dokuments als PDF-Datei 

Sie können ein Dokument auch in eine PDF-Datei ausgeben. 

PDF-Dateien lassen sich auf praktisch jedem Computer betrachten, sofern dort ein 

geeignetes Anzeigeprogramm (zum Beispiel der „Adobe Reader“) installiert ist. 

Alle Formatierungen und Objekte (Grafiken etc.) des Dokuments werden dabei 

originalgetreu wiedergegeben. 

Um von einem Dokument eine PDF-Datei zu erzeugen, gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Datei > Als PDF-Dokument exportieren auf. 

2. Es erscheint ein Dialogfenster. Nehmen Sie darin die gewünschten Einstellun-

gen vor (siehe unten) und bestätigen Sie mit OK. 

3. Nun erscheint ein weiterer Dialog. Geben Sie darin den Dateinamen an, unter 

dem die PDF-Datei gespeichert werden soll, und bestätigen Sie mit OK. 

Die PDF-Datei wird nun erzeugt. Um sie zu betrachten, starten Sie das Anzeige-

programm Ihrer Wahl und öffnen die Datei darin. 

Tipp: Falls auf Ihrem Rechner noch kein solches Programm installiert ist, finden 

Sie im Internet zahlreiche Programme, die für die Anzeige von PDF-

Dokumenten geeignet sind. Das am meisten verbreitete ist der kostenlose „Ado-

be Reader“. 

Das Dialogfenster des obigen Befehls erlaubt es Ihnen, folgende Einstellungen 

zum PDF-Export vorzunehmen: 
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Karteikarte Allgemein 

Auf dieser Karteikarte können Sie festlegen, ob nur Teile des Dokuments ausgege-

ben werden sollen, und weitere Einstellungen machen. Die Optionen entsprechen 

weitgehend denen des Befehls Datei > Drucken, der im Abschnitt „Drucken eines 

Dokuments“ (Seite 345) beschrieben wurde. 

Karteikarte Einstellungen 

Auf dieser Karteikarte können Sie Einstellungen zur Ausgabequalität machen: 

 AutoForm-Optionen 

 Hier lässt sich die Qualitätsstufe (sprich: Auflösung) einstellen, mit der Auto-

Formen und alle anderen Arten von Zeichnungen exportiert werden. Je höher 

die Qualitätsstufe, desto größer wird die erzeugte PDF-Datei. 

 Grafikoptionen 

 Hier können Sie festlegen, ob Bilder mit einer verlustfreien Komprimierung 

oder der verlustbehafteten JPEG-Komprimierung gespeichert werden sollen. 

Bei der JPEG-Komprimierung lässt sich weiterhin die Qualitätsstufe einstellen. 

Tipp: Normalerweise sollten Sie hier die verlustfreie Komprimierung wählen, 

da sie optimale Qualität gewährleistet. Enthält Ihr Dokument allerdings viele 

Bilder (speziell Fotos), kann dies zu einer sehr großen PDF-Datei führen. In 

diesem Falle ist die Verwendung der JPEG-Komprimierung zu empfehlen, da 

diese Fotos erheblich stärker komprimieren kann. 

 Die Option Für Transparenzen Alphakanal verwenden bestimmt, ob für die 

Darstellung von Transparenzen in Grafiken und Zeichnungen ein „Alphakanal“ 

verwendet werden soll. Normalerweise sehen diese am besten aus, wenn diese 

Option eingeschaltet ist. Manche PDF-Betrachter stellen Alphakanäle jedoch 

fehlerhaft dar, weshalb Sie diese Option auch abschalten können.  

 Weitere Optionen 

 PlanMaker-Dokument einbetten: Speichert eine Kopie des PlanMaker-

Dokuments innerhalb der PDF-Datei. Sie können diese PDF-Datei dann direkt 

in PlanMaker öffnen, worauf das Programm die PlanMaker-Datei daraus extra-

hiert und anzeigt. 

 Die Datei nach dem Export im PDF-Betrachter öffnen: Startet nach dem 

Erzeugen der PDF-Datei automatisch Ihren PDF-Betrachter (sofern einer instal-

liert ist) und zeigt die Datei darin an. 
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 Für Dateiverknüpfungen relative Pfade verwenden: Wandelt den Dateipfad 

von Verknüpfungen (Hyperlinks) auf Dateien automatisch in einen relativen 

Pfad (statt eines absoluten Pfads) um. Wenn Sie also beispielsweise einen Link 

auf die Datei c:\Dokumente\Listen\test.txt eingefügt haben und die PDF-Datei 

in den Ordner c:\Dokumente exportieren, wird dieser Link automatisch in „Lis-

ten\test.txt“ umgewandelt. 

 Schriftoptionen 

 Die Option Schriften einbetten lässt Sie wählen, ob die im Dokument verwen-

deten Schriften in die PDF-Datei eingebettet werden sollen.  

 Ist sie eingeschaltet, kann die PDF-Datei auf jedem Computer in den ursprüng-

lich verwendeten Schriften betrachtet werden – auch wenn der Computer diese 

Schriften nicht installiert hat. Ist sie ausgeschaltet, wird die PDF-Datei in auto-

matisch vom System gewählten Ersatzschriften angezeigt. 

Karteikarte Ansicht 

Diese Karteikarte enthält erweiterte Optionen zur Darstellung der PDF-Datei in 

einem PDF-Betrachter: 

 Navigationsfenster 

 Bestimmt, was im Navigationsfenster des PDF-Betrachters angezeigt werden 

soll. (Das Navigationsfenster ist die Leiste, die links von der PDF-Datei ange-

zeigt wird.) 

 Verfügbare Optionen: 

 Standard: Standardeinstellung des PDF-Betrachters verwenden 

 Keine Navigation: Im Navigationsfenster nichts anzeigen 

 Lesezeichen: Im Navigationsfenster alle Lesezeichen des Dokuments anzeigen 

 Miniaturseiten: Im Navigationsfenster Miniaturansichten aller Seiten des Do-

kuments anzeigen 

 Vergrößerungsstufe 

 Bestimmt, mit welcher Vergrößerungsstufe (Zoom) die PDF-Datei angezeigt 

werden soll: 

 Standard: Standardeinstellung des PDF-Betrachters verwenden 
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 Ganze Seite: Vergrößerungsstufe so einstellen, dass die gesamte Seite zu sehen 

ist 

 Seitenbreite: Auf die Seitenbreite zoomen 

 Seitenhöhe: Auf die Seitenhöhe zoomen 

 Benutzerdefiniert: Eigene Vergrößerungsstufe in Prozent festlegen 

 Seitenlayout 

 Bestimmt, mit welchem Layout die Seiten dargestellt werden sollen: 

 Standard: Standardeinstellung des PDF-Betrachters verwenden 

 Einzelne Seiten: Als einzelne Seiten anzeigen 

 Doppelseiten - ungerade Seiten links: Als Doppelseiten anzeigen (mit den 

ungeraden Seiten auf der linken Seite) 

 Doppelseiten - ungerade Seiten rechts: Als Doppelseiten anzeigen (mit den 

ungeraden Seiten auf der rechten Seite) 

 Weitere Einstellungen 

 Hier finden Sie folgende zusätzliche Optionen: 

 Dokumententitel anzeigen: Zeigt in der Titelleiste des PDF-Betrachters den 

Titel des Dokuments (statt seines Dateinamens) an. Tipp: Den Titel können Sie 

auf der Karteikarte Infos im Dialogfenster des Befehls Datei > Eigenschaften 

eintragen. 

 PDF-Betrachter auf Bildschirm zentrieren: Zentriert das Programmfenster 

des PDF-Betrachters nach dem Öffnen der PDF-Datei automatisch in der Bild-

schirmmitte. 

 Vollbildmodus: Schaltet den PDF-Betrachter nach dem Öffnen der PDF-Datei 

automatisch in den Vollbildmodus. 

 Menüleiste verbergen: Blendet die Menüleiste des PDF-Betrachters aus. 

 Symbolleisten verbergen: Blendet sämtliche Symbolleisten des PDF-

Betrachters aus. 

 Steuerelemente verbergen: Blendet die Steuerelemente für das Navigations-

fenster aus. 
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Karteikarte Schutz 

Mit Hilfe dieser Karteikarte können Sie die zu erzeugende PDF-Datei verschlüs-

seln und mit einem Kennwort vor dem Öffnen oder Abändern durch Unberechtigte 

schützen. 

 Art der Verschlüsselung 

 Hier können Sie bestimmen, ob die PDF-Datei verschlüsselt werden soll. Ne-

ben einer 40 Bit-Verschlüsselung, die mit relativ wenig Zeitaufwand zu kna-

cken ist, ist auch die erheblich sicherere 128 Bit-Verschlüsselung verfügbar. 

Hinweis: Die anderen Optionen in diesem Dialog werden erst verfügbar, 

wenn Sie eine Verschlüsselungsart ausgewählt haben. 

 Kennwort zum Öffnen des Dokuments 

 Wenn Sie hier ein Kennwort eingeben, fragt der PDF-Betrachter beim Öffnen 

der PDF-Datei nach diesem Kennwort. Wird ein falsches Kennwort eingege-

ben, kann der Anwender die Datei nicht öffnen. 

 Wenn Sie nichts eingeben, kann jedermann die Datei ohne Kennwort öffnen. 

 Kennwort zum Setzen von Zugriffsrechten 

 Des Weiteren können Sie die Zugriffsrechte für die PDF-Datei einschränken. 

Geben Sie dazu ein Kennwort für das Ändern der Rechte ein. Legen Sie dann 

mit Hilfe der Optionen im Bereich Zugriffsrechte fest, welche Rechte Anwen-

der haben sollen. 

 Hintergrundinformation: Manche PDF-Betrachter verfügen über einen Befehl 

zum Ändern der Zugriffsrechte. Ruft ein Anwender diesen Befehl auf, darf er 

nur fortfahren, wenn er das Kennwort eingibt, das Sie hier festgelegt haben. 

 Zugriffsrechte 

 Hier können Sie bestimmen, welche Zugriffsrechte Anwender auf die PDF-

Datei haben sollen, wenn sie diese in einem PDF-Betrachter öffnen. (Nur ver-

fügbar, wenn Sie oben ein Kennwort für das Setzen von Zugriffsrechten einge-

geben haben.) 
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Mailen eines Dokuments 

Sofern auf Ihrem Rechner ein geeignetes E-Mail-Programm installiert ist, können 

Sie Dokumente von PlanMaker aus per E-Mail versenden. 

Gehen Sie dazu wie folgt vor: 

1. Erstellen oder öffnen Sie das zu versendende Dokument. 

2. Rufen Sie in PlanMaker den Befehl Datei > Versenden auf.  

 Wenn Sie das Format PlanMaker-Dokument wählen, erhält der Empfänger eine E-Mail mit dem 
PlanMaker-Dokument als Anhang. Um dieses lesen zu können, benötigt er dementsprechend Plan-

Maker – oder den kostenlosen PlanMaker-Viewer von SoftMaker, der unter der Adresse 
www.softmaker.de/viewer.htm heruntergeladen werden kann. 

3. Wählen Sie das Format, in dem die E-Mail versandt werden soll.  

PlanMaker erzeugt nun eine entsprechende E-Mail und übergibt diese Ihrem E-

Mail-Programm. 

Hinweis: Der Empfänger erhält nicht den Inhalt des Dokuments als E-Mail, son-

dern eine E-Mail, die das PlanMaker-Dokument als Dateianhang enthält. Um das 

Dokument zu lesen, benötigt der Empfänger ebenfalls PlanMaker oder ein Pro-

gramm, das PlanMaker-Dateien anzeigen kann. 
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Schützen von Zellen und Tabellen 

Es gibt mehrere Möglichkeiten, Schutzmechanismen in Dokumente einzubauen. So 

können Sie beispielsweise das Editieren bestimmter Zellen verbieten oder gar das 

gesamte Dokument mit einem Kennwort gegen unberechtigtes Lesen schützen. 

Im Einzelnen stehen folgende Schutzmechanismen zur Verfügung: 

 Blattschutz 

 Mit dem Blattschutz können Sie bestimmte Zellen des Arbeitsblatts schützen. 

Wird der Blattschutz aktiviert, lassen sich diese Zellen beispielsweise nicht 

mehr ändern oder ihr Inhalt wird nicht mehr angezeigt. 

 Arbeitsmappenschutz 

 Mit dem Arbeitsmappenschutz können Sie verhindern, dass ein Anwender Ar-

beitsblätter hinzufügen, löschen oder ein-/ausblenden kann. 

 Dokumentschutz 

 Der Dokumentschutz schützt das komplette Dokument mit einem Kennwort 

gegen unberechtigtes Lesen oder Speichern. Beim Leseschutz wird das Doku-

ment zusätzlich verschlüsselt. 

Mehr zu den einzelnen Schutzarten erfahren Sie, in obiger Reihenfolge, auf den 

nächsten Seiten. 

Blattschutz 

Schalten Sie den Blattschutz für ein Arbeitsblatt ein, um dieses vor ungewollten 

Änderungen zu schützen. Bei aktiviertem Blattschutz werden alle entsprechend 

gekennzeichneten Zellen auf dem aktuellen Arbeitsblatt mit einem Schutz verse-

hen. Weiterhin sind zahlreiche Menübefehle ausgegraut (also nicht mehr aufrufbar) 

und es lassen sich keine Objekte mehr einfügen. 

Bevor Sie den Blattschutz aktivieren, müssen Sie jedoch mit dem Befehl Format > 

Zelle festlegen, welche Zellen geschützt werden sollen, und wie umfangreich der 

Schutz sein soll. 

Das Schützen von Zellen erfolgt also in zwei Schritten: 

 Erster Schritt: Schutzeinstellungen für Zellen festlegen 
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 Zweiter Schritt: Blattschutz aktivieren 

Lesen Sie dazu die nächsten Seiten. 

Erster Schritt: Schutzeinstellungen für Zellen festlegen 

Um Zellen zu schützen, legen Sie zunächst fest, welche Zellen geschützt werden 

sollen und wie umfangreich der Schutz sein soll.  

Dazu gehen Sie wie folgt vor: 

1. Markieren Sie die Zelle(n), deren Schutzeinstellungen geändert werden sollen. 

2. Rufen Sie den Befehl Format > Zelle auf. 

3. Wechseln Sie auf die Karteikarte Schutz. 

4. Wählen Sie die gewünschten Schutzeinstellungen (siehe unten). 

5. Bestätigen Sie mit OK. 

Die einzelnen Schutzeinstellungen im Dialogfenster dieses Befehls haben folgende 

Bedeutung: 

 Zelle schützen 

 Schützt die Zelle gegen Änderungen. 

 Bei aktiviertem Blattschutz kann also weder ihr Inhalt noch ihre Formatierung 

verändert werden. 

Wichtig: Standardmäßig ist diese Option bei allen Zellen aktiviert. Wenn Sie 

also möchten, dass bestimmte Zellen bei aktiviertem Blattschutz noch edi-

tierbar sein sollen, müssen Sie die Option Zellen schützen für diese Zellen 

ausschalten. 

 Formel nicht anzeigen 

 Zeigt bei Zellen, die eine Berechnung enthalten, die enthaltene Formel nicht 

mehr an, sondern nur ihr Ergebnis. 

 Bei aktiviertem Blattschutz kann also nicht mehr herausgefunden werden, wel-

che Berechnung diese Zelle enthält. 

 Zelle nicht anzeigen 

 Verbirgt den Inhalt der Zelle auf dem Bildschirm. 
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 Bei aktiviertem Blattschutz wird die Zelle also unsichtbar. Sie erscheint jedoch 

weiterhin im Ausdruck (siehe nächste Option). 

 Zelle nicht ausdrucken 

 Unterdrückt den Inhalt der Zelle im Ausdruck. 

 Bei aktiviertem Blattschutz erscheint die Zelle also im Ausdruck nicht, wenn 

Sie das Dokument drucken. 

Zweiter Schritt: Blattschutz aktivieren 

Der zweite Schritt beim Schützen von Zellen besteht darin, den Blattschutz für das 

aktuelle Arbeitsblatt zu aktivieren. 

Denn wenn Sie (wie gerade beschrieben) die Schutzeinstellungen von Zellen geän-

dert haben, hat dies noch keine Auswirkungen auf das Dokument. Sie müssen den 

Blattschutz erst aktivieren, damit diese Einstellungen wirksam werden. 

Hinweis: Der Aktivieren des Blattschutzes wirkt sich nur auf das aktuelle Ar-

beitsblatt aus. 

Um den Blattschutz für ein Arbeitsblatt zu aktivieren, gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Weiteres > Blattschutz auf. 

2. Nun können Sie auf Wunsch das Kennwort eingeben, das der Anwender ein-

geben muss, wenn er den Blattschutz wieder deaktivieren will. 

 Wenn Sie kein Kennwort vergeben möchten, lassen Sie das Eingabefeld einfach 

leer. 

3. Bestätigen Sie mit OK. 

Der Blattschutz ist nun aktiviert; die Schutzeinstellungen der Zellen werden jetzt 

also wirksam. 

Sie merken dies unter anderem daran, dass sich nur noch Zellen editieren lassen, 

bei denen die Einstellung Zelle schützen nicht aktiviert wurde. Diese Zellen wer-

den mit einem kleinen grünen Dreieck in der linken unteren Ecke gekennzeichnet. 

Dadurch sieht man sofort, welche Zellen sich bei aktiviertem Blattschutz noch ver-

ändern lassen. 
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Tipp: Wenn Sie den Blattschutz aktivieren, können beim Bewegen in der Tabelle 

mit der Taste (Tab) ausschließlich editierbare Zellen angefahren werden können. 

Geschützte Zellen werden übersprungen. 

Bei aktiviertem Blattschutz gibt es außerdem folgende Einschränkungen:  

 Die meisten Menübefehle zum Bearbeiten des Blattes sind gesperrt. 

 Bei Objekten lassen sich Position, Größe und auch alle anderen Eigenschaften 

nicht mehr verändern (außer bei Objekten, bei denen Sie die Eigenschaft Sper-

ren deaktiviert haben). 

 Text in Textrahmen lässt sich nicht mehr verändern (außer bei Objekten, bei 

denen Sie die Eigenschaft Text sperren deaktiviert haben). 

 Es lassen sich keine Objekte mehr auf dem Arbeitsblatt einfügen. 

Blattschutz deaktivieren 

Wenn Sie den Blattschutz aktiviert haben, können Sie diesen jederzeit wieder auf-

heben, indem Sie den Befehl Weiteres > Blattschutz aufheben aufrufen. 

Der Blattschutz wird dadurch wieder ausgeschaltet. 

Die mit Format > Zelle festgelegten Schutzeinstellungen sind nun also wieder 

unwirksam. PlanMaker merkt sie sich aber weiterhin. Wenn Sie den Blattschutz 

also erneut aktivieren, werden dieselben Schutzeinstellungen wieder aktiv. 

Tipp: Wenn Sie ein Dokument bei aktiviertem Blattschutz speichern, wird der 

Blattschutz automatisch wieder aktiviert, wenn das Dokument das nächste Mal 

geöffnet wird. Wenn der Blattschutz weiterhin mit einem Kennwort gesichert ist, 

kann er nur mit dem korrekten Kennwort deaktiviert werden. So können Sie Do-

kumente gegen Veränderungen durch Unbefugte schützen. 

Arbeitsmappenschutz 

Wenn Sie den Arbeitsmappenschutz aktivieren, verhindert PlanMaker sämtliche 

Änderungen, die Sie mit dem Arbeitsblattregister oder dem Befehl Tabelle > Blatt 

durchführen könnten. 

Dies hat folgende Auswirkungen: 
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 Es können keine Arbeitsblätter mehr hinzugefügt werden. 

 Arbeitsblätter lassen sich nicht mehr kopieren, löschen oder umbenennen. 

 Arbeitsblätter lassen sich nicht mehr ein- oder ausblenden. 

Ausführlichere Informationen dazu finden Sie auf den nächsten Seiten. 

Arbeitsmappenschutz aktivieren 

Um den Arbeitsmappenschutz zu aktivieren, gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Weiteres > Arbeitsmappenschutz auf. 

2. Nun können Sie auf Wunsch das Kennwort eingeben, das der Anwender ein-

geben muss, wenn er den Arbeitsmappenschutz wieder deaktivieren will.  

 Wenn Sie kein Kennwort vergeben möchten, lassen Sie das Eingabefeld einfach 

leer. 

3. Bestätigen Sie mit OK. 

Der Arbeitsmappenschutz ist nun aktiviert; es lassen sich nun also keine Arbeits-

blätter mehr einfügen, löschen, ein-/ausblenden etc. 

Darüber hinaus ist der größte Teil der Optionen im Dialogfenster des Befehl Datei 

> Eigenschaften nicht mehr verfügbar. 

Arbeitsmappenschutz deaktivieren 

Wenn Sie den Arbeitsmappenschutz aktiviert haben, können Sie diesen jederzeit 

wieder aufheben, indem Sie den Befehl Weiteres > Arbeitsmappenschutz aufhe-

ben aufrufen. 

Der Arbeitsmappenschutz wird dadurch wieder deaktiviert; das Einblenden, Lö-

schen, Ein-/Ausblenden etc. von Arbeitsblättern ist also wieder möglich. 

Tipp: Wenn Sie ein Dokument mit aktiviertem Arbeitsmappenschutz speichern, 

wird der Arbeitsmappenschutz automatisch wieder aktiviert, wenn das Dokument 

das nächste Mal geöffnet wird. Wenn der Schutz weiterhin mit einem Kennwort 

gesichert ist, kann er nur mit dem korrekten Kennwort deaktiviert werden. So 

können Sie Dokumente optimal gegen Veränderungen durch Unbefugte schüt-

zen. 
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Dokumentschutz 

Sie können Dokumente gegen unberechtigtes Lesen oder Speichern schützen, in-

dem Sie sie mit einem Dokumentschutz – genauer gesagt einem Lese- und/oder 

Schreibschutz – versehen. Öffnen beziehungsweise Speichern eines geschützten 

Dokuments ist nur nach Eingabe des korrekten Kennworts möglich. 

Um ein Dokument zu schützen, rufen Sie darin den Befehl Datei > Eigenschaften 

auf, wechseln auf die Karteikarte Schutz und wählen die Art des Dokumentschut-

zes. Tragen Sie außerdem das gewünschte Lese- und/oder Schreibkennwort ein. 

Es gibt folgende Arten von Dokumentschutz: 

 Kein Schutz 

 Schreibschutz (Dokument kann geöffnet werden, lässt sich aber nur mit 

Kennwort speichern) 

 Leseschutz (Dokument kann nur mit Kennwort geöffnet werden) 

 Schutz abhängig vom Kennwort (Kombination aus Lese- und Schreibschutz) 

Ausführliche Informationen folgen auf den nächsten Seiten. 

Dokumentschutz aktivieren 

Sie können Dokumente vor unberechtigtem Lesen oder Speichern schützen, indem 

Sie sie mit einem Dokumentschutz – genauer gesagt einem Lese- und/oder Schreib-

schutz – versehen. Öffnen beziehungsweise Speichern eines geschützten Doku-

ments ist nur nach Eingabe des Kennworts möglich. 

Beim Leseschutz wird das Dokument zusätzlich verschlüsselt, damit es auch mit 

anderen Programmen nicht eingesehen werden kann. 

Um ein Dokument zu schützen, gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Datei > Eigenschaften auf.  

2. Wechseln Sie auf die Karteikarte Schutz. 

3. Wählen Sie die gewünschte Art von Dokumentschutz (siehe unten). 

4. Im Gegensatz zu Blattschutz und Arbeitsmappenschutz müssen Sie beim Do-

kumentschutz immer ein Kennwort vergeben. Tragen Sie nun also ein Lese- 

und/oder Schreibkennwort ein (mindestens 4, maximal 15 Zeichen). 
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Wichtig: Wenn Sie ein Kennwort vergessen, kann das Dokument nicht mehr 

geöffnet beziehungsweise gespeichert werden. Es ist daher ratsam, sich das 

Kennwort zu notieren. Achten Sie dabei genau auf die Groß-/Kleinschrei-

bung! 

5. Bestätigen Sie mit OK. 

6. Es erscheint ein Dialog, in dem Sie das Lese- und/oder Schreibkennwort zur 

Kontrolle noch einmal eingeben müssen. 

7. Bestätigen Sie mit OK. 

8. Verlassen Sie das Dialogfenster mit OK. 

9. Speichern Sie das Dokument, damit die Änderungen wirksam werden. 

Zukünftig wird beim Öffnen dieses Dokuments automatisch das Kennwort erfragt. 

Wenn das richtige Kennwort angegeben wird, wird der Schutz vorübergehend au-

ßer Kraft gesetzt. 

Sie können im obigen Dialog zwischen folgenden Arten von Dokumentschutz wäh-

len: 

 Kein Schutz 

 Das Dokument wird nicht geschützt. Dies ist die Standardeinstellung. 

 Schreibschutz 

 Beim Öffnen des Dokuments wird der Anwender dazu aufgefordert, das 

Schreibkennwort einzugeben. Das Dokument kann nur dann gespeichert wer-

den, wenn hier das korrekte Schreibkennwort angegeben wird.  

 Wird ein falsches Kennwort oder überhaupt nichts eingegeben, wird das Do-

kument schreibgeschützt geöffnet. Es kann dann nicht gespeichert werden – 

auch nicht unter einem anderen Namen. 

 Leseschutz 

 Versucht ein Anwender, das Dokument zu öffnen, wird er dazu aufgefordert, 

das Lesekennwort anzugeben. Wird ein falsches Kennwort eingegeben, lässt 

sich das Dokument nicht öffnen.  

 Das Dokument wird hierbei außerdem verschlüsselt gespeichert, damit es auch 

mit anderen Programmen nicht eingesehen werden kann. 
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 Schutz abhängig vom Kennwort 

 Hier erscheinen beim Öffnen des Dokuments zwei Kennwortabfragen hinterei-

nander. Erst wird nach dem Lesekennwort gefragt, dann nach dem 

Schreibkennwort. 

 Gibt der Anwender nur das Lesekennwort ein, darf er das Dokument öffnen, 

aber nicht speichern.  

 Gibt er außerdem das Schreibkennwort ein, hat er vollen Zugriff, kann das Do-

kument also auch speichern. 

 Gibt er ein falsches Kennwort oder überhaupt nichts ein, wird der Zugriff auf 

das Dokument komplett verweigert. 

Dokumentschutz deaktivieren 

Wenn Sie ein lese- oder schreibgeschütztes Dokument öffnen und dabei das kor-

rekte Kennwort angeben, wird der Schutz deaktiviert – allerdings nur vorüberge-

hend. Wenn Sie dieses Dokument nämlich schließen, wird der Schutz wieder 

„scharfgemacht“; beim nächsten Öffnen erscheint also erneut die Abfrage für das 

Kennwort. 

Um den Schutz eines Dokuments permanent zu entfernen, gehen Sie wie folgt vor: 

1. Öffnen Sie das Dokument. 

2. Rufen Sie den Befehl Datei > Eigenschaften auf.  

3. Wechseln Sie auf die Karteikarte Schutz. 

4. Wählen Sie die Option Kein Schutz. 

5. Bestätigen Sie mit OK. 

6. Speichern Sie das Dokument, damit die Änderung wirksam wird. 

Der Dokumentschutz ist nun dauerhaft deaktiviert. 

Beim nächsten Öffnen des Dokuments erscheint keine Kennwortabfrage mehr. 

Jeder Anwender kann das Dokument nun wieder öffnen/speichern. 
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Fremdformate 

PlanMaker speichert Dokumente normalerweise in seinem „hauseigenen“ Da-

teiformat namens PlanMaker-Dokument ab. PlanMaker-Dokumente können leicht 

an der Namenserweiterung .PMD erkannt werden. Wenn Sie zum Beispiel ein Do-

kument unter dem Namen „Lohnsteuer“ speichern, lautet sein vollständiger Datei-

name LOHNSTEUER.PMD. 

Sie können PlanMaker aber auch anweisen, Dateien in einem anderen Dateiformat 

zu speichern. Dies ist nötig, wenn Sie beispielsweise ein PlanMaker-Dokument mit 

einem anderen Programm weiterbearbeiten möchten. Umgekehrt können Sie mit 

PlanMaker auch Dokumente öffnen, die mit anderen Tabellenkalkulationen erstellt 

wurden, also in einem Fremdformat vorliegen. 

In diesem Kapitel erfahren Sie alles Wissenswerte dazu. Es enthält folgende Ab-

schnitte: 

 Speichern und Öffnen von Fremdformaten 

 Im ersten Abschnitt erfahren Sie, wie Sie Dokumente in einem anderen Da-

teiformat speichern oder öffnen: Einfach den Befehl Datei > Speichern unter 

beziehungsweise Datei > Öffnen aufrufen und in der Liste Dateityp das ge-

wünschte Format einstellen. 

 Anmerkungen zum Textformat 

 Beim Öffnen oder Speichern von Textdateien erscheint ein Dialogfenster mit 

zusätzlichen Optionen. Hier finden Sie alle Informationen dazu. 

 Anmerkungen zum Excel-Format 

 Der letzte Abschnitt widmet sich dem Dateiformat von Microsoft Excel. Sie 

erfahren darin alles Wissenswerte über den Datenaustausch zwischen PlanMa-

ker und Excel. 

Lesen Sie dazu die nächsten Seiten. 

Speichern und Öffnen von Fremdformaten 

Folgendermaßen speichern oder öffnen Sie Dokumente in einem anderen Da-

teiformat: 
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Speichern eines Dokuments in einem Fremdformat 

Um das aktuelle Dokument in einem anderen Dateiformat zu speichern, rufen Sie 

den Befehl Datei > Speichern unter auf und öffnen die aufklappbare Liste Datei-

typ. Wählen Sie darin das gewünschte Format, geben Sie bei Bedarf einen anderen 

Dateinamen an und bestätigen Sie mit OK. 

Öffnen eines in einem Fremdformat vorliegenden Dokuments 

Um ein Dokument, das in einem anderen Dateiformat vorliegt, zu öffnen, rufen Sie 

den Befehl Datei > Öffnen auf, öffnen die Liste Dateityp und wählen das Format 

aus, in dem die Datei vorliegt. Wählen Sie dann die zu öffnende Datei und bestäti-

gen Sie mit OK. 

Unterstützte Dateiformate 

In den Dialogen zum Öffnen und Speichern von Dokumenten werden in der Liste 

Dateityp unter anderem folgende Dateiformate angeboten: 

 PlanMaker-Dokument 

 Das Hausformat für PlanMaker-Dokumente, in dem Sie Dokumente üblicher-

weise speichern 

 PlanMaker-Vorlage 

 Dokumentvorlage für PlanMaker-Dokumente (siehe dazu auch Abschnitt 

„Dokumentvorlagen“ ab Seite 181) 

 Microsoft Excel-Dokument 

 Sie können Dokumente auch im Dateiformat von Microsoft Excel öffnen und 

speichern. Unterstützt werden sowohl Excel 5.0 bis 2003 (.xls-Dateien) als 

auch Excel 2007 bis 2010 (.xlsx-Dateien). 

 Weitere Informationen zum Arbeiten mit Excel-Dateien finden Sie im Abschnitt 

„Anmerkungen zum Excel-Format“ ab Seite 367. 

 Microsoft Excel-Vorlage 

 Dokumentvorlage für Microsoft Excel-Dokumente 

 TextMaker-Datei (nur Speichern) 

 Speichert das Dokument in einem von der Textverarbeitung TextMaker lesba-

ren Dateiformat. 



 

Handbuch PlanMaker Fremdformate    365 

 PlanMaker 2010-Dokument und PlanMaker 2008-Dokument 

 Speichert das Dokument im Dateiformat von PlanMaker 2010 oder 2008, älte-

ren Versionen von PlanMaker. 

 dBase 

 dBase-Datenbank, wahlweise mit DOS-, Windows- oder Unicode-Zeichensatz. 

Vor dem Öffnen/Speichern der Datenbank erscheint ein Dialog, in dem Sie den 

Zeichensatz auswählen können. 

 Beachten Sie: Die meisten Datenbanken liegen im Format dBase/DOS vor – 

nicht im Format dBase/Windows. Selbst Windows-Datenbankprogramme ver-

wenden in der Regel das DOS-Format. 

 Textdatei 

 Textdatei, zum Beispiel mit Tabulatoren oder Strichpunkten als Trenner zwi-

schen den einzelnen Zellwerten. Siehe Abschnitt „Anmerkungen zum Textfor-

mat“ im Anschluss. 

Anmerkungen zum Textformat 

Wie im vorherigen Abschnitt erwähnt, können Sie mit PlanMaker auch reine Text-

dateien (zum Beispiel CSV-Dateien) öffnen und speichern: 

 Um eine Textdatei zu öffnen, rufen Sie Datei > Öffnen auf, wählen die ge-

wünschte Datei und bestätigen mit OK. 

 Um ein Dokument als Textdatei zu speichern, rufen Sie Datei > Speichern 

unter auf, wählen bei Dateityp den Eintrag Textdatei, geben den gewünschten 

Dateinamen ein und bestätigen mit OK. 

In beiden Fällen erscheint daraufhin ein zusätzlicher Dialog, in dem sich bei Be-

darf das Format der Textdatei genau festlegen lässt. 

Der Dialog enthält folgende Optionen: 

Optionen beim Speichern einer Textdatei 

Wenn Sie ein Dokument als Textdatei speichern, können Sie in dem Dialog fol-

gende Einstellungen vornehmen: 
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 Zeichensatz 

 Hier können Sie festlegen, mit welchem Zeichensatz die Textdatei gespeichert 

werden soll. 

 Hinweis: PlanMaker schlägt automatisch einen geeigneten Zeichensatz vor. In 

der Regel können Sie diese Vorgabe übernehmen. 

 Datenformat 

 Hier können Sie einstellen, in welchem Format die Zellinhalte in der Textdatei 

gespeichert werden sollen. Folgende Optionen stehen zur Wahl: 

 Trennzeichen zwischen den Feldern: Hier werden die Zellinhalte jeweils 

durch ein bestimmtes Trennzeichen voneinander getrennt (zum Beispiel einem 

Strichpunkt oder einem Tabulator). 

 Beispiel: 

 Peter;Müller-Lüdenscheidt;12345;Buxtehude 

 Thomas;Meier;54321;Neustadt 

 Feste Feldbreiten: Hier hingegen werden die Zellinhalte auf Spalten mit festen 

Breiten verteilt. Zwischenräume werden dabei mit Leerzeichen aufgefüllt.  

 Beispiel: 

 Peter   Müller-Lüdenscheidt  12345  Buxtehude 

 Thomas  Meier                54321  Neustadt 

 Trennzeichen 

 Hier können Sie bestimmen, welches Trennzeichen PlanMaker verwenden soll, 

um die einzelnen Zellinhalte einer Zeile voneinander abzugrenzen (zum Bei-

spiel Strichpunkte oder Tabulatoren). 

Hinweis: Das Trennzeichen sollte innerhalb der Zellinhalte natürlich nicht 

vorkommen, da PlanMaker dort sonst aus einer Zelle zwei Einträge machen 

würde. 

 Texterkennungszeichen 

 Auf Wunsch kann PlanMaker alle Zellen, die Text enthalten, mit einem be-

stimmten Zeichen umgeben (zum Beispiel Anführungszeichen).  

 Falls Sie das möchten, wählen Sie das gewünschte Zeichen aus der Liste. 
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 Zeilen beenden mit ... 

 Hier können Sie auswählen, welche Steuerzeichen am Ende jeder Zeile einge-

fügt werden sollen (um den Beginn einer neuen Zeile zu kennzeichnen). 

 Hinweis: PlanMaker schlägt automatisch geeignete Steuerzeichen vor. In der 

Regel können Sie diese Vorgabe übernehmen. 

 Folgende Optionen stehen zur Wahl: 

 CR+LF: Dies ist die empfohlene Einstellung für Windows. 

 LF: Dies ist die empfohlene Einstellung für Linux und Unix. 

 CR: Dieses Steuerzeichen war auf älteren Apple Mac-Systemen (vor Mac OS 

X) üblich. 

Optionen beim Öffnen einer Textdatei 

Beim Öffnen einer Textdatei werden die gleichen Optionen angeboten wie beim 

Speichern. Verwenden Sie diese, um PlanMaker mitzuteilen, welches Format die 

Textdatei hat, die geöffnet werden soll. 

Eine Option gibt es beim Öffnen zusätzlich: 

 Anzahl der Überschriftzeilen 

 Falls die Textdatei in den ersten Zeilen eine Überschrift (oder erläuternden Text 

o.ä.) enthält, können Sie hier einstellen, um wie viele Zeilen es sich handelt. 

PlanMaker wird diese Zeilen dann nicht auf mehrere Spalten verteilen, wie den 

Rest der Daten, sondern sie unverändert in jeweils einer Tabellenzelle ablegen. 

 Der Standardwert ist 0 (sprich: keine Überschriftzeilen vorhanden). 

Anmerkungen zum Excel-Format 

Wenn Sie vor dem Einsatz von PlanMaker die Tabellenkalkulation Microsoft Excel 

verwendet haben, wird Sie freuen, dass PlanMaker praktisch alle Excel-Dateien 

anstandslos öffnen kann. Umgekehrt ist mit PlanMaker auch das Speichern von 

Dokumenten im Excel-Format möglich. 

Auf den nächsten Seiten erfahren Umsteiger von Excel auf PlanMaker, was sie 

beim Öffnen und Speichern von Excel-Dateien beachten sollten. 
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Öffnen und Speichern von Excel-Dokumenten 

Wie im Abschnitt „Speichern und Öffnen von Fremdformaten“ beschrieben, kann 

PlanMaker auch Dateien im Excel-Format öffnen und speichern. 

Dies funktioniert in fast allen Fällen reibungslos. Manche Rechenfunktionen lassen 

sich jedoch nicht ohne manuellen Eingriff konvertieren, da sie a) Excel bezie-

hungsweise PlanMaker unbekannt sind oder b) in Excel beziehungsweise PlanMa-

ker unterschiedlich arbeiten. 

Was in diesem Fall zu tun ist, erfahren Sie hier: 

Warnmeldung beim Öffnen eines Excel-Dokuments 

Falls Sie beim Öffnen einer Excel-Datei die nachfolgende Hinweismeldung erhal-

ten, konnte PlanMaker nicht alle Rechenformeln umsetzen: 

 

Gehen Sie dann wie folgt vor: 

1. Aktivieren Sie mit dem Befehl Ansicht > Syntaxhervorhebung die Syn-

taxhervorhebung. 

2. Alle Zellen, die mit einer farblichen Hinterlegung versehen worden sind, konn-

ten nicht konvertiert werden.  

 Diese Zellen müssen von Hand nachbearbeitet werden. Vergleichen Sie ihren 

Inhalt mit dem der entsprechenden Zelle im Excel-Dokument. Versuchen Sie, 

die inkompatiblen Rechenfunktionen durch PlanMaker-Funktionen zu ersetzen. 

Ausführliche Informationen zu allen von PlanMaker unterstützten Rechenfunk-

tionen finden Sie im Abschnitt „Funktionen von A-Z“ ab Seite 455. 

3. Wenn alle Korrekturen erledigt sind, können Sie die Syntaxhervorhebung wie-

der ausschalten. 

Nun können Sie das überarbeitete Dokument gegebenenfalls noch im PlanMaker-

Format speichern. 
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Warnmeldung beim Speichern eines Dokuments im Excel-Format 

Wenn Sie ein PlanMaker-Dokument im Excel-Format speichern, erscheint die fol-

gende Warnmeldung, falls das Dokument Rechenformeln enthält, die nicht Excel-

kompatibel sind: 

 

Gehen Sie dann wie folgt vor: 

1. Aktivieren Sie mit dem Befehl Ansicht > Syntaxhervorhebung die Syn-

taxhervorhebung. 

2. Korrigieren Sie alle Zellen, die nun mit einem farbigen Hintergrund gekenn-

zeichnet worden sind, von Hand. Versuchen Sie, für die darin verwendeten Re-

chenfunktionen eine entsprechende Excel-Funktion zu finden. Informationen 

dazu finden Sie in der Hilfe zur betreffenden Rechenfunktion. 

3. Wenn alle Korrekturen erledigt sind, können Sie die Syntaxhervorhebung wie-

der ausschalten. 

Speichern Sie das Dokument nun erneut im Excel-Format. Erscheint dabei keine 

Warnmeldung mehr, sind alle Inkompatibilitäten beseitigt. 

Unterschiede zwischen PlanMaker und Excel 

In diesem Abschnitt finden Sie eine Liste aller Funktionen, die in PlanMaker und 

Microsoft Excel unterschiedlich implementiert sind: 

Allgemeines 

 PlanMaker kann in Excel-Dokumenten enthaltene Makros und VBA-Scripts 

nicht ausführen. Diese bleiben jedoch im Dokument erhalten und werden kor-

rekt abgespeichert, wenn Sie ein Dokument mit PlanMaker im Excel-Format 

speichern. 
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Rechenfunktionen 

 Einige Rechenfunktionen von PlanMaker werden von Excel nicht unterstützt 

(und umgekehrt). Beim Öffnen oder Speichern einer Excel-Datei, die solche 

Funktionen enthält, erscheint daher automatisch ein entsprechender Hinweis. 

Siehe dazu Abschnitt „Öffnen und Speichern von Excel-Dokumenten“ ab Seite 

368. 

Operatoren 

 Der Schnittmengen-Operator ist bei Excel die Leertaste, bei PlanMaker hin-

gegen das Zeichen \ (umgedrehter Schrägstrich). Dieser Operator wird daher 

beim Öffnen/Speichern von Excel-Dateien automatisch umgewandelt. 

 Für erweiterte Zellbezüge ist in Excel die Schreibweise A1:B3:D5 erlaubt. Bei 

PlanMaker muss dies hingegen als A1:B3~D5 notiert werden. Diese Schreib-

weise wird daher beim Öffnen/Speichern von Excel-Dateien automatisch um-

gewandelt. 

 Bei Excel ist die Rangfolge der Operatoren für Potenzierung (^) und das nega-

tive Vorzeichen (-) fälschlicherweise vertauscht. PlanMaker verwendet hinge-

gen die korrekte Reihenfolge. So ergibt beispielsweise -1^2 in Excel 1, in 

PlanMaker hingegen das korrekte Ergebnis -1 (da die Potenzierung vor dem 

Vorzeichenwechsel durchgeführt werden muss). 

 PlanMaker löst dieses Kompatibilitätsproblem beim Öffnen/Speichern von 

Excel-Dateien jedoch automatisch, indem er den Operator ^ durch die Rechen-

funktion POTENZ (die auch in Excel korrekt arbeitet) ersetzt. 
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Arbeiten mit arabischem Text 

Sie können in Ihren PlanMaker-Dokumenten auch arabische Schrift verwenden. In 

diesem Kapitel erfahren Sie alles Wissenswerte dazu. Es enthält folgende Ab-

schnitte: 

 Aktivieren der Unterstützung für arabischen Text 

 Ändern der Schreibrichtung in Tabellenzellen 

 Ändern der Schreibrichtung in Textrahmen 

 Ändern der Richtung von Arbeitsblättern 

 Ändern der Schriftart für arabischen Text (in Textrahmen) 

Lesen Sie dazu die nächsten Seiten. 

Wichtig: Die in diesem Kapitel beschriebenen Funktionen stehen nur zur Verfü-

gung, wenn in den Einstellungen die Option Erweiterte Unterstützung für 

arabischen Text aktiviert wurde. Lesen Sie dazu den nächsten Abschnitt. 

Aktivieren der Unterstützung für arabischen 

Text 

PlanMaker verfügt über eine „erweiterte Unterstützung für arabischen Text“, die 

einige zusätzliche Funktionen für das Bearbeiten von Text in arabischer Schrift 

bereitstellt. 

Um diese Option zu aktivieren, gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Weiteres > Einstellungen auf. 

2. Wechseln Sie auf die Karteikarte Allgemein. 

3. Schalten Sie darin die Option Erweiterte Unterstützung für arabischen Text 

ein. 

Wichtig: Nur wenn diese Option aktiviert ist, stehen die auf den nächsten Seiten 

beschriebenen Funktionen zur Verfügung. 
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Ändern der Schreibrichtung in Tabellenzellen 

Ist die Option Erweiterte Unterstützung für arabischen Text in den Einstellun-

gen aktiviert, können Sie in einer Tabellenzelle jederzeit die Schreibrichtung zwi-

schen links-nach-rechts und rechts-nach-links umschalten. 

Gehen Sie dazu wie folgt vor: 

1. Rufen Sie in der Zelle den Befehl Format > Zelle auf. 

2. Wechseln Sie auf die Karteikarte Ausrichtung. 

3. Wählen Sie bei Schreibrichtung die gewünschte Option: kontextabhängig, 

links-nach-rechts oder rechts-nach-links. 

Tipp: Bei der Standardeinstellung Kontextabhängig ermittelt PlanMaker die ge-

eignete Schreibrichtung selbstständig: Wenn Sie in die Zelle also Text in Arabisch 

eingeben, wird die Schreibrichtung automatisch auf rechts-nach-links gesetzt, an-

dernfalls auf links-nach-rechts. 

Ändern der Schreibrichtung in Textrahmen 

In Textrahmen können Sie die Schreibrichtung für den aktuellen Absatz jederzeit 

zwischen links-nach-rechts und rechts-nach-links umschalten – sofern in den Ein-

stellungen die Option Erweiterte Unterstützung für arabischen Text aktiviert ist. 

Gehen Sie dazu wie folgt vor: 

1. Setzen Sie die Schreibmarke in den gewünschten Absatz des Textrahmens. 

2. Rufen Sie den Befehl Format > Absatz auf. 

3. Wechseln Sie auf die Karteikarte Absatz. 

4. Schalten Sie unter Schreibrichtung die Option Rechts nach links ein, um die 

Schreibrichtung auf rechts-nach-links zu setzen.  

 Schalten Sie die Option aus, wenn die Schreibrichtung auf links-nach-rechts 

gesetzt werden soll. 
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Tipp: Verwenden der Tastatur 

Viel schneller geht das Ändern der Schreibrichtung eines Absatzes in einem Text-

rahmen, wenn Sie dafür die folgenden Tastenkürzel verwenden: 

 Wenn Sie gleichzeitig (Strg) und die linke Umschalttaste (ª) drücken, wird die 

Schreibrichtung auf links-nach-rechts gesetzt. 

 Wenn Sie gleichzeitig (Strg) und die rechte Umschalttaste (ª) drücken, wird 

die Schreibrichtung auf rechts-nach-links gesetzt. 

Anmerkung: Auf manchen Systemen (z.B. Ubuntu Linux) sind diese Tastenkombi-

nationen bereits mit anderen Funktionen belegt. Hier können Sie alternativ die Tas-

tenkombinationen (Strg)(ª)(A) (links-nach-rechts) und (Strg)(ª)(D) (rechts-nach-

links) verwenden. 

Ändern der Richtung von Arbeitsblättern 

Ist die Option Erweiterte Unterstützung für arabischen Text in den Einstellun-

gen aktiviert, können Sie die Schreibrichtung eines Arbeitsblatts jederzeit ändern. 

Gehen Sie dazu wie folgt vor: 

1. Rufen Sie in dem Arbeitsblatt den Befehl Tabelle > Eigenschaften auf. 

2. Schalten Sie unter Schreibrichtung die Option Rechts nach links ein, um die 

Schreibrichtung auf rechts-nach-links zu setzen.  

 Schalten Sie die Option aus, wenn die Schreibrichtung auf links-nach-rechts 

gesetzt werden soll. 

Die Richtung des Arbeitsblatts ändert sich nun entsprechend.  

Wenn Sie die Schreibrichtung eines Arbeitsblatts also auf rechts-nach-links ändern, 

ist nicht mehr die Tabellenspalte ganz links die erste Spalte, sondern die Tabellen-

spalte ganz rechts.  

Die Tabelle wird also horizontal gespiegelt – wie in folgender Abbildung zu sehen: 

 
Links: Tabelle mit Schreibrichtung links-nach-rechts 

Rechts: Tabelle mit Schreibrichtung rechts-nach-links 
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Hinweis: Die Schreibrichtung jeder einzelnen Tabellenzelle lässt sich natürlich 

auch weiterhin individuell festlegen (wie weiter oben im Abschnitt „Ändern der 

Schreibrichtung in Tabellenzellen“ beschrieben). 

Ändern der Schriftart für arabischen Text (in 

Textrahmen) 

Hinweis: Das Einschalten dieser Option wirkt sich nur auf die Schriftauswahl in 

Textrahmen aus. In Tabellenzellen kann immer nur eine Schrift gewählt werden. 

Ist die Option Erweiterte Unterstützung für arabischen Text in den Einstellun-

gen aktiviert, erscheinen im Dialogfenster des Befehls Format > Zeichen bei Text-

rahmen nicht nur eine, sondern drei Listen zur Auswahl von Schriftart, Schriftgrö-

ße, Schriftstil und Sprache: 

 Für lateinische Schriftzeichen (z.B. Englisch, Deutsch) 

 Für ostasiatische Schriftzeichen (Chinesisch, Japanisch, Koreanisch) 

 Für komplexe Schriftzeichen (z.B. Arabisch) 

Sie können diese Einstellungen in Textrahmen also für jede Art von Schriftzeichen 

getrennt vornehmen.  

Setzen Sie beispielsweise die Schriftart für lateinische Zeichen auf „Arial“ und die 

Schriftart für komplexe Zeichen auf „Simplified Arabic“, erscheinen alle lateini-

schen Zeichen, die Sie eintippen, automatisch in Arial und alle arabischen Zeichen 

in der Schrift „Simplified Arabic“. 

PlanMaker erkennt dabei selbsttätig, ob es sich bei den eingegebenen Zeichen um 

lateinische, asiatische oder komplexe (z.B. arabische) Schriftzeichen handelt. 
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Scripts (BasicMaker) 

Hinweis: BasicMaker ist nur unter Windows verfügbar und nicht in allen Versio-

nen von SoftMaker Office enthalten. 

Mit dem Programm BasicMaker können Sie Scripts in der Programmiersprache 

SoftMaker Basic schreiben und ausführen. SoftMaker Basic orientiert sich an Visu-

al Basic für Applikationen (VBA), der Programmiersprache von Microsoft Office. 

Mit Hilfe von Scripts lassen sich Arbeitsabläufe in der Textverarbeitung TextMaker 

und der Tabellenkalkulation PlanMaker automatisieren.  

Starten von BasicMaker 

Um BasicMaker zu starten oder ein BasicMaker-Script ausführen zu lassen, kön-

nen Sie eine der folgenden Vorgehensweisen verwenden: 

 BasicMaker über das Start-Menü starten 

 Sie können BasicMaker starten, indem Sie im Start-Menü auf Start > Pro-

gramme > SoftMaker Office > Hilfsprogramme > BasicMaker klicken. 

 BasicMaker von TextMaker/PlanMaker aus starten 

 Alternativ können Sie BasicMaker auch von TextMaker oder PlanMaker aus 

starten. Rufen Sie dazu in TextMaker/PlanMaker den Befehl Weiteres > Script 

bearbeiten auf. 

 Scripts von TextMaker/PlanMaker aus ausführen lassen 

 Um ein Script ausführen zu lassen, rufen Sie in TextMaker/PlanMaker den Be-

fehl Weiteres > Script starten auf. Es erscheint ein Dateidialog. Wählen Sie 

darin das Script, das ausgeführt werden soll, und bestätigen Sie mit OK. 

Alle weiteren Informationen zu BasicMaker und zum „Programmieren“ von Text-

Maker und PlanMaker finden Sie in der Online-Hilfe von BasicMaker, die Sie in 

BasicMaker über das Menü Hilfe aufrufen können. 
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Dokumentfenster 

Jedes Dokument, das Sie in PlanMaker öffnen oder neu anlegen, wird in seinem 

eigenen Dokumentfenster angezeigt. Dadurch können Sie mehrere Dokumente 

gleichzeitig bearbeiten und Daten zwischen diesen austauschen.  

In diesem Kapitel erfahren Sie, wie Sie Dokumentfenster einsetzen. Lesen Sie dazu 

die nächsten Seiten. 

Dokumentfenster anlegen 

Mit dem Befehl Datei > Neu weisen Sie das Programm an, ein neues leeres Do-

kumentfenster anzulegen. Möchten Sie ein neues Fenster anlegen und darin gleich 

eine Datei öffnen, verwenden Sie den Befehl Datei > Öffnen. Diese beiden Befeh-

le werden im Kapitel „Grundlagen“ (ab Seite 33) beschrieben. 

Hinweis: Ein neues Dokumentfenster wird dabei nur angelegt, wenn im Dialog-

fenster von Datei > Neu beziehungsweise Datei > Öffnen die Option Neues 

Fenster eingeschaltet ist. Andernfalls ersetzt PlanMaker den Inhalt des aktuellen 

Fensters. 

Mit Hilfe des Befehls Weiteres > Einstellungen können Sie übrigens die Stan-

dardeinstellung für den Schalter Neues Fenster ändern. Schalten Sie auf der Kar-

teikarte Dateien die Option Dokumente in neuen Fenstern öffnen aus, wird zu-

künftig beim Anlegen oder Öffnen eines Dokuments kein neues Fenster mehr 

angelegt. 

Dokumentfenster aktivieren 

Tastatureingaben und Menübefehle wirken sich immer nur auf das momentan akti-

ve Dokumentfenster aus. Um das aktive Fenster zu bestimmen, gehen Sie wie folgt 

vor: 

Maus: Klicken Sie auf eine beliebige Stelle innerhalb des gewünschten Fensters – 

sofern das Fenster sichtbar ist.  
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Tastatur: Öffnen Sie das Menü Fenster. Dieses enthält unten eine Liste aller ge-

öffneten Dokumentfenster samt den zugehörigen Dateinamen. Hier können Sie das 

gewünschte Fenster auswählen. 

Dokumentfenster schließen 

Möchten Sie die Arbeit an einem Dokument beenden, können Sie das zugehörige 

Dokumentfenster jederzeit schließen. Rufen Sie dazu den Befehl Datei > Schlie-

ßen auf.  

Das aktuelle Fenster wird nun samt Inhalt geschlossen. Wurde das Dokument seit 

dem letzten Speichern verändert, erscheint zuvor eine Sicherheitsabfrage, ob es 

gespeichert werden soll. 

Mit dem Befehl Fenster > Alle schließen können Sie alle geöffneten Dokument-

fenster auf einmal schließen lassen. 

Dokumentfenster maximieren 

Üblicherweise belegt ein Dokumentfenster nur einen Teil des Programmfensters. 

Wenn Sie sich aber auf ein bestimmtes Dokument konzentrieren möchten, können 

Sie das zugehörige Fenster maximieren: 

Maus: Klicken Sie auf die Schaltfläche  in der rechten oberen Ecke des Fens-

ters. Das Fenster nimmt daraufhin die gesamte Arbeitsfläche ein und überdeckt alle 

anderen Fenster. Mit der Schaltfläche  lässt sich das Fenster wieder auf seine 

alte Größe reduzieren.  

Tastatur: Öffnen Sie mit (Alt)(-) (Minustaste) das Systemmenü des Fensters und 

wählen Sie den Befehl Maximieren. Um die ursprüngliche Größe wiederherzustel-

len, wählen Sie den Befehl Wiederherstellen. 

Dokumentfenster minimieren 

Wenn Sie ein Dokumentfenster zwar noch nicht schließen, aber vorübergehend 

nicht mehr auf der Arbeitsfläche sehen wollen, können Sie es minimieren. Das 
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Fenster erscheint dann nur noch in Form eines Symbols in der linken unteren Ecke 

des Programmfensters.  

Gehen Sie dazu folgendermaßen vor: 

Maus: Klicken Sie auf die Schaltfläche  in der rechten oberen Ecke des Fens-

ters. Um das Fenster wiederherzustellen, führen Sie einen Doppelklick auf das 

Symbol des Fensters durch oder rufen es über das Menü Fenster auf. 

Tastatur: Öffnen Sie mit (Alt)(-) (Minustaste) das Systemmenü des Fensters und 

wählen Sie den Befehl Minimieren. Um das Fenster wiederherzustellen, rufen Sie 

es über das Menü Fenster auf. 

Dokumentfenster anordnen 

Sie können Dokumentfenster bei Bedarf automatisch anordnen lassen: 

 Mit dem Befehl Fenster > Überlappend weisen Sie PlanMaker an, die Fenster 

wie in einem Karteikasten hintereinander zu stapeln. Das aktuelle Fenster wird 

an die Spitze des Stapels gesetzt.  

 Mit Fenster > Untereinander werden die Fenster untereinander angeordnet.  

 Mit Fenster > Nebeneinander werden sie nebeneinander angeordnet. 

Um die Größe und Position eines Fensters von Hand zu ändern, gehen Sie wie 

folgt vor: 

Maus: Klicken Sie auf die Titelleiste des Fensters. Sofern das Fenster nicht maxi-

miert ist, können Sie es jetzt bei weiterhin gedrückter Maustaste an eine andere 

Position ziehen. Die Größe eines Fensters ändern Sie, indem Sie mit der Maus an 

der rechten unteren Fensterecke ziehen. 

Tastatur: Öffnen Sie mit (Alt)(-) (Minustaste) das Systemmenü des Fensters und 

wählen Sie den Befehl Verschieben beziehungsweise Größe ändern. Jetzt können 

Sie das Fenster mit den Richtungstasten verschieben beziehungsweise seine Größe 

verändern. Diese Befehle sind nicht verfügbar, wenn das Fenster maximiert ist. 
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Verwenden der Registerkarten für Dokumente 

Wenn Sie zwei oder mehr Dokumente geöffnet haben, erscheint unterhalb der 

Symbolleisten automatisch eine Leiste mit Registerkarten. Für jedes derzeit geöff-

nete Dokumentfenster wird darin eine Registerkarte angezeigt: 

 
Die Registerkarten für Dokumente 

Mit den Registerkarten für Dokumente lassen sich folgende Aktionen durchführen: 

Wechseln zwischen Dokumentfenstern 

Wenn Sie mit der linken Maustaste auf eine Registerkarte klicken, wird das ent-

sprechende Dokument zum aktiven Dokument gemacht. So können Sie blitzschnell 

zwischen den geöffneten Dokumentfenstern hin- und herwechseln. 

Alternativ können Sie auch die Tastatur verwenden: (Strg)(F6) wechselt zum 

nächsten Dokumentfenster und (Strg)(ª)(F6) zum vorherigen. 

Schließen von Dokumentfenstern 

Wenn Sie mit der mittleren Maustaste auf eine Registerkarte klicken, wird das ent-

sprechende Dokument geschlossen. 

Alternativ können Sie zum Schließen auch mit der linken Maustaste auf das x-

Symbol klicken, das in der rechten oberen Ecke der Registerkarte angezeigt wird. 

Wenn Sie mit der rechten Maustaste auf eine Registerkarte klicken, erscheint ein 

kleines Menü. Dieses enthält Befehle zum Schließen des aktuellen Dokuments 

oder aller anderen geöffneten Dokumente. 

Ein-/Ausblenden der Registerkarten für Dokumente 

Über den Befehl Fenster > Registerkarten können Sie bestimmen, ob die Leiste 

mit den Registerkarten angezeigt werden soll. Der Befehl öffnet ein Menü mit fol-

genden Optionen: 

 Aus 

 Schaltet die Leiste mit den Registerkarten aus. 
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 Ab zwei geöffneten Dokumenten 

 Blendet die Leiste automatisch ein, wenn mindestens zwei Dokumente geöffnet 

sind. Dies ist die Standardeinstellung 

 Immer sichtbar 

 Blendet die Leiste immer ein (auch wenn nur ein Dokument geöffnet ist.) 

Weitere Einstellungen zu den Registerkarten für Dokumente können Sie mit dem 

Befehl Weiteres > Einstellungen vornehmen (Karteikarte Allgemein). Siehe Ab-

schnitt „Einstellungen, Karteikarte Allgemein“ (ab Seite 385). 

Datenaustausch zwischen Dokumentfenstern 

Sie können Text, Zellen, Objekte etc. auch zwischen verschiedenen Dokumentfens-

tern austauschen. So lassen sich beispielsweise Zellen von einem Fenster in ein 

anderes verschieben oder kopieren. Sie kennen alle dafür notwendigen Befehle 

bereits aus dem Abschnitt „Markieren von Zellen“ ab Seite 64 und den nachfol-

genden Abschnitten. 

Markieren Sie beispielsweise in einem Fenster einige Zellen und kopieren Sie die-

se mit Bearbeiten > Kopieren oder (Strg)(C) in die Zwischenablage. Nun können 

Sie in ein anderes Fenster wechseln und dort mit Bearbeiten > Einfügen oder 
(Strg)(V) eine Kopie dieser Zellen einfügen. 
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Anpassen von PlanMaker 

PlanMaker lässt Sie über eine Vielzahl von Programmeinstellungen bestimmen, so 

dass Sie das Programm ganz an Ihren persönlichen Arbeitsstil anpassen können: 

 Einstellungen von PlanMaker ändern 

 Mit dem Befehl Weiteres > Einstellungen können Sie die Programmeinstel-

lungen ändern. Diese gelten für das gesamte Programm, also für alle Dokumen-

te. 

 Dokumenteigenschaften ändern 

 Die Dokumenteigenschaften sind hingegen Einstellungen, die nur das aktuelle 

Dokument betreffen und auch in diesem gespeichert werden. Sie können mit 

dem Befehl Datei > Eigenschaften geändert werden. 

 Arbeitsblatteigenschaften ändern 

 Die Arbeitsblatteigenschaften sind schließlich Einstellungen, die für jedes Ar-

beitsblatt eines Dokuments anders eingestellt werden können. Sie können mit 

dem Befehl Tabelle > Eigenschaften geändert werden. 

 Bildschirmdarstellung ändern 

 In diesem Abschnitt wird beschrieben, wie Sie die Darstellung des Dokuments 

auf dem Bildschirm anpassen und die Vergrößerungsstufe ändern können. Die 

meisten dazu benötigten Befehle finden Sie im Menü Ansicht. 

 Symbolleisten anpassen 

 Hier erfahren Sie, wie Sie mit dem Befehl Ansicht > Symbolleisten die Sym-

bolleisten (Funktionsleiste, Formatleiste etc.) nach Ihren Wünschen abändern 

können. 

 Tastenkürzel anpassen 

 Auch die Tastaturbelegung von PlanMaker lässt sich nach Belieben anpassen. 

Hierfür ist der Befehl Weiteres > Anpassen > Tastaturbelegung zuständig. 

 Listen für das automatische Füllen editieren 

 Mit dem Befehl Weiteres > Listen editieren können Sie eigene Listen für die 

Funktion Ausfüllen herstellen. 
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 Installieren zusätzlicher Wörterbücher 

 Bei der Installation von SoftMaker Office werden bereits Wörterbücher für 

einige Sprachen installiert. In diesem Abschnitt erfahren Sie, wie Sie bei Bedarf 

weitere Wörterbücher nachinstallieren können. 

Ausführliche Informationen zu diesen Themen folgen auf den nächsten Seiten. 

Einstellungen von PlanMaker ändern 

Allgemeine Einstellungen lassen sich mit dem Befehl Weiteres > Einstellungen 

ändern. Diese Einstellungen gelten für alle Dokumente. 

Die Optionen im Dialogfenster dieses Befehls sind nach Themen geordnet auf 

mehrere Karteikarten verteilt. Klicken Sie beispielsweise auf den Karteikartenreiter 

Dateien, können Sie Einstellungen zum Öffnen und Speichern von Dateien vor-

nehmen. 

Auf den nächsten Seiten finden Sie detaillierte Erläuterungen aller verfügbaren 

Einstellungen. 

Einstellungen, Karteikarte Ansicht 

Auf der Karteikarte Ansicht im Dialogfenster von Weiteres > Einstellungen kön-

nen Sie Einstellungen zum Aussehen von Tabellen vornehmen: 

Anzeiger 

Hier können Sie das Aussehen der kleinen Dreiecke ändern, die in Zellen angezeigt 

werden, die einen Kommentar enthalten oder geschützt sind: 

 Farbe der Kommentaranzeiger 

 Ändert die Farbe des kleinen Dreiecks, das in Zellen angezeigt wird, wenn die-

se einen Kommentar enthalten. 

 Farbe der Schutzanzeiger 

 Ändert die Farbe des kleinen Dreiecks, das bei aktiviertem Blattschutz in allen 

Zellen angezeigt wird, die nicht geschützt sind. 
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 Größe 

 Ändert die Größe obiger Anzeiger. 

Einstellungen, Karteikarte Allgemein 

Auf der Karteikarte Allgemein im Dialogfenster von Weiteres > Einstellungen 

können Sie allgemeine Einstellungen zu PlanMaker vornehmen: 

Schaltflächen „Benutzer privat“ und „Benutzer Firma“ 

Hier können Sie Ihre persönlichen Daten (Name, Adresse etc.) angeben – jeweils 

für Privatadresse und Geschäftsadresse. Diese Angaben können mit der Funktion 

BENUTZERFELD in die Tabelle eingefügt werden. 

Maximal widerrufbare Aktionen 

Hier können Sie einstellen, wie viele Aktionen sich mit dem Befehl Bearbeiten > 

Rückgängig maximal widerrufen lassen. Sie können diese Einstellung auf maxi-

mal 999 erhöhen.  

Informationen zum Befehl Bearbeiten > Rückgängig finden Sie im Abschnitt 

„Änderungen rückgängig machen“ ab Seite 63. 

Erweiterte Unterstützung für asiatische Schriften 

Hinweis: Das Einschalten dieser Option wirkt sich nur auf die Schriftauswahl in 

Textrahmen aus. In Tabellenzellen kann immer nur eine Schrift gewählt werden. 

Ist diese Option aktiviert, erscheinen im Dialogfenster des Befehls Format > Zei-

chen bei Textrahmen nicht nur eine, sondern drei Listen zur Auswahl von Schrift-

art, Schriftgröße, Schriftstil und Sprache: 

 Für lateinische Schriftzeichen (z.B. Englisch, Deutsch) 

 Für ostasiatische Schriftzeichen (Chinesisch, Japanisch, Koreanisch) 

 Für komplexe Schriftzeichen (z.B. Arabisch) 

Sie können diese Einstellungen in Textrahmen also für jede Art von Schriftzeichen 

getrennt vornehmen.  
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Setzen Sie beispielsweise die Schriftart für lateinische Zeichen auf „Arial“ und die 

Schriftart für asiatische Zeichen auf „SimHei“, erscheinen alle lateinischen Zei-

chen, die Sie eintippen, automatisch in Arial und alle asiatischen Zeichen in Sim-

Hei. 

PlanMaker erkennt dabei selbsttätig, ob es sich bei den eingegebenen Zeichen um 

lateinische, asiatische oder komplexe (z.B. arabische) Schriftzeichen handelt. 

Erweiterte Unterstützung für arabischen Text 

Wenn Sie diese Option aktivieren, werden einige zusätzliche Funktionen für das 

Bearbeiten von Text in arabischer Schrift verfügbar. Informationen dazu finden Sie 

im Kapitel „Arbeiten mit arabischem Text“ (ab Seite 371). 

Warnung beim Laden von OLE-Objekten 

Nur bei Linux: Ist diese Option eingeschaltet, erscheint beim Öffnen eines Doku-

ments mit OLE-Objekten eine Warnmeldung, die Sie darauf hinweisen soll, dass 

solche Objekte nicht dargestellt werden können. (OLE-Objekte können nur von der 

Windows-Version angezeigt werden.) 

Registerkarten für Dokumente 

Wenn Sie zwei oder mehr Dokumente geöffnet haben, wird unter den Symbolleis-

ten automatisch eine Leiste mit Registerkarten für jedes geöffnete Dokumentfens-

ter eingeblendet. 

Diese lassen sich unter anderem verwenden, um blitzschnell zwischen den geöffne-

ten Dokumenten hin- und herwechseln. (Siehe Abschnitt „Verwenden der Register-

karten für Dokumente“ ab Seite 380). 

Hierzu gibt es folgende Einstellungen: 

 In der aufklappbaren Liste unter Registerkarten für Dokumente können Sie 

bestimmen, ob die Leiste mit den Registerkarten angezeigt werden soll. Ver-

fügbare Optionen: 

 Aus: Schaltet die Leiste mit den Registerkarten aus. 

 Ab zwei geöffneten Dokumenten: Blendet die Leiste automatisch ein, wenn 

mindestens zwei Dokumente geöffnet sind. Dies ist die Standardeinstellung 
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 Immer sichtbar: Blendet die Leiste immer ein (auch wenn nur ein Dokument 

geöffnet ist.) 

 Dokumentsymbol anzeigen: Ist diese Option aktiviert, erscheint in jeder Re-

gisterkarte links ein Symbol, das den Dateityp des Dokuments anzeigt. 

 Schließen-Schaltfläche auch auf inaktiven Registerkarten anzeigen: Ist 

diese Option aktiviert, wird in jeder Registerkarte rechts ein x-Symbol ange-

zeigt. Klicken Sie dieses an, wird das zugehörige Fenster geschlossen.  

 Schalten Sie diese Option aus, wird das x-Symbol nur in der Registerkarte für 

das aktuelle Fenster angezeigt. 

Einstellungen, Karteikarte Bearbeiten 

Auf der Karteikarte Bearbeiten im Dialogfenster von Weiteres > Einstellungen 

können Sie Einstellungen zum Bearbeiten von Tabellenzellen vornehmen: 

 Markierung nach Eingabe ... bewegen 

 Bestimmt, in welche Richtung sich der Zellrahmen (der dunklere Rahmen, der 

auf dem Bildschirm die aktuelle Zelle kennzeichnet) bewegen soll, wenn Sie 

etwas in die Zelle eingeben und die Eingabetaste (¢) betätigen. 

 Zelle direkt in der Tabelle editieren 

 Diese Option ist standardmäßig eingeschaltet. Sie können den Inhalt einer Zelle 

nach dem Drücken der Taste (F2) also direkt in der Tabelle editieren. Schalten 

Sie die Option aus, lässt sich der Zellinhalt mit (F2) nur noch in der Bearbei-

tungsleiste editieren, die oberhalb des Dokuments angezeigt wird. 

 Automatische Prozentwerteingabe 

 Bestimmt das Verhalten von PlanMaker beim Eintippen von Zahlen in Zellen, 

die Prozentwerte enthalten oder im Zahlenformat „Prozent“ formatiert sind. Ist 

diese Option aktiviert, wird Ihrer Eingabe dabei automatisch ein Prozentzei-

chen angefügt. 

 Zellen automatisch vervollständigen 

 Wenn diese Option aktiviert ist, macht PlanMaker beim Eintippen von Text in 

eine Zelle automatisch Vorschläge aus den Einträgen direkt oberhalb oder un-

terhalb der Zelle. 

 Ein Beispiel: Sie haben in Tabellenzellen untereinander „New York“, „Rio“ und 

„Tokyo“ eingetragen. Wenn Sie nun in der Zelle direkt unterhalb dieser Zellen 
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ein „N“ eintippen, schlägt das Programm automatisch „New York“ vor. Tippen 

Sie hingegen ein „T“ ein, wird „Tokyo“ vorgeschlagen etc. 

  

 Um den Vorschlag zu übernehmen, drücken Sie die Eingabetaste (¢). Um ihn 

abzulehnen, tippen Sie einfach weiter oder drücken die Taste (Entf). 

 Falls Sie generell nicht möchten, dass PlanMaker beim Tippen solche Vor-

schläge macht, können Sie diese Option jederzeit ausschalten. 

 Zellbearbeitung wird nie mit linker Pfeiltaste verlassen 

 Diese Option bestimmt, was passieren soll, wenn Sie eine Zelle ansteuern, ei-

nen Wert eintippen und dann die Pfeiltaste (æ) betätigen: 

 Ein: Die Schreibmarke wird nach links bewegt (innerhalb Ihrer Eingabe). 

 Aus: Der Zellrahmen wird nach links bewegt. Der eingegebene Wert wird also 

übernommen, und die Zelle links von der aktuellen Zelle wird zur aktiven Zelle 

gemacht. 

 Meldung bei fehlerhaften Formeln 

 Wenn Sie eine Formel eingeben, die fehlerhaft formuliert ist (weil beispielswei-

se eine schließende Klammer fehlt), gibt PlanMaker eine Fehlermeldung aus, 

sobald Sie Ihre Eingabe mit der Eingabetaste (¢) abschließen. Wünschen Sie 

dies nicht, schalten Sie diese Option ab. 

 Hinweis: Unabhängig von dieser Option werden fehlerhafte Formeln beim 

Speichern automatisch durch den Text #FEHLER! ersetzt. 

 Quickinfos für Formeln 

 Wenn diese Option aktiviert ist, erscheint bei der manuellen Eingabe von Re-

chenfunktionen in eine Zelle automatisch ein kleines Infofenster unter der Ta-

bellenzelle. Dieses listet alle Parameter, die von der Funktion benötigt werden. 

 Zeichenformatierung auf das ganze Wort anwenden 

 Wenn diese Option aktiviert ist, hat das folgende Auswirkungen: 

 Wenn sich die Schreibmarke innerhalb eines Wortes befindet und Sie die Zei-

chenformatierung ändern (also beispielsweise eine andere Schrift wählen oder 

Fettdruck einschalten), wirkt sich dies auf das komplette Wort aus.  



 

Handbuch PlanMaker Anpassen von PlanMaker    389 

 So können Sie schnell die Formatierung eines einzelnen Wortes ändern, ohne 

dieses erst markieren zu müssen. 

 Trennzeichen für Zahlen 

 Hier können einstellen, welches Zeichen als Dezimaltrenner und welches als 

Tausendertrenner für Zahlen verwendet werden soll. 

Wichtig: Normalerweise sollten Sie hier stets die Einstellung Aus Sys-

temsteuerung verwenden. Wenn Sie manuelle Einstellungen vornehmen, die 

fehlerhaft sind, liefern die meisten Berechnungen ungültige oder falsche Er-

gebnisse. 

 Erläuterung: Der Dezimaltrenner ist das Zeichen, das man zwischen die Vor- 

und die Nachkommastellen einer Zahl setzt (z.B. das Komma in 17,50). Der 

Tausendertrenner ist das Zeichen, das zum Gruppieren langer Ziffern verwen-

det wird (z.B. die Punkte in 1.000.000). 

 Bei der Einstellung Aus Systemeinstellung verwendet PlanMaker automatisch 

das Dezimaltrennzeichen und das Tausendertrennzeichen, das in Ihren Syste-

meinstellungen festgelegt ist. (Dies ist die Standardeinstellung.) 

 Wählen Sie hingegen Benutzerdefiniert, können Sie selbst angeben, welche 

Zeichen als Dezimaltrenner und Tausendertrenner verwendet werden sollen. 

 Online-Berechnung in Statuszeile 

 Wenn Sie Zellen markieren, wird in der Statuszeile automatisch eine „Online-

Berechnung“ angezeigt – zum Beispiel die Summe dieser Zellen. Mit dieser 

Option können Sie bestimmen, welche Berechnung dort angezeigt werden soll. 

Einstellungen, Karteikarte Aussehen 

Auf der Karteikarte Aussehen im Dialogfenster von Weiteres > Einstellungen 

können Sie Einstellungen vornehmen, die das Aussehen der Benutzeroberfläche 

von PlanMaker betreffen: 

Dialogstil 

Über die Option Dialogstil lässt sich das Aussehen der Dialogfenster und Symbol-

leisten von PlanMaker ändern. An der Bedienung des Programms ändert sich dabei 

nichts; verwenden Sie einfach die Einstellung, die Ihnen am besten gefällt. 
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Dialogsprache 

Hier können Sie die Sprache wählen, in der Menüs und Dialogfenster angezeigt 

werden sollen. Nur anwendbar, wenn Sie bei der Installation mehrere Sprachen für 

die Benutzeroberfläche ausgewählt hatten (sofern verfügbar). 

Schriftenliste mit echten Schriften 

Ist diese Option aktiviert, zeigt PlanMaker in Schriftenlisten (zum Beispiel der 

Schriftenliste in der Formatleiste) alle Schriftnamen in der jeweiligen Schriftart an. 

So können Sie gleich sehen, wie die Schriften tatsächlich aussehen.  

Quickinfos 

Bestimmt, ob Quickinfos angezeigt werden sollen. 

Bei den Quickinfos handelt es sich um kurze Infotexte, die neben dem Mauszeiger 

angezeigt werden, wenn Sie mit der Maus auf ein Bildschirmelement wie bei-

spielsweise eine Schaltfläche in der Funktionsleiste zeigen.  

Warnton bei Meldungen 

Ist diese Option aktiviert, gibt PlanMaker bei Hinweis- und Fehlermeldungen einen 

Signalton aus. 

Große Symbole verwenden 

Wenn Sie diese Option aktivieren, werden in Symbolleisten und Menüs größere 

Symbole angezeigt. 

Hinweis: Eine Änderung an dieser Einstellung wird erst wirksam, wenn Sie das 

Programm beenden und neu starten. 

System-Dateidialoge verwenden 

Nur bei Windows: Diese Option bestimmt, welche Art von Dialogen bei Befehlen, 

die mit dem Öffnen und Speichern von Dateien zu tun haben, erscheinen sollen: 

 Aus: Es erscheinen PlanMakers eigene Dateidialoge. 
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 Ein: Es erscheinen die Standard-Dateidialoge des Betriebssystems, wie Sie sie 

von den meisten anderen Applikationen her kennen. 

Erstere sind etwas übersichtlicher, letztere bieten mehr Optionen. 

Bildschirmschriftarten glätten 

Nicht bei allen Betriebssystemen verfügbar: Wenn Sie diese Option aktivieren, 

wendet PlanMaker eine Technologie an, die die Kanten von Schriften auf dem 

Bildschirm glättet und so das Schriftbild verbessert – das sogenannte „Antia-

liasing“. 

Je nach Betriebssystem stehen unterschiedliche Optionen zur Verfügung. 

Hintergrundfarbe des Programms 

Hier können Sie die Hintergrundfarbe für Dokumentfenster ändern. 

Window Manager-Dialoge 

Nur bei Linux: Ist diese Option ausgeschaltet, zeichnet PlanMaker für Linux alle 

Dialogfenster selbst. Dies geht etwas schneller; allerdings können Dialoge hierbei 

nur innerhalb des Programmfensters dargestellt werden.  

Ist die Option eingeschaltet, zeichnet der Window Manager die Dialoge. 

Window Manager-Positionierung 

Nur bei Linux: Ist diese Option ausgeschaltet, positioniert PlanMaker für Linux 

alle Dialoge selbst – und zwar stets zentriert innerhalb des Programmfensters.  

Ist die Option eingeschaltet, überlässt PlanMaker es dem Window Manager, wo 

dieser die Dialoge platzieren möchte. 

Maßeinheit 

Nur bei Linux: Hier können Sie einstellen, welche Maßeinheiten PlanMaker stan-

dardmäßig verwenden soll: Metrisch (Zentimeter) oder U.S. (Zoll). 
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(Unter Windows ist diese Option nicht erforderlich, da das Programm dort automa-

tisch die Einstellung übernimmt, die in den Regions- und Sprachoptionen der Sys-

temsteuerung von Windows gewählt wurde.) 

Tipp: Unabhängig von dieser Einstellung können Sie in Dialogen jederzeit Werte in 

anderen Maßeinheiten eingeben, indem sie hinter dem Wert eine der folgenden 

Maßeinheiten eintippen: 

Einheit Bemerkung 

cm Zentimeter 

in Inch (Zoll) – 1 in entspricht 2,54 cm. 

pt Punkt – 72 pt entsprechen 1 in. 

pi Pica (Zeichen) 

Tippen Sie also beispielsweise für den linken Seitenrand „2 in“ ein, setzt PlanMa-

ker diesen auf 2 Zoll (=5,08 cm). 

Einstellungen, Karteikarte Sprache 

Auf der Karteikarte Sprache im Dialogfenster von Weiteres > Einstellungen kön-

nen Sie Einstellungen zu Rechtschreibprüfung und Silbentrennung vornehmen: 

Sprache 

Hier legen Sie die Sprache für Rechtschreibprüfung und Silbentrennung fest. Öff-

nen Sie die Liste dazu und wählen Sie die gewünschte Sprache darin aus. 

Hinweis: Beachten Sie dabei, dass es für Deutsch zwei Einträge in dieser Liste 

gibt: Wählen Sie „Deutsch (Deutschland)“ für die neue Rechtschreibung oder 

„Deutsch (Deutschland, alt)“ für die alte Rechtschreibung. Entsprechendes gilt 

für „Deutsch (Schweiz)“. 

Rubrik „Rechtschreibprüfung“ 

Hier können Sie folgende Einstellungen zur Rechtschreibprüfung vornehmen: 
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 Rechtschreibkorrektur während des Tippens 

 Wenn Sie diese Option aktiveren, prüft PlanMaker die Rechtschreibung bereits 

während der Eingabe von Text. Bei Tippfehlern erscheint sofort ein Dialogfens-

ter zur Korrektur. Siehe dazu Abschnitt „Rechtschreibprüfung während des 

Tippens“ ab Seite 316. 

 Hinweis: Wenn diese Option ausgeschaltet ist, müssen Sie natürlich nicht gänz-

lich auf eine Rechtschreibprüfung verzichten – Sie können diese jederzeit mit 

dem Befehl Weiteres > Rechtschreibprüfung manuell starten. Siehe dazu Ab-

schnitt „Rechtschreibprüfung nachträglich“ ab Seite 315. 

 Warnton bei Tippfehlern: Diese Option bestimmt, ob PlanMaker einen Sig-

nalton ausgeben soll, wenn die Rechtschreibkorrektur während des Tippens 

ein unbekanntes Wort findet. 

 Hunspell-Wörterbücher 

 Neben seinen eigenen Wörterbüchern unterstützt SoftMaker Office auch die 

Verwendung von Hunspell-Wörterbüchern. Diese sind als kostenlose Down-

loads erhältlich. Sie wurden größtenteils von engagierten Anwendern und nicht-

kommerziellen Einrichtungen erstellt.  

 Mit der Schaltfläche Hunspell-Wörterbücher können Sie heruntergeladene 

Hunspell-Wörterbücher installieren und außerdem einstellen, für welche Spra-

chen Hunspell-Wörterbücher verwendet werden sollen. 

 Siehe dazu Abschnitt „Installieren zusätzlicher Wörterbücher“ (ab Seite 431). 

Textbausteine automatisch ersetzen 

Wie im Abschnitt „Textbausteine“ ab Seite 320 beschrieben, können Sie mit Plan-

Maker Textbausteine anlegen (z.B. „Lst“ für „Lohnsteuer“).  

Wenn diese Option eingeschaltet ist, können Textbausteine direkt bei der Textein-

gabe ausgelöst werden. Dazu muss einfach das Kürzel für den Baustein (z.B. 

„Lst“) und dann Leertaste, Eingabetaste oder ein Satzzeichen getippt werden, wo-

rauf PlanMaker das Kürzel automatisch durch den Inhalt des Bausteins ersetzt.  

Ist die Option deaktiviert, können Textbausteine hingegen nur über den Befehl 

Einfügen > Textbaustein abgerufen werden. 
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Einstellungen, Karteikarte Dateien 

Auf der Karteikarte Dateien im Dialogfenster von Weiteres > Einstellungen kön-

nen Sie Einstellungen zum Öffnen und Speichern von Dateien vornehmen: 

Vorlagenpfad 

Hier lässt sich der Ordner einstellen, in dem sich die Dokumentvorlagen für neue 

PlanMaker-Dokumente befinden. Der Dialog, der beim Aufruf von Datei > Neu 

erscheint, um Sie eine Dokumentvorlage auswählen zu lassen, zeigt entsprechend 

alle Vorlagen an, die sich in diesem Ordner befinden. 

Hinweis: Normalerweise sollten Sie diese Einstellung nicht verändern. Ändern 

Sie diese nur, wenn Sie den Vorlagenordner tatsächlich an einen anderen Ort ver-

schoben haben. 

Standard-Dateiformat 

Hier können Sie das Dateiformat wählen, in dem PlanMaker neu angelegte Doku-

mente standardmäßig speichern soll. 

Wenn Sie ein Dokument mit dem Befehl Datei > Neu neu anlegen und es dann 

zum ersten Mal abspeichern, schlägt Ihnen der Speichern-Dialog als Vorgabe stets 

das hier eingestellte Dateiformat vor. 

Zur Wahl stehen das PlanMaker-Format und das Microsoft Excel-Format in mehre-

ren Versionen. 

Hinweis: Beachten Sie, dass das Excel-Format nicht alle Features von PlanMa-

ker kennt. Wenn Sie also ein mit PlanMaker erstelltes Dokument im Excel-

Format speichern, können unter Umständen Formatierungen oder Funktionen 

verloren gehen. Es empfiehlt sich daher, hier die Standardeinstellung „PlanMa-

ker“ zu verwenden. 

Rubrik „Speichern“ 

In der Rubrik Speichern können Sie Einstellungen zum Speichern von Dokumen-

ten vornehmen: 
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 .BAK-Dateien anlegen 

 Jedes Mal, wenn Sie ein Dokument speichern, legt PlanMaker auf Wunsch eine 

Sicherungskopie der letzten Fassung des Dokuments mit der Namenserweite-

rung .BAK an. Speichern Sie also das Dokument UMSATZ.PMD, wird erst die 

vorhandene Datei UMSATZ.PMD in UMSATZ.BAK umbenannt und dann UM-

SATZ.PMD gespeichert.  

 Wünschen Sie dies nicht, schalten Sie die Option ab. 

Tipp: Sie sollten diese Option normalerweise nicht ausschalten. Wenn die 

Originaldatei nach missglückten Veränderungen einmal versehentlich gespei-

chert wurde, haben Sie immer noch eine Sicherungskopie mit der vorherigen 

Fassung. Kopieren Sie dann einfach die .BAK-Datei auf die .PMD-Datei. 

 Beim Speichern nach Dokumentinfo fragen 

 Schalten Sie diese Option ein, erscheint beim ersten Speichern eines neuen Do-

kuments automatisch das Dialogfenster zum Eintragen der Dokumentinfos 

(siehe Kapitel „Dokumentinfos“ ab Seite 327). 

 Automatisches Sichern alle ... Minuten 

 Wenn diese Option aktiviert ist, macht PlanMaker im eingetragenen Zeitab-

stand (1-100 Minuten) automatisch Sicherungskopien aller geöffneten Doku-

mente in einem temporären Ordner. 

 Wenn PlanMaker korrekt beendet wird, werden diese Kopien automatisch wie-

der gelöscht. Wird er jedoch – zum Beispiel aufgrund eines Computerabsturzes 

– nicht korrekt beendet, erkennt PlanMaker dies beim nächsten Programmstart. 

Er bietet Ihnen an, Sicherungskopien aller Dokumente zu öffnen, die vor dem 

Absturz geändert wurden und noch nicht gespeichert waren. 

 Überprüfen Sie dann bei jedem wiederhergestellten Dokument, welche der zu-

letzt gemachten Änderungen verlorengegangen sind, und speichern Sie es dann 

mit Datei > Speichern. 

Rubrik Öffnen 

In der Rubrik Öffnen können Sie Einstellungen zum Öffnen von Dokumenten vor-

nehmen: 
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 Dokumente in neuen Fenstern öffnen 

 Ist diese Option aktiviert, wird beim Anlegen oder Öffnen eines Dokuments mit 

Datei > Neu beziehungsweise Datei > Öffnen ein neues Dokumentfenster ge-

öffnet.  

 Schalten Sie die Option aus, wird künftig erst das Dokument im aktuellen Fens-

ter geschlossen und die Datei im selben Fenster geöffnet.  

 Hinweis: Hier legen Sie lediglich die Standardeinstellung für diese Option fest. 

In den Dialogfenstern von Datei > Neu und Datei > Öffnen lässt sich bei je-

dem Aufruf individuell bestimmen, ob ein neues Fenster geöffnet werden soll, 

da jedes dieser Dialogfenster über einen Schalter Neues Fenster verfügt. 

 Einträge im Datei-Menü 

 Im Menü Datei zeigt PlanMaker eine Liste der zuletzt von Ihnen geöffneten 

Dateien an. Wählen Sie einen dieser Einträge, wird die entsprechende Datei so-

fort geöffnet. Hier lässt sich einstellen, wie viele Dateien dort angezeigt werden 

sollen. 

Einstellungen, Karteikarte System 

Auf der Karteikarte System im Dialogfenster von Weiteres > Einstellungen kön-

nen Sie folgende System-Einstellungen vornehmen: 

Grafiken im Speicher komprimieren 

Ist diese Option aktiviert, legt PlanMaker Grafiken komprimiert im Speicher ab. 

Vorteil: Bei Dokumenten, die viele Bilder enthalten, wird erheblich weniger Ar-

beitsspeicher verbraucht. Nachteil: Das Komprimieren kostet natürlich etwas Re-

chenzeit. 

In der Regel sollten Sie diese Option eingeschaltet lassen. 

Hinweis: Eine Änderung an dieser Einstellung wird erst wirksam, wenn Sie das 

Programm beenden und neu starten. 

Internen Grafikcache begrenzen 

PlanMaker besitzt einen Zwischenspeicher, der die Anzeige von Grafiken in Do-

kumenten erheblich beschleunigt. Ist diese Option aktiviert, begrenzt PlanMaker 

diesen Zwischenspeicher auf maximal 20% des Arbeitsspeichers.  
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In der Regel sollten Sie diese Option eingeschaltet lassen. 

Wenn Sie häufig Dokumente mit vielen hochaufgelösten Bildern verwenden, kön-

nen Sie diese Option testhalber deaktivieren. Die Anzeige von Grafiken ist dann 

möglicherweise flüssiger, allerdings kann es dabei passieren, dass PlanMaker einen 

Großteil des verfügbaren Arbeitsspeichers für sich beansprucht. 

Kantenglättung von Grafiken 

Wenn diese Option aktiviert ist, wendet PlanMaker bei Grafiken eine Technologie 

zum Glätten von Kanten und Linien an. Vorteil: Skalierte Grafiken werden schöner 

dargestellt. Nachteil: Dieses Verfahren kostet natürlich Rechenzeit beim Anzeigen 

von Grafiken. 

Nach Produktaktualisierungen suchen 

Nur bei Windows: Hier können Sie festlegen, wie oft die Software nachsehen soll, 

ob es Aktualisierungen für SoftMaker Office gibt. Aktualisierungen enthalten Feh-

lerkorrekturen und Funktionsverbesserungen. 

Hinweis: Das Prüfen auf Aktualisierungen funktioniert nur, wenn Ihr Computer auf 

das Internet zugreifen kann. 

Sie können die automatische Überprüfung auch abschalten, indem Sie den Eintrag 

Nie auswählen. Das Prüfen auf Aktualisierungen kann dann nur noch manuell 

(über die Schaltfläche Jetzt prüfen) durchgeführt werden. 

Dateierweiterungen verknüpfen 

Nur bei Windows: Mit dieser Schaltfläche können Sie bestimmte Typen von Da-

teien (zum Beispiel alle Excel-Dokumente) mit PlanMaker verknüpfen. Solche 

Dateien lassen sich dann beispielsweise mit einem Doppelklick auf die Datei im 

Windows Explorer öffnen. PlanMaker wird dann automatisch gestartet (sofern er 

nicht bereits läuft) und öffnet diese Datei. 

Wenn Sie die Schaltfläche Dateierweiterungen verknüpfen anklicken, erscheint 

ein Dialog. Dieser zeigt an, welche Dateitypen momentan mit PlanMaker ver-

knüpft sind. Klicken Sie auf das Kästchen vor dem gewünschten Dateityp, um die 

Verknüpfung ein- oder auszuschalten.  
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SHM-Erweiterungen verwenden 

Nur bei Linux: Ist diese Option aktiviert, verwendet PlanMaker Shared Memory-

Speicher, was die Bildschirmausgabe beschleunigen kann. 

Hinweis: Abhängig vom verwendeten System steht unter Umständen nicht genug 

Shared Memory für PlanMaker zur Verfügung. Ist dies der Fall, schaltet PlanMaker 

diese Option automatisch wieder aus. 

XIM verwenden 

Nur bei Linux: Ist diese Option aktiviert, unterstützt PlanMaker das Zusammen-

setzen von Akzentzeichen (à, ô, é etc.) mit Hilfe von „XIM“. 

Auf einer deutschen Tastatur kann dann beispielsweise das Zeichen „ô“ erzeugt 

werden, indem Sie erst die Taste (^) und danach die Taste (O) betätigen. 

Schalten Sie die Option aus, ist das Zusammensetzen von Zeichen auf diese Weise 

nicht mehr möglich.  

Hinweis: Auf manchen Systemen gibt es kleine Eingabeverzögerungen beim 

schnellen Tippen von Text, wenn diese Option aktiviert ist. 

Mausrad 

Nur bei Linux: Wenn Ihre Maus mit einem Mausrad ausgestattet ist, können Sie 

hier einstellen, wie weit beim Verwenden des Mausrads geblättert werden soll: 

seitenweise (also eine komplette Bildschirmseite) oder nur eine bestimmte Anzahl 

an Zeilen. 

Externe Programme 

Nur bei Linux: Diese Schaltfläche öffnet einen Dialog, in dem Sie die externen 

Programme festlegen können, die bei bestimmten Ereignissen automatisch gestar-

tet werden. Der Eintrag PDF-Betrachter bestimmt beispielsweise, welche Appli-

kation nach dem Erzeugen einer PDF-Datei automatisch aufgerufen wird, um das 

Ergebnis darin anzuzeigen. 

Hinweis: Sie müssen diese Felder nicht ausfüllen. Bei allen Feldern, die Sie leer 

lassen, wird automatisch das im System festgelegte Standardprogramm für diese 

Aktion verwendet. Nehmen Sie in diesem Dialog nur dann Änderungen vor, wenn 

Sie möchten, dass nicht das Standardprogramm aufgerufen wird, sondern ein ande-
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res Programm. Tragen Sie dazu einfach den Dateinamen der ausführbaren Datei 

ein (inklusive Pfad, falls nötig). 

Zusätzliche Schriftenpfade 

Nur bei Linux: Hier können Sie Pfade für zusätzliche Schriftarten angeben, die 

PlanMaker verwenden soll. Tragen Sie dazu das Unterverzeichnis ein, in dem sich 

die Schriftdateien befinden. Falls Sie mehrere Verzeichnisse eintragen möchten, 

trennen Sie diese durch einen Doppelpunkt. 

PlanMaker kann diese Schriftarten dann zusätzlich zu den in Ihrem System verfüg-

baren Schriften verwenden.  

Hinweis: Änderungen an dieser Einstellung werden erst wirksam, wenn Sie das 

Programm beenden und neu starten. 

Einstellungen, Karteikarte Schriften 

Auf der Karteikarte Schriften im Dialogfenster von Weiteres > Einstellungen 

können Sie festlegen, welche Schriften in Schriftenlisten (z.B. der Schriftenliste im 

Dialogfenster des Befehls Format > Zeichen) angezeigt werden sollen. 

Die Karteikarte präsentiert dazu eine Liste aller Schriften, die auf Ihrem System 

installiert sind. Um darin eine Schrift zu aktivieren oder zu deaktivieren, klicken 

Sie auf das Kästchen vor dem Namen der Schriftart. Alle Schriften, bei denen Sie 

das Häkchen entfernen, werden nicht mehr in Schriftenlisten angezeigt. 

Hintergrund: Unter den Schriftarten, die auf Ihrem System standardmäßig instal-

liert sind, befinden sich einige Schriften, die Sie vermutlich nie benötigen – weil 

diese beispielsweise ausschließlich Schriftzeichen für eine Sprache enthalten, die 

Sie nicht verwenden. Wenn Sie möchten, können Sie solche Schriften wie oben 

beschrieben ausblenden. 

Schriftenfilterung des Betriebssystems verwenden (ab Windows 7) 

Anwender von Windows 7 oder höher finden auf dieser Karteikartei außerdem eine 

Option namens Schriftenfilterung des Betriebssystems verwenden. Wenn diese 

eingeschaltet ist, verbirgt das System in Schriftenlisten automatisch alle Schriften, 

die ausschließlich fremdsprachige Schriftzeichen enthalten. 
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Dokumenteigenschaften ändern 

Über den Befehl Datei > Eigenschaften können Sie Einstellungen ändern, die nur 

das aktuelle Dokument betreffen und mit diesem gespeichert werden. Man nennt 

diese Einstellungen Dokumenteigenschaften. 

Die verfügbaren Dokumenteigenschaften sind nach Themen geordnet auf mehrere 

Karteikarten verteilt. Klicken Sie beispielsweise auf den Karteikartenreiter Infos, 

können Sie die Dokumentinfos bearbeiten. 

Auf den nächsten Seiten finden Sie detaillierte Erläuterungen aller verfügbaren 

Dokumenteigenschaften. 

Dokumenteigenschaften, Karteikarte Infos 

Auf der Karteikarte Infos im Dialogfenster von Datei > Eigenschaften können Sie 

die Dokumentinfos für das aktuelle Dokument eintragen.  

In den Dokumentinfos lassen sich erläuternde Angaben zum aktuellen Dokument 

machen (Thema, Autor, Schlüsselwörter etc.), nach denen mit dem Dateimanager 

auch gesucht werden kann. 

Informationen hierzu finden Sie im Abschnitt „Dokumentinfos“ ab Seite 327. 

Dokumenteigenschaften, Karteikarte Farben 

Auf der Karteikarte Farben im Dialogfenster von Datei > Eigenschaften können 

Sie die Farbpalette des aktuellen Dokuments bearbeiten. 

Wenn Sie eine Farbenliste – zum Beispiel die Farbenliste in der Formatleiste – öff-

nen, sehen Sie nur einen kleinen Ausschnitt aus den bis zu 16 Millionen verfügba-

ren Farben. Man nennt diesen Ausschnitt die Farbpalette des Dokuments. 

Diese Farbpalette kann jederzeit von Ihnen modifiziert werden. Sie können neue 

Farben hinzufügen und von Ihnen hinzugefügte Farben abändern. Die ersten 24 

Farben in der Farbpalette sind allerdings Standardfarben, die sich nicht verändern 

lassen. 

Wichtig: Änderungen an der Farbpalette werden im Dokument gespeichert. Sie 

können also zu jedem Dokument eine eigene Farbpalette zusammenstellen. 
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Hinzufügen einer Farbe 

Um der Farbpalette des aktuellen Dokuments eine Farbe hinzuzufügen, gehen Sie 

wie folgt vor: 

1. Rufen Sie den Befehl Datei > Eigenschaften auf und wechseln Sie auf die 

Karteikarte Farben. 

Tipp: Alternativ können Sie diesen Dialog von jedem beliebigen Dialogfens-

ter aus aufrufen, das eine Farbenliste enthält. Wählen Sie dazu in der Farben-

liste den Eintrag Andere... am Ende der Liste. 

2. Stellen Sie die gewünschte Farbe ein (siehe Abschnitt „Bedienung der Kontrol-

len zum Einstellen von Farben“ weiter unten).  

3. Klicken Sie auf die Schaltfläche Neu. 

4. Geben Sie der neuen Farbe im Feld Name einen beliebigen Namen und bestäti-

gen Sie diesen mit OK. 

5. Verlassen Sie den Dialog mit OK. 

PlanMaker fügt die neue Farbe nun der Farbpalette des Dokuments hinzu. Die Far-

be ist ab sofort in allen Dialogfenstern verfügbar, in denen eine Farbe ausgewählt 

werden kann. 

Ändern einer Farbe 

Hinweis: Sie können nur Farben ändern, die von Ihnen hinzugefügt wurden. Die 

ersten 24 Farben der Farbpalette sind Standardfarben, die sich nicht verändern 

lassen. 

Um eine Farbe zu ändern, gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Datei > Eigenschaften auf und wechseln Sie auf die 

Karteikarte Farben. 

 Oder: Alternativ können Sie auch den Eintrag Andere... in einer beliebigen 

Farbenliste verwenden, um diesen Dialog aufzurufen. 

2. Wählen Sie die zu verändernde Farbe in der Liste Farbpalette. 

3. Nehmen Sie die gewünschten Änderungen vor (siehe Abschnitt „Bedienung der 

Kontrollen zum Einstellen von Farben“ weiter unten). 

4. Klicken Sie auf Ändern. 
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Die Farbe wurde nun für das aktuelle Dokument verändert. 

Löschen oder Umbenennen einer Farbe 

Sie können selbstdefinierte Farben jederzeit löschen oder ihren Namen ändern. 

Rufen Sie dazu den Farbendialog auf, selektieren Sie eine Farbe in der Liste Farb-

palette und betätigen Sie die Schaltfläche Löschen beziehungsweise Umbenen-

nen. 

Bedienung der Kontrollen zum Einstellen von Farben 

Die Kontrollen in obigem Dialog lassen Sie Farben auf vielfältige Arten einstellen. 

Alle Wege führen zum gleichen Ergebnis – wählen Sie einfach die Methode, die 

Ihnen am meisten zusagt: 

 Verwenden des Farbfeldes und Helligkeitsreglers 

 Am einfachsten geht das Einstellen von Farben mit dem großen Farbfeld und 

dem Helligkeitsregler rechts daneben. Das Farbfeld stellt alle verfügbaren Farb-

töne in allen verfügbaren Sättigungen dar, der Helligkeitsregler daneben ist für 

die Helligkeit der Farbe zuständig. 

 Um eine Farbe einzustellen, klicken Sie zunächst in dem großen Farbfeld auf 

die gewünschte Farbe. Dann klicken Sie in dem Helligkeitsregler auf die ge-

wünschte Helligkeit. 

 Verwenden der Regler für Ton, Sättigung und Helligkeit 

 Alternativ können Sie Farben mit den darunter befindlichen Reglern Ton 

(=Farbton), Sätt (=Sättigung) und Hell (=Helligkeit) einstellen. Zulässig sind 

Werte zwischen 0 und 240. 

 Verwenden der Regler für Rot, Grün und Blau 

 Farben lassen sich alternativ auch über ihre Rot-, Grün- und Blauanteile einstel-

len. Dazu dienen die Regler Rot, Grün und Blau. Zulässig sind Werte zwi-

schen 0 und 255. 

Dokumenteigenschaften, Karteikarte Internet 

Auf der Karteikarte Internet im Dialogfenster von Datei > Eigenschaften lassen 

sich Farbgebung und Hintergrund eines HTML-Dokuments ändern. 
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 Farbeinstellungen nicht in der HTML-Datei speichern 

 Aktivieren Sie diese Option, gelten alle auf dieser Karteikarte gemachten Far-

beinstellungen nur in PlanMaker. Sie werden nicht im HTML-Dokument ge-

speichert. Öffnen Sie das Dokument also in einem Web-Browser, erscheinen 

die Standardfarben des Browsers – nicht die hier eingestellten Farben. 

 Blinken darstellen als 

 Mit der HTML-Textauszeichnung „Blinkend“ versehener Text wird in PlanMa-

ker nicht blinkend dargestellt, sondern durch die hier gewählte Farbe gekenn-

zeichnet. Standardeinstellung ist Gelb. 

 Hintergrundfarbe 

 Hier können Sie die Hintergrundfarbe des Dokuments auswählen.  

 Bei der Standardeinstellung „Auto“ wird die Hintergrundfarbe nicht verändert. 

Es erscheint also die Farbe, die der Anwender in seinem Internet-Browser ein-

gestellt hat. 

 Hintergrundbild 

 Sie können das Dokument mit einer Grafik als Hintergrund versehen, indem Sie 

hier den Namen der gewünschten Grafikdatei eintragen. Hintergrundgrafiken 

erscheinen als Kachelmuster. 

 Tragen Sie den vollständigen Pfad und Dateinamen der Grafik von Hand ein 

oder klicken Sie auf die Schaltfläche Datei..., um die Grafikdatei auf Ihrer 

Festplatte zu lokalisieren. 

 Hinweis: Das Hintergrundbild wird in PlanMaker nicht angezeigt; es ist nur in 

einem Internet-Browser zu sehen. 

 Verknüpfung 

 Wählen Sie hier die Farbe, in der Verknüpfungen (Links) dargestellt werden 

sollen. Standardeinstellung ist Blau. 

 Verwendete Verknüpfung 

 Wählen Sie hier die Farbe für bereits besuchte Verknüpfungen. Standardeinstel-

lung ist Violett. 

 Aktuelle Verknüpfung 

 Wählen Sie hier die Farbe für eine selektierte Verknüpfung. Standardeinstellung 

ist Rot. 
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Dokumenteigenschaften, Karteikarte Statistik 

Auf der Karteikarte Statistik im Dialogfenster von Datei > Eigenschaften können 

Sie statistische Informationen über das aktuelle Dokument abrufen: 

 In der Rubrik Zellen wird ausgegeben, wie viele Zellen ausgefüllt sind, und 

wie viele davon Text, Zahlen, Formeln beziehungsweise Kommentare enthal-

ten. 

 In der Rubrik Allgemeines wird die Zahl der Arbeitsblätter und die Zahl der 

Druckseiten ausgegeben. 

 In der Rubrik Objekte wird ausgegeben, wie viele Objekte (Diagramme, Gra-

fiken etc.) das Dokument enthält. 

 In der Rubrik Aktionen können Sie ablesen, wann das Dokument erstellt, zu-

letzt gespeichert und zuletzt gedruckt wurde. 

Dokumenteigenschaften, Karteikarte Optionen 

Auf der Karteikarte Optionen im Dialogfenster von Datei > Eigenschaften kön-

nen Sie allgemeine Einstellungen zum aktuellen Dokument vornehmen: 

Rubrik „Textrahmen“ 

 Tabulatorbreite 

 Hier können Sie die Tabulatorbreite für Text in Textrahmen einstellen. 

Rubrik „Arbeitsblatt“ 

 Syntaxhervorhebung 

 Ist diese Option aktiviert, werden die Tabellenzellen je nach Inhalt unterschied-

lich eingefärbt. Entspricht dem Befehl Ansicht > Syntaxhervorhebung (siehe 

Abschnitt „Syntaxhervorhebung“ ab Seite 103). 

 Formelanzeige 

 Ist diese Option aktiviert, werden bei allen Formeln die Rechenformeln statt der 

Ergebnisse angezeigt. Entspricht dem Befehl Ansicht > Formelanzeige (siehe 

Abschnitt „Formelanzeige“ ab Seite 103). 
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 Schutzanzeiger 

 Ist diese Option aktiviert, wird – sofern der Blattschutz für das Arbeitsblatt ak-

tiviert wurde – ein kleines grünes Dreieck bei allen Zellen eingeblendet, die 

nicht geschützt sind. Dadurch kann man besser erkennen, welche Zellen sich 

noch verändern lassen. Siehe auch Abschnitt „Blattschutz“ ab Seite 355. 

 Silbentrennung 

 Ist diese Option aktiviert, werden in allen Zellen, bei denen mit Format > Zelle 

die Option Zeilenumbruch aktiviert wurde, bei Bedarf automatische Silben-

trennungen durchgeführt. Siehe auch Abschnitt „Silbentrennung“ ab Seite 318. 

Rubrik „Kommentare“ 

 Marken anzeigen 

 Ist diese Option aktiviert, wird bei allen Zellen, die mit dem Befehl Einfügen > 

Kommentar mit einem Kommentar versehen wurden, ein kleines gelbes Drei-

eck eingeblendet. Siehe auch Abschnitt „Kommentare einfügen“ ab Seite 113. 

 Kommentare immer anzeigen 

 Wenn Sie eine Zelle mit einem Kommentar versehen, wird dieser normaler-

weise nur dann eingeblendet, wenn Sie mit der Maus auf diese Zelle zeigen. 

Aktivieren Sie diese Option, werden hingegen alle Kommentare im Dokument 

permanent angezeigt. 

Rubrik „Dezimaltrenner nach Zahleneingabe“ 

 Verschieben um ... Stellen 

 Aktivieren Sie diese Option, wird jede ganze Zahl, die Sie in eine Zelle einge-

ben, automatisch um die angegebene Zahl an Stellen verschoben. 

 Diese Option ist nützlich, wenn Sie beispielsweise viele kleine Geldbeträge 

eingeben müssen. Setzen Sie nämlich die Zahl der Stellen auf den Wert 2 und 

geben die Zahl 42 ein, wird dies automatisch in 0,42 gewandelt; die Eingabe 

234 wird in 2,34 gewandelt etc. So können Sie sich die Eingabe des Dezimal-

kommas sparen, wenn Sie beispielsweise eine lange Kolonne von Zahlen mit 

zwei Dezimalstellen eingeben möchten. 
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Rubrik „Fenster“ 

 Vertikale Bildlaufleiste 

 Hier können Sie wählen, ob die vertikale Bildlaufleiste für das Dokument an-

gezeigt werden soll. 

 Horizontale Bildlaufleiste 

 Hier können Sie wählen, ob die horizontale Bildlaufleiste für das Dokument 

angezeigt werden soll. 

 Arbeitsblattregister 

 Hier können Sie wählen, ob das Arbeitsblattregister unter der Tabelle angezeigt 

werden soll. Dieses dient zum Anlegen und Verwalten von Arbeitsblättern. 

Rubrik „Objekte“ 

 Textrahmen-Hilfslinien 

 Hier können Sie wählen, ob um Textrahmen graue Linien angezeigt werden 

sollen. Diese dienen lediglich dazu, die Position und Größe des Textrahmens 

anzuzeigen; sie werden nicht ausgedruckt. 

 Verborgene Objekte anzeigen 

 Wie Sie im Abschnitt „Verbergen von Objekten“ ab Seite 231 nachlesen kön-

nen, lassen sich Objekte verbergen, sprich: unsichtbar machen. 

 Schalten Sie jedoch die Option Verborgene Objekte anzeigen ein, werden 

auch verborgene Objekte wieder sichtbar. 

Standardwährung 

Hier können Sie die Standardwährung für das Dokument einstellen. Normalerweise 

sollte diese Option auf Aus Systemeinstellung gesetzt sein. Das bedeutet, dass 

PlanMaker die Standardwährung aus dem Ländereinstellungen Ihres Systems ver-

wendet.  

Wählen Sie eine andere Währung aus, hat das folgende Konsequenzen: 

1. Wenn Sie auf das Symbol  in der Formatleiste klicken, wird die Zelle in 

dieser Währung formatiert (statt der Standardwährung Ihres Systems). 
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2. Wenn Sie eine Rechenfunktion verwenden, die von PlanMaker automatisch im 

Währungsformat formatiert wird, verwendet PlanMaker diese Währung. 

Hinweis: Normalerweise gibt es keinen Grund, diese Einstellung zu ändern. 

PlanMaker ermittelt die auf Ihrem System eingestellte Währung automatisch und 

verwendet diese als Standardwährung. 

Schaltfläche „Kompatibilität“ 

Hier können programminterne Einstellungen zur Kompatibilität mit älteren Plan-

Maker-Dokumenten und Excel-Dokumenten vorgenommen werden. Diese werden 

beim Öffnen des Dokuments automatisch gesetzt und sollten normalerweise nicht 

verändert werden. 

Dokumenteigenschaften, Karteikarte Berechnen 

Auf der Karteikarte Berechnen im Dialogfenster von Datei > Eigenschaften kön-

nen Sie Einstellungen zu den Berechnungen im aktuellen Dokument vornehmen: 

Rubrik „Neuberechnung“ 

Hier können Sie bestimmen, ob die Berechnungen in der Tabelle automatisch aktu-

alisiert werden sollen, wenn Sie Änderungen am Tabelleninhalt vornehmen: 

 Automatisch berechnen 

 Wählen Sie diese Option, werden alle Berechnungen im Dokument automatisch 

erneut durchgeführt, wenn Sie etwas an der Tabelle ändern, also beispielsweise 

den Inhalt einer Tabellenzelle ändern. 

 Dies ist die Standardeinstellung. Sie sorgt dafür, dass alle Berechnungen stets 

aktuelle Ergebnisse liefern. 

 Neuberechnen nur vor dem ... 

 Wählen Sie hingegen diese Option, werden die Berechnungen nur dann auto-

matisch neu berechnet, wenn Sie das Dokument speichern, es drucken 

und/oder Zellen kopieren – je nachdem, welche Option(en) Sie hier wählen. 

Schalten Sie alle drei Optionen ab, werden Berechnungen überhaupt nicht mehr 

automatisch aktualisiert. 
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 Sie können die Berechnungen allerdings jederzeit manuell aktualisieren lassen: 

Rufen Sie dazu den Befehl Weiteres > Neu berechnen auf oder drücken Sie 

die Taste (F9). 

Rubrik „Externe Bezüge“ 

Hier können Sie Einstellungen zu externen Zellbezügen vornehmen. Das sind Be-

züge, die sich auf Zellen in anderen Arbeitsmappen beziehen. Details dazu finden 

Sie im Abschnitt „Externe Zellbezüge“ ab Seite 444. 

Verfügbare Optionen: 

 Daten nach dem Öffnen aktualisieren 

 Hier können Sie festlegen, ob beim Öffnen eines Dokuments alle darin enthal-

tenen externen Bezüge (einmalig) aktualisiert werden sollen: 

 Immer: Beim Öffnen externe Bezüge automatisch aktualisieren 

 Niemals: Beim Öffnen externe Bezüge nicht aktualisieren 

 Nachfragen: Beim Öffnen den Anwender fragen, ob die externen Bezüge aktu-

alisiert werden sollen. 

 Externe Daten im Dokument speichern 

 Ist diese Option aktiviert, speichert PlanMaker eine Kopie aller Werte, die von 

externen Zellbezügen geliefert werden, im Dokument. Fehlt die Datei für einen 

externen Bezug beim Aktualisieren, wird auch weiterhin der Wert angezeigt, 

den sich PlanMaker zuletzt gemerkt hat. 

 Schalten Sie die Option aus, wird stattdessen ein Fehlerwert angezeigt, wenn 

Sie einen externen Bezug aktualisieren und auf die zugehörige Datei nicht zu-

gegriffen werden kann. 

Rubrik „Rundung“ 

Aufgrund der Tatsache, dass wir Menschen ein anderes Zahlensystem als Compu-

ter verwenden, kann es beim Rechnen auf einem Computer gelegentlich zu (sehr 

kleinen) Rundungsfehlern kommen. Dies ist kein PlanMaker-spezifisches Problem, 

sondern prinzipbedingt und bei allen Computerprogrammen festzustellen. 

PlanMaker hat jedoch zwei Optionen, mit denen diese Rundungsfehler weitgehend 

ausgemerzt werden können: 
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 Schalten Sie die Option Endergebnis runden ein, rundet PlanMaker das End-

ergebnis jeder Berechnung in einer Zelle automatisch auf 15 Stellen.  

 Schalten Sie die Option Zwischenergebnisse runden ein, werden auch sämtli-

che Zwischenergebnisse einer Berechnung auf 15 Stellen gerundet.  

Die erste Option reduziert die Wahrscheinlichkeit, einen Rundungsfehler zu erhal-

ten, bereits erheblich, die zweite Option macht dies nochmals unwahrscheinlicher. 

Der Nachteil beider Optionen ist allerdings, dass das Neuberechnen von Tabellen 

etwas länger dauert. 

Ein klassisches Beispiel für dieses Rundungsproblem: 

Sind beide Optionen ausgeschaltet, ergibt die Berechnung (0,1+0,2-0,3)=0 den 

Wert FALSCH, obwohl WAHR das korrekte Ergebnis wäre. Schalten Sie die bei-

den Optionen ein, liefert die Berechnung ein korrektes Ergebnis. 

Rubrik „Diagramme“ 

Genau wie Berechnungen werden standardmäßig auch Diagramme automatisch 

aktualisiert, wenn Sie etwas am Tabelleninhalt ändern. 

Möchten Sie das nicht, dann können Sie die Option Automatisch aktualisieren in 

der Rubrik Diagramme ausschalten. 

Diagramme müssen dann bei Bedarf von Hand aktualisiert werden. Rufen Sie dazu 

den Befehl Weiteres > Diagramme aktualisieren auf oder drücken Sie die Taste 
(F8). 

Rubrik „Iterationen“ 

Diese Einstellung betrifft Zellen, die einen zirkulären Bezug enthalten. Von einem 

zirkulären Bezug spricht man, wenn eine Zelle beispielsweise eine Berechnung mit 

sich selbst durchführt, also zum Beispiel in der Zelle A1 die Formel =A1+A2 steht. 

Aktivieren Sie die Option Iterationen durchführen, werden solche Berechnungen 

bei jedem Neuberechnen des Arbeitsblatts so oft wiederholt, bis entweder die Ma-

ximale Anzahl erreicht ist oder das Ergebnis der Berechnung vom vorherigen Er-

gebnis um weniger als die Maximale Änderung abweicht. 

Normalerweise sollten Tabellen jedoch keine zirkulären Bezüge enthalten, weshalb 

diese Option standardmäßig ausgeschaltet ist. 
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Hinweis: Sofern Sie nicht bewusst zirkuläre Bezüge in der Tabelle verwenden, 

um beispielsweise Werte mit einem Iterationsverfahren zu ermitteln, sollten Sie 

diese Option nicht aktivieren, da sie die für das Neuberechnen der Tabelle erfor-

derliche Zeit deutlich erhöhen kann. 

Dokumenteigenschaften, Karteikarte Schutz 

Auf der Karteikarte Schutz im Dialogfenster von Datei > Eigenschaften können 

Sie Dokumente mit einem Dokumentschutz versehen. 

Öffnen beziehungsweise Speichern eines geschützten Dokuments ist nur nach Ein-

gabe des korrekten Kennworts möglich. Dokumente mit Leseschutz werden dabei 

zusätzlich verschlüsselt, damit sie auch mit anderen Programmen nicht eingesehen 

werden können. 

Informationen zu diesem Thema finden Sie im Abschnitt „Dokumentschutz“ ab 

Seite 360. 

Dokumenteigenschaften, Karteikarte Schriften 

Hinweis: Diese Karteikarte ist nur bei der Windows-Version von PlanMaker 

verfügbar. 

Auf der Karteikarte Schriften im Dialogfenster von Datei > Eigenschaften wird 

eine Liste aller im aktuellen Dokument verwendeten Schriftarten angezeigt. 

Die Liste ist aufgeteilt nach Schriften, die auf dem aktuell verwendeten Gerät ver-

fügbar sind, und solchen, die nicht verfügbar (sprich: installiert) sind. 

Arbeitsblatteigenschaften ändern 

Über den Befehl Tabelle > Eigenschaften können Sie Einstellungen festlegen, die 

nur das aktuelle Arbeitsblatt betreffen.  

Besteht ein Dokument also aus mehreren Arbeitsblättern, können Sie diese Einstel-

lungen für jedes Blatt getrennt vornehmen. Wechseln Sie dazu auf das gewünschte 

Arbeitsblatt und rufen Sie dann obigen Befehl auf. 

Es erscheint ein Dialogfenster mit folgenden Optionen: 
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 Zeilenköpfe 

 Ist diese Option aktiviert, werden Zeilenköpfe (mit 1, 2, 3... beschriftete Schalt-

flächen links der Tabelle) in dem Arbeitsblatt angezeigt. 

 Spaltenköpfe 

 Ist diese Option aktiviert, werden Spaltenköpfe (mit A, B, C... beschriftete 

Schaltflächen oberhalb der Tabelle) in dem Arbeitsblatt angezeigt. 

 Tipp: Sie können auch den Befehl Ansicht > Zeilen- & Spaltenköpfe ver-

wenden, um die Zeilen- und die Spaltenköpfe gemeinsam ein- oder auszuschal-

ten. 

 Seitenumbrüche 

 Ist diese Option aktiviert, wird eine dunkle Linie zwischen denjenigen Zellen 

angezeigt, bei denen beim Ausdruck ein Seitenumbruch stattfinden wird. 

 Nullwerte anzeigen 

 Eine Zelle enthält einen Nullwert, wenn dort entweder die Zahl 0 (Null) einge-

tragen wurde oder die Zelle eine Berechnung enthält, die Null ergibt.  

 Ist diese Option aktiviert, wird in solchen Zellen wie üblich die Zahl „0“ ange-

zeigt. Schalten Sie sie aus, wird darin nichts mehr angezeigt. 

 Gitternetzlinien 

 Ist diese Option aktiviert, wird ein Raster aus grauen Gitternetzlinien zwischen 

den Tabellenzellen angezeigt. Darunter können Sie auf Wunsch die Farbe die-

ser Linien ändern. 

 Die Gitternetzlinien werden normalerweise nicht ausgedruckt. Wenn Sie möch-

ten, dass diese Linien auch im Ausdruck erscheinen, rufen Sie den Befehl Datei 

> Seite einrichten auf, wechseln auf die Karteikarte Optionen und aktivieren 

darin die Option Gitternetz. 

 Abwechselnde Schattierung 

 Wenn Sie diese Option aktivieren, werden die Zeilen der Tabelle mit abwech-

selnden Schattierungen versehen: Jede ungerade Zeile erhält die Schattierung, 

die Sie mit der Schaltfläche Schattierung 1 festlegen; jede gerade Zeile erhält 

die mit Schattierung 2 festgelegte Schattierung. 

 Schreibrichtung 

 Für Tabellen in arabischer Schrift können Sie hier die Richtung des Arbeits-

blatts auf rechts-nach-links ändern.  
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 Das Arbeitsblatt wird dann horizontal gespiegelt – die Zelle A1 befindet sich 

also nicht mehr links oben, sondern rechts oben.  

 Siehe auch Kapitel „Arbeiten mit arabischem Text“ (ab Seite 371). 

Bildschirmdarstellung ändern 

In diesem Abschnitt erfahren Sie, wie Sie die Darstellung der Tabelle auf dem 

Bildschirm anpassen können. Die dazu benötigten Befehle finden Sie im Menü 

Ansicht. 

Folgende Themen werden in diesem Abschnitt behandelt: 

 Vergrößerungsstufe 

 Mit den Befehlen Ansicht > Originalgröße und Ansicht > Vergrößerungsstu-

fe können Sie die Vergrößerungsstufe einstellen, in der das Dokument ange-

zeigt wird. 

 Vollbildansicht 

 Der Befehl Ansicht > Vollbild maximiert das Programmfenster und blendet die 

meisten Bestandteile der Benutzeroberfläche aus, damit möglichst viel vom 

Dokument zu sehen ist.  

Lesen Sie dazu die nächsten Seiten. 

Vergrößerungsstufe 

Mit den Befehlen des Menüs Ansicht können Sie unter anderem die Vergröße-

rungsstufe für das aktuelle Dokument wählen. 

Während der Befehl Ansicht > Originalgröße das Dokument stets auf eine Ver-

größerungsstufe von 100% bringt, erlaubt Ansicht > Vergrößerungsstufe eine 

genaue Auswahl der gewünschten Vergrößerungsstufe: 

Vergrößerungsstufe Erläuterung 

An Selektion anpassen Wählt automatisch die Vergrößerungsstufe, bei der 

die momentan selektierten Zellen genau in das Ar-

beitsfenster passen. 
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Vorherige Vergrößerungsstufe Stellt die zuletzt gewählte Vergrößerungsstufe wieder 

her. 

50%, 75% etc. Wählt eine der vorgegebenen Vergrößerungsstufen. 

Alternativ können Sie auch eine beliebige Vergrößerungsstufe in das Eingabefeld 

oberhalb der Liste eintragen (50 bis 400 Prozent). 

Tipp: Verwenden des Zoomreglers 

Sie können die Vergrößerungsstufe auch mit dem Zoomregler in der rechten unte-

ren Bildschirmecke ändern. 

 

Ziehen Sie dazu entweder an dem Schieber in der Mitte, oder klicken Sie auf das 

Minus- oder Plussymbol, um die Vergrößerungsstufe zu verändern. 

Vollbildansicht 

Mit dem Befehl Ansicht > Vollbild) (Tastenkürzel (F6)) können Sie in die Voll-

bildansicht schalten, in der das Programm den gesamten Bildschirm zur Darstel-

lung des Dokuments nutzt. PlanMaker vergrößert dazu sein Programmfenster auf 

die volle Bildschirmgröße und blendet sämtliche Symbolleisten aus. 

Um diesen Ansichtsmodus wieder zu verlassen, drücken Sie die Taste (Esc) oder 

rufen den Befehl Ansicht > Vollbild noch einmal auf. 

Verwenden der Symbolleiste der Vollbildansicht 

Wenn Sie den Vollbildmodus aktivieren, erscheint eine zusätzliche Symbolleiste 

auf dem Bildschirm. 

 
Die Symbolleiste „Vollbildmodus“ 

Diese hat folgende Funktionen (von links nach rechts): 

 Menüleiste ein-/ausblenden 
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 Modus „Blatt verschieben“ aktivieren/deaktivieren 

 Wenn Sie diesen Modus aktivieren, können Sie das Dokument mit der Maus 

verschieben. Klicken Sie dazu in das Dokument und ziehen Sie es bei weiterhin 

gedrückter Maustaste in die gewünschte Richtung. 

 Hinweis: Das Anklicken von Zellen, um die Schreibmarke zu setzen oder etwas 

zu selektieren, ist in diesem Modus nicht mehr möglich. 

 Um den Modus „Blatt verschieben“ wieder zu verlassen, klicken Sie dieses 

Symbol noch einmal an. 

 Die Schaltfläche Schließen beendet den Vollbildmodus. 

Symbolleisten anpassen 

Es gibt in PlanMaker zahlreiche Symbolleisten (zum Beispiel die Funktionsleiste 

oder die Formatleiste). Symbolleisten ermöglichen blitzschnellen Zugriff auf die 

Funktionen von PlanMaker. Jedes Symbol steht für einen bestimmten Befehl. Kli-

cken Sie darauf, wird der entsprechende Befehl aufgerufen.  

 
Eine Symbolleiste (hier: die Funktionsleiste) 

In diesem Abschnitt wird beschrieben, wie Sie diese nützlichen Helfer an Ihren 

persönlichen Arbeitsstil anpassen. Mit dem Befehl Ansicht > Symbolleisten kön-

nen Sie die Symbolleisten nach Belieben konfigurieren: 

 Symbolleisten anzeigen/verbergen 

 Symbolleisten auf dem Bildschirm positionieren 

 Symbolleisten verwalten (eigene Symbolleisten erstellen, löschen, umbenen-

nen) 

 Symbole einer Symbolleiste bearbeiten (Symbole hinzufügen, entfernen, ver-

schieben) 

 Benutzerdefinierte Symbole erstellen (zum Starten beliebiger Programme) 

Informationen dazu finden Sie, in obiger Reihenfolge, auf den nächsten Seiten. 
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Symbolleisten anzeigen/verbergen 

Sie können die einzelnen Symbolleisten jederzeit ein- oder ausschalten, um bei-

spielsweise mehr Platz für das Bearbeiten des Dokuments auf dem Bildschirm zu 

gewinnen. 

Gehen Sie dazu wie folgt vor: 

1. Rufen Sie den Befehl Ansicht > Symbolleisten auf. 

2. Klicken Sie in das Kästchen vor der gewünschten Symbolleiste, um sie ein- 

beziehungsweise auszuschalten. Wenn die Symbolleiste eingeschaltet ist, er-

scheint ein Häkchen in dem Kästchen. 

3. Verlassen Sie das Dialogfenster mit Schließen. 

Die Symbolleiste wurde nun ein- beziehungsweise ausgeschaltet. 

Tipp: Dies geht auch schneller: Klicken Sie mit der rechten Maustaste auf eine 

beliebige Symbolleiste, erscheint ein Menü mit einer Liste aller verfügbaren 

Symbolleisten. Klicken Sie einen dieser Menüeinträge an, wird die entsprechen-

de Leiste ein- beziehungsweise ausgeschaltet. 

Sichtbar in Modus ... 

Manche Symbolleisten werden nur in bestimmten Arbeitsmodi von PlanMaker 

angezeigt. So ist zum Beispiel die Formatleiste nur im normalen Editiermodus 

sichtbar – wechseln Sie hingegen in den Objektmodus, wird sie ausgeblendet, da 

sie hier keine Funktion hat. 

Zuständig hierfür ist die Option Sichtbar in Modus ..., die bestimmt, wann eine 

Symbolleiste sichtbar ist. Einige Beispiele: 

Option Bedeutung 

Alle Die gewählte Symbolleiste ist immer sichtbar (sofern sie natür-

lich nicht ausgeschaltet wurde). Beispiel: Funktionsleiste 

Editiermodus Die Leiste ist nur im normalen Editiermodus sichtbar, nicht je-

doch im Objektmodus (siehe auch Abschnitt „Der Objektmodus“ 

ab Seite 215). Beispiel: Formatleiste 

Objekt Die Leiste ist nur im Objektmodus sichtbar, nicht jedoch im 

normalen Editiermodus (siehe auch Abschnitt „Der Objektmo-

dus“ ab Seite 215). Beispiel: Objektleiste 
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Diagramm Die Leiste erscheint nur, wenn im Dokument ein Diagramm 

selektiert wird. Beispiel: Diagrammleiste 

Gliederung Die Leiste erscheint nur, wenn die Gliederung des Dokuments 

angezeigt wird (siehe auch Abschnitt „Gliederungen“ ab Seite 

333). Beispiel: Gliederungsleiste 

Grafik Die Leiste erscheint nur, wenn im Dokument eine Grafik selek-

tiert wird. Beispiel: Grafikleiste 

Um diese Einstellung für eine der Symbolleisten zu ändern, rufen Sie Ansicht > 

Symbolleisten auf, selektieren die Leiste in der Liste Symbolleisten und wählen 

die gewünschte Option bei Sichtbar in Modus... 

Hinweis: Es macht normalerweise keinen Sinn, diese Einstellung bei den Stan-

dard-Symbolleisten (Funktionsleiste, Formatleiste etc.) zu ändern. Diese Einstel-

lung ist in erster Linie für selbsterstellte Symbolleisten gedacht. 

Symbolleisten auf dem Bildschirm positionieren 

Sie können jede einzelne Symbolleiste nach Belieben auf dem Bildschirm positio-

nieren. Verwenden Sie dazu entweder den Befehl Ansicht > Symbolleisten oder 

ziehen Sie die Symbolleiste einfach mit der Maus an die gewünschte Position. 

Ändern der Position mit dem Befehl Ansicht > Symbolleisten 

Gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Ansicht > Symbolleisten auf. 

2. Selektieren Sie die gewünschte Symbolleiste per Mausklick. 

3. Wählen Sie bei Position, wo die Symbolleiste platziert werden soll. 

Hinweis: Wenn Sie die Option Frei wählen, werden die Symbole der Symbolleiste 

in einem Fenster angezeigt, das wie ein Programmfenster frei bewegt, vergrößert 

und verkleinert werden kann. 

Ändern der Position mit der Maus 

Alle derzeit eingeschalteten Symbolleisten lassen sich auch mit der Maus verschie-

ben. Gehen Sie wie folgt vor: 
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1. Zeigen Sie mit der Maus auf einen leeren Bereich der Symbolleiste. 

2. Drücken Sie die linke Maustaste und halten Sie diese gedrückt. 

3. Ziehen Sie die Symbolleiste bei weiterhin gedrückter Maustaste an die ge-

wünschte Position. 

4. Lassen Sie die Maustaste los, um die Symbolleiste dort abzusetzen. 

Beim Verschieben ist eine Positionierhilfe aktiv: Wenn Sie die Symbolleiste in die 

Nähe einer der Kanten des Programmfensters ziehen, springt diese automatisch auf 

die entsprechende Kante. Lassen Sie die Leiste beispielsweise an der oberen Kante 

los, entspricht dies dem Wählen der Position Oben im Dialogfenster von Ansicht 

> Symbolleisten.  

Verschieben mit der Maus verhindern: Wenn Sie verhindern möchten, dass eine Sym-

bolleiste versehentlich mit der Maus verschoben werden kann, rufen Sie den Be-

fehl Ansicht > Symbolleisten auf, selektieren die entsprechende Leiste und schal-

ten die Option Nicht verschiebbar ein. 

Symbolleisten verwalten 

Sie können jederzeit neue Symbolleisten erstellen und vorhandene Leisten löschen, 

umbenennen etc. Verwenden Sie hierzu die Schaltflächen im Dialogfenster des 

Befehls Ansicht > Symbolleisten. 

Neue Symbolleiste erstellen 

PlanMaker lässt Sie jederzeit eigene Symbolleisten erstellen.  

Benötigen Sie beispielsweise häufig die Befehle des Menüs Fenster, die in der 

Standard-Funktionsleiste nicht vorhanden sind, wäre es überlegenswert, sich hier-

für eine eigene Symbolleiste anzulegen. 

Folgendermaßen erstellen Sie eine neue Symbolleiste: 

1. Betätigen Sie die Schaltfläche Neu. 

2. Es erscheint ein Dialogfenster, in das Sie einen Namen für die neue Leiste ein-

geben – zum Beispiel „Meine Symbolleiste“. Bestätigen Sie dann mit OK. 

3. Die neue Symbolleiste wurde angelegt. Schließen Sie das Dialogfenster oder 

klicken Sie auf die Schaltfläche Bearbeiten, um sie gleich mit Symbolen zu 

füllen. Lesen Sie dazu den Abschnitt „Symbole einer Symbolleiste bearbeiten“ 

ab Seite 419. 
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Symbolleiste löschen 

Mit der Schaltfläche Löschen entfernen Sie eine selbsterstellte Symbolleiste: 

1. Selektieren Sie die zu löschende Symbolleiste in der Liste. 

2. Betätigen Sie die Schaltfläche Löschen. 

Hinweis: Sie können nur selbsterstellte Symbolleisten löschen. Die Standard-

Symbolleisten (Funktionsleiste, Formatleiste etc.) lassen sich nicht entfernen.  

Sie können eine Standard-Symbolleiste jedoch jederzeit ausschalten, wenn Sie sie 

nicht benötigen (siehe Abschnitt „Symbolleisten anzeigen/verbergen“ ab Seite 

415). 

Symbolleiste umbenennen 

Mit der Schaltfläche Umbenennen geben Sie einer selbsterstellten Symbolleiste 

einen anderen Namen: 

1. Selektieren Sie die gewünschte Symbolleiste in der Liste. 

2. Betätigen Sie die Schaltfläche Umbenennen. 

3. Tippen Sie den neuen Namen ein und bestätigen Sie mit OK. 

Hinweis: Sie können nur selbsterstellte Symbolleisten umbenennen. Die Standard-

Symbolleisten (Funktionsleiste, Formatleiste etc.) lassen sich nicht umbenennen. 

Symbolleiste zurücksetzen 

Mit der Schaltfläche Zurücksetzen machen Sie alle Änderungen an einer der 

Standard-Symbolleisten rückgängig: 

1. Selektieren Sie die gewünschte Symbolleiste in der Liste. 

2. Betätigen Sie die Schaltfläche Zurücksetzen. 

Nun enthält die Symbolleiste wieder die Standard-Symbole. Außerdem wurden die 

Optionen Sichtbar in Modus... und Position auf die Standardeinstellung zurück-

gesetzt. 

Hinweis: Dieser Befehl ist nur auf die Standard-Symbolleisten (Funktionsleiste, 

Formatleiste etc.) anwendbar, nicht jedoch auf selbsterstellte Symbolleisten. 
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Symbole einer Symbolleiste anpassen 

Mit der Schaltfläche Bearbeiten können Sie die Symbole auf Symbolleisten bear-

beiten. Informationen hierzu finden Sie im nächsten Abschnitt. 

Symbole einer Symbolleiste bearbeiten 

Sie können in Symbolleisten jederzeit Symbole hinzufügen, entfernen und ver-

schieben sowie Trennstriche/Leerräume einfügen und entfernen. 

Dazu gehen Sie folgendermaßen vor: 

1. Stellen Sie sicher, dass die betreffende Symbolleiste eingeschaltet ist. Ist dies 

nicht der Fall, rufen Sie Ansicht > Symbolleisten auf und schalten die Symbol-

leiste ein. 

2. Rufen Sie den Befehl Weiteres > Anpassen > Symbolleisten auf. Alternativ 

können Sie diesen Befehl auch durch Betätigen der Schaltfläche Anpassen im 

Dialogfenster des Befehls Ansicht > Symbolleisten aufrufen. 

3. Verwenden Sie eines der unten beschriebenen Verfahren, um Symbole hinzuzu-

fügen, zu entfernen, zu verschieben etc. 

4. Verlassen Sie den Dialog mit Schließen. 

Tipp: Der Befehl Weiteres > Anpassen > Symbolleisten lässt sich auch über das 

Kontextmenü für Symbolleisten oder durch einen Doppelklick auf einen leeren 

Bereich einer beliebigen Symbolleiste aufrufen.  

Beim Aufruf dieses Befehls erscheint ein Dialogfenster, in dem sämtliche Symbole 

aufgelistet sind, die Sie einer Symbolleiste hinzufügen können. 
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Die Symbole für die einzelnen Befehle sind der Übersichtlichkeit halber auf Kate-

gorien verteilt. Wählen Sie in der Liste Gruppe eine Kategorie, werden in der Lis-

te Befehl alle verfügbaren Symbole dieser Kategorie angezeigt.  

Das Bearbeiten der Symbole einer Symbolleiste funktioniert folgendermaßen: 

 Hinzufügen eines Symbols 

 Ziehen Sie das Symbol mit der Maus einfach direkt aus dem Dialogfenster an 

die gewünschte Position in der Symbolleiste. 

 Löschen eines Symbols 

 Ziehen Sie das Symbol aus der Symbolleiste heraus (z.B. in das Dokument), 

worauf es gelöscht wird.  

 Verschieben eines Symbols 

 Ziehen Sie das Symbol in der Symbolleiste mit der Maus an die gewünschte 

Position. Sie können ein Symbol auch von einer Symbolleiste in eine andere 

verschieben. 

 Tipp: Das Verschieben von Symbolen funktioniert übrigens auch, wenn dieser 

Dialog nicht geöffnet ist. Halten Sie einfach die Taste (Alt) gedrückt und ziehen 

Sie das Symbol dann mit der Maus an die neue Position. 

 Einfügen eines Trennstrichs/Leerraums 

 Ziehen Sie ein Symbol einige Millimeter nach rechts, wird links davon ein 

Trennstrich oder ein Leerraum eingefügt (je nach Betriebssystem). 
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 Entfernen eines Trennstrichs/Leerraums 

 Ziehen Sie ein Symbol, das sich rechts von einem Trennstrich/Leerraum befin-

det, an das Symbol links davon heran, wird der Trennstrich/Leerraum entfernt. 

Zurücksetzen einer Symbolleiste: Falls Sie beim Bearbeiten einer der Standard-

Symbolleisten Fehler gemacht haben, können Sie die Leiste jederzeit zurücksetzen. 

Rufen Sie dazu den Befehl Ansicht > Symbolleisten auf, selektieren Sie die ge-

wünschte Symbolleiste per Mausklick und betätigen Sie die Schaltfläche Zurück-

setzen. Nun werden alle Änderungen an der Symbolleiste rückgängig gemacht; sie 

enthält also wieder die Standard-Symbole.  

Benutzerdefinierte Symbole erstellen 

Sie können auch benutzerdefinierte Symbole anlegen und diese dann in beliebige 

Symbolleisten einfügen. Mit solchen Symbolen lassen sich beliebige Programme 

starten. 

Um ein benutzerdefiniertes Symbol anzulegen – zum Beispiel eines zum Starten 

des Windows-Editors –, gehen Sie folgendermaßen vor: 

1. Rufen Sie Weiteres > Anpassen > Symbolleisten auf. 

2. Wählen Sie in der Liste Gruppe die Kategorie Benutzer. 

3. Wählen Sie eines der Symbole in der Liste Befehl. Die ersten drei Symbole 

sind (als Beispiel) mit dem Windows-Taschenrechner, der Windows-Zeichenta-

belle und der Windows-Systemsteuerung vorbelegt. Wählen Sie beispielsweise 

das vierte Symbol. 

4. Betätigen Sie die Schaltfläche Bearbeiten. Er erscheint ein weiteres Dialog-

fenster. 

5. Tragen Sie bei Beschreibung eine kurze Beschreibung für das zu startende 

Programm ein – zum Beispiel „Windows-Editor“. 

6. Bei Befehlszeile geben Sie den vollständigen Pfad und Dateinamen des zu star-

tenden Programms an – zum Beispiel C:\WINDOWS\NOTEPAD.EXE. 

7. Optional: Falls in der Symbolleiste ein anderes Symbol als das Standardsymbol 

dieses Programms angezeigt werden soll, tragen Sie bei Symboldatei den Pfad 

und Dateinamen der gewünschten Symboldatei ein.  

 Beachten Sie dabei, dass Symbole in Symbolleisten etwas kleiner sind als die 

üblichen Windows-Symbole. 
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8. Bestätigen Sie mit OK. 

9. Das benutzerdefinierte Symbol ist nun angelegt. Falls Sie es gleich in eine der 

Symbolleisten setzen möchten, ziehen Sie es mit der Maus in die gewünschte 

Symbolleiste. 

Wenn Sie das Dialogfenster nun mit Schließen verlassen, können Sie das neue 

Symbol gleich ausprobieren. Klicken Sie es an, wird der Windows-Editor gestartet.  

Falls das nicht klappt, ist der Pfad oder Dateiname falsch eingetragen. Bearbeiten 

Sie das Symbol dann erneut (wie oben beschrieben) und korrigieren Sie die Anga-

ben.  

Verwenden des Symbolleisten-Menüs 

Einige Symbolleisten enden mit einem doppelten Pfeil » nach rechts, wie in fol-

gender Abbildung zu sehen: 

 

Wenn Sie diesen Doppelpfeil anklicken, öffnet sich das Symbolleisten-Menü für 

diese Leiste.  

Dieses Menü ermöglicht schnellen Zugriff auf alle Befehle zum Arbeiten mit Sym-

bolleisten, die in den vorherigen Abschnitten beschrieben wurden. Im Einzelnen 

gibt es im Symbolleisten-Menü folgende Befehle: 

 Schaltflächen hinzufügen/entfernen 

 Dieser Befehl zeigt eine Liste aller Symbole für eine Symbolleiste an. Klicken 

Sie einen der Einträge an, wird das entsprechende Symbol in der Leiste ein- be-

ziehungsweise ausgeschaltet. 

 (Dieser Befehl soll nur zum schnellen Ein- oder Ausschalten von Symbolen 

dienen. Wie Sie die Symbole auf einer Leiste individuell konfigurieren, ist im 

Abschnitt „Symbole einer Symbolleiste bearbeiten“ ab Seite 419 beschrieben.) 

 Position 

 Mit diesem Befehl können Sie die Position der Symbolleiste ändern. Verfügba-

re Optionen: oben, unten, links, rechts oder frei (in einem kleinen Fenster, des-

sen Position und Größe sich mit der Maus beliebig ändern lassen). 
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 Symbolleisten 

 Ruft den Befehl Ansicht > Symbolleisten auf, mit dem Sie Symbolleisten ein-

/ausschalten, konfigurieren und verwalten können. 

 Siehe Abschnitt „Symbolleisten anpassen“ ab Seite 414. 

 Anpassen 

 Ruft den Befehl Weiteres > Anpassen > Symbolleisten auf, mit dem Sie die 

Symbole einer Symbolleiste bearbeiten können (Symbole hinzufügen, entfer-

nen, verschieben etc.). 

 Siehe Abschnitt „Symbole einer Symbolleiste bearbeiten“ ab Seite 419. 

 Diese Symbolleiste zurücksetzen 

 Setzt die Symbolleiste zurück. Die Leiste zeigt dann wieder ihre Standardsym-

bole an. Außerdem werden alle Einstellungen, die zu der Leiste gemacht wur-

den, verworfen. 

Tastenkürzel anpassen 

Wie Sie wissen, lassen sich die gebräuchlichsten Befehle von PlanMaker auch über 

„Tastenkürzel“ aufrufen. So können Sie beispielsweise den Befehl Datei > Spei-

chern blitzschnell mit der Tastenkombination (Strg)(S) aufrufen. 

Mit dem Befehl Weiteres > Anpassen > Tastaturbelegung lassen sich diese Tas-

tenkürzel nach Belieben anpassen. Sie können Befehlen neue Tastenkürzel zuord-

nen und vorhandene Zuordnungen ändern oder entfernen. 
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Weiterhin können Sie mit kompletten Tastaturbelegungen arbeiten. In einer Tasta-

turbelegung sind die Tastenkürzel für sämtliche Befehle gespeichert. Wenn Sie 

zwischen zwei Tastaturbelegungen wechseln, ändern sich dementsprechend alle 

Tastenkürzel. 

Das Dialogfenster des Befehls Weiteres > Anpassen > Tastaturbelegung verfügt 

über Schaltflächen mit folgenden Funktionen: 

 Schaltfläche „Anwenden“: Die selektierte Tastaturbelegung aktivieren 

 Schaltfläche „Neu“: Neue Tastaturbelegung erstellen 

 Hinweis: Wenn Sie nur einige Tastenkürzel hinzufügen oder ändern möchten, 

ist es nicht erforderlich, dafür extra eine eigene Tastaturbelegung anzulegen. 

Klicken Sie einfach auf die Schaltfläche Bearbeiten, und ändern Sie direkt die 

Standard-Tastaturbelegung. 

 Schaltfläche „Bearbeiten“: Tastenkürzel einer Tastaturbelegung bearbeiten 

 Schaltfläche „Löschen“: Tastaturbelegung löschen 

 Schaltfläche „Umbenennen“: Tastaturbelegung umbenennen 

 Schaltfläche „Zurücksetzen“: Tastenkürzel einer Tastaturbelegung auf die 

Standardkürzel zurücksetzen (nur bei den vorgegebenen Belegungen Standard 

und Classic möglich). 

Ausführliche Informationen folgen auf den nächsten Seiten. 
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Tastaturbelegung aktivieren 

Mit dem Befehl Weiteres > Anpassen > Tastaturbelegung können Sie wählen, 

welche Tastaturbelegung aktiv sein soll. 

Gehen Sie dazu wie folgt vor: 

1. Rufen Sie den Befehl Weiteres > Anpassen > Tastaturbelegung auf. 

2. Selektieren Sie die gewünschte Tastaturbelegung. 

3. Klicken Sie auf Anwenden, um sie zu aktivieren. 

Nun stehen die in der Tastaturbelegung festgelegten Tastenkürzel zur Verfügung. 

Wie eingangs erwähnt, sind in einer Tastaturbelegung alle Tastenkürzel für sämtli-

che Befehle gespeichert. Wenn Sie zwischen zwei Tastaturbelegungen wechseln, 

ändern sich alle Tastenkürzel entsprechend.  

Standardmäßig sind die zwei folgenden Tastaturbelegungen vorgegeben: 

Standard Die Standardbelegung – enthält alle in diesem Handbuch er-

wähnten Tastenkürzel (z.B. (Strg)(S) für Speichern) 

Classic Eine an WordStar angelehnte Tastaturbelegung (früher weit 

verbreitete Tastaturbelegung). 

Tipp: Eine Tabelle der wichtigsten Tastenkürzel der Tastaturbelegung Standard 

finden Sie im Kapitel „Tastenbelegung“ ab Seite 753. 

Bei Bedarf können Sie diese beiden Standardbelegungen jederzeit abändern und 

auch eigene Tastaturbelegungen erstellen, womit sich die nachfolgenden Abschnit-

te befassen. 

Tastaturbelegung erstellen 

Mit dem Befehl Weiteres > Anpassen > Tastaturbelegung lassen sich komplette 

Tastaturbelegungen zusammenstellen. So können Sie sich mehrere Tastaturbele-

gungen für unterschiedliche Einsatzzwecke anlegen und bei Bedarf zwischen die-

sen wechseln. 

Hinweis: Wenn Sie nur einige Tastenkürzel hinzufügen oder ändern möchten, ist 

es nicht erforderlich, dafür extra eine eigene Tastaturbelegung anzulegen. Kli-

cken Sie einfach auf die Schaltfläche Bearbeiten, und ändern Sie direkt die 

Standard-Tastaturbelegung. 



 

426    Anpassen von PlanMaker Handbuch PlanMaker 

Folgendermaßen erstellen Sie eine neue Tastaturbelegung: 

1. Rufen Sie den Befehl Weiteres > Anpassen > Tastaturbelegung auf. 

2. Wählen Sie die Tastaturbelegung aus, auf der die neue Tastaturbelegung basie-

ren soll. 

 Hinweis: Die neue Tastaturbelegung übernimmt automatisch alle Tastenkürzel 

der Tastaturbelegung, die Sie hier auswählen. 

3. Betätigen Sie die Schaltfläche Neu... 

4. Es erscheint ein Dialogfenster, in das Sie einen Namen für die neue Tastaturbe-

legung eingeben – zum Beispiel „Meine Tastaturbelegung“. Bestätigen Sie 

dann mit OK. 

Die neue Tastaturbelegung wird nun angelegt. Anschließend erscheint automatisch 

ein Dialogfenster zum Ändern der Tastenkürzel. Informationen hierzu finden Sie 

im Abschnitt „Tastenkürzel einer Tastaturbelegung bearbeiten“ ab Seite 426. 

Tastaturbelegung umbenennen oder löschen 

Selbsterstellte Tastaturbelegungen lassen sich jederzeit umbenennen oder löschen. 

Gehen Sie dazu wie folgt vor: 

1. Rufen Sie den Befehl Weiteres > Anpassen > Tastaturbelegung auf. 

2. Wählen Sie die gewünschte Tastaturbelegung per Mausklick. 

3. Klicken Sie auf Umbenennen, um ihr einen neuen Namen zu geben. 

 Oder: Klicken Sie auf Löschen, um sie zu löschen. 

Sie können nur selbsterstellte Tastaturbelegungen umbenennen oder löschen. Die 

vorgegebenen Belegungen Standard und Classic lassen sich nicht entfernen.  

Tastenkürzel einer Tastaturbelegung bearbeiten 

Mit dem Befehl Weiteres > Anpassen > Tastaturbelegung lassen sich Tastaturbe-

legungen nicht nur anlegen und verwalten. Die wichtigste Funktion dieses Befehls 

ist vielmehr das Ändern der enthaltenen Tastenkürzel. Hierzu dient die Schaltfläche 

Bearbeiten. 
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Einem Befehl ein Tastenkürzel zuweisen 

Wenn Sie einen der Menübefehle besonders häufig benötigen, können Sie ihm ein 

Tastenkürzel zuweisen, um ihn zukünftig blitzschnell mit einem einzigen Tasten-

druck aufrufen zu können. 

Um beispielsweise dem Befehl Tabelle > Sortieren das Tastenkürzel (Strg)(F12) 

zuzuweisen, gehen Sie wie folgt vor: 

1. Rufen Sie den Befehl Weiteres > Anpassen > Tastaturbelegung auf. 

2. Falls nötig: Selektieren Sie die gewünschte Tastaturbelegung (falls Sie eine 

andere als die derzeit aktive Tastaturbelegung verändern möchten). 

3. Klicken Sie auf die Schaltfläche Bearbeiten. 

4. Wählen Sie in der Liste Gruppe eine Befehlskategorie. Wählen Sie dann in der 

Liste Befehl den Befehl, dessen Tastenkürzel Sie verändern möchten.  

 In unserem Beispiel wäre also bei Gruppe „Tabelle“ und bei Befehl „Sortie-

ren“ zu wählen. 

5. Klicken Sie in das Eingabefeld Bitte Tastenkürzel drücken und betätigen Sie 

das gewünschte Tastenkürzel – hier also (Strg)(F12). 

 Tipp: Falls Sie sich vertippt haben, können Sie das eingegebene Tastenkürzel 

mit der Rücktaste (æ__) wieder löschen. 

6. Nicht vergessen: Klicken Sie auf Hinzufügen, um dem Befehl dieses Tasten-

kürzel zuzuweisen.  

7. Bestätigen Sie mit OK und verlassen Sie den Hauptdialog mit Schließen. 

Zukünftig können Sie den Befehl Tabelle > Sortieren mit der Tastenkombination 
(Strg)(F12) aufrufen.  

Verfügbare Tastenkürzel 

Beachten Sie, dass nicht alle Tastenkombinationen, die Sie auf Ihrer Tastatur er-

zeugen können, auch für Tastenkürzel erlaubt sind. 

In der Regel sollten Sie für Tastenkürzel Buchstabentasten, Zahlentasten oder 

Funktionstasten verwenden. Diese können Sie mit den Tasten (Strg), (Alt) 

und/oder der Umschalttaste (ª) kombinieren. 
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Sie können ganz einfach überprüfen, ob die von Ihnen gewünschte Tastenkombina-

tion zulässig ist: Betätigen Sie die Tastenkombination im Feld Bitte Tastenkürzel 

drücken. Wenn sie nicht erscheint, ist sie nicht zulässig.  

Einige Beispiele für gültige Tastenkürzel: 

 (Strg)(A) 

 (Alt)(A) (Tastenkombinationen mit der Alt-Taste sind allerdings nicht zu emp-

fehlen – (Alt)(A) ist beispielsweise für den Aufruf des Menüs Ansicht zustän-

dig!) 

 (Strg)(Alt)(A) 

 (Strg)(ª)(A) 

 (Strg)(Alt)(ª)(A) 

 (Strg)(F1) 

 etc. 

Hinweis: Buchstaben allein sind natürlich nicht zulässig. Sie können also nicht (A) 

oder (ª)(A) als Tastenkürzel verwenden. 

Tastenkürzel bereits belegt: Wenn Sie ein Tastenkürzel drücken, das bereits belegt ist, 

wird unter dem Eingabefeld angezeigt, womit dieses Kürzel momentan belegt ist. 

Sie sollten dann die Rücktaste (æ__) betätigen, um das Tastenkürzel wieder zu 

löschen und ein anderes Tastenkürzel nehmen. Andernfalls überschreiben Sie die 

bisherige Zuordnung dieses Kürzels. 

Zweiteilige Tastenkürzel: Sie können auch zweiteilige Tastenkürzel verwenden (ent-

sprechend dem WordStar-Standard) – zum Beispiel (Strg)(K)(X). Hierbei sind al-

lerdings nur Tastenkürzel nach dem Schema „Strg + Buchstabe + Buchstabe“ zu-

lässig. 

Ein Tastenkürzel wieder entfernen 

Wenn Sie Befehlen Tastenkürzel zuordnen, können Sie dies jederzeit wieder rück-

gängig machen, indem Sie diese Zuordnung entfernen. 

Dazu gehen Sie wie folgt vor: 

1. Rufen Sie, wie oben beschrieben, den Dialog Tastaturbelegung bearbeiten 

auf. 

2. Wählen Sie in der Liste Gruppe eine Befehlsgruppe und dann in der Liste Be-

fehl den gewünschten Befehl. 
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3. Es erscheinen nun bei Aktuelle Tastenkürzel alle diesem Befehl zugewiesenen 

Kürzel. Selektieren Sie das zu entfernende Tastenkürzel und klicken Sie die 

Schaltfläche Entfernen. 

4. Bestätigen Sie mit OK und verlassen Sie den Hauptdialog mit Schließen. 

Das Tastenkürzel wurde nun entfernt – der Befehl kann zukünftig nicht mehr über 

dieses Kürzel aufgerufen werden. 

Tastenkürzel einer Tastaturbelegung zurücksetzen 

Klicken Sie im Dialogfenster von Weiteres > Anpassen > Tastaturbelegung auf 

die Schaltfläche Zurücksetzen, werden alle Tastenkürzel der aktuellen Tastaturbe-

legung wieder auf die Standardbelegung zurückgesetzt.  

Hinweis: Dadurch gehen alle Änderungen, die Sie an den Tastenkürzeln dieser 

Tastaturbelegung vorgenommen haben, verloren. 

Dies ist nur bei den vorgegebenen Tastaturbelegungen Standard und Classic mög-

lich. 

Listen für das automatische Füllen editieren 

Wie im Abschnitt „Automatisches Füllen von Zellen“ ab Seite 78 beschrieben, 

können Sie mit der Funktion Bearbeiten > Ausfüllen einen Zellbereich automa-

tisch mit einem gleichbleibenden Wert oder einer Reihe von Werten füllen. 

Mit dem Befehl Weiteres > Listen editieren können Sie eigene Listen für diese 

Funktion erstellen und bearbeiten. 

Erzeugen Sie beispielsweise eine Liste mit dem Inhalt „Rot“, „Grün“ und „Blau“ 

und füllen dann, ausgehend von einer Zelle mit dem Inhalt „Rot“, weitere Zellen, 

so werden diese mit Grün, Blau, Rot, Grün, Blau etc. gefüllt. 

Das Dialogfenster des Befehls Weiteres > Listen editieren verfügt dazu über 

Schaltflächen mit folgenden Funktionen: 

 Schaltfläche „Neu“: Neue Liste erstellen 

 Schaltfläche „Bearbeiten“: Liste bearbeiten 

 Schaltfläche „Löschen“: Liste löschen 
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 Schaltfläche „Importieren“: Aus den derzeit markierten Zellen eine Liste 

erzeugen 

Ausführliche Informationen folgen auf den nächsten Seiten. 

Liste für das automatische Füllen erstellen 

Um eine neue Liste für die Funktion Ausfüllen zu erstellen, gehen Sie wie folgt 

vor: 

1. Rufen Sie den Befehl Weiteres > Listen editieren auf. 

2. Betätigen Sie die Schaltfläche Neu. 

3. Es erscheint ein Dialogfenster. Geben Sie darin die gewünschten Listeneinträge 

ein. Beachten Sie dabei, dass in jeder Zeile nur ein Eintrag stehen darf. Sie 

können jederzeit die Eingabetaste (¢) betätigen, um eine neue Zeile einzufü-

gen.  

4. Klicken Sie dann auf OK. 

Die neue Liste wurde nun angelegt. 

Liste für das automatische Füllen bearbeiten 

Um eine von Ihnen erstellte Liste für die Funktion Ausfüllen zu bearbeiten, gehen 

Sie wie folgt vor: 

1. Rufen Sie den Befehl Weiteres > Listen editieren auf. 

2. Selektieren Sie die zu bearbeitende Liste per Mausklick. 

3. Betätigen Sie die Schaltfläche Bearbeiten. 

4. Es erscheint ein Dialogfenster mit den Listeneinträgen. Bearbeiten Sie diese 

nach Wunsch. Beachten Sie dabei, dass in jeder Zeile nur ein Eintrag stehen 

darf. Sie können jederzeit die Eingabetaste (¢) betätigen, um eine neue Zeile 

einzufügen.  

5. Klicken Sie dann auf OK. 

Die Liste wurde nun entsprechend geändert. 
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Liste für das automatische Füllen löschen 

Um eine von Ihnen erstellte Liste für die Funktion Ausfüllen zu löschen, gehen Sie 

wie folgt vor: 

1. Rufen Sie den Befehl Weiteres > Listen editieren auf. 

2. Selektieren Sie die zu bearbeitende Liste per Mausklick. 

3. Betätigen Sie die Schaltfläche Löschen. 

Die Liste wurde nun entfernt. 

Liste für das automatische Füllen importieren 

Wenn ein PlanMaker-Dokument eine Reihe von Zellen hat, die Sie gerne als Liste 

zum automatischen Füllen speichern möchten, gehen Sie vor folgt vor: 

1. Markieren Sie die Zellen, aus denen eine Liste erstellt werden soll. 

2. Rufen Sie den Befehl Weiteres > Listen editieren auf. 

3. Betätigen Sie die Schaltfläche Importieren. 

PlanMaker liest die markierten Zellen nun aus und erstellt eine neue Liste aus de-

ren Inhalten. Jede markierte Zelle wird dabei ein Listeneintrag. 

Wenn Sie dabei mehrere Zeilen und Spalten markiert haben, legt PlanMaker ent-

sprechend auch mehrere Listen an. Zuvor erscheint eine Rückfrage, ob Sie die Da-

ten zeilenweise oder spaltenweise importieren möchten. Wählen Sie Zeilenweise, 

wenn jede Zeile zu einer Liste werden soll, beziehungsweise Spaltenweise, wenn 

jede Spalte zu einer Liste werden soll. 

Installieren zusätzlicher Wörterbücher 

Bei der Installation von SoftMaker Office werden bereits Wörterbücher für einige 

Sprachen installiert. Falls Sie später noch weitere Wörterbücher nachinstallieren 

möchten, haben Sie dafür folgende Möglichkeiten: 
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 Installieren zusätzlicher SoftMaker-Wörterbücher 

 Nur unter Windows: In der Windows-Version von SoftMaker Office können 

Sie derzeit nicht installierte SoftMaker-Wörterbücher mithilfe des Installations-

programms jederzeit nachinstallieren.  

 Installieren von Hunspell-Wörterbüchern 

 Alle Anwendungen in SoftMaker Office unterstützen außerdem die freien Hun-

spell-Wörterbücher. Diese können auf www.softmaker.de kostenlos herunter-

geladen und dann über den Befehl Weiteres > Einstellungen (Karteikarte 

Sprache) installiert werden. 

 Wählen eines anderen Wörterbuchs für eine Sprache 

 Wenn Sie für eine Sprache mehrere Wörterbücher installiert haben (z.B. eines 

von SoftMaker und eines von Hunspell), können Sie außerdem festlegen, wel-

ches dieser Wörterbücher verwendet werden soll. Im letzten Abschnitt erfahren 

Sie, wie das geht. 

Lesen Sie dazu die nächsten Seiten. 

Installieren zusätzlicher SoftMaker-Wörterbücher 

Hinweis für Linux-Anwender: Dieser Abschnitt betrifft nur die Windows-

Version. Unter Linux werden stets alle SoftMaker-Wörterbücher installiert – hier 

ist ein Nachinstallieren also nicht nötig. 

Bei SoftMaker Office werden hochwertige Wörterbücher für zahlreiche Sprachen 

mitgeliefert. Um eines dieser Wörterbucher (oder beliebige andere Komponenten 

von SoftMaker Office) nachträglich zu installieren, gehen Sie wie folgt vor: 

1. Starten Sie das Installationsprogramm, mit dem Sie SoftMaker Office installiert 

haben, erneut. 

 Wenn Sie SoftMaker Office auf CD-ROM erworben haben, finden Sie das Installationsprogramm 
im Hauptverzeichnis der CD.  

 Wenn Sie SoftMaker Office als Download erworben haben, starten Sie das heruntergeladene Instal-
lationsprogramm erneut. Falls Sie dieses mittlerweile gelöscht haben sollten, laden Sie es einfach 

erneut herunter. Instruktionen dazu finden Sie in der E-Mail, die Sie beim Erwerb von SoftMaker 

Office von uns erhalten haben. 

2. Nach einigen Dialogfenstern, die Sie einfach bestätigen können, gelangen Sie 

zu einem Dialog mit folgender Auswahl: Ändern, Reparieren oder Entfernen. 

Klicken Sie auf Ändern. 
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3. Es erscheint ein Dialog, der alle einzelnen Komponenten von SoftMaker Office 

auflistet. Klicken Sie auf das Pluszeichen (+) vor der Kategorie Rechtschreib-

prüfung, Silbentrennung, Thesaurus, um diese aufzuklappen. 

4. Nun sehen Sie eine Liste aller Sprachen, die von den Sprachwerkzeugen von 

SoftMaker Office unterstützt werden.  

 Wenn Sie auf das Symbol vor einer der Sprachen klicken, werden Optionen 

zum Installieren der entsprechenden Sprache angezeigt. Wählen Sie für alle 

Sprachen, die Sie installieren möchten, die Option Auf der lokalen Festplatte 

installieren. 

5. Wenn Sie Ihre Auswahl getroffen haben, klicken Sie so oft auf die Schaltfläche 

Weiter, bis der Installationsvorgang beginnt. 

Die gewählten Wörterbücher werden nun installiert. 

Installieren von Hunspell-Wörterbüchern 

Neben seinen eigenen Wörterbüchern unterstützt SoftMaker Office auch die Ver-

wendung von Hunspell-Wörterbüchern. Diese sind als kostenlose Downloads er-

hältlich. Sie wurden größtenteils von engagierten Anwendern und nicht-

kommerziellen Einrichtungen erstellt.  

Hunspell-Wörterbücher gibt es für sehr viele Sprachen. Falls Sie also für eine 

Sprache kein Wörterbuch in SoftMaker Office finden, lohnt es sich nachzusehen, 

ob ein Hunspell-Wörterbuch dafür existiert. 

Eine Liste aller für SoftMaker Office verfügbaren Hunspell-Wörterbücher finden 

Sie im Bereich „Download“ auf unserer Website www.softmaker.de. Dort können 

Sie die Wörterbücher auch kostenlos herunterladen. 

Um ein Hunspell-Wörterbuch herunterzuladen und zu installieren, gehen Sie fol-

gendermaßen vor: 

1. Gehen Sie mit Ihrem Webbrowser auf die Website www.softmaker.de 

2. Navigieren Sie dort im Bereich „Download“ zu den kostenlosen Hunspell-

Wörterbüchern. 

3. Es wird nun eine Liste aller von SoftMaker Office unterstützten Hunspell-

Wörterbücher angezeigt. Laden Sie das gewünschte Wörterbuch herunter und 

speichern Sie es auf der Festplatte. 

4. Starten Sie eines der Programme von SoftMaker Office (TextMaker, PlanMaker 

oder Presentations). 

http://www.softmaker.de/
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5. Rufen Sie darin den Befehl Weiteres > Einstellungen auf und wechseln Sie 

auf die Karteikarte Sprache. 

6. Klicken Sie auf die Schaltfläche Hunspell-Wörterbücher. 

7. Es erscheint ein Dialog mit einer Liste aller installierten Sprachen/Wörter-

bücher. Klicken Sie darin auf die Schaltfläche Hunspell-Wörterbuch hinzu-

fügen. 

8. Es erscheint ein Dateidialog. Wechseln Sie darin in den Ordner, in den Sie das 

heruntergeladene Wörterbuch gespeichert haben.  

9. Wählen Sie die Wörterbuchdatei in der Dateiliste aus und klicken Sie auf Öff-

nen. 

Das Wörterbuch wird nun installiert und steht fortan in allen Applikationen von 

SoftMaker Office zur Verfügung. 

Wählen eines anderen Wörterbuchs für eine Sprache 

Wenn Sie für eine Sprache mehrere Wörterbücher installiert haben (zum Beispiel 

ein Wörterbuch von SoftMaker und ein Hunspell-Wörterbuch), können Sie jeder-

zeit einstellen, welches Wörterbuch für diese Sprache verwendet werden soll. Ge-

hen Sie dazu wie folgt vor:  

1. Rufen Sie den Befehl Weiteres > Einstellungen auf und wechseln Sie auf die 

Karteikarte Sprache. 

2. Klicken Sie auf die Schaltfläche Hunspell-Wörterbücher. 

3. Es erscheint ein Dialog mit einer Liste aller installierten Sprachen/Wörterbü-

cher. Wählen Sie zuerst in dieser Liste die gewünschte Sprache aus. 

4. Wählen Sie dann in der aufklappbaren Liste Wörterbuch aus, welches Wörter-

buch für die selektierte Sprache verwendet werden soll. Die Liste kann, je 

nachdem welche Wörterbücher installiert sind, folgende Einträge haben: 

 SoftMaker: Das bei SoftMaker Office mitgelieferte Wörterbuch. (Dies ist 

die Standardeinstellung.) 

 Hunspell: Ein Hunspell-Wörterbuch (kostenlos herunterladbares, freies 

Wörterbuch, siehe vorheriger Abschnitt) 

5. Bestätigen Sie mit OK. 
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Die Rechtschreibprüfung wird von nun an für diese Sprache das gewählte Wörter-

buch verwenden. 
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Formeln und Funktionen 
Dieses Kapitel widmet sich dem wohl wichtigsten Thema bei einer Tabellenkalku-

lation: dem Arbeiten mit Rechenformeln. 

Das Kapitel besteht aus folgenden Abschnitten: 

 Grundlegendes zu Berechnungen 

 Im ersten Abschnitt erfahren Sie, wie Formeln aufgebaut sein müssen und wel-

che Rechenoperatoren darin verwendet werden können. 

 Berechnungen eingeben 

 Hier erfahren Sie, wie Sie Rechenformeln in eine Zelle eingeben und welche 

Hilfsmittel dafür zur Verfügung stehen. 

 Relative und absolute Zellbezüge 

 Dieser Abschnitt erläutert den Unterschied zwischen relativen Zellbezügen 

(z.B. =A1) und absoluten Zellbezügen (z.B. =$A$1) in Rechenformeln. 

 Externe Zellbezüge 

 Im nächsten Abschnitt geht es um externe Zellbezüge in Rechenformeln. Das 

sind Bezüge, die sich auf Zellen in anderen Arbeitsmappen beziehen. 

 Fehlerwerte 

 Liefert eine Berechnung einen Fehler, ist das Ergebnis dieser Formel ein soge-

nannter Fehlerwert. Dieser Abschnitt beschreibt alle Fehlerwerte. 

 Arbeiten mit Matrizen 

 Hier erfahren Sie, wie Sie Matrizen und Matrixfunktionen einsetzen. 

 Anmerkungen zu den Datenbankfunktionen 

 Hier erfahren Sie Wissenswertes zum Umgang mit Datenbankfunktion wie 

dbAnzahl, dbSumme etc. 

 Funktionen von A-Z 

 Der größte Teil dieses Kapitels besteht aus einer alphabetisch sortierten Liste 

aller verfügbaren Rechenfunktionen mit einer ausführlichen Beschreibung, wie 

man die einzelnen Funktionen anwendet. 
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Tipp für Einsteiger: Eine kleine Einführung zum Durchführen von Berechnungen 

finden Sie auch im Kapitel „Die PlanMaker-Tour“ ab Seite 43. 

Grundlegendes zu Berechnungen 

Wenn Sie in PlanMaker eine Berechnung durchführen möchten, setzen Sie zu-

nächst den Zellrahmen auf die Zelle, in der das Ergebnis erscheinen soll. Dann 

tippen Sie die gewünschte Berechnung in diese Zelle ein. 

Wichtig: Beim Eintippen einer Formel müssen Sie stets mit einem Gleichheits-

zeichen = beginnen, denn sonst wird Ihre Eingabe von PlanMaker als Text be-

ziehungsweise Zahlenwert betrachtet.  

Rechenformeln können bestehen aus: 

 Festen Werten (zum Beispiel einer Zahl oder Text) 

 Zellbezüge (zum Beispiel A1 oder D2:D3) 

 Matrizen (siehe auch Abschnitt „Arbeiten mit Matrizen“ ab Seite 450) 

 Rechenoperatoren (zum Beispiel + und -, siehe auch Abschnitt „Operatoren in 

Berechnungen“ im Anschluss) 

 Rechenfunktionen (zum Beispiel SUMME) 

Das Ergebnis einer Berechnung kann sowohl einen Endwert als auch ein Zwi-

schenergebnis darstellen, denn jede Zelle, die das Ergebnis einer Berechnung ent-

hält, kann in einer anderen Zelle wieder verwendet werden. 

Eine gültige Rechenformel kann also beispielsweise folgendermaßen aussehen: 

= 67 + (A3 * Summe(B1:C5)) 

Operatoren in Berechnungen 

Sie können in Berechnungen die nachfolgend aufgelisteten Rechenoperatoren ver-

wenden. 

Beachten Sie bei Berechnungen mit mehreren verschiedenen Operatoren, dass es 

eine Rangfolge für Operatoren gibt: Teilberechnungen mit einem Operator höheren 

Rangs werden vor Teilberechnungen mit einem Operator niedrigeren Rangs durch-

geführt.  
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Diese Rangfolge kann durch die Verwendung von Klammern außer Kraft gesetzt 

werden:  

1+2*2 ergibt beispielsweise 5, da die Multiplikation einen höheren Rang hat als die 

Addition und deshalb zuerst berechnet wird. (1+2)*2 ergibt hingegen 6, da die 

Klammern diese Rangfolge außer Kraft setzen. 

Es gilt folgende Rangfolge bei den Operatoren: 

1. Rang: \ Schnittbereich 

2. Rang: % Prozent 

3. Rang: ^ Potenzierung* 

4. Rang: + Positives Vorzeichen (nicht Addition!) 

 – Negatives Vorzeichen* (nicht Subtraktion!) 

5. Rang: * Multiplikation 

 / Division 

6. Rang: + Addition 

 – Subtraktion 

7. Rang: & Verkettung von Zeichenketten ("Plan" & "Maker" ergibt bei-

spielsweise "PlanMaker") 

8. Rang: = Gleich 

 <> Ungleich 

 < Kleiner 

 > Größer 

 <= Kleiner oder gleich 

 >= Größer oder gleich 

* Hinweis: Bei Microsoft Excel ist die Rangfolge von Potenzierung und Vorzeichen fälschlicherweise 
vertauscht. PlanMaker verwendet hingegen die mathematisch korrekte Reihenfolge. So ergibt bei-

spielsweise die Formel -1^2 in Excel das falsche Ergebnis 1, in PlanMaker hingegen das korrekte Er-
gebnis -1. 
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Berechnungen eingeben 

Es gibt mehrere Möglichkeiten, eine Rechenformel in eine Zelle einzugeben. Diese 

lassen sich nach Belieben kombinieren. 

Eingeben von Rechenformeln per Hand 

Sie können Rechenformeln einfach von Hand in die gewünschte Tabellenzelle ein-

tragen. 

Wichtig: Wenn Sie Formeln direkt in eine Tabellenzelle eingeben, müssen Sie 

zuerst immer das Gleichheitszeichen = eintippen, damit PlanMaker weiß, dass 

nun kein Text, sondern eine Formel folgt. 

Wenn Sie die Formel eingegeben haben, betätigen Sie die Eingabetaste (¢), um 

Ihre Eingabe zu bestätigen – oder (Esc), um sie zu verwerfen. 

Alternativ können Sie Eingaben auch über die folgenden Schaltflächen der Bear-

beitungsleiste abschließen: 

 Klicken Sie auf , um die Eingabe zu übernehmen. 

 Oder klicken Sie auf , um die Eingabe zu verwerfen. 

Um die Formel in einer Zelle nachträglich zu bearbeiten, steuern Sie die Zelle an 

und betätigen die Taste (F2). Alternativ können Sie auch einen Doppelklick auf die 

Zelle ausführen, um die Formel zu bearbeiten. 

Verwenden der Maus beim Eingeben von Formeln 

Sie können beim Eingeben von Rechenformeln die Maus verwenden, um Zellbe-

reiche oder einzelne Zellen in die Formel zu übernehmen. Ziehen Sie dazu einfach 

ein Rechteck in der Tabelle auf beziehungsweise klicken Sie die gewünschte Zelle 

an. 

Ein Beispiel: 

Sie möchten in eine Zelle die Formel =SUMME(B2:D4) eingeben. Dazu können 

Sie wie folgt vorgehen: 

1. Geben Sie =SUMME( ein. 
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2. Selektieren Sie die Zellen B2 bis D4 mit der Maus. Ziehen Sie dazu bei ge-

drückter linker Maustaste ein Rechteck auf, das in Zelle B2 beginnt und in Zel-

le D4 endet. 

3. In der Zelle erscheint nun automatisch der Bereich B2:D4, so dass die Formel 

lautet: =SUMME(B2:D4 

4. Geben Sie die schließende Klammer ein und betätigen Sie die Eingabetaste 
(¢). 

Die vollständige Formel =SUMME(B2:D4) ist nun in die Zelle eingetragen. 

Der Befehl Einfügen > Funktion 

Wenn Sie in einer Formel Rechenfunktionen verwenden möchten, können Sie diese 

einfach eintippen oder aber den Befehl Einfügen > Funktion verwenden. Dieser 

erlaubt es Ihnen, Rechenfunktionen komfortabel per Maus auszuwählen. 

 

Das Dialogfenster für diesen Befehl hat folgende Bestandteile: 

 Eingabefeld Berechnung 

 Hier können Sie die Formel editieren. 

 Kategorie 

 In dieser Liste können Sie wählen, welche Arten von Rechenfunktionen in der 

Liste Funktion angezeigt werden sollen. 
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 Funktion 

 In dieser Liste werden alle Funktionen der gewählten Kategorie angezeigt. Füh-

ren Sie einen Doppelklick auf eine Funktion durch, um sie in das Eingabefeld 

Berechnung zu übertragen. 

 Tipp: Wenn Sie eine Funktion selektieren, wird im unteren Teil des Dialogs 

automatisch eine Kurzbeschreibung dazu eingeblendet. Bei der Windows-

Version von PlanMaker können Sie außerdem eine Hilfeseite zu jeder Rechen-

funktion abrufen, indem Sie die Funktion selektieren und dann die Taste (F1) 

drücken. 

 Operator 

 Hier werden die wichtigsten Rechenoperatoren angezeigt. Klicken Sie einen 

Operator an, wird er in das Eingabefeld eingefügt. 

 Schaltfläche Einfügen 

 Fügt den Inhalt des Eingabefelds Berechnung in die Zelle ein und schließt den 

Dialog. 

 Schaltfläche Schließen 

 Schließt den Dialog, ohne die Berechnung einzufügen. 

Relative und absolute Zellbezüge 

Wenn Sie sich in einer Rechenformel auf andere Zellen beziehen möchten, können 

Sie diesen Zellbezug entweder als relativ (z.B. =A1) oder als absolut (z.B. =$A$1) 

eintragen. 

Dieser Abschnitt erläutert die Unterschiede zwischen diesen beiden Adressierungs-

arten: 

Relative Zellbezüge 

Wenn Sie in einer Formel die Adresse einer anderen Zelle eintippen, wird dieser 

Zellbezug von PlanMaker stets als relativer Zellbezug interpretiert. 

Ein Beispiel: Sie geben in Zelle B3 folgende Formel ein: 

=B1+B2 
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Dies interpretiert PlanMaker nicht als „Addiere B1 und B2“, sondern vielmehr als 

„Addiere die Werte in den beiden Zellen, die direkt über der Zelle B3 liegen“.  

Sie merken dies, wenn Sie die Zelle B3 nach C3 kopieren oder verschieben. Plan-

Maker passt die Formel dann nämlich sofort an: 

=C1+C2 

Absolute Zellbezüge 

Wenn Sie verhindern möchten, dass die Formel automatisch angepasst wird, müs-

sen Sie den Zellbezug als absolut eintippen, indem Sie vor die Spalten- und/oder 

Zeilenadresse ein Dollarzeichen ($) setzen. Wahlweise können ganze Zelladressen 

(zum Beispiel $B$1) oder nur ein Teil davon (zum Beispiel $B1 oder B$1) als ab-

solut klassifiziert werden. 

Ein absoluter Zellbezug bezieht sich immer auf die ursprüngliche Zelladresse, ganz 

egal, wohin Sie die Zelle mit der Formel später verschieben. 

Beispiel: =$B$1 + $B$2 

Tragen Sie diese Formel in die Zelle B3 ein und verschieben diese Zelle nach C3, 

bezieht sich PlanMaker danach immer noch auf die Zellen B1 und B2. 

Tipp: Verwenden der F4-Taste zum Ändern der Adressierung 

Wenn Sie einen Zellbezug in eine Formel eingeben, können Sie anschließend mit 

der Taste (F4) zwischen relativer und absoluter Adressierung umschalten.  

Tippen Sie also beispielsweise in eine Zelle =A4 ein, ändert PlanMaker dies auf: 

=$A4, wenn Sie einmal (F4) drücken, 

=A$4, wenn Sie noch einmal (F4) drücken, 

=$A$4, wenn Sie noch einmal (F4) drücken. 

... und wieder =A4, wenn Sie noch einmal (F4) drücken. 
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Externe Zellbezüge 

Sie können sich in Rechenformeln auch auf Zellen beziehen, die sich in anderen 

PlanMaker- oder Excel-Dokumenten befinden. Solche Zellbezüge nennt man ex-

terne Zellbezüge. 

In diesem Abschnitt erfahren Sie alles Wissenswerte dazu. Folgende Themen wer-

den darin behandelt: 

 Eingeben von externen Zellbezügen 

 Aktualisieren und Verwalten von externen Zellbezügen 

Lesen Sie dazu die nächsten Seiten. 

Eingeben von externen Zellbezügen 

Zellbezüge, die sich auf Zellen in einem anderen Dokument beziehen, müssen wie 

folgt in Rechenformeln eingegeben werden: 

='C:\Mein Verzeichnis\[Meine Arbeitsmappe.pmd]Tabelle1'!A1 

Dieses Beispiel liefert einen Bezug auf die Zelle A1 im Arbeitsblatt „Tabelle1“ im 

PlanMaker-Dokument „Meine Arbeitsmappe.pmd“ im Verzeichnis „C:\Mein Ver-

zeichnis“. 

Wie Sie sehen, bestehen externe Zellbezüge immer aus folgenden Komponenten: 

 Anführungszeichen 

 Externe Zellbezüge sollten stets mit einem Anführungszeichen beginnen. Sie 

können wahlweise einfache Anführungszeichen (') oder doppelte Anführungs-

zeichen (") verwenden. 

 Ordner 

 Als nächstes ist der vollständige Pfad zu dem Ordner anzugeben, in dem sich 

die externe Datei befindet – zum Beispiel: C:\Mein Verzeichnis\ 

 Tipp: Falls sich die externe Datei im gleichen Verzeichnis wie Ihr Dokument 

befindet, kann der Pfad auch weggelassen werden. 

 Dateiname in eckigen Klammern 

 Dahinter kommt der Dateiname, umgeben von eckigen Klammern. Es muss 

sich bei der Datei um ein PlanMaker- oder ein Exceldokument handeln. 



 

Handbuch PlanMaker Formeln und Funktionen    445 

 Name des Arbeitsblatts 

 Die nächste Komponente ist der Name des Arbeitsblatts, in dem sich die ge-

wünschte Zelle befindet. 

 Anführungszeichen 

 Dahinter ist ein weiteres Anführungszeichen zu schreiben. 

 Ausrufezeichen 

 Als nächstes muss ein Ausrufezeichen getippt werden. 

 Zellbezug 

 Die letzte Komponente ist die Adresse der Zelle(n), auf die Sie sich beziehen 

möchten. Es sind natürlich auch Zellbereiche zulässig. 

Schließen Sie Ihre Eingabe mit der Eingabetaste (¢) ab. PlanMaker liest daraufhin 

den Inhalt der Zelle aus der angegebenen Datei aus. 

Informationen zum Aktualisieren und Verwalten externer Zellbezüge finden Sie im 

Anschluss. 

Anmerkungen 

 Wenn PlanMaker die angegebene Datei nicht findet, erscheint nach dem Betäti-

gen der Eingabetaste automatisch ein Dialog, in dem Sie die Datei auswählen 

können. 

 Tipp: Wenn Sie den Pfad und Dateinamen nicht von Hand eintippen möchten, 

können Sie folgenden Trick anwenden: Tippen Sie als Pfad und Dateinamen 

einfach nur [x.pmd] ein – also beispielsweise [x.pmd]Tabelle1!A1. So können 

Sie das Erscheinen des Dateidialogs nach dem Drücken der Eingabetaste ab-

sichtlich auslösen und die Datei bequem aus dem Dialog auswählen. 

 Wenn PlanMaker das angegebene Arbeitsblatt nicht findet, erscheint nach dem 

Betätigen der Eingabetaste automatisch ein Dialog, in dem Sie das Arbeitsblatt 

auswählen können. 

 Der Pfad auf die externe Datei wird normalerweise absolut gespeichert. Falls 

sich das externe Dokument allerdings im gleichen Ordner befindet wie Ihre Ar-

beitsmappe (oder einem Unterordner davon), speichert PlanMaker nur den rela-

tiven Pfad.  
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 In der Praxis bedeutet das: Wenn sich Dokument und externe Datei im gleichen 

Ordner befinden und Sie beide gemeinsam in einen anderen Ordner verschie-

ben, funktionieren Bezüge auf diese externe Datei auch weiterhin. 

 Tipp: Wenn Sie sich die komplette Tipparbeit sparen möchten, können Sie einen 

externen Zellbezug auch auf folgende Art einfügen: 

 1. Öffnen Sie das Dokument mit der Zelle, auf die Sie sich beziehen möchten. 

 2. Kopieren Sie darin die gewünschte Zelle in die Zwischenablage. 

 3. Wechseln Sie zurück zum aktuellen Dokument. 

 4. Navigieren Sie zu der Zelle, in die der Bezug eingefügt werden soll. 

 5. Rufen Sie Bearbeiten > Inhalte einfügen auf. 

 6. Klicken Sie auf die Schaltfläche Bezüge einfügen. 

 PlanMaker fügt nun einen externen Zellbezug auf diese Zelle ein. 

Aktualisieren und Verwalten von externen Zellbezügen 

Mit dem Befehl Tabelle > Externe Bezüge können Sie die externen Bezüge in 

einem Dokument aktualisieren und verwalten. 

Der Befehl öffnet ein Dialogfenster, in dem alle Dateien aufgelistet sind, zu denen 

es externe Bezüge gibt. 

Mithilfe der Schaltflächen in diesem Dialog können Sie folgende Aktionen durch-

führen: 

 Aktualisieren 

 Aktualisiert alle externen Bezüge, die sich auf die momentan in der Liste selek-

tierte Datei beziehen.  

 (Siehe auch Hinweise zum Aktualisieren weiter unten.) 

 Alles aktualisieren 

 Aktualisiert alle externen Bezüge im gesamten Dokument. 

 Öffnen 

 Öffnet die in der Liste selektierte externe Datei. 
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 Ändern 

 Lässt Sie für die in der Liste selektierte externe Datei eine andere Datei aus-

wählen. Alle Bezüge auf diese Datei werden daraufhin im Dokument entspre-

chend angepasst. 

 Vorherige 

 Springt zur vorherigen Zelle, die einen Bezug auf die in der Liste selektierte 

Datei enthält. 

 Nächste 

 Springt zur nächsten Zelle, die einen Bezug auf die in der Liste selektierte Da-

tei enthält. 

Die Schaltfläche Schließen beendet den Dialog. 

Anmerkungen zum Aktualisieren von externen Zellbezügen 

Hinweis: Die Werte, die von externen Zellbezügen zurückgeliefert werden, wer-

den nicht bei jedem Neuberechnen der Arbeitsmappe automatisch aktualisiert.  

Externe Zellbezüge werden nur in folgenden Fällen aktualisiert: 

 Wenn Sie ein Dokument öffnen, werden alle darin enthaltenen externen Bezüge 

(einmalig) automatisch aktualisiert.  

 (Dieses automatische Update können Sie auf Wunsch abschalten – siehe Optio-

nen weiter unten.) 

 Danach können Sie die externen Bezüge jederzeit manuell aktualisieren, indem 

Sie den Befehl Tabelle > Externe Bezüge aufrufen und, wie oben beschrieben, 

die Schaltfläche Aktualisieren oder Alle aktualisieren verwenden. 

Optionen zum Aktualisieren von externen Zellbezügen 

Für das Aktualisieren von externen Zellbezügen gibt es nachfolgende Optionen in 

den Dokumenteigenschaften.  

Um diese zu ändern, rufen Sie den Befehl Datei > Eigenschaften auf und wech-

seln auf die Karteikarte Berechnen. In der Rubrik Externe Bezüge finden Sie dort 

folgende Optionen: 
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 Daten nach dem Öffnen aktualisieren 

 Hier können Sie festlegen, ob beim Öffnen eines Dokuments alle darin enthal-

tenen externen Bezüge (einmalig) aktualisiert werden sollen: 

 Immer: Beim Öffnen externe Bezüge automatisch aktualisieren 

 Niemals: Beim Öffnen externe Bezüge nicht aktualisieren 

 Nachfragen: Beim Öffnen den Anwender fragen, ob die externen Bezüge aktu-

alisiert werden sollen. 

 Externe Daten im Dokument speichern 

 Ist diese Option aktiviert, speichert PlanMaker eine Kopie aller Werte, die von 

externen Zellbezügen geliefert werden, im Dokument. Fehlt die Datei für einen 

externen Bezug beim Aktualisieren, wird auch weiterhin der Wert angezeigt, 

den sich PlanMaker zuletzt gemerkt hat. 

 Schalten Sie die Option aus, wird stattdessen ein Fehlerwert angezeigt, wenn 

Sie einen externen Bezug aktualisieren und auf die zugehörige Datei nicht zu-

gegriffen werden kann. 

Hinweis: Die obigen Optionen sind keine globalen Einstellungen, sondern Do-

kumenteigenschaften. Sie lassen sich also für jedes Dokument unterschiedlich 

einstellen. 

Fehlerwerte 

Tritt in einer Berechnung ein Fehler auf, liefert sie als Ergebnis einen sogenannten 

Fehlerwert.  

Ein Beispiel: In einer Zelle ist eine Division durch den Inhalt einer anderen Zelle 

durchzuführen. Diese andere Zelle nimmt nun den Wert 0 an. PlanMaker kann die-

se Division durch Null, die ja in der Mathematik nicht zulässig ist, nicht durchfüh-

ren. Das Ergebnis der Rechenformel ist deshalb der Fehlerwert #DIV/0!, der an-

zeigt, dass hier eine Division durch Null stattfindet. 

Es gibt folgende Fehlerwerte: 
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Fehlerwert Erläuterung 

#BEZUG! Ungültiger Zellbezug. Erscheint, wenn die Formel einen Zellbezug 

enthält, der ungültig ist oder nach dem Löschen von Zellen (z.B. mit 

Tabelle > Zellen löschen) nicht mehr existiert. 

#DIV/0! Division durch Null. Erscheint, wenn die Formel eine Division durch 

Null enthält, die in der Mathematik ja bekanntermaßen nicht zulässig 

ist. 

#FEHLER! Ungültige Rechenformel. Erscheint unter anderem bei falsch ge-

schriebenen oder unbekannten Funktionsnamen, wenn geöffnete 

Klammern nicht geschlossen werden oder wenn eine Funktion mit 

zu vielen oder zu wenigen Argumenten aufgerufen wird. 

#NAME? Bezug mit einem ungültigen Namen. Erscheint, wenn sich ein Zell-

bezug auf einen Blattnamen oder Bereichsnamen bezieht, der nicht 

existiert. 

#NV „Nicht vorhanden“. Erscheint, wenn die Zelle einen #NV-Fehlerwert 

oder einen Bezug auf eine Zelle mit einem #NV-Fehlerwert enthält. 

Siehe auch Beschreibung der Funktion „NV (Nicht vorhanden)“ ab 

Seite 625. 

#WERT! Ungültiger Wert. Erscheint, wenn eine Funktion mit einem nicht 

geeigneten Wertetyp aufgerufen wird, sie also beispielsweise eine 

Zahl als Argument erwartet, ihr aber eine Zeichenkette übergeben 

wird. 

#ZAHL! Ungültige Zahl. Erscheint, wenn eine Funktion mit einem Wert auf-

gerufen wird, der außerhalb des für die Funktion zulässigen Wer-

tebereichs liegt (zum Beispiel WURZEL(-2)). 

Tipp: Mit den Funktionen ISTFEHLER und ISTFEHL können Sie bei Bedarf prü-

fen, ob die Berechnung in einer bestimmten Zelle einen Fehlerwert ergibt. 

Tipp: Weiterhin können Sie den Befehl Weiteres > Formelüberwachung ver-

wenden, um alle Zellen mit einem Fehlerwert aufzuspüren und zu analysieren. 

Siehe dazu Abschnitt „Analysieren von Tabellen“ ab Seite 102.  
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Arbeiten mit Matrizen 

Sie können in PlanMaker auch Matrizen eingeben und Berechnungen damit durch-

führen. Unter einer Matrix A versteht man ein rechteckiges Zahlenschema in fol-

gender Form: 

 

a11 bis amn nennt man die Elemente der Matrix. Diese sind auf m Zeilen und n 

Spalten aufgeteilt. Man spricht daher auch von einer m x n-Matrix. 

Eingabe von Matrizen in entsprechende Zellbereiche 

Um eine Matrix in PlanMaker einzugeben, verteilt man die Zeilen und Spalten der 

Matrix einfach auf Zeilen und Spalten der Tabelle.  

Wenn Sie also die folgende Matrix verwenden möchten... 

 

...so ist diese in PlanMaker folgendermaßen einzutragen: 

 

Wie Sie sehen kann jeder (rechteckige) Zellbereich auch als Matrix angesehen 

werden – und umgekehrt. Dementsprechend können Sie bei Rechenfunktionen, die 

als Argument eine Matrix erwarten, stets auch einen Zellbereich angeben, der die 

Elemente der Matrix enthält. 
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Eingabe von Matrixformeln 

PlanMaker verfügt über sogenannte Matrixfunktionen, mit denen Sie Berechnun-

gen mit Matrizen durchführen können – zum Beispiel die Inverse einer Matrix fin-

den. Eine Rechenformel mit einer Matrixfunktion nennen wir auch Matrixformel. 

Im Unterschied zu „gewöhnlichen“ Formeln liefern Matrixformeln keinen Einzel-

wert zurück, sondern eine komplette Matrix. Aus diesem Grund müssen solche 

Matrixformeln anders eingegeben werden als sonst üblich. Sehen wir uns dies an-

hand eines Beispiels einmal an: 

Sie möchten die Inverse der oben abgebildeten 3x3-Matrix ermitteln. Dazu gehen 

Sie wie folgt vor: 

1. Markieren des Bereichs für die Ergebnismatrix 

 Schon vor der Eingabe einer Matrixformel müssen Sie den Zellbereich markie-

ren, der von der Ergebnismatrix belegt werden soll. Die Inverse einer Matrix 

hat stets genau so viele Zeilen und Spalten wie die Ausgangsmatrix. Markieren 

Sie also einen Bereich mit 3x3 Zellen – zum Beispiel die Zellen E10:G12. 

2. Eingabe der Matrixformel 

 Geben Sie nun die gewünschte Matrixformel ein. In unserem Beispiel wäre das 

die Formel =MINV(E6:G8). 

3. Strg+Umschalt+Eingabetaste 

 Wichtig: Zum Abschluss der Formel drücken Sie nicht die Eingabetaste (¢), 

sondern die Tastenkombination (Strg)(ª)(¢). 

In den Zellen E10:G12 wird nun das Ergebnis der Berechnung, also die Inverse der 

Ausgangsmatrix, abgelegt: 

 

Anmerkungen: 
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 Wenn Sie einen Bereich markiert hatten, der größer ist als der von der Ergeb-

nismatrix benötigte, wird in den überflüssigen Zellen der Fehlerwert #NV 

(„nicht vorhanden“) angezeigt. Vorsicht: Ist der markierte Bereich hingegen zu 

klein, werden nicht alle Elemente der Matrix angezeigt. 

 Zum nachträglichen Editieren von Matrixformeln ist erneut obiges Verfahren 

anzuwenden: Alle Zellen der Ergebnismatrix markieren, Formel abändern, 
(Strg)(ª)(¢) drücken. Gehen Sie nicht so vor, erhalten Sie von PlanMaker eine 

Warnmeldung und werden gefragt, ob Sie die Matrix überschreiben möchten. 

 Tipp: Um alle von einer Matrixformel belegten Zellen zu markieren, klicken 

Sie eine dieser Zellen an und drücken dann (Strg)(7). 

Eingabe von Matrizen mit festen Werten 

Bei Bedarf können Sie statt eines Zellbezugs auch eine aus festen Werten beste-

hende Matrix in Formeln eingeben. Umgeben Sie die Werte dazu mit geschweiften 

Klammern { }. Trennen Sie die Spalten durch Punkte und die Zeilen durch Strich-

punkte. 

Für die oben bereits als Beispiel verwendete Matrix... 

 

...könnte man in PlanMaker also auch schreiben: 

={1.2.3;3.-1.1;2.2.4} 

Anmerkungen: 

 Obige Schreibweise ist nur für Matrizen zulässig, die ausschließlich aus festen 

Werten bestehen; Formeln oder Zellbezüge sind darin nicht erlaubt. 

 Mit obiger Schreibweise können natürlich auch Vektoren eingegeben werden: 

für einen Zeilenvektor wie a = (1, 2, 3) schreibt man {1.2.3}; für einen entspre-

chenden Spaltenvektor schreibt man {1;2;3}. 
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Anmerkungen zu den Datenbankfunktionen 

PlanMaker verfügt über eine Reihe von Datenbankfunktionen, mit denen Sie einen 

Tabellenbereich, der wie eine Datenbank aufgebaut ist, abfragen und auswerten 

können. 

Alle Datenbankfunktionen erwarten folgende Argumente: 

FUNKTIONSNAME(Datenbankbereich; Spalte; Suchkriterienbereich) 

So berechnet die Funktion DBSUMME beispielsweise die Summe all derjenigen 

Zellen in einem Datenbankbereich, die sich in der angegebenen Spalte befinden 

und den im Suchkriterienbereich angegebenen Bedingungen entsprechen. 

Um die Datenbankfunktionen einsetzen zu können, müssen folgende Schritte 

durchgeführt werden: 

Anlegen eines Datenbankbereichs 

Ein Datenbankbereich ist ein beliebiger Zellbereich mit den auszuwertenden Da-

ten. Er muss wie folgt aufgebaut sein: 

 Die erste Zeile muss jeweils eine eindeutige Beschriftung für die darunter lie-

gende Spalte enthalten (zum Beispiel Menge, Preis etc.). 

 Die Daten müssen zeilenweise eingetragen werden. 

Jede Zeile des Datenbankbereichs entspricht also dem, was man bei Datenbank-

programmen als Datensatz bezeichnet, die Spalten entsprechen den Datenbankfel-

dern. 

Anlegen eines Suchkriterienbereichs 

Der Suchkriterienbereich ist ein weiterer Zellbereich. In diesen können Sie beliebi-

ge viele Suchkriterien eingetragen. 

Der Suchkriterienbereich muss wie folgt aufgebaut sein: 

 Wichtig: Der Suchkriterienbereich muss sich oberhalb des Datenbankbereichs 

befinden. Weiterhin darf er den Datenbankbereich nicht überlappen. 

 Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten. Wenn 

Sie beispielsweise Suchkriterien für die Spalten festlegen wollen, die Sie im 
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Datenbankbereich mit den Überschriften Menge und Preis versehen haben, 

müssen Sie auch hier Menge und Preis eintragen. 

 Unter den Beschriftungen sind die zu erfüllenden Bedingungen einzutragen. 

Dies können sowohl Einzelwerte als auch Vergleiche wie „>42“ oder „<10“ 

sein. 

 Sind mehrere Suchbedingungen in der gleichen Zeile eingetragen, müssen die 

Bedingungen in Spalte 1 und Spalte 2 und Spalte 3 etc. erfüllt werden. 

 Sind mehrere Zeilen mit Suchbedingungen eingetragen, müssen die Bedingun-

gen in Zeile 1 oder Zeile 2 oder Zeile 3 etc. erfüllt werden. 

Anwenden der Datenbankfunktionen 

Nachdem Sie Datenbankbereich und Suchkriterienbereich ausgefüllt haben, kön-

nen Sie die Datenbankfunktionen einsetzen. 

Nachfolgend einige Beispiele. Nehmen wir an, Sie haben folgende Tabelle erstellt: 

 

Hier können beispielsweise folgende Berechnungen durchgeführt werden: 

DBANZAHL(A11:C16; ; A2:A3) ergibt 2. Hier wird die Anzahl aller Datensätze 

berechnet, bei denen gilt: Farbe = blau. 
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DBANZAHL(A11:C16; ; A6:B7) ergibt 3. Hier wird die Anzahl aller Datensätze 

berechnet, bei denen gilt: (Menge > 25 und Menge < 75). 

DBANZAHL(A11:C16; ; A6:C8) ergibt 4. Hier wird die Anzahl aller Datensätze 

berechnet, bei denen gilt: (Menge > 25 und Menge < 75) oder (Farbe = rot). 

DBSUMME(A11:C16; "Menge"; A2:A3) ergibt 150. Hier wird die Summe der 

Spalte „Menge“ für die Datensätze berechnet, bei denen gilt: Farbe = blau. 

DBSUMME(A11:C16; 1; A2:A3) ergibt 150. Diese Formel entspricht der obigen, 

denn statt der Bezeichnung der Spalte können Sie auch die Nummer der Spalte 

(innerhalb der Tabellenbereichs) angeben. 

Funktionen von A-Z 

Auf den nun folgenden Seiten finden Sie Beschreibungen aller Rechenfunktionen 

von PlanMaker in alphabetischer Reihenfolge. 

ABRUNDEN (Abrunden auf n Stellen) 

Syntax: 

ABRUNDEN(Zahl; n) 

Beschreibung: 

Rundet eine Zahl betragsmäßig auf n Nachkommastellen ab. 

n ist die gewünschte Anzahl an Nachkommastellen.  

Wird n nicht angegeben, wird die Zahl auf 0 Nachkommastellen gerundet. 

n darf auch ein negativer Wert sein, worauf der ganzzahlige Teil der Zahl abgerun-

det wird: Ist n beispielsweise -2, wird die Zahl auf ein Vielfaches von Hundert ab-

gerundet (siehe letztes Beispiel). 

Beispiel: 

ABRUNDEN(1,234; 2) ergibt 1,23 
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ABRUNDEN(1,235; 2) ergibt 1,23 

ABRUNDEN(888,999; 0) ergibt 888 

ABRUNDEN(888,999; -2) ergibt 800 

Siehe auch: 

AUFRUNDEN, RUNDEN, KÜRZEN 

ABS (Absolutbetrag) 

Syntax: 

ABS(Zahl) 

Beschreibung: 

Liefert den Absolutbetrag einer Zahl, entfernt also ihr Vorzeichen. 

Beispiel: 

ABS(42) ergibt 42 

ABS(0) ergibt 0 

ABS(-42) ergibt 42 

Siehe auch: 

VORZEICHEN, NEG 
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ACHSENABSCHNITT (Achsenabschnitt einer Regressionsge-

raden) 

Syntax: 

ACHSENABSCHNITT(y_Werte; x_Werte) 

Beschreibung: 

Ermittelt den y-Achsenabschnitt einer Regressionsgeraden. Das ist die y-

Koordinate des Punktes, an dem die Regressionsgerade die y-Achse schneidet. 

Eine Regressionsgerade ist das Resultat einer linearen Regression. Darunter ver-

steht man das Anpassen einer linearen Funktion (Regressionsgerade oder Aus-

gleichsgerade genannt) an eine Menge von Punkten (zum Beispiel den Messpunk-

ten einer Messreihe). 

Mit der Funktion ACHSENABSCHNITT können Sie voraussagen, welchen Wert y 

(die abhängige Variable) ungefähr haben wird, wenn x (die unabhängige Variable) 

Null ist. 

Sie können somit zum Beispiel abschätzen, welchen Widerstand ein temperaturab-

hängiger Widerstand bei 0° haben wird, nachdem Sie den Widerstand bei verschie-

denen anderen Temperaturen gemessen haben. 

Für die Argumente y_Werte und x_Werte geben Sie in der Regel einen Zellbe-

reich an. 

y_Werte sind die abhängigen Variablen (in obigem Beispiel also der Widerstand). 

x_Werte sind die unabhängigen Variablen (in obigem Beispiel also die Tempera-

tur). 

Hinweis: 

Beachten Sie, dass diese Funktion erst die y_Werte und dann die x_Werte erwar-

tet – nicht umgekehrt. 

Anmerkung: 

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleins-

ten Quadrate durchgeführt. 
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Beispiel: 

Von einem temperaturabhängigen Widerstand wurde gemessen, welcher Wider-

stand bei verschiedenen Temperaturen vorliegt. 

In den Zellen A1 bis A4 sind die x-Koordinaten der Messpunkte eingetragen (also 

die unabhängigen Variablen; in unserem Beispiel ist das die Temperatur): 8, 20, 25, 

28 

In den Zellen B1 bis B4 sind die y-Koordinaten eingetragen (also die abhängigen 

Variablen; in unserem Beispiel ist dies der Widerstand): 261, 508, 608, 680 

Mit der folgenden Formel können Sie abschätzen, welcher Widerstand bei 0°C 

geliefert werden wird: 

ACHSENABSCHNITT(B1:B4; A1:A4) ergibt 93,69817 

Bei 0° wäre also ein Widerstand von 93,69817 (Ohm) zu erwarten. 

Siehe auch: 

SCHÄTZER, STEIGUNG 

Anmerkung: 

ACHSENABSCHNITT(y_Werte; x_Werte) entspricht SCHÄTZER(0; y_Werte; 

x_Werte). 

ADRESSE (Zelladresse als Text ausgeben) 

Syntax: 

ADRESSE(Zeile; Spalte [; Abs] [; Modus] [; Blattname]) 

Beschreibung: 

Liefert die Adresse einer Zelle als Text. 

Für Zeile und Spalte ist die Zeilennummer und Spaltennummer der Zelle anzuge-

ben. 



 

Handbuch PlanMaker Formeln und Funktionen    459 

Das optionale Argument Abs bestimmt, ob eine absolute oder relative Adresse ge-

liefert werden soll: 

1 oder nicht angegeben: Zeile und Spalte absolut 

2: Zeile absolut, Spalte relativ 

3: Zeile relativ, Spalte absolut 

4: Zeile und Spate relativ 

Über den optionalen Wahrheitswert Modus können Sie bestimmen, in welchem 

Format die Zelladresse ausgegeben werden soll: 

WAHR oder nicht angegeben: Normale Zelladresse ausgeben (z.B. A1) 

FALSCH: Zelladresse im Format „Z1S1“ ausgeben (eine alternative Art der Zella-

dressierung, die nur von Microsoft Excel unterstützt wird) 

Wird die optionale Zeichenkette Blattname angegeben, so wird das Ergebnis im 

Format Blattname!Adresse ausgegeben (siehe letztes Beispiel). 

Beispiel: 

ADRESSE(1; 5) ergibt $E$1 

ADRESSE(1; 5; 4) ergibt E1 

ADRESSE(1; 5; 4; ; "Tabelle1") ergibt Tabelle1!E1 

Siehe auch: 

INDIREKT, BEREICH.VERSCHIEBEN, SPALTE, ZEILE 

ANZAHL (Wie viele Zellen mit Zahlen ausgefüllt?) 

Syntax: 

ANZAHL(Bereich1 [; Bereich2 ...]) 
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Beschreibung: 

Ermittelt, wie viele Zellen in einem oder mehreren Bereichen mit Zahlen gefüllt 

sind. Datumsangaben sind ebenfalls Zahlen; sie werden also mitgezählt. 

Beispiel: 

Angenommen, die Zellen A1 bis A3 enthalten die Werte 42, "Test" und WAHR; die 

Zelle A4 ist leer. Dann gilt: 

ANZAHL(A1:A4) ergibt 1 

Zum Vergleich: ANZAHL2(A1:A4) ergibt 3 

Siehe auch: 

ANZAHL2, ISTZAHL 

Anmerkung: 

Die Funktion ANZAHL2 (siehe dort) arbeitet ähnlich, sie zählt jedoch Zellen mit 

beliebigem Inhalt. 

ANZAHL2 (Wie viele Zellen ausgefüllt?) 

Syntax: 

ANZAHL2(Bereich1 [; Bereich2 ...]) 

Beschreibung: 

Ermittelt, wie viele Zellen in einem oder mehreren Bereichen mit beliebigen Wer-

ten gefüllt sind.  

Die Zellen dürfen beliebige Zahlen, Zeichenketten, Wahrheitswerte oder Fehler-

werte enthalten. 
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Beispiel: 

Angenommen, die Zellen A1 bis A3 enthalten die Werte 42, "Test" und WAHR; die 

Zelle A4 ist leer. Dann gilt: 

ANZAHL2(A1:A4) ergibt 3 

Zum Vergleich: ANZAHL(A1:A4) ergibt 1 

Siehe auch: 

ANZAHL, ISTLEER 

Anmerkung: 

Die Funktion ANZAHL (siehe dort) arbeitet ähnlich, sie zählt jedoch nur Zellen 

mit Zahlen. 

ANZAHLLEEREZELLEN (Wie viele Zellen leer?) 

Syntax: 

ANZAHLLEEREZELLEN(Bereich1 [; Bereich2 ...]) 

Beschreibung: 

Ermittelt, wie viele Zellen in einem Bereich leer sind. 

Beispiel: 

Angenommen, die Zellen A1 bis A3 enthalten die Werte 42, "Test" und WAHR; die 

Zelle A4 ist leer. Dann gilt: 

ANZAHLLEEREZELLEN(A1:A4) ergibt 1 

Siehe auch: 

ISTLEER, ANZAHL 
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ANZAHLP (PlanMaker 97-Kompatibilitätsfunktion) 

Syntax: 

ANZAHLP(Bereich1 [; Bereich2 ...]) 

Beschreibung: 

Ermittelt, wie viele Zellen in einem oder mehreren Bereichen mit Zahlen oder 

Wahrheitswerten gefüllt sind.  

Hinweis: 

Diese Funktion ist nur aus Kompatibilitätsgründen zu PlanMaker 97 noch vorhan-

den. Verwenden Sie diese Funktion möglichst nicht mehr, sondern benutzen Sie 

stattdessen die Excel-kompatiblen Funktionen ANZAHL und ANZAHL2. 

Der Unterschied zwischen diesen Funktionen: 

ANZAHL2 zählt alle Zellen, die nicht leer sind (unabhängig von deren Inhalt). 

ANZAHL zählt alle Zellen, die Zahlen enthalten. 

ANZAHLP zählt alle Zellen, die Zahlen oder Wahrheitswerte enthalten. 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

Angenommen, die Zellen A1 bis A3 enthalten die Werte 42, "Test" und WAHR; die 

Zelle A4 ist leer. Dann gilt: 

ANZAHL2(A1:A4) ergibt 3 

ANZAHL(A1:A4) ergibt 1 

ANZAHLP(A1:A4) ergibt 2 
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Siehe auch: 

ANZAHL, ANZAHL2 

ARBEITSTAG (Datum nach x Arbeitstagen) 

Syntax: 

ARBEITSTAG(Ausgangsdatum; Tage [; FreieTage]) 

Beschreibung: 

Ermittelt das Datum, das x Arbeitstage vor oder hinter dem Ausgangsdatum liegt. 

Samstage und Sonntage werden dabei übersprungen. Weiterhin kann der Funktion 

optional eine Liste mit freien Tagen (z.B. Feiertagen) übergeben werden. Diese 

werden dann ebenfalls übersprungen. 

Ausgangsdatum ist das Startdatum. 

Tage ist die Zahl der Tage. Tage darf auch ein negativer Wert sein – in diesem Fal-

le wird kein zukünftiges sondern ein vergangenes Datum geliefert. 

Für FreieTage kann optional eine Liste mit freien Tagen angegeben werden. Es 

muss sich dabei um einen Zellbereich oder eine Matrix handeln, die Datumswerte 

enthält. 

Beispiel: 

ARBEITSTAG("7.6.2004"; 10) ergibt den 21.6.2004. 

Der 10.6.2004 war allerdings ein Feiertag. Wollte man dies berücksichtigen, so 

müsste man schreiben: 

ARBEITSTAG("7.6.2004"; 10; "10.6.2004") – und das ergibt den 22.6. statt des 

21.6, da der Feiertag in der Zählung übersprungen wird. 

Siehe auch: 

FEIERTAG, NETTOARBEITSTAGE 
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ARCCOS (Arcuscosinus) 

Syntax: 

ARCCOS(Zahl) 

Beschreibung: 

Die Funktion ARCCOS (= Arcuscosinus) ist die Umkehrfunktion der Funktion 

COS: Sie liefert den inversen Cosinus einer Zahl – also den Winkel, dessen Cosi-

nus Zahl ist. 

Der zulässige Wertebereich für Zahl ist: -1  Zahl  1 

Das Ergebnis wird im Bogenmaß (Radiant) geliefert. 

Tipp: 

Mit der Funktion GRAD können Sie das Ergebnis vom Bogenmaß in Grad um-

rechnen. 

Beispiel: 

ARCCOS(1) ergibt 0 

ARCCOS(COS(0,1234)) ergibt 0,1234 

Siehe auch: 

COS 

ARCCOSHYP (Arcuscosinus Hyperbolicus) 

Syntax: 

ARCCOSHYP(Zahl) 
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Beschreibung: 

Die Funktion ARCCOSHYP (= Arcuscosinus Hyperbolicus) ist die Umkehrfunk-

tion der Funktion COSHYP: Sie liefert den inversen hyperbolischen Cosinus einer 

Zahl – also den Wert, dessen hyperbolischer Cosinus Zahl ist. 

Beispiel: 

ARCCOSHYP(1,1) ergibt 0,44357 

ARCCOSHYP(COSHYP(0,1234)) ergibt 0,1234 

Siehe auch: 

COSHYP 

ARCCOT (Arcuscotangens) 

Syntax: 

ARCCOT(Zahl) 

Beschreibung: 

Die Funktion ARCCOT (= Arcuscotangens) ist die Umkehrfunktion der Funktion 

COT: Sie liefert den inversen Cotangens einer Zahl – also den Winkel, dessen 

Cotangens Zahl ist. 

Das Ergebnis wird im Bogenmaß (Radiant) geliefert. 

Tipp: 

Mit der Funktion GRAD können Sie das Ergebnis vom Bogenmaß in Grad um-

rechnen. 
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Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

ARCCOT(1) ergibt 0,7854 (entspricht PI()/4, also 45°) 

ARCCOT(COT(0,1234)) ergibt 0,1234 

Siehe auch: 

COT 

ARCCOTHYP (Arcuscotangens Hyperbolicus) 

Syntax: 

ARCCOTHYP(Zahl) 

Beschreibung: 

Die Funktion ARCCOTHYP (= Arcuscotangens Hyperbolicus) ist die Umkehr-

funktion der Funktion COTHYP: Sie liefert den inversen hyperbolischen Cotan-

gens einer Zahl – also den Wert, dessen COTHYP Zahl ist. 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

ARCCOTHYP(2) ergibt 0,54931 

ARCCOTHYP(COTHYP(0,1234)) ergibt 0,1234 



 

Handbuch PlanMaker Formeln und Funktionen    467 

Siehe auch: 

COTHYP 

ARCSIN (Arcussinus) 

Syntax: 

ARCSIN(Zahl) 

Beschreibung: 

Die Funktion ARCSIN (= Arcussinus) ist die Umkehrfunktion der Funktion SIN: 

Sie liefert den inversen Sinus einer Zahl – also den Winkel, dessen Sinus Zahl ist. 

Der zulässige Wertebereich für Zahl ist: -1  Zahl  1 

Das Ergebnis wird im Bogenmaß (Radiant) geliefert. 

Tipp: 

Mit der Funktion GRAD können Sie das Ergebnis vom Bogenmaß in Grad um-

rechnen. 

Beispiel: 

ARCSIN(1) ergibt 1,5708... (entspricht PI()/2, also 90°) 

ARCSIN(SIN(0,1234)) ergibt 0,1234 

Siehe auch: 

SIN 
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ARCSINHYP (Arcussinus Hyperbolicus) 

Syntax: 

ARCSINHYP(Zahl) 

Beschreibung: 

Die Funktion ARCSINHYP (= Arcussinus Hyperbolicus) ist die Umkehrfunktion 

der Funktion SINHYP: Sie liefert den inversen hyperbolischen Sinus einer Zahl – 

also den Wert, dessen SINHYP Zahl ist. 

Beispiel: 

ARCSINHYP(1,1) ergibt 0,9503 

ARCSINHYP(SINHYP(0,1234)) ergibt 0,1234 

Siehe auch: 

SINHYP 

ARCTAN (Arcustangens) 

Syntax: 

ARCTAN(Zahl) 

Beschreibung: 

Die Funktion ARCTAN (= Arcustangens) ist die Umkehrfunktion der Funktion 

TAN: Sie liefert den inversen Tangens einer Zahl – also den Winkel, dessen Tan-

gens Zahl ist. 

Das Ergebnis wird im Bogenmaß (Radiant) geliefert. 
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Tipp: 

Mit der Funktion GRAD können Sie das Ergebnis vom Bogenmaß in Grad um-

rechnen. 

Beispiel: 

ARCTAN(1) ergibt 0,7854 (entspricht PI()/4, also 45°) 

ARCTAN(TAN(0,1234)) ergibt 0,1234 

Siehe auch: 

ARCTAN2, TAN 

ARCTAN2 (Arcustangens 2) 

Syntax: 

ARCTAN2(x; y) 

Beschreibung: 

Liefert den Winkel zwischen der x-Achse und einer Geraden vom Nullpunkt (0; 0) 

zu einem Punkt P (x; y). 

Als Argumente sind die x- und die y-Koordinate dieses Punktes anzugeben. 

Das Ergebnis wird in Bogenmaß (Radiant) geliefert. 

Tipp: 

Mit der Funktion GRAD können Sie das Ergebnis vom Bogenmaß in Grad um-

rechnen. 

Beispiel: 

ARCTAN2(1; 1) ergibt 0,7854 (entspricht PI()/4, also 45°) 
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Siehe auch: 

ARCTAN, TAN 

ARCTANHYP (Arcustangens Hyperbolicus) 

Syntax: 

ARCTANHYP(Zahl) 

Beschreibung: 

Die Funktion ARCTANHYP (= Arcustangens Hyperbolicus) ist die Umkehrfunk-

tion der Funktion TANHYP: Sie liefert den inversen hyperbolischen Tangens einer 

Zahl – also den Wert, dessen TANHYP Zahl ist. 

Der zulässige Wertebereich für Zahl ist: -1 < Zahl < 1 

Beispiel: 

ARCTANHYP(0,5) ergibt 0,54931 

ARCTANHYP(TANHYP(0,1234)) ergibt 0,1234 

Siehe auch: 

TANHYP 

AUFRUNDEN (Aufrunden auf n Stellen) 

Syntax: 

AUFRUNDEN(Zahl; n) 

Beschreibung: 

Rundet eine Zahl betragsmäßig auf n Nachkommastellen auf. 
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n ist die gewünschte Anzahl an Nachkommastellen.  

Wird n nicht angegeben, wird die Zahl auf 0 Nachkommastellen gerundet. 

n darf auch ein negativer Wert sein, worauf der ganzzahlige Teil der Zahl aufge-

rundet wird: Ist n beispielsweise -2, wird die Zahl auf ein Vielfaches von Hundert 

aufgerundet (siehe letztes Beispiel). 

Beispiel: 

AUFRUNDEN(1,234; 2) ergibt 1,24 

AUFRUNDEN(1,235; 2) ergibt 1,24 

AUFRUNDEN(444,222; 0) ergibt 445 

AUFRUNDEN(444,222; -2) ergibt 500 

Siehe auch: 

ABRUNDEN, RUNDEN, KÜRZEN 

AUSWAHL (Ist x>0, x=0 oder x<0?) 

Syntax: 

AUSWAHL(Zahl; WennGrößer [; WennNull; WennKleiner]) 

Beschreibung: 

Liefert einen der folgenden Werte zurück: 

WennGrößer, wenn Zahl größer als Null ist. 

WennNull, wenn Zahl gleich Null ist. 

WennKleiner, wenn Zahl kleiner als Null ist. 

Die letzten beiden Argumente sind dabei optional. 
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Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

AUSWAHL(42; "Größer"; "Null"; "Kleiner") ergibt Größer 

AUSWAHL(0; "Größer"; "Null"; "Kleiner") ergibt Null 

AUSWAHL(-42; "Größer"; "Null"; "Kleiner") ergibt Kleiner 

Siehe auch: 

WENN 

B (PlanMaker 97-Kompatibilitätsfunktion) 

Syntax: 

B(n; p; k1 [; k2]) 

wobei: 

n = Anzahl der Versuche 

p = Trefferwahrscheinlichkeit eines Versuchs (0 bis 100%) 

k1 = Untere Schranke 

k2 = Obere Schranke (optional) 

Beschreibung: 

Liefert die Wahrscheinlichkeit, mit der bei n unabhängigen Versuchen ein Ereignis 

genau k1 mal beziehungsweise zwischen k1 und k2 mal auftritt. 



 

Handbuch PlanMaker Formeln und Funktionen    473 

Hinweis: 

Diese Funktion ist nur aus Kompatibilitätsgründen zu PlanMaker 97 noch vorhan-

den. Verwenden Sie diese Funktion möglichst nicht mehr, sondern benutzen Sie 

stattdessen die folgenden Excel-kompatiblen Funktionen: 

B(n; p; k1) entspricht BINOMVERT(k1; n; p; FALSCH) 

B(n; p; k1; k2) entspricht BINOMVERT(k2; n; p; WAHR) - BINOMVERT(k1-1; 

n; p; WAHR) 

Beispiel: 

Beim tausendmaligen Werfen einer Münze werden die Adler gezählt. Es gilt also: n 

= 1000 (1000 Versuche), p = 50% (die Chance, einen Adler zu erhalten, ist 50%). 

Mit welcher Wahrscheinlichkeit werden bei 1000 Würfen exakt 480 Adler gewor-

fen? 

B(1000; 50%; 480) ergibt 0,01134 

Mit welcher Wahrscheinlichkeit werden zwischen 480 und 520 Adler geworfen? 

B(1000; 50%; 480; 520) ergibt 0,80521 

Siehe auch: 

BINOMVERT 

BENUTZERFELD (Benutzerdaten ausgeben) 

Syntax: 

BENUTZERFELD(Feldname) 

Beschreibung: 

Liefert das angegebene Feld aus den eingetragenen Benutzerdaten (Name, Adresse 

etc.). 

Hinweis: Sie können die Benutzerdaten jederzeit bearbeiten, indem Sie den Befehl 

Weiteres > Einstellungen aufrufen, auf die Karteikarte Allgemein wechseln und 
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die Schaltfläche Benutzer privat beziehungsweise Benutzer Firma anklicken 

(siehe auch Abschnitt „Einstellungen, Karteikarte Allgemein“ ab Seite 385). 

Die Funktion erwartet als Argument den Feldnamen der gewünschten Information 

entsprechend der nachfolgenden Tabelle. Die Groß-/Kleinschreibung des Feldna-

mens spielt keine Rolle. Achten Sie aber darauf, feste Zeichenketten stets mit dop-

pelten Anführungszeichen (") zu umgeben (siehe Beispiele). 

Benutzerdaten (privat) Feldname 

Vorname (privat) Privat.Vorname 

Name (privat) Privat.Name 

Straße (privat) Privat.Straße 

Initialen (privat) Privat.Initialen 

PLZ (privat) Privat.PLZ 

Ort (privat) Privat.Ort 

Telefon 1 (privat) Privat.Telefon1 

Telefon 2 (privat) Privat.Telefon2 

Telefax (privat) Privat.Telefax 

E-Mail (privat) Privat.E-Mail 

Homepage (privat) Privat.Homepage 

Benutzerdaten (Firma) Feldname 

Vorname (Firma) Firma.Vorname 

Name (Firma) Firma.Name 

Initialen (Firma) Firma.Initialen 

Firma Firma.Firma 

Abteilung Firma.Abteilung 

Straße (Firma) Firma.Straße 

PLZ (Firma) Firma.PLZ 

Ort (Firma) Firma.Ort 

Telefon 1 (Firma) Firma.Telefon1 

Telefon 2 (Firma) Firma.Telefon2 

Telefax (Firma) Firma.Telefax 

E-Mail (Firma) Firma.E-Mail 

Homepage (Firma) Firma.Homepage 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

BENUTZERFELD("Firma.Ort") ergibt Nürnberg 
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BENUTZERFELD("Firma.Homepage") ergibt www.softmaker.de 

Siehe auch: 

DATEINAME, BLATTNAME 

BEREICHE (Zahl der Bereiche) 

Syntax: 

BEREICHE(Bezug) 

Beschreibung: 

Ermittelt, wie viele Bereiche der übergebene Zellbezug enthält. 

Beispiel: 

BEREICHE(A1:B2) ergibt 1 

BEREICHE((A1:B2; E5:G7)) ergibt 2 

Siehe auch: 

INDEX, SPALTEN, ZEILEN 

BEREICH.VERSCHIEBEN (Versetzter Zellbezug) 

Syntax: 

BEREICH.VERSCHIEBEN(Bezug; Zeilen; Spalten [; Höhe] [; Breite]) 



 

476    Formeln und Funktionen Handbuch PlanMaker 

Beschreibung: 

Liefert einen Zellbezug, der gegenüber dem ursprünglichen Zellbezug um die an-

gegebene Zahl an Zeilen und/oder Spalten versetzt ist. Optional kann auch die 

Größe von Bezug geändert werden. 

Hinweis: Hierbei werden weder physikalisch Tabellenzellen verschoben, noch 

wird die Markierung versetzt. Die Funktion liefert lediglich einen versetzten Zell-

bezug zurück. 

Bezug ist der ursprüngliche Zellbezug. Sie können wahlweise eine einzelne Zelle 

oder einen Zellbereich (in der Schreibweise Startzelle:Endzelle) angeben. 

Bei Zeilen geben Sie die Zahl der Zeilen an, um die Bezug versetzt werden soll. Es 

ist auch ein negativer Wert erlaubt – hier wird Bezug nach oben statt nach unten 

versetzt. 

Bei Spalten geben Sie die Zahl der Spalten an, um die Bezug versetzt werden soll. 

Es ist auch ein negativer Wert erlaubt – hier wird Bezug nach links statt nach 

rechts versetzt. 

Wenn Sie das optionale Argument Höhe angeben, wird die Höhe des Bezugs auf 

die entsprechende Anzahl an Zeilen geändert. 

Wenn Sie das optionale Argument Breite angeben, wird die Breite des Bezugs auf 

die entsprechende Anzahl an Spalten geändert. 

Beispiel: 

BEREICH.VERSCHIEBEN(A1; 2; 0) liefert einen Zellbezug auf die Zelle A3 

BEREICH.VERSCHIEBEN(A1:C3; 1; 1) liefert einen Zellbezug auf den Zellbe-

reich B2:D4 

BEREICH.VERSCHIEBEN(A1:C3; 1; 1; 5; 3) liefert einen Zellbezug auf den 

Zellbereich B2:D6 

SUMME(BEREICH.VERSCHIEBEN(A1:C3; 1; 1; 5; 3)) liefert die Summe der 

Zellen im Bereich B2:D6 

Siehe auch: 

ADRESSE, INDIREKT, SPALTE, ZEILE 
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BESSELI (Modifizierte Besselfunktion erster Art) 

Syntax: 

BESSELI(x; n) 

Beschreibung: 

Liefert die modifizierte Besselfunktion erster Art In(x). 

x ist der auszuwertende Wert. 

n ist die Ordnung der Besselfunktion. n muss größer gleich Null sein. Erwartet 

wird eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkom-

mastellen automatisch ab. 

Siehe auch: 

BESSELJ, BESSELK, BESSELY 

BESSELJ (Besselfunktion erster Art) 

Syntax: 

BESSELJ(x; n) 

Beschreibung: 

Liefert die Besselfunktion erster Art Jn(x). 

x ist der auszuwertende Wert. 

n ist die Ordnung der Besselfunktion. n muss größer gleich Null sein. Erwartet 

wird eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkom-

mastellen automatisch ab. 
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Siehe auch: 

BESSELI, BESSELK, BESSELY 

BESSELK (Modifizierte Besselfunktion zweiter Art) 

Syntax: 

BESSELK(x; n) 

Beschreibung: 

Liefert die modifizierte Besselfunktion zweiter Art Kn(x). 

x ist der auszuwertende Wert. 

n ist die Ordnung der Besselfunktion. n muss größer gleich Null sein. Erwartet 

wird eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkom-

mastellen automatisch ab. 

Siehe auch: 

BESSELI, BESSELJ, BESSELY 

BESSELY (Besselfunktion zweiter Art) 

Syntax: 

BESSELY(x; n) 

Beschreibung: 

Liefert die Besselfunktion zweiter Art Yn(x) (auch Weberfunktion oder Neumann-

funktion genannt). 

x ist der auszuwertende Wert. 
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n ist die Ordnung der Besselfunktion. n muss größer gleich Null sein. Erwartet 

wird eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkom-

mastellen automatisch ab. 

Siehe auch: 

BESSELI, BESSELJ, BESSELK 

BESTIMMTHEITSMASS (Bestimmtheitskoeffizient) 

Syntax: 

BESTIMMTHEITSMASS(Bereich1; Bereich2) 

Beschreibung: 

Liefert den Bestimmtheitskoeffizienten zweier Datengruppen.  

Dieser ist ein Maß für den linearen Zusammenhang der Datengruppen. Je näher er 

an 1 liegt, desto größer ist der Zusammenhang.  

Bereich1 und Bereich2 sind Zellbezüge auf die beiden Datengruppen. Diese müs-

sen Zahlen enthalten. Leere Zellen sowie Zeichenketten und Wahrheitswerte wer-

den ignoriert. 

Die Datengruppen müssen die gleiche Anzahl an Werten besitzen, ansonsten liefert 

die Funktion den Fehlerwert #NV. 

Beispiel: 

Sind die Zellen A1 bis A3 mit den Werten 2, 5, 3 und die Zellen B1 bis B3 mit den 

Werten 2, 7, 4 gefüllt, so gilt: 

BESTIMMTHEITSMASS(A1:A3; B1:B3) ergibt 0,99436 

Siehe auch: 

PEARSON 
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Anmerkung: 

BESTIMMTHEITSMASS ist das Quadrat von PEARSON (Pearsonscher Korrela-

tionskoeffizient). 

BETAINV (Quantile einer Betaverteilung) 

Syntax: 

BETAINV(Wahrscheinlichkeit; Alpha; Beta [; A; B]) 

Beschreibung: 

Liefert Quantile einer Betaverteilung.  

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Betaverteilung. 

Zulässig sind nur Werte mit 0 < Wahrscheinlichkeit  1. 

Alpha und Beta sind die Formparameter der Funktion. Beide müssen größer als 

Null sein.  

A und B (optional) bestimmen die Grenzen des Intervalls. Wenn Sie diese Werte 

nicht angeben, wird A auf 0 und B auf 1 gesetzt (entspricht der Normalverteilung). 

Hinweis: 

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. 

Findet PlanMaker nach 100 Iterationen kein Ergebnis, das weniger als 3x10^-7 

von Wahrscheinlichkeit abweicht, zeigt er den Fehlerwert #NV an und bricht die 

Näherung ab. 

Siehe auch: 

BETAVERT 
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BETAVERT (Betaverteilung) 

Syntax: 

BETAVERT(X; Alpha; Beta [; A; B]) 

Beschreibung: 

Liefert Werte der Verteilungsfunktion einer betaverteilten Zufallsvariablen. 

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll.  

Alpha und Beta sind die Formparameter der Funktion. Beide müssen größer als 

Null sein.  

A und B (optional) bestimmen die Grenzen des Intervalls. Wenn Sie diese Werte 

nicht angeben, wird A auf 0 und B auf 1 gesetzt (entspricht der Normalverteilung). 

A darf nicht kleiner als X sein. B darf nicht größer als X sein. 

Siehe auch: 

BETAINV 

BININDEZ (Binärzahl in Dezimalzahl wandeln) 

Syntax: 

BININDEZ(Zahl) 

Beschreibung: 

Wandelt eine Binärzahl (Basis 2) in eine Dezimalzahl (Basis 10) um. 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel). 

Zahl darf maximal 32 Stellen umfassen, der zulässige Wertebereich ist also: 
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-(2^31)  Zahl  (2^31)-1 

Beispiel: 

BININDEZ("101010") ergibt 42 

BININDEZ("00101010") ergibt ebenfalls 42 

BININDEZ("11111111111111111111111111010110") ergibt -42 

Siehe auch: 

DEZINBIN, BININHEX, BININOKT 

BININHEX (Binärzahl in Hexadezimalzahl wandeln) 

Syntax: 

BININHEX(Zahl [; Stellen]) 

Beschreibung: 

Wandelt eine Binärzahl (Basis 2) in eine Hexadezimalzahl (Basis 16) um. 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel).  

Zahl darf maximal 32 Stellen umfassen, der zulässige Wertebereich ist also: 

-(2^31)  Zahl  (2^31)-1 

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 
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Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert. 

Beispiel: 

BININHEX("101010") ergibt 2A 

BININHEX("00101010") ergibt ebenfalls 2A 

BININHEX("101010"; 1) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit 

mindestens 2 Stellen dargestellt werden kann 

BININHEX("11111111111111111111111111010110") ergibt FFFFFFD6 (negative 

Zahl) 

Siehe auch: 

HEXINBIN, BININDEZ, BININOKT 

BININOKT (Binärzahl in Oktalzahl wandeln) 

Syntax: 

BININOKT(Zahl [; Stellen]) 

Beschreibung: 

Wandelt eine Binärzahl (Basis 2) in eine Oktalzahl (Basis 8) um. 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel).  

Zahl darf maximal 32 Stellen umfassen, der zulässige Wertebereich ist also: 

-(2^31)  Zahl  (2^31)-1 

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 



 

484    Formeln und Funktionen Handbuch PlanMaker 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert. 

Beispiel: 

BININOKT("101010") ergibt 52 

BININOKT("00101010") ergibt ebenfalls 52 

BININOKT("101010"; 1) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit 

mindestens 2 Stellen dargestellt werden kann 

BININOKT("11111111111111111111111111010110") ergibt 37777777726 (negati-

ve Zahl) 

Siehe auch: 

OKTINBIN, BININDEZ, BININHEX 

BINOMVERT (Binomialverteilung) 

Syntax: 

BINOMVERT(k; n; p; Kumuliert) 

Beschreibung: 

Liefert die Wahrscheinlichkeiten einer binomialverteilten Zufallsvariablen. 

Die Binomialverteilung ist die Wahrscheinlichkeitsverteilung für die Anzahl Tref-

fer (k) bei einem Zufallsexperiment, das n mal unabhängig wiederholt wird und 

nur zwei mögliche Ergebnisse hat (Treffer oder Fehlschlag), wobei die Wahr-

scheinlichkeit für einen Treffer pro Wiederholung p beträgt. 

Sie können mit dieser Funktion beispielsweise ermitteln, wie groß die Wahrschein-

lichkeit ist, bei 10 Münzwürfen genau 4 Adler zu erhalten. 
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k ist die Anzahl an Treffern, hier also 4. k muss größer gleich Null und kleiner 

gleich n sein. 

n ist die Zahl der Wiederholungen, hier also 10. 

n und k sollten ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker die 

Nachkommastellen automatisch weg. 

p ist die Trefferwahrscheinlichkeit pro Wiederholung, hier also die Wahrschein-

lichkeit einen Adler zu erhalten, sprich 50%. 

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert wer-

den soll: 

FALSCH: Es wird die Dichtefunktion geliefert. BINOMVERT ermittelt also die 

Wahrscheinlichkeit, dass es genau k Treffer gibt. 

WAHR: Es wird die Verteilungsfunktion (also die integrierte Dichtefunktion) gelie-

fert. BINOMVERT ermittelt also die Wahrscheinlichkeit, dass es höchstens k Tref-

fer gibt.  

Beispiel: 

Greifen wir obiges Beispiel auf:  

Wie groß ist die Wahrscheinlichkeit, bei 10 Münzwürfen genau 4 Adler zu werfen? 

BINOMVERT(4; 10; 50%; FALSCH) ergibt 0,20508. 

Wie groß ist die Wahrscheinlichkeit, höchstens 4 Adler zu werfen? 

Hier verwendet man statt der Dichtefunktion die Verteilungsfunktion (Argument 

Kumuliert mit WAHR angeben): 

BINOMVERT(4; 10; 50%; WAHR) ergibt 0,37695. 

Siehe auch: 

KOMBINATIONEN, KRITBINOM, NEGBINOMVERT 
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BLATTNAME (Name eines Arbeitsblatts) 

Syntax: 

BLATTNAME([n]) 

Beschreibung: 

Liefert den Namen eines Arbeitsblatts. 

Wenn das optionale Argument n nicht angegeben ist, liefert die Funktion den Na-

men des aktuellen Arbeitsblatts, ansonsten den des n-ten Blattes (von links nach 

rechts). 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

Ein Dokument erhält vier Arbeitsblätter: „Frühling“, „Sommer“, „Herbst“ und 

„Winter“ (in dieser Reihenfolge). Die Schreibmarke befindet sich gerade in einer 

Zelle der dritten Tabelle („Herbst“). Dann gilt: 

BLATTNAME() ergibt Herbst 

BLATTNAME(1) ergibt Frühling 

Siehe auch: 

BLATTNUMMER, DATEINAME  

BLATTNUMMER (Laufende Nummer eines Arbeitsblatts) 

Syntax: 

BLATTNUMMER([Blattname]) 
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Beschreibung: 

Liefert die laufende Nummer eines Arbeitsblatts in der Arbeitsmappe zurück. Das 

erste Blatt hat die Nummer 1, das zweite die Nummer 2 etc. 

Wenn das optionale Argument Blattname nicht angegeben ist, liefert die Funktion 

die Nummer des aktuellen Arbeitsblatts, ansonsten den des Blatts mit dem angege-

benen Namen. 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

Beim dritten Arbeitsblatt in einer Arbeitsmappe gilt: 

BLATTNUMMER() ergibt 3 

Siehe auch: 

BLATTNAME, DATEINAME  

BOGENMASS (Grad in Bogenmaß umwandeln) 

Syntax: 

BOGENMASS(Zahl) 

Beschreibung: 

Wandelt einen in Grad vorliegenden Winkel ins Bogenmaß (Radiant) um. 

Die Formel für die Umrechnung lautet:  

BOGENMASS(x) = x * PI() / 180 
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Beispiel: 

BOGENMASS(180) ergibt 3,14159... (den Wert der Kreiszahl Pi) 

Siehe auch: 

GRAD 

BW (Barwert) 

Syntax: 

BW(Zins; Zzr; Rmz [; Zw] [; Fälligkeit]) 

Beschreibung: 

Liefert den Barwert einer Einlage, basierend auf einer Investition mit regelmäßigen 

konstanten Zahlungen und feststehendem Zins. 

Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode) 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 

Rmz = Annuität (Betrag, der pro Periode gezahlt wird) 

Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zah-

lung erreichen möchten. Wenn Sie das Argument Zw nicht angeben, wird es auf 

Null gesetzt. 

Fälligkeit (optional) = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 

Beispiel: 

BW(6,5%/12; 12*10; 650) ergibt -57244,52 
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Diese Formel berechnet den Barwert eines Darlehens mit einem Zinssatz von 6,5% 

(pro Jahr, deshalb die Teilung durch 12), einer Laufzeit von 10 Jahren (=12*10 

Monate) und einer Annuität von 650 Euro (pro Monat). 

Siehe auch: 

KAPZ, RMZ, ZINS, ZINSZ, ZW, ZZR 

CHIINV (Quantile einer Chi-Quadrat-Verteilung) 

Syntax: 

CHIINV(Wahrscheinlichkeit; Freiheitsgrade) 

Beschreibung: 

Liefert Quantile einer Chi-Quadrat-Verteilung.  

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Chi-Quadrat-

Verteilung. Zulässig sind nur Werte aus dem Intervall [0..1]. 

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht klei-

ner als 1 oder größer als 10^10 sein. Erwartet wird eine ganze Zahl; ist dies nicht 

der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 

Hinweis: 

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. 

Findet PlanMaker nach 100 Iterationen kein Ergebnis, das weniger als 3x10^-7 

von Wahrscheinlichkeit abweicht, zeigt er den Fehlerwert #NV an und bricht die 

Näherung ab. 

Siehe auch: 

CHITEST, CHIVERT 
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CHITEST (Chi-Quadrat-Unabhängigkeitstest) 

Syntax: 

CHITEST(BeobachteteWerte; ErwarteteWerte) 

Beschreibung: 

Liefert die Teststatistik eines Chi-Quadrat-Unabhängigkeitstests.  

Ein Chi-Quadrat-Test liefert ein allgemeines Kriterium für die Übereinstimmung 

der Grundgesamtheit mit einer Stichprobe. 

Für BeobachteteWerte sind die beobachteten Werte anzugeben; für Erwartete-

Werte die erwarteten Werte. 

Siehe auch: 

CHIINV, CHIVERT 

CHIVERT (Chi-Quadrat-Verteilung) 

Syntax: 

CHIVERT(X; Freiheitsgrade) 

Beschreibung: 

Liefert Werte der Verteilungsfunktion einer Chi Quadrat-verteilten Zufallsvariab-

len. 

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X darf keine ne-

gative Zahl sein. 

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht klei-

ner als 1 oder größer als 10^10 sein. Erwartet wird eine ganze Zahl; ist dies nicht 

der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 
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Siehe auch: 

CHIINV, CHITEST 

CODE (ANSI-Code eines Zeichens) 

Syntax: 

CODE(Zeichenkette) 

Beschreibung: 

Liefert den ANSI-Code des ersten Zeichens der übergebenen Zeichenkette. 

Beispiel: 

CODE("A") ergibt 65 

CODE("Arthur") ergibt ebenfalls 65 

CODE(ZEICHEN(123)) ergibt 123 

CODE("") ergibt 0 

Siehe auch: 

ZEICHEN 

COS (Cosinus) 

Syntax: 

COS(Zahl) 

Beschreibung: 

Liefert den Cosinus eines Winkels.  
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Der Winkel ist dabei im Bogenmaß (Radiant) anzugeben. 

Tipp: 

Mit der Funktion BOGENMASS können Sie einen in Grad vorliegenden Winkel 

ins Bogenmaß umrechnen. 

Beispiel: 

COS(PI()) ergibt -1 

COS(BOGENMASS(180)) ergibt -1 

Siehe auch: 

ARCCOS 

COSHYP (Cosinus Hyperbolicus) 

Syntax: 

COSHYP(Zahl) 

Beschreibung: 

Die Funktion COSHYP (= Cosinus Hyperbolicus) liefert den hyperbolischen Co-

sinus einer Zahl. 

Beispiel: 

COSHYP(0,1) ergibt 1,005 

Siehe auch: 

ARCCOSHYP 
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COT (Cotangens) 

Syntax: 

COT(Zahl) 

Beschreibung: 

Liefert den Cotangens eines Winkels.  

Der Winkel ist dabei im Bogenmaß (Radiant) anzugeben. 

Tipp: 

Mit der Funktion BOGENMASS können Sie einen in Grad vorliegenden Winkel 

ins Bogenmaß umrechnen. 

Beispiel: 

COT(PI()/4) ergibt 1 

COT(BOGENMASS(45)) ergibt 1 

Siehe auch: 

ARCCOT 

COTHYP (Cotangens Hyperbolicus) 

Syntax: 

COTHYP(Zahl) 

Beschreibung: 

Die Funktion COTHYP (= Cotangens Hyperbolicus) liefert den hyperbolischen 

Cotangens einer Zahl. 
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Beispiel: 

COTHYP(0,45) ergibt 2,37024 

Siehe auch: 

ARCCOTHYP 

DATEDIF (Datumsdifferenz) 

Syntax: 

DATEDIF(Ausgangsdatum; Enddatum; Modus) 

Beschreibung: 

Berechnet die Differenz zwischen zwei Daten, wahlweise in Tagen, Monaten oder 

Jahren. 

Hinweis: Dies ist eine undokumentierte Excel-Funktion. Sie wurde aus der Hilfe 

von Microsoft Excel wieder entfernt und wird von daher – zumindest offiziell – 

nicht mehr von Excel unterstützt. 

Ausgangsdatum und Enddatum sind die beiden Daten. Das Ausgangsdatum muss 

vor dem Enddatum liegen. 

Modus bestimmt, auf welche Weise und in welcher Einheit die Differenz zwischen 

Ausgangsdatum und Enddatum berechnet werden soll: 

"y" Zahl der vergangenen Jahre 

"m" Zahl der vergangenen Monate 

"d" Zahl der vergangenen Tage 

"ym" Zahl der Monate, wenn man die Tage und Jahre der Datumsangaben ignoriert 

"yd" Zahl der Tage, wenn man die Jahre der Datumsangaben ignoriert 

"md" Zahl der Tage, wenn man die Monate und Jahre der Datumsangaben ignoriert 
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Beispiel: 

In A1 steht das Geburtsdatum einer Person (z.B. der 3.4.1970). In A2 steht das zu 

vergleichende Datum (z.B. der 8.6.2012).  

Folgendermaßen berechnen Sie das Alter der Person: 

In Jahren: 

DATEDIF(A1; A2; "y") ergibt 42 (Jahre) 

In Monaten: 

DATEDIF(A1; A2; "m") ergibt 506 (Monate) 

In Tagen: 

DATEDIF(A1; A2; "d") ergibt 15407 (Tage) 

In Jahren, Monaten und Tagen: 

DATEDIF(A1; A2; "y") ergibt 42 (Jahre) 

DATEDIF(A1; A2; "ym") ergibt 2 (Monate) 

DATEDIF(A1; A2; "md") ergibt 5 (Tage) 

(Die Person ist also 42 Jahre, 2 Monate und 5 Tage alt.) 

Siehe auch: 

JETZT, NETTOARBEITSTAGE, TAGE 

DATEINAME (Dateiname des Dokuments) 

Syntax: 

DATEINAME([Mit_Pfad]) 

Beschreibung: 

Liefert den Dateinamen des aktuellen Dokuments. 

Der Wahrheitswert Mit_Pfad bestimmt, ob auch der Pfad (Laufwerk und Ver-

zeichnis) ausgegeben werden sollen: 

FALSCH oder nicht angegeben: ohne Pfad 

WAHR: mit Pfad 
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Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

Speichern Sie ein Dokument im Verzeichnis c:\Dokumente unter dem Dateinamen 

Umsätze.pmd ab, so gilt in diesem Dokument: 

DATEINAME() ergibt Umsätze.pmd 

DATEINAME(WAHR) ergibt c:\Dokumente\Umsätze.pmd 

Siehe auch: 

BENUTZERFELD, BLATTNAME 

DATUM (Datumswert bilden) 

Syntax: 

DATUM(Jahr; Monat; Tag) 

Beschreibung: 

Bildet einen Datumswert aus den Argumenten Jahr, Monat und Tag. 

Beispiel: 

DATUM(2008; 9; 25) ergibt 39716 

Dieser Datumswert wird von PlanMaker allerdings automatisch im Zahlenformat 

„Datum/Zeit“ formatiert, so dass in der Zelle steht: 25.09.2008. 

Siehe auch: 

DATWERT, ZEIT, ZEITWERT 
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DATWERT (Text in Datum wandeln) 

Syntax: 

DATWERT(Zeichenkette) 

Beschreibung: 

Wandelt eine in Textform angegebene Datumsangabe in ein Datum (genauer ge-

sagt: in eine serielle Datumszahl) um.  

Hinweis: 

Diese Funktion ist nur aus Kompatibilitätsgründen zu älteren Tabellenkalkulatio-

nen noch vorhanden. PlanMaker selbst benötigt sie nicht mehr, da er Daten, die als 

Text angegeben sind, bei Bedarf automatisch in ein Datum umwandelt. 

Beispiel: 

DATWERT("25.09.2008") ergibt die serielle Datumszahl 39716. 

Formatieren Sie diese nun mit Format > Zelle in einem der Datum/Zeit-Formate 

(zum Beispiel T.M.JJ), so wird in der Zelle das Datum angezeigt, das sich hinter 

diesem Wert verbirgt: der 25.9.2008.  

Siehe auch: 

ZEITWERT, DATUM, ZEIT 

DBANZAHL (Datenbankfunktion) 

Syntax: 

DBANZAHL(Datenbankbereich; Spalte; Suchkriterienbereich) 
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Beschreibung: 

Ermittelt die Anzahl der Zellen in einem Datenbankbereich, die den im Suchkrite-

rienbereich angegebenen Bedingungen entsprechen. 

Berücksichtigt werden dabei nur Zellen, die Zahlen enthalten. Zellen mit Zeichen-

ketten und Wahrheitswerten werden ignoriert. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 453. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Wenn das Argument Spalte nicht leer ist, berücksichtigt die Funktion nur Zellen 

aus der entsprechenden Spalte. Sie können entweder die Spaltennummer oder die 

Spaltenbeschriftung in doppelten Anführungszeichen angeben (zum Beispiel 

"Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

DBANZAHL2 

DBANZAHL2 (Datenbankfunktion) 

Syntax: 

DBANZAHL2(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Ermittelt die Anzahl der Zellen in einem Datenbankbereich, die den im Suchkrite-

rienbereich angegebenen Bedingungen entsprechen. 

Im Gegensatz zur Datenbankfunktion DBANZAHL berücksichtigt DBANZAHL2 

nicht nur Zellen mit Zahlenwerten, sondern beliebige Zellen – also auch Zellen mit 

Zeichenketten und Wahrheitswerten. 
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Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 453. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Wenn das Argument Spalte nicht leer ist, berücksichtigt die Funktion nur Zellen 

aus der entsprechenden Spalte. Sie können entweder die Spaltennummer oder die 

Spaltenbeschriftung in doppelten Anführungszeichen angeben (zum Beispiel 

"Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

DBANZAHL 

DBAUSZUG (Datenbankfunktion) 

Syntax: 

DBAUSZUG(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert genau den Wert aus einer Spalte eines Datenbankbereichs, der den im 

Suchkriterienbereich angegebenen Bedingungen entspricht. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 453. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 
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Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Hinweis: 

Es darf nur eine einzige Zeile die Suchbedingungen erfüllen; andernfalls liefert die 

Funktion den Fehlerwert #ZAHL. 

DBMAX (Datenbankfunktion) 

Syntax: 

DBMAX(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert den größten Wert aus einer Spalte eines Datenbankbereichs, der den im 

Suchkriterienbereich angegebenen Bedingungen entspricht. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 453. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

MAX, DBMIN 
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DBMIN (Datenbankfunktion) 

Syntax: 

DBMIN(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert den kleinsten Wert aus einer Spalte eines Datenbankbereichs, der den im 

Suchkriterienbereich angegebenen Bedingungen entspricht. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 453. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

MIN, DBMAX 

DBMITTELWERT (Datenbankfunktion) 

Syntax: 

DBMITTELWERT(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert den Mittelwert der Werte aus einer Spalte eines Datenbankbereichs, die den 

im Suchkriterienbereich angegebenen Bedingungen entsprechen. 
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Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 453. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

MITTELWERT 

DBPRODUKT (Datenbankfunktion) 

Syntax: 

DBPRODUKT(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert das Produkt der Werte aus einer Spalte eines Datenbankbereichs, die den im 

Suchkriterienbereich angegebenen Bedingungen entsprechen. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 453. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 
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Siehe auch: 

PRODUKT 

DBSTDABW (Datenbankfunktion) 

Syntax: 

DBSTDABW(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert einen Schätzwert für die Standardabweichung der Grundgesamtheit, basie-

rend auf den Werten aus einer Spalte eines Datenbankbereichs, die den im Suchkri-

terienbereich angegebenen Bedingungen entsprechen. 

Die Funktion geht davon aus, dass die ermittelten Werte eine Stichprobe aus der 

Grundgesamtheit darstellen. Ausgehend davon wird die Standardabweichung ge-

schätzt. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 453. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

STABW, DBSTDABWN 
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DBSTDABWN (Datenbankfunktion) 

Syntax: 

DBSTDABWN(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert die Standardabweichung einer Grundgesamtheit, basierend auf den Werten 

aus einer Spalte eines Datenbankbereichs, die den im Suchkriterienbereich angege-

benen Bedingungen entsprechen. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 453. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

STABWN, DBSTDABW 

DBSUMME (Datenbankfunktion) 

Syntax: 

DBSUMME(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert die Summe der Werte aus einer Spalte eines Datenbankbereichs, die den im 

Suchkriterienbereich angegebenen Bedingungen entsprechen. 
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Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 453. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

SUMME 

DBVARIANZ (Datenbankfunktion) 

Syntax: 

DBVARIANZ(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert einen Schätzwert für die Varianz der Grundgesamtheit, basierend auf den 

Werten aus einer Spalte eines Datenbankbereichs, die den im Suchkriterienbereich 

angegebenen Bedingungen entsprechen. 

Die Funktion geht davon aus, dass die ermittelten Werte eine Stichprobe aus der 

Grundgesamtheit darstellen. Ausgehend davon wird die Varianz geschätzt. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 453. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 
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Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

VARIANZ, DBVARIANZEN 

DBVARIANZEN (Datenbankfunktion) 

Syntax: 

DBVARIANZEN(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert die Varianz einer Grundgesamtheit, basierend auf den Werten aus einer 

Spalte eines Datenbankbereichs, die den im Suchkriterienbereich angegebenen 

Bedingungen entsprechen. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 453. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

VARIANZEN, DBVARIANZ 
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DELTA (Prüfen auf Gleichheit zweier Werte) 

Syntax: 

DELTA(Wert1; Wert2) 

Beschreibung: 

Prüft, ob zwei Zahlenwerte gleich sind. Ist dies der Fall, liefert die Funktion 1, an-

sonsten 0. 

Wert1 und Wert2 müssen Zahlen sein. Auch Zeichenketten, die ausschließlich 

eine Zahl enthalten, sind zulässig.  

Beispiel: 

DELTA(1; 2) ergibt 0 

DELTA(2; 2) ergibt 1 

DELTA(2; "2") ergibt 1 

DELTA("Text"; "Text") ergibt den Fehlerwert #WERT! 

Siehe auch: 

IDENTISCH 

DEZIBEL (Dezibelwert zweier Größen) 

Syntax: 

DEZIBEL(P2 [; P1]) 

Beschreibung: 

Berechnet den Dezibelwert (dB) für das Verhältnis zweier Größen.  

Der Berechnung liegt folgende Formel zugrunde: 
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DEZIBEL(P2; P1) = 10 * LOG10(P2/P1) 

Hinweis: Achten Sie dabei auf die Reihenfolge der Parameter: Erst muss der Zähler 

P2 des Quotienten übergeben werden, dann der Nenner P1 – nicht umgekehrt. 

P2 und P1 müssen Zahlen sein. Ihr Quotient muss größer als Null sein. 

Der Parameter P1 ist optional. Wird er nicht angegeben, setzt PlanMaker ihn auto-

matisch auf 1 (eins). 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

DEZIBEL(1000; 10) ergibt 20 

DEZINBIN (Dezimalzahl in Binärzahl wandeln) 

Syntax: 

DEZINBIN(Zahl [; Stellen]) 

Beschreibung: 

Wandelt eine Dezimalzahl (Basis 10) in eine Binärzahl (Basis 2) um. 

Zahl ist die umzuwandelnde Zahl. 

Der zulässige Wertebereich für Zahl ist: 

-(2^31)  Zahl  (2^31)-1 

Das entspricht: 

-2.147.483.648  Zahl  2.147.483.647 
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Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert (siehe letztes Beispiel). 

Beispiel: 

DEZINBIN(42) ergibt 101010 

DEZINBIN(42; 8) ergibt 00101010 

DEZINBIN(42; 4) ergibt den Fehlerwert #ZAHL!, da die Zahl 42 binär nur mit 

mindestens 6 Stellen dargestellt werden kann 

DEZINBIN(-42) ergibt 11111111111111111111111111010110 

Siehe auch: 

BININDEZ, DEZINHEX, DEZINOKT 

DEZINHEX (Dezimalzahl in Hexadezimalzahl wandeln) 

Syntax: 

DEZINHEX(Zahl [; Stellen]) 

Beschreibung: 

Wandelt eine Dezimalzahl (Basis 10) in eine Hexadezimalzahl (Basis 16) um. 

Zahl ist die umzuwandelnde Zahl. 

Der zulässige Wertebereich für Zahl ist: 
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-(2^31)  Zahl  (2^31)-1 

Das entspricht: 

-2.147.483.648  Zahl  2.147.483.647 

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert (siehe letztes Beispiel). 

Beispiel: 

DEZINHEX(42) ergibt 2A 

DEZINHEX(42; 8) ergibt 0000002A 

DEZINHEX(42; 1) ergibt den Fehlerwert #ZAHL!, da die Zahl 42 hexadezimal 

nur mit mindestens 2 Stellen dargestellt werden kann 

DEZINHEX(-42) ergibt FFFFFFD6 

Siehe auch: 

HEXINDEZ, DEZINBIN, DEZINOKT 

DEZINOKT (Dezimalzahl in Oktalzahl wandeln) 

Syntax: 

DEZINOKT(Zahl [; Stellen]) 
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Beschreibung: 

Wandelt eine Dezimalzahl (Basis 10) in eine Oktalzahl (Basis 8) um. 

Zahl ist die umzuwandelnde Zahl. 

Der zulässige Wertebereich für Zahl ist: 

-(2^31)  Zahl  (2^31)-1 

Das entspricht: 

-2.147.483.648  Zahl  2.147.483.647 

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert (siehe letztes Beispiel). 

Beispiel: 

DEZINOKT(42) ergibt 52 

DEZINOKT(42; 8) ergibt 00000052 

DEZINOKT(42; 1) ergibt den Fehlerwert #ZAHL!, da die Zahl 42 oktal nur mit 

mindestens 2 Stellen dargestellt werden kann 

DEZINOKT(-42) ergibt 37777777726 

Siehe auch: 

OKTINDEZ, DEZINBIN, DEZINHEX 
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DIA (Arithmetisch-degressive Abschreibung) 

Syntax: 

DIA(AW; RW; ND; ZR) 

Beschreibung: 

Liefert die arithmetisch-degressive Abschreibung eines Objekts über einen be-

stimmten Zeitraum. 

Die Funktion erwartet folgende Argumente: 

AW = Anschaffungskosten des Objekts 

RW = Restwert des Objekts am Ende der Nutzungsdauer 

ND = Nutzungsdauer (Anzahl der Perioden, über die das Objekt abgeschrieben 

wird) 

ZR = Zeitraum (in der gleichen Einheit wie ND anzugeben) 

Hinweis: 

Diese Funktion ist auf das deutsche Steuerrecht nur bedingt anwendbar! 

Beispiel: 

Bei einer für € 200.000,- erworbenen Maschine, die 10 Jahre genutzt wird und ei-

nen Restwert von € 10.000,- hat, gilt für das erste Jahr folgender jahresbezogener 

Abschreibungsbetrag: 

DIA(200000; 10000; 10; 1) ergibt 34545,45 Euro 

Siehe auch: 

GDA, LIA 



 

Handbuch PlanMaker Formeln und Funktionen    513 

EDATUM (Datum in/vor n Monaten) 

Syntax: 

EDATUM(Ausgangsdatum; m) 

Beschreibung: 

Ermittelt das Datum, das m Monate vor/nach dem Datum Ausgangsdatum liegt. 

Sie können damit Termine ermitteln, die auf denselben Tag eines anderen Monats 

fallen. 

Mit dem Argument m geben Sie die Zahl der Monate an. 

Wenn m positiv ist, wird das Datum berechnet, das m Monate hinter dem Aus-

gangsdatum liegt. 

Wenn m negativ ist, erhalten Sie das Datum, das m Monate vor dem Ausgangsda-

tum liegt. 

m sollte eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker die Nach-

kommastellen automatisch. 

Beispiel: 

EDATUM("30.03.2013"; 1) ergibt 30.04.2013 

EDATUM("31.03.2013"; 1) ergibt ebenfalls 30.04.2013, da der April nur 30 Tage 

hat. 

Siehe auch: 

MONATSENDE 

EFFEKTIV (Effektivzins) 

Syntax: 

EFFEKTIV(NomZins; Zinsgutschriften) 
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Beschreibung: 

Ermittelt den effektiven Jahreszins, ausgehend vom nominalen Jahreszins und der 

Zahl der Zinsgutschriften pro Jahr. 

NomZins ist der nominale Jahreszins. 

Zinsgutschriften ist die Zahl der Zinsgutschriften pro Jahr (muss mindestens 1 

sein). 

Hinweis: 

Diese Funktion berechnet nicht den effektiven Jahreszins gemäß der deutschen 

Preisangabenverordnung (PAngV). Sie berücksichtigt keinerlei Gebühren, Provisi-

onen etc., sondern schlägt lediglich die über das Jahr anfallenden Zinseszinsen auf 

den Nominalzins auf. 

Beispiel: 

Eine Geldanlage bietet 5% nominalen Jahreszins, Zinsen werden 4x pro Jahr gut-

geschrieben. Wie hoch liegt der effektive Jahreszins? 

EFFEKTIV(5%; 4) ergibt ca. 5,09% 

Siehe auch: 

NOMINAL 

ERSETZEN (Text in Zeichenkette ersetzen) 

Syntax: 

ERSETZEN(Zeichenkette; Start; Anzahl; Ersatztext) 

Beschreibung: 

Ersetzt einen bestimmten Teil einer Zeichenkette durch anderen Text. 

Zeichenkette ist die ursprüngliche Zeichenkette. 

Start ist die Position des ersten Zeichens, das ersetzt werden soll. 
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Anzahl ist die Zahl der Zeichen, die ersetzt werden. 

Ersatztext ist der neue Text. 

Beispiel: 

ERSETZEN ("aaaaaa"; 3; 2; "bb") ergibt aabbaa 

ERSETZEN ("aaaaaa"; 3; 4; "bb") ergibt aabb 

ERSETZEN ("cccccc"; 3; 2; "dddddddd") ergibt ccddcc 

ERSETZEN ("cccccc"; 3; 4; "dddddddd") ergibt ccdddd 

ERSETZEN ("cccccc"; 3; 6; "dddddddd") ergibt ccdddddd 

Siehe auch: 

FINDEN, SUCHEN, TEIL, WECHSELN 

ERSTELLDATUM (Datum des Erstellens eines Dokuments) 

Syntax: 

ERSTELLDATUM() 

Beschreibung: 

Liefert das Datum und die Uhrzeit des Zeitpunkts, an dem das aktuelle Dokument 

erstellt wurde. 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

Wurde ein Dokument am 22.07.2013 um 16:03 erstellt, so gilt: 
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ERSTELLDATUM() = 22.07.13 16:03 

Tipp: Über die Auswahl eines geeigneten Datumsformats mit dem Befehl Format 

> Zelle können Sie bestimmen, ob nur das Datum, nur die Uhrzeit oder beides an-

gezeigt werden soll. 

Siehe auch: 

JETZT 

EUROCONVERT (Euro-Währungen konvertieren) 

Syntax: 

EUROCONVERT(Zahl; Quellwährung; Zielwährung) 

Beschreibung: 

Diese Funktion kann die alten Währungen aller EU-Mitgliedsländer umrechnen, 

die der Währungsunion beigetreten sind, also die Einheitswährung Euro eingeführt 

haben. 

Sie können mit dieser Funktion folgende Arten von Umrechnungen durchführen: 

a) Einen Betrag von einer dieser Währungen in Euro umrechnen – zum Beispiel 

DM in Euro. 

b) Einen Betrag von Euro in eine dieser Währungen umrechnen – zum Beispiel 

Euro in DM. 

c) Einen Betrag von einer dieser Währungen in eine andere umrechnen – und zwar 

über den Zwischenschritt der Umrechnung in den Euro („Triangulation“). Beispiel: 

Peseten -> Euro -> DM. Beachten Sie: Bei dieser Methode können Rundungsfeh-

ler (von maximal 0,01) auftreten. 

Die Argumente Quellwährung und Zielwährung geben Sie mit Hilfe der Codes in 

der nachfolgenden Tabelle an. Sie können entweder PM-Codes oder ISO-Codes 

verwenden.  

Anmerkung: Microsoft Excel unterstützt bei dieser Funktion nur ISO-Codes. 

Wenn Ihr Dokument also Excel-kompatibel sein soll, dürfen Sie für die Währungs-

codes nur ISO-Codes (rechte Spalte) verwenden. 
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Die Groß-/Kleinschreibung der Codes spielt keine Rolle. 

Land PM-Code ISO-Code 

Alle Euro-Länder (Euro) € EUR 

Belgien (Franc) BF BEF 

Deutschland (Mark) DM DEM 

Finnland (Markka) mk FIM 

Frankreich (Franc) F FRF 

Griechenland (Drachme) Dr GRD 

Irland (Pfund) IR£ IEP 

Italien (Lira) L ITL 

Luxemburg (Franc) LF LUF 

Malta (Lira) Lm MTL 

Niederlande (Gulden) fl NLG 

Österreich (Schilling) öS ATS 

Portugal (Escudo) esc PTE 

Slowakei (Kronen) Sk SKK 

Slowenien (Tolar) SIT SIT 

Spanien (Peseta) pts ESP 

Beispiel: 

EUROCONVERT (100; "DM"; "€") rechnet 100 DM in Euro um, ergibt also 51,13 

(Euro) 

EUROCONVERT (100; "DEM"; "EUR") ist die Excel-kompatible Schreibweise 

des obigen Beispiels. Das Ergebnis ist natürlich das Gleiche: 51,13 (Euro) 

EUROCONVERT (100; "DEM"; "ATS") ergibt 703,55 (öS) 

EXP (e hoch x) 

Syntax: 

EXP(Zahl) 

Beschreibung: 

Führt eine Potenzierung der Konstanten e mit der angegebenen Zahl durch, be-

rechnet also e
x
. 

Bei e handelt es sich um die Eulersche Zahl (2,71828...), die Basis des natürlichen 

Logarithmus. 
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Anmerkung: 

Die Umkehrfunktion zu dieser Funktion ist LN (natürlicher Logarithmus). 

Beispiel: 

EXP(5) ergibt 148,4132 

EXP(LN(0,1234)) ergibt 0,1234 

Siehe auch: 

LN, POTENZ 

EXPONVERT (Exponentialverteilung) 

Syntax: 

EXPONVERT(x; Lambda; Kumuliert) 

Beschreibung: 

Liefert die Wahrscheinlichkeiten einer exponentialverteilten Zufallsvariablen. 

Mit der Exponentialverteilung können die Zeitintervalle zwischen unabhängigen 

Ereignissen modelliert werden (also beispielsweise Wartezeiten). 

Wenn beispielsweise bekannt ist, dass durchschnittlich alle drei Minuten ein Kunde 

an einem Bankschalter eintrifft, können Sie mit dieser Funktion die Wahrschein-

lichkeit berechnen, dass sich nach spätestens zwei Minuten ein Kunde einfindet. 

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. x muss größer 

gleich Null sein. 

Lambda () ist die mittlere Anzahl von Ereignissen pro Zeitintervall. Lambda 

muss größer als Null sein. 

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert wer-

den soll: 

FALSCH: Es wird die Dichtefunktion geliefert. 
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WAHR: Es wird die Verteilungsfunktion (also die integrierte Dichtefunktion) gelie-

fert. 

Siehe auch: 

POISSON 

FAKULTÄT (Fakultät) 

Syntax: 

FAKULTÄT(Zahl) 

Beschreibung: 

Liefert x! (die Fakultät von x). 

Als Fakultät bezeichnet man das Produkt aller positiven ganzen Zahlen von 1 bis 

zur angegebenen Zahl. 

Die übergebene Zahl muss größer gleich Null sein. Nachkommastellen werden 

automatisch abgeschnitten. 

Beispiel: 

FAKULTÄT(9) entspricht 1*2*3*4*5*6*7*8*9, ergibt also 362880 

Siehe auch: 

ZWEIFAKULTÄT 

FALSCH (Wahrheitswert) 

Syntax: 

FALSCH() 
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Beschreibung: 

Liefert den Wahrheitswert FALSCH. 

Siehe auch: 

WAHR 

FEHLER.TYP (Fehlerwerte abfragen) 

Syntax: 

FEHLER.TYP(Zelle) 

Beschreibung: 

Mit dieser Funktion kann abgefragt werden, welche Art von Fehler in einer Zelle 

auftritt. 

Als Argument erwartet die Funktion die Adresse der zu überprüfenden Zelle. 

Die Funktion liefert folgende Ergebnisse: 

Fehlerwert in der Zelle Ergebnis 

Kein Fehler #NV 

#FEHLER! 1 

#DIV/0! 2 

#WERT! 3 

#BEZUG! 4 

#NAME? 5 

#ZAHL! 6 

#NV 7 

Informationen zu den einzelnen Fehlerwerten finden Sie im Abschnitt 

„Fehlerwerte“ ab Seite 448. 
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Beispiel: 

In Zelle A1 steht die Berechnung 1/0, in Zelle A2 wird 1/1 berechnet. Hier gilt: 

FEHLER.TYP(A1) ergibt 2 (also #DIV/0!) 

FEHLER.TYP(A2) ergibt #NV (also kein Fehler) 

Die folgende Formel liefert den Text „Fehler!“ zurück, wenn in Zelle A1 ein belie-

biger Fehler auftritt, ansonsten wird der Wert in A1 zurückgeliefert: 

WENN(ISTNV(FEHLER.TYP(A1)); A1; "Fehler!") 

Siehe auch: 

ISTFEHL, ISTFEHLER, ISTNV, WENNFEHLER, Abschnitt über „Fehlerwerte“ 

ab Seite 448  

FEIERTAG (Datum von beweglichen Feiertagen) 

Syntax: 

FEIERTAG(Jahr; Typ) 

Beschreibung: 

Liefert das Datum von beweglichen christlichen Feiertagen im angegebenen Jahr. 

Jahr ist das gewünschte Jahr (als ganze Zahl). 

Typ ist eine ganze Zahl, die bestimmt, für welchen Feiertag das Datum geliefert 

werden soll: 

0: Karfreitag 

1: Ostersonntag 

2: Ostermontag 

3: Christi Himmelfahrt 

4: Pfingstsonntag 

5: Pfingstmontag 
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6: Fronleichnam 

7: Aschermittwoch  

8: Buß- und Bettag 

9: Erster Adventssonntag 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

FEIERTAG(2008; 1) ergibt den 23.3.2008 (Ostersonntag 2008) 

FEIERTAG(JAHR(HEUTE()); 5) liefert den Pfingstmontag des laufenden Jahres 

Siehe auch: 

ARBEITSTAG, NETTOARBEITSTAGE 

FEST (Zahl mit festen Nachkommastellen formatieren) 

Syntax: 

FEST(Zahl [; n] [; Keine_Tausenderpunkte]) 

Beschreibung: 

Konvertiert eine Zahl in eine Zeichenkette. Diese enthält die auf n Stellen gerunde-

te Zahl mit Tausenderpunkten. 

Zahl ist die umzuwandelnde Zahl. 

Das optionale Argument n bestimmt gewünschte Anzahl an Nachkommastellen. 

Wird es nicht angegeben, wird die Zahl auf 2 Nachkommastellen gerundet. 
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n darf auch ein negativer Wert sein, worauf der ganzzahlige Teil der Zahl gerundet 

wird: Ist n beispielsweise -2, wird die Zahl auf ein Vielfaches von Hundert gerun-

det (siehe letztes Beispiel). 

Der optionale Wahrheitswert Keine_Tausenderpunkte bestimmt, ob die Zahl mit 

Tausenderpunkten formatiert werden soll:  

FALSCH oder nicht angegeben: Mit Tausenderpunkten 

WAHR: Ohne Tausenderpunkte 

Hinweis: 

Beachten Sie, dass das Ergebnis dieser Funktion eine Zeichenkette ist. Um eine 

Zahl zu runden, ohne sie in eine Zeichenkette zu wandeln, verwenden Sie eine der 

Rundungsfunktionen (siehe unten). 

Um eine Zahl nur gerundet anzuzeigen, ohne sie tatsächlich zu runden, können Sie 

auch den Befehl Format > Zelle verwenden. 

Beispiel: 

FEST(1234,5678; 2) ergibt die Zeichenkette 1.234,57 

FEST(1234,5678; 2; WAHR) ergibt die Zeichenkette 1234,57 (ohne Tausender-

punkte) 

FEST(1234,5678; -2) ergibt die Zeichenkette 1.200 

Siehe auch: 

RUNDEN, ABRUNDEN, AUFRUNDEN, KÜRZEN 

FINDEN (Text in Zeichenkette suchen) 

Syntax: 

FINDEN(Suchbegriff; Zeichenkette [; Startposition]) 
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Beschreibung: 

Ermittelt die Position von Suchbegriff in Zeichenkette. 

Mit dem optionalen Argument Startposition können Sie festlegen, ab welcher Po-

sition der Zeichenkette gesucht werden soll. Wird es nicht angegeben, beginnt die 

Suche mit dem ersten Zeichen. 

Die Groß-/Kleinschreibung muss hierbei exakt übereinstimmen. Verwenden Sie die 

Funktion SUCHEN, wenn die Groß-/Kleinschreibung nicht beachtet werden soll. 

Beispiel: 

FINDEN("a"; "Banane") ergibt 2 

FINDEN("A"; "Banane") ergibt den Fehlerwert #WERT!, da ein großes „A“ in der 

Zeichenkette nicht vorkommt. 

FINDEN("a"; "Banane"; 3) ergibt 4 

Siehe auch: 

SUCHEN, ERSETZEN, WECHSELN 

FINV (Quantile einer F-Verteilung) 

Syntax: 

FINV(Wahrscheinlichkeit; Freiheitsgrade1; Freiheitsgrade2) 

Beschreibung: 

Liefert Quantile einer F-Verteilung.  

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der F-Verteilung. 

Zulässig sind nur Werte aus dem Intervall [0..1]. 

Freiheitsgrade1 bestimmt die Zahl der Freiheitsgrade im Zähler. 

Freiheitsgrade2 bestimmt die Zahl der Freiheitsgrade im Nenner. 
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Die Freiheitsgrade dürfen nicht kleiner als 1 oder größer als 10^10 sein. Erwartet 

wird jeweils eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die 

Nachkommastellen automatisch ab. 

Hinweis: 

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. 

Findet PlanMaker nach 100 Iterationen kein Ergebnis, das weniger als 3x10^-7 

von Wahrscheinlichkeit abweicht, zeigt er den Fehlerwert #NV an und bricht die 

Näherung ab. 

Siehe auch: 

FTEST, FVERT 

FISHER (Fisher-Transformation) 

Syntax: 

FISHER(Zahl) 

Beschreibung: 

Liefert die Fisher-Transformation für die übergebene Zahl. 

Der zulässige Wertebereich für Zahl ist: -1  Zahl < 1 

Siehe auch: 

FISHERINV, KORREL, KOVAR 

FISHERINV (Umkehrung der Fisher-Transformation) 

Syntax: 

FISHERINV(Zahl) 
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Beschreibung: 

Liefert die umgekehrte Fisher-Transformation für die übergebene Zahl. 

Anmerkung: 

Diese Funktion ist die Umkehrfunktion der Funktion FISHER. 

Siehe auch: 

FISHER 

FTEST (F-Test) 

Syntax: 

FTEST(Werte1; Werte2) 

Beschreibung: 

Liefert die Teststatistik eines F-Tests.  

Mit einem F-Test kann die Konsistenz der Varianzen zweier Stichproben geprüft 

werden. 

Werte1 und Werte2 sind die zu untersuchenden Wertebereiche (Stichproben). 

Es müssen jeweils mindestens zwei Werte angegeben sein; andernfalls liefert die 

Funktion den Fehlerwert #DIV/0! (Division durch Null). 

Liegt die Varianz von Werte1 oder Werte2 bei 0, liefert diese Funktion den Feh-

lerwert #DIV/0!. 

Siehe auch: 

FINV, FVERT 
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FVERT (F-Verteilung) 

Syntax: 

FVERT(X; Freiheitsgrade1; Freiheitsgrade2) 

Beschreibung: 

Liefert Werte der Verteilungsfunktion einer F-verteilten Zufallsvariablen. 

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X darf keine ne-

gative Zahl sein. 

Freiheitsgrade1 bestimmt die Zahl der Freiheitsgrade im Zähler. 

Freiheitsgrade2 bestimmt die Zahl der Freiheitsgrade im Nenner. 

Die Freiheitsgrade dürfen nicht kleiner als 1 oder größer als 10^10 sein. Erwartet 

wird jeweils eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die 

Nachkommastellen automatisch ab. 

Siehe auch: 

FINV, FTEST 

GAMMAINV (Quantile einer Gammaverteilung) 

Syntax: 

GAMMAINV(Wahrscheinlichkeit; Alpha; Beta) 

Beschreibung: 

Liefert Quantile einer Gammaverteilung.  

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Gammavertei-

lung. Zulässig sind nur Werte aus dem Intervall [0..1]. 

Alpha und Beta sind die Formparameter der Funktion. Beide müssen größer als 

Null sein. 
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Hinweis: 

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. 

Findet PlanMaker nach 100 Iterationen kein Ergebnis, das weniger als 3x10^-7 

von Wahrscheinlichkeit abweicht, zeigt er den Fehlerwert #NV an und bricht die 

Näherung ab. 

Siehe auch: 

GAMMAVERT 

GAMMALN (Logarithmus der Gammafunktion) 

Syntax: 

GAMMALN(x) 

Beschreibung: 

Liefert den natürlichen Logarithmus der Gammafunktion.  

x muss größer als Null sein. 

Siehe auch: 

FAKULTÄT 

GAMMAVERT (Gammaverteilung) 

Syntax: 

GAMMAVERT(X; Alpha; Beta; Kumuliert) 

Beschreibung: 

Liefert die Wahrscheinlichkeiten einer gammaverteilten Zufallsvariablen. 
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X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X muss größer 

gleich Null sein. 

Alpha und Beta sind die Formparameter der Funktion. Beide müssen größer als 

Null sein.  

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert wer-

den soll: 

FALSCH: Es wird die Dichtefunktion geliefert. 

WAHR: Es wird die Verteilungsfunktion (also die integrierte Dichtefunktion) gelie-

fert. 

Siehe auch: 

GAMMAINV 

GANZZAHL (Runden auf ganze Zahl) 

Syntax: 

GANZZAHL(Zahl) 

Beschreibung: 

Rundet eine Zahl betragsmäßig auf die nächstkleinere ganze Zahl ab. 

Hinweis: 

Beachten Sie beim Anwenden dieser Funktion auf negative Zahlen den Unter-

schied zu anderen Rundungsfunktionen wie zum Beispiel ABRUNDEN: 

ABRUNDEN(-1,234; 0) ergibt -1, da hier der Betrag von Zahl auf die nächstklei-

nere ganze Zahl abgerundet wird 

GANZZAHL(-1,234) ergibt -2, da hier die negative Zahl selbst auf die nächstklei-

nere ganze Zahl abgerundet wird. 



 

530    Formeln und Funktionen Handbuch PlanMaker 

Beispiel: 

GANZZAHL(5,9) ergibt 5 

GANZZAHL(-5,1) ergibt -6 

Siehe auch: 

KÜRZEN, ABRUNDEN, AUFRUNDEN, RUNDEN 

GAUSS (PlanMaker 97-Kompatibilitätsfunktion) 

Syntax: 

GAUSS(x) 

Beschreibung: 

Liefert das Integral der Funktion PHI (Dichtefunktion einer Standardnormalvertei-

lung) abzüglich 0,5. 

Hinweis: 

Diese Funktion ist nur aus Kompatibilitätsgründen zu PlanMaker 97 noch vorhan-

den. Verwenden Sie diese Funktion möglichst nicht mehr, sondern benutzen Sie 

stattdessen die folgende Excel-kompatible Funktion: 

GAUSS(x) entspricht auch STANDNORMVERT(x) - 0,5 

Siehe auch: 

PHI, NORMVERT, STANDNORMVERT 

GAUSSFEHLER (Gaußsche Fehlerfunktion) 

Syntax: 

GAUSSFEHLER(Untergrenze [; Obergrenze]) 



 

Handbuch PlanMaker Formeln und Funktionen    531 

Beschreibung: 

Liefert die Gaußsche Fehlerfunktion. 

Untergrenze und Obergrenze (optional) bestimmen die Grenzen des Intervalls, 

dessen Integralfläche berechnet werden soll. Wird Obergrenze nicht angegeben, 

wird die Integralfläche von 0 bis Untergrenze berechnet. 

Siehe auch: 

GAUSSFKOMPL 

GAUSSFKOMPL (Komplement zur Gaußschen Fehlerfunktion) 

Syntax: 

GAUSSFKOMPL(Untergrenze) 

Beschreibung: 

Liefert das Komplement zur Gaußschen Fehlerfunktion. 

Für Untergrenze ist die untere Grenze des Integrals anzugeben. Es sind nur Werte 

größer gleich Null zulässig. 

Siehe auch: 

GAUSSFEHLER 

GDA (Geometrisch-degressive Abschreibung) 

Syntax: 

GDA(AW; RW; ND; P [; Faktor]) 
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Beschreibung: 

Berechnet den Abschreibungsbetrag eines Objekts für eine bestimmte Periode nach 

der Methode der geometrisch-degressiven Doppelraten-Abschreibung. 

AW = Anschaffungswert des Objekts 

RW = Restwert des Objekts am Ende der Nutzungsdauer 

ND = Nutzungsdauer (Anzahl der Perioden, über die das Objekt abgeschrieben 

wird) 

P = Periode, deren Abschreibungsbetrag berechnet werden soll (in der gleichen 

Einheit wie ND anzugeben) 

Faktor (optional) = Rate, um die der jeweilige Buchwert verringert wird. Fehlt 

dieses Argument, wird Faktor auf 2 gesetzt (Doppelraten-Abschreibung). 

Beispiel: 

Bei einer für € 200.000,- erworbenen Maschine, die 10 Jahre genutzt wird und 

dann einen Restwert von € 10.000,- hat, muss für das erste Jahr folgender jahresbe-

zogener Abschreibungsbetrag angesetzt werden: 

GDA(200000; 10000; 10; 1) ergibt 40000,- Euro 

Siehe auch: 

GDA2, DIA, LIA 

GDA2 (Geometrisch-degressive Abschreibung) 

Syntax: 

GDA2(AW; RW; ND; P [; M]) 

Beschreibung: 

Berechnet den Abschreibungsbetrag eines Objekts für eine bestimmte Periode nach 

der Methode der geometrisch-degressiven Abschreibung.  

AW = Anschaffungswert des Objekts 
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RW = Restwert des Objekts am Ende der Nutzungsdauer 

ND = Nutzungsdauer (Anzahl der Perioden, über die das Objekt abgeschrieben 

wird) 

P = Periode, deren Abschreibungsbetrag berechnet werden soll (in der gleichen 

Einheit wie ND anzugeben) 

M = Zahl der Monate im ersten Jahr (optional). Wird diese nicht angegeben, wird 

M auf 12 gesetzt. 

Beispiel: 

GDA2(200000; 10000; 6; 1; 7) ergibt 45850,00 

Siehe auch: 

GDA, DIA, LIA 

GEOMITTEL (Geometrisches Mittel) 

Syntax: 

GEOMITTEL(Zahl1; Zahl2 [; Zahl3...]) 

Beschreibung: 

Liefert das einfache geometrische Mittel der übergebenen Zahlen. 

Dieses wird durch Ziehen der n-ten Wurzel aus dem Produkt der Einzelwerte er-

mittelt (n ist die Anzahl der Werte). 

Alle übergebenen Werte müssen größer als Null sein. 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Beispiel: 

GEOMITTEL(1; 2; 6) ergibt 2,28943 
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Siehe auch: 

HARMITTEL, MITTELWERT 

GERADE (Aufrunden auf eine gerade Zahl) 

Syntax: 

GERADE(Zahl) 

Beschreibung: 

Rundet Zahl auf die betragsmäßig nächstgrößere gerade Zahl auf. 

Beispiel: 

GERADE(42) ergibt 42 

GERADE(43) ergibt 44 

GERADE(-43) ergibt -44 

Siehe auch: 

UNGERADE, VRUNDEN, RUNDEN, ISTGERADE 

GESTUTZTMITTEL (Mittelwert ohne Randwerte) 

Syntax: 

GESTUTZTMITTEL(Datenbereich; Prozentwert) 

Beschreibung: 

Liefert den Mittelwert einer Datenmenge, blendet dabei jedoch den angegebenen 

Prozentsatz an Randwerten aus. 
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Unter „Randwerten“ sind die kleinsten und größten Werte einer Datenmenge zu 

verstehen. Dies sind häufig „Ausreißer“ (untypisch niedrige oder hohe Werte, die 

zum Beispiel aufgrund eines Messfehlers entstanden sind).  

Datenbereich ist ein Zellbezug auf die zu untersuchende Datenmenge. 

Mit Prozentwert geben Sie an, wie viel Prozent der Randwerte nicht berücksich-

tigt werden sollen. 

Wenn beispielsweise 100 Werte vorliegen und Prozentwert auf 10% gesetzt wur-

de, werden 10 Werte ignoriert: die 5 niedrigsten und die 5 höchsten. 

Die Zahl der nicht zu berücksichtigen Werte wird stets auf ein Vielfaches von 2 

abgerundet, damit gleich viele niedrige und hohe Werte ausgeblendet werden. Bei 

einer Datenmenge mit 30 Werten würden bei Prozentwert = 10 also nicht 3, son-

dern 2 Werte ignoriert. 

Beispiel: 

In den Zellen A1 bis A10 befinden sich die folgenden 10 Werte: 43, 45, 42, 0, 44, 

45, 42, 1234, 40, 41 

Wie Sie sehen, befinden sich zwei Ausreißer unter diesen Werten: 0 und 1234. Mit 

der Funktion MITTELWERT würden Sie deshalb einen unbrauchbaren Mittelwert 

erhalten: 

MITTELWERT(A1:A10) ergibt 159,2 

Verwenden Sie hingegen GESTUTZTMITTEL und blenden beispielsweise 20% 

der Werte an den Rändern aus – in diesem Fall sind das günstigerweise genau die 

beiden Ausreißer unter den 10 Werten –, wird ein brauchbarer Mittelwert geliefert: 

GESTUTZTMITTEL(A1:A10; 20%) ergibt: 42,75 

Siehe auch: 

MITTELWERT, GEOMITTEL, HARMITTEL 

GGANZZAHL (Zahl größer gleich Schwellenwert?) 

Syntax: 

GGANZZAHL(Zahl; Schwelle) 
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Beschreibung: 

Diese Funktion liefert 1, wenn Zahl  Schwelle ist, ansonsten liefert sie 0. 

Beispiel: 

GGANZZAHL(41; 42) ergibt 0 

GGANZZAHL(42; 42) ergibt 1 

GGANZZAHL(42,1; 42) ergibt 1 

Siehe auch: 

DELTA 

GGT (Größter gemeinsamer Teiler) 

Syntax: 

GGT(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Ermittelt den ggT („größter gemeinsamer Teiler“) einer Menge von Zahlen. Der 

ggT ist die größte all derjenigen ganzen Zahlen, durch die alle Argumente ohne 

Rest teilbar sind. 

Als Argumente können Zahlen oder Zellbezüge übergeben werden. 

Alle übergebenen Zahlen müssen größer als Null sein. Weiterhin sollten nur ganze 

Zahlen verwendet werden. Ist dies nicht der Fall, schneidet PlanMaker die Nach-

kommastellen automatisch ab. 

Beispiel: 

GGT(25; 100; 250) ergibt 25 

GGT(25; 105; 250) ergibt 5 

Sind die Zellen A1 bis A3 mit den Werten 4, 8 und 6 gefüllt, so gilt: 
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GGT(A1:A3) ergibt 2 

Siehe auch: 

KGV 

GLÄTTEN (Überflüssige Leerzeichen entfernen) 

Syntax: 

GLÄTTEN(Zeichenkette) 

Beschreibung: 

Entfernt alle Leerzeichen am Beginn und am Ende einer Zeichenkette. 

Beispiel: 

GLÄTTEN("    Text  ") ergibt Text 

Siehe auch: 

SÄUBERN 

GRAD (Bogenmaß in Grad umwandeln) 

Syntax: 

GRAD(Zahl) 

Beschreibung: 

Wandelt eine Winkelangabe, die im Bogenmaß (Radiant) gegeben ist, in Grad um. 

Die Formel für die Umrechnung lautet:  

GRAD(x) = x * 180 / PI() 
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Beispiel: 

GRAD(PI()) ergibt 180 

Siehe auch: 

BOGENMASS 

GROSS (In Großbuchstaben wandeln) 

Syntax: 

GROSS(Zeichenkette) 

Beschreibung: 

Wandelt alle Buchstaben einer Zeichenkette in Großbuchstaben um. 

Beispiel: 

GROSS("PlanMaker") ergibt PLANMAKER 

Siehe auch: 

GROSS2, KLEIN 

GROSS2 (In Groß-/Kleinbuchstaben wandeln) 

Syntax: 

GROSS2(Zeichenkette) 

Beschreibung: 

Wandelt eine Zeichenkette wie folgt um: Buchstaben am Wortanfang werden groß, 

alle anderen Buchstaben klein geschrieben. 
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Beispiel: 

GROSS2("guten tag") ergibt Guten Tag 

GROSS2("Guten Tag") ergibt Guten Tag 

GROSS2("GuTeN TaG") ergibt Guten Tag 

Siehe auch: 

GROSS, KLEIN 

GTEST (Gauß-Test) 

Syntax: 

GTEST(Datenbereich; x [; Sigma]) 

Beschreibung: 

Liefert die einseitige Prüfstatistik für einen Gauß-Test. 

Sie können mit dieser Funktion prüfen, mit welcher Wahrscheinlichkeit eine Stich-

probe aus einer bestimmten Grundgesamtheit stammt. 

Datenbereich ist ein Zellbezug auf den Datenbereich, gegen den x getestet werden 

soll. Es sollten mindestens 30 Werte vorliegen. 

x ist der zu testende Wert. 

Das optionale Argument Sigma ist die Standardabweichung  der Grundgesamt-

heit (sofern bekannt). Falls diese nicht angegeben wird, verwendet PlanMaker au-

tomatisch die Standardabweichung der gegebenen Stichprobe (also der Werte in 

Datenbereich). 

Siehe auch: 

STANDARDISIERUNG, NORMVERT, STANDNORMVERT 
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HARMITTEL (Harmonisches Mittel) 

Syntax: 

HARMITTEL(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Liefert das harmonische Mittel der übergebenen Zahlen.  

Dieses ist definiert als der Kehrwert des arithmetischen Mittels der Kehrwerte der 

Einzelwerte. 

Alle übergebenen Werte müssen größer Null sein. 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Beispiel: 

HARMITTEL(1; 2; 6) ergibt 1,8 

Siehe auch: 

GEOMITTEL, MITTELWERT 

HÄUFIGKEIT (Häufigkeitsverteilung) 

Syntax: 

HÄUFIGKEIT(Daten; Grenzen) 

Beschreibung: 

Liefert eine Häufigkeitsverteilung. Sie können damit ermitteln, wie viele Werte aus 

einer Datenmenge sich innerhalb bestimmter Intervalle befinden. 

Das Ergebnis wird in Form einer einspaltigen Matrix geliefert. 
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Bei Daten sind die auszuwertenden Daten einzutragen. Leere Zellen und Zeichen-

ketten werden ignoriert. 

Mit Klassen definieren Sie die zu betrachtenden Intervalle. Geben Sie als Klassen 

beispielsweise die Matrix {10; 15; 42} ein, liefert die Funktion eine Matrix mit 

folgenden vier Werten: 

1. Die Anzahl der Werte, die <=10 sind. 

2. Die Anzahl der Werte, die >10 und <=15 sind. 

3. Die Anzahl der Werte, die >15 und <=42 sind. 

4. Die Anzahl der Werte, die >42 sind. 

Daten und Klassen müssen jeweils eine einspaltige Matrix sein; sie dürfen also 

nicht mehr als eine Spalte an Daten enthalten. 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 450. 

Beachten Sie dabei, dass die von dieser Funktion gelieferte Matrix ein Element 

mehr hat als die Matrix Klassen.  

Siehe auch: 

ANZAHL 

HEUTE (Aktuelles Datum) 

Syntax: 

HEUTE() 

Beschreibung: 

Liefert das aktuelle Systemdatum (ohne Uhrzeit). 
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Das Ergebnis ist – wie alle Datumsangaben in einer Tabellenkalkulation – eine 

Zahl. PlanMaker weist ihr automatisch das Zahlenformat „Datum/Zeit“ zu, damit 

sie als Datum dargestellt wird. 

Beispiel: 

HEUTE() ergibt 22.07.2013 

Siehe auch: 

JETZT 

HEXINBIN (Hexadezimalzahl in Binärzahl wandeln) 

Syntax: 

HEXINBIN(Zahl [; Stellen]) 

Beschreibung: 

Wandelt eine Hexadezimalzahl (Basis 16) in eine Binärzahl (Basis 2) um. 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel).  

Der zulässige Wertebereich für Zahl ist (in hexadezimaler Schreibweise): 

80000000  Zahl  7FFFFFFF 

Das entspricht in Dezimalschreibweise: 

-2.147.483.648  Zahl  2.147.483.647 

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 
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Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert. 

Beispiel: 

HEXINBIN("2A") ergibt 101010 

HEXINBIN("2A"; 8) ergibt 00101010 

HEXINBIN("2A"; 2) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit min-

destens 5 Stellen dargestellt werden kann 

HEXINBIN("FFFFFFD6") ergibt 11111111111111111111111111010110 (negative 

Zahl) 

Siehe auch: 

BININHEX, HEXINDEZ, HEXINOKT 

HEXINDEZ (Hexadezimalzahl in Dezimalzahl wandeln) 

Syntax: 

HEXINDEZ(Zahl) 

Beschreibung: 

Wandelt eine Hexadezimalzahl (Basis 16) in eine Dezimalzahl (Basis 10) um. 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel).  

Der zulässige Wertebereich für Zahl ist (in hexadezimaler Schreibweise): 

80000000  Zahl  7FFFFFFF 

Das entspricht in Dezimalschreibweise: 
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-2.147.483.648  Zahl  2.147.483.647 

Beispiel: 

HEXINDEZ("2A") ergibt 42 

HEXINDEZ("FFFFFFD6") ergibt -42 

Siehe auch: 

DEZINHEX, HEXINBIN, HEXINOKT 

HEXINOKT (Hexadezimalzahl in Oktalzahl wandeln) 

Syntax: 

HEXINOKT(Zahl [; Stellen]) 

Beschreibung: 

Wandelt eine Hexadezimalzahl (Basis 16) in eine Oktalzahl (Basis 8) um. 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel).  

Der zulässige Wertebereich für Zahl ist (in hexadezimaler Schreibweise): 

80000000  Zahl  7FFFFFFF 

Das entspricht in Dezimalschreibweise: 

-2.147.483.648  Zahl  2.147.483.647 

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 
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Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert. 

Beispiel: 

HEXINOKT("2A") ergibt 52 

HEXINOKT("2A"; 4) ergibt 0052 

HEXINOKT("2A"; 1) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit min-

destens 2 Stellen dargestellt werden kann 

HEXINOKT("FFFFFFD6") ergibt 37777777726 (negative Zahl) 

Siehe auch: 

OKTINHEX, HEXINBIN, HEXINDEZ 

HYPERLINK (Hyperlink) 

Syntax: 

HYPERLINK(Zieladresse [; Beschriftung]) 

Beschreibung: 

Zeigt in der Zelle einen Hyperlink auf die angegebene Zieladresse an. Als Linktext 

wird die Zieladresse oder optional der mit dem Parameter Beschriftung übergebe-

ne Text angezeigt. 

Sie können mit dieser Funktion beispielsweise einen Link auf eine Webseite einfü-

gen. Klickt der Anwender diesen an, wird automatisch sein Internet-Browser ge-

startet und diese Seite darin aufgerufen.  

Weiterhin lassen sich unter anderem Links auf ein anderes PlanMaker-Dokument 

einfügen, das beim Anklicken dieses Links automatisch geöffnet wird. 
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Zieladresse ist die Adresse, auf die der Link zeigen soll. Zulässig hierfür ist eine 

feste Zeichenkette, eine Berechnung oder ein Bezug auf die Zelle, in der sich die 

gewünschte Zieladresse befindet. Siehe Beispiele. 

Beschriftung (optional) ist der Text, der in der Zelle erscheinen soll. Wenn dieser 

nicht angegeben wird, erscheint stattdessen die Zieladresse als Text in der Zelle. 

Beispiel: 

=HYPERLINK("http://www.softmaker.com") 

Obiger Hyperlink öffnet die Webseite www.softmaker.com im Browser. 

=HYPERLINK("http://www.softmaker.com"; "Unsere Homepage") 

Dito, allerdings wird als Linktext nicht die Zieladresse, sondern der Text „Unsere 

Homepage“ angezeigt. 

=HYPERLINK("c:\Mein Ordner\Dateiname.pmd") 

Obiger Link öffnet die Datei c:\Mein Ordner\Dateiname.pmd in PlanMaker. 

Hinweis: Sie können mit dieser Funktion nicht nur PlanMaker-Dateien öffnen, 

sondern auch beliebige andere Arten von Dokumenten, sofern diesen ein Pro-

gramm zugewiesen ist, mit dem sie geöffnet werden sollen. 

=HYPERLINK("[c:\Mein Ordner\Dateiname.pmd]Tabelle1!A5") 

Obiger Link öffnet die Datei c:\Mein Ordner\Dateiname.pmd in PlanMaker und 

springt zur Zelle A5 auf dem Arbeitsblatt „Tabelle1“. Wichtig: Der komplette Da-

teiname muss dabei mit eckigen Klammern umgeben werden. Direkt dahinter ist 

der Name des Arbeitsblatts, ein Ausrufezeichen und die Zielzelle anzugeben. 

=HYPERLINK("[c:\Mein Ordner\Dateiname.pmd]Tabelle1!MeinBereich") 

Obiger Link öffnet die Datei c:\Mein Ordner\Dateiname.pmd in PlanMaker und 

springt zur linken oberen Ecke des benannten Bereichs „MeinBereich“ auf dem 

Arbeitsblatt „Tabelle1“. 

=HYPERLINK("http://www.softmaker.com#Sprungziel") 

Obiger Link öffnet die Webseite www.softmaker.com im Browser und springt zu 

der Sprungmarke (dem Anker) „Sprungziel“. Alternativ können Sie hierfür auch 

die Schreibweise =HYPERLINK("[http://www.softmaker.com]Sprungziel") ver-

wenden. 

=HYPERLINK(E1; E2) 
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Obiger Link öffnet die Zieladresse, die in der Zelle E1 eingetragen ist. Als Linktext 

wird der Inhalt der Zelle E2 angezeigt. 

Siehe auch: 

Der Abschnitt „Verknüpfungen anbringen“ (ab Seite 339) beschreibt eine alternati-

ve Methode zum Anbringen von Links. Die HYPERLINK-Funktion ist allerdings 

flexibler in der Anwendung. 

HYPGEOMVERT (Hypergeometrische Verteilung) 

Syntax: 

HYPGEOMVERT(k; n; K; N) 

Beschreibung: 

Liefert die Wahrscheinlichkeiten einer hypergeometrisch verteilten Zufallsvariab-

len. 

Die hypergeometrische Verteilung ist die Wahrscheinlichkeitsverteilung für bei-

spielsweise das Ziehen von k roten Kugeln in einem Zufallsexperiment nach dem 

Modell der zufälligen Entnahme von n Kugeln (ohne Zurücklegen) aus einer Urne, 

die zu Beginn N Kugeln enthält, davon K rote. 

k ist die Zahl der Treffer (Treffer = Ziehen einer roten Kugel). 

n ist der Umfang der Stichprobe (Zahl der Kugeln, die gezogen werden sollen). 

K ist die Zahl der möglichen Treffer innerhalb der Grundgesamtheit (Zahl der an-

fänglich vorhandenen roten Kugeln). 

N ist der Umfang der Grundgesamtheit (Zahl der anfänglich vorhandenen Kugeln 

insgesamt). 

Alle Argumente sollten ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker 

die Nachkommastellen automatisch weg. 
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Beispiel: 

Eine Urne enthält insgesamt 10 Kugeln (N=10), davon 2 rote (K=2). Wie groß ist 

die Wahrscheinlichkeit, beim Ziehen von 5 Kugeln (n=5) genau 1 rote Kugel zu 

erhalten (k=1)? 

HYPGEOMVERT(1; 5; 2; 10) ergibt 0,55556 

Siehe auch: 

NEGBINOMVERT 

IDENTISCH (Zeichenketten identisch?) 

Syntax: 

IDENTISCH(Zeichenkette1; Zeichenkette2) 

Beschreibung: 

Liefert WAHR, wenn Zeichenkette1 mit Zeichenkette2 übereinstimmt. 

Auch die Groß-/Kleinschreibung muss exakt übereinstimmen.  

Beispiel: 

IDENTISCH("aaa"; "aaa") ergibt WAHR 

IDENTISCH("aaa"; "Aaa") ergibt FALSCH 

IDENTISCH(GROSS("aaa"); GROSS("Aaa")) ergibt WAHR 

Siehe auch: 

FINDEN, SUCHEN 
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IKV (Interner Zinsfuß) 

Syntax: 

IKV(Werte [; Schätzwert]) 

Beschreibung: 

Liefert einen Schätzwert für den internen Zinsfuß einer Investition. Im Gegensatz 

zur Funktion QIKV werden dabei keine Finanzierungskosten oder Reinvestitions-

gewinne berücksichtigt.  

Als Basis dienen die im Bereich Werte angegebenen Auszahlungen (negative Wer-

te) und Einzahlungen (positive Werte). Die Zahlungen dürfen unterschiedlich groß 

sein, müssen jedoch in gleichmäßigen Zeitintervallen (z.B. monatlich oder jährlich) 

auftreten. 

Die Funktion erwartet folgende Argumente: 

Für Werte gibt man einen Zellbezug an, in dem die Zahlungen eingetragen wur-

den. Es muss mindestens eine Auszahlung und eine Einzahlung vorliegen. 

Für Schätzwert können Sie (optional) einen Schätzwert für das Ergebnis der Be-

rechnung angeben (siehe Hinweis). 

Hinweis: 

Die Berechnung erfolgt mit Hilfe eines Näherungsverfahrens (Iterationsverfahren). 

Falls die Funktion nach 20 Näherungsschritten noch kein Ergebnis mit einer Ge-

nauigkeit von 0,00001% oder besser findet, bricht sie die Näherung ab und liefert 

als Ergebnis den Fehlerwert #ZAHL!. Versuchen Sie in diesem Fall einen anderen 

Wert für Schätzwert anzugeben. 

Siehe auch: 

QIKV, XINTZINSFUSS, ZINS 
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IMABS (Absolutbetrag einer komplexen Zahl) 

Syntax: 

IMABS(KomplexeZahl) 

Beschreibung: 

Liefert den Absolutbetrag (Modul) einer komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMABS("2+4i") ergibt 4,47214 

Siehe auch: 

KOMPLEXE, IMARGUMENT, IMEXP, IMKONJUGIERTE 

IMAGINÄRTEIL (Imaginärteil einer komplexen Zahl) 

Syntax: 

IMAGINÄRTEIL(KomplexeZahl) 

Beschreibung: 

Liefert den Imaginärteil einer komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMAGINÄRTEIL("2+4i") ergibt 4 
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Siehe auch: 

KOMPLEXE, IMREALTEIL 

IMAPOTENZ (Potenz einer komplexen Zahl) 

Syntax: 

IMAPOTENZ(KomplexeZahl; Exponent) 

Beschreibung: 

Potenziert die komplexe Zahl KomplexeZahl mit dem Exponenten Exponent. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMAPOTENZ("2+4i"; 2) ergibt -12+16i 

Siehe auch: 

KOMPLEXE, IMWURZEL 

IMARGUMENT (Winkel einer komplexen Zahl) 

Syntax: 

IMARGUMENT(KomplexeZahl) 

Beschreibung: 

Liefert den Winkel (Bogenmaß) zur Darstellung der komplexen Zahl in trigono-

metrischer Schreibweise. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 
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Beispiel: 

IMARGUMENT("2+4i") ergibt 1,10715 

Siehe auch: 

KOMPLEXE, IMABS, IMEXP, IMKONJUGIERTE 

IMCOS (Cosinus einer komplexen Zahl) 

Syntax: 

IMCOS(KomplexeZahl) 

Beschreibung: 

Liefert den Cosinus einer komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMCOS("2+4i") ergibt -11,3642347064011 - 24,8146514856342i 

Siehe auch: 

KOMPLEXE, IMSIN 

IMDIV (Division komplexer Zahlen) 

Syntax: 

IMDIV(KomplexeZahl1; KomplexeZahl2) 
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Beschreibung: 

Liefert das Ergebnis der Division der komplexen Zahl KomplexeZahl1 durch die 

komplexe Zahl KomplexeZahl2. 

Die Argumente müssen komplexe Zahlen im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMDIV("4+12i"; "2+4i") ergibt 2,8+0,4i 

Siehe auch: 

KOMPLEXE, IMPRODUKT, IMSUB, IMSUMME 

IMEXP (Algebraische Form einer komplexen Zahl) 

Syntax: 

IMEXP(KomplexeZahl) 

Beschreibung: 

Liefert die algebraische Form einer in exponentieller Schreibweise vorliegenden 

komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMEXP("2+4i") ergibt -4,82980938326939 - 5,59205609364098i 

Siehe auch: 

KOMPLEXE, IMABS, IMARGUMENT, IMKONJUGIERTE 
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IMKONJUGIERTE (Konjugiert komplexe Zahl) 

Syntax: 

IMKONJUGIERTE(KomplexeZahl) 

Beschreibung: 

Liefert die konjugiert komplexe Zahl zu einer komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMKONJUGIERTE("2+4i") ergibt 2-4i 

Siehe auch: 

KOMPLEXE, IMABS, IMARGUMENT, IMEXP 

IMLN (Natürlicher Logarithmus einer komplexen Zahl) 

Syntax: 

IMLN(KomplexeZahl) 

Beschreibung: 

Liefert den Logarithmus einer komplexen Zahl zur Basis e (natürlicher Logarith-

mus). 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMLN("2+4i") ergibt 1,497866136777 + 1,10714871779409i 
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Siehe auch: 

KOMPLEXE, IMLOG10, IMLOG2 

IMLOG10 (Zehnerlogarithmus einer komplexen Zahl) 

Syntax: 

IMLOG10(KomplexeZahl) 

Beschreibung: 

Liefert den Logarithmus einer komplexen Zahl zur Basis 10 (Zehnerlogarithmus 

oder dekadischer Logarithmus). 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMLOG10("2+4i") ergibt 0,650514997831991 + 0,480828578784234i 

Siehe auch: 

KOMPLEXE, IMLN, IMLOG2 

IMLOG2 (Zweierlogarithmus einer komplexen Zahl) 

Syntax: 

IMLOG2(KomplexeZahl) 

Beschreibung: 

Liefert den Logarithmus einer komplexen Zahl zur Basis 2 (Zweierlogarithmus). 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 
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Beispiel: 

IMLOG2("2+4i") ergibt 2,16096404744368 + 1,59727796468811i 

Siehe auch: 

KOMPLEXE, IMLN, IMLOG10 

IMNEG (Negativer Wert einer komplexen Zahl) 

Syntax: 

IMNEG(KomplexeZahl) 

Beschreibung: 

Liefert den negativen Wert einer komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Tipp: Alternativ zu IMNEG(A1) können Sie auch die folgende Formel verwenden: 

KOMPLEXE(-IMREALTEIL(A1); -IMAGINÄRTEIL(A1)) 

Beispiel: 

IMNEG("2+4i") ergibt -2-4i 

Siehe auch: 

KOMPLEXE 
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IMPRODUKT (Produkt komplexer Zahlen) 

Syntax: 

IMPRODUKT(KomplexeZahl1; KomplexeZahl2 [; KomplexeZahl3 ...]) 

Beschreibung: 

Liefert das Produkt der übergebenen komplexen Zahlen. 

Die Argumente müssen komplexe Zahlen im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMPRODUKT("2+4i"; "1+2i") ergibt -6+8i 

Siehe auch: 

KOMPLEXE, IMDIV, IMSUB, IMSUMME 

IMREALTEIL (Realteil einer komplexen Zahl) 

Syntax: 

IMREALTEIL(KomplexeZahl) 

Beschreibung: 

Liefert den Realteil einer komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMREALTEIL("2+4i") ergibt 2 
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Siehe auch: 

KOMPLEXE, IMAGINÄRTEIL 

IMSIN (Sinus einer komplexen Zahl) 

Syntax: 

IMSIN(KomplexeZahl) 

Beschreibung: 

Liefert den Sinus einer komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMSIN("2+4i") ergibt 24,8313058489464 - 11,3566127112182i 

Siehe auch: 

KOMPLEXE, IMCOS 

IMSUB (Differenz komplexer Zahlen) 

Syntax: 

IMSUB(KomplexeZahl1; KomplexeZahl2) 

Beschreibung: 

Liefert die Differenz zweier komplexer Zahlen, subtrahiert also KomplexeZahl2 

von KomplexeZahl1. 

Die Argumente müssen komplexe Zahlen im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 
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Beispiel: 

IMSUB("2+4i"; "1+2i") ergibt 1+2i 

Siehe auch: 

KOMPLEXE, IMDIV, IMPRODUKT, IMSUMME 

IMSUMME (Summe komplexer Zahlen) 

Syntax: 

IMSUMME(KomplexeZahl1; KomplexeZahl2 [; KomplexeZahl3...]) 

Beschreibung: 

Liefert die Summe der übergebenen komplexen Zahlen. 

Die Argumente müssen komplexe Zahlen im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMSUMME("2+4i"; "1+2i") ergibt 3+6i 

Siehe auch: 

KOMPLEXE, IMDIV, IMPRODUKT, IMSUB 

IMWURZEL (Quadratwurzel einer komplexen Zahl) 

Syntax: 

IMWURZEL(KomplexeZahl) 
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Beschreibung: 

Liefert die Quadratwurzel einer komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMWURZEL("2+4i") ergibt 1,79890743994787 + 1,11178594050284i 

Siehe auch: 

KOMPLEXE, IMAPOTENZ 

INDEX (Zelle in einem Bereich) 

Syntax: 

INDEX(Bereich; Zeile; Spalte [; Teilbereich]) 

Beschreibung: 

Liefert einen Bezug auf die Zelle, die sich in der angegebenen Zeile und Spalte 

von Bereich befindet. 

Für Bereich ist der gewünschte Zellbereich anzugeben. 

Mit Zeile und Spalte bestimmen Sie, in welcher Zeile und Spalte von Bereich sich 

die zu liefernde Zelle befindet (ausgehend von der linken oberen Ecke von Be-

reich). 

Wenn Zeile oder Spalte zu groß ist, liefert die Funktion den Fehlerwert #BEZUG. 

Das optionale Argument Teilbereich ist nur aus Gründen der Excel-Kompatibilität 

vorhanden. Es kann angegeben werden, wird von PlanMaker aber nicht ausgewer-

tet. 

Kompatibilitätshinweis: 

Diese Funktion ist nicht vollständig kompatibel zur gleichnamigen Excel-Funktion: 
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Beim Argument Bereich werden Mehrfachmarkierungen (unzusammenhängende 

Zellbereiche) nicht unterstützt. 

Das Argument Teilbereich wird nicht ausgewertet. 

Beispiel: 

INDEX(B2:D4; 2; 2) liefert einen Bezug auf die Zelle C3 

Siehe auch: 

VERGLEICH, SVERWEIS, WVERWEIS 

INDIREKT (Bezug aus Zeichenkette bilden) 

Syntax: 

INDIREKT(Zeichenkette [; Modus]) 

Beschreibung: 

Bildet aus einer Zeichenkette einen Zellbezug. 

Die übergebene Zeichenkette kann beispielsweise eine Zelladresse (z.B. "A1" 

oder "$A$1") oder einen Bereichsnamen enthalten. 

Der optionale Wahrheitswert Modus bestimmt, in welchem Format die übergebene 

Zelladresse vorliegen muss: 

WAHR oder nicht angegeben: Normale Zelladresse (z.B. A1) 

FALSCH: Zelladresse im Format „Z1S1“ (eine alternative Art der Zelladressie-

rung, die nur von Microsoft Excel unterstützt wird) 

Beispiel: 

INDIREKT("A1") liefert einen Bezug auf die Zelle A1. 

Steht in Zelle D2 der Text "E5", so liefert INDIREKT(D2) einen Bezug auf die 

Zelle E5. Mit GANZZAHL(INDIREKT(D2)) könnten Sie beispielsweise den In-

halt der Zelle E5 auf eine ganze Zahl abrunden. 



 

562    Formeln und Funktionen Handbuch PlanMaker 

Weisen Sie einem Zellbereich den Namen „Name1“ zu, so liefert INDI-

REKT("Name1") einen Bezug auf diesen benannten Bereich. 

Siehe auch: 

ADRESSE, BEREICH.VERSCHIEBEN, SPALTE, ZEILE  

ISOWOCHE (Kalenderwoche nach ISO-Norm) 

Syntax: 

ISOWOCHE(Datum [; JahrZurückgeben]) 

Beschreibung: 

Ermittelt, in der wievielten Kalenderwoche eines Jahres sich ein Datum befindet. 

Im Gegensatz zu der Excel-kompatiblen Funktion KALENDERWOCHE verwen-

det diese Funktion nicht die in den USA und vielen anderen Teilen der Welt übliche 

Rechenmethode. Sie richtet sich vielmehr nach der u.a. in Deutschland, Österreich 

und der Schweiz verbindlichen ISO-Norm 8601. Diese legt folgendes fest: 

1. Wochenbeginn ist stets ein Montag (nicht Sonntag). 

2. Die erste Kalenderwoche eines Jahres ist diejenige, die den 4. Januar enthält. 

Hinweis: 

Hierbei kann es vorkommen, dass der 29., 30. und 31. Dezember bereits zur ersten 

Kalenderwoche des nächsten Jahres gezählt werden (oder der 1., 2., 3. Januar zur 

letzten Kalenderwoche des vorherigen Jahrs). 

Deshalb verfügt die Funktion zusätzlich über den Parameter JahrZurückgeben, 

der folgende Auswirkung hat: 

Ist dieser 0 oder nicht angegeben, liefert die Funktion die Wochennummer zurück. 

Ist dieser 1, liefert die Funktion das Jahr zurück, dem das Datum gemäß ISO-

Norm zugerechnet wird (siehe Beispiele). 
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Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

ISOWOCHE("01.01.2004") ergibt 1 

ISOWOCHE("01.01.2005") ergibt 53 

ISOWOCHE("01.01.2005"; 1) ergibt 2004 

Siehe auch: 

KALENDERWOCHE, JAHR, MONAT, TAG, WOCHENTAG 

ISPMT (Zinszahlung) 

Syntax: 

ISPMT(Zins; Zr; Zzr; Bw) 

Beschreibung: 

Liefert die im angegebenen Zeitraum gezahlten Zinsen für eine Investition mit 

gleichbleibenden Raten. 

Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode) 

Zr = die zu betrachtende Periode 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 

Bw = Barwert (der anfängliche Betrag) 

Siehe auch: 

KAPZ, RMZ, ZINSZ 
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ISTBEZUG (Ist ein Zellbezug?) 

Syntax: 

ISTBEZUG(Wert) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn der übergebene Wert ein gültiger Zellbe-

zug ist. 

Beispiel: 

ISTBEZUG(A1) ergibt WAHR 

ISTBEZUG($A$1) ergibt WAHR 

ISTBEZUG(A1:C7) ergibt WAHR 

ISTBEZUG("beliebiger Text") ergibt FALSCH 

ISTBEZUG(Quartal1) ergibt so lange FALSCH, bis Sie einem Zellbereich den 

Namen „Quartal1“ zuweisen – ab dann ergibt auch diese Berechnung WAHR. 

Siehe auch: 

ISTFORMEL 

ISTFEHL (Ist Fehlerwert außer #NV?) 

Syntax: 

ISTFEHL(Zelle) 

Beschreibung: 

Im Unterschied zur Funktion ISTFEHLER (siehe dort) liefert ISTFEHL nur dann 

den Wahrheitswert WAHR, wenn die übergebene Zelle einen Fehlerwert außer 

#NV liefert. 
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Beispiel: 

ISTFEHL(A1) ergibt WAHR, wenn der Inhalt der Zelle A1 einen Fehlerwert außer 

#NV ergibt. 

ISTFEHL(A1) ergibt FALSCH, wenn Zelle A1 keinen Fehler zurückliefert oder 

dort die Funktion NV() eingetragen ist. 

Siehe auch: 

ISTFEHLER, ISTNV, FEHLER.TYP, WENNFEHLER, Abschnitt über 

„Fehlerwerte“ ab Seite 448 

ISTFEHLER (Ist ein Fehler?) 

Syntax: 

ISTFEHLER(Zelle) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle einen beliebigen 

Fehlerwert liefert. 

Beispiel: 

ISTFEHLER(A1) ergibt WAHR, wenn der Inhalt der Zelle A1 einen beliebigen 

Fehlerwert zurückliefert. 

Siehe auch: 

ISTFEHL, ISTNV, FEHLER.TYP, WENNFEHLER, Abschnitt über „Fehlerwerte“ 

ab Seite 448 
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ISTFORMEL (Ist eine Formel?) 

Syntax: 

ISTFORMEL(Zelle) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle eine Formel enthält. 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

Steht in der Zelle A1 eine Formel, in Zelle C7 beispielsweise ein fester Zahlenwert 

oder Klartext, so gilt: 

ISTFORMEL(A1) ergibt WAHR 

ISTFORMEL(C7) ergibt FALSCH 

Siehe auch: 

ISTBEZUG 

ISTGERADE (Ist eine gerade Zahl?) 

Syntax: 

ISTGERADE(Zahl) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn Zahl eine gerade Zahl ist.  
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Hinweis: 

Zahl sollte eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker die 

Nachkommastellen automatisch. 

Beispiel: 

ISTGERADE(2) ergibt WAHR 

ISTGERADE(2,75) ergibt WAHR 

ISTGERADE(3) ergibt FALSCH 

ISTGERADE(3,75) ergibt FALSCH 

Siehe auch: 

ISTUNGERADE 

ISTKTEXT (Ist kein Text?) 

Syntax: 

ISTKTEXT(Zelle) 

Beschreibung: 

Die Funktion ISTKTEXT (sprich: „Ist kein Text“) liefert nur dann den Wahr-

heitswert WAHR, wenn die übergebene Zelle keine Zeichenkette enthält. 

Beispiel: 

Enthält Zelle A1 eine feste Zeichenkette oder eine Berechnung, die eine Zeichen-

kette liefert, Zelle C7 hingegen eine Zahl, so gilt: 

ISTKTEXT(A1) ergibt FALSCH 

ISTKTEXT(C7) ergibt WAHR 
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Siehe auch: 

ISTTEXT, ISTLOG, ISTZAHL 

Anmerkung: 

ISTTEXT ist das Gegenstück zu dieser Funktion: Sie liefert WAHR, wenn sich in 

der Zelle eine Zeichenkette befindet. 

ISTLEER (Ist leer?) 

Syntax: 

ISTLEER(Zelle) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle leer ist. 

Beispiel: 

Enthält Zelle A1 beispielsweise einen beliebigen Wert, Zelle C7 ist hingegen leer, 

so gilt: 

ISTLEER(A1) ergibt FALSCH 

ISTLEER(C7) ergibt WAHR 

Siehe auch: 

ISTNV, ANZAHL, ANZAHL2 

ISTLOG (Ist Wahrheitswert?) 

Syntax: 

ISTLOG(Zelle) 
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Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle einen Wahrheitswert 

(WAHR oder FALSCH) enthält. 

Beispiel: 

Enthält Zelle A1 einen Wahrheitswert, oder eine Berechnung, die einen Wahr-

heitswert liefert, Zelle C7 hingegen Text, so gilt: 

ISTLOG(A1) ergibt WAHR 

ISTLOG(C7) ergibt FALSCH 

Siehe auch: 

ISTTEXT, ISTZAHL 

ISTNV (Ist nicht vorhanden?) 

Syntax: 

ISTNV(Zelle) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle den Fehlerwert #NV 

(„nicht vorhanden“) liefert.  

Eine Zelle liefert diesen Fehlerwert dann, wenn darin die Funktion NV() eingetra-

gen wurde oder die Zelle eine Berechnung enthält, die den Fehler #NV liefert. 

Informationen über die Verwendung des Fehlerwerts #NV finden Sie bei der Be-

schreibung der Funktion NV (Nicht vorhanden) ab Seite 625. 

Beispiel: 

In Zelle A1 wurde die Funktion NV() eingetragen, um zu kennzeichnen, dass hier 

ein für eine andere Berechnung zwingend erforderlicher Wert noch nicht vorhan-

den ist.  
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Zelle C7 führt eine Berechnung mit Zelle A1 durch, zum Beispiel A1*2. Da Zelle 

A1 aber den Fehlerwert #NV liefert, ist das Ergebnis dieser Berechnung ebenfalls 

der Fehlerwert #NV. 

Hier gilt also: 

ISTNV(A1) ergibt WAHR 

ISTNV(C7) ergibt ebenfalls WAHR 

Siehe auch: 

NV(), FEHLER.TYP, ISTFEHL, ISTFEHLER, WENNFEHLER, Abschnitt über 

„Fehlerwerte“ ab Seite 448 

ISTTEXT (Ist eine Zeichenkette?) 

Syntax: 

ISTTEXT(Zelle) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle eine Zeichenkette 

enthält. 

Beispiel: 

Enthält Zelle A1 eine feste Zeichenkette oder eine Berechnung, die eine Zeichen-

kette liefert, Zelle C7 hingegen eine Zahl, so gilt: 

ISTTEXT(A1) ergibt WAHR 

ISTTEXT(C7) ergibt FALSCH 

Siehe auch: 

ISTKTEXT, ISTLOG, ISTZAHL 
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Anmerkung: 

ISTKTEXT ist das Gegenstück zu dieser Funktion: Sie liefert WAHR, wenn sich in 

der Zelle keine Zeichenkette befindet. 

ISTUNGERADE (Ist eine ungerade Zahl?) 

Syntax: 

ISTUNGERADE(Zahl) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn Zahl eine ungerade Zahl ist.  

Hinweis: 

Zahl sollte eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker die 

Nachkommastellen automatisch. 

Beispiel: 

ISTUNGERADE(1) ergibt WAHR 

ISTUNGERADE(1,75) ergibt WAHR 

ISTUNGERADE(2) ergibt FALSCH 

ISTUNGERADE(2,75) ergibt FALSCH 

Siehe auch: 

ISTGERADE 
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ISTZAHL (Ist eine Zahl?) 

Syntax: 

ISTZAHL(Zelle) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle eine Zahl enthält. 

Datumsangaben werden ebenfalls als Zahlen betrachtet; Wahrheitswerte (WAHR 

und FALSCH) hingegen nicht. 

Beispiel: 

Die Zellen A1 bis A4 enthalten folgende Werte:  

"Text", 42, 25.09.2013 und WAHR 

Hier gilt: 

ISTZAHL(A1) ergibt FALSCH 

ISTZAHL(A2) ergibt WAHR 

ISTZAHL(A3) ergibt WAHR 

ISTZAHL(A4) ergibt FALSCH 

Siehe auch: 

ISTZAHLP, ISTLOG, ISTTEXT, ISTKTEXT 

ISTZAHLP (PlanMaker 97-Kompatibilitätsfunktion) 

Syntax: 

ISTZAHLP(Zelle) 
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Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle eine Zahl oder einen 

Wahrheitswert enthält. 

Datumsangaben werden ebenfalls als Zahlen betrachtet. 

Hinweis: 

Diese Funktion ist nur aus Kompatibilitätsgründen zu PlanMaker 97 noch vorhan-

den. Verwenden Sie diese Funktion möglichst nicht mehr, sondern stattdessen die 

Excel-kompatible Funktion ISTZAHL (ohne „P“). 

Der Unterschied: 

ISTZAHLP betrachtet auch Wahrheitswerte als Zahlen, ISTZAHL hingegen nicht. 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

Die Zellen A1 bis A4 enthalten folgende Werte:  

"Text", 42, 25.09.2013 und WAHR 

Hier gilt: 

ISTZAHLP(A1) ergibt FALSCH 

ISTZAHLP(A2) ergibt WAHR 

ISTZAHLP(A3) ergibt WAHR 

ISTZAHLP(A4) ergibt WAHR (!) 

Zum Vergleich: ISTZAHL(A4) ergibt hingegen FALSCH 

Siehe auch: 

ISTZAHL 
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JAHR (Jahr aus einem Datumswert ermitteln) 

Syntax: 

JAHR(Datum) 

Beschreibung: 

Liefert die Jahreszahl eines Datumswerts. 

Beispiel: 

JAHR("25.9.2013") ergibt 2013 

Siehe auch: 

ISOWOCHE, KALENDERWOCHE, MONAT, TAG, WOCHENTAG 

JETZT (Aktuelles Datum, aktuelle Uhrzeit) 

Syntax: 

JETZT() 

Beschreibung: 

Liefert das aktuelle Datum und die aktuelle Uhrzeit. 

Das Ergebnis ist – wie alle Datumsangaben in einer Tabellenkalkulation – eine 

Zahl. PlanMaker weist ihr automatisch das Zahlenformat „Datum/Zeit“ im Format 

hh:mm:ss zu, damit sie als Uhrzeit angezeigt wird. 

Das Ergebnis enthält allerdings auch das Datum. Formatieren Sie die Zelle also 

zum Beispiel in das Zahlenformat TT.MM.JJJJ hh:mm um, wird das aktuelle Da-

tum und die aktuelle Uhrzeit angezeigt. 
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Siehe auch: 

HEUTE 

KALENDERWOCHE (Kalenderwoche) 

Syntax: 

KALENDERWOCHE(Datum [; Wochenbeginn]) 

Beschreibung: 

Ermittelt, in der wievielten Kalenderwoche eines Jahres sich ein Datum befindet. 

Hierbei wird die in den USA und vielen anderen Teilen der Welt übliche Rechen-

methode angewandt: Als erste Kalenderwoche des Jahres gilt stets die Woche, die 

den 1. Januar enthält. 

Hinweis: 

In Deutschland wird normalerweise nach einer anderen Methode gerechnet; hier 

folgt man der ISO-Norm (siehe Funktion ISOWOCHE). 

Wichtig: 

Beachten Sie außerdem, dass diese Funktion standardmäßig den Sonntag als Wo-

chenbeginn ansieht – nicht den Montag. 

Mit dem optionalen Argument Wochenbeginn können Sie dies allerdings ändern. 

Für Wochenbeginn sind folgende Werte zulässig: 

1 oder nicht angegeben: Woche beginnt am Sonntag 

2: Woche beginnt am Montag 

Beispiel: 

Am Sonntag, dem 4.1.2004 gilt: 

KALENDERWOCHE("4.1.2004"; 1) ergibt 2 
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KALENDERWOCHE("4.1.2004"; 2) ergibt 1 

Siehe auch: 

ISOWOCHE, JAHR, MONAT, TAG, WOCHENTAG 

KAPZ (Kapitalrückzahlung) 

Syntax: 

KAPZ(Zins; Zr; Zzr; Bw [; Zw] [; Fälligkeit]) 

Beschreibung: 

Liefert den Tilgungsanteil der Zahlung in der angegebenen Periode, basierend auf 

einer Investition mit regelmäßigen konstanten Zahlungen und feststehendem Zins. 

Sie können mit dieser Funktion beispielsweise berechnen, wie groß bei einem Kre-

dit der Tilgungsanteil der Annuität in einer bestimmten Periode ist.  

„Periode“ bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen 

Rückzahlungen ist die dritte Periode beispielsweise der dritte Monat. 

Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode) 

Zr = die zu betrachtende Periode 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 

Bw = Barwert (der anfängliche Betrag) 

Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zah-

lung erreichen möchten. Wenn Sie das Argument Zw nicht angeben, wird es auf 

Null gesetzt. 

Fälligkeit (optional) = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 
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Beispiel: 

Es wird ein Kredit über € 100.000,- zu folgenden Bedingungen aufgenommen: 

Jahreszins: 10% 

Rückzahlungen: monatlich 

Laufzeit: 6 Jahre 

Wie groß ist der Tilgungsanteil der Zahlung in Monat 32? 

KAPZ(10%/12; 32; 6*12; 100000) ergibt -1.318 Euro. 

Beachten Sie dabei, dass alle Angaben auf der gleichen Zeiteinheit basieren müs-

sen – hier also auf Monaten, da die Rückzahlungen monatlich erfolgen.  

Deshalb wurde in der obigen Formel der Jahreszins durch 12 geteilt (um den Zins 

pro Monat zu erhalten) und die Laufzeit mit 12 multipliziert (um die Laufzeit in 

Monaten zu erhalten). 

Siehe auch: 

BW, ISPMT, KUMKAPITAL, KUMZINSZ, RMZ, ZINS, ZINSZ, ZW, ZZR 

Anmerkung: 

Die Funktion ZINSZ ist das Gegenstück zu KAPZ: Sie liefert den Zinsanteil der 

Zahlung in dieser Periode.  

Die Funktion RMZ hingegen liefert den Gesamtbetrag der Zahlung (Annuität) pro 

Periode, also die Summe von Tilgungsanteil und Zinsanteil. 

KGRÖSSTE (k-größter Wert) 

Syntax: 

KGRÖSSTE(Bereich; k) 

Beschreibung: 

Liefert den k-größten Wert einer Zahlenmenge. Der 1-größte Wert ist der größte 

Wert, der 2-größte ist der zweitgrößte Wert etc. 
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Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf 

einen Zellbereich, in dem Zahlen eingetragen sind. 

k bestimmt, die „wievielt-größte“ Zahl geliefert werden soll. 

k darf nicht kleiner als 1 oder größer als die Anzahl an Zahlen in Bereich sein, 

andernfalls liefert die Funktion den Fehlerwert #ZAHL!. 

Beispiel: 

Sind in den Zellen A1:A5 die Zahlen 4, 2, 6, 5, 9 eingetragen, so gilt: 

KGRÖSSTE(A1:A5; 1) ergibt 9 

KGRÖSSTE(A1:A5; 2) ergibt 6 

KGRÖSSTE(A1:A5; 3) ergibt 5 

etc. 

Siehe auch: 

KKLEINSTE, MAX, QUANTIL, QUANTILSRANG, RANG 

KGV (Kleinstes gemeinsames Vielfaches) 

Syntax: 

KGV(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Ermittelt das kgV („kleinstes gemeinsames Vielfaches“) einer Menge von Zahlen. 

Das kgV ist die kleinste all derjenigen ganzen Zahlen, die ein Vielfaches der Ar-

gumente sind. 

Als Argumente können Zahlen oder Zellbezüge übergeben werden. 

Alle übergebenen Zahlen müssen größer gleich 1 sein. Weiterhin sollten nur ganze 

Zahlen verwendet werden. Ist dies nicht der Fall, schneidet PlanMaker die Nach-

kommastellen automatisch ab. 
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Beispiel: 

KGV(5; 10; 15) ergibt 30 

Sind die Zellen A1 bis A3 mit den Werten 4, 8 und 6 gefüllt, so gilt: 

KGV(A1:A3) ergibt 24 

Siehe auch: 

GGT 

KKLEINSTE (k-kleinster Wert) 

Syntax: 

KKLEINSTE(Bereich; k) 

Beschreibung: 

Liefert den k-kleinsten Wert einer Zahlenmenge. Der 1-kleinste Wert ist der kleins-

te Wert, der 2-kleinste ist der zweitkleinste Wert etc. 

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf 

einen Zellbereich, in dem Zahlen eingetragen sind. 

k bestimmt, die „wievielt-kleinste“ Zahl geliefert werden soll. 

k darf nicht kleiner als 1 oder größer als die Anzahl an Zahlen in Bereich sein, 

andernfalls liefert die Funktion den Fehlerwert #ZAHL!. 

Beispiel: 

Sind in den Zellen A1:A5 die Zahlen 4, 2, 6, 5, 9 eingetragen, so gilt: 

KKLEINSTE(A1:A5; 1) ergibt 2 

KKLEINSTE(A1:A5; 2) ergibt 4 

KKLEINSTE(A1:A5; 3) ergibt 5 

etc. 
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Siehe auch: 

KGRÖSSTE, MIN, QUANTIL, QUANTILSRANG, RANG 

KLEIN (In Kleinbuchstaben wandeln) 

Syntax: 

KLEIN(Zeichenkette) 

Beschreibung: 

Wandelt alle Buchstaben einer Zeichenkette in Kleinbuchstaben um. 

Beispiel: 

KLEIN("PlanMaker") ergibt planmaker 

Siehe auch: 

GROSS, GROSS2 

KOMBINATIONEN (Kombinationen) 

Syntax: 

KOMBINATIONEN(n; k) 

Beschreibung: 

Ermittelt die Anzahl der ungeordneten Stichproben vom Umfang k, die man einer 

Gesamtheit von n verschiedenen Elementen ohne Zurücklegen entnehmen kann. 

Im Klartext: Es stehen insgesamt n Elemente zur Verfügung. Aus diesen soll eine 

Teilmenge von genau k Elementen gezogen werden. Diese Funktion berechnet, wie 

viele unterschiedliche Teilmengen es hierbei geben kann. 
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n gibt an, aus wie vielen Elementen die Gesamtheit besteht. n muss größer als k 

sein. 

k gibt an, wie viele Elemente in einer Stichprobe gezogen werden sollen. k muss 

größer als 0 und kleiner als n sein. 

n und k sollten ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker die 

Nachkommastellen automatisch weg. 

Beispiel: 

Betrachten wir eine Lotterie, bei der 6 aus 49 verschiedenen Kugeln gezogen wer-

den. 

Um zu berechnen, wie viele Kombinationen hierbei möglich sind, würde man 

schreiben: 

KOMBINATIONEN(49; 6) 

Es gibt also 13.983.816 Kombinationsmöglichkeiten. 

Siehe auch: 

VARIATIONEN 

KOMPLEXE (Komplexe Zahl bilden) 

Syntax: 

KOMPLEXE(Realteil; Imaginärteil [; Suffix]) 

Beschreibung: 

Bildet aus dem angegebenen Realteil und Imaginärteil eine komplexe Zahl in der 

Form x+yi oder x+yj. 

Mit Suffix können Sie bei Bedarf bestimmen, welcher Buchstabe für die imaginäre 

Einheit verwendet werden soll: entweder "i" oder "j" (Kleinbuchstabe!). Wird Suf-

fix nicht angegeben, wird automatisch "i" verwendet. 
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Tipp: 

Um komplexe Zahlen in Tabellenzellen einzugeben, benötigen Sie die Funktion 

KOMPLEXE eigentlich nicht, sondern können den Wert auch einfach eintippen. 

Wenn Sie in eine Zelle also zum Beispiel die komplexe Zahl 2+4i eintragen möch-

ten, müssen Sie nicht =KOMPLEXE(2;4) eingeben, sondern können einfach 2+4i 

tippen. 

Auch in Formeln lassen sich komplexe Zahlen einfach eintippen. Wichtig: Umge-

ben Sie die komplexe Zahl dabei mit doppelten Anführungszeichen. Statt 

=IMAPOTENZ(KOMPLEXE(2;4)) können Sie also auch einfach 

=IMAPOTENZ("2+4i") schreiben. 

Beispiel: 

KOMPLEXE(2;4) ergibt 2+4i 

KOMPLEXE(2;4;"i") ergibt ebenfalls 2+4i 

KOMPLEXE(2;4;"j") ergibt 2+4j 

Siehe auch: 

IMAGINÄRTEIL, IMREALTEIL 

KONFIDENZ (Konfidenzintervall) 

Syntax: 

KONFIDENZ(Alpha; Sigma; n) 

Beschreibung: 

Ermöglicht die Bestimmung des 1-Alpha-Konfidenzintervalls für den Erwartungs-

wert (= Mittelwert) einer Wahrscheinlichkeitsverteilung. 

Das 1-Alpha-Konfidenzintervall ist ein symmetrischer Bereich um den Mittelwert 

einer Stichprobe, das den Mittelwert der Grundgesamtheit mit einer Wahrschein-

lichkeit von 1-Alpha enthält. 

Alpha ist die Irrtumswahrscheinlichkeit. Zulässig sind nur Werte aus dem Intervall 

[0..1]. 
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Ist Alpha beispielsweise 0,05 (also 5%), so ist die Wahrscheinlichkeit, dass der 

tatsächliche Mittelwert außerhalb des mit Hilfe der KONFIDENZ-Funktion ermit-

telten Intervalls liegt, 5%. Man spricht hier vom 95%-Konfidenzintervall. 

Sigma ist die Standardabweichung der Grundgesamtheit. Sie muss größer als Null 

sein. 

n gibt den Umfang der Stichprobe an. Dieser muss größer als Null sein. 

Beispiel: 

In einem Schweinezuchtbetrieb soll das Durchschnittsgewicht von 1000 Ferkeln 

bestimmt werden. Dazu wird eine Stichprobe (mit Zurücklegen) vom Umfang 

n=65 genommen. Das dabei ermittelte Durchschnittsgewicht liegt bei 30 kg. Die 

Standardabweichung beträgt 1,6 kg. 

Es soll nun das 95%-Konfidenzintervall (Alpha ist hier also 0,05) ermittelt werden. 

Man würde also berechnen: 

KONFIDENZ(0,05; 1,6; 65) ergibt 0,38897 (kg) 

Das Durchschnittsgewicht der Grundgesamtheit (= aller 1000 Schweine) liegt also 

mit einer Wahrscheinlichkeit von 95% zwischen 30-0,38897 kg und 30+0,38897 

kg. 

KORREL (Korrelationskoeffizient) 

Syntax: 

KORREL(Bereich1; Bereich2) 

Beschreibung: 

Berechnet den Korrelationskoeffizienten von zwei Datengruppen. 

Der Korrelationskoeffizient ist ein Maß für die wechselseitige Beziehung zwischen 

den Datengruppen. 

Bereich1 und Bereich2 sind Zellbezüge auf die beiden Datengruppen. Leere Zel-

len sowie Zeichenketten und Wahrheitswerte werden ignoriert. 

Die Datengruppen müssen die gleiche Anzahl an Werten besitzen, ansonsten liefert 

die Funktion den Fehlerwert #NV. 
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Beispiel: 

Sind die Zellen A1 bis A3 mit den Werten 2, 5, 3 und die Zellen B1 bis B3 mit den 

Werten 2, 7, 4 gefüllt, so gilt: 

KORREL(A1:A3; B1:B3) ergibt 0,99718 

Siehe auch: 

FISHER, KOVAR 

KOVAR (Kovarianz) 

Syntax: 

KOVAR(Bereich1; Bereich2) 

Beschreibung: 

Berechnet die Kovarianz zweier Datengruppen. 

Die Kovarianz ist ein Maß für die gemeinsame lineare Streuung der Datengruppen. 

Sie wird aus dem Mittelwert der Produkte der Abweichungen der Wertepaare um 

das arithmetische Mittel gebildet. 

Bereich1 und Bereich2 sind Zellbezüge auf die beiden Datengruppen. Diese müs-

sen ganze Zahlen enthalten. Leere Zellen sowie Zeichenketten und Wahrheitswerte 

werden ignoriert. 

Die Datengruppen müssen die gleiche Anzahl an Werten besitzen, ansonsten liefert 

die Funktion den Fehlerwert #NV. 

Beispiel: 

Sind die Zellen A1 bis A3 mit den Werten 2, 5, 3 und die Zellen B1 bis B3 mit den 

Werten 2, 7, 4 gefüllt, so gilt: 

KOVAR(A1:A3; B1:B3) ergibt 2,55556 
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Siehe auch: 

FISHER, KORREL 

KRITBINOM 

Syntax: 

KRITBINOM(n; p; Alpha) 

Beschreibung: 

Liefert den kleinsten Wert für eine binomialverteilte Zufallsvariable, bei dem die 

angegebene Irrtumswahrscheinlichkeit Alpha nicht überschritten wird. 

Es wird also berechnet, wie oft ein bestimmtes Ereignis mit der Wahrscheinlichkeit 

p beim Durchführen einer Stichprobe mit n Wiederholungen höchstens eintreten 

darf, bevor seine kumulierten Wahrscheinlichkeiten einen Wert größer oder gleich 

der Irrtumswahrscheinlichkeit Alpha annehmen. 

Diese Funktion ist nur bei Binomialverteilungen anwendbar (siehe auch Funktion 

BINOMVERT); es muss sich also um unabhängige Ziehungen handeln, bei denen 

nur zwei Ergebnisse möglich sind: Erfolg (Ereignis tritt ein) oder Fehlschlag (Er-

eignis tritt nicht ein). 

n ist die Anzahl der durchgeführten Versuche. 

p ist die Wahrscheinlichkeit des Erfolgs pro Wiederholung. Zulässig sind nur Werte 

aus dem Intervall [0..1]. 

Alpha ist die Irrtumswahrscheinlichkeit, die nicht überschritten werden darf. Zu-

lässig sind nur Werte aus dem Intervall [0..1]. 

Beispiel: 

Aus früheren Lieferungen ist ihnen bekannt, dass normalerweise 7% eines be-

stimmten elektronischen Bauteils defekt sind. Um diese Aussage zu überprüfen, 

führen Sie bei einer neuen Lieferung eine Stichprobe von 100 Bauteilen durch. Wie 

viele davon dürfen höchstens defekt sein, wenn die Irrtumswahrscheinlichkeit 1% 

nicht überschreiten soll? 

KRITBINOM(100; 7%; 1%) ergibt 2 
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Siehe auch: 

BINOMVERT 

KUMKAPITAL (Kumulierte Kapitalrückzahlungen) 

Syntax: 

KUMKAPITAL(Zins; Zzr; Bw; z1; z2; Fälligkeit) 

Beschreibung: 

Ermittelt die Summe der zwischen Periode z1 und z2 fälligen Kapitalrückzahlun-

gen (Tilgungsanteile), basierend auf einer Investition mit regelmäßigen konstanten 

Zahlungen und feststehendem Zins. 

Sie können mit dieser Funktion beispielsweise berechnen, wie groß bei einem Kre-

dit der Tilgungsanteil der Annuitäten in den angegebenen Perioden ist.  

„Periode“ bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen 

Rückzahlungen ist die dritte Periode beispielsweise der dritte Monat. 

Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode). 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 

Bw = Barwert (der anfängliche Betrag) 

z1; z2 = der zu betrachtende Zeitraum: z1 ist die erste zu berücksichtigende Perio-

de, z2 die letzte. (Die Perioden sind mit 1 beginnend durchnummeriert.) 

Fälligkeit = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 

Beispiel: 

Es wird ein Kredit über € 100.000,- zu folgenden Bedingungen aufgenommen: 

Jahreszins: 10% 
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Zahlungen: monatlich, jeweils am Monatsende 

Laufzeit: 6 Jahre 

Wie groß ist der Tilgungsanteil der Zahlungen in den Perioden (=Monaten) 24 bis 

36 insgesamt? 

KUMKAPITAL(10%/12; 6*12; 100000; 24; 36; 0) ergibt -16863,71 Euro. 

Beachten Sie dabei, dass alle Angaben auf der gleichen Zeiteinheit basieren müs-

sen – hier also auf Monaten, da die Zahlungen monatlich erfolgen.  

Deshalb wurde in der obigen Formel der Jahreszins durch 12 geteilt (um den Zins 

pro Monat zu erhalten) und die Laufzeit mit 12 multipliziert (um die Laufzeit in 

Monaten zu erhalten). 

Siehe auch: 

KUMZINSZ, KAPZ, ZINSZ, RMZ 

Anmerkung: 

Die Funktion KUMZINSZ ist das Gegenstück zu KUMKAPITAL: Sie liefert die 

Summe der Zinsanteile. 

KUMZINSZ (Kumulierte Zinszahlungen) 

Syntax: 

KUMZINSZ(Zins; Zzr; Bw; z1; z2; Fälligkeit) 

Beschreibung: 

Ermittelt die Summe der zwischen Periode z1 und z2 fälligen Zinszahlungen, ba-

sierend auf einer Investition mit regelmäßigen konstanten Zahlungen und festste-

hendem Zins. 

Sie können mit dieser Funktion beispielsweise berechnen, wie groß bei einem Kre-

dit der Zinsanteil der Annuitäten in den angegebenen Perioden ist.  

„Periode“ bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen 

Rückzahlungen ist die dritte Periode beispielsweise der dritte Monat. 
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Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode). 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 

Bw = Barwert (der anfängliche Betrag) 

z1; z2 = der zu betrachtende Zeitraum: z1 ist die erste zu berücksichtigende Perio-

de, z2 die letzte. (Die Perioden sind mit 1 beginnend durchnummeriert.) 

Fälligkeit = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 

Beispiel: 

Es wird ein Kredit über € 100.000,- zu folgenden Bedingungen aufgenommen: 

Jahreszins: 10% 

Zahlungen: monatlich, jeweils am Monatsende 

Laufzeit: 6 Jahre 

Wie groß ist der Zinsanteil der Zahlungen in den Perioden (=Monaten) 24 bis 36 

insgesamt? 

KUMZINSZ(10%/12; 6*12; 100000; 24; 36; 0) ergibt -7219,88 Euro. 

Beachten Sie dabei, dass alle Angaben auf der gleichen Zeiteinheit basieren müs-

sen – hier also auf Monaten, da die Zahlungen monatlich erfolgen.  

Deshalb wurde in der obigen Formel der Jahreszins durch 12 geteilt (um den Zins 

pro Monat zu erhalten) und die Laufzeit mit 12 multipliziert (um die Laufzeit in 

Monaten zu erhalten). 

Siehe auch: 

KUMKAPITAL, KAPZ, ZINSZ, RMZ 
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Anmerkung: 

Die Funktion KUMKAPITAL ist das Gegenstück zu KUMZINSZ: Sie liefert die 

Summe der Tilgungsanteile. 

KURT (Kurtosis einer Verteilung) 

Syntax: 

KURT(Zahl1; Zahl2; Zahl3; Zahl4 [; Zahl5 ...]) 

oder 

KURT(Bereich1; Bereich2 [; Bereich3 ...]) 

Beschreibung: 

Berechnet die Kurtosis („Gipfligkeit“) einer Wahrscheinlichkeitsverteilung. 

Die Kurtosis ist ein Maß für die Wölbung der Dichtefunktion einer Verteilung im 

Vergleich zur Dichtefunktion der Normalverteilung. 

Bei einer steiler gewölbten („schmalgipfligen“) Verteilung ist die Kurtosis ein posi-

tiver Wert, bei flacher gewölbten („breitgipfligen“) Kurve ein negativer Wert.  

Wenn sich die Kurtosis Null annähert, entspricht die betrachtete Verteilung in guter 

Näherung einer Normalverteilung (siehe Funktion NORMVERT). 

Zahl1, Zahl2, Zahl3, Zahl4 etc. sind die Werte der Verteilung, deren Kurtosis 

berechnet werden soll. Leere Zellen sowie Zeichenketten und Wahrheitswerte wer-

den ignoriert. 

Es müssen mindestens vier Werte angegeben sein; andernfalls liefert die Funktion 

den Fehlerwert #DIV/0! (Division durch Null). 

Hinweis: 

Diese Funktion erwartet als Argumente keine Wertepaare (x-Wert und y-Wert), 

sondern nur die Werte der Verteilung. Mehrmals vorkommende Werte müssen ent-

sprechend oft wiederholt werden (siehe Beispiel). 
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Beispiel: 

Sie messen die Körpergrößen einer Gruppe von Personen und erhalten dabei fol-

gende Ergebnisse: 1 x 1,60m, 2 x 1,65m, 4 x 1,70m, 2 x 1,75m und 1x1,80m.  

Die Verteilung (Dichtefunktion) dieser Messergebnisse hat folgende Gipfligkeit: 

KURT(1,60; 1,65; 1,65; 1,70; 1,70; 1,70; 1,70; 1,75; 1,75; 1,80) ergibt 0,08036. 

Siehe auch: 

SCHIEFE, NORMVERT 

KÜRZEN (Zahl auf n Nachkommastellen kürzen) 

Syntax: 

KÜRZEN(Zahl [; n]) 

Beschreibung: 

Kürzt eine Zahl auf n Nachkommastellen (ohne zu runden). 

n ist die gewünschte Anzahl an Nachkommastellen.  

Wird n nicht angegeben, wird die Zahl auf 0 Nachkommastellen gekürzt. 

n darf auch ein negativer Wert sein, worauf auch der ganzzahlige Teil der Zahl ge-

kürzt wird (siehe letztes Beispiel). 

Beispiel: 

KÜRZEN(5,779) ergibt 5 

KÜRZEN(5,779; 2) ergibt 5,77 

KÜRZEN(1234; -2) ergibt 1200 

Siehe auch: 

ABRUNDEN, AUFRUNDEN, NACHKOMMA, RUNDEN 
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Anmerkung: 

Die Nachkommastellen erhalten Sie mit der Funktion NACHKOMMA. 

LÄNGE (Länge einer Zeichenkette) 

Syntax: 

LÄNGE(Wert) 

Beschreibung: 

Ermittelt, aus wie vielen Zeichen der übergebene Wert besteht.  

Wenn der übergebene Wert eine Zahl, ein Datum oder ein Wahrheitswert ist, wird 

er in eine Zeichenkette konvertiert. 

Beachten Sie: Bei Datumsangaben wird die serielle Datumszahl in eine Zeichen-

kette konvertiert, nicht das formatierte Datum selbst (siehe letztes Beispiel). 

Beispiel: 

LÄNGE("Text") ergibt 4 

LÄNGE(42) ergibt 2 

LÄNGE(-42) ergibt 3 

LÄNGE(42,5) ergibt 4 

LÄNGE(42,50) ergibt ebenfalls 4 (die überflüssige Null wird automatisch ent-

fernt!) 

LÄNGE(WAHR) ergibt 4 

Beachten Sie: Wenn in Zelle A1 das Datum 25.09.2008 in einer beliebigen Forma-

tierung steht, so gilt: 

LÄNGE(A1) ergibt 5 

Grund: Datumswerte werden in einer Tabellenkalkulation stets als Zahlen gespei-

chert – das Datum 25.09.2008 beispielsweise als 39716. Insofern ist das Ergebnis 

der Berechnung zwar unerwartet, aber völlig korrekt – denn: 
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LÄNGE(39716) ergibt ebenfalls 5 

Siehe auch: 

LINKS, RECHTS, TEIL 

LAUFZEIT (Laufzeit) 

Syntax: 

LAUFZEIT(Zins; Bw; Zw) 

Beschreibung: 

Ermittelt den Zeitraum (die Anzahl an Perioden), der benötigt wird, um mit einer 

festverzinslichen Anlage einen bestimmten Betrag zu erreichen.  

Es werden keine regelmäßigen Zahlungen geleistet; es gibt also nur eine einzige 

Einzahlung am Beginn der Laufzeit. 

Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode) 

Bw = Barwert (der anfängliche Betrag) 

Zw = Zukünftiger Wert (der Zielwert) 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Tipp: Sie können Berechnungen mit der Funktion LAUFZEIT wie folgt mit Excel-

kompatiblen Funktionen durchführen: 

Laufzeit(Zins; Bw; Zw) entspricht ZZR(Zins; 0; Bw; -Zw) 

Beachten Sie dabei das Minuszeichen vor Zw! 



 

Handbuch PlanMaker Formeln und Funktionen    593 

Beispiel: 

Sie möchten mit einer Anlage von € 3000,- auf eine Auszahlung von € 5000,- 

kommen. Der Zinssatz beträgt 6% pro Jahr. Wie viele Perioden (= Jahre) werden 

dafür benötigt? 

LAUFZEIT(6%; 3000; 5000) ergibt 8,76669 (Jahre) 

Siehe auch: 

ZGZ 

LIA (Lineare Abschreibung) 

Syntax: 

LIA(AW; RW; ND) 

Beschreibung: 

Liefert den Wert der linearen Abschreibung eines Objekts pro Periode. 

AW = Anschaffungskosten des Objekts 

RW = Restwert des Objekts am Ende der Nutzungsdauer 

ND = Nutzungsdauer (Anzahl der Perioden, über die das Objekt abgeschrieben 

wird) 

Beispiel: 

LIA(6000; 3000; 5) ergibt 600 

Siehe auch: 

DIA, GDA 
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LINKS (Teil einer Zeichenkette) 

Syntax: 

LINKS(Zeichenkette [; n]) 

Beschreibung: 

Liefert die ersten n Zeichen einer Zeichenkette. 

Ist n nicht angegeben, liefert die Funktion nur das erste Zeichen. 

Beispiel: 

LINKS("Tiergarten"; 4) ergibt Tier 

LINKS("Tiergarten") ergibt T 

Siehe auch: 

RECHTS, TEIL, ERSETZEN 

LN (Natürlicher Logarithmus) 

Syntax: 

LN(Zahl) 

Beschreibung: 

Liefert den natürlichen Logarithmus (Basis e) einer Zahl. 

Die übergebene Zahl muss größer als Null sein. 

Anmerkung: 

Die Umkehrfunktion zu dieser Funktion ist EXP. 
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Beispiel: 

LN(0,7) ergibt -0,3567 

LN(EXP(1,234)) ergibt 1,234 

Siehe auch: 

LOG, LOG10, EXP 

LOG (Logarithmus) 

Syntax: 

LOG(Zahl [; Basis]) 

Beschreibung: 

Liefert den Logarithmus einer Zahl zur angegebenen Basis.  

Die übergebene Zahl muss größer als Null sein. 

Ist das Argument Basis nicht angegeben, wird als Basis 10 verwendet. 

Beispiel: 

LOG(100) entspricht log 10 (100), ergibt also 2 

LOG(10 ^ 0,1234) ergibt 0,1234 

LOG(8; 2) entspricht log 2 (8), ergibt also 3 

Siehe auch: 

LOG10, LN 
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LOG10 (Zehnerlogarithmus) 

Syntax: 

LOG10(Zahl) 

Beschreibung: 

Liefert den Zehnerlogarithmus (dekadischer Logarithmus) einer Zahl, also den 

Logarithmus zur Basis 10. 

Die übergebene Zahl muss größer als Null sein. 

Beispiel: 

LOG10(100) ergibt 2 

LOG10(10 ^ 0,1234) ergibt 0,1234 

Siehe auch: 

LOG, LN 

LOGINV (Quantile einer Lognormalverteilung) 

Syntax: 

LOGINV(Wahrscheinlichkeit; Mittelwert; Standardabweichung) 

Beschreibung: 

Liefert Quantile einer logarithmischen Normalverteilung („Lognormalverteilung“). 

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Lognormalvertei-

lung. Zulässig sind nur Werte aus dem Intervall [0..1]. 

Mittelwert ist der Mittelwert von LN(x). 
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Standardabweichung ist die Standardabweichung von LN(x). Diese muss größer 

als Null sein. 

Siehe auch: 

LN, LOGNORMVERT 

LOGNORMVERT (Logarithmische Normalverteilung) 

Syntax: 

LOGNORMVERT(x; E; S) 

Beschreibung: 

Liefert die Wahrscheinlichkeiten einer logarithmisch normalverteilten Zufallsvari-

ablen. 

Sie können mit dieser Funktion Wahrscheinlichkeitsverteilungen betrachten, bei 

denen nicht die Zufallsvariable selbst, sondern ihr natürlicher Logarithmus nor-

malverteilt ist. 

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. x muss größer als 

Null sein. 

Für E ist der Erwartungswert  (My) der Verteilung anzugeben. 

Für S ist die Standardabweichung  (Sigma) der Verteilung anzugeben. S muss 

größer als Null sein. 

Anmerkung: 

Geliefert wird die Verteilungsfunktion (also die integrierte Dichtefunktion). 

Siehe auch: 

LN, LOGINV, NORMVERT, STANDNORMVERT 



 

598    Formeln und Funktionen Handbuch PlanMaker 

MAX (Maximalwert) 

Syntax: 

MAX(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Liefert den größten Wert innerhalb der angegebenen Zahlen. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Beispiel: 

MAX(5; 7; 4; 9) ergibt 9 

Wenn die Zellen A1 bis A3 mit den Werten -1, -2 und WAHR gefüllt sind, so gilt: 

MAX(A1:A3) ergibt -1 (der Wahrheitswert WAHR wird ignoriert) 

Siehe auch: 

MAXA, MIN, KGRÖSSTE 

MAXA (Maximalwert) 

Syntax: 

MAXA(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Die Funktion MAXA entspricht nahezu der Funktion MAX (siehe Hinweis). Sie 

liefert also den größten Wert innerhalb der angegebenen Zahlen. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 
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Hinweis: 

Im Gegensatz zu MAX berücksichtigt die Funktion MAXA auch Werte, die keine 

Zahlen sind: Beliebige Zeichenketten und der Wahrheitswert FALSCH werden als 

0 interpretiert, WAHR als 1. 

Leere Zellen werden hingegen auch hier ignoriert. 

Beispiel: 

MAXA(5; 7; 4; 9) ergibt 9 

Wenn die Zellen A1 bis A3 mit den Werten -1, -2 und WAHR gefüllt sind, so gilt: 

MAXA(A1:A3) ergibt 1 (denn WAHR = 1) 

MAX(A1:A3) ergibt hingegen -1 (denn der Wahrheitswert WAHR wird bei der 

Funktion MAX ignoriert) 

Siehe auch: 

MAX 

MDET (Determinante einer Matrix) 

Syntax: 

MDET(Matrix) 

Beschreibung: 

Liefert die Determinante einer quadratischen Matrix. 

Matrix kann eine Matrix oder ein entsprechender Zellbezug sein. Matrix muss 

numerische Werte enthalten und quadratisch sein, also die gleiche Anzahl an Zeilen 

und Spalten besitzen. 

Beispiel: 

MDET({9.8.8; 2.4.6; 1.2.1}) ergibt -40 
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Siehe auch: 

Abschnitt „Arbeiten mit Matrizen“ ab Seite 450, MINV, MMULT, MSOLVE, 

MTRANS 

MEDIAN (Median) 

Syntax: 

MEDIAN(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Liefert den Median der angegebenen Zahlen. 

Der Median ist die Zahl, die in der Mitte einer Reihe von Zahlen liegt. Die Hälfte 

dieser Zahlen hat also Werte, die kleiner sind als der Median, die andere Hälfte 

Werte, die größer sind. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Beachten Sie: 

Ist eine ungerade Anzahl an Werten gegeben, liefert MEDIAN die Zahl in der Mit-

te. 

Ist eine ungerade Anzahl an Werten gegeben, liefert MEDIAN den Mittelwert der 

beiden in der Mitte liegenden Zahlen (siehe zweites Beispiel). 

Beispiel: 

MEDIAN(1; 2; 3; 4; 5) ergibt 3 

MEDIAN(1; 2; 3; 4; 5; 1000) ergibt 3,5 

Siehe auch: 

MITTELWERT, MODALWERT, QUANTIL 
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MILLISEKUNDEN (Millisekunden aus einem Datumswert 

ermitteln) 

Syntax: 

MILLISEKUNDEN(Uhrzeit) 

Beschreibung: 

Liefert den Millisekundenanteil aus einem Datumswert. 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

MILLISEKUNDEN("12:34:56,555") ergibt 555 

MILLISEKUNDEN("25.09.2013 12:34:56,555") ergibt 555 

Siehe auch: 

STUNDE, MINUTE, SEKUNDE 

MIN (Minimalwert) 

Syntax: 

MIN(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Liefert den kleinsten Wert innerhalb der angegebenen Zahlen. 
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Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Beispiel: 

MIN(5; 7; 4; 9) ergibt 4 

Wenn die Zellen A1 bis A3 mit den Werten 5, 2 und WAHR gefüllt sind, so gilt: 

MIN(A1:A3) ergibt 2 (der Wahrheitswert WAHR wird ignoriert) 

Siehe auch: 

MINA, MAX, KKLEINSTE 

MINA (Minimalwert) 

Syntax: 

MINA(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Die Funktion MINA entspricht nahezu der Funktion MIN (siehe Hinweis). Sie 

liefert also den kleinsten Wert innerhalb der angegebenen Zahlen. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 

Hinweis: 

Im Gegensatz zu MIN berücksichtigt die Funktion MINA auch Werte, die keine 

Zahlen sind: Beliebige Zeichenketten und der Wahrheitswert FALSCH werden als 

0 interpretiert, WAHR als 1. 

Leere Zellen werden hingegen auch hier ignoriert. 
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Beispiel: 

MINA(5; 7; 4; 9) ergibt 4 

Wenn die Zellen A1 bis A3 mit den Werten 5, 2 und WAHR gefüllt sind, so gilt: 

MINA(A1:A3) ergibt 1 (denn WAHR = 1)  

MIN(A1:A3) ergibt hingegen 2 (denn der Wahrheitswert WAHR wird hier igno-

riert) 

Siehe auch: 

MIN 

MINUTE (Minute aus einem Datumswert ermitteln) 

Syntax: 

MINUTE(Uhrzeit) 

Beschreibung: 

Liefert den Minutenanteil aus einem Datumswert. 

Beispiel: 

MINUTE("12:34:56") ergibt 34 

MINUTE("25.09.2013 10:30:56") ergibt 30 

Siehe auch: 

STUNDE, SEKUNDE, MILLISEKUNDEN 
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MINV (Inverse einer Matrix) 

Syntax: 

MINV(Matrix) 

Beschreibung: 

Liefert die Inverse einer quadratischen Matrix.  

Die Inverse A-1 einer Matrix A ist die Matrix, mit der A multipliziert werden muss, 

um die Einheitsmatrix 1 zu erhalten. 

Matrix kann eine Matrix oder ein entsprechender Zellbezug sein. Matrix muss 

numerische Werte enthalten und quadratisch sein, also die gleiche Anzahl an Zeilen 

und Spalten besitzen. 

Anmerkung: 

Singuläre Matrizen (Matrizen, deren Determinante Null ist) haben keine Inverse. 

Hier liefert MINV den Fehlerwert #ZAHL. 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 450. 

Beispiel: 

MINV({9.8.8;2.4.6;1.2.1}) ergibt: 

{0,2.-0,2.-0,4;-0,1.-0,025.0,95;0.0,25.-0,5} 

Siehe auch: 

Abschnitt „Arbeiten mit Matrizen“ ab Seite 450, MDET, MMULT, MSOLVE, 

MTRANS 
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MITTELABW (Mittlere Abweichung vom Mittelwert) 

Syntax: 

MITTELABW(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Berechnet die durchschnittliche Abweichung der angegebenen Zahlen von ihrem 

Mittelwert. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Beispiel: 

MITTELABW(2; 2; 2; 2) ergibt 0 

MITTELABW(2; 2; 2; 3) ergibt 0,375 

Siehe auch: 

SUMQUADABW, STABW, VARIANZ 

MITTELWERT (Arithmetisches Mittel) 

Syntax: 

MITTELWERT(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Liefert das einfache arithmetische Mittel der übergebenen Zahlen.  

Dieses wird durch Teilen der Summe der Einzelwerte durch deren Anzahl berech-

net. 
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Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Beispiel: 

MITTELWERT(1; 2; 6) entspricht (1+2+6) / 3, ergibt also 3 

Wenn die Zellen A1 bis A4 die Werte 0, 1, 2 und den Wahrheitswert WAHR enthal-

ten, so gilt: 

MITTELWERT(A1:A4) entspricht (0+1+2) / 3, ergibt also 1. Die Zelle mit dem 

Wahrheitswert wird hierbei nicht berücksichtigt – auch nicht beim Ermitteln der 

Anzahl der Werte. 

Siehe auch: 

MITTELWERTA, GEOMITTEL, HARMITTEL 

MITTELWERTA (Arithmetisches Mittel) 

Syntax: 

MITTELWERTA(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Die Funktion MITTELWERTA entspricht nahezu der Funktion MITTELWERT 

(siehe Hinweis). Sie liefert also das arithmetische Mittel der übergebenen Zahlen.  

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 

Hinweis: 

Im Gegensatz zu MITTELWERT berücksichtigt die Funktion MITTELWERTA 

auch Werte, die keine Zahlen sind: Beliebige Zeichenketten und der Wahrheitswert 

FALSCH werden als 0 interpretiert, WAHR als 1. 

Leere Zellen werden hingegen auch hier ignoriert. 
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Beispiel: 

MITTELWERTA(1; 2; 6) entspricht (1+2+6) / 3, ergibt also 3 

Wenn die Zellen A1 bis A4 die Werte 0, 1, 4 und den Wahrheitswert WAHR enthal-

ten, so gilt: 

MITTELWERTA(A1:A4) entspricht (0+1+4+1) / 4, ergibt also 1,5. Der Wahr-

heitswert WAHR wird hier als 1 interpretiert. 

Zum Vergleich: 

MITTELWERT(A1:A4) entspricht (0+1+4) / 3, ergibt also etwa 1,66667. Der 

Wahrheitswert wird hier ignoriert. 

Siehe auch: 

MITTELWERT 

MITTELWERTWENN (Mittelwert ausgewählter Werte) 

Syntax: 

MITTELWERTWENN(Suchbereich; Suchkriterium [; Mittelwertbereich]) 

Beschreibung: 

Liefert den Mittelwert (einfaches arithmetisches Mittel) derjenigen Werte in einem 

Bereich, für die die angegebene Bedingung zutrifft.  

Suchbereich ist der zu durchsuchende Bereich. 

Suchkriterium ist die zu erfüllende Bedingung: 

Hier können Sie einerseits einfach einen Wert angeben (zum Beispiel "42" oder 

"Schrauben"). In diesem Fall wird der Mittelwert aller Posten geliefert, die diesem 

Wert entsprechen. 

Andererseits ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier wird der 

Mittelwert aller Posten geliefert, die dieser Bedingung entsprechen. 

Hinweis: Das Suchkriterium sollte stets mit doppelten Anführungszeichen (") um-

geben werden. 
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Das optionale Argument Mittelwertbereich bestimmt, das Mittel welcher Werte 

geliefert werden soll. Wenn Mittelwertbereich nicht angegeben ist, werden die 

Werte im Suchbereich verwendet. 

Kompatibilitätshinweis: 

Diese Funktion ist nicht kompatibel zum .xls-Dateiformat von Microsoft Excel 

2003 und früher. Wenn Sie ein Dokument in diesem Format speichern, werden alle 

Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester 

Wert ersetzt.  

Wenn Sie diese Funktion einsetzen möchten, sollten Sie Ihr Dokument also nicht 

im Dateiformat „Microsoft Excel 97-2003 (.xls)“ speichern, sondern eines der fol-

genden Formate verwenden: 

 „PlanMaker-Dokument (.pmd)“ 

 oder: „Microsoft Excel 2007-2010 (.xlsx)“ 

Beispiel: 

In den Zellen A1 bis A5 stehen die Werte 1; 2; 3; 2; 1. Hier gilt: 

MITTELWERTWENN(A1:A5; "2") ergibt 2 

MITTELWERTWENN(A1:A5; ">=2") ergibt (2+3+2)/3, also 2,33333 

Siehe auch: 

MITTELWERT, MITTELWERTWENNS, SUMMEWENN, SUMMEWENNS, 

ZÄHLENWENN, ZÄHLENWENNS 

 

MITTELWERTWENNS (Mittelwert ausgewählter Werte) 

Syntax: 

MITTELWERTWENNS(Mittelwertbereich; Suchbereich1; Suchkriterium1 [; 

Suchbereich2; Suchkriterium2 ...]) 
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Beschreibung: 

Liefert den Mittelwert (einfaches arithmetisches Mittel) derjenigen Werte in einem 

Bereich, für die alle angegebenen Bedingungen zutreffen.  

Entspricht der Funktion MITTELWERTWENN, erlaubt allerdings die Verwendung 

mehrerer Suchbereiche (inklusive eines Suchkriteriums für jeden Bereich). 

Beachten Sie: Die Reihenfolge der Parameter ist hier anders als bei MITTEL-

WERTWENN: Bei MITTELWERTWENNS ist der Mittelwertbereich der erste 

Parameter und nicht der letzte.  

Mittelwertbereich ist der Bereich mit den Werten, deren Mittelwert berechnet 

werden soll.  

Suchbereich1 ist der erste zu durchsuchende Bereich. Dieser muss die gleichen 

Ausmaße haben wie der Mittelwertbereich. 

Suchkriterium1 ist die Bedingung, die die Werte in Suchbereich1 erfüllen müs-

sen: 

Hier können Sie einerseits einfach einen Wert angeben (zum Beispiel "42" oder 

"Schrauben"). In diesem Fall wird der Mittelwert aller Posten geliefert, die diesem 

Wert entsprechen. 

Andererseits ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier wird der 

Mittelwert aller Posten geliefert, die dieser Bedingung entsprechen. 

Hinweis: Die Suchkriterien sollten stets mit doppelten Anführungszeichen (") um-

geben werden. 

Im Gegensatz zur Funktion MITTELWERTWENN können Sie bei MITTEL-

WERTWENNS auch mehrere Suchbereiche mit jeweils dazugehörendem Suchkri-

terium angeben. Es werden dann nur diejenigen Werte in die Berechnung einbezo-

gen, bei denen alle Kriterien erfüllt sind. 

Kompatibilitätshinweis: 

Diese Funktion ist nicht kompatibel zum .xls-Dateiformat von Microsoft Excel 

2003 und früher. Wenn Sie ein Dokument in diesem Format speichern, werden alle 

Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester 

Wert ersetzt.  

Wenn Sie diese Funktion einsetzen möchten, sollten Sie Ihr Dokument also nicht 

im Dateiformat „Microsoft Excel 97-2003 (.xls)“ speichern, sondern eines der fol-

genden Formate verwenden: 



 

610    Formeln und Funktionen Handbuch PlanMaker 

 „PlanMaker-Dokument (.pmd)“ 

 oder: „Microsoft Excel 2007-2010 (.xlsx)“ 

Beispiel: 

MITTELWERTWENNS(A1:A10; C1:C10; ">1"; C1:C10; "<2")  

Diese Formel liefert den Mittelwert all derjenigen Zellen im Bereich A1:A10, bei 

denen die entsprechende Zelle im Bereich C1:C10 größer als 1 und kleiner als 2 

ist. 

Siehe auch: 

MITTELWERT, MITTELWERTWENN, SUMMEWENN, SUMMEWENNS, 

ZÄHLENWENN, ZÄHLENWENNS 

MMULT (Multiplikation zweier Matrizen) 

Syntax: 

MMULT(Matrix1; Matrix2) 

Beschreibung: 

Liefert das Produkt zweier Matrizen. 

Matrix1 und Matrix2 können Matrizen oder entsprechende Zellbezüge sein. Beide 

Matrizen müssen numerische Werte enthalten.  

Beachten Sie: Die Spaltenzahl von Matrix1 muss mit der Zeilenzahl von Matrix2 

übereinstimmen; andernfalls ist eine Multiplikation nicht möglich. 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 450. 
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Beispiel: 

MMULT({1.2;3.4}; {5.6;7.8}) ergibt {19.22;43.50} 

Siehe auch: 

Abschnitt „Arbeiten mit Matrizen“ ab Seite 450, MDET, MINV, MSOLVE, 

MTRANS 

MODALWERT (Häufigster Wert) 

Syntax: 

MODALWERT(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Ermittelt den häufigsten Wert (auch Modalwert oder dichtester Wert genannt) in-

nerhalb der angegebenen Zahlenwerte. 

Bei der Dichtefunktion einer Wahrscheinlichkeitsverteilung entspricht der Modal-

wert dem „Gipfel“ des Graphen. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 

Wenn die Werte mehrere Modalwerte enthalten, wird der kleinste Modalwert gelie-

fert. 

Enthalten die Werte keinen mehrfach vorkommenden Wert, liefert die Funktion den 

Fehlerwert #NV. 

Beispiel: 

MODALWERT(1; 2; 4; 4; 4; 2; 1) ergibt 4 

MODALWERT(1; 2; 4; 4; 2; 1) ergibt 1 (hier wird der kleinste der drei Modalwer-

te geliefert) 

MODALWERT(1; 4; 2) ergibt #NV, da kein Wert mehr als ein Mal vorkommt. 
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Siehe auch: 

MEDIAN, NORMVERT 

MONAT (Monat aus einem Datumswert ermitteln) 

Syntax: 

MONAT(Datum) 

Beschreibung: 

Liefert die Monatszahl eines Datumswerts. 

Beispiel: 

MONAT("25.9.2013") ergibt 9 

MONAT("17. August") ergibt 8 

Siehe auch: 

ISOWOCHE, JAHR, KALENDERWOCHE, TAG, WOCHENTAG 

MONATSENDE (Monatsende in/vor n Monaten) 

Syntax: 

MONATSENDE(Ausgangsdatum; m) 

Beschreibung: 

Liefert das Monatsende, das m Monate vor/nach dem Ausgangsdatum liegt.  

Das Argument Ausgangsdatum muss ein gültiger Datumswert sein, andernfalls 

liefert die Funktion den Fehlerwert #WERT!. 

Mit dem Argument m geben Sie die Zahl der Monate an. 
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Wenn m Null ist, wird das Monatsende des gleichen Monats ermittelt. 

Wenn m positiv ist, wird das Monatsende berechnet, das m Monate hinter dem 

Ausgangsdatum liegt. 

Wenn m negativ ist, erhalten Sie das Monatsende, das m Monate vor dem Aus-

gangsdatum liegt. 

m sollte eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker die Nach-

kommastellen automatisch. 

Beispiel: 

MONATSENDE("25.09.2013"; 0) ergibt den 30.09.2013 

MONATSENDE("25.09.2013"; 1) ergibt den 31.10.2013 

MONATSENDE("25.09.2013"; -1) ergibt den 31.08.2013 

Siehe auch: 

EDATUM 

MSOLVE (Lösung eines linearen Gleichungssystems) 

Syntax: 

MSOLVE(A_Matrix; B_Vektor) 

Beschreibung: 

Liefert die Lösung eines linearen Gleichungssystem Ax=B. 

A_Matrix ist die Matrix A. Sie können hierfür eine Matrix oder einen entspre-

chenden Zellbezug angeben. A_Matrix muss numerische Werte enthalten und 

quadratisch sein, also die gleiche Anzahl an Zeilen und Spalten besitzen.  

Weiterhin darf die Determinante dieser Matrix nicht Null sein, da diese Funktion 

sonst keine oder unendlich viele Lösungen liefern würde. 

B_Vektor ist der Vektor B. Auch hierfür können Sie einen Zellbereich oder eine 

Matrix angeben. Es muss sich dabei um einen Vektor (also einen eindimensionalen 
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Bereich) handeln, was bedeutet, dass B_Vektor entweder nur eine Zeile oder nur 

eine Spalte umfassen darf. 

Das Ergebnis dieser Funktion ist ein Vektor mit den Lösungen. 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Anmerkung: 

Die Lösung wird bei dieser Funktion mit der Methode der Singulärwertzerlegung 

ermittelt. Bei größeren Matrizen (mehr als 10-20 Zeilen) kann es hierbei unter Um-

ständen zu signifikanten Rundungsfehlern kommen. 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 450.  

Beispiel: 

Sie möchten folgendes lineares Gleichungssystem lösen: 

2x + 3y = 4 

2x + 2y = 8 

Dazu würden Sie folgende Formel formulieren: 

MSOLVE({2.3;2.2};{4;8}) 

Als Ergebnis wird der Vektor {8;-4} geliefert. x ist also 8, y ist -4. 

Siehe auch: 

Abschnitt „Arbeiten mit Matrizen“ ab Seite 450, MDET, MINV, MMULT, 

MTRANS 
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MTRANS (Transponieren einer Matrix) 

Syntax: 

MTRANS(Matrix) 

Beschreibung: 

Transponiert die übergebene Matrix, vertauscht also die Zeilen mit den Spalten. 

Wenn Sie beispielsweise eine 2x4-Matrix transponieren, erhalten Sie eine 4x2-

Matrix. 

Matrix kann eine Matrix oder ein entsprechender Zellbezug sein. 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 450.  

Beachten Sie dabei insbesondere, dass der vor der Eingabe der Formel zu markie-

rende Bereich die korrekten Ausmaße haben muss. Wenn die Matrix aus x Spalten 

und y Zeilen besteht, muss dieser Bereich y Spalten und x Zeilen umfassen. 

Beispiel: 

MTRANS({1.2.3;4.5.6}) ergibt {1.4;2.5;3.6} 

Siehe auch: 

Abschnitt „Arbeiten mit Matrizen“ ab Seite 450, MDET, MINV, MMULT, MSOL-

VE 

N (Wert in Zahl umwandeln) 

Syntax: 

N(Wert) 
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Beschreibung: 

Wandelt den übergebenen Wert in eine Zahl. 

Der übergebene Wert muss eine Zahl, ein Datumswert oder ein Wahrheitswert sein, 

andernfalls liefert N den Wert Null zurück.  

Hinweis: 

Diese Funktion ist nur aus Gründen der Kompatibilität mit älteren Tabellenkalkula-

tionen noch vorhanden. PlanMaker selbst benötigt sie nicht mehr, da er Werte bei 

Bedarf automatisch in Zahlen umwandelt. 

Beispiel: 

N("Text") ergibt 0 

N("42") ergibt 0 

N(42) ergibt 42 

N(WAHR) ergibt 1 

Steht in Zelle A1 das Datum 25.09.2008, so gilt: 

N(A1) ergibt 39716, die serielle Datumszahl für dieses Datum 

Siehe auch: 

T, WERT, TEXT 

NACHKOMMA (Nachkommastellen einer Zahl) 

Syntax: 

NACHKOMMA(Zahl) 

Beschreibung: 

Liefert den Nachkommaanteil der angegebenen Zahl. 
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Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

NACHKOMMA(5,779) ergibt 0,779 

Siehe auch: 

KÜRZEN 

Anmerkung: 

Die Vorkommastellen erhalten Sie mit der Funktion KÜRZEN. 

NBW (Nettobarwert) 

Syntax: 

NBW(Zins; Zahlung1; Zahlung2 [; Zahlung3 ...]) 

Beschreibung: 

Liefert den Nettobarwert (Kapitalwert) einer Investition, basierend auf einer Inves-

tition mit regelmäßigen Zahlungen und feststehendem Zins. 

Die Funktion erwartet folgende Argumente: 

Zins ist der Zinssatz für die Dauer einer Periode. 

Zahlung1, Zahlung2 etc. sind die Zahlungsvorgänge. Sie können entweder ein-

zelne Werte oder ganze Zellbereiche mit Werten angeben. Wichtig: Die Zahlungen 

müssen jeweils an Ende einer Periode erfolgen.  

Die Zahlungen können unterschiedlich groß sein und aus Einzahlungen (positive 

Werte) und Auszahlungen (negative Werte) bestehen. Sie müssen jedoch in gleich-

bleibenden Zeitabständen (jeweils am Ende einer Periode) erfolgen und in genau 

der Reihenfolge eingetragen werden, in der sie tatsächlich erfolgt sind.  
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Ausgelassene Zahlungen müssen mit 0 (Null) eingetragen werden. 

Die Unterschiede zur Funktion BW: 

1. Bei NBW sind unterschiedlich große Zahlungen möglich, bei BW nur gleich-

bleibende. 

2. Bei NBW müssen Zahlungen stets am Ende der Periode erfolgen, bei BW kön-

nen sie auch am Beginn der Periode erfolgen. 

Beispiel: 

NBW(6,5%; 4000; 5000) ergibt 8164,16 

Siehe auch: 

BW, XKAPITALWERT 

NEG (Negativer Wert einer Zahl) 

Syntax: 

NEG(Zahl) 

Beschreibung: 

Kehrt das Vorzeichen einer Zahl um.  

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Als Alternative können Sie einfach die Multiplikation mit dem Wert -1 verwenden. 

NEG(x) entspricht (-1) * x. 

Beispiel: 

NEG(42) ergibt -42 
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NEG(-42) ergibt 42 

NEG(0) ergibt 0 

Siehe auch: 

ABS, VORZEICHEN 

NEGBINOMVERT (Negative Binomialverteilung) 

Syntax: 

NEGBINOMVERT(k; r; p) 

Beschreibung: 

Liefert die Wahrscheinlichkeiten einer negativ-binomialverteilten Zufallsvariablen. 

Die negative Binomialverteilung (auch Pascal-Verteilung genannt) liefert die 

Wahrscheinlichkeit für das Erhalten von k Fehlschlägen vor dem r-ten Treffer bei 

einem Zufallsexperiment mit voneinander unabhängigen Wiederholungen und nur 

zwei möglichen Ergebnissen (Treffer oder Fehlschlag), wobei die Wahrscheinlich-

keit für einen Treffer pro Wiederholung p beträgt. 

k ist die Anzahl an Misserfolgen. 

r ist die Anzahl an Treffern. 

k und r sollten ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker die 

Nachkommastellen automatisch weg. 

p ist die Trefferwahrscheinlichkeit pro Wiederholung. 

Beispiel: 

In einer Urne befinden sich 1 rote und 5 schwarze Kugeln. Wie groß ist die Wahr-

scheinlichkeit, mit Zurücklegen 10 schwarze Kugeln (=Misserfolge) zu ziehen, 

bevor die 2-te rote Kugel (=Erfolg) gezogen wird? 

NEGBINOMVERT(10; 2; 1/6) ergibt 0,04935. 
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Siehe auch: 

BINOMVERT 

NETTOARBEITSTAGE (Zahl der Arbeitstage) 

Syntax: 

NETTOARBEITSTAGE(Ausgangsdatum; Enddatum [; FreieTage]) 

Beschreibung: 

Ermittelt die Zahl der Arbeitstage zwischen Ausgangsdatum und Enddatum. 

Samstage und Sonntage werden dabei übersprungen. Weiterhin kann der Funktion 

optional eine Liste mit freien Tagen (z.B. Feiertagen) übergeben werden. Diese 

werden dann ebenfalls übersprungen. 

Ausgangsdatum und Enddatum sind der erste beziehungsweise der letzte Tag des 

zu betrachtenden Zeitintervalls. 

Für FreieTage kann optional eine Liste mit freien Tagen angegeben werden. Es 

muss sich dabei um einen Zellbereich oder eine Matrix handeln, die Datumswerte 

enthält. 

Beispiel: 

NETTOARBEITSTAGE("1.1.2010"; "31.1.2010") ergibt 22.  

Der Januar 2010 hatte also 22 Arbeitstage (ohne Berücksichtigung der Feiertage). 

Möchte man dabei die Feiertage am 1.1.2010 und am 6.1.2010 berücksichtigen, 

kann man diese beiden Daten beispielsweise in die Zellen A1 und A2 eintragen und 

dann schreiben: 

NETTOARBEITSTAGE("1.1.2010"; "31.1.2010"; A1:A2)  

Das Ergebnis ist 20, da diese Feiertage im Jahr 2010 beide auf Wochentage fielen, 

also 2 Tage abzuziehen sind. 
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Siehe auch: 

ARBEITSTAG, TAGE 

NICHT (Logisches NICHT) 

Syntax: 

NICHT(Wahrheitswert) 

Beschreibung: 

Kehrt den übergebenen Wahrheitswert um. WAHR wird zu FALSCH und FALSCH 

wird zu WAHR. 

Beispiel: 

NICHT(WAHR) ergibt FALSCH 

NICHT(A1=0) ergibt WAHR, wenn der Inhalt der Zelle A1 verschieden von Null 

ist. 

Siehe auch: 

ODER, UND, XODER 

NOMINAL (Nominalverzinsung) 

Syntax: 

NOMINAL(EffZins; Zinsgutschriften) 

Beschreibung: 

Ermittelt den nominalen Jahreszins, ausgehend vom effektiven Jahreszins und der 

Zahl der Zinsgutschriften pro Jahr. 

EffZins ist der effektive Jahreszins. 
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Zinsgutschriften ist die Zahl der Zinsgutschriften pro Jahr (muss mindestens 1 

sein). 

Beispiel: 

Eine Geldanlage bietet 5% effektiven Jahreszins, Zinsen werden 4x pro Jahr gutge-

schrieben. Wie hoch liegt der nominale Jahreszins? 

NOMINAL(5%; 4) ergibt ca. 4,91% 

Siehe auch: 

EFFEKTIV 

NORMINV (Quantile einer Normalverteilung) 

Syntax: 

NORMINV(Wahrscheinlichkeit; Mittelwert; Standardabweichung) 

Beschreibung: 

Liefert Quantile einer Normalverteilung.  

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Verteilung. Zu-

lässig sind nur Werte aus dem Intervall [0..1]. 

Mittelwert ist der Mittelwert der Verteilung. 

Standardabweichung ist die Standardabweichung der Verteilung. Diese muss grö-

ßer als Null sein. 

Hinweis: 

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. 

Findet PlanMaker nach 100 Iterationen kein Ergebnis, das weniger als 3x10^-7 

von Wahrscheinlichkeit abweicht, zeigt er den Fehlerwert #NV an und bricht die 

Näherung ab. 



 

Handbuch PlanMaker Formeln und Funktionen    623 

Siehe auch: 

NORMVERT 

NORMVERT (Normalverteilung) 

Syntax: 

NORMVERT(x; E; S; Kumuliert) 

Beschreibung: 

Liefert die Wahrscheinlichkeiten einer normalverteilten Zufallsvariablen. 

Die Normalverteilung (auch Gauß-Verteilung oder Gaußsche Glockenkurve ge-

nannt) ist in der Wahrscheinlichkeitsrechnung von großer Bedeutung, da viele Zu-

fallsvariablen normalverteilt oder zumindest annähernd normalverteilt sind. 

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. 

Für E ist der Erwartungswert  (My) der Verteilung anzugeben. 

Für S ist die Standardabweichung  (Sigma) der Verteilung anzugeben. 

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert wer-

den soll: 

FALSCH: Es wird die Dichtefunktion (also die Gaußsche Glockenkurve) geliefert. 

WAHR: Es wird die Verteilungsfunktion (also die integrierte Dichtefunktion) gelie-

fert. 

      

Dichtefunktion (links) und Verteilungsfunktion (rechts) 
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Siehe auch: 

NORMINV, STANDNORMVERT  

NOTIERUNGBRU (Geldbetrag in Dezimalbruch wandeln) 

Syntax: 

NOTIERUNGBRU(Zahl; Teiler) 

Beschreibung: 

Wandelt einen Geldbetrag, der als Dezimalzahl ausgedrückt ist, in einen Dezimal-

bruch um. 

(In den USA ist es bei manchen Arten von Geldgeschäften üblich, Geldbeträge als 

Bruchzahlen darzustellen – zum Beispiel 27 4/8 statt 27,50.) 

Zahl ist die umzuwandelnde Zahl. 

Teiler ist der gewünschte Teiler. Er muss größer gleich 1 sein. Weiterhin sollte Tei-

ler eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker automatisch 

alle Nachkommastellen. 

Beispiel: 

NOTIERUNGBRU(27,5; 8) ergibt 27,4 (da 27,5 dem Bruch 27 4/8 entspricht) 

Siehe auch: 

NOTIERUNGDEZ 

NOTIERUNGDEZ (Geldbetrag in Dezimalzahl wandeln) 

Syntax: 

NOTIERUNGDEZ(Zahl; Teiler) 
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Beschreibung: 

Wandelt einen Geldbetrag, der als Dezimalbruch ausgedrückt ist, in eine Dezimal-

zahl um. 

(In den USA ist es bei manchen Arten von Geldgeschäften üblich, Geldbeträge als 

Bruchzahlen darzustellen – zum Beispiel 27 4/8 statt 27,50.) 

Zahl ist die umzuwandelnde Zahl. 

Teiler ist der verwendete Teiler. Er muss größer gleich 1 sein. Weiterhin sollte Tei-

ler eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker automatisch 

alle Nachkommastellen. 

Beispiel: 

NOTIERUNGDEZ(27,4; 8) wandelt die Bruchzahl 27 4/8 in die Dezimalzahl 27,5 

um. 

Siehe auch: 

NOTIERUNGBRU 

NV (Nicht vorhanden) 

Syntax: 

NV() 

Beschreibung: 

Liefert den Fehlerwert #NV („nicht vorhanden“). 

Mit Hilfe dieser Funktion können Sie leere Zellen, die erst später ausgefüllt werden 

sollen, als noch nicht vorhanden kennzeichnen. Alle Berechnungen, die sich auf 

eine solche Zelle beziehen, haben stets den Fehlerwert #NV als Ergebnis. 

Auf diese Weise können Sie verhindern, dass Berechnungen mit leeren Zellen 

durchgeführt werden, obwohl diese Zellen zwingend mit Werten gefüllt sein müss-

ten, damit ein korrektes Ergebnis geliefert werden kann.  
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Anmerkung: 

Statt =NV() können Sie auch #NV in die Zelle eingeben, was das gleiche Resultat 

liefert. 

Beispiel: 

Sie möchten Ihren Jahresumsatz anhand der Summe der vier Quartalsergebnisse 

berechnen. Diese werden in die Zellen A1 bis A4 eingetragen; der Jahresumsatz 

ließe sich also mit der Formel SUMME(A1:A4) berechnen. 

Es gibt nur ein Problem: Das Ergebnis für das vierte Quartal liegt noch nicht vor; 

die Zelle A4 ist also leer. Der Jahresumsatz darf also noch nicht ausgerechnet wer-

den. 

PlanMaker berechnet jedoch stur die Summe von A1 bis A4 – auch dann, wenn 

einer der Werte fehlt. Ergebnis: ein scheinbar miserables Jahresergebnis, schreiend 

davonlaufende Aktionäre. 

Wesentlich gesünder ist es, die Zelle A4 nicht einfach leer zu lassen, sondern dort 

NV() einzutragen. Damit kennzeichnen Sie die Zelle als noch „nicht vorhanden“. 

Das bewirkt, dass die Summenformel jetzt als Ergebnis keinen falschen Zahlenwert 

mehr hat, sondern den Fehlerwert #NV. Das signalisiert, dass eines der Quartalser-

gebnisse noch nicht vorhanden ist, der Jahresumsatz also noch nicht berechnet 

werden kann. Ergebnis: keine schreiend davonlaufenden Aktionäre. 

Siehe auch: 

ISTNV, ISTFEHL, ISTFEHLER, FEHLER.TYP, Abschnitt über „Fehlerwerte“ ab 

Seite 448 

OBERGRENZE (Aufrunden auf ein Vielfaches von n) 

Syntax: 

OBERGRENZE(Zahl; Basis) 

Beschreibung: 

Rundet Zahl auf ein Vielfaches von Basis auf. 
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Bei positiven Zahlen wird auf das nächstgrößere Vielfache von Basis aufgerundet, 

bei negativen Zahlen hingegen auf das nächstkleinere Vielfache abgerundet. 

Zahl und Basis müssen das gleiche Vorzeichen haben, sonst liefert die Funktion 

den Fehlerwert #ZAHL! 

Beispiel: 

OBERGRENZE(42,5; 1) ergibt 43 

OBERGRENZE(-42,5; -1) ergibt -43 

OBERGRENZE(21; 5) ergibt 25 

OBERGRENZE(12,3456; 0,01) ergibt 12,35 

Siehe auch: 

UNTERGRENZE, VRUNDEN, RUNDEN, KÜRZEN 

ODER (Logisches ODER) 

Syntax: 

ODER(Wahrheitswert1; Wahrheitswert2 [; Wahrheitswert3 ...]) 

Beschreibung: 

Diese Funktion liefert WAHR, wenn mindestens einer der übergebenen Wahr-

heitswerte WAHR ist, ansonsten liefert sie FALSCH. 

Sie können damit beispielsweise prüfen, ob von mehreren Bedingungen mindestens 

eine zutrifft. 

Beispiel: 

ODER(WAHR; WAHR) ergibt WAHR 

ODER(WAHR; FALSCH) ergibt WAHR 

ODER(FALSCH; FALSCH) ergibt FALSCH 
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ODER(A1=0; A1>10) ergibt WAHR; wenn A1 entweder Null oder größer als Zehn 

ist. 

Siehe auch: 

XODER, UND, NICHT 

OKTINBIN (Oktalzahl in Binärzahl wandeln) 

Syntax: 

OKTINBIN(Zahl [; Stellen]) 

Beschreibung: 

Wandelt eine Oktalzahl (Basis 8) in eine Binärzahl (Basis 2) um. 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel).  

Der zulässige Wertebereich für Zahl ist (in Oktalschreibweise): 

20000000000  Zahl  17777777777 

Das entspricht in Dezimalschreibweise: 

-2.147.483.648  Zahl  2.147.483.647 

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert. 
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Beispiel: 

OKTINBIN("52") ergibt 101010 

OKTINBIN("52"; 8) ergibt 00101010 

OKTINBIN("52"; 2) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit mindes-

tens 6 Stellen dargestellt werden kann 

OKTINBIN("37777777726") ergibt 11111111111111111111111111010110 (negati-

ve Zahl) 

Siehe auch: 

BININOKT, OKTINDEZ, OKTINHEX 

OKTINDEZ (Oktalzahl in Dezimalzahl wandeln) 

Syntax: 

OKTINDEZ(Zahl) 

Beschreibung: 

Wandelt eine Oktalzahl (Basis 8) in eine Dezimalzahl (Basis 10) um. 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel).  

Der zulässige Wertebereich für Zahl ist (in Oktalschreibweise): 

20000000000  Zahl  17777777777 

Das entspricht in Dezimalschreibweise: 

-2.147.483.648  Zahl  2.147.483.647 

Beispiel: 

OKTINDEZ("52") ergibt 42 



 

630    Formeln und Funktionen Handbuch PlanMaker 

OKTINDEZ("0052") ergibt ebenfalls 42 

OKTINDEZ("37777777726") ergibt -42 

Siehe auch: 

DEZINOKT, OKTINBIN, OKTINHEX 

OKTINHEX (Oktalzahl in Hexadezimalzahl wandeln) 

Syntax: 

OKTINHEX(Zahl [; Stellen]) 

Beschreibung: 

Wandelt eine Oktalzahl (Basis 8) in eine Hexadezimalzahl (Basis 16) um. 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel).  

Der zulässige Wertebereich für Zahl ist (in Oktalschreibweise): 

20000000000  Zahl  17777777777 

Das entspricht in Dezimalschreibweise: 

-2.147.483.648  Zahl  2.147.483.647 

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert. 
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Beispiel: 

OKTINHEX("52") ergibt 2A 

OKTINHEX("0052") ergibt ebenfalls 2A 

OKTINHEX("52"; 1) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit min-

destens 2 Stellen dargestellt werden kann 

OKTINHEX("37777777726") ergibt FFFFFFD6 (negative Zahl) 

Siehe auch: 

HEXINOKT, OKTINBIN, OKTINDEZ 

PEARSON (Pearsonscher Korrelationskoeffizient) 

Syntax: 

PEARSON(Bereich1; Bereich2) 

Beschreibung: 

Berechnet den Pearsonschen Korrelationskoeffizienten r zweier Datengruppen. 

Dieser ist ein Maß für die lineare Abhängigkeit der Datengruppen. 

PEARSON kann Werte zwischen -1 und 1 annehmen. 1 bedeutet perfekte lineare 

Abhängigkeit. -1 zeigt perfekte reziproke Abhängigkeit (die Werte in Bereich2 

nehmen so ab, wie die Werte in Bereich1 zunehmen). 

Bereich1 und Bereich2 sind Zellbezüge auf die beiden Datengruppen. Diese soll-

ten Zahlen enthalten. Leere Zellen sowie Zeichenketten und Wahrheitswerte wer-

den ignoriert. 

Die Datengruppen müssen die gleiche Anzahl an Werten besitzen, ansonsten liefert 

die Funktion den Fehlerwert #NV. 

Beispiel: 

Sind die Zellen A1 bis A3 mit den Werten 1, 2, 3 und die Zellen B1 bis B3 mit den 

Werten 2, 3, 4 gefüllt, so gilt: 
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PEARSON(A1:A3; B1:B3) ergibt 1 

Sind die Zellen A1 bis A3 mit den Werten 1, 2, 3 und die Zellen B1 bis B3 mit den 

Werten 4, 3, 2 gefüllt, so gilt: 

PEARSON(A1:A3; B1:B3) ergibt -1 

Siehe auch: 

BESTIMMTHEITSMASS, STEIGUNG, ACHSENABSCHNITT 

PHI (PlanMaker 97-Kompatibilitätsfunktion) 

Syntax: 

PHI(x) 

Beschreibung: 

Liefert die Dichtefunktion einer Standardnormalverteilung. 

Hinweis: 

Diese Funktion ist nur aus Kompatibilitätsgründen zu PlanMaker 97 noch vorhan-

den. Verwenden Sie diese Funktion möglichst nicht mehr, sondern benutzen Sie 

stattdessen die folgende Excel-kompatible Funktion: 

PHI(x) entspricht NORMVERT(x; 0; 1; FALSCH) 

Siehe auch: 

NORMVERT, GAUSS 

PI (Kreiszahl Pi) 

Syntax: 

PI() 
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Beschreibung: 

Liefert die Kreiszahl  (Pi), die das Verhältnis vom Umfang eines Kreises (2r) zu 

seinem Durchmesser (2r) angibt.  

Beispiel: 

PI() ergibt 3,14159265... 

POISSON (Poisson-Verteilung) 

Syntax: 

POISSON(x; Lambda; Kumuliert) 

Beschreibung: 

Liefert Wahrscheinlichkeiten einer Poisson-verteilten Zufallsvariablen. 

Die Poisson-Verteilung beschreibt das Eintreffen voneinander unabhängiger, 

gleichartiger Ereignisse in einem Zeitraum (zum Beispiel das Eintreffen von Kun-

den an einem Schalter oder das Eingehen von Telefonanrufen).  

Sie eignet sich besonders für Wahrscheinlichkeitsverteilungen, bei denen sehr viele 

Ergebnisse aus einer Stichprobe vorliegen und die Wahrscheinlichkeit, dass das zu 

untersuchende Ereignis eintritt, sehr klein ist. Hier nähert sich die Poisson-

Verteilung nämlich der Binomialverteilung (mit Lambda = n*p) an. Im Gegensatz 

zur Binomialverteilung benötigt sie (abgesehen von x) jedoch nur einen Parameter: 

den Erwartungswert Lambda (siehe Beispiel). 

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. x muss größer als 

Null sein. Weiterhin sollte x eine ganze Zahl sein. Ist dies nicht der Fall, schneidet 

PlanMaker die Nachkommastellen automatisch ab. 

Lambda () ist der erwartete Wert (Mittelwert) für x. Lambda muss größer als 

Null sein. 

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert wer-

den soll: 

FALSCH: Es wird die Dichtefunktion geliefert. 
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WAHR: Es wird die Verteilungsfunktion (also die integrierte Dichtefunktion) gelie-

fert. 

Beispiel: 

Bei einem bestimmten Reifentyp für Pkws treten bei 100.000 km Fahrt durch-

schnittlich 4 Reifenschäden auf.  

Wie groß ist die Wahrscheinlichkeit, dass nur 3 Reifenschäden auftreten? 

Möchte man dies mit der Funktion BINOMVERT (Binomialverteilung) berechnen, 

müsste man schreiben: 

BINOMVERT(3; 100000; 4/100000; FALSCH) ergibt 0,195368768 

Verwendet man hingegen die Poisson-Verteilung, kann man auf die Parameter n 

und p verzichten und schreibt schlicht und ergreifend: 

POISSON(3; 4; FALSCH) ergibt 0,195366815 

Die beiden Ergebnisse sind (wie oben beschrieben) erwartungsgemäß sehr ähnlich. 

Weiteres Beispiel: Wie groß ist die Wahrscheinlichkeit, dass höchstens 3 Schäden 

auftreten? 

Hier verwendet man statt der Dichtefunktion die Verteilungsfunktion (Argument 

Kumuliert mit WAHR angeben): 

POISSON(3; 4; WAHR) ergibt 0,43347 

Siehe auch: 

BINOMVERT 

POLYNOMIAL (Multinomialkoeffizient) 

Syntax: 

POLYNOMIAL(Zahl1; Zahl2 [; Zahl3 ...]) 
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Beschreibung: 

Liefert den Multinomialkoeffizienten (auch: „Polynomialkoeffizient“) einer Grup-

pe von Zahlen. 

Alle übergebenen Zahlen müssen größer gleich 1 sein. 

Beispiel: 

POLYNOMIAL(1; 2; 3; 4; 5) ergibt 37837800 

Siehe auch: 

FAKULTÄT 

POTENZ (Potenzierung) 

Syntax: 

POTENZ(x; y) 

Beschreibung: 

Berechnet x hoch y. 

Anmerkung: 

Mit dem Operator ^ können Sie genau das Gleiche erreichen:  

POTENZ(x; y) entspricht x^y. 

Beispiel: 

POTENZ(2; 4) entspricht 2^4, ergibt also 16 

Siehe auch: 

LOG, WURZELN, Abschnitt „Operatoren in Berechnungen“ ab Seite 438 
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POTENZREIHE (Potenzreihe) 

Syntax: 

POTENZREIHE(x; n; m; Koeffizienten) 

Beschreibung: 

Liefert eine Potenzreihe gemäß folgender Formel: 

POTENZREIHE(x,n,m,a) =  

a1*x^n + a2*x^(n+m) + a3*x^(n+2m) + a4*x^(n+3m) + ... 

x ist die Basis. 

n ist der Exponent für das erste Glied der Reihe. 

m ist das Inkrement für n. 

Koeffizienten sind die Koeffizienten, mit denen die einzelnen Glieder der Reihe 

multipliziert werden. Koeffizienten kann entweder ein Zellbezug oder eine ein-

spaltige Matrix sein. 

Die Zahl der Koeffizienten bestimmt gleichzeitig, aus wie vielen Gliedern die Rei-

he bestehen wird. Sind beispielsweise 10 Koeffizienten angegeben, wird eine Rei-

he mit 10 Gliedern gebildet. 

Beispiel: 

POTENZREIHE(2; 2; 1; {1; 2; 3; 4; 5}) ergibt 516 

Siehe auch: 

POTENZ 
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PRODUKT (Produkt) 

Syntax: 

PRODUKT(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Liefert das Produkt der angegebenen Zahlen, multipliziert sie also miteinander. 

Anmerkung: 

Beachten Sie: Normalerweise berücksichtigt diese Funktion nur Zahlen und igno-

riert Zeichenketten und Wahrheitswerte. Anders sieht es allerdings aus, wenn Sie 

ihr feste Werte übergeben: Hier werden Zeichenketten, die Zahlen enthalten, mit-

gezählt. Weiterhin werden die Wahrheitswerte WAHR als 1 und FALSCH als 0 

behandelt. Siehe Beispiele: 

Beispiel: 

PRODUKT(2; 3; 4) entspricht 2*3*4, ergibt also 24 

Wenn die Zellen A1 bis A3 mit den Werten 2, 3 und 4 gefüllt sind, gilt: 

PRODUKT(A1:A3) entspricht 2*3*4, ergibt also 24 

Beachten Sie: 

PRODUKT(2; "5"; WAHR) ergibt 2*5*1, also 10 

Aber: Sind die Zellen A1 bis A3 mit 2, "5" und WAHR gefüllt, liefert die Formel 

PRODUKT(A1:A3) ein anderes Ergebnis: Es kommt 2 heraus, da Zeichenketten 

und Wahrheitswerte nur berücksichtigt werden, wenn sie als feste Werte übergeben 

werden. 

Siehe auch: 

SUMME 
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QIKV (Modifizierter interner Zinsfuß) 

Syntax: 

QIKV(Werte; Investition; Reinvestition) 

Beschreibung: 

Liefert ein modifiziertes Modell des IKV (interner Zinsfuß), das Sollzins (für In-

vestitionen) und Habenzins (für Reinvestitionen) berücksichtigt.  

Als Basis dienen die im Bereich Werte angegebenen Auszahlungen (negative Wer-

te) und Einzahlungen (positive Werte). Die Zahlungen dürfen unterschiedlich groß 

sein, müssen jedoch in gleichmäßigen Zeitintervallen (z.B. monatlich oder jährlich) 

auftreten. 

Die Funktion erwartet folgende Argumente: 

Für Werte gibt man einen Zellbezug an, in dem die Zahlungen eingetragen wur-

den. Es muss mindestens eine Auszahlung und eine Einzahlung vorliegen. 

Für Investition ist der Sollzins (für Investitionen) anzugeben. 

Für Reinvestition ist der Habenzins (für Reinvestitionen) anzugeben.  

Siehe auch: 

IKV, XINTZINSFUSS, ZINS 

QUADRATESUMME (Summe der Quadrate) 

Syntax: 

QUADRATESUMME(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Ermittelt die Summe der Quadrate der übergebenen Zahlenwerte. 
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Beispiel: 

QUADRATESUMME(1; 2; 3) entspricht 1^2 + 2^2 + 3^2, ergibt also 14. 

Siehe auch: 

SUMME 

QUANTIL (Quantile einer Datenmenge) 

Syntax: 

QUANTIL(Bereich; Alpha) 

Beschreibung: 

Ermittelt das Alpha-Quantil einer Datenmenge.  

Geben Sie für Alpha beispielsweise 0,5 an, wird das 0,5-Quantil (der Median) ge-

liefert. 

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf 

einen Zellbereich, in dem Zahlen eingetragen sind. 

Alpha ist der gewünschte Prozentwert. Zulässig sind Werte zwischen 0 (=0%) bis 

1 (=100%). 

Beispiel: 

Sind in den Zellen A1 bis A9 die Werte 1 bis 9 eingetragen, so gilt: 

QUANTIL(A1:A9; 0,75) ergibt 7 

Siehe auch: 

QUARTILE, QUANTILSRANG, MEDIAN, MODALWERT 
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QUANTILSRANG (Prozentrang eines Wertes) 

Syntax: 

QUANTILSRANG(Bereich; Zahl [; Stellen]) 

Beschreibung: 

Liefert den prozentualen Rang (Alpha) eines Werts innerhalb einer Datenmenge. 

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf 

einen Zellbereich, in dem Zahlen eingetragen sind. 

Zahl ist der Wert, dessen Rang bestimmt werden soll. Wenn Zahl nicht in der an-

gegebenen Datenmenge enthalten ist, wird eine Interpolation durchgeführt. 

Mit dem optionalen Argument Stellen können Sie bestimmen, auf wie viele Nach-

kommastellen das Ergebnis berechnet werden soll. Geben Sie dazu die gewünschte 

Anzahl an Nachkommastellen an. Wenn Sie nichts angeben, werden drei Nach-

kommastellen verwendet. 

Beispiel: 

Sind in den Zellen A1 bis A9 die Werte 1, 2, 3, 4, 5, 6, 7, 8, 9 eingetragen, so gilt: 

QUANTILSRANG(A1:A9; 5) ergibt 0,5 (5 liegt also genau in der Mitte der Da-

tenmenge) 

Siehe auch: 

QUANTIL, QUARTILE 

QUARTILE (Quartile einer Datenmenge) 

Syntax: 

QUARTILE(Bereich; n) 
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Beschreibung: 

Liefert eines der Quartile einer Datenmenge. 

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf 

einen Zellbereich, in dem auszuwertenden Zahlen eingetragen sind. 

n bestimmt, welches Quartil geliefert werden soll. Zulässig sind folgende Werte: 

0: das Minimum (also der kleinste Wert) 

1: das untere Quartil (also das 0,25-Quantil) 

2: das mittlere Quartil (also das 0,5-Quantil, der Median) 

3: das obere Quartil (also das 0,75-Quantil) 

4: das Maximum (also der größte Wert) 

Ist n < 0 oder > 4, liefert die Funktion den Fehlerwert #ZAHL. 

Beispiel: 

Sind in den Zellen A1 bis A9 die Werte 1, 2, 3, 4, 5, 6, 7, 8, 9 eingetragen, so gilt: 

QUARTILE(A1:A9; 3) entspricht QUANTIL(A1:A9; 0,75), ergibt also 7 

Siehe auch: 

QUANTIL, QUANTILSRANG, MEDIAN, MODALWERT 

QUOTIENT (Ganzzahliger Teil einer Division) 

Syntax: 

QUOTIENT(x; y) 

Beschreibung: 

Ermittelt den ganzzahligen Teil der Division von x durch y. 
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Beispiel: 

QUOTIENT(6; 4) ergibt 1 

Siehe auch: 

REST, RESTP 

RANG (Rang eines Wertes in einer Wertemenge) 

Syntax: 

RANG(Zahl; Bereich [; Aufsteigend]) 

Beschreibung: 

Liefert den Rang einer Zahl in einer Menge von Zahlen. Die größte Zahl hat den 

Rang 1, die zweitgrößte Zahl den Rang 2 etc. 

Zahl ist die Zahl, deren Rang ermittelt werden soll. Wenn Zahl in Bereich nicht 

vorhanden ist, liefert die Funktion den Fehlerwert #NV. 

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf 

einen Zellbereich, in dem die vorliegenden Zahlen eingetragen sind. 

Der optionale Wahrheitswert Aufsteigend bestimmt, ob eine aufsteigende oder 

eine absteigende Reihenfolge verwendet werden soll: 

FALSCH oder nicht angegeben: absteigende Reihenfolge (die größte Zahl hat 

Rang 1) 

WAHR: aufsteigende Reihenfolge (die kleinste Zahl hat Rang 1) 

Hinweis: 

Ist eine Zahl in Bereich mehrere Male enthalten, so wirkt sich das auf die nachfol-

genden Ränge aus: Kommt die Zahl 42 beispielsweise zweimal vor und hat den 

Rang 10, so erhält die nächstkleinere Zahl den Rang 12 – nicht 11! 
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Beispiel: 

Sind in den Zellen A1:A5 die Zahlen 4, 2, 6, 5, 9 eingetragen, so gilt: 

RANG(9; A1:A5) ergibt 1 

RANG(2; A1:A5) ergibt 5 

RANG(2; A1:A5; WAHR) ergibt 1 

Siehe auch: 

KKLEINSTE, KGRÖSSTE, QUANTIL, QUANTILSRANG 

RECHTS (Teil einer Zeichenkette) 

Syntax: 

RECHTS(Zeichenkette [; n]) 

Beschreibung: 

Liefert die letzten n Zeichen einer Zeichenkette. 

Ist n nicht angegeben, liefert die Funktion nur das letzte Zeichen. 

Beispiel: 

RECHTS("Tiergarten"; 6) ergibt garten 

RECHTS("Tiergarten") ergibt n 

Siehe auch: 

LINKS, TEIL, ERSETZEN 
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REST (Rest einer Division) 

Syntax: 

REST(x; y) 

Beschreibung: 

Ermittelt den Rest der Division von x durch y nach der „Excel-Methode“. 

Wichtig: Diese Funktion liefert teilweise falsche Ergebnisse (siehe Anmerkung)! 

Beispiel: 

REST(5; 3) ergibt 2 

REST(5; 0) ergibt den Fehlerwert #DIV/0! 

REST(5; -3) ergibt -1 (falsch! – siehe Anmerkung) 

Siehe auch: 

RESTP, QUOTIENT 

Anmerkung: 

Die Tabellenkalkulation Microsoft Excel liefert bei dieser Funktion falsche Er-

gebnisse, wenn entweder Zähler oder Nenner negativ sind. 

PlanMaker liefert aus Kompatibilitätsgründen ebenfalls falsche Ergebnisse, ver-

fügt aber zusätzlich über die Funktion RESTP, die korrekte Ergebnisse zurückgibt. 

Den Unterschied zwischen REST und RESTP können Sie dieser Tabelle entneh-

men (die hinterlegten Ergebnisse sind falsch): 
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Kompatibilitätshinweis: 

Hinweis: Die Funktion RESTP ist in Excel nicht vorhanden. Wenn Sie ein Doku-

ment mit dieser Funktion im Excel-Format speichern, wird sie durch ihren letzten 

Wert ersetzt. 

RESTP (Rest einer Division) 

Syntax: 

RESTP(x; y) 

Beschreibung: 

Ermittelt den Rest der Division von x durch y nach der „PlanMaker-Methode“ 

(siehe Anmerkung). 

Beispiel: 

RESTP(5; 3) ergibt 2 

RESTP(5; 0) ergibt den Fehlerwert #DIV/0! 

RESTP(5; -3) ergibt 2 (siehe Anmerkung) 

Siehe auch: 

REST, QUOTIENT 
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Anmerkung: 

Die Tabellenkalkulation Microsoft Excel liefert bei der Funktion REST falsche 

Ergebnisse, wenn entweder Zähler oder Nenner negativ sind.  

Wenn Sie korrekte Ergebnisse erhalten möchten, sollten Sie statt REST die hier 

beschriebene Funktion RESTP verwenden. 

Den Unterschied zwischen REST und RESTP können Sie dieser Tabelle entneh-

men (die hinterlegten Ergebnisse sind falsch): 

 

Kompatibilitätshinweis: 

Hinweis: Die Funktion RESTP ist in Excel nicht vorhanden. Wenn Sie ein Doku-

ment mit dieser Funktion im Excel-Format speichern, wird sie durch ihren letzten 

Wert ersetzt. 

RGP (Kenngrößen einer linearen Regression) 

Syntax: 

RGP(y_Werte [; x_Werte] [; Konstante] [; Statistik]) 

Beschreibung: 

Liefert verschiedene Kenngrößen einer linearen Regression. 

Unter einer linearen Regression versteht man das Anpassen einer linearen Funktion 

(Regressionsgerade oder Ausgleichsgerade genannt) an eine Menge von Punkten 

(zum Beispiel den Messpunkten einer Messreihe). 

Die Funktionsgleichung für diese Regressionsgerade lautet: 
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y = m*x + b  

RGP erwartet als Argumente die y-Werte (und, sofern angegeben, die zugehörigen 

x-Werte) und liefert als Ergebnis eine Matrix in der Form {m.b}. m ist die Steigung 

der Geraden, b ist der y-Achsenabschnitt (also die y-Koordinate des Punktes, an 

dem die Gerade die y-Achse schneidet). 

Liegen mehrere Bereiche mit x-Werten vor, lautet die Funktionsgleichung: 

y = (m1*x1) + (m2*x2) + ... + (mn*xn) + b 

In diesem Fall liefert die Funktion RGP eine Matrix in der Form {mn . mn-1 . ... . 

m2 . m1 . b}.  

Wird das optionale Argument Statistik verwendet, wird die resultierende Matrix 

um weitere Kenngrößen (Standardfehler, Bestimmtheitsmaß etc.) erweitert. 

Die Funktion RGP erwartet folgende Argumente: 

y_Werte: Hier geben Sie die vorliegenden y-Koordinaten, also die abhängigen 

Werte, an. y_Werte kann entweder ein Zellbezug oder eine Matrix sein. 

x_Werte: Hier können optional die x-Koordinaten, also die unabhängigen Werte 

angegeben werden. Auch x_Werte kann entweder ein Zellbezug oder eine Matrix 

sein. Wird x_Werte nicht angegeben, verwendet die Funktion automatisch die 

Werte 1, 2, 3, ... (entsprechend der Anzahl der vorliegenden y_Werte). 

Konstante: Mit dem optionalen Argument Konstante können Sie festlegen, ob die 

Konstante b (der y-Achsenabschnitt) auf Null gesetzt werden soll: 

WAHR oder nicht angegeben: b wird aus den vorliegenden Daten automatisch be-

rechnet. 

FALSCH: b wird auf Null gesetzt. Die Regressionsgerade wird dadurch gezwun-

gen, durch den Nullpunkt zu laufen. Dies geschieht durch entsprechendes Anpas-

sen des Koeffizienten m. 

Statistik: Das optionale Argument Statistik bestimmt, ob zusätzliche Kenngrößen 

geliefert werden sollen: 

FALSCH oder nicht angegeben: keine zusätzlichen Kenngrößen liefern. 

WAHR: zusätzliche Kenngrößen liefern. In diesem Falle wird eine Matrix zurück-

geliefert, die nicht nur m und b, sondern folgende Werte enthält: 

{mn . mn-1 . ... . m2 . m1 . b ; smn . smn-1 . ... . sm2 . sm1 . sb ; R
2
 . sey ; F. df ; 

ssreg . ssresid} 
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Grafisch dargestellt sieht diese Matrix also wie folgt aus: 

 

Bei obigen Kürzeln handelt es sich um folgende Kenngrößen: 

Kürzel Erläuterung 

sm1, sm2 etc. Standardfehler für die Koeffizienten m1, m2 etc. 

sb Standardfehler für die Konstante b 

R2 Bestimmtheitsmaß R2 (Korrelationskoeffizient) 

sey Standardfehler für y 

F F-Wert 

df Freiheitsgrade 

ssreg Regressions-Quadratsumme 

ssresid Residual-Quadratsumme 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 450. 

Anmerkung: 

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleins-

ten Quadrate durchgeführt. 
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Beispiel: 

RGP({4; 5; 6}) liefert die Matrix {1.3}. Die Steigung m beträgt also 1 und der y-

Achsenabschnitt b ist 3. (Da die x-Werte nicht angegeben wurden, hat die RGP-

Funktion dafür automatisch die Werte 1, 2, 3, ... verwendet.) 

Siehe auch: 

RKP, TREND, VARIATION 

RKP (Kenngrößen einer exponentiellen Regression) 

Syntax: 

RKP(y_Werte [; x_Werte] [; Konstante] [; Statistik]) 

Beschreibung: 

Liefert verschiedene Kenngrößen einer exponentiellen Regression. 

Unter einer exponentiellen Regression versteht man das Anpassen einer Exponenti-

alkurve an eine Menge von Punkten (zum Beispiel den Messpunkten einer Mess-

reihe). 

Die Funktionsgleichung für diese Exponentialkurve lautet: 

y = b*m^x 

beziehungsweise (wenn mehrere Bereiche mit x-Werten vorliegen): 

y = b * (m1^x1) * (m2^x2) * ... * (mn^xn) 

RKP erwartet als Argumente die y-Werte (und, sofern angegeben, die zugehörigen 

x-Werte) und liefert als Ergebnis eine Matrix in der Form {mn . mn-1 . ... . m2 . m1 

. b}.  

Wird das optionale Argument Statistik verwendet, wird die resultierende Matrix 

um weitere Kenngrößen (Standardfehler, Bestimmtheitsmaß etc.) erweitert. 

Die Funktion RKP erwartet folgende Argumente: 

y_Werte: Hier geben Sie die vorliegenden y-Koordinaten, also die abhängigen 

Werte, an. y_Werte kann entweder ein Zellbezug oder eine Matrix sein. 
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x_Werte: Hier können optional die x-Koordinaten, also die unabhängigen Werte 

angegeben werden. Auch x_Werte kann entweder ein Zellbezug oder eine Matrix 

sein. Wird x_Werte nicht angegeben, verwendet die Funktion automatisch die 

Werte 1, 2, 3, ... (entsprechend der Anzahl der vorliegenden y_Werte). 

Konstante: Mit dem optionalen Argument Konstante können Sie festlegen, ob die 

Konstante b auf Eins gesetzt werden soll: 

WAHR oder nicht angegeben: b wird aus den vorliegenden Daten automatisch be-

rechnet. 

FALSCH: b wird fest auf Eins gesetzt, und die Kurve wird entsprechend „hingebo-

gen“. Dies geschieht durch Anpassen des Koeffizienten m. 

Statistik: Das optionale Argument Statistik bestimmt, ob zusätzliche Kenngrößen 

geliefert werden sollen: 

FALSCH oder nicht angegeben: keine zusätzlichen Kenngrößen liefern. 

WAHR: zusätzliche Kenngrößen liefern. In diesem Falle wird eine Matrix zurück-

geliefert, die nicht nur m und b, sondern folgende Werte enthält: 

{mn . mn-1 . ... . m2 . m1 . b ; smn . smn-1 . ... . sm2 . sm1 . sb ; R
2
 . sey ; F. df ; 

ssreg . ssresid} 

Grafisch dargestellt sieht diese Matrix also wie folgt aus: 

 

Bei obigen Kürzeln handelt es sich um folgende Kenngrößen: 

Kürzel Erläuterung 

sm1, sm2 etc. Standardfehler für die Koeffizienten m1, m2 etc. 

sb Standardfehler für die Konstante b 

R2 Bestimmtheitsmaß R2 (Korrelationskoeffizient) 

sey Standardfehler für y 
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F F-Wert 

df Freiheitsgrade 

ssreg Regressions-Quadratsumme 

ssresid Residual-Quadratsumme 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 450. 

Siehe auch: 

RGP, TREND, VARIATION 

RMZ (Regelmäßige Zahlung) 

Syntax: 

RMZ(Zins; Zzr; Bw [; Zw] [; Fälligkeit]) 

Beschreibung: 

Liefert die Höhe der Zahlung (Annuität) pro Periode, basierend auf einer Investiti-

on mit regelmäßigen konstanten Zahlungen und feststehendem Zins. 

Sie können mit dieser Funktion beispielsweise berechnen, wie hoch die (konstan-

ten) Zahlungen pro Periode ausfallen. Diese Zahlungen („Annuitäten“) bestehen 

stets aus einem Tilgungsanteil (siehe Funktion KAPZ) und einem Zinsanteil (siehe 

Funktion ZINSZ). 

„Periode“ bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen 

Rückzahlungen ist die dritte Periode beispielsweise der dritte Monat. 

Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode) 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 
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Bw = Barwert (der anfängliche Betrag) 

Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zah-

lung erreichen möchten. Wenn Sie das Argument Zw nicht angeben, wird es auf 

Null gesetzt. 

Fälligkeit (optional) = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 

Beispiel: 

RMZ(6,5%; 10; 1000) ergibt -139,10 

Siehe auch: 

BW, ISPMT, KAPZ, ZINS, ZINSZ, ZW, ZZR 

RÖMISCH (Römische Schreibweise einer Zahl) 

Syntax: 

RÖMISCH(Zahl [; Darstellung]) 

Beschreibung: 

Wandelt eine Zahl in eine Zeichenkette mit der römischen Schreibweise dieser 

Zahl um. 

Der zulässige Wertebereich für Zahl ist: 0  Zahl < 4000. 

Zahl sollte eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker auto-

matisch alle Nachkommastellen. 

Wenn Zahl Null ist, wird eine leere Zeichenkette zurückgeliefert. 

Wird das optionale Argument Darstellung angegeben, versucht PlanMaker, die 

römische Zahl in verkürzter Schreibweise darzustellen (siehe Beispiele). Für Dar-

stellung sind Werte von 0 (nicht kürzen) bis 4 (so kurz wie möglich) zulässig. 



 

Handbuch PlanMaker Formeln und Funktionen    653 

Beispiel: 

RÖMISCH(1999) ergibt MCMXCIX 

RÖMISCH(1999; 0) ergibt ebenfalls MCMXCIX 

RÖMISCH(1999; 1) ergibt MLMIL 

RÖMISCH(1999; 2) ergibt MXMIX 

RÖMISCH(1999; 3) ergibt MVMIV 

RÖMISCH(1999; 4) ergibt MIM 

RUNDEN (Runden auf n Stellen) 

Syntax: 

RUNDEN(Zahl; n) 

Beschreibung: 

Rundet eine Zahl auf n Nachkommastellen. 

n ist die gewünschte Anzahl an Nachkommastellen.  

Wird n nicht angegeben, wird die Zahl auf 0 Nachkommastellen gerundet. 

n darf auch ein negativer Wert sein, worauf der ganzzahlige Teil der Zahl gerundet 

wird: Ist n beispielsweise -2, wird die Zahl auf ein Vielfaches von Hundert gerun-

det (siehe letztes Beispiel). 

Beispiel: 

RUNDEN(1,234; 2) ergibt 1,23 

RUNDEN(1,235; 2) ergibt 1,24 

RUNDEN(444,222; 0) ergibt 444 

RUNDEN(444,222; -2) ergibt 400 
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Siehe auch: 

ABRUNDEN, AUFRUNDEN, KÜRZEN, VRUNDEN 

SÄUBERN (Nicht-druckbare Zeichen entfernen) 

Syntax: 

SÄUBERN(Zeichenkette) 

Beschreibung: 

Entfernt alle nicht-druckbaren Zeichen aus einer Zeichenkette (alle Zeichen mit 

einem ANSI-Code < 32). 

SCHÄTZER (Schätzwert für einen linearen Trend) 

Syntax: 

SCHÄTZER(x; y_Werte; x_Werte) 

Beschreibung: 

Liefert zum angegebenen x-Wert x den y-Wert auf einer Regressionsgeraden, die 

anhand der übergebenen x- und y-Werte gebildet wird. 

Eine Regressionsgerade ist das Resultat einer linearen Regression. Darunter ver-

steht man das Anpassen einer linearen Funktion (Regressionsgerade oder Aus-

gleichsgerade genannt) an eine Menge von Punkten (zum Beispiel den Messpunk-

ten einer Messreihe). 

Mit der Funktion SCHÄTZER können Sie voraussagen, welchen Wert y (der ab-

hängigen Variable) bei einem bestimmten Wert x (der unabhängigen Variable) un-

gefähr haben wird. 

Sie können somit beispielsweise abschätzen, welchen Widerstand ein temperatur-

abhängiger Widerstand bei einer bestimmten Temperatur haben wird, nachdem Sie 

den Widerstand bei verschiedenen anderen Temperaturen gemessen haben. 
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Für die Argumente y_Werte und x_Werte geben Sie in der Regel einen Zellbe-

reich an. 

y_Werte sind die abhängigen Variablen (in obigem Beispiel also der Widerstand). 

x_Werte sind die unabhängigen Variablen (in obigem Beispiel also die Tempera-

tur). 

Hinweis: 

Beachten Sie, dass diese Funktion als zweites und drittes Argument erst die 

y_Werte und dann die x_Werte erwartet – nicht umgekehrt. 

Anmerkung: 

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleins-

ten Quadrate durchgeführt. 

Beispiel: 

Von einem temperaturabhängigen Widerstand wurde gemessen, welcher Wider-

stand bei verschiedenen Temperaturen vorliegt. 

In den Zellen A1 bis A4 sind die x-Koordinaten der Messpunkte eingetragen (also 

die unabhängigen Variablen; in unserem Beispiel ist das die Temperatur): 8, 20, 25, 

28 

In den Zellen B1 bis B4 sind die y-Koordinaten eingetragen (also die abhängigen 

Variablen; in unserem Beispiel ist dies der Widerstand): 261, 508, 608, 680 

Mit der folgenden Formel können Sie abschätzen, welcher Widerstand bei 15°C 

geliefert werden wird: 

SCHÄTZER(15; B1:B4; A1:A4) ergibt 405,21805 (Ohm) 

Siehe auch: 

ACHSENABSCHNITT, STEIGUNG 

Anmerkung: 

ACHSENABSCHNITT(y_Werte; x_Werte) entspricht SCHÄTZER(0; y_Werte; 

x_Werte). 
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SCHIEFE (Schiefe einer Verteilung) 

Syntax: 

SCHIEFE(Zahl1; Zahl2; Zahl3 [; Zahl4 ...]) 

oder 

SCHIEFE(Bereich1; Bereich2 [; Bereich3 ...]) 

Beschreibung: 

Berechnet die Schiefe der Dichtefunktion einer Wahrscheinlichkeitsverteilung. 

Die Schiefe ist ein Maß für den Grad der Asymmetrie dieser Funktion. 

Befinden sich mehr Werte rechts des arithmetischen Mittels der Verteilung, spricht 

man von einer „rechtsschiefen“ Verteilung. SCHIEFE liefert hier einen positiven 

Wert. 

Den umgekehrten Fall bezeichnet man als „linksschiefe“ Verteilung. Hier liefert 

SCHIEFE einen negativen Wert. 

Wenn sich die SCHIEFE Null annähert, so ist die betrachtete Dichtefunktion in 

guter Näherung symmetrisch. 

Zahl1, Zahl2, Zahl3 etc. sind die Werte der Verteilung, deren Schiefe berechnet 

werden soll. Leere Zellen sowie Zeichenketten und Wahrheitswerte werden igno-

riert. 

Es müssen mindestens drei Werte angegeben sein; andernfalls liefert die Funktion 

den Fehlerwert #DIV/0! (Division durch Null). 

Hinweis: 

Diese Funktion erwartet als Argumente keine Wertepaare (x-Wert und y-Wert), 

sondern nur die Werte der Verteilung. Mehrmals vorkommende Werte müssen ent-

sprechend oft wiederholt werden (siehe Beispiel). 

Beispiel: 

Sie messen die Körpergrößen von Menschen und erhalten dabei folgende Ergeb-

nisse: 1 x 1,60m, 2 x 1,65m, 4 x 1,70m, 2 x 1,75m und 1x1,80m.  
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Die Dichtefunktion der Verteilung dieser Messergebnisse hat folgende Schiefe: 

SCHIEFE(1,60; 1,65; 1,65; 1,70; 1,70; 1,70; 1,70; 1,75; 1,75; 1,80) ergibt 

4,66562E-15; liegt also nahezu bei Null. 

Siehe auch: 

ACHSENABSCHNITT, SCHÄTZER, KURT, NORMVERT 

SCHNITTBEREICH (Schnittmenge zweier Bereiche) 

Syntax: 

SCHNITTBEREICH(Bereich1; Bereich2) 

Beschreibung: 

Liefert einen Bezug auf den Zellbereich, der sich sowohl in Bereich1 als auch in 

Bereich2 befindet. 

Alternativ zu dieser Funktion können Sie auch den Operator \ verwenden. SUM-

ME(SCHNITTBEREICH(A1:D4; C3:E6)) ist also gleichbedeutend mit SUM-

ME(A1:D4\C3:E6). 

Kompatibilitätshinweis: 

Beim Bilden von Schnittbereichen gibt es folgende Unterschiede zwischen Plan-

Maker und Excel: 

1. Die Funktion SCHNITTBEREICH ist in Excel nicht vorhanden.  

Wenn Sie eine Datei, die diese Funktion verwendet, im Excel-Format speichern, 

wandelt PlanMaker die Funktion daher automatisch in eine Excel-kompatible 

Schreibweise um (ersetzt sie also durch entsprechende Operatoren). 

2. Excel verwendet als Operator für Schnittmengen nicht \ sondern die Leer-

taste. 

Beim Öffnen und Speichern von Excel-Dateien werden diese Operatoren daher von 

PlanMaker automatisch ersetzt. Öffnen Sie also eine Excel-Datei, in der ein Leer-

zeichen als Operator verwendet wird, erscheint in PlanMaker automatisch das Zei-
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chen \. Speichern Sie diese Datei dann im Excel-Format, wird \ wieder in ein Leer-

zeichen gewandelt. 

Beispiel: 

SCHNITTBEREICH(A1:D4; C3:E6) liefert einen Bezug auf C3:D4 

SEKUNDE (Sekunde aus einem Datumswert ermitteln) 

Syntax: 

SEKUNDE(Uhrzeit) 

Beschreibung: 

Liefert den Sekundenanteil aus einem Datumswert. 

Beispiel: 

SEKUNDE("12:34:56") ergibt 56 

SEKUNDE("25.09.2013 10:30:56") ergibt 56 

Siehe auch: 

STUNDE, MINUTE, MILLISEKUNDEN 

SIN (Sinus) 

Syntax: 

SIN(Zahl) 

Beschreibung: 

Liefert den Sinus eines Winkels.  
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Der Winkel ist dabei im Bogenmaß (Radiant) anzugeben. 

Tipp: 

Mit der Funktion BOGENMASS können Sie einen in Grad vorliegenden Winkel 

ins Bogenmaß umrechnen. 

Beispiel: 

SIN(PI()/2) ergibt 1 

SIN(BOGENMASS(90)) ergibt 1 

Siehe auch: 

ARCSIN 

SINHYP (Sinus Hyperbolicus) 

Syntax: 

SINHYP(Zahl) 

Beschreibung: 

Die Funktion SINHYP (Sinus Hyperbolicus) liefert den hyperbolischen Sinus ei-

ner Zahl. 

Beispiel: 

SINHYP(0,45) ergibt 0,4653 

Siehe auch: 

ARCSINHYP 
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SORTIERENM (Sortieren) 

Syntax: 

SORTIERENM(Bereich; Schlüssel [; GroßKlein] [; Spaltenweise] [; Spaltennum-

mer]) 

Beschreibung: 

Diese Funktion sortiert einen Zellbereich oder eine Matrix nach einem oder mehre-

ren Kriterien. Als Ergebnis liefert sie eine Matrix mit den sortierten Werten. 

Bereich bestimmt den Datenbereich, der sortiert werden soll. Sie können einen 

hierfür ein- oder zweidimensionalen Zellbereich oder eine Matrix angeben. 

Schlüssel bestimmt, nach welchen Zeilen der Datenbereich sortiert werden soll. 

Geben Sie dazu einen zweizeiligen Zellbereich oder eine zweizeilige Matrix mit 

folgendem Inhalt an: 

In der ersten Zeile müssen die Nummern der Zeilen im Datenbereich angegeben 

werden, nach denen sortiert werden soll. Geben Sie also als Sortierschlüssel {1.3} 

an, wird nach der ersten und der dritten Zeile sortiert.  

In der zweiten Zeile kann (optional) anhand eines Wahrheitswerts angegeben wer-

den, dass absteigend sortiert werden soll:  

FALSCH oder nicht angegeben: aufsteigend sortieren 

WAHR: absteigend sortieren 

Geben Sie also als Sortierschlüssel {1.3; wahr.falsch} an, wird nach der ersten Zei-

le absteigend und der dritten Zeile aufsteigend sortiert. 

Das optionale Argument GroßKlein bestimmt, ob bei Zeichenketten auch nach 

Groß-/Kleinschreibung sortiert werden soll: 

FALSCH oder nicht angegeben: Groß-/Kleinschreibung ignorieren 

WAHR: Groß-/Kleinschreibung beachten, also Begriffe, bei denen der erste Buch-

stabe klein geschrieben ist, vor Begriffe sortieren, die mit demselben Buchstaben in 

Großschreibung beginnen. 

Das optionale Argument Spaltenweise bestimmt, ob die Sortierung zeilen- oder 

spaltenweise erfolgen soll: 

FALSCH oder nicht angegeben: zeilenweise sortieren 
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WAHR: spaltenweise sortieren 

Wenn Sie das optionale Argument Spaltennummer verwenden, liefert die Funkti-

on statt der gesamten Daten nur eine bestimmte Spalte (beziehungsweise Zeile – 

bei spaltenweiser Sortierung) zurück: 

Wird dieses Argument nicht angegeben, liefert die Funktion alle Spalten des Da-

tenbereichs zurück. 

Wird es auf n gesetzt, wird nur die n-te Spalte des Datenbereichs zurückgeliefert. 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 450. 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

SORTIERENM({4;2;3}; {1}) ergibt {2;3;4} 

SORTIERENM({4;2;3}; {1; WAHR}) ergibt {4;3;2} 

Siehe auch: 

SORTIERENV, Abschnitt „Sortieren“ ab Seite 95 

SORTIERENV (Sortieren) 

Syntax: 

SORTIERENV(Bereich [; Absteigend] [; GroßKlein] [; Datenbereich]) 
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Beschreibung: 

Diese Funktion sortiert einen eindimensionalen Zellbereich oder Vektor. Als Er-

gebnis liefert sie einen Vektor mit den sortierten Werten. 

Der Unterschied zur Funktion SORTIERENM liegt darin, dass SORTIERENV nur 

auf eindimensionale Bereiche angewandt werden kann. Das sind Bereiche, die 

entweder nur eine Zeile oder nur eine Spalte umfassen. 

Bereich ist der eindimensionale Bereich, der sortiert werden soll. 

Das optionale Argument Absteigend bestimmt, ob absteigend sortiert werden soll: 

FALSCH oder nicht angegeben: aufsteigend sortieren 

WAHR: absteigend sortieren 

Das optionale Argument GroßKlein bestimmt, ob bei Zeichenketten auch nach 

Groß-/Kleinschreibung sortiert werden soll: 

FALSCH oder nicht angegeben: Groß-/Kleinschreibung ignorieren 

WAHR: Groß-/Kleinschreibung beachten, also Begriffe, bei denen der erste Buch-

stabe klein geschrieben ist, vor Begriffe sortieren, die mit demselben Buchstaben in 

Großschreibung beginnen. 

Wenn Sie das optionale Argument Datenbereich verwenden, liefert die Funktion 

als Ergebnis nicht die Daten aus Bereich, sondern die Daten aus Datenbereich 

zurück. Datenbereich muss genau die gleichen Ausmaße wie Bereich haben. 

Dies ist praktisch, wenn Sie beispielsweise eine Tabelle erstellen, die eine Spalte 

mit den Namen von Sportlern und daneben eine Spalte mit deren Punktzahl enthält. 

Geben Sie hier als Bereich die Spalte mit den Punktzahlen ein, als Datenbereich 

jedoch die Spalte mit den Namen, erhalten Sie als Ergebnis eine Namensliste, die 

nach Punktzahlen sortiert ist. 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 450. 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 
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Beispiel: 

SORTIERENV({4;2;3}) ergibt {2;3;4} 

SORTIERENV({4;2;3}; WAHR) ergibt {4;3;2} 

SORTIERENV({4.2.3}) ergibt {2.3.4} 

Siehe auch: 

SORTIERENM, Abschnitt „Sortieren“ ab Seite 95 

SPALTE (Spaltennummer von Zellen) 

Syntax: 

SPALTE([Bezug]) 

Beschreibung: 

Liefert die Spaltennummer(n) einer Zelle oder eines Bereichs von Zellen: 

Ist Bezug eine einzelne Zelle, liefert die Funktion die Spaltennummer dieser Zelle. 

Ist Bezug ein Bereich von Zellen, liefert die Funktion die darin enthaltenen Spal-

tennummern als horizontale Matrix. Hinweis: In diesem Fall muss die Formel als 

Matrixformel eingegeben werden (siehe Abschnitt „Arbeiten mit Matrizen“ ab Sei-

te 450). 

Wird das Argument Bezug nicht angegeben, liefert die Funktion die Spaltennum-

mer der Zelle, in der sie aufgerufen wurde. 

Beispiel: 

SPALTE(D2) ergibt 4 

SPALTE(D2:F4) ergibt {4.5.6} 

SPALTE() ergibt 3, wenn Sie die Funktion SPALTE() beispielsweise in der Zelle 

C5 aufrufen 
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Siehe auch: 

ZEILE, SPALTEN 

SPALTEN (Anzahl Spalten) 

Syntax: 

SPALTEN(Bereich) 

Beschreibung: 

Liefert die Zahl der Spalten im angegebenen Bereich. 

Beispiel: 

SPALTEN(A1:D5) ergibt 4 

Siehe auch: 

ZEILEN, SPALTE 

STABW (Standardabweichung einer Stichprobe) 

Syntax: 

STABW(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Liefert einen Schätzwert für die Standardabweichung der Grundgesamtheit anhand 

einer Stichprobe. 

Die Standardabweichung gibt an, um welchen Betrag die übergebenen Werte 

durchschnittlich vom Mittelwert abweichen. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte (Stichprobe).  



 

Handbuch PlanMaker Formeln und Funktionen    665 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Anmerkung: 

Die Standardabweichung wird nach der Methode „Erwartungstreue Schätzung“ 

oder „n-1“ berechnet. 

Beispiel: 

STABW(2; 2; 3; 4; 1) ergibt 1,14018 

Siehe auch: 

STABWN, VARIANZ 

STABWA (Standardabweichung) 

Syntax: 

STABWA(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Die Funktion STABWA entspricht nahezu der Funktion STABW (siehe Hinweis). 

Sie liefert also einen Schätzwert für die Standardabweichung der Grundgesamtheit 

anhand einer Stichprobe. 

Die Standardabweichung gibt an, um welchen Betrag die übergebenen Werte 

durchschnittlich vom Mittelwert abweichen. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte (Stichprobe).  

Hinweis: 

Im Gegensatz zu STABW berücksichtigt die Funktion STABWA auch Werte, die 

keine Zahlen sind: Beliebige Zeichenketten und der Wahrheitswert FALSCH wer-

den als 0 interpretiert, WAHR als 1. 
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Leere Zellen werden hingegen auch hier ignoriert. 

Anmerkung: 

Die Standardabweichung wird nach der Methode „Erwartungstreue Schätzung“ 

oder „n-1“ berechnet. 

Beispiel: 

STABWA(2; 2; 3; 4; 1) ergibt 1,14018 

Siehe auch: 

STABW 

STABWN (Standardabweichung einer Grundgesamtheit) 

Syntax: 

STABWN(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Liefert die Standardabweichung einer Grundgesamtheit. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte. Es müssen alle Werte der 

Grundgesamtheit angegeben werden. Falls nur eine Stichprobe aus der Grundge-

samtheit vorliegt, ist statt STABWN die Funktion STABW zu verwenden. Diese 

liefert einen Schätzwert für die Standardabweichung. 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Anmerkung: 

Die Standardabweichung wird nach der Methode „n“ berechnet. 
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Beispiel: 

STABWN(2; 2; 3; 4; 1) ergibt 1,0198 

Siehe auch: 

STABW, VARIANZEN 

STABWNA (Standardabweichung) 

Syntax: 

STABWNA(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Die Funktion STABWNA entspricht nahezu der Funktion STABWN (siehe Hin-

weis). Sie liefert also die Standardabweichung einer Grundgesamtheit. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte. Es müssen alle Werte der 

Grundgesamtheit angegeben werden. Falls nur eine Stichprobe aus der Grundge-

samtheit vorliegt, ist statt STABWNA die Funktion STABWA zu verwenden. Diese 

liefert einen Schätzwert für die Standardabweichung. 

Hinweis: 

Im Gegensatz zu STABWN berücksichtigt die Funktion STABWNA auch Werte, 

die keine Zahlen sind: Beliebige Zeichenketten und der Wahrheitswert FALSCH 

werden als 0 interpretiert, WAHR als 1. 

Leere Zellen werden hingegen auch hier ignoriert. 

Anmerkung: 

Die Standardabweichung wird nach der Methode „n“ berechnet. 

Beispiel: 

STABWNA(2; 2; 3; 4; 1) ergibt 1,0198 



 

668    Formeln und Funktionen Handbuch PlanMaker 

Siehe auch: 

STABWN 

STANDARDISIERUNG (Standardisierung) 

Syntax: 

STANDARDISIERUNG(x; Mittelwert; Standardabweichung) 

Beschreibung: 

Berechnet den standardisierten Wert von x, basierend auf einer durch Mittelwert 

und Standardabweichung definierten Verteilung. 

x ist der zu standardisierende Wert. 

Mittelwert ist das arithmetische Mittel der Verteilung. 

Standardabweichung ist die Standardabweichung der Verteilung. 

Beispiel: 

STANDARDISIERUNG(5; 4; 1,25) ergibt 0,8 

Siehe auch: 

MITTELWERT, STABW, NORMVERT, STANDNORMVERT 

STANDNORMINV (Quantile einer Standardnormalverteilung) 

Syntax: 

STANDNORMINV(Wahrscheinlichkeit) 

Beschreibung: 

Liefert Quantile einer Standardnormalverteilung.  
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Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Verteilung. Zu-

lässig sind nur Werte aus dem Intervall [0..1]. 

Hinweis: 

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. 

Findet PlanMaker nach 100 Iterationen kein Ergebnis, das weniger als 3x10^-7 

von Wahrscheinlichkeit abweicht, zeigt er den Fehlerwert #NV an und bricht die 

Näherung ab. 

Siehe auch: 

NORMINV, STANDNORMVERT 

STANDNORMVERT (Standardnormalverteilung) 

Syntax: 

STANDNORMVERT(x) 

Beschreibung: 

Liefert die kumulierten Wahrscheinlichkeiten einer standardnormalverteilten Zu-

fallsvariablen. 

Die Standardnormalverteilung (auch „standardisierte Normalverteilung“ genannt) 

ist eine Normalverteilung (siehe Funktion NORMVERT), deren arithmetisches 

Mittel  gleich Null und deren Standardabweichung  gleich 1 ist. 

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. 

Anmerkung: 

Geliefert wird die Verteilungsfunktion (also die integrierte Dichtefunktion). 

Siehe auch: 

NORMVERT 
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STEIGUNG (Steigung einer Regressionsgeraden) 

Syntax: 

STEIGUNG(y_Werte; x_Werte) 

Beschreibung: 

Ermittelt die Steigung einer Regressionsgeraden. Als Steigung bezeichnet man den 

Wert, um den die y-Koordinate wächst, wenn man die x-Koordinate um Eins er-

höht. 

Eine Regressionsgerade ist das Resultat einer linearen Regression. Darunter ver-

steht man das Anpassen einer linearen Funktion (Regressionsgerade oder Aus-

gleichsgerade genannt) an eine Menge von Punkten (zum Beispiel den Messpunk-

ten einer Messreihe). 

Für die Argumente y_Werte und x_Werte geben Sie in der Regel einen Zellbe-

reich an. 

y_Werte sind die abhängigen Variablen. 

x_Werte sind die unabhängigen Variablen. 

Hinweis: 

Beachten Sie, dass diese Funktion erst die y_Werte und dann die x_Werte erwar-

tet – nicht umgekehrt. 

Anmerkung: 

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleins-

ten Quadrate durchgeführt. 

Beispiel: 

Von einem temperaturabhängigen Widerstand wurde gemessen, welcher Wider-

stand bei verschiedenen Temperaturen vorliegt. 

In den Zellen A1 bis A4 sind die x-Koordinaten der Messpunkte eingetragen (also 

die unabhängigen Variablen; in unserem Beispiel ist das die Temperatur): 8, 20, 25, 

28 
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In den Zellen B1 bis B4 sind die y-Koordinaten eingetragen (also die abhängigen 

Variablen; in unserem Beispiel ist dies der Widerstand): 261, 508, 608, 680 

Mit der folgenden Formel können Sie die Steigung der Regressionsgeraden ermit-

teln, die obigen Messwerten zugrunde liegt: 

STEIGUNG(B1:B4; A1:A4) ergibt 20,76799 

Siehe auch: 

ACHSENABSCHNITT, SCHÄTZER 

STFEHLERYX (Standardfehler einer linearen Regression) 

Syntax: 

STFEHLERYX(y_Werte; x_Werte) 

Beschreibung: 

Liefert den Standardfehler einer linearen Regression. 

Der Standardfehler ist ein Maß für die Zuverlässigkeit einer linearen Regression: Je 

größer der Standardfehler, desto stärker weichen die geschätzten Werte von den 

tatsächlichen Werten ab. 

Für die Argumente y_Werte und x_Werte geben Sie in der Regel einen Zellbe-

reich an. 

y_Werte sind die abhängigen Variablen. 

x_Werte sind die unabhängigen Variablen. 

Hinweis: 

Beachten Sie, dass diese Funktion erst die y_Werte und dann die x_Werte erwar-

tet – nicht umgekehrt. 
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Anmerkung: 

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleins-

ten Quadrate durchgeführt. 

Beispiel: 

Von einem temperaturabhängigen Widerstand wurde gemessen, welcher Wider-

stand bei verschiedenen Temperaturen vorliegt. 

In den Zellen A1 bis A4 sind die x-Koordinaten der Messpunkte eingetragen (also 

die unabhängigen Variablen; in unserem Beispiel ist das die Temperatur): 8, 20, 25, 

28 

In den Zellen B1 bis B4 sind die y-Koordinaten eingetragen (also die abhängigen 

Variablen; in unserem Beispiel ist dies der Widerstand): 261, 508, 608, 680 

Mit der folgenden Formel ermitteln Sie den Standardfehler der Regression, die 

obigen Messwerten zugrunde liegt: 

STFEHLERYX(B1:B4; A1:A4) ergibt 4,97351 

Siehe auch: 

ACHSENABSCHNITT, STEIGUNG, SCHÄTZER 

STUNDE (Stunde aus einem Datumswert ermitteln) 

Syntax: 

STUNDE(Uhrzeit) 

Beschreibung: 

Liefert den Stundenanteil aus einem Datumswert. 

Beispiel: 

STUNDE("12:34:56") ergibt 12 

STUNDE("25.09.2013 10:30:56") ergibt 10 
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Siehe auch: 

MINUTE, SEKUNDE, MILLISEKUNDEN 

SUCHEN (Text in Zeichenkette suchen) 

Syntax: 

SUCHEN(Suchbegriff; Zeichenkette [; Startposition]) 

Beschreibung: 

Ermittelt die Position von Suchbegriff in Zeichenkette. 

Mit dem optionalen Argument Startposition können Sie festlegen, ab welchem 

Zeichen der Zeichenkette gesucht werden soll. Wird er nicht angegeben, beginnt 

die Suche mit dem ersten Zeichen. 

Die Groß-/Kleinschreibung des Suchbegriffs spielt dabei keine Rolle. Verwenden 

Sie die Funktion FINDEN, wenn die Groß-/Kleinschreibung beachtet werden soll. 

Beispiel: 

SUCHEN("a"; "Banane") ergibt 2 

SUCHEN("A"; "Banane") ergibt 2 

SUCHEN("a"; "Banane"; 3) ergibt 4 

SUCHEN("x"; "Banane") ergibt den Fehlerwert #WERT!, da in der durchsuchten 

Zeichenkette kein „x“ vorkommt. 

Siehe auch: 

FINDEN, IDENTISCH, WECHSELN 
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SUMME (Summe) 

Syntax: 

SUMME(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Bildet die Summe aus den angegebenen Zahlenwerten. 

Anmerkung: 

Beachten Sie: Normalerweise berücksichtigt diese Funktion nur Zahlen und igno-

riert Zeichenketten und Wahrheitswerte. Anders sieht es allerdings aus, wenn Sie 

ihr feste Werte übergeben: Hier werden Zeichenketten, die Zahlen enthalten, einbe-

zogen. Weiterhin werden die Wahrheitswerte WAHR als 1 und FALSCH als 0 be-

handelt. Siehe Beispiele. 

Beispiel: 

SUMME(1; 2; 3; 4) entspricht 1+2+3+4, ergibt also 10 

Wenn die Zellen A1 bis A4 mit den Werten 1, 2, 3 und 4 gefüllt sind, gilt: 

SUMME(A1:A4) entspricht 1+2+3+4, ergibt also 10 

Aber: 

SUMME(1; "2"; WAHR) ergibt 1+2+1, also 4 

Aber: Sind die Zellen A1 bis A3 mit 1, "2" und WAHR gefüllt, liefert die Formel 

SUMME(A1:A3) ein anderes Ergebnis: Es kommt 1 heraus, da Zeichenketten und 

Wahrheitswerte nur berücksichtigt werden, wenn sie als feste Werte übergeben 

wurden. 

Tipp 1: 

Über das Summensymbol in der Bearbeitungsleiste können Sie besonders schnell 

die Summe eines bestimmten Zellbereichs bilden: Klicken Sie das Summensymbol 

dazu an und markieren Sie mit der Maus die zu summierenden Zellen. 
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Tipp 2: 

Das AutoSummen-Symbol  in der Funktionsleiste ist ein weiterer prakti-

scher Helfer: 

Wenn Sie dieses Symbol in einer leeren Zelle direkt unter einer Gruppe von Zellen 

mit Zahlen anklicken, fügt es dort automatisch die Summenfunktion für diesen 

Zellbereich ein.  

Alternativ können Sie auch erst einen Bereich von Zellen mit Zahlen markieren 

und das Symbol dann anklicken, worauf es die Summe dieses Zellbereichs direkt 

darunter einfügt. 

Sie können dieses Symbol auch für andere Funktionen verwenden. Klicken Sie 

dazu auf das Pfeilchen rechts neben dem Symbol. Es öffnet sich eine Liste der ver-

fügbaren Funktionen – zum Beispiel Anzahl, Produkt, Mittelwert etc. Wählen Sie 

darin die gewünschte Funktion und gehen Sie dann wie oben beschrieben vor. 

Siehe auch: 

PRODUKT, SUMMENPRODUKT 

SUMMENPRODUKT (Summenprodukt) 

Syntax: 

SUMMENPRODUKT(Bereich1; Bereich2 [; Bereich3 ...]) 

Beschreibung: 

Multipliziert alle sich entsprechenden Elemente von zwei oder mehr Matrizen mit-

einander und bildet dann die Summe dieser Produkte. 

Bereich1, Bereich2 etc. sind die Matrizen, deren Summenprodukt berechnet wer-

den soll. In der Regel sind hier die Zellbereiche anzugeben, in denen die Werte 

enthalten sind.  

Die Zahl der Zeilen und Spalten der einzelnen Matrizen muss identisch sein, an-

dernfalls liefert die Funktion den Fehlerwert #NV. 

Leere Zellen und Zellen mit einem nicht-numerischen Inhalt (Zeichenketten etc.) 

werden als Null interpretiert. 
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Beispiel: 

Sie haben ein Dokument erstellt, in dem Sie Ihren Lagerbestand erfassen.  

Das Dokument enthält zwei gleich große Bereiche. Im ersten sind die Stückzahlen 

der Artikel eingetragen. Im zweiten Bereich die zugehörigen Einzelpreise.  

 

Um den Gesamtwert aller Artikel im Lager auszurechnen, müssen die Stückzahlen 

der einzelnen Artikel mit ihrem jeweiligen Einzelpreis multipliziert werden. 

Schließlich muss die Summe dieser Produkte gebildet werden.  

Diese gesamte Berechnung bekommen Sie mit der Funktion SUMMENPRODUKT 

unter einen Hut:  

SUMMENPRODUKT(B4:C6; B11:C13) ergibt 12710.  

Es befinden sich derzeit also Artikel im Wert von € 12710,- im Lager. 

Siehe auch: 

SUMME 
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SUMMEWENN (Summe ausgewählter Werte) 

Syntax: 

SUMMEWENN(Suchbereich; Suchkriterium [; Summenbereich]) 

Beschreibung: 

Bildet die Summe derjenigen Werte in einem Bereich, für die die angegebene Be-

dingung zutrifft.  

Suchbereich ist der zu durchsuchende Bereich. 

Suchkriterium ist die zu erfüllende Bedingung: 

Hier können Sie einerseits einfach einen Wert angeben (zum Beispiel "42" oder 

"Schrauben"). In diesem Fall werden alle Posten addiert, die diesem Wert entspre-

chen. 

Andererseits ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier werden 

alle Posten addiert, die dieser Bedingung entsprechen. 

Hinweis: Das Suchkriterium sollte stets mit doppelten Anführungszeichen (") um-

geben werden. 

Das optionale Argument Summenbereich bestimmt, welche Werte tatsächlich ad-

diert werden sollen. Wenn Summenbereich nicht angegeben ist, werden die Werte 

im Suchbereich addiert. 

Beispiel: 

In den Zellen A1 bis A5 stehen die Werte 1; 2; 3; 2; 1. Hier gilt: 

SUMMEWENN(A1:A5; "2") ergibt 2+2, also 4 

SUMMEWENN(A1:A5; ">=2") ergibt 2+3+2, also 7 

Sie tragen Ihre Tageseinnahmen in eine Tabelle ein – etwa wie folgt: 
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Wie groß ist die Summe der Umsätze, wenn man nur Umsätze größer als € 40,- 

berücksichtigt? 

SUMMEWENN(D2:D5; ">40") ergibt 100,80 Euro 

Wie viele Blumen der Gattung „Rosen“ wurden verkauft? 

SUMMEWENN(C2:C5; "Rosen"; B2:B5) ergibt 18 

Bei obiger Formel wurde das optionale Argument Summenbereich eingesetzt: Der 

Suchbereich C2:C5 (also die Sorte) wurde durchsucht, die zu addierenden Zahlen 

wurden jedoch dem Summenbereich B2:B5 (also der Stückzahl) entnommen. 

Siehe auch: 

MITTELWERTWENN, MITTELWERTWENNS, SUMME, SUMMEWENNS, 

ZÄHLENWENN, ZÄHLENWENNS 

SUMMEWENNS (Summe ausgewählter Werte) 

Syntax: 

SUMMEWENNS(Summenbereich; Suchbereich1; Suchkriterium1 [; Suchbe-

reich2; Suchkriterium2 ...]) 

Beschreibung: 

Bildet die Summe derjenigen Werte in einem Bereich, für die alle angegebenen 

Bedingungen zutreffen.  



 

Handbuch PlanMaker Formeln und Funktionen    679 

Entspricht der Funktion SUMMEWENN, erlaubt allerdings die Verwendung meh-

rerer Suchbereiche (inklusive eines Suchkriteriums für jeden Bereich). 

Beachten Sie: Die Reihenfolge der Parameter ist hier anders als bei SUMME-

WENN: Bei SUMMEWENNS ist der Summenbereich der erste Parameter und 

nicht der letzte.  

Summenbereich ist der Bereich mit den Werten, die addiert werden sollen.  

Suchbereich1 ist der erste zu durchsuchende Bereich. Dieser muss die gleichen 

Ausmaße haben wie der Summenbereich. 

Suchkriterium1 ist die Bedingung, die die Werte in Suchbereich1 erfüllen müs-

sen: 

Hier können Sie einerseits einfach einen Wert angeben (zum Beispiel "42" oder 

"Schrauben"). In diesem Fall werden alle Posten addiert, die diesem Wert entspre-

chen. 

Andererseits ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier werden 

alle Posten addiert, die dieser Bedingung entsprechen. 

Hinweis: Die Suchkriterien sollten stets mit doppelten Anführungszeichen (") um-

geben werden. 

Im Gegensatz zur Funktion SUMMEWENN können Sie bei SUMMEWENNS 

auch mehrere Suchbereiche mit jeweils dazugehörendem Suchkriterium angeben. 

Es werden dann nur diejenigen Werte addiert, bei denen alle Kriterien erfüllt sind. 

Kompatibilitätshinweis: 

Diese Funktion ist nicht kompatibel zum .xls-Dateiformat von Microsoft Excel 

2003 und früher. Wenn Sie ein Dokument in diesem Format speichern, werden alle 

Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester 

Wert ersetzt.  

Wenn Sie diese Funktion einsetzen möchten, sollten Sie Ihr Dokument also nicht 

im Dateiformat „Microsoft Excel 97-2003 (.xls)“ speichern, sondern eines der fol-

genden Formate verwenden: 

 „PlanMaker-Dokument (.pmd)“ 

 oder: „Microsoft Excel 2007-2010 (.xlsx)“ 
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Beispiel: 

SUMMEWENNS(A1:A10; C1:C10; ">1"; C1:C10; "<2")  

Diese Formel liefert die Summe all derjenigen Zellen im Bereich A1:A10, bei de-

nen die entsprechende Zelle im Bereich C1:C10 größer als 1 und kleiner als 2 ist. 

Siehe auch: 

MITTELWERTWENN, MITTELWERTWENNS, SUMME, SUMMEWENN, 

ZÄHLENWENN, ZÄHLENWENNS 

SUMMEX2MY2 (Summe von x^2 - y^2) 

Syntax: 

SUMMEX2MY2(Bereich1; Bereich2) 

Beschreibung: 

Subtrahiert jeweils die Quadrate der sich entsprechenden Elemente von zwei Mat-

rizen und bildet dann die Summe dieser Differenzen. 

Es wird also folgende Berechnung durchgeführt: 

SUMMEX2MY2 = (x^2 - y^2) 

Bereich1 und Bereich2 sind die Matrizen, deren SummeX2MY2 berechnet wer-

den soll. In der Regel sind hier die Zellbereiche anzugeben, in denen die Werte 

enthalten sind.  

Die Zahl der Zeilen und Spalten dieser beiden Matrizen muss identisch sein, an-

dernfalls liefert die Funktion den Fehlerwert #NV. 

Wertepaare, bei denen mindestens ein Wert leer oder nicht-numerisch ist, werden 

ignoriert. 

Beispiel: 

In den Zellen A1 bis A3 stehen folgende Werte: 9, 4, 7 

In den Zellen B1 bis B3 stehen folgende Werte: 1, 0, 5 
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Wenn Sie hier SUMMEX2MY2(A1:A3; B1:B3) berechnen, entspricht das folgen-

der Berechnung: 

(9^2) - (1^2) + (4^2) - (0^2) + (7^2) - (5^2) 

Das Ergebnis ist 120. 

Siehe auch: 

SUMME, SUMMENPRODUKT, SUMMEX2PY2, SUMMEXMY2, QUADRA-

TESUMME 

SUMMEX2PY2 (Summe von x^2 + y^2) 

Syntax: 

SUMMEX2PY2(Bereich1; Bereich2) 

Beschreibung: 

Summiert die Quadrate der Elemente von zwei Matrizen. 

Es wird also folgende Berechnung durchgeführt: 

SUMMEX2PY2 = (x^2 + y^2) 

Bereich1 und Bereich2 sind die Matrizen, deren SummeX2PY2 berechnet werden 

soll. In der Regel sind hier die Zellbereiche anzugeben, in denen die Werte enthal-

ten sind.  

Die Zahl der Zeilen und Spalten dieser beiden Matrizen muss identisch sein, an-

dernfalls liefert die Funktion den Fehlerwert #NV. 

Wertepaare, bei denen mindestens ein Wert leer oder nicht-numerisch ist, werden 

ignoriert. 

Beispiel: 

In den Zellen A1 bis A3 stehen folgende Werte: 9, 4, 7 

In den Zellen B1 bis B3 stehen folgende Werte: 1, 0, 5 
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Wenn Sie hier SUMMEX2PY2(A1:A3; B1:B3) berechnen, entspricht das folgen-

der Berechnung: 

(9^2) + (1^2) + (4^2) + (0^2) + (7^2) + (5^2) 

Das Ergebnis ist 172. 

Siehe auch: 

SUMME, SUMMENPRODUKT, SUMMEX2MY2, SUMMEXMY2, QUADRA-

TESUMME 

SUMMEXMY2 (Summe von (x - y)^2) 

Syntax: 

SUMMEXMY2(Bereich1; Bereich2) 

Beschreibung: 

Berechnet jeweils das Quadrat der Differenz der sich entsprechenden Elemente von 

zwei Matrizen und bildet dann die Summe dieser Differenzen. 

Es wird also folgende Berechnung durchgeführt: 

SUMMEXMY2 = (x - y)^2 

Bereich1 und Bereich2 sind die Matrizen, deren SummeXMY2 berechnet werden 

soll. In der Regel sind hier die Zellbereiche anzugeben, in denen die Werte enthal-

ten sind. 

Die Zahl der Zeilen und Spalten dieser beiden Matrizen muss identisch sein, an-

dernfalls liefert die Funktion den Fehlerwert #NV. 

Wertepaare, bei denen mindestens ein Wert leer oder nicht-numerisch ist, werden 

ignoriert. 

Beispiel: 

In den Zellen A1 bis A3 stehen folgende Werte: 9, 4, 7 

In den Zellen B1 bis B3 stehen folgende Werte: 1, 0, 5 
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Wenn Sie hier SUMMEXMY2(A1:A3; B1:B3) berechnen, entspricht das folgender 

Berechnung: 

(9-1)^2 + (4-0)^2 + (7-5)^2 

Das Ergebnis ist 84. 

Siehe auch: 

SUMME, SUMMENPRODUKT, SUMMEX2MY2, SUMMEX2PY2, QUADRA-

TESUMME 

SUMQUADABW (Mittlere quadratische Abweichung vom 

Mittelwert) 

Syntax: 

SUMQUADABW(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Berechnet die mittlere quadratische Abweichung der angegebenen Zahlenwerte 

von ihrem Mittelwert. 

Leere Zellen, Zeichenketten und Wahrheitswerte werden ignoriert. 

Beispiel: 

SUMQUADABW(2; 2; 2; 3) ergibt 0,75 

Siehe auch: 

MITTELABW, STABW, SUMME, VARIANZ 
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SVERWEIS (Zellbereich spaltenweise durchsuchen) 

Syntax: 

SVERWEIS(Suchkriterium; Bereich; n [; Sortiert]) 

Beschreibung: 

Diese Funktion sucht in der ersten Spalte von Bereich nach dem ersten Vorkom-

men von Suchkriterium. Wird es gefunden, liefert die Funktion den Inhalt der 

Zelle, die sich in der gleichen Zeile und der n-ten Spalte von Bereich befindet. 

Suchkriterium ist der gesuchte Wert. Die Groß-/Kleinschreibung spielt keine Rol-

le. 

Bereich ist der zu durchsuchende Zellbereich. Die erste Spalte muss die zu durch-

suchenden Werte enthalten. Dies können Zeichenketten, Zahlen oder Wahrheits-

werte sein. 

Für n ist anzugeben, aus der wievielten Spalte von Bereich ein Wert zurückgelie-

fert werden soll, wenn das Suchkriterium gefunden wird. 

Ist n kleiner als 1, wird der Fehlerwert #BEZUG! zurückgeliefert. Ist n größer als 

die Spaltenzahl von Bereich, wird der Fehlerwert #BEZUG! zurückgeliefert.  

Sortiert ist ein Wahrheitswert, mit dem Sie angeben, ob die Werte in der ersten 

Zeile von Bereich sortiert sind: 

Ist Sortiert WAHR oder nicht angegeben, müssen die Werte in der ersten Spalte 

von Bereich aufsteigend sortiert sein. 

Ist Sortiert FALSCH, spielt die Reihenfolge der Werte in der ersten Spalte keine 

Rolle. 

Wichtig: Wenn Sie Sortiert also nicht explizit auf FALSCH setzen, müssen diese 

Werte in sortierter Reihenfolge vorliegen! 

Hinweis: 

Wenn Sortiert auf WAHR gesetzt ist und SVERWEIS keinen exakt mit dem 

Suchkriterium übereinstimmenden Wert findet, wird automatisch der nächstklei-

nere Wert genommen. Existiert kein kleinerer Wert, weil Suchkriterium kleiner 

als der kleinste vorhandene Wert ist, liefert die Funktion den Fehlerwert #NV. 
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Beispiel: 

Sie verkaufen Blumen zu unterschiedlichen Stückpreisen – je nachdem, wie viele 

Pflanzen der Kunde abnimmt. Dazu haben Sie eine Tabelle mit einer Rabattstaffel 

erstellt: 

 

Jetzt können Sie die Funktion SVERWEIS einsetzen, um abhängig von der Stück-

zahl den Preis für eine bestimmte Blumensorte zu ermitteln.  

Verwenden Sie dazu folgende Argumente: 

Als Suchkriterium geben Sie den Namen der Blumensorte an (also "Rosen", 

"Nelken" oder "Tulpen"). 

Als Bereich geben Sie die den Zellbereich an, der in der ersten Zeile die Namen 

der Blumensorten und darunter die Preise enthält – hier also A2:D4. 

Für n geben Sie die Stückzahl plus Eins an, denn die erste Spalte (n=1) enthält ja 

keine Preise, sondern die Namen der Pflanzen. 

Beispiele: 

SVERWEIS("Rosen"; A2:D4; 2; FALSCH) liefert den Stückpreis bei der Abnahme 

von einer Rose, also 5,50 Euro. 

SVERWEIS("Rosen"; A2:D4; 3; FALSCH) liefert den Stückpreis bei der Abnahme 

von zwei Rosen, also 5,10 Euro. 

SVERWEIS("Rosen"; A2:D4; 4; FALSCH) liefert den Stückpreis bei der Abnahme 

von drei Rosen, also 4,95 Euro. 

SVERWEIS("Nelken"; A2:D4; 4; FALSCH) liefert den Stückpreis bei der Abnah-

me von drei Nelken, also 4,50 Euro. 

SVERWEIS("Nelken"; A2:D4; 5; FALSCH) liefert den Fehlerwert #BEZUG, da n 

größer als die Zeilenzahl von Bereich ist. 
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SVERWEIS("Petunien"; A2:D4; 4; FALSCH) liefert den Fehlerwert #NV, da „Pe-

tunien“ in der ersten Zeile von Bereich nicht vorkommt. 

Siehe auch: 

WVERWEIS, INDEX, VERGLEICH 

T (Wert in eine Zeichenkette umwandeln) 

Syntax: 

T(Wert) 

Beschreibung: 

Wandelt den übergebenen Wert in eine Zeichenkette. 

Der übergebene Wert muss eine Zeichenkette sein, andernfalls liefert die Funktion 

eine leere Zeichenkette zurück. 

Hinweis: 

Diese Funktion ist nur aus Gründen der Kompatibilität mit älteren Tabellenkalkula-

tionen noch vorhanden. PlanMaker selbst benötigt sie nicht mehr, da er Werte bei 

Bedarf automatisch in Zeichenketten umwandelt. 

Beispiel: 

T("Text") ergibt Text 

T("42") ergibt 42 

T(42) ergibt eine leere Zeichenkette 

T(WAHR) ergibt eine leere Zeichenkette 

Siehe auch: 

N, WERT, TEXT 
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TAG (Tag aus einem Datumswert ermitteln) 

Syntax: 

TAG(Datum) 

Beschreibung: 

Liefert den Tag eines Datumswerts. 

Beispiel: 

TAG("25.9.2013") ergibt 25 

TAG("17. August") ergibt 17 

Siehe auch: 

ISOWOCHE, JAHR, KALENDERWOCHE, MONAT, WOCHENTAG 

TAGE (Differenz zwischen zwei Daten) 

Syntax: 

TAGE(Datum1; Datum2) 

Beschreibung: 

Liefert die Differenz zwischen zwei Datumswerten in Tagen. 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 



 

688    Formeln und Funktionen Handbuch PlanMaker 

Beispiel: 

TAGE("01.1.2013"; "14.01.2013") ergibt 13 

TAGE("14.01.2013"; "01.01.2013") ergibt -13 

Siehe auch: 

DATEDIF, NETTOARBEITSTAGE, TAGE360, ZEITDIFFERENZ 

TAGE360 (Differenz zwischen zwei Daten) 

Syntax: 

TAGE360(Ausgangsdatum; Enddatum [; Methode]) 

Beschreibung: 

Die Funktion TAGE360 liefert die Differenz zwischen zwei Datumswerten in Ta-

gen. Im Unterschied zur Funktion TAGE führt sie die Berechnung jedoch auf Basis 

eines Jahres mit 360 Tagen (12 Monate à 30 Tage) durch und lässt Schaltjahre au-

ßer acht. 

Das optionale Argument Methode bestimmt, wie dabei mit Daten umgegangen 

werden soll, die auf den 31. des Monats fallen: 

FALSCH oder nicht angegeben: Es wird die amerikanische Buchführungsmetho-

de verwendet: Ist das Ausgangsdatum der 31. des Monats, wird dieses zum 30 des-

selben Monats. Ist das Enddatum der 31., wird es zum 1. des Folgemonats. 

WAHR: Es wird die europäische Buchführungsmethode verwendet: Ist Ausgangs- 

oder Enddatum der 31. des Monats, wird dieses zum 30. des Monats. 

Hinweis: 

Sofern Sie also nicht nach der amerikanischen Buchführungsmethode rechnen 

möchten, muss das Argument Methode mit WAHR angegeben werden. 

Beispiel: 

TAGE360("1.1.2013"; "1.2.2013"; WAHR) ergibt 30 
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TAGE360("1.2.2013"; "1.3.2013"; WAHR) ergibt 30 

TAGE360("1.1.2008"; "1.1.2009"; WAHR) ergibt 360 

Siehe auch: 

DATEDIF, NETTOARBEITSTAGE, TAGE, ZEITDIFFERENZ 

TAGEIMJAHR (Zahl der Tage eines Jahres) 

Syntax: 

TAGEIMJAHR(Datum) 

Beschreibung: 

Liefert die Anzahl der Tage eines bestimmten Jahres. 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

TAGEIMJAHR("1.1.2012") ergibt 366 (2012 ist ein Schaltjahr) 

TAGEIMJAHR("1.1.2013") ergibt 365 (2013 ist kein Schaltjahr) 

Siehe auch: 

JAHR, TAGE, TAGE360 



 

690    Formeln und Funktionen Handbuch PlanMaker 

TAGEIMMONAT (Zahl der Tage eines Monats) 

Syntax: 

TAGEIMMONAT(Datum) 

Beschreibung: 

Liefert die Anzahl der Tage eines bestimmten Monats. 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

TAGEIMMONAT("25.09.2013") ergibt 30 (Tage) 

TAGEIMMONAT("25.10.2013") ergibt 31 (Tage) 

TAN (Tangens) 

Syntax: 

TAN(Zahl) 

Beschreibung: 

Liefert den Tangens eines Winkels.  

Der Winkel ist dabei im Bogenmaß (Radiant) anzugeben. 

Tipp: 

Mit der Funktion BOGENMASS können Sie einen in Grad vorliegenden Winkel 

ins Bogenmaß umrechnen. 
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Beispiel: 

TAN(PI()/4) ergibt 1 

TAN(BOGENMASS(45)) ergibt 1 

Siehe auch: 

ARCTAN 

TANHYP (Tangens Hyperbolicus) 

Syntax: 

TANHYP(Zahl) 

Beschreibung: 

Die Funktion TANHYP (Tangens Hyperbolicus) liefert den hyperbolischen Tan-

gens einer Zahl. 

Beispiel: 

TANHYP(0,45) ergibt 0,4219 

Siehe auch: 

ARCTANHYP 

TEIL (Teil einer Zeichenkette) 

Syntax: 

TEIL(Zeichenkette; Start; Anzahl) 
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Beschreibung: 

Liefert einen Teil einer Zeichenkette.  

Das Teilstück beginnt bei Start und ist Anzahl Zeichen lang. 

Beispiel: 

TEIL("Kartoffel"; 2; 3) ergibt art 

TEIL("Kartoffel"; 2; 8) ergibt artoffel 

TEIL("Kartoffel"; 2; 100) ergibt artoffel 

TEIL("Kartoffel"; 100; 100) ergibt eine leere Zeichenkette 

Siehe auch: 

LINKS, RECHTS, ERSETZEN, FINDEN, SUCHEN 

TEILERGEBNIS (Berechnungen, die Filter berücksichtigen) 

Syntax: 

TEILERGEBNIS(Funktion; Bereich1 [; Bereich2 ...]) 

Beschreibung: 

Diese Funktion wendet eine der unten aufgeführten Rechenfunktionen auf Zellbe-

reiche an, berücksichtigt dabei jedoch gefilterte Zellen nicht. 

Erläuterung: Wenn Sie mit dem Befehl Tabelle > Filter Teile eines Zellbereichs 

herausfiltern und dann beliebige Rechenfunktionen auf diesen Bereich anwenden, 

beziehen diese stets auch die gefilterten Zellen mit ein. Anders sieht es bei der 

Funktion TEILERGEBNIS aus: diese berücksichtigt die gefilterten Zellen nicht. 

Mit dem Argument Funktion bestimmen Sie, welche Rechenfunktion angewandt 

werden soll: 

1: MITTELWERT (arithmetisches Mittel) 

2: ANZAHL (wie viele Zellen mit Zahlen ausgefüllt?) 

3: ANZAHL2 (wie viele Zellen ausgefüllt?) 

4: MAX (größter Wert) 
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5: MIN (kleinster Wert) 

6: PRODUKT (Produkt) 

7: STABW (Standardabweichung Stichprobe) 

8: STABWN (Standardabweichung Grundgesamtheit) 

9: SUMME (Summe) 

10: VARIANZ (Varianz Stichprobe) 

11: VARIANZEN (Varianz Grundgesamtheit) 

Ist Funktion also beispielsweise 9, liefert TEILERGEBNIS die Summe des Zell-

bereichs. 

Bei Bereich1; Bereich2 etc. geben Sie den Zellbereich oder die Zellbereiche an, 

auf die Sie obige Funktion anwenden möchten. 

Beispiel: 

TEILERGEBNIS(9; A1:E6) berechnet die Summe des Bereichs A1:E6, berück-

sichtigt dabei jedoch gefilterte Zellen nicht. 

Siehe auch: 

Abschnitt „Filtern“ ab Seite 98. 

TEXT (Zahl in formatierten Text wandeln) 

Syntax: 

TEXT(Zahl; Format) 

Beschreibung: 

Wandelt eine Zahl in eine Zeichenkette mit beliebig definierbarer Formatierung 

um.  

Über das Argument Format geben Sie die gewünschte Formatierung an. Tragen 

Sie hier eine entsprechende Zeichenkette ein. Diese muss aufgebaut sein wie eine 

Zeichenkette, die Sie beim Anlegen benutzerdefinierter Zahlenformate mit dem 

Befehl Format > Zelle eingeben (siehe Abschnitt „Aufbau eines benutzerdefinier-

ten Zahlenformats“ ab Seite 149). 
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Anmerkung: 

Wenn Sie das Format von Zahlen ändern möchten, ohne sie dabei in eine Zeichen-

kette zu wandeln, rufen Sie den Befehl Format > Zelle auf und wählen das ge-

wünschte Zahlenformat. 

Beispiel: 

TEXT("25.9.2013"; "TT.MM.JJ") ergibt den Text 25.09.13 

TEXT(2,715; "0,00 ""EUR""") ergibt den Text 2,72 EUR 

Siehe auch: 

WERT, T, N 

TINV (Quantile einer t-Verteilung) 

Syntax: 

TINV(Wahrscheinlichkeit; Freiheitsgrade) 

Beschreibung: 

Liefert Quantile einer t-Verteilung.  

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der t-Verteilung. Zu-

lässig sind nur Werte aus dem Intervall [0..1]. 

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht klei-

ner als 1 sein. Erwartet wird jeweils eine ganze Zahl; ist dies nicht der Fall, schnei-

det PlanMaker die Nachkommastellen automatisch ab. 

Hinweis: 

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. 

Findet PlanMaker nach 100 Iterationen kein Ergebnis, das weniger als 3x10^-7 

von Wahrscheinlichkeit abweicht, zeigt er den Fehlerwert #NV an und bricht die 

Näherung ab. 
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Siehe auch: 

TTEST, TVERT 

TREND (Werte einer linearen Regression) 

Syntax: 

TREND(y_Werte [; x_Werte] [; Neue_x_Werte] [; Konstante]) 

Beschreibung: 

Liefert die Werte einer linearen Regression. 

Unter einer linearen Regression versteht man das Anpassen einer linearen Funktion 

(Regressionsgerade oder Ausgleichsgerade genannt) an eine Menge von Punkten 

(zum Beispiel den Messpunkten einer Messreihe). 

TREND erwartet als Argumente die y-Werte (und, sofern angegeben, die zugehöri-

gen x-Werte) und liefert als Ergebnis eine Matrix mit den entsprechenden y-

Koordinaten der Regressionsgeraden. 

Im Einzelnen erwartet die Funktion folgende Argumente: 

y_Werte: Hier geben Sie die vorliegenden y-Koordinaten, also die abhängigen 

Werte, an. y_Werte kann entweder ein Zellbezug oder eine Matrix sein. 

x_Werte: Hier können optional die x-Koordinaten, also die unabhängigen Werte 

angegeben werden. Auch x_Werte kann entweder ein Zellbezug oder eine Matrix 

sein. Wird x_Werte nicht angegeben, verwendet die Funktion automatisch die 

Werte 1, 2, 3, ... (entsprechend der Anzahl der vorliegenden y_Werte). 

Neue_x_Werte: Wird dieses Argument nicht angegeben, liefert die Ergebnismatrix 

dieser Funktion die y-Koordinaten der Regressionsgeraden entsprechend den in 

x_Werte angegebenen x-Koordinaten. Bei Bedarf können Sie mit Neue_x_Werte 

jedoch andere x-Koordinaten angeben. Auch Neue_x_Werte kann entweder ein 

Zellbezug oder eine Matrix sein.  

Konstante: Mit dem optionalen Argument Konstante können Sie festlegen, ob die 

Konstante b (der y-Achsenabschnitt) auf Null gesetzt werden soll: 

WAHR oder nicht angegeben: b wird aus den vorliegenden Daten automatisch be-

rechnet. 
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FALSCH: b wird auf Null gesetzt. Die Regressionsgerade wird dadurch gezwun-

gen, durch den Nullpunkt zu laufen. Dies geschieht durch entsprechendes Anpas-

sen des Koeffizienten m. 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 450. 

Anmerkung: 

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleins-

ten Quadrate durchgeführt. 

Beispiel: 

Von einem temperaturabhängigen Widerstand wurde gemessen, welcher Wider-

stand bei verschiedenen Temperaturen vorliegt. 

In den Zellen A1 bis A4 sind die x-Koordinaten der Messpunkte eingetragen (also 

die unabhängigen Variablen; in unserem Beispiel ist das die Temperatur): 8, 20, 25, 

28 

In den Zellen B1 bis B4 sind die y-Koordinaten eingetragen (also die abhängigen 

Variablen; in unserem Beispiel ist dies der Widerstand): 261, 508, 608, 680 

Mit der folgenden Formel erhalten Sie die y-Koordinaten der entsprechenden 

Punkte auf der Regressionsgeraden (als Matrix): 

TREND(B1:B4; A1:A4) 

Siehe auch: 

RGP, RKP, VARIATION 

TTEST (t-Test) 

Syntax: 

TTEST(Werte1; Werte2; Seiten; Typ) 
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Beschreibung: 

Liefert die Teststatistik eines Studentschen t-Tests.  

Mit einem t-Test kann die Konsistenz der Mittelwerte zweier Stichproben geprüft 

werden. 

Werte1 und Werte2 sind die zu untersuchenden Wertebereiche (Stichproben). 

Seiten bestimmt, ob ein ein- oder ein zweiseitiger Test verwendet werden soll: 

1: einseitiger Test 

2: zweiseitiger Test 

Typ bestimmt die Art des Tests: 

1: abhängige Stichproben („gepaart“) 

2: unabhängige Stichproben, gleiche Varianzen („homoskedastisch“) 

3: unabhängige Stichproben, ungleiche Varianzen („heteroskedastisch“) 

Siehe auch: 

TINV, TVERT 

TVERT (t-Verteilung) 

Syntax: 

TVERT(X; Freiheitsgrade; Seiten) 

Beschreibung: 

Liefert Werte der Verteilungsfunktion einer t-verteilten (Student-verteilten) Zu-

fallsvariablen. 

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X darf keine ne-

gative Zahl sein. 

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht klei-

ner als 1 sein. Erwartet wird jeweils eine ganze Zahl; ist dies nicht der Fall, schnei-

det PlanMaker die Nachkommastellen automatisch ab. 
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Seiten bestimmt, ob ein ein- oder ein zweiseitiger Test verwendet werden soll: 

1: einseitiger Test 

2: zweiseitiger Test 

Siehe auch: 

TINV, TTEST 

TYP (Typ des Arguments ermitteln) 

Syntax: 

TYP(Wert) 

Beschreibung: 

Liefert den Datentyp des Arguments in Form einer Zahl. 

Welche Zahl für welchen Typ steht, können Sie der nachfolgenden Tabelle ent-

nehmen: 

Argument ist ... Ergebnis 

Zahl oder leere Zelle 1 

Zeichenkette 2 

Wahrheitswert 4 

Fehlerwert 16 

Matrix 64 

Beispiel: 

TYP(42) ergibt 1 

Steht in Zelle A1 die Zeichenkette "Text", so gilt: 

TYP(A1) ergibt 2 
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Siehe auch: 

FEHLER.TYP 

UMWANDELN (Maßeinheiten umrechnen) 

Syntax: 

UMWANDELN(Zahl; Quelleinheit, Zieleinheit) 

Beschreibung: 

Wandelt eine Zahl von einer Einheit in eine andere um. 

Die Argumente Quelleinheit und Zieleinheit geben Sie mit Hilfe der Codes in der 

nachfolgenden Tabelle an.  

Beide Einheiten müssen aus der gleichen Kategorie sein. So können Sie beispiels-

weise Meter in Meilen umrechnen, aber natürlich nicht in Gramm. 

Wenn diese Funktion den Fehlerwert #NV zurückliefert, liegt dies meist daran, 

dass a) Quelleinheit und Zieleinheit nicht aus derselben Kategorie stammen oder b) 

einer der beiden Codes in falscher Schreibweise angegeben wurde. 

Achten Sie genau auf die Groß-/Kleinschreibung der Codes! 

Es gibt folgende Codes: 

Masse Code 

Gramm g 

Stück (Gewichtseinheit) sg 

Pfund* (Handelsgewicht) lbm 

u (Atommasse) u 

Unze ozm 

* Entspricht nicht dem im deutschen Sprachraum teil-

weise noch verwendeten Pfund (½ Kilo) 

 

Länge Code 

Meter m 

Meile (Landmeile) mi 

Meile (nautische Meile) Nmi 

Zoll (Inch) in 

Fuß (Feet) ft 

Yard yd 
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Ångström ang 

Pica Pica 

Lichtjahr* ly 

Parsec (Parallaxensekunde)* parsec 

* Diese Einheit wird von Excel nicht unterstützt.  

Zeit Code 

Sekunde sec 

Minute mn 

Stunde hr 

Tag day 

Jahr** yr 

Fortnight* ftn 

* Diese Einheit wird von Excel nicht unterstützt.  

** Basierend auf einem Jahr mit 365,25 Tagen  

Flüssigkeitsmaße Code 

Liter l (kleines „L“) 

Teelöffel (Teaspoon) tsp 

Esslöffel (Tablespoon) tbs 

Flüssige Unze (Ounce) oz 

Tasse (Cup) cup 

Pint (U.S.) pt 

Pint (U.K.) uk_pt 

Quart (amerikanisches) qt 

Gallone (amerikanische) gal 

Kraft Code 

Newton N 

Dyne dyn 

Pound-force lbf 

Leistung Code 

Watt W 

PS HP 

Feldstärke Code 

Tesla T 

Gauß ga 

Energie Code 

Joule J 

Erg e 

Thermodynamische Kalorie c 

Kalorie cal 

Elektronvolt eV 
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PS mal Stunde HPh 

Wattstunden Wh 

Foot-pound force flb 

BTU (British Thermal Unit) BTU 

Druck Code 

Pascal Pa 

Atmosphären atm 

mm Quecksilbersäule mmHg 

Temperatur Code 

Grad Fahrenheit F 

Grad Celsius C 

Grad Kelvin K 

Weiterhin können Sie vor den Code einen der gebräuchlichen Präfixe setzen. So 

lässt sich beispielsweise der Präfix „m“ (Milli...) mit der Einheit „g“ (Gramm) zur 

Einheit „mg“ (Milligramm) kombinieren. 

Achten Sie auch hier genau auf die Groß-/Kleinschreibung! 

Es gibt folgende Präfixe: 

Präfix (und Faktor) Code 

Exa (10^18) E 

Peta (10^15) P 

Tera (10^12) T 

Giga (10^9) G 

Mega (10^6) M 

Kilo (1000) k 

Hekto (100) h 

Deka (10) e 

Dezi (0,1) d 

Zenti (0,01) c 

Milli (0,001) m 

Mikro (10^-6) u 

Nano (10^-9) n 

Piko (10^-12) p 

Femto (10^-15) f 

Atto (10^-18) a 

Beispiel: 

UMWANDELN(1; "day"; "sec") ergibt 86400 (Tage -> Sekunden) 

UMWANDELN(1; "mi"; "km") ergibt 1,60934 (Meilen -> Kilometer) 

UMWANDELN(100; "kW"; "HP") ergibt 134,10201 (100 kW -> PS) 
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UMWANDELN(1;"aparsec";"cm") ergibt 3,08568 (Attoparsec -> cm) 

UND (Logisches UND) 

Syntax: 

UND(Wahrheitswert1; Wahrheitswert2 [; Wahrheitswert3 ...]) 

Beschreibung: 

Diese Funktion liefert WAHR, wenn alle ihr übergebenen Wahrheitswerte WAHR 

sind, ansonsten liefert sie FALSCH. 

Sie können damit beispielsweise prüfen, ob mehrere Bedingungen allesamt zutref-

fen. 

Beispiel: 

UND(WAHR; WAHR) ergibt WAHR 

UND(WAHR; FALSCH) ergibt FALSCH 

UND(FALSCH; FALSCH) ergibt FALSCH 

UND(A1>0; A1<1) ergibt WAHR; wenn A1 größer als Null und kleiner als Eins 

ist. 

Siehe auch: 

ODER, XODER, NICHT 

UNGERADE (Aufrunden auf eine ungerade Zahl) 

Syntax: 

UNGERADE(Zahl) 
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Beschreibung: 

Rundet Zahl auf die betragsmäßig nächstgrößere ungerade Zahl auf. 

Beispiel: 

UNGERADE(41) ergibt 41 

UNGERADE(42) ergibt 43 

UNGERADE(-42) ergibt -43 

Siehe auch: 

GERADE, VRUNDEN, RUNDEN, ISTUNGERADE 

UNTERGRENZE (Abrunden auf ein Vielfaches von n) 

Syntax: 

UNTERGRENZE(Zahl; Basis) 

Beschreibung: 

Rundet Zahl auf ein Vielfaches von Basis ab. 

Bei positiven Zahlen wird auf das nächstkleinere Vielfache von Basis abgerundet, 

bei negativen Zahlen wird hingegen auf das nächstgrößere Vielfache aufgerundet. 

Zahl und Basis müssen das gleiche Vorzeichen haben, sonst liefert die Funktion 

den Fehlerwert #ZAHL! 

Beispiel: 

UNTERGRENZE(42,5; 1) ergibt 42 

UNTERGRENZE(-42,5; -1) ergibt -42 

UNTERGRENZE(21; 5) ergibt 20 

UNTERGRENZE(12,3456; 0,01) ergibt 12,34 
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Siehe auch: 

OBERGRENZE, VRUNDEN, RUNDEN, KÜRZEN 

VARIANZ (Varianz einer Stichprobe) 

Syntax: 

VARIANZ(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Liefert einen Schätzwert für die Varianz einer Grundgesamtheit anhand einer 

Stichprobe. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte (Stichprobe).  

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Anmerkung: 

Die Varianz wird nach der Methode „Erwartungstreue Schätzung“ oder „n-1“ be-

rechnet. 

Beispiel: 

VARIANZ(2; 2; 3; 4; 1) ergibt 1,3 

Siehe auch: 

VARIANZA, VARIANZEN, STABW, STABWN 

VARIANZA (Varianz) 

Syntax: 

VARIANZA(Zahl1; Zahl2 [; Zahl3 ...]) 
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Beschreibung: 

Die Funktion VARIANZA entspricht nahezu der Funktion VARIANZ (siehe Hin-

weis). Sie liefert also einen Schätzwert für die Varianz einer Grundgesamtheit an-

hand einer Stichprobe. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte (Stichprobe).  

Hinweis: 

Im Gegensatz zu VARIANZ berücksichtigt die Funktion VARIANZA auch Werte, 

die keine Zahlen sind: Beliebige Zeichenketten und der Wahrheitswert FALSCH 

werden als 0 interpretiert, WAHR als 1. 

Leere Zellen werden hingegen auch hier ignoriert. 

Anmerkung: 

Die Varianz wird nach der Methode „Erwartungstreue Schätzung“ oder „n-1“ be-

rechnet. 

Beispiel: 

VARIANZA(2; 2; 3; 4; 1) ergibt 1,3 

Siehe auch: 

VARIANZ 

VARIANZEN (Varianz einer Grundgesamtheit) 

Syntax: 

VARIANZEN(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Liefert die Varianz einer vollständigen Grundgesamtheit. 
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Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. Es müssen alle Werte 

der Grundgesamtheit angegeben werden. Falls nur eine Stichprobe aus der Grund-

gesamtheit vorliegt, ist statt VARIANZEN die Funktion VARIANZ zu verwenden. 

Diese liefert einen Schätzwert für die Varianz. 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Anmerkung: 

Die Varianz wird nach der Methode „n“ berechnet. 

Beispiel: 

VARIANZEN(2; 2; 3; 4; 1) ergibt 1,04 

Siehe auch: 

VARIANZ, STABW, STABWN 

VARIANZENA (Varianz) 

Syntax: 

VARIANZENA(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Die Funktion VARIANZENA entspricht nahezu der Funktion VARIANZEN (siehe 

Hinweis). Sie liefert also die Varianz einer vollständigen Grundgesamtheit. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. Es müssen alle Werte 

der Grundgesamtheit angegeben werden. Falls nur eine Stichprobe aus der Grund-

gesamtheit vorliegt, ist statt VARIANZENA die Funktion VARIANZA oder VA-

RIANZ zu verwenden. Diese liefert einen Schätzwert für die Varianz. 
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Hinweis: 

Im Gegensatz zu VARIANZEN berücksichtigt die Funktion VARIANZENA auch 

Werte, die keine Zahlen sind: Beliebige Zeichenketten und der Wahrheitswert 

FALSCH werden als 0 interpretiert, WAHR als 1. 

Leere Zellen werden hingegen auch hier ignoriert. 

Beispiel: 

VARIANZENA(2; 2; 3; 4; 1) ergibt 1,04 

Siehe auch: 

VARIANZEN 

VARIATION (Werte einer exponentiellen Regression) 

Syntax: 

VARIATION(y_Werte [; x_Werte] [; Neue_x_Werte] [; Konstante]) 

Beschreibung: 

Liefert die Werte einer exponentiellen Regression. 

Unter einer exponentiellen Regression versteht man das Anpassen einer Exponenti-

alkurve an eine Menge von Punkten (zum Beispiel den Messpunkten einer Mess-

reihe). 

VARIATION erwartet als Argumente die y-Werte (und, sofern angegeben, die zu-

gehörigen x-Werte) und liefert als Ergebnis eine Matrix mit den y-Koordinaten der 

Exponentialkurve. 

Im Einzelnen erwartet die Funktion folgende Argumente: 

y_Werte: Hier geben Sie die vorliegenden y-Koordinaten, also die abhängigen 

Werte, an. y_Werte kann entweder ein Zellbezug oder eine Matrix sein. Es sind 

nur positive Werte zulässig; andernfalls liefert die Funktion den Fehlerwert 

#ZAHL. 
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x_Werte: Hier können optional die x-Koordinaten, also die unabhängigen Werte 

angegeben werden. Auch x_Werte kann entweder ein Zellbezug oder eine Matrix 

sein. Wird x_Werte nicht angegeben, verwendet die Funktion automatisch die 

Werte 1, 2, 3, ... (entsprechend der Anzahl der vorliegenden y_Werte). 

Neue_x_Werte: Wird dieses Argument nicht angegeben, liefert die Ergebnismatrix 

dieser Funktion die y-Koordinaten der Regressionsgeraden entsprechend den in 

x_Werte angegebenen x-Koordinaten. Bei Bedarf können Sie mit Neue_x_Werte 

jedoch andere x-Koordinaten angeben. Auch Neue_x_Werte kann entweder ein 

Zellbezug oder eine Matrix sein.  

Konstante: Mit dem optionalen Argument Konstante können Sie festlegen, ob die 

Konstante b auf Eins gesetzt werden soll: 

WAHR oder nicht angegeben: b wird aus den vorliegenden Daten automatisch be-

rechnet. 

FALSCH: b wird fest auf Eins gesetzt und die Kurve durch Anpassen des Koeffi-

zienten m entsprechend „hingebogen“. 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 450. 

Siehe auch: 

RGP, RKP, TREND 

VARIATIONEN (Variationen) 

Syntax: 

VARIATIONEN(n; k) 

Beschreibung: 

Ermittelt die Anzahl der geordneten Stichproben vom Umfang k, die man einer 

Gesamtheit von n verschiedenen Elementen ohne Zurücklegen entnehmen kann. 
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n gibt an, aus wie vielen Elementen die Gesamtheit besteht. n muss größer als k 

sein. 

k gibt an, wie viele Elemente in einer Stichprobe gezogen werden sollen. k muss 

größer als 0 und kleiner als n sein. 

n und k sollten natürlich ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker 

die Nachkommastellen automatisch weg. 

Anmerkung: 

VARIATIONEN unterscheidet sich von KOMBINATIONEN wie folgt: Bei den 

Variationen darf die Reihenfolge der gezogenen Elemente nachträglich nicht mehr 

verändert werden, bei den Kombinationen spielt sie keine Rolle.  

Mit VARIATIONEN können Sie also zum Beispiel berechnen, wie viele Möglich-

keiten es für die ersten 3 Plätze eines Wettlaufs mit 10 Teilnehmern gibt. Mit 

KOMBINATIONEN können Sie hingegen ermitteln, wie viele Möglichkeiten es 

beim Ziehen von 6 Kugeln aus 49 gibt. 

Der Unterschied: Während sich die Reihenfolge der gezogen Lottozahlen nach 

Belieben ändern lässt (sie könnten diese also zum Beispiel nachträglich aufsteigend 

sortieren), würden die Läufer natürlich protestieren, wenn Sie die Plätze 1-3 nun 

plötzlich nach den Anfangsbuchstaben der Nachnamen umsortieren würden.  

Bei den Variationen spielt also die Anordnung eine Rolle; bei den Kombinationen 

hingegen nicht. 

Beispiel: 

Greifen wir gleich das Beispiel mit den Läufern auf. Sie möchten wissen, wie viele 

Variationen es für die ersten 3 Plätze eines Wettlaufs mit 10 Läufern gibt. Die For-

mel hierfür lautet: 

VARIATIONEN(10; 3) 

Ergebnis: Es gibt 720 Variationsmöglichkeiten. 

Siehe auch: 

KOMBINATIONEN 
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VERGLEICH (Position eines Werts in einem Bereich) 

Syntax: 

VERGLEICH(Suchkriterium; Suchvektor [; Modus]) 

Beschreibung: 

Durchsucht einen Vektor (also einen eindimensionalen Zellbereich) nach einem 

Suchkriterium und liefert dann dessen Position innerhalb dieses Zellbereichs. Ist 

das Suchkriterium also das fünfte Element des Suchvektors, liefert die Funktion 

das Ergebnis 5. 

Suchkriterium ist der gesuchte Wert. Zulässig sind alle Werte von Werten oder ein 

Zellbezug. 

Suchvektor ist der zu durchsuchende Zellbereich. Dieser kann entweder Zeichen-

ketten, Zahlen oder Wahrheitswerte enthalten. Es muss sich dabei um einen Vektor 

handeln (also um einen Bereich mit entweder nur einer Zeile oder einer Spalte). 

Modus gibt an, welche Art von Suche durchgeführt werden soll: 

1 oder nicht angegeben: Es wird der größte Wert gesucht, der kleiner oder gleich 

Suchkriterium ist. Wichtig: Die Elemente im Suchvektor müssen bei diesem Mo-

dus aufsteigend sortiert sein. Andernfalls liefert die Funktion möglicherweise fal-

sche Ergebnisse.  

0: Es wird der Wert gesucht, der dem Suchkriterium genau entspricht. Die Elemen-

te im Suchvektor brauchen bei diesem Modus nicht sortiert zu sein.  

-1: Es wird der kleinste Wert gesucht, der größer oder gleich Suchkriterium ist. 

Wichtig: Die Elemente im Suchvektor müssen bei diesem Modus absteigend sor-

tiert sein. Andernfalls liefert die Funktion möglicherweise falsche Ergebnisse.  

Tipp: Wenn Sie Modus 0 verwenden und nach einer Zeichenkette suchen, darf das 

Suchkriterium darf auch Platzhalter enthalten: ein Fragezeichen (?) steht für ein 

beliebiges Zeichen, ein Sternchen (*) für beliebig viele Zeichen. 

Beispiel: 

VERGLEICH("b"; {"a";"b";"c";"d"}; 0) ergibt 2. "b" ist also das zweite Element 

des durchsuchten Vektors. 
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Siehe auch: 

INDEX, SVERWEIS, VERWEIS, WVERWEIS 

VERKETTEN (Zeichenketten verbinden) 

Syntax: 

VERKETTEN(Zeichenkette1; Zeichenkette2 [; Zeichenkette3 ...]) 

Beschreibung: 

Verbindet zwei oder mehr Zeichenketten zu einer einzigen Zeichenkette. 

Anmerkung: 

Der Operator & tut exakt das gleiche. VERKETTEN("Text1"; "Text2") entspricht 

also "Text1" & "Text2". 

Beispiel: 

VERKETTEN("Guten "; "Morgen") ergibt Guten Morgen 

VERKETTEN(2; " Stück"; " Zucker") ergibt 2 Stück Zucker 

VERWEIS (Zellbereich durchsuchen) 

Vorbemerkung: 

Die Funktion VERWEIS durchsucht einen Zellbereich nach einem Suchkriterium 

(also z.B. nach einer Zahl oder einer Zeichenkette) und liefert dann den Inhalt einer 

anderen Zelle mit entsprechender Position.  

Die zu durchsuchenden Daten müssen dabei in sortierter Reihenfolge vorliegen. 

Tipp: Es gibt zwei Alternativen zu dieser Funktion, die auch mit unsortierten Daten 

zurechtkommen und zudem etwas flexibler sind: SVERWEIS und WVERWEIS. 

Die Funktion VERWEIS kann auf zwei verschiedene Arten eingesetzt werden: 
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Variante mit zwei eindimensionalen Bereichen: Hier werden der Funktion zwei 

Vektoren (also eindimensionale Bereiche) übergeben: Suchvektor und Ergebnis-

vektor. Findet die Funktion das Suchkriterium im Suchvektor, liefert sie als Er-

gebnis die Zelle mit der gleichen Position im Ergebnisvektor. 

Variante mit einem zweidimensionalen Bereich: Hier wird der Funktion ein 

zweidimensionaler Bereich übergeben. Findet sie das Suchkriterium in der ersten 

Zeile (beziehungsweise Spalte) dieses Bereichs, liefert sie als Ergebnis die Zelle 

mit der gleichen Position in der letzten Zeile (beziehungsweise Spalte) dieses Be-

reichs. 

Variante mit zwei eindimensionalen Bereichen 

Syntax: 

VERWEIS(Suchkriterium; Suchvektor; Ergebnisvektor) 

Beschreibung: 

Diese Variante der Funktion VERWEIS durchsucht den Zellbereich Suchvektor 

nach dem Suchkriterium. Wird es gefunden, liefert sie den Inhalt der Zelle, die 

sich in der gleichen Zeile/Spalte im Zellbereich Ergebnisvektor befindet. 

Suchkriterium ist der gesuchte Wert. Die Groß-/Kleinschreibung spielt keine Rol-

le. 

Suchvektor ist der zu durchsuchende Zellbereich. Dieser kann Zeichenketten, 

Zahlen oder Wahrheitswerte enthalten. Es muss sich dabei allerdings um einen 

Vektor (also einen eindimensionalen Bereich) handeln, was bedeutet, dass Such-

vektor entweder nur eine Zeile oder nur eine Spalte umfassen darf. 

Wichtig: Die Werte in Suchvektor müssen aufsteigend sortiert sein. Andernfalls 

liefert diese Funktion möglicherweise falsche Ergebnisse. Falls die Werte nicht 

sortiert sind, können Sie alternativ die Funktionen SVERWEIS oder WVERWEIS 

verwenden. 

Ergebnisvektor ist der Zellbereich, aus dem das Ergebnis der Funktion geliefert 

werden soll. Auch dieser Bereich muss ein Vektor sein. Außerdem muss seine Grö-

ße und seine Ausrichtung (horizontal oder vertikal) der von Ergebnisvektor ent-

sprechen. 
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Hinweis: 

Wenn VERWEIS keinen exakt mit dem Suchkriterium übereinstimmenden Wert 

findet, wird automatisch der nächstkleinere Wert genommen. 

Existiert kein kleinerer Wert, weil Suchkriterium kleiner als der kleinste vorhan-

dene Wert ist, liefert die Funktion den Fehlerwert #NV. 

Beispiel: 

Bei folgender Tabelle ... 

 

... liefert VERWEIS folgende Ergebnisse: 

VERWEIS(1; A1:A3; B1:B3) ergibt Ergebnis_1 

VERWEIS(2; A1:A3; B1:B3) ergibt Ergebnis_2 

VERWEIS(3; A1:A3; B1:B3) ergibt Ergebnis_3 

VERWEIS(2,5; A1:A3; B1:B3) ergibt Ergebnis_2 (da hier der nächstkleinere Wert 

genommen wird) 

VERWEIS(10; A1:A3; B1:B3) ergibt Ergebnis_3 (aus dem gleichen Grund) 

VERWEIS(0; A1:A3; B1:B3) ergibt #NV 

Siehe auch: 

SVERWEIS, WVERWEIS, INDEX, VERGLEICH 

Variante mit einem zweidimensionalen Bereich 

Syntax: 

VERWEIS(Suchkriterium; Bereich) 
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Beschreibung: 

Diese Variante der Funktion VERWEIS durchsucht die erste Spalte von Bereich 

nach dem Suchkriterium. Wird es gefunden, liefert sie den Inhalt der Zelle, die 

sich in der gleichen Zeile der letzten Spalte von Bereich befindet. 

Alternativ kann diese Funktion den Bereich auch spaltenweise durchsuchen. Die 

Suchrichtung wird nämlich durch die Dimensionen von Bereich bestimmt:  

Umfasst Bereich mehr Spalten als Zeilen, durchsucht die Funktion die erste Zeile 

und liefert den Wert aus der letzten Zeile.  

Umfasst Bereich mehr Zeilen als Spalten oder ist quadratisch, durchsucht die 

Funktion die erste Spalte und liefert den Wert aus der letzten Spalte.  

Suchkriterium ist der gesuchte Wert. Die Groß-/Kleinschreibung spielt keine Rol-

le. 

Bereich ist der zu durchsuchende Bereich. Er muss in der ersten Zeile (bezie-

hungsweise Spalte) die zu durchsuchenden Werte und in der letzten Zeile (bezie-

hungsweise Spalte) die zu liefernden Ergebnisse enthalten. Es kann sich dabei um 

Zeichenketten, Zahlen oder Wahrheitswerte handeln. Der Bereich muss zweidi-

mensional sein, also mindestens zwei Zeilen und zwei Spalten umfassen. 

Wichtig: Die Werte in der ersten Zeile (beziehungsweise Spalte) müssen aufstei-

gend sortiert sein. Andernfalls liefert diese Funktion möglicherweise falsche Er-

gebnisse. Falls die Werte nicht sortiert sind, können Sie alternativ die Funktionen 

SVERWEIS oder WVERWEIS verwenden. 

Hinweis: 

Wenn VERWEIS keinen exakt mit dem Suchkriterium übereinstimmenden Wert 

findet, wird automatisch der nächstkleinere Wert genommen. 

Existiert kein kleinerer Wert, weil Suchkriterium kleiner als der kleinste vorhan-

dene Wert ist, liefert die Funktion den Fehlerwert #NV. 

Beispiel: 

Bei folgender Tabelle ... 
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... liefert VERWEIS folgende Ergebnisse: 

VERWEIS(1; A1:B3) ergibt Ergebnis_1 

VERWEIS(2; A1:B3) ergibt Ergebnis_2 

VERWEIS(3; A1:B3) ergibt Ergebnis_3 

VERWEIS(2,5; A1:B3) ergibt Ergebnis_2 (da hier der nächstkleinere Wert ge-

nommen wird) 

VERWEIS(10; A1:B3) ergibt Ergebnis_3 (aus dem gleichen Grund) 

VERWEIS(0; A1:B3) ergibt #NV 

Siehe auch: 

SVERWEIS, WVERWEIS, INDEX, VERGLEICH 

VORZEICHEN (Vorzeichen einer Zahl) 

Syntax: 

VORZEICHEN(Zahl) 

Beschreibung: 

Diese Funktion liefert das Vorzeichen einer Zahl. Sie kann folgende Werte anneh-

men: 

1, wenn die übergebene Zahl positiv ist 

-1, wenn die Zahl negativ ist 

0, wenn die Zahl Null ist 
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Beispiel: 

VORZEICHEN(-5) ergibt -1 

Siehe auch: 

ABS, NEG 

VRUNDEN (Runden auf ein Vielfaches von n) 

Syntax: 

VRUNDEN(Zahl; Basis) 

Beschreibung: 

Rundet Zahl auf ein Vielfaches von Basis. 

Basis muss größer als Null sein. 

Ist der Rest der Division von Zahl durch Basis kleiner als die Hälfte von Basis, 

wird abgerundet. Ist er größer oder gleich der Hälfte von Basis, wird aufgerundet 

(siehe Beispiele). 

Beispiel: 

VRUNDEN(1234,5678; 1) ergibt 1235 

VRUNDEN(1234,5678; 0,01) ergibt 1234,57 

VRUNDEN(22; 5) ergibt 20 

VRUNDEN(23; 5) ergibt 25 

VRUNDEN(22,5; 5) ergibt 25 

Siehe auch: 

UNTERGRENZE, OBERGRENZE, ABRUNDEN, AUFRUNDEN, RUNDEN, 

KÜRZEN 
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WAHL (Auswahl aus einer Liste) 

Syntax: 

WAHL(Index; Wert1; Wert2 [; Wert3 ...]) 

Beschreibung: 

Diese Funktion wählt mit Hilfe von Index einen Wert aus der Liste der Argumente 

aus. 

Index gibt die Position in der Liste der Argumente an. Ist Index 1, wird das erste 

Element zurückgeliefert, ist Index 2, das zweite Element etc. 

Wenn Index kleiner als 1 oder größer als die Anzahl der Listeneinträge ist, liefert 

die Funktion den Fehlerwert #WERT! zurück. 

Beispiel: 

WAHL(2; "Eins"; "Zwei"; "Drei") ergibt Zwei 

Siehe auch: 

INDEX, SVERWEIS, WVERWEIS 

WAHR (Wahrheitswert) 

Syntax: 

WAHR() 

Beschreibung: 

Liefert den Wahrheitswert WAHR.  

Siehe auch: 

FALSCH 
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WAHRSCHBEREICH (Wahrscheinlichkeit) 

Syntax: 

WAHRSCHBEREICH(Werte; Wahrscheinlichkeiten; k1 [; k2]) 

Beschreibung: 

Liefert die Wahrscheinlichkeit für ein Intervall von Werten, deren Einzelwahr-

scheinlichkeiten jeweils angegeben sind. 

Einfacher ausgedrückt: Diese Funktion summiert die jeweiligen Wahrscheinlich-

keiten der Werte in diesem Intervall. 

Werte sind die zu untersuchenden Werte. 

Wahrscheinlichkeiten sind die dazugehörigen Einzelwahrscheinlichkeiten. 

Alle Wahrscheinlichkeiten müssen größer gleich 0 (0%) und kleiner gleich 1 

(100%) sein. Die Summe der Einzelwahrscheinlichkeiten muss 1 ergeben. 

Sind mehr oder weniger Werte als Wahrscheinlichkeiten angegeben, liefert die 

Funktion den Fehler #NV. 

k1 und k2 bestimmen das Intervall von Werten, deren gemeinsame Wahrschein-

lichkeit ermittelt werden sollen. Wenn k2 nicht angegeben ist, wird nur die Wahr-

scheinlichkeit des Wertes k1 ermittelt. 

Beispiel: 

In den Zellen A1 bis A3 sind die Werte 1, 2, 3 eingetragen, in den Zellen B1 bis B3 

die dazugehörigen Wahrscheinlichkeiten: 17%, 33%, 50%. 

Wie groß ist die Wahrscheinlichkeit, dass ein Wert zwischen 2 und 3 liegt? 

WAHRSCHBEREICH(A1:A3; B1:B3; 2; 3) ergibt 33% + 50% = 83% 
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WÄHRUNG (Zahl als Währung formatieren) 

Syntax: 

WÄHRUNG(Zahl [; n]) 

Beschreibung: 

Konvertiert eine Zahl in eine Zeichenkette. Diese enthält die auf n Stellen gerunde-

te und als Währung formatierte Zahl. 

PlanMaker ermittelt die anzuzeigende Währung aus den Ländereinstellungen Ihres 

Betriebssystems. Bei Anwendern in Deutschland und Österreich wird der Betrag 

also in Euro angezeigt, bei Schweizern in sFr etc. 

Zahl ist die umzuwandelnde Zahl. 

Das optionale Argument n bestimmt gewünschte Anzahl an Nachkommastellen. 

Wird es nicht angegeben, wird die Zahl auf 2 Nachkommastellen gerundet. 

n darf auch ein negativer Wert sein, worauf der ganzzahlige Teil der Zahl gerundet 

wird: Ist n beispielsweise -2, wird die Zahl auf ein Vielfaches von Hundert gerun-

det (siehe letztes Beispiel). 

Hinweis: 

Beachten Sie, dass das Ergebnis dieser Funktion eine Zeichenkette ist. Um eine 

Zahl zu runden, ohne sie in eine Zeichenkette zu wandeln, verwenden Sie eine der 

Rundungsfunktionen wie zum Beispiel RUNDEN.  

Um eine Zahl nur gerundet und als Währung formatiert anzuzeigen, können Sie 

auch über den Befehl Format > Zelle ihr Zahlenformat ändern. 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

WÄHRUNG(123,456) ergibt die Zeichenkette € 123,46 
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WÄHRUNG(123,456; 2) ergibt die Zeichenkette € 123,46 

WÄHRUNG(123,456; -2) ergibt die Zeichenkette € 100 

WECHSELN (Text in Zeichenkette ersetzen) 

Syntax: 

WECHSELN(Zeichenkette; Suchtext; Ersatztext [; n]) 

Beschreibung: 

Ersetzt den Suchtext in einer Zeichenkette durch den Ersatztext. 

Zeichenkette ist die ursprüngliche Zeichenkette. 

Suchtext ist der zu ersetzende Text. Hierbei ist die Groß-/Kleinschreibung zu be-

achten. 

Ersatztext ist neue Text. 

Das optionale Argument n bestimmt, das wievielte Vorkommen des Suchbegriffs 

ersetzt werden soll. Wird n nicht angegeben, werden alle Vorkommen ersetzt. 

Beispiel: 

WECHSELN("aabbaabb"; "aa"; "xx") ergibt xxbbxxbb 

WECHSELN("aabbaabb"; "aa"; "xx"; 2) ergibt aabbxxbb 

WECHSELN("aabbaabb"; "AA"; "xx") ergibt aabbaabb 

Siehe auch: 

FINDEN, SUCHEN, ERSETZEN 
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WEIBULL (Weibull-Verteilung) 

Syntax: 

WEIBULL(x; Alpha; Beta; Kumuliert) 

Beschreibung: 

Liefert Wahrscheinlichkeiten einer Weibull-verteilten Zufallsvariablen. 

Die Weibull-Verteilung ist eine Erweiterung der Exponentialverteilung (siehe 

Funktion EXPONVERT) auf Ereignisse, die nicht rein zufällig sind und nicht exakt 

der Poisson-Verteilung (siehe Funktion POISSON) genügen. 

Sie wird besonders bei Zuverlässigkeitsbetrachtungen eingesetzt. 

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. x muss größer 

oder gleich Null sein. 

Alpha ist ein Parameter der Verteilung. Alpha bestimmt die Form der Verteilungs-

kurve. Bei Alpha=1 entspricht die Weibull-Verteilung einer Exponentialverteilung 

mit Lambda = 1/Beta. 

Beta ist ein weiterer Parameter der Verteilung. Beta bestimmt die Skalierung der 

Verteilungskurve, streckt beziehungsweise staucht den Funktionsgraphen also. 

Beide Parameter müssen größer als Null sein. 

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert wer-

den soll: 

FALSCH: Es wird die Dichtefunktion geliefert. 

WAHR: Es wird die Verteilungsfunktion (also die integrierte Dichtefunktion) gelie-

fert. 

Beispiel: 

WEIBULL(42; 2; 100; WAHR) ergibt 0,16172 

WEIBULL(42; 2; 100; FALSCH) ergibt 0,00704 
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Siehe auch: 

EXPONVERT, POISSON 

WENN (Wenn-Dann-Sonst-Bedingung) 

Syntax: 

WENN(Bedingung; WennWahr [; WennFalsch]) 

Beschreibung: 

Diese Funktion liefert den Wert WennWahr, wenn Bedingung wahr ist, ansonsten 

den Wert WennFalsch (sofern angegeben). 

Bedingung kann ein beliebiger Ausdruck sein, der WAHR oder FALSCH zurück-

liefert. 

WennWahr und WennFalsch können beliebige Werte oder Ausdrücke (also auch 

Formeln) sein. 

Beispiel: 

Die Formel WENN(A1<5; "Nachbestellen!"; "Bestand ok") liefert die Zeichenkette 

„Nachbestellen!“, wenn A1<5 ist. Ist dies nicht der Fall (A1 ist also  5), liefert sie 

die Zeichenkette „Bestand ok“. 

Siehe auch: 

AUSWAHL 

WENNFEHLER (liefert Zeichenkette bei Fehler) 

Syntax: 

WENNFEHLER(Wert; Zeichenkette) 



 

Handbuch PlanMaker Formeln und Funktionen    723 

Beschreibung: 

Gibt normalerweise den übergebenen Wert zurück. Liefert dieser Wert jedoch ei-

nen (beliebigen) Fehlerwert, wird stattdessen die übergebene Zeichenkette zu-

rückgegeben. 

Kompatibilitätshinweis: 

Diese Funktion ist nicht kompatibel zum .xls-Dateiformat von Microsoft Excel 

2003 und früher. Wenn Sie ein Dokument in diesem Format speichern, werden alle 

Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester 

Wert ersetzt.  

Wenn Sie diese Funktion einsetzen möchten, sollten Sie Ihr Dokument also nicht 

im Dateiformat „Microsoft Excel 97-2003 (.xls)“ speichern, sondern eines der fol-

genden Formate verwenden: 

 „PlanMaker-Dokument (.pmd)“ 

 oder: „Microsoft Excel 2007-2010 (.xlsx)“ 

Beispiel: 

WENNFEHLER(A1; "Fehler!") liefert den Inhalt der Zelle A1, solange diese kei-

nen Fehlerwert enthält. Befindet sich in dieser Zelle jedoch ein Fehlerwert, wird 

stattdessen der Text „Fehler!“ geliefert. 

Siehe auch: 

ISTFEHL, ISTFEHLER, ISTNV, FEHLER.TYP, Abschnitt über „Fehlerwerte“ ab 

Seite 448 

WERT (Zeichenkette in Zahl umwandeln) 

Syntax: 

WERT(Zeichenkette) 
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Beschreibung: 

Wandelt eine Zeichenkette in eine Zahl um (sofern diese aus einer gültigen Zahl 

besteht). 

Hinweis: 

Diese Funktion ist nur aus Gründen der Kompatibilität mit älteren Tabellenkalkula-

tionen noch vorhanden. PlanMaker selbst benötigt sie nicht mehr, da er Zeichen-

ketten bei Bedarf automatisch in Zahlen umwandelt. 

Beispiel: 

WERT("42") ergibt 42 

WERT("42 DM") ergibt 42, denn „DM“ ist eine Währungseinheit. 

WERT("42 Bolzen") ergibt hingegen den Fehlerwert #WERT!. 

WERT("WAHR") ergibt 1 

WERT("25.09.2008") ergibt 39716, die serielle Datumszahl für das Datum 

25.09.2008 

Siehe auch: 

TEXT, T, N 

WIEDERHOLEN (Zeichenkette n mal wiederholen) 

Syntax: 

WIEDERHOLEN(Zeichenkette; n) 

Beschreibung: 

Wiederholt die übergebene Zeichenkette n mal. 

Über das Argument n bestimmen Sie die Anzahl der Wiederholungen. n sollte eine 

ganze Zahl sein. Ist dies nicht der Fall, schneidet PlanMaker die Nachkommastel-

len automatisch ab. 
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Beispiel: 

WIEDERHOLEN("Text"; 3) ergibt TextTextText 

Siehe auch: 

ERSETZEN, WECHSELN 

WOCHENTAG (Wochentag aus Datum ermitteln) 

Syntax: 

WOCHENTAG(Datum [; Modus]) 

Beschreibung: 

Liefert den Wochentag eines Datums in Form einer Zahl von 1 bis 7 beziehungs-

weise 0 bis 6. 

Über das optionale Argument Modus können Sie festlegen, welche Ergebnisse 

diese Funktion liefern soll: 

Ist Modus 1 oder nicht angegeben, liefert die Funktion Werte von 1 (=Sonntag) bis 

7 (=Samstag). 

Ist Modus 2, liefert die Funktion Werte von 1 (=Montag) bis 7 (=Sonntag). 

Ist Modus 3, liefert die Funktion Werte von 0 (=Montag) bis 6 (=Sonntag). 

Beispiel: 

WOCHENTAG("25.9.1966") ergibt 1 (also Sonntag) 

WOCHENTAG("25.9.1966"; 2) ergibt 7 (also Sonntag) 

Siehe auch: 

ISOWOCHE, JAHR, KALENDERWOCHE, MONAT, TAG 
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WURZEL (Quadratwurzel) 

Syntax: 

WURZEL(Zahl) 

Beschreibung: 

Liefert die Quadratwurzel einer Zahl.  

Die übergebene Zahl muss größer gleich Null sein. 

Beispiel: 

WURZEL(25) ergibt 5 

WURZEL(-25) ergibt den Fehlerwert #ZAHL! 

Siehe auch: 

WURZELN, POTENZ 

WURZELN (Wurzel) 

Syntax: 

WURZELN(Zahl [; n]) 

Beschreibung: 

Zieht die n-te Wurzel aus einer Zahl. Wird n nicht angegeben, liefert die Funktion 

die Quadratwurzel (n=2).  

n sollte eine ganze Zahl sein. Ist dies nicht der Fall, schneidet PlanMaker die 

Nachkommastellen automatisch ab. 

Wenn n gerade ist, muss Zahl positiv sein. 
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Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

WURZELN(25) ergibt 5 

WURZELN(-25) ergibt den Fehlerwert #ZAHL! 

WURZELN(125; 3) ergibt 5 

WURZELN(-125; 3) ergibt -5 

Siehe auch: 

WURZEL, POTENZ 

WURZELPI (Quadratwurzel von x*Pi) 

Syntax: 

WURZELPI(Zahl) 

Beschreibung: 

Liefert die Quadratwurzel einer mit der Kreiszahl Pi multiplizierten Zahl. 

Die übergebene Zahl muss größer gleich Null sein. 

Beispiel: 

WURZELPI(42) entspricht WURZEL(42*PI()), ergibt also 11,48681381 

Siehe auch:   

PI, WURZEL, WURZELN 
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WVERWEIS (Zellbereich zeilenweise durchsuchen) 

Syntax: 

WVERWEIS(Suchkriterium; Bereich; n [; Sortiert]) 

Beschreibung: 

Sucht in der ersten Zeile von Bereich nach dem ersten Vorkommen von Suchkri-

terium. Wird es gefunden, liefert die Funktion den Inhalt der Zelle, die sich in der 

gleichen Spalte und der n-ten Zeile von Bereich befindet. 

Suchkriterium ist der gesuchte Wert. Die Groß-/Kleinschreibung spielt keine Rol-

le. 

Bereich ist der zu durchsuchende Zellbereich. Die erste Zeile muss die zu durchsu-

chenden Werte enthalten. Dies können Zeichenketten, Zahlen oder Wahrheitswerte 

sein. 

Für n ist anzugeben, aus der wievielten Zeile von Bereich ein Wert zurückgeliefert 

werden soll, wenn das Suchkriterium gefunden wird. 

Ist n kleiner als 1, wird der Fehlerwert #WERT! zurückgeliefert. Ist n größer als 

die Zeilenzahl von Bereich, wird der Fehlerwert #BEZUG! zurückgeliefert.  

Sortiert ist ein Wahrheitswert, mit dem Sie angeben, ob die Werte in der ersten 

Zeile von Bereich sortiert sind: 

Ist Sortiert WAHR oder nicht angegeben, müssen die Werte in der ersten Zeile von 

Bereich aufsteigend sortiert sein. 

Ist Sortiert FALSCH, spielt die Reihenfolge der Werte in der ersten Zeile keine 

Rolle. 

Wichtig: Wenn Sie Sortiert also nicht explizit auf FALSCH setzen, müssen diese 

Werte in sortierter Reihenfolge vorliegen! 

Hinweis: 

Wenn WVERWEIS keinen exakt mit dem Suchkriterium übereinstimmenden 

Wert findet, wird automatisch der nächstkleinere Wert genommen.  

Existiert kein kleinerer Wert, weil Suchkriterium kleiner als der kleinste vorhan-

dene Wert ist, liefert die Funktion den Fehlerwert #NV. 
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Beispiel: 

Sie verkaufen Blumen zu unterschiedlichen Stückpreisen – je nachdem, wie viele 

Pflanzen der Kunde abnimmt. Dazu haben Sie eine Tabelle mit einer Rabattstaffel 

erstellt: 

 

Jetzt können Sie die Funktion WVERWEIS einsetzen, um abhängig von der Stück-

zahl den Preis für eine bestimmte Blumensorte zu ermitteln. 

Verwenden Sie dazu folgende Argumente: 

Als Suchkriterium geben Sie den Namen der Blumensorte an (also "Rosen", 

"Nelken" oder "Tulpen"). 

Als Bereich geben Sie die den Zellbereich an, der in der ersten Zeile die Namen 

der Blumensorten und darunter die Preise enthält – hier also B1:D4. 

Für n geben Sie die Stückzahl plus Eins an, denn die erste Zeile (n=1) enthält ja 

keine Preise, sondern die Namen der Pflanzen. 

Beispiele: 

WVERWEIS("Rosen"; B1:D4; 2; FALSCH) liefert den Preis für eine Rose, also € 

5,50. 

WVERWEIS("Rosen"; B1:D4; 4; FALSCH) liefert den Preis für drei Rosen, also € 

4,95. 

WVERWEIS("Nelken"; B1:D4; 4; FALSCH) liefert den Preis für drei Nelken, also 

€ 4,50. 

WVERWEIS("Nelken"; B1:D4; 5; FALSCH) liefert den Fehlerwert #BEZUG, da n 

größer als die Zeilenzahl von Bereich ist. 

WVERWEIS("Petunien"; B1:D4; 4; FALSCH) liefert den Fehlerwert #NV, da „Pe-

tunien“ in der ersten Zeile von Bereich nicht vorkommt. 



 

730    Formeln und Funktionen Handbuch PlanMaker 

Siehe auch: 

SVERWEIS, INDEX, VERGLEICH  

XINTZINSFUSS (Interner Zinsfuß) 

Syntax: 

XINTZINSFUSS(Werte; Daten [; Schätzwert]) 

Beschreibung: 

Liefert einen Schätzwert für den internen Zinsfuß einer Investition mit nicht perio-

disch anfallenden Zahlungen. 

Als Basis dienen die im Bereich Werte angegebenen Auszahlungen (negative Wer-

te) und Einzahlungen (positive Werte). Die Zahlungen dürfen zu beliebigen Zeit-

punkten erfolgen. Das Datum für jede Zahlung ist jeweils im Bereich Daten anzu-

geben. 

Die Funktion erwartet folgende Argumente: 

Für Werte gibt man einen Zellbezug an, in dem die Zahlungen eingetragen wur-

den. Es muss mindestens eine Auszahlung und eine Einzahlung vorliegen. 

Für Daten gibt man einen Zellbezug an, in dem die Datumsangaben für jede im 

Bereich Werte eingetragene Zahlung angegeben ist. 

Für Schätzwert können Sie (optional) einen Schätzwert für das Ergebnis der Be-

rechnung angeben (siehe Hinweis). 

Hinweis: 

Die Berechnung erfolgt mit Hilfe eines Näherungsverfahrens (Iterationsverfahren). 

Falls die Funktion nach 20 Näherungsschritten noch kein Ergebnis mit einer Ge-

nauigkeit von 0,00001% oder besser findet, bricht sie die Näherung ab und liefert 

als Ergebnis den Fehlerwert #ZAHL!. Versuchen Sie in diesem Fall einen anderen 

Wert für Schätzwert anzugeben. 

Siehe auch: 

IKV, QIKV, XKAPITALWERT, ZINS 
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XKAPITALWERT (Nettobarwert) 

Syntax: 

XKAPITALWERT(Zins; Werte; Daten) 

Beschreibung: 

Liefert den Kapitalwert (Nettobarwert) einer Investition mit nicht periodisch anfal-

lenden Zahlungen. 

Als Basis dienen die im Bereich Werte angegebenen Auszahlungen (negative Wer-

te) und Einzahlungen (positive Werte). Die Zahlungen dürfen zu beliebigen Zeit-

punkten erfolgen. Das Datum für jede Zahlung ist jeweils im Bereich Daten anzu-

geben. 

Die Funktion erwartet folgende Argumente: 

Zins ist der Kapitalzinsfuß für die Zahlungen. 

Für Werte gibt man einen Zellbezug an, in dem die Zahlungen eingetragen wur-

den. Es muss mindestens eine Auszahlung und eine Einzahlung vorliegen. 

Für Daten gibt man einen Zellbezug an, in dem die Datumsangaben für jede im 

Bereich Werte eingetragene Zahlung angegeben ist. 

Siehe auch: 

NBW, XINTZINSFUSS 

XODER (Logisches EXKLUSIV ODER) 

Syntax: 

XODER(Wahrheitswert1; Wahrheitswert2 [; Wahrheitswert3 ...]) 

Beschreibung: 

Die Funktion XODER („Exklusiv Oder“) liefert WAHR, wenn eine ungerade An-

zahl der ihr übergebenen Wahrheitswerte WAHR ist, ansonsten liefert sie FALSCH. 
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Häufig wird diese Funktion mit nur zwei Argumenten verwendet. Hier eignet sie 

sich nämlich ideal für Entweder-Oder-Entscheidungen: 

Wenn entweder das eine oder das andere Argument WAHR ist, liefert sie WAHR. 

Sind hingegen beide WAHR oder beide FALSCH, liefert sie FALSCH. 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

XODER(WAHR; WAHR) ergibt FALSCH 

XODER(WAHR; FALSCH) ergibt WAHR 

XODER(FALSCH; WAHR) ergibt WAHR 

XODER(FALSCH; FALSCH) ergibt FALSCH 

Siehe auch: 

ODER, UND, NICHT 

ZÄHLENWENN (Zählen ausgewählter Werte) 

Syntax: 

ZÄHLENWENN(Suchbereich; Suchkriterium) 

Beschreibung: 

Ermittelt, wie viele Werte in einem Bereich der angegebenen Bedingung entspre-

chen. 

Suchbereich ist der zu durchsuchende Bereich. 

Suchkriterium ist die zu erfüllende Bedingung: 
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Hier können Sie einerseits einen einfachen Wert angeben (zum Beispiel "42" oder 

"Schrauben"). In diesem Fall werden alle Posten gezählt, die diesem Wert entspre-

chen.  

Tipp: Um alle nicht-leeren Zellen zu zählen, geben Sie als Kriterium "*" an. ZÄH-

LENWENN(D2:D4; "*") zählt beispielsweise alle Zellen im angegebenen Bereich, 

die nicht leer sind. 

Weiterhin ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier werden 

alle Posten gezählt, die dieser Bedingung entsprechen. 

Hinweis: Das Suchkriterium sollte stets mit doppelten Anführungszeichen (") um-

geben werden. 

Beispiel: 

In den Zellen A1 bis A5 stehen die Werte 1; 2; 3; 2; 1. Hier gilt: 

ZÄHLENWENN(A1:A5; "2") ergibt 2 

ZÄHLENWENN(A1:A5; ">=2") ergibt 3 

Siehe auch: 

ANZAHL, MITTELWERTWENN, MITTELWERTWENNS, SUMMEWENN, 

SUMMEWENNS, ZÄHLENWENNS 

ZÄHLENWENNS (Zählen ausgewählter Werte) 

Syntax: 

ZÄHLENWENNS(Suchbereich1; Suchkriterium1 [; Suchbereich2; Suchkriterium2 

...]) 

Beschreibung: 

Prüft die Zellen aus mehreren Bereichen auf jeweils eine Bedingung und zählt, wie 

oft dabei alle Bedingungen erfüllt sind.  

Entspricht der Funktion ZÄHLENWENN, erlaubt allerdings die Verwendung meh-

rerer Suchbereiche (inklusive eines Suchkriteriums für jeden Bereich). 
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Suchbereich1 ist der erste zu durchsuchende Bereich. Beachten Sie, dass alle 

Suchbereiche die gleichen Ausmaße haben müssen. 

Suchkriterium1 ist die Bedingung, die die Werte in Suchbereich1 erfüllen müs-

sen: 

Hier können Sie einerseits einen einfachen Wert angeben (zum Beispiel "42" oder 

"Schrauben"). In diesem Fall gilt die Bedingung als erfüllt, wenn die Zelle diesen 

Wert enthält. 

Weiterhin ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier gilt die 

Bedingung als erfüllt, wenn der Zellinhalt dieser Bedingung entspricht. 

Hinweis: Das Suchkriterium sollte stets mit doppelten Anführungszeichen (") um-

geben werden. 

Im Gegensatz zur Funktion ZÄHLENWENN können Sie bei ZÄHLENWENNS 

auch mehrere Bereiche (jeweils mit zugehörigem Suchkriterium) angeben. Es wird 

dann gezählt, wie oft die Zellen aus den einzelnen Bereichen alle ihrem jeweiligen 

Kriterium entsprechen. Siehe Beispiele. 

Kompatibilitätshinweis: 

Diese Funktion ist nicht kompatibel zum .xls-Dateiformat von Microsoft Excel 

2003 und früher. Wenn Sie ein Dokument in diesem Format speichern, werden alle 

Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester 

Wert ersetzt.  

Wenn Sie diese Funktion einsetzen möchten, sollten Sie Ihr Dokument also nicht 

im Dateiformat „Microsoft Excel 97-2003 (.xls)“ speichern, sondern eines der fol-

genden Formate verwenden: 

 „PlanMaker-Dokument (.pmd)“ 

 oder: „Microsoft Excel 2007-2010 (.xlsx)“ 

Beispiel: 

ZÄHLENWENNS(C1:C10; ">1"; C1:C10; "<2")  

Diese Formel ermittelt, wie viele der Werte im Bereich C1:C10 größer als 1 und 

kleiner als 2 sind. 

ZÄHLENWENNS(A1:D4; "Thunfisch"; G10:K14; ">500")  



 

Handbuch PlanMaker Formeln und Funktionen    735 

Diese Formel ermittelt, wie oft die folgenden Bedingungen zutreffen: die Zelle im 

Bereich A1:D4 enthält „Thunfisch“ und die entsprechende Zelle im Bereich 

G10:K14 ist größer als 500. 

Siehe auch: 

ANZAHL, MITTELWERTWENN, MITTELWERTWENNS, SUMMEWENN, 

SUMMEWENNS, ZÄHLENWENN 

ZEICHEN (Zeichen per ANSI-Code) 

Syntax: 

ZEICHEN(Zahl) 

Beschreibung: 

Liefert das Zeichen mit dem ANSI-Code Zahl. 

Zahl muss größer oder gleich 10 sein. 

Beispiel: 

ZEICHEN(65) ergibt A 

ZEICHEN(32) ergibt ein Leerzeichen 

ZEICHEN(CODE("X") ergibt X 

Siehe auch: 

CODE 

ZEILE (Zeilennummer von Zellen) 

Syntax: 

ZEILE([Bezug]) 
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Beschreibung: 

Liefert die Zeilennummer(n) einer Zelle oder eines Bereichs von Zellen: 

Ist Bezug eine einzelne Zelle, liefert die Funktion die Zeilennummer dieser Zelle. 

Ist Bezug ein Bereich von Zellen, liefert die Funktion die darin enthaltenen Zeilen-

nummern als vertikale Matrix. Hinweis: In diesem Fall muss die Formel als Mat-

rixformel eingegeben werden (siehe Abschnitt „Arbeiten mit Matrizen“ ab Seite 

450). 

Wird das Argument Bezug nicht angegeben, liefert die Funktion die Zeilennummer 

der Zelle, in der sie aufgerufen wurde. 

Beispiel: 

ZEILE(D2) ergibt 2 

ZEILE(D2:F4) ergibt {2;3;4} 

ZEILE() ergibt 5, wenn Sie die Funktion ZEILE() beispielsweise in der Zelle A5 

aufrufen 

Siehe auch: 

SPALTE, ZEILEN 

ZEILEN (Zahl der Zeilen) 

Syntax: 

ZEILEN(Bereich) 

Beschreibung: 

Liefert die Anzahl der Zeilen im angegebenen Bereich. 

Beispiel: 

ZEILEN(A1:D5) ergibt 5 
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Siehe auch: 

ZEILE, SPALTEN 

ZEIT (Datumswert bilden) 

Syntax: 

ZEIT(Stunde; Minute; Sekunde) 

Beschreibung: 

Bildet einen Datumswert aus den Argumenten Stunde, Minute und Sekunde. 

Beispiel: 

ZEIT(0; 20; 0) ergibt 0,01389. Dieser Datumswert wird von PlanMaker allerdings 

automatisch im Zahlenformat „Datum/Zeit“ formatiert, so dass in der Zelle steht: 

00:20:00. 

Siehe auch: 

ZEITWERT, DATUM, DATWERT 

ZEITDIFFERENZ (Differenz zwischen zwei Uhrzeiten) 

Syntax: 

ZEITDIFFERENZ(Beginn; Ende) 

Beschreibung: 

Berechnet die zwischen zwei Uhrzeiten verstrichene Zeit. 

Für Beginn und Ende ist jeweils eine Uhrzeit anzugeben.  
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Sie können auch ein Datum mit einer Uhrzeit angeben (siehe letztes Beispiel), in 

diesem Fall müssen aber sowohl Beginn als auch Ende ein Datum enthalten, sonst 

liefert die Funktion den Fehlerwert #WERT!. 

Hinweis: 

Diese Funktion liefert auch dann sinnvolle Resultate, wenn Ende kleiner als Be-

ginn ist.  

Beispiel: Ein Arbeiter nimmt seine Tätigkeit um 22:00 auf und geht um 6:00 nach 

Hause. Würden Sie jetzt, um seine Arbeitszeit zu ermitteln, einfach Anfangszeit 

von Endzeit abziehen, wäre das Ergebnis -16 Stunden. Verwenden Sie hingegen die 

Funktion ZEITDIFFERENZ, ist das Ergebnis 8 Stunden. 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

ZEITDIFFERENZ("8:00"; "16:00") ergibt 8:00 

ZEITDIFFERENZ("22:00"; "6:00") ergibt 8:00 

ZEITDIFFERENZ("1.10.2013 22:00"; "2.10.2013 6:00") ergibt 8:00 

Siehe auch: 

ZEIT, ZEITWERT 

ZEITWERT (Text in Uhrzeit wandeln) 

Syntax: 

ZEITWERT(Zeichenkette) 
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Beschreibung: 

Wandelt eine in Textform angegebene Zeitangabe in eine Uhrzeit (genauer gesagt: 

in eine serielle Datumszahl) um.  

Hinweis: 

Diese Funktion ist nur aus Kompatibilitätsgründen zu älteren Tabellenkalkulatio-

nen noch vorhanden. PlanMaker selbst benötigt sie nicht mehr, da er Uhrzeiten, 

die als Text angegeben sind, bei Bedarf automatisch in den Typ Datum/Uhrzeit 

umwandelt. 

Beispiel: 

ZEITWERT("10:30:00") ergibt die serielle Datumszahl 0,4375. 

Formatieren Sie diese mit Format > Zelle nun in einem der Datum/Zeit-Formate 

(zum Beispiel h:mm), so wird in der Zelle die Uhrzeit angezeigt, die sich hinter 

diesem Wert verbirgt: 10:30. 

Siehe auch: 

DATWERT, DATUM, ZEIT 

ZELLE (Informationen über eine Zelle) 

Syntax: 

ZELLE(Typ [; Bezug]) 

Beschreibung: 

Liefert verschiedene Informationen über die angegebene Zelle zurück. 

Der Parameter Typ bestimmt, welche Art von Information geliefert werden soll. 

Geben Sie dazu eine der folgenden Zeichenketten an: 

Typ Erläuterung 

"Adresse" Liefert die Adresse der Zelle (als Text). 
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"Breite" (Wird nicht unterstützt und liefert deshalb den Fehlerwert #NV.) 

"Dateiname" Liefert den vollständigen Pfad und Dateinamen des Dokuments, in 

dem sich die Zelle befindet. 

"Farbe" Liefert 1, wenn das Zahlenformat der Zelle die Option Negative 

Werte in Rot verwendet; ansonsten wird 0 zurückgeliefert. 

"Format" (Wird nicht unterstützt und liefert deshalb den Fehlerwert #NV.) 

"Inhalt" Liefert den Wert zurück, der sich in der Zelle befindet. 

"Klammern" (Wird nicht unterstützt und liefert deshalb den Fehlerwert #NV.) 

"Präfix" Liefert eine der folgenden Zeichenketten zurück: 

', wenn die Zelle linksbündigen Text enthält 

", wenn die Zelle rechtsbündigen Text enthält 

^, wenn die Zelle zentrierten Text enthält 

\, wenn die Zelle ausgefüllten Text enthält 

"", wenn die Zelle etwas anderes enthält 

"Schutz" Liefert 1, wenn die Zelle geschützt ist; ansonsten wird 0 zurückgelie-

fert. 

"Spalte" Liefert die Spaltennummer der Zelle (als Zahl). 

"Typ" Liefert eine der folgenden Zeichenketten zurück: 

b, wenn die Zelle leer ist 

l, wenn die Zelle Text enthält 

w, wenn die Zelle etwas anderes enthält 

"Zeile" Liefert die Zeilennummer der Zelle. 

Bezug (optional) ist die Adresse der Zelle, zu der Informationen geliefert werden 

sollen.  

Wenn Bezug mehrere Zellen umfasst, wird nur die linke obere Zelle verwendet. 

Wenn Bezug weggelassen wird, wird die aktuelle Zelle verwendet. (Excel verhält 

sich hier anders; siehe Hinweis.) 

Kompatibilitätshinweis: 

Diese Funktion ist nicht 100% identisch mit der gleichnamigen Excel-Funktion. Es 

gibt folgende Einschränkungen: 

1. PlanMaker unterstützt nicht alle Typen von Informationen (siehe Tabelle oben).  
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2. Wenn der Parameter Bezug leer gelassen wird, liefert PlanMaker Informationen 

zur aktuellen Zelle, Excel hingegen zu der zuletzt geänderten Zelle. 

Beispiel: 

=ZELLE("Zeile"; B5) liefert die Zeilennummer dieser Zelle, also 5. 

Siehe auch: 

DATEINAME, SPALTE, ZEILE 

ZGZ (Zinssatz) 

Syntax: 

ZGZ(Zr; Bw; Zw) 

Beschreibung: 

Berechnet den Zinssatz pro Periode, der benötigt wird, um mit einer festverzinsli-

chen Anlage innerhalb einer bestimmten Anzahl an Perioden einen bestimmten 

Betrag zu erreichen.  

Es werden hierbei keine regelmäßigen Zahlungen geleistet; es gibt also nur eine 

einzige Einzahlung am Beginn der Laufzeit. 

Die Funktion erwartet folgende Argumente: 

Zr = Zeitraum (Anzahl der Perioden). Wird beispielsweise der Jahreszins betrach-

tet, ist eine Periode ein Jahr lang. 

Bw = Barwert (der anfängliche Betrag) 

Zw = Zukünftiger Wert (der Zielwert) 

Kompatibilitätshinweis: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 
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Tipp: Als Excel-kompatible Alternative können Sie die Funktion ZINS verwenden, 

die allerdings nur eine Näherung an das präzise Ergebnis liefert: 

ZGZ(Zr; Bw; Zw) entspricht näherungsweise ZINS(Zr; 0; Bw; -Zw) 

Beachten Sie das Minuszeichen vor Zw!  

Berücksichtigen Sie hierbei bitte, dass die Funktion ZINS nur ein angenähertes 

Ergebnis liefert (Iterationsverfahren), die Funktion ZGZ hingegen ein exaktes. 

Beispiel: 

Sie möchten mit einer festverzinslichen Anlage von € 3000,- innerhalb von 10 Jah-

ren € 5000,- erreichen. Wie hoch muss der jährliche Zinssatz sein? 

ZGZ(10; 3000; 5000) ergibt einen Jahreszins von 0,05241 (also etwa 5,24%). 

Siehe auch: 

LAUFZEIT, ZINS 

ZINS (Zinssatz per Iterationsverfahren) 

Syntax: 

ZINS(Zzr; Rmz; Bw [; Zw] [; Fälligkeit] [; Schätzwert]) 

Beschreibung: 

Liefert eine Schätzung für den Zinsanteil der Zahlung pro Periode, basierend auf 

einer Investition mit regelmäßigen konstanten Zahlungen und feststehendem Zins. 

Die Funktion erwartet folgende Argumente: 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 

Rmz = Annuität (Betrag, der pro Periode gezahlt wird) 

Bw = Barwert (der anfängliche Betrag) 
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Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zah-

lung erreichen möchten. Wenn Sie das Argument Zw nicht angeben, wird es auf 

Null gesetzt. 

Fälligkeit (optional) = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 

Schätzwert (optional) = Ihr Schätzwert, wie hoch der Zinssatz vermutlich sein 

wird (siehe Hinweis). 

Hinweis: 

Die Berechnung erfolgt mit Hilfe eines Näherungsverfahrens (Iterationsverfahren). 

Falls die Funktion nach 20 Näherungsschritten noch kein Ergebnis mit einer Ge-

nauigkeit von 0,00001% oder besser findet, bricht sie die Näherung ab und liefert 

als Ergebnis den Fehlerwert #ZAHL!. Versuchen Sie in diesem Fall einen anderen 

Wert für Schätzwert anzugeben. 

Beispiel: 

ZINS(12*10; -650; 60000) ergibt 0,455087% 

Diese Formel berechnet per Iterationsverfahren den Zinssatz bei einem Kredit über 

€ 60.000 mit einer Laufzeit von 10 Jahren (=12*10 Monate) und einer Zahlung von 

€ 650,- (pro Monat). 

Das Ergebnis ist der Zinssatz pro Monat. Um den Jahreszins zu erhalten, muss es 

also mit 12 multipliziert werden. 

Siehe auch: 

BW, KAPZ, RMZ, XINTZINSFUSS, ZINSZ, ZW, ZZR 

ZINSZ (Zinszahlung) 

Syntax: 

ZINSZ(Zins; Zr; Zzr; Bw [; Zw] [; Fälligkeit]) 
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Beschreibung: 

Liefert den Zinsanteil der Zahlung in der angegebenen Periode, basierend auf einer 

Investition mit regelmäßigen konstanten Zahlungen und feststehendem Zins. 

Sie können mit dieser Funktion beispielsweise berechnen, wie groß bei einem Kre-

dit der Zinsanteil der Annuität in einer bestimmten Periode ist.  

„Periode“ bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen 

Rückzahlungen ist die dritte Periode beispielsweise der dritte Monat. 

Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode) 

Zr = die zu betrachtende Periode 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 

Bw = Barwert (der anfängliche Betrag) 

Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zah-

lung erreichen möchten. Wenn Sie das Argument Zw nicht angeben, wird es auf 

Null gesetzt. 

Fälligkeit (optional) = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 

Beispiel: 

Es wird ein Kredit über € 100.000,- zu folgenden Bedingungen aufgenommen: 

Jahreszins: 10% 

Zahlungen: monatlich 

Laufzeit: 6 Jahre 

Wie groß ist der Zinsanteil der Zahlung (Annuität) in Monat 32? 

ZINSZ(10%/12; 32; 6*12; 100000) ergibt -534 Euro 

Beachten Sie dabei, dass alle Angaben auf der gleichen Zeiteinheit basieren müs-

sen – hier also auf Monaten, da die Zahlungen monatlich erfolgen.  
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Deshalb wurde in der obigen Formel der Jahreszins durch 12 geteilt (um den Zins 

pro Monat zu erhalten) und die Laufzeit mit 12 multipliziert (um die Laufzeit in 

Monaten zu erhalten). 

Siehe auch: 

BW, ISPMT, KAPZ, RMZ, ZINS, ZW, ZZR 

Anmerkung: 

Die Funktion KAPZ ist das Gegenstück zu ZINSZ: Sie liefert den Tilgungsanteil 

der Zahlung in dieser Periode.  

Die Funktion RMZ hingegen liefert den Gesamtbetrag der Zahlung (Annuität) pro 

Periode, also die Summe von Tilgungsanteil und Zinsanteil. 

ZUFALLSBEREICH (zufälliger Wert) 

Syntax: 

ZUFALLSBEREICH(Untergrenze; Obergrenze) 

Beschreibung: 

Liefert eine ganze Zufallszahl x im Bereich Untergrenze  x Obergrenze. 

Bei jeder Neuberechnung des Dokuments wird diese Zahl neu erzeugt.  

Tipp: Durch Aufruf des Befehl Weiteres > Neu berechnen (Tastenkürzel (F9)) 

können Sie ein Dokument manuell neu berechnen lassen. 

Beispiel: 

ZUFALLSBEREICH(1; 6) liefert ganze Zufallszahlen zwischen 1 und 6, simuliert 

also einen Würfel. 

Siehe auch: 

ZUFALLSZAHL 
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ZUFALLSZAHL (zufälliger Wert) 

Syntax: 

ZUFALLSZAHL() 

Beschreibung: 

Liefert eine Zufallszahl x im Bereich 0  x 1. 

Bei jeder Neuberechnung des Dokuments wird diese Zahl neu erzeugt.  

Tipp: Durch Aufruf des Befehl Weiteres > Neu berechnen (Tastenkürzel (F9)) 

können Sie ein Dokument manuell neu berechnen lassen. 

Beispiel: 

ZUFALLSZAHL() ergibt eine Zufallszahl 

Will man beispielsweise eine ganze Zufallszahl zwischen 1 und 6 erzeugen, um 

einen Würfel zu simulieren, könnte man folgende Formel verwenden: 

GANZZAHL(ZUFALLSZAHL()*6+1) 

Einfacher geht dies allerdings mit ZUFALLSBEREICH(1; 6). 

Siehe auch: 

ZUFALLSBEREICH  

ZULETZTGEDRUCKT (Datum des letzten Ausdrucks) 

Syntax: 

ZULETZTGEDRUCKT() 

Beschreibung: 

Liefert das Datum, an dem das aktuelle Dokument zuletzt ausgedruckt wurde. 
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Siehe auch: 

ZULETZTGESPEICHERT 

ZULETZTGESPEICHERT (Datum des letzten Speicherns) 

Syntax: 

ZULETZTGESPEICHERT() 

Beschreibung: 

Liefert das Datum, an dem das aktuelle Dokument zuletzt gespeichert wurde. 

Siehe auch: 

ZULETZTGEDRUCKT 

ZW (Zukünftiger Wert) 

Syntax: 

ZW(Zins; Zzr; Rmz [; Bw] [; Fälligkeit]) 

Beschreibung: 

Liefert den zukünftigen Wert einer Investition, basierend auf einer Investition mit 

regelmäßigen konstanten Zahlungen und feststehendem Zins. 

Sie können mit dieser Funktion beispielsweise den zukünftigen Wert (= Endwert) 

eines Kredits ausrechnen. 

Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode) 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 

Rmz = Annuität (Betrag, der pro Periode gezahlt wird) 
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Bw (optional) = Barwert. Wenn Sie das Argument Bw nicht angeben, wird es auf 

Null gesetzt. 

Fälligkeit (optional) = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 

Beispiel: 

ZW(6,5%/12; 10; -1000) ergibt 10.247,30 

Siehe auch: 

BW, KAPZ, RMZ, ZINS, ZINSZ, ZW2, ZZR 

ZW2 (Zukünftiger Wert) 

Syntax: 

ZW2(Bw; Zinsen) 

Beschreibung: 

Liefert den zukünftigen Wert einer Investition für eine Reihe unterschiedlicher 

periodischer Zinssätze. 

Es werden keine regelmäßigen Zahlungen geleistet; es gibt also nur eine einzige 

Einzahlung am Beginn der Laufzeit. 

Sie können mit dieser Funktion beispielsweise den zukünftigen Wert (= Endwert) 

eines Kredits ausrechnen. 

Die Funktion erwartet folgende Argumente: 

Bw = Barwert (der anfängliche Betrag) 

Zinsen = Zellbezug auf einen Tabellenbereich, in dem die unterschiedlichen Zinss-

ätze pro Periode enthalten sind (in entsprechender Reihenfolge, also beispielsweise 

erst der Zinssatz für das erste Jahr, dann der für das zweite Jahr etc.). 
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Beispiel: 

Für eine Einlage von € 10.000,- erhalten Sie im ersten Jahr 5% Zinsen, im zweiten 

5,2%, im dritten 5,5%, im vierten 5,9%. Um den zukünftigen Wert dieser Investiti-

on zu berechnen, tragen Sie diese vier Zinssätze (in der korrekten Reihenfolge) 

beispielsweise in die Zellen A1 bis A4 ein und wenden dann die folgende Formel 

an: 

ZW2(10000; A1:A4) ergibt 12.341 Euro 

Die unterschiedlichen Zinssätze können auch direkt in folgender Form angegeben 

werden: 

ZW2(10000; {5%; 5,2%; 5,5%; 5,9%}) 

Siehe auch: 

ZW 

ZWEIFAKULTÄT (Zweierfakultät) 

Syntax: 

ZWEIFAKULTÄT(Zahl) 

Beschreibung: 

Liefert die Zweierfakultät einer Zahl. 

Die Zweierfakultät wird wie folgt gebildet: 

Ist Zahl gerade, wird das Produkt aller geraden positiven Zahlen von 2 bis Zahl 

berechnet (also 2*4*6*...*Zahl). 

Ist Zahl ungerade, wird das Produkt aller ungeraden positiven Zahlen von 1 bis 

Zahl berechnet (also 1*3*5*...*Zahl). 

Die übergebene Zahl muss positiv sein. Nachkommastellen werden automatisch 

abgeschnitten. 
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Beispiel: 

ZWEIFAKULTÄT(8) entspricht 2*4*6*8, ergibt also 384 

ZWEIFAKULTÄT(9) entspricht 1*3*5*7*9, ergibt also 945 

Siehe auch: 

FAKULTÄT 

ZZR (Zinszeitraum) 

Syntax: 

ZZR(Zins; Rmz; Bw [; Zw] [; Fälligkeit]) 

Beschreibung: 

Ermittelt die Zahl der Zahlungszeiträume (Perioden), basierend auf einer Investiti-

on mit regelmäßigen konstanten Zahlungen und feststehendem Zins. 

Sie können mit dieser Funktion beispielsweise berechnen, wie viele regelmäßige 

Zahlungen (Annuitäten) bei einem Kredit erfolgen müssen. 

„Periode“ bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen 

Rückzahlungen ist die dritte Periode beispielsweise der dritte Monat. 

Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode) 

Rmz = Annuität (Betrag, der pro Periode gezahlt wird) 

Bw = Barwert (der anfängliche Betrag) 

Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zah-

lung erreichen möchten. Wenn Sie das Argument Zw nicht angeben, wird es auf 

Null gesetzt. 

Fälligkeit (optional) = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 
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Siehe auch: 

BW, KAPZ, RMZ, ZINS, ZINSZ, ZW 
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Tastenbelegung 

Auf den nächsten Seiten finden Sie Tabellen mit den wichtigsten Tastenkürzeln 

von PlanMaker: 

 Tastenkürzel zum Editieren von Tabellen 

 Tastenkürzel für Menübefehle 

Tipp: Über den Befehl Weiteres > Anpassen > Tastaturbelegung können Sie 

die Tastenbelegung von PlanMaker jederzeit ändern (siehe Abschnitt 

„Tastenkürzel anpassen“ ab Seite 423). 

Tastenkürzel zum Editieren von Tabellen 

Befehl   Tastenkürzel 

Zur nächsten Zelle            (æ)/(Æ)/(½)/(¼) 

Zur nächsten ausgefüllten Zelle  (Strg) + 
(æ)/(Æ)/(½)/(¼) 

Eine Bildschirmseite nach oben  (Bild½) 

Eine Bildschirmseite nach unten  (Bild¼) 

Zur ersten Zelle der aktuellen Spalte  (Strg)(Bild½) 

Zur letzten Zelle der aktuellen Spalte  (Strg)(Bild¼) 

Zur ersten Zelle der aktuellen Zeile  (Pos1) 

Zur letzten ausgefüllten Zelle der aktuellen Zeile  (Ende) 

Zur ersten Zelle der Tabelle (Zelle A1)  (Strg)(Pos1) 

Zur letzten ausgefüllten Zelle der Tabelle  (Strg)(Ende) 

Zum vorherigen Arbeitsblatt  (Strg)(ª)(Tab) 

Zum nächsten Arbeitsblatt  (Strg)(Tab) 

Zur nächsten zirkulären Verknüpfung   (ª)(F5) 

Zelle über der aktuellen Zelle kopieren  (Strg)(,) (Komma) 
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Befehl   Tastenkürzel 

Wert aus Zelle über der aktuellen Zelle kopieren  (Strg)(ª)(,) (Komma) 

Matrixformel eingeben  (Strg)(ª)(¢) 

Matrixformel selektieren  (Strg)(7) 

Bedingtes Format selektieren  (Strg)(6) 

Auswahlliste mit den Zellinhalten direkt  

oberhalb oder unterhalb der Zelle öffnen 

 (Alt)(ª)(¼) 

Umschalten zwischen den Eingabemodi AUTO und TEXT 

(siehe Abschnitt „Statuszeile“, Seite 31) 

 (Strg)(ª)(F4) 

Hexadezimalen Zeichencode in Unicode-Zeichen wandeln*  (Strg)(Alt)(ª)(X) 

* Tippen Sie beispielsweise 20AC ein und betätigen dann diese Tastenkombination, erscheint ein Euro-
zeichen (da dieses Zeichen im Unicode-Zeichensatz den Code 20AC hat). 

Tastenkürzel für Menübefehle 

Befehl   Tastenkürzel 

Datei > Neu            (Strg)(N) 

Datei > Öffnen  (Strg)(O) 

Datei > Schließen  (Strg)(W) oder (Strg)(F4) 

Datei > Speichern  (Strg)(S) 

Datei > Dateimanager  (F12) 

Datei > Drucken  (Strg)(P) 

Datei > Beenden  (Strg)(Q) oder (Alt)(F4) 

   

Bearbeiten > Rückgängig  (Strg)(Z) 

Bearbeiten > Wiederherstellen  (Strg)(Y) 

Bearbeiten > Wiederholen  (Strg)(ª)(Y) 

Bearbeiten > Ausschneiden  (Strg)(X) 
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Befehl   Tastenkürzel 

Bearbeiten > Kopieren  (Strg)(C) 

Bearbeiten > Einfügen  (Strg)(V) 

Bearbeiten > Inhalte einfügen  (Strg)(ª)(V) 

Bearbeiten > Alles markieren  (Strg)(A) 

Bearbeiten > Suchen  (Strg)(F) 

Bearbeiten > Ersetzen  (Strg)(H) 

Bearbeiten > Suchen wiederholen  (F3) 

Bearbeiten > Gehe zu  (Strg)(G) oder (F5) 

   

Ansicht > Vollbild  (F6) 

   

Format > Zelle  (Strg)(1) 

Zahlenformat: Zahl  (Strg)(ª)(1) 

Zahlenformat: Wissenschaftlich  (Strg)(ª)(2) 

Zahlenformat: Währung  (Strg)(ª)(4) 

Zahlenformat: Prozent  (Strg)(ª)(5) 

Format > Zeichen  (Strg)(2) 

Format > Standard  (Strg)(Leertaste) 

Schriftart in der Formatleiste wählen  (Strg)(D) 

Fettdruck ein-/ausschalten  (Strg)(ª)(F) oder (Strg)(B) 

Kursivschrift ein-/ausschalten  (Strg)(ª)(K) oder (Strg)(I) 

Unterstreichen ein-/ausschalten  (Strg)(ª)(U) 

Hochstellen  (Strg)(ª)(Num+) 

Tiefstellen  (Strg)(ª)(Num-) 

Hoch-/Tiefstellen abschalten  (Strg)(ª)(Num*) 

Ausrichtung: Standard  (Strg)(T) 
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Befehl   Tastenkürzel 

Ausrichtung: Linksbündig  (Strg)(L) 

Ausrichtung: Rechtsbündig  (Strg)(R) 

Ausrichtung: Zentriert  (Strg)(E) 

Ausrichtung: Blocksatz  (Strg)(J) 

   

Einfügen > Funktion  (F7) 

Einfügen > Kommentar  (ª)(F2) 

Aktuelles Datum einfügen  (Strg)(.) 

Aktuelle Uhrzeit einfügen  (Strg)(ª)(.) 

   

Aktuelle Zeile ausblenden  (Strg)(9) 

Aktuelle Zeile einblenden  (Strg)(ª)(9) 

Aktuelle Spalte ausblenden  (Strg)(0) 

Aktuelle Spalte einblenden  (Strg)(ª)(0) 

   

Tabelle > Zellen einfügen  (Strg)(+) 

Tabelle > Zellen löschen  (Strg)(-) 

   

Weiteres > Neu berechnen  (F9) 

Nur aktuelles Arbeitsblatt neu berechnen  (ª)(F9) 

Weiteres > Diagramme aktualisieren  (F8) 
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Index 

# 
#BEZUG! 448, 449 

#DIV/0! 448, 449 

#FEHLER! 448, 449 

#NAME? 448, 449 

#NV 448, 449, 520, 564, 569, 625 

#WERT! 448, 449 

#ZAHL! 448, 449 

$ 
$-Zeichen 442, 443 

% 
%-Zeichen 438, 439 

3 
3D-Ansicht 

bei Diagrammen 290 

3D-Effekt 

bei Objekten 226 

A 
ABRUNDEN (Abrunden auf n Stellen) 455 

Abrunden auf ein Vielfaches von n 
(UNTERGRENZE) 703 

ABS (Absolutbetrag) 456 

Absatz (Menü Format) 169, 170, 172, 173, 
318 

Abschreibung 
arithmetisch-degressiv (DIA) 512 

geometrisch-degressiv (GDA) 531 

geometrisch-degressiv (GDA2) 532 
linear (LIA) 593 

Absolutbetrag (ABS) 456 

Absolute Zellbezüge 442, 443 

Abstand zur Blattkante 194, 195 

Achsen (in Diagrammen) 278, 280, 282 

ACHSENABSCHNITT (Achsenabschnitt 

einer Regressionsgeraden) 457 

Addition 438, 439 

ADRESSE (Zelladresse als Text ausgeben) 
458 

Aktualisieren 57, 59, 112 

Aktualisierungen suchen 396, 397 

Alle schließen (Menü Fenster) 378 

Alles markieren (Menü Bearbeiten) 64, 66 

Alles speichern (Menü Datei) 40 

Als PDF-Dokument exportieren (Menü Datei) 
348 

Analysieren von Tabellen 102 

Änderungsdatum 198, 201 

Annuität 651, Siehe RMZ (Regelmäßige 

Zahlung) 

Anpassen (Menü Weiteres) 

Symbolleisten 419, 421 
Tastaturbelegung 423 

Ansicht > Beobachtungsfenster 105 

Ansicht > Fixieren 131 

Ansicht > Formelanzeige 103 

Ansicht > Objektmodus 215 

Ansicht > Originalgröße 412 

Ansicht > Symbolleisten 414 

Ansicht > Syntaxhervorhebung 103 

Ansicht > Vergrößerungsstufe 412 

Ansicht > Vollbild 413 

Ansicht > Zeilen- & Spaltenköpfe 410, 411 

ANSI-Code eines Zeichens (CODE) 491 

Antialiasing 389, 391 

ANZAHL (Wie viele Zellen mit Zahlen 
ausgefüllt?) 459 

ANZAHL2 (Wie viele Zellen ausgefüllt?) 460 

ANZAHLLEEREZELLEN (Wie viele Zellen 
leer?) 461 

ANZAHLP (PlanMaker 97-

Kompatibilitätsfunktion) 462 

Arabische Schriftzeichen 371, 385, 386 

Arbeitsblatt 83, 84 

Ausblenden 86, 87 
Eigenschaften ändern 86, 87, 410 

Einblenden 86 

Einfügen 84 
Kopieren 86 

Löschen 86 

Umbenennen 86 
Verschieben 86 

Arbeitsblattregister 85, 404, 406 

Arbeitsmappe 83, 84 

Arbeitsmappenschutz (Menü Weiteres) 359 

ARBEITSTAG (Datum nach x Arbeitstagen) 
463 
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Arbeitstage zählen (NETTOARBEITSTAGE) 

620 

ARCCOS (Arcuscosinus) 464 

ARCCOSHYP (Arcuscosinus Hyperbolicus) 

464 

ARCCOT (Arcuscotangens) 465 

ARCCOTHYP (Arcuscotangens 
Hyperbolicus) 466 

ARCSIN (Arcussinus) 467 

ARCSINHYP (Arcussinus Hyperbolicus) 468 

ARCTAN (Arcustangens) 468 

ARCTAN2 (Arcustangens) 469 

ARCTANHYP (Arcustangens Hyperbolicus) 
470 

Arcuscosinus (ARCCOS) 464 

Arcuscosinus Hyperbolicus (ARCCOSHYP) 
464 

Arcuscotangens (ARCCOT) 465 

Arcuscotangens Hyperbolicus 

(ARCCOTHYP) 466 

Arcussinus (ARCSIN) 467 

Arcussinus Hyperbolicus (ARCSINHYP) 468 

Arcustangens 
ARCTAN 468 

ARCTAN2 469 

Arcustangens Hyperbolicus (ARCTANHYP) 
470 

Asiatische Schriftzeichen 385 

AUFRUNDEN (Aufrunden auf n Stellen) 470 

Aufrunden auf ein Vielfaches von n 

(OBERGRENZE) 626 

Ausblenden von Zellen 

manuell 141 

mittels einer Gliederung 333 

Ausfüllen (Menü Bearbeiten) 78, 79 

Ausfüllen von Zellen (automatisch) 78 

Ausrichten oder verteilen (Menü Objekt) 219 

Ausrichtung 
bei Textrahmen 234, 235 

der Druckseiten 194, 195 

von Zellinhalten 160, 161 

Ausschneiden (Menü Bearbeiten) 72 

AUSWAHL (Ist x>0, x=0 oder x<0?) 471 

Auswahlliste (Formularobjekt) 303 

Auto-Eingabemodus 31, 32 

Autofilter 101 

AutoFormat (Menü Format) 184 

AutoFormen 

Eigenschaften ändern 252 

Text hinzufügen 251 

Zeichnen 248, 251 

Automatisch berechnen 407 

Automatische Prozentwerteingabe 387 

Automatisches Sichern 394, 395 

B 
B (PlanMaker 97-Kompatibilitätsfunktion) 

472 

BAK-Dateien anlegen 394, 395 

Balkendiagramm 259, 260 

Barwert (BW) 488 

BasicMaker 375 

Bearbeiten > Alles markieren 64, 66 

Bearbeiten > Ausfüllen 78, 79 

Bearbeiten > Ausschneiden 72 

Bearbeiten > Duplizieren 219 

Bearbeiten > Einfügen 72 

Bearbeiten > Ersetzen 206, 207 

Bearbeiten > Ersetzen wiederholen 207 

Bearbeiten > Gehe zu 210 

Bearbeiten > Gehe zur Verknüpfung 339, 341 

Bearbeiten > Inhalte einfügen 74 

Bearbeiten > Kopieren 72 

Bearbeiten > Löschen 36, 67 

Bearbeiten > Rückgängig 36, 63 

Bearbeiten > Selektiv löschen 67, 68 

Bearbeiten > Suchen 205, 207 

Bearbeiten > Suchen wiederholen 207 

Bearbeiten > Verknüpfungen 244 

Bearbeiten > Wiederherstellen 36, 63 

Bearbeiten > Wiederholen 64 

Bearbeitungsleiste 29 

Bedingte Formatierung (Menü Format) 185 

Bedingung 
AUSWAHL 471 

WENN 722 

Beenden (Menü Datei) 41 

Beim Speichern nach Dokumentinfo fragen 
394, 395 

Benutzer Firma 385 

Benutzer privat 385 

Benutzerdaten ausgeben (BENUTZERFELD) 

473 
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Benutzerdefinierte Zahlenformate 144, 147, 

149 

BENUTZERFELD (Benutzerdaten ausgeben) 
473 

Benutzerwörterbücher 317 

Beobachtungsfenster (Menü Ansicht) 105 

BEREICH.VERSCHIEBEN (Versetzter 
Zellbezug) 475 

BEREICHE (Zahl der Bereiche) 475 

Bereiche benennen 88, Siehe Namen 

Beschnitt (von Grafiken) 238, 240 

Bessel 477, 478 

BESSELI (Modifizierte Besselfunktion erster 
Art) 477 

BESSELJ (Besselfunktion erster Art) 477 

BESSELK (Modifizierte Besselfunktion 
zweiter Art) 478 

BESSELY (Besselfunktion zweiter Art) 478 

Bestimmtheitskoeffizient 

(BESTIMMTHEITSMASS) 479 

BESTIMMTHEITSMASS 

(Bestimmtheitskoeffizient) 479 

BETAINV (Quantile einer Betaverteilung) 

480 

BETAVERT (Betaverteilung) 481 

Betaverteilung 
BETAINV 480 

BETAVERT 481 

Bildlaufleiste (Formularobjekt) 309 

Bildlaufleiste ein-/ausschalten 404, 406 

Bildschirmschriftarten glätten 389, 391 

Binärzahl in Dezimalzahl wandeln 

(BININDEZ) 481 

Binärzahl in Hexadezimalzahl wandeln 

(BININHEX) 482 

Binärzahl in Oktalzahl wandeln (BININOKT) 

483 

BININDEZ (Binärzahl in Dezimalzahl 

wandeln) 481 

BININHEX (Binärzahl in Hexadezimalzahl 

wandeln) 482 

BININOKT (Binärzahl in Oktalzahl wandeln) 

483 

Binomialverteilung 

BINOMVERT 484 
KRITBINOM 585 

NEGBINOMVERT 619 

BINOMVERT (Binomialverteilung) 484 

Blasendiagramm 259, 261 

Blatt (Menü Tabelle) 84, 86 

BLATTNAME (Name eines Tabellenblatts) 

486 

BLATTNUMMER (Nummer eines 

Arbeitsblatts) 486 

Blattschutz 355 

Blattschutz (Menü Weiteres) 355, 357 

Blattschutz aufheben (Menü Weiteres) 358 

Blocksatz, vertikaler 234, 236 

Bodenfläche (in Diagrammen) 270 

BOGENMASS (Grad in Bogenmaß 
umwandeln) 487 

Bogenmaß in Grad umwandeln (GRAD) 537 

Börsendiagramm 259, 262 

Boxplot-Diagramm 259, 264 

Box-Whisker-Plot 259, 264 

Breite einer Spalte ändern 139 

Bruch (Zahlenformat) 144, 146 

Buchhaltung (Zahlenformat) 144, 145 

BW (Barwert) 488 

C 
CHIINV (Quantile einer Chi-Quadrat-

Verteilung) 489 

Chi-Quadrat-Unabhängigkeitstest (CHITEST) 
490 

Chi-Quadrat-Verteilung 
CHIINV 489 

CHIVERT 490 

CHITEST (Chi-Quadrat-Unabhängigkeitstest) 

490 

CHIVERT (Chi-Quadrat-Verteilung) 490 

CODE (ANSI-Code eines Zeichens) 491 

COS (Cosinus) 491 

COSHYP (Cosinus Hyperbolicus) 492 

Cosinus (COS) 491 

Cosinus Hyperbolicus (COSHYP) 492 

COT (Cotangens) 493 

Cotangens (COT) 493 

Cotangens Hyperbolicus (COTHYP) 493 

COTHYP (Cotangens Hyperbolicus) 493 

CSV-Dateiformat 365 

D 
DATEDIF (Datumsdifferenz) 494 

Datei > Alles speichern 40 
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Datei > Als PDF-Dokument exportieren 348 

Datei > Beenden 41 

Datei > Dateimanager 328 

Datei > Druckbereich 
Druckbereich entfernen 196 

Druckbereich festlegen 196 

Datei > Drucken 345 

Datei > Druckvorschau 343 

Datei > Eigenschaften 400 

Karteikarte Berechnen 407 
Karteikarte Farben 400 

Karteikarte Infos 327, 400 

Karteikarte Internet 402 
Karteikarte Optionen 404 

Karteikarte Schriften 410 
Karteikarte Schutz 360, 410 

Karteikarte Statistik 404 

Datei > Holen 238 

Datei > Neu 37, 181, 182 

Datei > Öffnen 37, 183, 363, 364 

Datei > Quelle wählen 238 

Datei > Schließen 378 

Datei > Seite einrichten 194, 196, 198 

Datei > Speichern 40 

Datei > Speichern unter 40, 363, 364 

Datei > Versenden 353 

Dateierweiterungen verknüpfen 396, 397 

Dateiformat 363, 364 

Dateiformate 363 

Dateimanager (Menü Datei) 328 

DATEINAME (Dateiname des Dokuments) 
495 

Dateityp 363, 364 

Daten in Zellen eingeben 60 

Daten konsolidieren (Menü Tabelle) 121, 123, 
126, 130 

Datenbankfunktionen 453, 497, 498, 499, 
500, 501, 502, 503, 504, 505, 506 

Datenbereich (von Diagrammen) 287, 288 

Datenpunkte (in Diagrammen) 272 

Datenquelle (von Diagrammen) 287, 288 

Datenreihen (in Diagrammen) 272, 287, 288 

Datum 
aktuelles (HEUTE) 541 

aktuelles, mit Uhrzeit (JETZT) 574 

Datumswert bilden (DATUM) 496 
Eingeben 60, 61 

DATUM (Datumswert bilden) 496 

Datum des Erstellens eines Dokuments 

(ERSTELLDATUM) 515 

Datum in/vor n Monaten (EDATUM) 513 

Datum/Zeit (Zahlenformat) 144, 145 

Datumsdifferenz (DATEDIF) 494 

DATWERT (Text in Datum wandeln) 497 

DBANZAHL (Datenbankfunktion) 497, 498 

dBase-Dateiformat 363, 365 

DBAUSZUG (Datenbankfunktion) 499 

DBMAX (Datenbankfunktion) 500 

DBMIN (Datenbankfunktion) 501 

DBMITTELWERT (Datenbankfunktion) 501 

DBPRODUKT (Datenbankfunktion) 502 

DBSTDABW (Datenbankfunktion) 503 

DBSTDABWN (Datenbankfunktion) 504 

DBSUMME (Datenbankfunktion) 504 

DBVARIANZ (Datenbankfunktion) 505 

DBVARIANZEN (Datenbankfunktion) 506 

DELTA (Prüfen auf Gleichheit zweier Werte) 
507 

Design Science 246, 247 

Determinante einer Matrix (MDET) 599 

DEZIBEL (Dezibelwert zweier Größen) 507 

Dezimaltrenner nach Zahleneingabe 
verschieben 404, 405 

Dezimalzahl in Binärzahl wandeln 
(DEZINBIN) 508 

Dezimalzahl in Hexadezimalzahl wandeln 
(DEZINHEX) 509 

Dezimalzahl in Oktalzahl wandeln 
(DEZINOKT) 510 

DEZINBIN (Dezimalzahl in Binärzahl 

wandeln) 508 

DEZINHEX (Dezimalzahl in 
Hexadezimalzahl wandeln) 509 

DEZINOKT (Dezimalzahl in Oktalzahl 
wandeln) 510 

DIA (Arithmetisch-degressive Abschreibung) 
512 

Diagramm (Menü Objekt) 
Als Grafik speichern 293 

Daten in Spalten 265 

Daten in Zeilen 265 
Horizontale Gitternetzlinien anzeigen 283, 

284 

Position des Diagramms ändern 292 
Trendlinie hinzufügen 276 

Vertikale Gitternetzlinien anzeigen 283, 284 
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Diagramme 257 

Aktualisieren 292 

als Grafik speichern 293 

Anordnung der Datenreihen ändern 265, 
287 

Bearbeiten 258 

Diagrammeigenschaften ändern 286 
Diagrammelemente bearbeiten 265 

Diagrammtyp ändern 259, 260 

Einfügen 258 
Position ändern 292 

Diagramme aktualisieren (Menü Weiteres) 
292, 407, 409 

Diagrammelemente 265 

Diagrammfläche (in Diagrammen) 268 

Diagrammleiste 258, 259 

Diagrammtitel 289 

Dialogsprache 389, 390 

Dialogstil 389 

Division 438, 439 

Dokumente in neuen Fenstern öffnen 394, 396 

Dokumenteigenschaften 400 

Karteikarte Berechnen 407 

Karteikarte Farben 400 

Karteikarte Infos 400 

Karteikarte Internet 402 
Karteikarte Optionen 404 

Karteikarte Schriften 410 

Karteikarte Schutz 410 
Karteikarte Statistik 404 

Dokumentfenster 30, 377 

Dokumentinfos 327 

Dokumentschutz 360 

Dokumentstatistik 404 

Dokumentvorlagen 181, 182, 183 

Drag and Drop 72, 73 

Drehen 
Achsenbeschriftungen 278, 280, 282, 283 

Objekte 218, 220, 221 

Text in AutoFormen 254 
Text in Textrahmen 234, 235 

Zellinhalte 160, 161 

Drehen oder Kippen (Menü Objekt) 218, 219 

Drehfeld (Formularobjekt) 308 

Dreidimensionale Berechnungen 51, 88 

Druckbereich 196 

Druckbereich (Menü Datei) 
Druckbereich entfernen 196 

Druckbereich festlegen 196 

Druckdatum 198, 201 

Drucken (Menü Datei) 345 

Druckrichtung 196, 197 

Druckvorschau (Menü Datei) 343 

Druckzeit 198, 201 

Duplizieren (Menü Bearbeiten) 219 

Durchstreichen 165 

E 
Ecken (in Diagrammen) 271 

EDATUM (Datum in/vor n Monaten) 513 

Editiermodus 215 

Effekte (bei Objekten) 227 

EFFEKTIV (Effektivzins) 513 

Effektivzins (EFFEKTIV) 513 

Eigenschaften (Menü Datei) 400 
Karteikarte Berechnen 407 

Karteikarte Farben 400 

Karteikarte Infos 327, 400 
Karteikarte Internet 402 

Karteikarte Optionen 404 

Karteikarte Schriften 410 
Karteikarte Schutz 360, 410 

Karteikarte Statistik 404 

Eigenschaften (Menü Objekt) 
Allgemeine Eigenschaften 220 

Bei Auswahllisten 304 
Bei Bezeichnungen 311 

Bei Bildlaufleisten 309 

Bei Diagrammen 259, 260, 286 
Bei Drehfeldern 308 

Bei Grafiken 238 

Bei Gruppenfeldern 311 
Bei Kontrollkästchen 300 

Bei Listen 305 

Bei OLE-Objekten 245 
Bei Optionsfeldern 302 

Bei Schaltflächen 307 

Bei Textrahmen 234 
Bei Zeichnungen 252 

Standardeinstellungen ändern 229 

Eigenschaften (Menü Tabelle) 86, 87, 410 

Einblenden von Zellen 141 

Einfügen 
Spalten 71 

Zeilen 71 

Zellen 71 

Einfügen (Menü Bearbeiten) 72 

Einfügen > Funktion 440, 441 

Einfügen > Kommentar 113 

Einfügen > Kopf- und Fußzeile 198, 199 
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Einfügen > Seitenumbruch 202 

Einfügen > Sonderzeichen 133, 134 

Einfügen > Textbaustein 321, 322, 323 

Einstellungen 383 

Einstellungen (Menü Weiteres) 384 

Karteikarte Allgemein 385 
Karteikarte Ansicht 384 

Karteikarte Aussehen 389 

Karteikarte Bearbeiten 387 
Karteikarte Dateien 394 

Karteikarte Schriften 399 

Karteikarte Sprache 392 
Karteikarte System 396 

Einzüge 170 

Ellipsen 
Eigenschaften ändern 252 

Zeichnen 248, 250 

E-Mail 353 

Endergebnis runden 407, 409 

Entfernen (Menü Tabelle) 

Doppelte Zeilen 70 
Leere Zeilen 70 

Ersetzen (Menü Bearbeiten) 206, 207 

ERSETZEN (Text in Zeichenkette ersetzen) 

514 

Ersetzen wiederholen (Menü Bearbeiten) 207 

Erstelldatum 198, 201 

ERSTELLDATUM (Datum des Erstellens 
eines Dokuments) 515 

Erweiterte Unterstützung für arabischen Text 
371, 385, 386 

Erweiterte Unterstützung für asiatische 
Schriften 385 

EUROCONVERT (Euro-Währungen 

konvertieren) 516 

Euro-Währungen konvertieren 
(EUROCONVERT) 516 

Excel-Dateiformat 299, 363, 364, 367, 368, 
369 

EXP (e hoch x) 517 

Exponentialverteilung (EXPONVERT) 518 

Exponentielle Regression 
Kenngrößen (RKP) 649 

Werte (VARIATION) 707 

EXPONVERT (Exponentialverteilung) 518 

Export (eines Fremdformats) 363 

Externe Bezüge (Menü Tabelle) 446 

Externe Zellbezüge 444 

F 
FAKULTÄT (Fakultät) 519 

FALSCH (Wahrheitswert) 519 

Farbe 

von Objekten 221 
von Text 166 

von Zellen 157 

Farbpalette bearbeiten 400 

Farbverlauf (bei Objekten) 221, 223 

FEHLER.TYP (Fehlerwerte abfragen) 520 

Fehlerindikator (in Diagrammen) 272, 274 

Fehlerwerte 110, 448 

Fehlerwerte abfragen (FEHLER.TYP) 520 

FEIERTAG (Datum von beweglichen 
Feiertagen) 521 

Felder (für Kopf-/Fußzeilen) 198, 200 

Fenster > Alle schließen 378 

Fenster > Nebeneinander 379 

Fenster > Registerkarten 380 

Fenster > Überlappend 379 

Fenster > Untereinander 379 

FEST (Zahl mit festen Nachkommastellen 

formatieren) 522 

Fett 165 

Filter 98, 692 

Filter (Menü Tabelle) 

Alles anzeigen 98, 101, 102 
Autofilter 101 

Spezialfilter 98 

FINDEN (Text in Zeichenkette suchen) 523 

FINV (Quantile einer F-Verteilung) 524 

FISHER (Fisher-Transformation) 525 

FISHERINV (Umkehrung der Fisher-
Transformation) 525 

Fixieren (Menü Ansicht) 131 

Flächendiagramm 259, 260 

Format > Absatz 169, 170, 172, 173, 318 

Format > AutoFormat 184 

Format > Bedingte Formatierung 185 

Format > Format übertragen 193 

Format > Gültigkeitsprüfung 111, 186, 187 

Format > Schattierung 157 

Format > Standard 169 

Format > Umrandung 155 

Format > Verknüpfung 339 

Format > Verknüpfung entfernen 339, 341 
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Format > Zeichen 163, 164, 165, 166, 167, 

168 

Format > Zeichenvorlage 173, 174, 175, 176 

Format > Zelle 

Karteikarte Ausrichtung 160 
Karteikarte Schattierung 157 

Karteikarte Schutz 356 

Karteikarte Umrandung 155 
Karteikarte Zahlenformat 142, 144, 147 

Format > Zellenvorlage 178, 179, 180, 181 

Format übertragen (Menü Format) 193 

Formatleiste 29, 164, 165, 166 

Formelanzeige (Menü Ansicht) 103 

Formeleditor 246 

Formelüberwachung (Menü Weiteres) 106, 

108, 109, 110, 111 

Formelüberwachungsleiste 106, 107 

Formulare 295 

Formularleiste 297 

Fraktil 639, Siehe QUANTIL 

Freihandformen 
Eigenschaften ändern 252 

Zeichnen 248, 249 

Fremdformate 363 

F-Test (FTEST) 526 

FTEST (F-Test) 526 

Füllung 

von Objekten 221 
von Zellen 157 

Funktion (Menü Einfügen) 440, 441 

Funktionen 

Beschreibungen aller Funktionen 455 
einfügen 440, 441 

Funktionsleiste 28 

Fußzeile 198 

FVERT (F-Verteilung) 527 

F-Verteilung 
FINV 524 

FVERT 527 

G 
Gammafunktion (GAMMALN) 528 

GAMMAINV (Quantile einer 
Gammaverteilung) 527 

GAMMALN (Logarithmus der 
Gammafunktion) 528 

GAMMAVERT (Gammaverteilung) 528 

Gammaverteilung 

GAMMAINV 527 

GAMMAVERT 528 

GANZZAHL (Runden auf ganze Zahl) 529 

GAUSS (PlanMaker 97-

Kompatibilitätsfunktion) 530 

GAUSSFEHLER (Gaußsche Fehlerfunktion) 

530 

GAUSSFKOMPL (Komplement zur 

Gaußschen Fehlerfunktion) 531 

Gaußsche Fehlerfunktion 

GAUSSFEHLER 530 
GAUSSFKOMPL 531 

Gauß-Test (GTEST) 539 

Gauß-Verteilung (NORMVERT) 623 

GDA (Geometrisch-degressive Abschreibung) 

531 

GDA2 (Geometrisch-degressive 

Abschreibung) 532 

Gehe zu (Menü Bearbeiten) 210 

Gehe zur Verknüpfung (Menü Bearbeiten) 
339, 341 

Geometrisches Mittel (GEOMITTEL) 533 

GEOMITTEL (Geometrisches Mittel) 533 

GERADE (Aufrunden auf eine gerade Zahl) 

534 

GESTUTZTMITTEL (Mittelwert ohne 

Randwerte) 534 

GGANZZAHL (Zahl größer gleich 

Schwellenwert?) 535 

GGT (Größter gemeinsamer Teiler) 536 

Gipfligkeit einer Verteilung (KURT) 589 

Gitternetzlinien 
in Diagrammen 283 

zwischen Tabellenzellen 410, 411 

GLÄTTEN (Überflüssige Leerzeichen 
entfernen) 537 

Gleichheit zweier Werte (DELTA) 507 

Gliederung (Menü Tabelle) 
Gliederung entfernen 335, 336 

Gliederungsfeld automatisch einblenden 

337, 338 
Gruppieren 335 

Gruppierung aufheben 335, 336 

Optionen 337 

Gliederungen 333 

Ein- und Ausblenden von gruppierten 
Zellen 335, 337 

Einstellungen ändern 337 

Gliederungsansicht schützen 337, 338 

Gliederungsfeld 333, 337, 338 
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Gliederungsleiste 333, 335 

GRAD (Bogenmaß in Grad umwandeln) 537 

Grad in Bogenmaß umwandeln 
(BOGENMASS) 487 

Grafiken 236 
Eigenschaften ändern 238 

Einfügen 236 
Einscannen 238 

Grafiken im Speicher komprimieren 396 

GROSS (In Großbuchstaben wandeln) 538 

GROSS2 (In Groß-/Kleinbuchstaben 
wandeln) 538 

Großbuchstaben 165 

Großbuchstaben, wandeln in (GROSS) 538 

Großbuchstaben, wandeln in (GROSS2) 538 

Größe 

von Objekten 217 
von Zellen 139 

Große Symbole verwenden 389, 390 

Größenachse (in Diagrammen) 280 

Größter gemeinsamer Teiler (GGT) 536 

Grundlagen 33 

Gruppieren 

von Objekten 232 

Gruppieren (Menü Objekt) 232 

Gruppierung aufheben (Menü Objekt) 232 

GTEST (Gauß-Test) 539 

Gültigkeitsprüfung 186 

Gültigkeitsprüfung (Menü Format) 111, 186, 
187 

H 
Handbuch 23 

HARMITTEL (Harmonisches Mittel) 540 

Harmonisches Mittel (HARMITTEL) 540 

HÄUFIGKEIT (Häufigkeitsverteilung) 540 

Häufigkeitsverteilung (HÄUFIGKEIT) 540 

HEUTE (Aktuelles Datum) 541 

Hexadezimalzahl in Binärzahl wandeln 
(HEXINBIN) 542 

Hexadezimalzahl in Dezimalzahl wandeln 
(HEXINDEZ) 543 

Hexadezimalzahl in Oktalzahl wandeln 

(HEXINOKT) 544 

HEXINBIN (Hexadezimalzahl in Binärzahl 
wandeln) 542 

HEXINDEZ (Hexadezimalzahl in 
Dezimalzahl wandeln) 543 

HEXINOKT (Hexadezimalzahl in Oktalzahl 

wandeln) 544 

Hintergrundbild 402, 403 

Hintergrundfarbe 

des Dokuments 402, 403 
des Programms 389, 391 

von Text 166 

von Zellen 157 

Hochformat 194, 195 

Hochstellen 167 

Hoch-Tief-Diagramm 259, 262 

Höhe einer Zeile ändern 139 

Holen (Menü Datei) 238 

Horizontale Ausrichtung 
von Zellinhalten 160 

Horizontale Gitternetzlinien anzeigen 283, 
284 

HTML-Dokumente 341 

Hunspell-Wörterbücher 392, 393, 431 

Hypergeometrische Verteilung 

(HYPGEOMVERT) 547 

HYPERLINK (Hyperlink) 545 

HYPGEOMVERT (Hypergeometrische 

Verteilung) 547 

I 
IDENTISCH (Zeichenketten identisch?) 548 

IF-Bedingung 722, Siehe WENN 

IKV (Interner Zinsfuß) 549 

Im Dokument ablegen (Grafiken) 236, 237 

IMABS (Absolutbetrag einer komplexen 

Zahl) 550 

IMAGINÄRTEIL (Imaginärteil einer 

komplexen Zahl) 550 

IMAPOTENZ (Potenz einer komplexen Zahl) 

551 

IMARGUMENT (Winkel einer komplexen 

Zahl) 551 

IMCOS (Cosinus einer komplexen Zahl) 552 

IMDIV (Division komplexer Zahlen) 552 

IMEXP (Algebraische Form einer komplexen 
Zahl) 553 

IMKONJUGIERTE (Konjugiert komplexe 
Zahl) 554 

IMLN (Natürlicher Logarithmus einer 
komplexen Zahl) 554 

IMLOG10 (Zehnerlogarithmus einer 
komplexen Zahl) 555 
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IMLOG2 (Zweierlogarithmus einer 

komplexen Zahl) 555 

IMNEG (Negativer Wert einer komplexen 
Zahl) 556 

Import (eines Fremdformats) 363 

IMPRODUKT (Produkt komplexer Zahlen) 

557 

IMREALTEIL (Realteil einer komplexen 

Zahl) 557 

IMSIN (Sinus einer komplexen Zahl) 558 

IMSUB (Differenz komplexer Zahlen) 558 

IMSUMME (Summe komplexer Zahlen) 559 

IMWURZEL (Quadratwurzel einer 
komplexen Zahl) 559 

In den Ordner des Dokuments kopieren 
(Grafiken) 236, 237 

INDEX (Zelle in einem Bereich) 560 

INDIREKT (Bezug aus Zeichenkette bilden) 

561 

Informationen über eine Zelle (ZELLE) 739 

Inhalte einfügen (Menü Bearbeiten) 74 

Innenränder 
von Text in AutoFormen 254 

von Textrahmen 234, 235 

von Zellen 160, 161 

Installation 

Linux 26 
Windows 25 

Internen Grafikcache begrenzen 396 

Interner Zinsfuß 

IKV 549 
QIKV 638 

XINTZINSFUSS 730 

Internet 

Farben einstellen 402 

HTML-Dokumente 341 

Inverse einer Matrix (MINV) 604 

ISOWOCHE (Kalenderwoche nach ISO-
Norm) 562 

ISPMT (Zinszahlung) 563 

ISTBEZUG (Ist ein Zellbezug?) 564 

ISTFEHL (Ist ein Fehlerwert außer #NV?) 

448, 449, 564 

ISTFEHLER (Ist ein Fehler?) 448, 449, 565 

ISTFORMEL (Ist eine Formel?) 566 

ISTGERADE (Ist eine gerade Zahl?) 566 

ISTKTEXT (Ist kein Text?) 567 

ISTLEER (Ist leer?) 568 

ISTLOG (Ist Wahrheitswert?) 568 

ISTNV (Ist nicht vorhanden?) 569 

ISTTEXT (Ist eine Zeichenkette?) 570 

ISTUNGERADE (Ist eine ungerade Zahl?) 
571 

ISTZAHL (Ist eine Zahl?) 572 

ISTZAHLP (PlanMaker 97-
Kompatibilitätsfunktion) 572 

Iterationen 407, 409 

J 
JAHR (Jahr aus einem Datumswert ermitteln) 

574 

JETZT (Aktuelles Datum, aktuelle Uhrzeit) 

574 

K 
Kalenderwoche 

ISOWOCHE 562 
KALENDERWOCHE 575 

KALENDERWOCHE (Kalenderwoche) 575 

Kantenglättung von Grafiken 396, 397 

Kapitälchen 165 

Kapitalrückzahlung (KAPZ) 576 

Kapitalrückzahlung, kumuliert 

(KUMKAPITAL) 586 

Kapitalwert 

NBW 617 
XKAPITALWERT 731 

KAPZ (Kapitalrückzahlung) 576 

Kegeldiagramm 259, 262 

Kenngrößen einer Regression 
RGP (linear) 646 

RKP (exponentiell) 649 

Kerning 168 

KGRÖSSTE (k-größter Wert) 577 

KGV (Kleinstes gemeinsames Vielfaches) 578 

KKLEINSTE (k-kleinster Wert) 579 

KLEIN (In Kleinbuchstaben wandeln) 580 

Kleinbuchstaben, wandeln in (KLEIN) 580 

Kleinstes gemeinsames Vielfaches (KGV) 578 

KOMBINATIONEN 580 

Kommentar (Menü Einfügen) 113 

Kommentare immer anzeigen 404, 405 

KOMPLEXE (Komplexe Zahl bilden) 581 

Komplexe Schriftzeichen 385 

Komplexe Zahlen 581 

Absolutbetrag (IMABS) 550 
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Algebraische Form (IMEXP) 553 

Cosinus (IMCOS) 552 

Differenz (IMSUB) 558 

Division (IMDIV) 552 
Imaginärteil (IMAGINÄRTEIL) 550 

KOMPLEXE (Komplexe Zahl bilden) 581 

Konjugierte (IMKONJUGIERTE) 554 
Logarithmus, natürlicher (IMLN ) 554 

Logarithmus, Zehner (IMLOG10 ) 555 

Logarithmus, Zweier (IMLOG2 ) 555 
Negativer Wert (IMNEG) 556 

Potenz (IMAPOTENZ) 551 

Produkt (IMPRODUKT) 557 

Quadratwurzel (IMWURZEL) 559 

Realteil (IMREALTEIL) 557 
Sinus (IMSIN) 558 

Summe (IMSUMME) 559 

Winkel (IMARGUMENT) 551 

KONFIDENZ (Konfidenzintervall) 582 

Konfidenzintervall (KONFIDENZ) 582 

Konsolidieren von Daten 121 

Kontrollkästchen (Formularobjekt) 300 

Kopf- und Fußzeile (Menü Einfügen) 198, 
199 

Kopfzeile 198 

Kopieren (Menü Bearbeiten) 72 

KORREL (Korrelationskoeffizient) 583 

Korrelationskoeffizient 
KORREL 583 

PEARSON 631 

KOVAR (Kovarianz) 584 

Kovarianz (KOVAR) 584 

Kreisdiagramm 259, 262 

Kreise 

Eigenschaften ändern 252 

Zeichnen 248, 250 

KRITBINOM 585 

KUMKAPITAL (Kumulierte 

Kapitalrückzahlungen) 586 

KUMZINSZ (Kumulierte Zinszahlungen) 587 

Kursdiagramm 259, 262 

Kursiv 165 

KURT (Kurtosis einer Verteilung) 589 

Kurtosis einer Verteilung (KURT) 589 

Kurven 
Eigenschaften ändern 252 

Zeichnen 248, 249 

KÜRZEN (Zahl auf n Nachkommastellen 
kürzen) 590 

L 
LÄNGE (Länge einer Zeichenkette) 591 

Laufweite 167 

LAUFZEIT 592 

Leerzeichen entfernen (GLÄTTEN) 537 

Legende (in Diagrammen) 285 

Leuchteffekt (bei Objekten) 227, 228 

LIA (Lineare Abschreibung) 593 

Lineare Regression 
ACHSENABSCHNITT 457 

Kenngrößen (RGP) 646 

SCHÄTZER 654 
Trend in Diagrammen anzeigen 276 

Werte (TREND) 695 

Lineares Gleichungssystem (MSOLVE) 613 

Linien 
Eigenschaften ändern 252 

Zeichnen 248, 249 

zur Umrandung von Objekten 224 

Liniendiagramm 259, 260 

LINKS (Teil einer Zeichenkette) 594 

Links (Verknüpfungen) 

bei Objekten 228, 229 

bei Zellinhalten 339 

Funktion HYPERLINK 545 

Linksbündig 160 

Liste (Formularobjekt) 305 

Listen editieren (Menü Weiteres) 82, 83, 429 

LN (Natürlicher Logarithmus) 594 

LOG (Logarithmus) 595 

LOG10 (Zehnerlogarithmus) 596 

Logarithmische Normalverteilung 

LOGINV 596 

LOGNORMVERT 597 

Logarithmus 
natürlicher (LN) 594 

Zehner (LOG10) 596 

zu beliebiger Basis (LOG) 595 

LOGINV (Quantile einer 
Lognormalverteilung) 596 

LOGNORMVERT (Logarithmische 
Normalverteilung) 597 

Löschen 
Doppelte Zeilen 70 

Leere Zeilen 70 

Zellen 69 
Zellinhalte 67, 68 

Löschen (Menü Bearbeiten) 36, 67 

Lösung eines LGS (MSOLVE) 613 
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M 
Mailen eines Dokuments 353 

Makros 299, 369 

Marken anzeigen 404, 405 

Markieren 
Objekte 214 

Zellen 64 

Markierung nach Eingabe ... bewegen 387 

Maßeinheit 389, 391 

Maßeinheiten umrechnen (UMWANDELN) 
699 

MathType 246, 247 

Matrix 450 

Arbeiten mit Matrizen 450 
MDET (Determinante) 599 

MINV (Inverse) 604 

MMULT (Multiplikation) 610 
MSOLVE (Lösung eines LGS) 613 

MTRANS (Transponieren) 615 

Matrixfunktionen 450, 451 

Mausrad 396, 398 

MAX (Maximalwert) 598 

MAXA (Maximalwert) 598 

Maximal widerrufbare Aktionen 385 

MDET (Determinante einer Matrix) 599 

MEDIAN 600 

Meldung bei fehlerhaften Formeln 387, 388 

Menüleiste 28 

MILLISEKUNDEN (Millisekunden aus 
einem Datumswert ermitteln) 601 

MIN (Minimalwert) 601 

MINA (Minimalwert) 602 

MINUTE (Minute aus einem Datumswert 

ermitteln) 603 

MINV (Inverse einer Matrix) 604 

MITTELABW (Mittlere Abweichung vom 
Mittelwert) 605 

Mittelwert 
Arithmetisch (MITTELWERT) 605 
Arithmetisch (MITTELWERTA) 606 

Ausgewählter Werte 

(MITTELWERTWENN) 607 
Ausgewählter Werte 

(MITTELWERTWENNS) 608 

Geometrisch (GEOMITTEL) 533 
Harmonisch (HARMITTEL) 540 

Ohne Randwerte (GESTUTZTMITTEL) 

534 

MITTELWERT (Arithmetisches Mittel) 605 

MITTELWERTA (Arithmetisches Mittel) 606 

MITTELWERTWENN (Mittelwert 

ausgewählter Werte) 607 

MITTELWERTWENNS (Mittelwert 

ausgewählter Werte) 608 

Mittlere Abweichung vom Mittelwert 

(MITTELABW) 605 

Mittlere quadratische Abweichung vom 

Mittelwert (SUMQUADABW) 683 

MMULT (Multiplikation zweier Matrizen) 

610 

MODALWERT (Häufigster Wert) 611 

Modifizierter interner Zinsfuß (QIKV) 638 

Modulo 644, Siehe REST 

MONAT (Monat aus einem Datumswert 
ermitteln) 612 

MONATSENDE (Monatsende in/vor n 
Monaten) 612 

MSOLVE (Lösung eines linearen 
Gleichungssystems) 613 

MTRANS (Transponieren einer Matrix) 615 

Multinomialkoeffizient (POLYNOMIAL) 634 

Multiplikation 438, 439 

Multiplikation zweier Matrizen (MMULT) 
610 

N 
N (Wert in Zahl umwandeln) 615 

Nach Produktaktualisierungen suchen 396, 
397 

NACHKOMMA (Nachkommastellen einer 
Zahl) 616 

Namen (für Tabellenbereiche) 88 

Namen (Menü Tabelle) 88, 92 
Anwenden 93 

Bearbeiten 89, 90 

Liste einfügen 92 
Übernehmen 91 

NBW (Nettobarwert) 617 

Nebeneinander (Menü Fenster) 379 

NEG (Negativer Wert einer Zahl) 618 

Negative Binomialverteilung 
(NEGBINOMVERT) 619 

Negativer Wert (NEG) 618 

NEGBINOMVERT (Negative 
Binomialverteilung) 619 

NETTOARBEITSTAGE (Zahl der 
Arbeitstage) 620 
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Nettobarwert 

NBW 617 

XKAPITALWERT 731 

Netzdiagramm 259, 261, 291 

Neu (Menü Datei) 37, 181, 182 

Neu berechnen (Menü Weiteres) 112, 407, 

408 

Neuberechnen nur vor dem ... 407 

Neue Zeichnung (Menü Objekt) 248 

Neuer Diagrammrahmen (Menü Objekt) 258 

Neuer Grafikrahmen (Menü Objekt) 236 

Neuer OLE-Objektrahmen (Menü Objekt) 

241, 242, 243 

Neuer Textrahmen (Menü Objekt) 233 

Neues Formularobjekt (Menü Objekt) 297 
Auswahlliste 303 

Bezeichnung 311 
Bildlaufleiste 309 

Drehfeld 308 

Gruppenfeld 311 
Kontrollkästchen 300 

Liste 305 

Optionsfeld 301 

Schaltfläche 307 

Neumannfunktion (BESSELY) 478 

NICHT (Logisches NICHT) 621 

NOMINAL (Nominalverzinsung) 621 

Normal.pmv 183 

Normalverteilung 

NORMINV 622 
NORMVERT 623 

Normalverteilung, logarithmische 
LOGINV 596 

LOGNORMVERT 597 

NORMINV (Quantile einer 
Normalverteilung) 622 

NORMVERT (Normalverteilung) 623 

NOTIERUNGBRU (Geldbetrag in 
Dezimalbruch wandeln) 624 

NOTIERUNGDEZ (Geldbetrag in 
Dezimalzahl wandeln) 624 

Nullwerte anzeigen/verbergen 142, 144, 410, 
411 

NV (Nicht vorhanden) 625 

O 
Oberflächendiagramm 259, 261 

OBERGRENZE (Aufrunden auf ein 
Vielfaches von n) 626 

Objekt > Ausrichten oder verteilen 219 

Objekt > Diagramm 

Als Grafik speichern 293 
Daten in Spalten 265 

Daten in Zeilen 265 

Horizontale Gitternetzlinien anzeigen 283, 
284 

Position des Diagramms ändern 292 

Trendlinie hinzufügen 276 
Vertikale Gitternetzlinien anzeigen 283, 284 

Objekt > Drehen oder Kippen 218, 219 

Objekt > Eigenschaften 

Allgemeine Eigenschaften 220 

Bei Auswahllisten 304 

Bei Bezeichnungen 311 
Bei Bildlaufleisten 309 

Bei Diagrammen 259, 260, 286 

Bei Drehfeldern 308 
Bei Grafiken 238 

Bei Gruppenfeldern 311 

Bei Kontrollkästchen 300 
Bei Listen 305 

Bei OLE-Objekten 245 

Bei Optionsfeldern 302 
Bei Schaltflächen 307 

Bei Textrahmen 234 

Bei Zeichnungen 252 
Standardeinstellungen ändern 229 

Objekt > Gruppieren 232 

Objekt > Gruppierung aufheben 232 

Objekt > Neue Zeichnung 248 

Objekt > Neuer Diagrammrahmen 258 

Objekt > Neuer Grafikrahmen 236 

Objekt > Neuer OLE-Objektrahmen 241, 242, 
243 

Objekt > Neuer Textrahmen 233 

Objekt > Neues Formularobjekt 297 
Auswahlliste 303 

Bezeichnung 311 

Bildlaufleiste 309 
Drehfeld 308 

Gruppenfeld 311 

Kontrollkästchen 300 
Liste 305 

Optionsfeld 301 

Schaltfläche 307 

Objekt > Reihenfolge 231 

Objekte 213 
Ausrichten und verteilen 219 

Duplizieren 219 
Eigenschaften ändern 220 

Einfügen 214 
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Größe ändern 217 

Gruppieren 232 

Position ändern 217 

Reihenfolge ändern 231 
Rotieren 218, 220, 221 

Selektieren 214 

Verbergen 231 
Verteilen 219 

Objektleiste 215 

Objektmodus 215 

Objektmodus (Menü Ansicht) 215 

ODER (Logisches ODER) 627 

Öffnen (Menü Datei) 37, 183, 363, 364 

Oktalzahl in Binärzahl wandeln (OKTINBIN) 

628 

Oktalzahl in Dezimalzahl wandeln 

(OKTINDEZ) 629 

Oktalzahl in Hexadezimalzahl wandeln 

(OKTINHEX) 630 

OKTINBIN (Oktalzahl in Binärzahl wandeln) 

628 

OKTINDEZ (Oktalzahl in Dezimalzahl 

wandeln) 629 

OKTINHEX (Oktalzahl in Hexadezimalzahl 

wandeln) 630 

OLE-Objekte 241 

Bearbeiten 243 
Eigenschaften ändern 245 

Einfügen 241 

Online-Berechnung 387, 389 

Operatoren 438 

Optimale Breite 140 

Optimale Höhe 140 

Optionsfeld (Formularobjekt) 301 

Originalgröße (Menü Ansicht) 412 

P 
Papiergröße 194, 195 

Papierschacht 194, 195 

Papierschächte 194, 195 

Pascal-Verteilung (NEGBINOMVERT) 619 

PDF-Export 348 

PEARSON (Pearsonscher 

Korrelationskoeffizient) 631 

Pfeile 

Zeichnen 248, 250 

PHI (PlanMaker 97-Kompatibilitätsfunktion) 

632 

PI (Kreiszahl Pi) 632 

PlanMaker 2008 363, 365 

PlanMaker 2010 363, 365 

PlanMaker-Tour 43 

POISSON (Poisson-Verteilung) 633 

Poisson-Verteilung (POISSON) 633 

POLYNOMIAL (Multinomialkoeffizient) 634 

Polynomialkoeffizient (POLYNOMIAL) 634 

Position 
von Objekten 217 

Position eines Werts in einem Bereich 

(VERGLEICH) 710 

POTENZ (Potenzierung) 635 

Potenzierung 
Funktion POTENZ 635 

Operator 438, 439 

Potenzreihe (POTENZREIHE) 636 

POTENZREIHE (Potenzreihe) 636 

Primäre Achsen (in Diagrammen) 289, 290 

PRODUKT (Produkt) 637 

Prozent (Zahlenformat) 144, 146 

Prozentzeichen 438, 439 

Pyramidendiagramm 259, 262 

Q 
QIKV (Modifizierter interner Zinsfuß) 638 

QUADRATESUMME (Summe der Quadrate) 

638 

Quadratwurzel (WURZEL) 726 

QUANTIL (Quantile einer Datenmenge) 639 

QUANTILSRANG (Prozentrang eines 
Wertes) 640 

QUARTILE (Quartile einer Datenmenge) 640 

Quelle wählen (Menü Datei) 238 

Querformat 194, 195 

Quickinfos 389, 390 

Quickinfos für Formeln 387, 388 

QUOTIENT (Ganzzahliger Teil einer 
Division) 641 

R 
Rahmen 213, Siehe Objekte 

Ränder 
Innenränder von AutoFormen 254 

Innenränder von Textrahmen 234, 235 

Innenränder von Zellen 160, 161 
Seitenränder 194, 195 
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RANG (Rang eines Wertes in einer 

Wertemenge) 642 

Raster 410, 411 

Rechtecke 

Eigenschaften ändern 252 
Zeichnen 248, 250 

RECHTS (Teil einer Zeichenkette) 643 

Rechtsbündig 160 

Rechtschreibprüfung 313 
Benutzerwörterbücher bearbeiten 317 

Nachträglich 315 
Sprache einstellen 313 

Während des Tippens 316, 392, 393 
Wörterbücher nachinstallieren 431 

Rechtschreibprüfung (Menü Weiteres) 315 

Redo 36, 63 

Regelmäßige Zahlung (RMZ) 651 

Registerkarten (Menü Fenster) 380 

Registerkarten für Dokumente 380, 385, 386 

Regression, exponentielle 
Kenngrößen (RKP) 649 

Werte (VARIATION) 707 

Regression, lineare 

Kenngrößen (RGP) 646 
Werte (TREND) 695 

Reihenachse (in Diagrammen) 282 

Reihenfolge (Menü Objekt) 231 

Reihenfolge (von Objekten) 231 

Relative Zellbezüge 442 

REST (Rest einer Division) 644 

RESTP (Rest einer Division) 645 

RGP (Kenngrößen einer linearen Regression) 
646 

Ringdiagramm 259, 262 

RKP (Kenngrößen einer exponentiellen 

Regression) 649 

RMZ (Regelmäßige Zahlung) 651 

RÖMISCH (Römische Schreibweise einer 
Zahl) 652 

Rotieren 
Achsenbeschriftungen 278, 280, 282, 283 

Objekte 218, 220, 221 
Text in AutoFormen 254 

Text in Textrahmen 234, 235 

Zellinhalte 160, 161 

Rubrikenachse (in Diagrammen) 278 

Rückgängig (Menü Bearbeiten) 36, 63 

Runden 
ABRUNDEN 455 

AUFRUNDEN 470 

FEST 522 

GANZZAHL 529 

GERADE 534 
KÜRZEN 590 

OBERGRENZE 626 

RUNDEN 653 
UNGERADE 702 

UNTERGRENZE 703 

VRUNDEN 716 
Zahlen gerundet anzeigen (per 

Zahlenformat) 142, 143 

RUNDEN (Runden auf n Stellen) 653 

S 
SÄUBERN (Nicht-druckbare Zeichen 

entfernen) 654 

Säulendiagramm 259, 260 

Scannen 238 

Schaltfläche (Formularobjekt) 307 

Schatten (bei Objekten) 225 

Schattierung (Menü Format) 157 

SCHÄTZER (Schätzwert für einen linearen 

Trend) 654 

SCHIEFE (Schiefe einer Verteilung) 656 

Schließen (Menü Datei) 378 

Schnellwahlpfade 325 

Schnittbereich 
Funktion SCHNITTBEREICH 657 

Operator 438, 439 

SCHNITTBEREICH (Schnittmenge zweier 

Bereiche) 657 

Schnittmenge 369, 370 

Schreibrichtung 372, 373 

Schriftart 163, 164 

Schriftenliste mit echten Schriften 389, 390 

Schriftfarbe 166 

Schriftgröße 163, 164 

Schutzanzeiger 404, 405 

Schützen 355 
Arbeitsmappenschutz 358 
Blattschutz 355 

Dokumentschutz 360 

Gliederungsansicht schützen 337, 338 

Schwellenwert (GGANZZAHL) 535 

Script bearbeiten (Menü Weiteres) 375 

Script starten (Menü Weiteres) 375 

Scripts 299, 369, 375 

Seite einrichten (Menü Datei) 194, 196, 198 
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Seitenformat 194 

Seitennummer 196, 198, 201 

Seitenränder 194, 195 

Seitenumbruch 
Ein-/Ausblenden 410, 411 

Manuell beeinflussen 202 

Seitenumbruch (Menü Einfügen) 202 

Seitenverhältnis beibehalten 220 

Seitenzahl 198, 201 

Sekundäre Achsen (in Diagrammen) 288, 289, 
290 

SEKUNDE (Sekunde aus einem Datumswert 

ermitteln) 658 

Selektieren 

Objekte 214 
Zellen 64 

Selektiv löschen (Menü Bearbeiten) 67, 68 

SHM-Erweiterungen verwenden 396, 398 

Sicherungskopien 394, 395 

Silbentrennung 318 
in Textrahmen 318 

in Zellen 319 

Sprache einstellen 313 

SIN (Sinus) 658 

SINHYP (Sinus Hyperbolicus) 659 

Sinus (SIN) 658 

Sinus Hyperbolicus (SINHYP) 659 

Skalierung (von Druckseiten) 196, 198 

Skalierung beibehalten 220 

SoftMaker 22 

SoftMaker Basic 375 

SoftMaker Formeleditor 246 

Sonderzeichen (Menü Einfügen) 133, 134 

Sortieren 
Befehl Tabelle > Sortieren 95 

Funktion SORTIERENM 660 
Funktion SORTIERENV 661 

Sortieren (Menü Tabelle) 95 

SORTIERENM (Sortieren) 660 

SORTIERENV (Sortieren) 661 

Spalte 
Breite ändern 139 

Ein-/ausblenden 141 

Einfügen 71 

Löschen 69 

Markieren 64, 65 

Spalte (Menü Tabelle) 
Ausblenden 141, 142 

Breite 140 

Einblenden 141, 142 

Optimale Breite 140 

SPALTE (Spaltennummer von Zellen) 663 

SPALTEN (Anzahl Spalten) 664 

Spaltenkopf 
Ändern der Spaltenbreite 139 

Drucken 196, 197 
Ein-/Ausblenden 410, 411 

Verwenden zum Markieren 64, 65 

Spaltennummer von Zellen (SPALTE) 663 

Speichern 
automatisch 394, 395 

Sicherungskopien 394, 395 
von Dokumenten 40 

Speichern (Menü Datei) 40 

Speichern unter (Menü Datei) 40, 363, 364 

Spezialfilter 98 

Spiegelungseffekt (bei Objekten) 227 

Sprache 

Für die Benutzeroberfläche 389, 390 
für Rechtschreibung/Silbentrennung 313 

Sprachmodule 313 

STABW (Standardabweichung einer 

Stichprobe) 664 

STABWA (Standardabweichung einer 

Stichprobe) 665 

STABWN (Standardabweichung einer 

Grundgesamtheit) 666 

STABWNA (Standardabweichung einer 

Grundgesamtheit) 667 

Standard (Menü Format) 169 

Standard (Zahlenformat) 144 

Standardabweichung 
Grundgesamtheit (STABWN) 666 

Grundgesamtheit (STABWNA) 667 

Stichprobe (STABW) 664 
Stichprobe (STABWA) 665 

Standard-Dateiformat 394 

Standardfehler einer linearen Regression 

(STFEHLERYX) 671 

STANDARDISIERUNG (Standardisierung) 

668 

Standardnormalverteilung 

STANDNORMINV 668 
STANDNORMVERT 669 

Standardwährung 404, 406 

STANDNORMINV (Quantile einer 

Standardnormalverteilung) 668 

STANDNORMVERT 

(Standardnormalverteilung) 669 
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Statistik (des Dokuments) 404 

Statuszeile 31 

STEIGUNG (Steigung einer 
Regressionsgeraden) 670 

STFEHLERYX (Standardfehler einer linearen 
Regression) 671 

Studentscher t-Test (TTEST) 696 

Student-Verteilung 
TINV 694 

TVERT 697 

STUNDE (Stunde aus einem Datumswert 
ermitteln) 672 

Subtraktion 438, 439 

Suchen 
Dateien 330 

Funktion FINDEN 523 
Funktion SUCHEN 673 

Zellinhalte 205 

Suchen (Menü Bearbeiten) 205, 207 

SUCHEN (Text in Zeichenkette suchen) 673 

Suchen wiederholen (Menü Bearbeiten) 207 

SUMME (Summe) 674 

Summe ausgewählter Werte 

(SUMMEWENN) 677 

Summe ausgewählter Werte 
(SUMMEWENNS) 678 

SUMMENPRODUKT (Summenprodukt) 675 

SUMMEWENN (Summe ausgewählter 

Werte) 677 

SUMMEWENNS (Summe ausgewählter 

Werte) 678 

SUMMEX2MY2 (Summe von x^2 - y^2) 680 

SUMMEX2PY2 (Summe von x^2 + y^2) 681 

SUMMEXMY2 (Summe von (x - y)^2) 682 

SUMQUADABW (Mittlere quadratische 

Abweichung vom Mittelwert) 683 

Support 22 

SVERWEIS (Zellbereich spaltenweise 
durchsuchen) 684 

Symbolleisten 
Verwenden 28 

Symbolleisten (Menü Ansicht) 414 

Syntaxhervorhebung (Menü Ansicht) 103 

System-Dateidialoge verwenden 389, 390 

Systemvoraussetzungen 23 

Szenarien (Menü Weiteres) 116 

T 
T (Wert in eine Zeichenkette umwandeln) 686 

Tabelle 
Bearbeiten 57 

Gestalten 137 

Markieren 64, 65 
Neu anlegen 37 

Öffnen 37 

Schützen 355, 360 
Speichern 40 

Tabelle > Blatt 84, 86 

Tabelle > Daten konsolidieren 121, 123, 126, 

130 

Tabelle > Eigenschaften 86, 87, 410 

Tabelle > Entfernen 
Doppelte Zeilen 70 

Leere Zeilen 70 

Tabelle > Externe Bezüge 446 

Tabelle > Filter 
Alles anzeigen 98, 101, 102 

Autofilter 101 
Spezialfilter 98 

Tabelle > Gliederung 

Gliederung entfernen 335, 336 

Gliederungsfeld automatisch einblenden 

337, 338 
Gruppieren 335 

Gruppierung aufheben 335, 336 

Optionen 337 

Tabelle > Namen 88, 92 

Anwenden 93 
Bearbeiten 89, 90 

Liste einfügen 92 

Übernehmen 91 

Tabelle > Sortieren 95 

Tabelle > Spalte 
Ausblenden 141, 142 

Breite 140 
Einblenden 141, 142 

Optimale Breite 140 

Tabelle > Text in Spalten aufteilen 96 

Tabelle > Transponieren 96 

Tabelle > Zeile 
Ausblenden 141 

Einblenden 141 

Höhe 140 

Optimale Höhe 140 

Tabelle > Zellen einfügen 71 

Tabelle > Zellen löschen 69 

Tabulatorbreite (in Textrahmen) 404 
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TAG (Tag aus einem Datumswert ermitteln) 

687 

TAGE (Differenz zwischen zwei Daten) 687 

TAGE360 (Differenz zwischen zwei Daten) 

688 

TAGEIMJAHR (Zahl der Tage eines Jahres) 

689 

TAGEIMMONAT (Zahl der Tage eines 

Monats) 690 

TAN (Tangens) 690 

Tangens (TAN) 690 

Tangens Hyperbolicus (TANHYP) 691 

TANHYP (Tangens Hyperbolicus) 691 

Tastenkürzel 

Anpassen 423 
für Sonderzeichen 133, 134 

für Zeichenvorlagen 173, 174, 175 

für Zellenvorlagen 179 
Vordefinierte 753, 754 

Technischer Support 22 

TEIL (Teil einer Zeichenkette) 691 

TEILERGEBNIS 692 

TEXT (Zahl in formatierten Text wandeln) 

693 

Text (Zahlenformat) 144, 147 

Text eingeben 60, 62 

Text in Spalten aufteilen (Menü Tabelle) 96 

Text in Zeichenkette ersetzen 
ERSETZEN 514 

WECHSELN 720 

TextArt-Objekte 
Eigenschaften ändern 252 

Zeichnen 248, 251 

Textauszeichnungen 163, 165 

Textbaustein (Menü Einfügen) 321, 322, 323 

Textbausteine 
Automatisch ersetzen 392, 393 

Verwenden 320 

Textdatei-Dateiformat 363, 365 

Text-Eingabemodus 31, 32 

TextMaker-Dateiformat 363, 364 

Textmarker 166 

Textrahmen 233 
Eigenschaften ändern 233, 234 

Einfügen 233 

Textrahmen-Hilfslinien 404, 406 

Tiefstellen 167 

TINV (Quantile einer t-Verteilung) 694 

Titel (von Diagrammen) 289 

Titelleiste 27 

Tortendiagramm 259, 262 

Transparenz (von Grafiken) 238, 240 

Transponieren (Menü Tabelle) 96 

Transponieren einer Matrix (MTRANS) 615 

TREND (Werte einer linearen Regression) 
695 

Trendlinien (in Diagrammen) 276 

Trennzeichen für Zahlen 387, 389 

t-Test (TTEST) 696 

TTEST (t-Test) 696 

TVERT (t-Verteilung) 697 

t-Verteilung 

TINV 694 
TVERT 697 

TYP (Typ des Arguments ermitteln) 698 

U 
Überlappend (Menü Fenster) 379 

Überlappende Objekte 234, 235, 254 

Uhrzeiten eingeben 60, 61 

Umrandung (Menü Format) 155 

UMWANDELN (Maßeinheiten umrechnen) 
699 

UND (Logisches UND) 702 

Undo 36, 63 

UNGERADE (Aufrunden auf eine ungerade 
Zahl) 702 

Untereinander (Menü Fenster) 379 

UNTERGRENZE (Abrunden auf ein 
Vielfaches von n) 703 

Unterschneidung (Kerning) 168 

Unterstreichen 165 

Updates suchen 396, 397 

V 
Varianz 

Grundgesamtheit (VARIANZEN) 705 

Grundgesamtheit (VARIANZENA) 706 

Stichprobe (VARIANZ) 704 
Stichprobe (VARIANZA) 704 

VARIANZ (Varianz einer Stichprobe) 704 

VARIANZA (Varianz einer Stichprobe) 704 

VARIANZEN (Varianz einer 
Grundgesamtheit) 705 
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VARIANZENA (Varianz einer 

Grundgesamtheit) 706 

VARIATION (Werte einer exponentiellen 
Regression) 707 

VARIATIONEN 708 

VBA 375 

VBA-Scripts 299, 369 

Verbergen 
Objekte 231 

Zellinhalte 356 

Verbindungen 
Eigenschaften ändern 252 

Zeichnen 248, 250 

Verborgene Objekte anzeigen 404, 406 

VERGLEICH (Position eines Werts in einem 

Bereich) 710 

Vergrößerungsstufe (Menü Ansicht) 412 

VERKETTEN (Zeichenketten verbinden) 711 

Verkettung von Zeichenketten 438, 439, 711 

Verknüpfung (Menü Format) 339 

Verknüpfung entfernen (Menü Format) 339, 
341 

Verknüpfungen (Links) 

bei Objekten 228, 229 

bei Zellinhalten 339 
Funktion HYPERLINK 545 

Verknüpfungen (Menü Bearbeiten) 244 

Verschieben um ... Stellen 404, 405 

Verschlüsselung 360, Siehe Dokumentschutz 

Versenden (Menü Datei) 353 

Vertikale Ausrichtung 

bei AutoFormen 254 
bei Textrahmen 234, 235 

von Zellinhalten 160, 161 

Vertikale Gitternetzlinien anzeigen 283, 284 

Vertikaler Text 160, 162 

VERWEIS (Zellbereich durchsuchen) 711 

Visual Basic 375 

Vollbild (Menü Ansicht) 413 

Vollbildansicht 413 

Vorlagenpfad 394 

Vorschau 37, 39 

Vorzeichen 438, 439 

VORZEICHEN (Vorzeichen einer Zahl) 715 

VRUNDEN (Runden auf ein Vielfaches von 
n) 716 

W 
WAHL (Auswahl aus einer Liste) 717 

WAHR (Wahrheitswert) 717 

Wahrheitswert (Zahlenformat) 144, 146 

WAHRSCHBEREICH (Wahrscheinlichkeit) 
718 

WÄHRUNG (Zahl als Währung formatieren) 
719 

Währung (Zahlenformat) 144, 145 

Wände (in Diagrammen) 270 

Warnton bei Meldungen 389, 390 

Warnton bei Tippfehlern 392, 393 

Warnung beim Laden von OLE-Objekten 385, 
386 

Weberfunktion (BESSELY) 478 

WECHSELN (Text in Zeichenkette ersetzen) 

720 

WEIBULL (Weibull-Verteilung) 721 

Weiche Kanten-Effekt (bei Objekten) 227 

Weiteres > Anpassen 
Symbolleisten 419, 421 

Tastaturbelegung 423 

Weiteres > Arbeitsmappenschutz 359 

Weiteres > Blattschutz 355, 357 

Weiteres > Blattschutz aufheben 358 

Weiteres > Diagramme aktualisieren 292, 407, 
409 

Weiteres > Einstellungen 384 
Karteikarte Allgemein 385 

Karteikarte Ansicht 384 
Karteikarte Aussehen 389 

Karteikarte Bearbeiten 387 

Karteikarte Dateien 394 

Karteikarte Schriften 399 

Karteikarte Sprache 392 

Karteikarte System 396 

Weiteres > Formelüberwachung 106, 108, 

109, 110, 111 

Weiteres > Listen editieren 82, 83, 429 

Weiteres > Neu berechnen 112, 407, 408 

Weiteres > Rechtschreibprüfung 315 

Weiteres > Script bearbeiten 375 

Weiteres > Script starten 375 

Weiteres > Szenarien 116 

Weiteres > Wörterbücher bearbeiten 317 

Weiteres > Zielwertsuche 114 

WENN (Wenn-Dann-Sonst-Bedingung) 722 
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WENNFEHLER (liefert Zeichenkette bei 

Fehler) 722 

WERT (Zeichenkette in Zahl umwandeln) 723 

Wiederherstellen (Menü Bearbeiten) 36, 63 

Wiederholen (Menü Bearbeiten) 64 

WIEDERHOLEN (Zeichenkette n mal 
wiederholen) 724 

Wiederholungsspalten 196, 197 

Wiederholungszeilen 196, 197 

Window Manager-Dialoge 389, 391 

Window Manager-Positionierung 389, 391 

Wissenschaftliches Zahlenformat 144, 146 

WOCHENTAG (Wochentag aus Datum 
ermitteln) 725 

Wölbung einer Verteilung (KURT) 589 

Wörterbücher bearbeiten (Menü Weiteres) 
317 

Wörterbücher nachinstallieren (für 
Rechtschreibprüfung) 431 

Wurzel 
WURZEL 726 

WURZELN 726 
WURZELPI 727 

WURZEL (Quadratwurzel) 726 

WURZELN (Wurzel) 726 

WURZELPI (Quadratwurzel von x*Pi) 727 

WVERWEIS (Zellbereich zeilenweise 
durchsuchen) 728 

X 
X-Achse (in Diagrammen) 278 

XIM verwenden 396, 398 

XINTZINSFUSS (Interner Zinsfuß) 730 

XKAPITALWERT (Nettobarwert) 731 

XLSX-Dateiformat 363, 364 

XODER (Logisches EXKLUSIV ODER) 731 

XY-Punktdiagramm 259, 261 

Y 
Y-Achse (in Diagrammen) 280 

Z 
Z-Achse (in Diagrammen) 282 

Zahl (Zahlenformat) 144, 145 

Zählen 
ANZAHL 459 

ANZAHL2 460 

ANZAHLLEEREZELLEN 461 

ZÄHLENWENN 732 

ZÄHLENWENNS 733 

Zahlen eingeben 60 

Zahlenformat 142, 144, 147, 149 

ZÄHLENWENN (Zählen ausgewählter 

Werte) 732 

ZÄHLENWENNS (Zählen ausgewählter 

Werte) 733 

Zehnerlogarithmus (LOG10) 596 

Zeichen (Menü Format) 163, 164, 165, 166, 
167, 168 

ZEICHEN (Zeichen per ANSI-Code) 735 

Zeichenbreite 167 

Zeichenformat 163 

Zeichenformatierung auf das ganze Wort 

anwenden 387, 388 

Zeichenketten 

Teil ausschneiden (LINKS) 594 
Teil ausschneiden (RECHTS) 643 

Teil ausschneiden (TEIL) 691 

Verbinden (VERKETTEN) 711 

Zeichenvorlage (Menü Format) 173, 174, 175, 

176 

Zeichenvorlagen 173 

Zeichnungen 248 
Eigenschaften ändern 252 

Einfügen 248 

Zeichnungsfläche (in Diagrammen) 269 

Zeile 
Ein-/ausblenden 141 

Einfügen 71 
Höhe ändern 139 

Löschen 69, 70 

Markieren 64, 65 

Zeile (Menü Tabelle) 

Ausblenden 141 
Einblenden 141 

Höhe 140 

Optimale Höhe 140 

ZEILE (Zeilennummer von Zellen) 735 

Zeilen- & Spaltenköpfe (Menü Ansicht) 410, 
411 

ZEILEN (Zahl der Zeilen) 736 

Zeilenabstand 170 

Zeilenkopf 

Ändern der Zeilenhöhe 139 
Drucken 196, 197 

Ein-/Ausblenden 410, 411 

Verwenden zum Markieren 64, 65 
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Zeilennummer von Zellen (ZEILE) 735 

Zeilenumbruch 160, 162 

ZEIT (Datumswert bilden) 737 

ZEITDIFFERENZ (Differenz zwischen zwei 
Uhrzeiten) 737 

ZEITWERT (Text in Uhrzeit wandeln) 738 

Zelladresse als Text ausgeben (ADRESSE) 

458 

Zellbearbeitung wird nie mit linker Pfeiltaste 

verlassen 387, 388 

Zelle 

Ausfüllen 60 

Automatisch ausfüllen 78 

Einfügen 71 
Größe ändern 139 

Löschen 69 

Markieren 64, 66 
Schützen 355 

Verbinden 160, 162 

ZELLE (Informationen über eine Zelle) 739 

Zelle (Menü Format) 
Karteikarte Ausrichtung 160 

Karteikarte Schattierung 157 

Karteikarte Schutz 356 

Karteikarte Umrandung 155 

Karteikarte Zahlenformat 142, 144, 147 

Zelle direkt in der Tabelle editieren 387 

Zellen automatisch vervollständigen 60, 63, 
387 

Zellen einfügen (Menü Tabelle) 71 

Zellen löschen (Menü Tabelle) 69 

Zellen verbinden 160, 162 

Zellenvorlage (Menü Format) 178, 179, 180, 
181 

Zellenvorlagen 177 

Zellrahmen 35 

Zentriert 160 

ZGZ (Zinssatz) 741 

Zielwertsuche (Menü Weiteres) 114 

ZINS (Zinssatz per Iterationsverfahren) 742 

Zinsfuß 
IKV 549 

QIKV 638 

XINTZINSFUSS 730 

Zinssatz (ZGZ) 741 

Zinssatz per Iterationsverfahren (ZINS) 742 

ZINSZ (Zinszahlung) 743 

Zinszahlung (ZINSZ) 743 

Zinszahlung, kumuliert (KUMZINSZ) 587 

Zinszeitraum (ZZR) 750 

Zirkulärer Bezug 31, 32, 407, 409 

z-Test 539, Siehe GTEST (Gauß-Test) 

ZUFALLSBEREICH (zufälliger Wert) 745 

ZUFALLSZAHL (zufälliger Wert) 746 

Zukünftiger Wert (ZW) 747 

Zukünftiger Wert (ZW2) 748 

ZULETZTGEDRUCKT (Datum des letzten 

Ausdrucks) 746 

ZULETZTGESPEICHERT (Datum des 

letzten Speicherns) 747 

ZW (Zukünftiger Wert) 747 

ZW2 (Zukünftiger Wert) 748 

Zweierfakultät (ZWEIFAKULTÄT) 749 

ZWEIFAKULTÄT (Zweierfakultät) 749 

Zwischenergebnisse runden 407, 409 

Zylinderdiagramm 259, 262 

ZZR (Zinszeitraum) 750 
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